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Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED “AS IS,” 
AND IS SUBJECT TO BEING 
CHANGED, WITHOUT NOTICE, IN 
FUTURE EDITIONS. FURTHER, TO 
THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, KEYSIGHT 
DISCLAIMS ALL WARRANTIES, 
EITHER EXPRESS OR IMPLIED WITH 
REGARD TO THIS MANUAL AND 
ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED 
WARRANTIES OF 
MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE 
FOR ERRORS OR FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE 
FURNISHING, USE, OR 
PERFORMANCE OF THIS 
DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD 
KEYSIGHT AND THE USER HAVE A 
SEPARATE WRITTEN AGREEMENT 
WITH WARRANTY TERMS 
COVERING THE MATERIAL IN THIS 

DOCUMENT THAT CONFLICT WITH 
THESE TERMS, THE WARRANTY 
TERMS IN THE SEPARATE 
AGREEMENT WILL CONTROL.

Technology Licenses

The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license.

U.S. Government Rights

The Software is “commercial 
computer software,” as defined by 
Federal Acquisition Regulation 
(“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and 
Department of Defense FAR 
Supplement (“DFARS”) 227.7202, the 
U.S. government acquires 
commercial computer software 
under the same terms by which the 
software is customarily provided to 
the public. Accordingly, Keysight 
provides the Software to U.S. 
government customers under its 
standard commercial license, which 
is embodied in its End User License 
Agreement (EULA), a copy of which 
can be found at 
http://www.keysight.com/find/sweu
la. The license set forth in the EULA 
represents the exclusive authority by 
which the U.S. government may use, 
modify, distribute, or disclose the 
Software. The EULA and the license 
set forth therein, does not require or 
permit, among other things, that 
Keysight: (1) Furnish technical 
information related to commercial 
computer software or commercial 
computer software documentation 
that is not customarily provided to 
the public; or (2) Relinquish to, or 
otherwise provide, the government 
rights in excess of these rights 
customarily provided to the public to 
use, modify, reproduce, release, 
perform, display, or disclose 
commercial computer software or 
commercial computer software 
documentation. No additional 
government requirements beyond 
those set forth in the EULA shall 
apply, except to the extent that those 
terms, rights, or licenses are 
explicitly required from all providers 
of commercial computer software 
pursuant to the FAR and the DFARS 
and are set forth specifically in 

writing elsewhere in the EULA. 
Keysight shall be under no obligation 
to update, revise or otherwise modify 
the Software. With respect to any 
technical data as defined by FAR 
2.101, pursuant to FAR 12.211 and 
27.404.2 and DFARS 227.7102, the 
U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as 
applicable in any technical data.

Safety Notices

A CAUTION notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly 
performed or adhered to, could 
result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION 
notice until the indicated 
conditions are fully understood 
and met. 

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly 
performed or adhered to, could 
result in personal injury or death. 
Do not proceed beyond a 
WARNING notice until the 
indicated conditions are fully 
understood and met.

A NOTE calls the user’s attention 
to an important point or special 
information in the text.
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Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument 
software upgrades, application information, and product information, browse to one of the following URLs, 
according to the name of your product:

http://www.keysight.com/find/fieldfox

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:

http://www.keysight.com/find/MyKeysight

Information on preventing instrument damage can be found at:

https//www.keysight.com/find/PreventingInstrumentRepair 

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. 
To search for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/fieldfoxsupport
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A12.3x and A.12.4x Firmware – Release B Series FieldFox

For customers upgrading FieldFox firmware, the following is a list of changes from the previous release:

— Added: EMI (Electromagnetic Interference) – Option 361 Measurement mode

— CISPR (International Special Committee on Radio Interference) and Amplitude Probability          

— Improved: EMI log limit lines (display process) 

— GPS feature – Improved: GPS with more robust time-proxy syncing

— OTA mode – Improved: 5G NR EVM Conducted measurement launch

— NA mode – Added: Apply Nearest feature

— SA mode – Added: 

— IQ Streaming (Option 353)

— EMI Electromagnetic Interference (Option 361)

— EIRP (Effective Isotropic Radiated Power)

— Analog Demodulation Metrics

— Measure Setup menu for General or IQ Streaming analysis

— Improved: Record/Playback *.CSV file saving process

— Mapping functionality – Added: Directional Bearing
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Contacting Keysight

Assistance with test and measurements needs and information on finding a local Keysight office are available 
on the Web at: http://www.keysight.com/find/assist.

If you do not have access to the Internet, please contact your Keysight field engineer. 

In any correspondence or telephone conversation, refer to the Keysight product by its model number and full 
serial number. With this information, the Keysight representative can determine whether your product is still 
within its warranty period.

To contact Keysight for sales and technical support, refer to support links on the following Keysight websites: 
http://www.keysight.com/find/support (product specific information and support, software and 
documentation updates) http://www.keysight.com/find/assist (worldwide contact information for repair 
and service).



 6 



Keysight N9938-90006 User’s Guide                                                                                                             7

1. Overview

Models and Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Accessories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Optional Accessories  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

FieldFox Manuals, Software, and Supplemental Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Conventions that are used in the Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Safety Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

2. Preparing for Initial Use of Your New FieldFox

Check the Shipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Meeting Power Requirements for the AC/DC Adapter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Install the Lithium-Ion Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Battery Usage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

FieldFox ON/OFF Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Power Button LED Status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

FieldFox High Temperature Protection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
How to monitor the internal FieldFox temperature:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Temperature Control Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
High-Temp Shutdown Warning (RTSA Mode Only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Avoid Overpowering the FieldFox. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Take the FieldFox Tour  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Front Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Top Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Right Side Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Left Side Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Screen Tour. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

How to Enter Numeric Values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Multiplier Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Connector Care. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

3. CAT (Cable and Antenna Test) Mode

CAT Mode Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
How to select CAT Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Measurement Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Quick Settings Table. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Frequency Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Scale Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Averaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Smoothing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Single or Continuous Measure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Resolution (Number of Data Points)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56



8                                                                                                          Keysight N9938-90006 User’s Guide

Sweep Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .56
Output Power. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .57
Interference Rejection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58
Coupled Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58

Return Loss Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60
How to Measure Return Loss  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60

1-Port Cable Loss Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60
How to make a 1-port Cable Loss Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .61

2-Port Insertion Loss Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62

4. DTF (Distance to Fault) Measurements

How to make DTF Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .64

DTF Measurement Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
DTF Settings Table. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
DTF Measurement (Format)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
DTF Start and Stop Distance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67
Frequency Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67
Coupled Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68
Cable (Correction) Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69
Window Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .72
DTF Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .73
Calculated DTF values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .73
About Alias Faults . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .73

5. TDR (Time Domain Reflectometry) - Option 215

TDR Measurement Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
TDR Measurement (Format)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
TDR Settings Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
TDR Start and Stop Distance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .79
TDR Sweep  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .79
Frequency Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .80
Cable (Correction) Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81
Window Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .84
TDR Units. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .85
Calculated TDR values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .85
About Alias Faults . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .86
How to Prevent Undersampling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .87

6. NA (Network Analyzer) Mode

NA Mode Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91
About S-parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91
Mixed-Mode S-Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92



Keysight N9938-90006 User’s Guide                                                                                                             9

Parameter Conversion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Receiver Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Multi-Trace Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Quick Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Calibration Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Format  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Frequency Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Scale Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Magnitude Offset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Electrical Delay. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Phase Offset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Averaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
IF Bandwidth. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Smoothing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Single or Continuous Measure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Resolution (Number of Data Points)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Sweep Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Triggering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Output Power . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
System Impedance (Z0) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Port Extensions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Velocity Factor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Big Marker Display States (A and B) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Increase Dynamic Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

7. Time Domain – Option 010

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

Time Domain (Transform) Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Transform Settings Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Start/Stop (Frequency Range) and Points. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Stimulus (Mode) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Set Frequency Lowpass . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Start/Stop Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Distance Units  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Window Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Transform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Line Loss and Velocity Factor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Data Chain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Trace Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Transform Enable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Gate Enable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Gating . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122



10                                                                                                          Keysight N9938-90006 User’s Guide

How to make Time Domain Gating settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123
Start, Stop, Center, and Span Gate Times . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123
Gating Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123

8. Calibration for NA, CAT, and VVM Modes

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126
Why and When to Calibrate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126
Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126
CalReady . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .127
How to Perform a Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .127
Mechanical Cal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .129
ECal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .131
Simple Response Cals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .134
View Cal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .136
Calibration Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .136
Isolation Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .139
Waveguide Calibrations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .139
Enhanced Response Optimization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .141
Interpolation *  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .142
Cal ON? – Questionable Accuracy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .142
Compatible Mode Calibrations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .142
Save the Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .142
CalReady Properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .142
Apply Nearest (NA Mode Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144

Verifying Calibration and Jumper Cable Integrity. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144
Verify a Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144
Test the Jumper Cable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .145

Calibration Method Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .146

9. SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)

SA Mode Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .151
How to select SA Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .151
Frequency Range. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .151
Radio Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .153
Custom Radio Standards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .154
Channel Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .155
Reverse Swap  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .156
Scale and Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .157
External Gain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .158
Attenuation Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .159
Preamplifier Control (Opt 235)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .160
Check for Compressed Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .160



Keysight N9938-90006 User’s Guide                                                                                                             11

Field Strength Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Using the Antenna/Cable Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Source Tracking Offset and Offset Reversal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
Tune & Listen (AM/FM). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
Analog Demod . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Independent Source/Tracking Generator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
Resolution Bandwidth (Res BW)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Video Bandwidth (Video BW). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
AF RBW (Audio-Frequency Resolution BW) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
Sweep Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
IF Output. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Sweep Acquisition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
Very Long Sweep Times . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
Zero Span Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
Triggering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
FFT Gating (Opt 238) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
Single / Continuous / Restart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198
Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198
Trace Display States (SA Mode). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198
Average Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199
Average Count . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
Alignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Detection Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
Display Line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Noise Marker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
Band/Interval Power Marker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
Frequency Counter at Marker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
Time Zero Fixed Marker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
Audio Beep at Marker Power . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
Meas UNCAL Error . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
Old Data Indicator (*) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

Channel Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Radio Standards and Channel Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Measurement Preset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Averaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Traces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Channel Power (CHP). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216

How to Set Up EMF Settings (Requires EMF (Option 358), GPS (Option 307), and SA Mode 
(Option 233–Mixed Analyzers))  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

EMF Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
EMF Setup Procedure. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229

Spectrum Emission Mask (SEM) — (SA Mode Only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238



12                                                                                                          Keysight N9938-90006 User’s Guide

How to select Spectrum Emission Mask (SEM) Measurement  . . . . . . . . . . . . . . . . . . . .240

IQ Analysis (Requires Option 351 IQ Analyzer and Option 353 IQ Streaming, SA Mode Only) . .
245

How to Select IQ Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .245
How to Setup IQ Analysis General  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246
How to Setup IQ Analysis Streaming  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246

Effective Isotropic Radiated Power (EIRP) – (SA Mode Only) . . . . . . . . . . . . . . . . . . . . . . . . .248
How to Select Effective Isotropic Radiated Power (EIRP)  . . . . . . . . . . . . . . . . . . . . . . . .248
How to Setup EIRP (Effective Isotropic Radiated Power) . . . . . . . . . . . . . . . . . . . . . . . . .248

10. RTSA (Real-time Spectrum Analyzer) Mode—Option 350

RTSA Mode Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .254
How to select RTSA Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .254
Frequency Range. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .254
Scale and Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .256
External Gain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .256
Attenuation Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .257
Preamplifier Control (Opt 235)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .258
Check for Compressed Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .258
Spectrum Selection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .259
Setting the IF Path. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .263
Resolution Bandwidth (Res BW) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .263
Triggering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .264
Single / Continuous / Restart / Time Per Div . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .267
Acq Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .268
Points (not user settable)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .268
Trace Display States (RTSA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .269
Detection Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .270
Average Count, Show Density, Blue, and Red Percentage Limits  . . . . . . . . . . . . . . . . .271
Alignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .272
Display Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .272

Spectrogram Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .274
Spectrogram Display (RTSA Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .274
Common Settings for Spectrogram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .275

Record/Playback (RTSA Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .276
About Sessions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .276
FieldFox Setting Changes during Record and Playback  . . . . . . . . . . . . . . . . . . . . . . . . .277
About State and User Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .278
How to Record a Session  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .279
How to Playback a Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .280
Recording Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .281
Record Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .282



Keysight N9938-90006 User’s Guide                                                                                                             13

Playback Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Manage Sessions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Record Playback Example (RTSA Mode Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284

11.    IQ Analyzer (IQA) – Option 351

About I/Q Analyzer (IQA) Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289

I/Q Analyzer (IQA) Mode Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290
How to Make Measurements Using the I/Q Analyzer Mode . . . . . . . . . . . . . . . . . . . . . . 290
How to Capture I/Q Data to a File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
How to modify the I/Q data measurement parameters  . . . . . . . . . . . . . . . . . . . . . . . . . 294

Using Markers (IQA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
Noise Marker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
Band/Interval Power Marker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
Band Span Marker (Spectrum Only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307
Interval Span Marker (Waveform Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307
Coupled Markers (Waveform Only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307
Continuous Peak Search Marker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309

Alignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310

Trace Display States (IQA Mode) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
How to display the Trace States  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310

Other Features Available  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312

12. Electromagnetic Interference (EMI) Measurements – Option 361

Using EMI Measurements (Option 361) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 317

EMI Measurements Mode Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318
How to select EMI Measurements Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318
Frequency Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318
Scale and Units  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 320
External Gain  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 320
Attenuation Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 321
CISPR (International Special Committee on Radio Interference) Control. . . . . . . . . . . . 321
Preamplifier Control (Opt 235) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
Resolution Bandwidth (Res BW)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
Single / Continuous / Restart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327
Points  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328
Trace Display States (EMI Mode) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328
Trace Averaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
Alignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
Detection Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330



14                                                                                                          Keysight N9938-90006 User’s Guide

Input – (Trace Input for APD Measurements) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .331

About Electromagnetic Interference (EMI) Measurements. . . . . . . . . . . . . . . . . . . . . . . . . . .333
EMI Measurement Features (Option 361) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .333

How to Set Up Electromagnetic Interference (EMI) Mode Settings. . . . . . . . . . . . . . . . . . . .335
EMI Measurement Mode Setup Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .335

Glossary (EMI)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .336

13. Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 371, 5G TF Option 377, 5G 
NR / 5G NR EVM Conducted Option 378

Using OTA (Options 370 – LTE FDD, 372 – TDD, 377 – 5G TF, and Option 378 – 5G NR / 5G NR 
Conducted) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .340

About Over–the–Air (OTA) Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .342
LTE FDD and LTE TDD Features (Option 370 and Option 371)  . . . . . . . . . . . . . . . . . . . .342
5G TF Features (Option 377) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .348
5G NR Features (Option 378)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .349
5G NR EVM Conducted Features (P/O: Option 378)  . . . . . . . . . . . . . . . . . . . . . . . . . . . .352

How to Set Up Over–the–Air (OTA) Mode Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353
OTA Setup Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353
Optional: Using RTSA to verify the signal quality (Requires Option 350 and Preamp Option 
235)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .370
How to Define a Cell or Cell(s) and Use OTA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .371

How to Set Up EMF Mode Settings (Requires EMF (Option 358) and 5G NR (Option 378)).387
EMF Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .387
EMF Setup Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .390

How to Use Data Logging (OTA Options 370, 372, 377, and 378)  . . . . . . . . . . . . . . . . . . . .394
Screen Annotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .394
How to Record a Data Log Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .395
To change Data Logging Configuration settings: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .396
How to Play a Data Log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .397

Other Features Available . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .398

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .399

Glossary (OTA) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .400

14. 5G Rapid Prototype Phased Array Antenna – Option 360

Using the Phased Array Antenna (Option 360) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .407

About Phased Array Antenna Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .408
Phased Array Antenna Features (Option 360)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .408

How to Set Up Phased Array Antenna Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .417
Option 360 Setup Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .417
How to Define a Set Up a Scan and Use Option 360  . . . . . . . . . . . . . . . . . . . . . . . . . . .429

How to Use Data Logging/Playback (Option 360) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .438



Keysight N9938-90006 User’s Guide                                                                                                             15

Screen Annotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438
How to Record a Data Log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
To change Data Logging Configuration settings:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
How to Playback a Data Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 441

Using Mapping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 442

Other Features Available  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 442

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443

15. USB Antennas – (Full Capability Requires EMF Option 358, and either SA mode (Option 233 Mixed 
Analyzers) or OTA—5G NR / 5G NR EVM Conducted Option 378)

Using USB Antennas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 448

About USB Antenna Measurements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 449
USB Antenna Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 449

How to Set Up a USB Antenna  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451
USB Antenna Setup Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451

Other Features Available  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 455

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 456

16. Indoor and Outdoor Mapping – Option 352 (Requires Spectrum Analyzer Mode (Option 233), and GPS 
Receiver (Option 307))

How to Install Node.js and Running the FieldFox Mapping Software  . . . . . . . . . . . . . . . . . 462

Downloading and Using the FieldFox Map Support Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . 464

Importing a .zip File to the FieldFox. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469

How to Set Up Mapping Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 471
How to Set Up Mapping When the FieldFox Is On The LAN. . . . . . . . . . . . . . . . . . . . . . 472
Option 352 Indoor Maps Setup Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 474
Option 352 Outdoor Maps Setup Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 478
Setting up Data Logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 486

How to Use Data Logging (Option 352)    . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
Screen Annotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
How to Add Directional Finding (DF) Bearing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 496
How to Record a Data Log (Outdoor Logging Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 499
To change Data Logging Configuration settings: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 500
How to Play a Data Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 500

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 501
General Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 503
Port 5000 in Use Error  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 503
Update Available Message. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 505
Miscellaneous Mapping Errors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 506

17. Remote Server Mode (Requires SA Hardware/SA Option 233) 



16                                                                                                          Keysight N9938-90006 User’s Guide

In this Chapter:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .508

Connecting Using Remote Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .509
Changing Frequency Converter Head Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .510

89600 VSA Software Overview (Requires N991xB/3xB/5xB/6xB and SA Option 233) . . . . .511

18. Interference Analyzer (SA Mode) – Option 236 

Spectrogram and Waterfall Displays. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .514
Spectrogram Display (SA Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .514
Common Settings for Waterfall and Spectrogram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .516
Waterfall Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .517

Record/Playback (SA Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .519
About Sessions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .519
FieldFox Setting Changes during Record and Playback  . . . . . . . . . . . . . . . . . . . . . . . . .520
About State and User Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .521
How to Record a Session  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .522
How to Playback a Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .523
Recording Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .523
Frequency Mask Trigger Configuration (SA Mode Only)  . . . . . . . . . . . . . . . . . . . . . . . . .525
Record Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .526
Playback Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .527
Manage Sessions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .527
Record Playback Example (SA Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .528

19. Reflection Mode (SA Models) - Option 320

Reflection Mode Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .534
How to select Reflection Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .534
Measurement Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .534
Normalize. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .534

20. Built-in Power Meter Mode – Option 310

Built-in Power Meter Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .539
How to select Built-in Power Meter Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .539
Frequency/ Span / Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .539
Attenuation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .540

21. Power Meter (USB/LAN) Mode - Option 302

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .543
Supported Power Sensors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .543
How to Connect a USB Power Sensor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .543
How to Connect a LAN Power Sensor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .544

USB and LAN Power Meter Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .546
How to select Power Meter Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .546



Keysight N9938-90006 User’s Guide                                                                                                             17

How to select a Sensor Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 547
Average / Peak . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 547
Zeroing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 547
Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 548
Source Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 548
Source Power Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 550
Relative and Offset Power Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 550
Display Units. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Resolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 551
Averaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 552
Single or Continuous Measure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 552
Step Detection Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 553
Limits  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 553

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 554
LAN Sensors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 554

22. Frequency Offset Using Power Sensor (FOPS) – Option 208

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 559

FOPS Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 561
How to select Power Meter (USB Sensor) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 561
Measurement Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 561
Sweep Type and Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 562
Power Sensor Settling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 564
Sweep Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 564
Amplitude Markers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 565
Trace Math . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 565

23. Pulse Measurements Mode – Option 330

Supported Power Sensors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 569
Switching between Pulse Measurement Mode and Power Meter Mode  . . . . . . . . . . . . 569
How to Connect the USB Power Sensor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 570
How to Connect the LAN Power Sensor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 570

Pulse Measurement Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 573
How to select Pulse Measurement Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 573
Measurement Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 573
Frequency / Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 573
Zoom Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 574
Scale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 575
Averaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 575
Video Bandwidth  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 576
Single or Continuous Measure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 577
Resolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 577



18                                                                                                          Keysight N9938-90006 User’s Guide

Triggering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .577
Marker Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .580
Amplitude Markers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .581
Marker Search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .581
Auto Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .582
Pulse Top . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .583
Grid  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .583
Trace Memory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .584

24. VVM (Vector Voltmeter) Mode - Option 308

Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .587

VVM Mode Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .588
How to select VVM Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .588
Measurement Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .588
Frequency Selection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .588
Display Resolution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .588
IF Bandwidth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .589
Output Power. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .589
Averaging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .590
Single or Continuous Measure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .591
VVM Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .591
Zeroing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .591

1-Port Cable Trimming Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .593
How to make a 1-Port Cable Trimming Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . .593

2-Port Transmission Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .595
How to make a 2-Port Transmission Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . .595

A/B and B/A Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .596

25. ERTA (Extended Range Transmission Analysis) Mode - Option 209

Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .598

Requirements and Limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .599
Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .599
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .599

Start Connection Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .600
On the Receiver unit: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .600

Configure Measurement Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .604
Select Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .604
Normalize. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .605
Source Tracking Offset and Offset Reversal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .605
Improve Dynamic Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .606
Source Enable and Source Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .606



Keysight N9938-90006 User’s Guide                                                                                                             19

26. AM/FM Metrics (SA Only and Option 355)

Using AM/FM Metrics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 607
Overview of Measurement Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 607
How to Set Up AM/FM Metrics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 610

SINAD and THD Calculations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 614

Interpreting AM/FM Metrics Error Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 617
Test Tone Not Found  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 617

27. Channel Scanner (Option 312)

Using Channel Scanner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 622

How to Set Up Channel Scanner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 623
How to Define a Channel and Use Channel Scanner . . . . . . . . . . . . . . . . . . . . . . . . . . . 626
Field Strength Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 640
Using the Antenna/Cable Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 646
Using Mapping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 648
Using Resolution Bandwidth Tradeoff (Res BW Tradeoff). . . . . . . . . . . . . . . . . . . . . . . . 648

28. Noise Figure Mode (Option 356)

Using Noise Figure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 652

How to Define a Noise Figure Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 656
Example: Typical Noise Figure Measurement Procedure. . . . . . . . . . . . . . . . . . . . . . . . . 656
Overview of Softkey Menus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 657
How to Use DUT Measurement Setups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 664
Single / Continuous / Restart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 676
Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 676
Resolution Bandwidth (Res BW)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 677
Alignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 677
Calculating Noise Figure Measurement Uncertainty. . . . . . . . . . . . . . . . . . . . . . . . . . . . 678
Using ENR Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 683
About ENR (*.enr), Preamplifier (*.amp), and DUT (*.dut) Files. . . . . . . . . . . . . . . . . . . . 684
Using Markers (Noise Figure). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 686

Calibration Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 687
When to Calibrate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 687

How to use Auto-Integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 690
About Auto-Integration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 690
Auto-Integration Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 691

Other Features Available  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 696

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 697

29. Data Analysis Features

All about Markers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 700



20                                                                                                          Keysight N9938-90006 User’s Guide

How to create Markers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .700
How to move a Marker after it is created . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .700
About Delta Markers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .701
Signal Track Marker (NF and SA Mode ONLY) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .702
Marker Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .702
Coupled Markers (NA Mode). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .703
Marker Colors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .704
Marker Trace (CAT, NA, NF Modes). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .704
Marker Trace (IQA and SA Mode) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .704
Marker Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .705
Searching with Markers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .706
What Is a ‘Peak’ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .711
Marker Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .713
I/Q Analyzer (IQA) Marker Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .714
SA Marker Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .714

All about Limit Lines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .715
How to Create Fixed Limit Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .715
Relative Limit Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .716
Build From Trace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .716
Limit Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .717
How to Save and Recall Limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .718
Display Line (I/Q, NF, and SA Modes Only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .719

All about Trace Math . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .720
How to display data and memory traces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .720
How to perform Trace Math . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .720
About Math Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .721

All about Scale Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .722
How to Use Scale Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .722
Averaging (CAT, NA, Power Meter, Channel Scanner, and Pulse Measurement Modes Only)
722

30. System Settings

Run/Hold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .726
How to perform a single sweep while in Hold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .726

Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .727
How to Preset the FieldFox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .727

User Preset. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .727
How to set User Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .728
How to recall User Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .728

Audio (Volume) Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .728
How to set the FieldFox Volume Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .729



Keysight N9938-90006 User’s Guide                                                                                                             21

Display (Settings) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 729
Display Brightness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 729
Display Colors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 729
Trace Width  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 730
Title . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 730
Edit Keywords . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 731
Full Screen Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 731

Utilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 732
How to view and change Utilities Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 732

Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 740
Quick Settings Table. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 740
Save and Reset Preferences. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 742
Global Settings (Overview). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 742

Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 744

Audio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 745

Date and Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 746

GPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 746
How to select CAT distance units: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 746

Frequency Reference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 748
How to set the frequency reference settings:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 748

File folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 748
How to set File Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 748

Alpha Numeric Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 749

File Saving Naming Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 749

Quick Save Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 749

Group Save File Types Editing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 750
Group Save File Types Procedure. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 750
Group Save File Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 750

CAT (Distance Units). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 751

CAT/NA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 752

SA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 753

Discrete Colors Softkey Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 754
Using the Discrete Colors Softkey Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 754

System Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 754
Options (Licensing). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 754
GNSS (GPS+) and GPS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 756
Frequency Reference Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 760
Variable Voltage Source (Opt. 309) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 762
Security Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 763
Date and Time, Format, and Time Zone Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 764



22                                                                                                          Keysight N9938-90006 User’s Guide

LAN Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .765
Power ON. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .767
FieldFox Package Installer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .767

Service Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .769
System Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .769
Event Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .770
Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .770
Internal Temperatures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .770
Erase User Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .770
How to Erase User Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .771

Understanding the Fan Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .772

31. Using the Mini-USB Port to send SCPI Commands and Queries

Mini-USB Connection to PC with IO Libraries  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .775

32. File Management

Saving and Recalling Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .778
Save Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .778
Recall Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .782
Move (Copy) Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .782
Set File Type and Select Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .783
Manage Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .786
Manage Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .788
Edit Keywords  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .789
Prefixes and Suffixes for Filenames. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .789

Press Printing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .792
How to print the current screen or a saved file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .792

33. Working with the Lithium-Ion Battery

Viewing the Battery Charge Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .793
Service Diagnostics—Battery Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .794
Built-In Battery Gauge  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .794

Charging the Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .795
Internal Charging with the AC/DC Adapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .795
Using the External Battery Charger (N9910X–872)  . . . . . . . . . . . . . . . . . . . . . . . . . . . .797

Reconditioning Battery  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .798

Battery Care . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .798

Maximizing Battery Life . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .798

Lithium-Ion Battery Disposal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .799

34. Safety Considerations



Keysight N9938-90006 User’s Guide                                                                                                             23

For the FieldFox  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 802

For the AC/DC Adapter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 804

For the External Battery Charger (N9910X-872) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 805

For the Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 806
High Capacity Lithium Battery (N9910X-876). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 807
Standard Capacity Battery (N9910X-870). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 809

Battery Protective Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 811
Battery Protective Functions (N9910X-876) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 811
Battery Protective Functions (N9910X-870) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 813

Batteries: Safe Handling and Disposal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 814

Battery Transportation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 814

Environmental Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 815

Electrical Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 815

Electrostatic Discharge (ESD) Precautions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 815

FieldFox Markings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 815

Battery Markings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 818

Packaging Markings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 821

AC/DC Adapter Markings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 821

Certification and Compliance Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 824
Certification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 824
Manufacturer’s Declaration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 825
Declaration of Conformity  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 825
EMC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 825
Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 825
Acoustic Statement (European Machinery Directive)  . . . . . . . . . . . . . . . . . . . . . . . . . . . 825

A:.Connector Care Review

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 828

B:.Specifications/Data Sheet

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 830

C:.Instrument Calibration

How Often Should Calibrate My Instrument?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 831

How do I Get an Instrument Calibration?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 831

What Are My Choices of Instrument Calibration? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 832

D:.Korean Battery Safety Translation

E:.Russian Battery Safety Translation



24                                                                                                          Keysight N9938-90006 User’s Guide

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .844

F:. Keysight Software End-User Licensing Agreement (EULA)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .856



 25

Keysight Handheld Analyzers
N99xxB User’s Guide

1 Overview

Models and Options

Table 1-1 Models

Model Max Freq 
(GHz)

Description

N9913B 4 Vector Network Analyzer AND Spectrum RF Analyzer

N9914B 6.5 Vector Network Analyzer AND Spectrum RF Analyzer

N9915B 9 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9916B 14 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9917B 18 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9918B 26.5 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9933B 4 Spectrum Microwave Analyzer

N9934B 6.5 Spectrum Microwave Analyzer

N9935B 9 Spectrum Microwave Analyzer

N9936B 14 Spectrum Microwave Analyzer

N9937B 18 Spectrum Microwave Analyzer

N9938B 26.5 Spectrum Microwave Analyzer

N9950B 32 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9951B 44 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9952B 50 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9953B 54 Vector Network Analyzer AND Spectrum Microwave Analyzer

N9960B 32 Spectrum Microwave Analyzer

N9961B 44 Spectrum Microwave Analyzer

N9962B 50 Spectrum Microwave Analyzer

N9963B 54 Spectrum Microwave Analyzer

Minimum Frequency: 30 kHz for all VNA models; 9 kHz for all SA models (usable to 5 kHz)
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FieldFox Options: For a comprehensive list, view the FieldFox Configuration 
Guide at: 
https://www.keysight.com/us/en/assets/7018-06515/configuration-guides/
5992-3701.pdf.

Accessories
The following accessories are included with every FieldFox. Spare accessories 
can be ordered at any time. Refer to Table 1-2. Some of the optional 
accessories—not included unless requested—are listed in Table 1-3. For more, 
refer to http://www.keysight.com/find/fieldfox.

Optional Accessories

To see a complete list of accessories that are available for the FieldFox, please 
visit: http://www.keysight.com/find/fieldfox.

Table 1-2 Accessories

Accessory Part 
Number

Description

N9910X–873 AC/DC Adapter (except for US/Canada)a

a. Depending on your region, the FieldFox comes with either a 
N9910X-873 AC/DC adapter or a N9910X-877 AC/DC adapter. 

N9910X-876 Lithium-Ion Battery (High Capacity)

N9910X–877 AC/DC Adapter for US / Canada onlya

N9910X–880 Soft-case w/ Backpack & Shoulder Strap

N9910X–891 Quick Reference Guide (printed copy)

Table 1-3 Optional Accessories (partial list)

Optional Accessory 
Part Number

Description

N9910X-872 External battery charger

N9910X–886 17 mm torque wrench

N9910X-887 Replacement Fan Kit

Although not supplied, a USB keyboard and mouse CAN be used with the 
FieldFox.
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FieldFox Manuals, Software, and Supplemental Help
The following manuals and software are available for the FieldFox. 

To access all of these, visit: www.keysight.com/find/fieldfoxsupport

— User’s Guide –This manual, included with shipment.

— Quick Reference Guide – Printed copy with laminated pages for outdoor 
use included with shipment.

— Supplemental Online Help - Concepts and Reference information. 
Programming Guide – Online, off line and pdf versions.  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm

— FieldFox Data Link Software and Help – Free download. Includes help on 
editing calibration kits and cable files. Refer to  
FieldFox Data Link Software | Keysight.

— Service Guide – Free download.   
FieldFox MW VNA/SA Service Guide (keysight.com)

— Firmware Updates – Check to see if you have the latest FieldFox firmware.   
FieldFox Current Firmware (New CPU) | Keysight

Conventions that are used in the Manual

— Hardkey indicates a front panel button. The functionality of these buttons 
does not change.

The five Softkey menus change dynamically and follow these color 
conventions:

— Softkey Blue indicates an available setting.

— Softkey Green indicates a change in menu level when selected.

— Softkey Black indicates the default or selected setting.

— Softkey Yellow indicates an active entry in process.

— Softkey Grey indicates a key that is NOT available.

Safety Notes

The following safety notes are used throughout this manual. Familiarize 
yourself with each of the notes and its meaning before operating this 
instrument. More pertinent safety notes for using this product are located in 
Chapter 34, “Safety Considerations”, on page  801.

Denotes a hazard. It calls attention to a procedure that, if not correctly 
performed or adhered to, would result in damage to or destruction of the 
product or loss of important data. Do not proceed beyond a caution note 
until the indicated conditions are fully understood and met.
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Denotes a hazard. It calls attention to a procedure which, if not correctly 
performed or adhered to, could result in injury or loss of life. Do not 
proceed beyond a warning note until the indicated conditions are fully 
understood and met.
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2 Preparing for Initial Use of Your New FieldFox

Check the Shipment
When you receive your FieldFox, check the shipment according to the 
following procedure:

1. Inspect the shipping container for damage. Signs of damage may include 
a dented or torn shipping container or cushioning material that indicates 
signs of unusual stress or compacting. If not damaged, save the packaging 
material in case the FieldFox needs to be returned

2. Carefully remove the contents from the shipping container, and verify that 
the standard accessories and your ordered options are included in the 
shipment according to the Box Contents List

3. For any question or problems, refer to “Contacting Keysight” on page 5

Meeting Power Requirements for the AC/DC Adapter

The AC/DC adapter supplied with the analyzer is equipped with a three-wire 
power cord, in accordance with international safety standards. The power 
cable appropriate to the original product shipping location is included with the 
FieldFox.

Various AC power cables are available from Keysight that are unique to specific 
geographic areas. You can order additional AC power cables that are correct 
for use in different areas. For the power cord part number information please 
visit: http://www.keysight.com/find/fieldfox

Voltage: 100 VAC to 240 VAC

Frequency: 50 Hz to 60 Hz

Current: 1.5 A (100 VAC) to 0.75 A (240 VAC)
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Install the Lithium-Ion Battery

Battery Usage

When you receive your FieldFox, the lithium-ion battery is not installed, and it 
is partially charged to approximately 40% to preserve battery life. A lithium-ion 
battery has no memory effect, so it can be used partially charged, as shipped.

A fully charged battery will power your FieldFox for about four hours, so if you 
plan to use it for this long, you should fully charge the battery.

Learn more about the lithium-ion battery in Chapter 33, “Working with the 
Lithium-Ion Battery.”

Battery charge status is viewable:

— In the upper-right corner of the screen.

— On the Battery screen. To access the screen, select System, Service 
Diagnostics, and Battery.

Step Notes

1. Open the battery door Push the button on the battery compartment door while sliding the 
door outward.

2. Insert the battery. The terminals end of the battery is inserted into the compartment.

3. Close the battery door. Slide the battery compartment door upwards until it latches.

The FieldFox will shut down to prevent the battery from discharging to a 
level that is damaging. If this occurs, charge the battery either internally or 
externally.
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— On the battery. Open the FieldFox battery compartment door to view the 
battery LCD.

To conserve battery power:

— Use Run/Hold to single-trigger a measurement when needed. Hold is 
shown on the display.

— Press System then Display then Brightness. Use the  arrows, the 
rotary knob, or numeric keypad to adjust the brightness to dim the FieldFox 
display as much as possible.

— Briefly press the power button > Standby, to switch to Standby mode when 
the FieldFox is not being used. Press power button again to restore power. All 
current settings are preserved.

To recharge a battery:

Use ONLY a FieldFox charger to recharge a battery.

— The battery can be fully charged while in the FieldFox in about 4 hours with 
the FieldFox either ON or OFF.

— The battery can be fully charged externally using the external battery 
charger in about 4 hours.

— When the battery is removed, the FieldFox can still be powered by the 
AC/DC adapter.

FieldFox ON/OFF Settings

— To turn power ON, briefly press the power button. Boot-up takes about 1 
minute.

— To switch to Standby mode (low battery drain), briefly press the power 
button. See the Note above concerning Stand By.

When powered by the battery only, the FieldFox can stay in Standby mode 
for a maximum of four hours and then it powers off automatically. When 
the relative battery charge drops by about 20%, the FieldFox will power off 
to preserve the remaining charge.

The FieldFox power button shut down/standby sequence includes a 10 
second counter that allows you to either choose a softkey to immediately 
initiate the action (Standby / Shut down / Restart*), or to let the countdown 
counter expire after 10 seconds then perform the action. *Restart can only 
be enabled via the Restart softkey.
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— To turn Power OFF (very low battery drain), press the power button briefly 
and press the Shutdown softkey. Data and instrument state are NOT 
automatically saved when the FieldFox is powered OFF. Learn how to save 
data and instrument state in Chapter 32, “File Management”, on page  777. 
See the Note above concerning Shut down.

— To restart FieldFox, press the power button and press Restart. See the Note 
above concerning Restart.

— Press Cancel to exit the power down sequence.

— You can also access the power down softkey menu choices (Standby, Shut 
down, Restart, and Cancel) by using the Mode hardkey:

— Press Mode

— Then More

— Then Shut down

— You can make a setting to automatically Power ON the FieldFox when a 
power source is connected. Learn how on “Power ON” on page 767.

Power Button LED Status

FieldFox High Temperature Protection
The following features prevent degradation or damage in the event of high 
internal temperatures in the FieldFox.

How to monitor the internal FieldFox temperature:

— Press System, then Service Diagnostics.

— Then Internal Temperatures.

Solid green Power is ON

Blinking green FieldFox in Stand By mode

Blinking ambera

a. LED showing a repeating ramping-up of the intensity of the LED to indicate the 
battery is charging.

Battery charging when the FieldFox power is off

Blinking amber and green Stand By mode and battery charging

Not lit Power is Off and battery is not charging

Do NOT store the FieldFox in the soft-case while powered ON or in 
Standby mode. 
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— The average temperature that is displayed for the Internal Temperature is 
the average of the RF1, RF2, SB1, SB2 temperatures. These temperatures 
come from internal sensors embedded within the FieldFox.

The average temperature does not include the CPU or the battery 
temperatures. The FieldFox does not measure the CPU and battery 
temperatures.

Temperature Control Mode

The FieldFox’s internal temperature control preserves measurement accuracy 
and maintains the long-term reliability of the FieldFox. See also, “High-Temp 
Shutdown Warning (RTSA Mode Only)” on page 35. 

Entering Temperature Control Mode

At an average internal temperature of above approximately 64°C, the FieldFox 
enters Temperature Control mode by reducing display intensity. This should 
decrease the internal temperature which preserves measurement accuracy and 
maintains the long-term reliability of the FieldFox. Refer to Figure 2-1.

In addition, duty cycling is enabled when the internal average temperature of 
the FieldFox reaches the duty cycling threshold of above ~64°C. All 
applications (except RTSA): Power for internal circuitry is turned off between 
sweeps and delaying occurs for the next sweep. In RTSA mode, power is only 
turned off, if the FieldFox is in Single Sweep or Hold.

All applications (including RTSA): Display dims to 40% at ~64°C. 

For all modes, except RTSA mode, you will see the following messages 
displayed for ~3 seconds: 

"Automatic Meas Duty Cycling activated for thermal 
management"
Later if the temperatures are reduced:

"Temperatures reduced, ending Automatic Meas Duty Cycling"
For RTSA mode (where duty cycling is not possible), you will see the following 
messages displayed for ~3 seconds: 

"Entering Auto Protect mode for thermal management"
Later if the temperatures are reduced:

"Temperatures reduced, exiting Automatic Protect Mode"

Measurement speed specifications do NOT apply in Temperature Control 
Mode.
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Entering Auto Protect (Maximum) Threshold Temperature Mode

At above approximately 75°C, the FieldFox enters (Maximum) Auto Protect 
temperature control mode by displaying the “Entering Auto Protect mode...”. 
See also Table 2-1 on page 36.

When you enter the Auto Protect (Maximum) Threshold, the following message 
is displayed:

"Entering Maximum Auto Protect mode for thermal management"
When temperature reaches the maximum protection threshold (~75°C), some 
applications take additional measures.

Figure 2-1 Entering Auto Protect mode message (above ~64°C)—(Displays for 3 sec)

Exiting Maximum Auto Protect Threshold Temperature Mode

When the temperature drops to approximately 73.5°C, a message is displayed 
indicating that the FieldFox is leaving Temperature Control Mode and normal 
operating settings are restored (refer to Figure 2-2). See also, Table 2-1 on 
page 36.

When you exit the Auto Protect (Maximum) Threshold control mode, the 
following message is displayed:

"Temperatures reduced, exiting Maximum Auto Protect mode"

Figure 2-2 Exiting Maximum Auto Protect mode message—(~62.5°C)
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High-Temp Shutdown Warning (RTSA Mode Only)

In extreme situations, Temperature Control mode may not stop an increase in 
the FieldFox internal temperature. Just prior to shut down, the FieldFox will 
display a warning of imminent shut down and the instrument turns off. At 
above approximately 77°C, a Maximum Auto Protect message—(Top 
“WARNING...” message) displays for 9 sec. Red text at left bottom corner of 
display remains on until internal temperature returns to ~75.5°C. At above 
~78°C, High-Temperature Shut down will engage and turn OFF the FieldFox. 
Refer to Figure 2-3. See also, Table 2-1 on page 36. 

Figure 2-3 Shutdown Warning message—(above ~77°C) - (RTSA Mode Only!)
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Summary of FieldFox Average Internal Temperature Protection 
Behavior

Avoid Overpowering the FieldFox
The FieldFox can be damaged with too much power or voltage applied. 
Exceeding the maximum RF power levels shown below will cause an ADC Over 
Range message to appear on the screen.

Table 2-1 Summary of FieldFox Temperature Protection 

Threshold Average Internal 
Temperature

Description of Behavior

Duty cycling ~64°C Duty cycling is enabled when the internal average temperature of the 
FieldFox reaches the duty cycling threshold of ~64°C. Power is turned 
off between sweeps and delaying occurs for the next sweep. 

In RTSA mode power is only turned off in Single Sweep or Hold. This 
enables you to control your instrument’s temperature when you don’t 
need to make a measurement by using the “Run/Hold” hardkey to 
pause the sweep. 

All applications (including RTSA): Display dims to 40% at ~64°C. 

Maximum Protect (Initial) ~75°C When temperature reaches the maximum protection threshold 
(~75°C) some applications take additional measures. 

1 degree below shutdown 
(RTSA Mode Only)

~77°C RTSA Shutdown Warning (~77°C) — (Top “WARNING...” message 
displays for 9 sec). Red text at bottom of display remains on until 
internal temperature returns to ~75.5°C. Refer to Figure 2-3 on 
page 35.

Shutdown ~78°C Instrument shuts down.

Exit Duty Cycle ~62.5°C The temperature required to come out of the duty cycle threshold. 

Maximum Input Voltages and Power:

RF Output Connector: 50V DC, +23 dBm RF

Ext Trig/Ref Connector: 5.5 V DC

RF Input: 

    +27 dBm RF, ±50 VDC Max. (N991xA/B, N9925B, N9926A,       
      N9928A, N993xA/B)

    +23 dBm RF, ±50 VDC Max. (N9923A, N9923AN)

    +25 dBm RF, ±40 VDC Max. (N995xA/B, N996xA/B)

DC Input: 19VDC, 4ADC, 60 Watts maximum when charging battery 

Learn more about Maximum power and voltages in the FieldFox Data 
Sheet.
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Very often, coaxial cables and antennas build up a static charge, which, if 
allowed to discharge by connecting to the FieldFox, may damage the 
instrument input circuitry. To avoid such damage, it is recommended to 
dissipate any static charges by temporarily attaching a short to the cable 
or antenna prior to attaching to the FieldFox.
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Take the FieldFox Tour

Front Panel
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No. Caption Description Learn 
More:

1 Power ON: press momentarily. 

STAND BY: with FieldFox power ON, press briefly.

OFF: press and hold until the FieldFox shuts off (about 4 seconds).

“FieldFox 
ON/OFF 
Settings” 
on 
page 31

2 LED Not lit: FieldFox OFF, not charging

Green: FieldFox ON. Charging status indicated by battery icon on screen

Orange, flashing: FieldFox STAND BY 

Orange, intensity increasing, flashing slowly: FieldFox OFF, charging

“Power 
Button 
LED 
Status” 
on 
page 32

3 System Displays a sub-menu for system setup “System 
Settings” 
on 
page 725

4 Function keys Includes: Freq/Dist, Scale/Amptd, BW, Sweep, Trace, Meas 
Setup, Measure, and Mode.

Refer to 
specific 
Mode.

5 Preset Returns the analyzer to a known state “How to 
Preset the 
FieldFox” 
on 
page 727

6 Enter Confirms a parameter selection or configuration --

7 Marker Activates marker function “All about 
Markers” 
on 
page 700

8 Mkr-->Tools Displays a sub-menu for marker functions “All about 
Markers” 
on 
page 700

9 Esc Exits and closes the Active Entry dialog box or clears the character input --

10 Save/Recall Saves the current trace or recalls saved data from memory “Saving 
and 
Recalling 
Files” on 
page 778
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11 Limit Sets limit lines for quick Pass/Fail judgment “All about 
Limit 
Lines” on 
page 715

12 Run/Hold Toggles between free Run and Hold/Single operation. “Run/Hol
d” on 
page 726

13 Cal Displays a sub-menu for calibration functions “Calibrati
on 
Method 
Summary
” on 
page 146

14 Arrow keys Increases or decreases a value or setting. --

15 Returns to the previous menu selection. --

16 Rotary knob Highlights an item for selection, or enables incremental changes to values. --

17 Softkeys Allows selection of settings for configuring and performing measurements, and 
for other FieldFox functions.

--

18 Screen Transflective screen, viewable under all lighting conditions. If you are using your 
FieldFox in direct sunlight, you do not need to shield the display from the 
sunlight. In bright lighting conditions, the display is brighter and easier to read 
when you allow light to fall directly on the screen. Alternative color modes exist 
that maximize viewing in direct sunlight conditions, as well as other conditions 
such as nighttime work.

Clean the Transflective screen with gentle 
and minimal wiping using Isopropyl alcohol 
applied to a lint-free cloth.

“Screen 
Tour” on 
page 44

No. Caption Description Learn 
More:
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Top Panel

Caption Descriptions Learn More:

Port 1 
RF Output

For CAT and NA measurements, use to make reflection measurements. 
Maximum: ±50 VDC, +27 dBm RF

Also, for SA source output in SA mode.

“CAT Mode Settings” 
on page 51  
“NA Mode Settings” on 
page 91 
Chapter 9, “SA 
(Spectrum Analyzer) 
Mode (Option 
233–Mixed Analyzers)”, 
on page  147

Port 2 
SA RF Input

For SA, use to make all measurements. 

For CAT, NA, and VVM mode, use to make Port 2 transmission 
measurements.

Maximum: ±50 VDC, +27 dBm RF.

“SA Mode Settings” on 
page 151 

GPS Ant SMA (f ) connector for use with built-in GPS. Produces a settable 3.3 VDC or 
5 VDC bias voltage for the antenna pre-amplifier. Use with a GPS antenna 
such as N9910X-825. Other GPS antennas can also be used. 

“GPS” on page 746

Ref In 
Trig In

SMA (f) connector for use with Frequency Reference Source and External 
Trigger Input signal. 

Maximum: 5.5 VDC.

“Frequency Reference 
Source” on page 760. 
“Triggering” on 
page 192 



 42                                                                                                                     Keysight N9938-90006 User’s Guide

Preparing for Initial Use of Your New FieldFox
Take the FieldFox Tour

Right Side Panel

Connector Description Learn More:

Ethernet cable connector to read trace data using the FieldFox Data Link 
Software and connect to the FieldFox remotely.

Download the latest version of the software at: 
www.keysight.com/find/fieldfoxsupport 

“LAN Settings” on 
page 765

IF Out used in SA mode for external signal processing.  “IF Output” on 
page 185

Frequency Reference Source Output

Trigger Output (ERTA mode).

Chapter 25, “ERTA 
(Extended Range 
Transmission Analysis) 
Mode - Option 209”, on 
page  597

Secure Digital slot. Use to extend the memory of the FieldFox. “Saving and Recalling 
Files” on page 778

The mini-USB port can be connected to your PC’s standard USB port to 
send SCPI commands.

IMPORTANT! It is recommended that only USB 
certified cables are used with the FieldFox.

Chapter 31, “Using the 
Mini-USB Port to send 
SCPI Commands and 
Queries”, on page  775

Two standard USB connectors used to connect a power sensor for Power 
Meter Mode. Also used to save files to a USB flash drive.

IMPORTANT! It is recommended that only USB 
certified cables are used with the FieldFox.

“Saving and Recalling 
Files” on page 778
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Left Side Panel

Connector Description Learn More:

Audio output jack for use with SA Mode Tune and Listen. “Tune & Listen 
(AM/FM)” on page 166

DC Voltage Source for use with external DC Bias. “Variable Voltage 
Source (Opt. 309)” on 
page 762

DC power connector used to connect to the AC/DC adapter. Maximum: 19 
VDC, 4 ADC.

“Internal Charging with 
the AC/DC Adapter ” on 
page 795
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Screen Tour

Caption Description Learn More:

1 Title – write your own text here “Title” on page 730

2 Current Mode --

3 Run / Hold “Run/Hold” on 
page 726

4 Display Format Mode dependent

5 Scale/division Mode dependent

6 Calibration Status (CAT and NA)

Detection Method (SA)

“Cal ON? – 
Questionable 
Accuracy” on page 142

7 Velocity Factor (Fault Meas) “About Velocity Factor 
and Cable Loss” on 
page 69

8 Averaging Status and Count Mode dependent

9 Data / Mem Display (CAT and NA)  
Step / FFT (SA)

“All about Trace Math” 
on page 720 
“Resolution Bandwidth 
(Res BW)” on page 182

10 Resolution Setting Mode dependent

11 Measurement Start Freq or Distance Mode dependent
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12 Bandpass / Lowpass setting (Fault Meas)  
IF BW in NA Mode

“DTF Measurement 
Settings” on page 66

13 Output Power Level (CAT and NA) “Output Power” on 
page 57

14 Measurement Stop Freq or Distance Mode dependent

15 Actual Sweep Time Mode dependent

16 Limit Line Status “All about Limit Lines” 
on page 715

17 Time and Date “Date and Time” on 
page 746

18 Marker Readout “All about Markers” on 
page 700

19 Battery Status “Viewing the Battery 
Charge Status” on 
page 793

20 Measurement Type (CAT and NA) --

21 acquisition Mode dependent

22 Reference Position Mode dependent

Caption Description Learn More:



 46                                                                                                                     Keysight N9938-90006 User’s Guide

Preparing for Initial Use of Your New FieldFox
How to Enter Numeric Values

How to Enter Numeric Values
Many settings on the FieldFox require the entry of numeric values.

How to enter numeric values

Use any combination of the following keys:

— Numeric 0–9 keys, along with the polarity (+/-) key.

— Up/Down arrow keys to increment or decrement values.

— Rotary knob to scroll through a set of values.

— Back erases previously entered values. 

— Esc exits data entry without accepting the new value.

To complete the setting, press Enter or a different softkey or hardkey. 

Multiplier Abbreviations

Many times after entering numeric values, a set of multiplier or suffix softkeys 
are presented. The following explains the meaning of these abbreviations.

Select Frequency multipliers as follows: 

— GHz Gigahertz (1e9 Hertz)

— MHz Megahertz (1e6 Hertz)

— KHz Kilohertz (1e3 Hertz)

— Hz Hertz

Select Time multipliers as follows:

— s Seconds

— ms milliseconds (1e–3)

— us microseconds (1e–6)

— ns nanoseconds (1e–9)

— ps picoseconds (1e-12)
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Connector Care

— Never store connectors, airlines, or calibration standards loose in a box. This 
is a common cause of connector damage. 

— Install protective end caps when connectors are not in use.

— Keep connector temperature the same as the test instrument. Holding the 
connector in your hand or cleaning connector with compressed air can 
significantly change the temperature. Wait for connector temperature to 
stabilize before using in calibration or measurements.

— Do not touch the mating plane surfaces. Natural skin oils and microscopic 
particles of dirt are difficult to remove from these surfaces.

— Do not set connectors contact-end down on a hard surface. The plating and 
mating plane surfaces can be damaged if the interface comes in contact 
with any hard surface.

— Wear a grounded wrist strap and work on a grounded, conductive table 
mat. This helps protect the analyzer and devices from electrostatic 
discharge (ESD).

— Refer to “Connector Care Review” on page 827.

Because of the very small and precise mechanical tolerances of mmWave 
connectors, minor defects, damage, and dirt can significantly degrade 
repeatability and accuracy. In addition, a dirty or damaged connector can 
destroy connectors that are mated to it. For this reason, NEVER use a 
damaged connector. See also 
http://na.support.keysight.com/pna/connectorcare/Connector_Care.htm
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3 CAT (Cable and Antenna Test) Mode

In this Chapter

CAT Mode is typically used to test an entire 
transmission system, from the transmitter to the 
antenna. This process is sometimes referred to as 
Line Sweeping.

CAT Mode is similar to NA (Network Analyzer) 
Mode. Learn more in the Supplemental Online Help: 
http://na.support.keysight.com/fieldfox/help/SupH
elp/FieldFox.htm

CAT Mode Distance to Fault measurements are 
discussed in Chapter 4, “DTF (Distance to Fault) 
Measurements.”.

IMPORTANT! For CAT and NA modes, limit lines do not apply  
where F1 = F2.

“Measurement Selection” on page 51

“Quick Settings Table” on page 52

“Frequency Range” on page 53

“Scale Settings” on page 53

“Averaging” on page 54

“Smoothing” on page 55

“Single or Continuous Measure” on page 55

“Resolution (Number of Data Points)” on page 56

“Sweep Time” on page 56

“Output Power” on page 57

“Interference Rejection” on page 58

“Coupled Frequency” on page 58
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Procedures

See Also

“Return Loss Measurements” on page 60

“1-Port Cable Loss Measurements” on page 60

“2-Port Insertion Loss Measurements” on page 62

Chapter 8, “Calibration for NA, CAT, and VVM Modes”, on page  125

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720

Making 75Ω (ohm) Measurements at the FieldFox Supplemental Online Help: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm
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CAT Mode Settings
Select CAT Mode before making any setting in this chapter.

How to select CAT Mode

— Press Mode. 

— Then CAT/TDR.

Measurement Selection

How to select a CAT Mode Measurement

Learn more about the following measurements in the Supplemental Online 
Help: http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm

Press Measure   1.

Then choose one of the following: These softkeys also appear after CAT Mode 
is selected.

— Distance To Fault 1-port reflection measurement that uses Inverse Fourier 
Transform (IFT) calculations to determine and display the distance to, and 
relative size of, a fault or disruption in the transmission line. Units are in 
return loss format, expressed as a positive number in dB, unless the 
measurement selected is DTF (VSWR). Learn more about DTF 
Measurements refer to Chapter 4, “DTF (Distance to Fault) 
Measurements.”.

— Return Loss & DTF Displays both a Return Loss measurement and a DTF 
measurement. Use this format to display the frequency settings that are 
used to make the DTF measurement. The frequency range settings for these 
two measurements can be coupled or uncoupled. Learn more on page 58.

Calibrations are applied to both traces

When in Hold mode and Single sweep is performed, only the active 

trace is triggered. Use the  arrows to activate a trace

— Return Loss 1-port reflection measurement that displays the amount of 
incident signal energy MINUS the amount of energy that is reflected. The 
higher the trace is on the screen, the more energy being reflected back to 
the FieldFox. Learn how to measure Return Loss on page 60.

— VSWR (Voltage Standing Wave Ratio – also known as SWR) 1-port 
reflection measurement that displays the ratio of the maximum reflected 
voltage over the minimum reflected voltage. The higher the trace is on the 
screen, the more energy being reflected back to the FieldFox.

— DTF (VSWR) Distance to Fault in VSWR format.
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— Cable Loss (1-Port) 1-port reflection measurement that displays the loss of 
a transmission line. Learn more on page 60

— Insertion Loss (2-Port) 2-port transmission measurement that accurately 
displays the loss through a cable or other device in dB. Both ends of the 
cable must be connected to the FieldFox. NO phase information is included 
in this measurement. Learn more at “2-Port Insertion Loss Measurements” 
on page 62. This feature is available only with an option on some FieldFox 
models. For detailed information, please view the FieldFox Configuration 
Guide at: 
https://www.keysight.com/us/en/assets/7018-06515/configuration-guid
es/5992-3701.pdf.

— DTF (Lin) Distance to Fault in Linear format.

— TDR (Lin rho) The Y-axis of the display is linear, real, unitless values. A trace 
without reflections shows as 0 (zero). Maximum reflections from an open or 
short show as 1.

— TDR (ohm) The Y-axis of the display is impedance (ohms).

— TDR & DTF TDR and DTF are displayed.

Quick Settings Table

Both CAT and NA Modes allow you to view and change most relevant settings 
from a single location. All of these settings are discussed in this chapter and, 
unless otherwise noted, ALL of these settings can also be made using the 
standard softkey menus.

How to view and change Quick Settings

— Press Meas Setup   4.

— Then Settings.

— Press Next Page and Previous Page to view all settings. If these softkeys 
are NOT available, then all available settings fit on one page. 

— To change a setting:

— Use the  arrows to highlight a setting.

— Then press Edit. The current setting changes to yellow. 

— Some settings require you to press a softkey to change the value. 

Otherwise, use the numeric keypad,  arrows, or rotary knob to 
change the value.

— When finished changing a value, press Done Edit.

— Press Dock Window to relocate the Settings table to a position relative to 
the trace window. The Dock Window setting persists through a Preset. 
Choose from the following
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— Full (Default setting) Only the Settings table is shown on the screen. 
The trace window is temporarily not shown

— Left The Settings table is shown to the left of the trace window

— Bottom The Settings table is shown below the trace window

— When finished changing ALL settings, press Done to save your settings

Frequency Range

Set the range of frequencies over which you would like to make CAT Mode 
measurements

When the frequency range is changed after a calibration is performed, the cal 
becomes interpolated. Learn more in “Interpolation *” on page 142.

How to set Frequency Range

— Press Freq/Dist.

— Then choose from the following

— Start and Stop frequencies - beginning and end of the sweep.

— Center and Span frequencies – the center frequency and span of 
frequencies (half on either side of center).

— Follow each setting by entering a value using the numeric keypad,  
arrows, or the rotary knob.

— After using the keypad, select a multiplier key. Learn about multiplier 
abbreviations in Chapter 1, “Overview.” 

— After using the  arrows or the rotary knob, press Enter. The 
amount of frequency increment is based on the current span and can 
NOT be changed in CAT Mode.

Scale Settings

Adjust the Y-axis scale to see the relevant portions of the data trace. The Y-axis 
is divided into 10 graticules.

This setting can be changed at any time without affecting calibration accuracy.

How to set Scale

— Press Scale / Amptd.

— Then choose from the following three methods:

1. Autoscale Automatically adjusts the Y-axis to comfortably fit the 
Minimum and Maximum amplitude of the trace on the screen.

2. Set Scale, acquisition, and Reference Position:
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— Scale Manually enter a scale per division to view specific 
areas of the trace

— Ref Level Manually set the value of the reference line. 
Enter a negative value by pressing Run/Hold (+/-) either 
before or after typing a value

— Ref Pos Manually set the position of the reference line. 
Values must be between 0 (TOP line) and 10 (BOTTOM 
line)

3. Set Top and Bottom graticule values. The scale per division is 
calculated.

— Top to set the value of the Top graticule.

— Bottom to set the value of the Bottom graticule.

— Enter a negative value by pressing Run/Hold (+/-) either 
before or after typing a value.

Averaging

Trace Averaging helps to smooth a trace to reduce the effects of random noise 
on a measurement. The FieldFox computes each data point based on the 
average of the same data point over several consecutive sweeps.

Average Count determines the number of sweeps to average; the higher the 
average count, the greater the amount of noise reduction. 

An average counter is shown in the left edge of the screen as Avg N. This 
shows the number of previous sweeps that have been averaged together to 
form the current trace. When the counter reaches the specified count, then a 
‘running average’ of the last N sweeps is displayed. Average Count = 1 means 
there is NO averaging. 

This setting can be changed at any time without affecting calibration accuracy.

Scale annotation on the FieldFox screen

Reference Line = red arrow

Ref Level = -40 dB

Ref Position = 1 

Scale = 2 dB per division

Averaging is often used to increase the dynamic range of a measurement. 
To achieve the highest dynamic range, select NA mode and reduce the IF 
Bandwidth setting. Learn more about dynamic range in “Increase Dynamic 
Range” on page 112.
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How to set Trace Averaging

— Press BW   2.

— Then Average N where N is the current count setting.

— Enter a value using the numeric keypad. Enter 1 for NO averaging.

— Press Enter.

— While Trace Averaging is in process, press Sweep 3 then Restart to restart 
the averaging at 1.

Smoothing

Trace smoothing averages a number of adjacent data points to smooth the 
peak-to-peak noise values on a displayed trace. The number of adjacent data 
points that are averaged is known as the smoothing aperture. Aperture is set 
by specifying a percentage of the X-axis span.

Trace smoothing does NOT significantly increase measurement time.

Smoothing can be used with any CAT format.

When enabled, Smo appears on the FieldFox screen.

How to set Smoothing

— Press BW   2.

— Then Smoothing ON OFF.

— Then Sm. Aperture and enter a value between 0 and 25 (percent) using the 
numeric keypad.

— Press Enter.

Single or Continuous Measure

This setting determines whether the FieldFox sweeps continuously or only once 
each time the Single button is pressed. Use Single to conserve battery power 
or to allow you to save or analyze a specific measurement trace.

This setting can be changed at any time without affecting calibration accuracy.

How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

— Single   Automatically sets Continuous OFF and causes FieldFox to 
make ONE sweep, then hold for the next Single key press. Hold is 
annotated in the upper left corner of the display when NOT sweeping, 
and changes to an arrow --> while the sweep occurs
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— Continuous   Makes continuous sweeps. This is the typical setting 
when battery power is not critical.

You can also use Run / Hold +/- to toggle between Single and Continuous.

Resolution (Number of Data Points)

Data points are individual measurements that are made and plotted across the 
X-axis to form a trace. Select more data points to increase measurement 
resolution. However, more data points require more time to complete an entire 
measurement sweep

When the Resolution is changed after a calibration is performed, the cal 
becomes interpolated. Learn more in “Interpolation *” on page 142

How to set Resolution

— Press Sweep   3.

— Then Resolution.

— Then choose one of the following: 
101 | 201 | 401 | 601 | 801 | 1001 |1601 | 4001 | 10001.

— Using SCPI, Resolution can be set to any number of points between 3 and 
10001. See the Programming Guide at 
https://www.keysight.com/us/en/lib/resources/service-manuals/keysigh
t-fieldfox-library-help-and-manuals-2153870.html.

Sweep Time

The fastest possible sweep time is always used as the default setting. Use the 
Min Swp Time setting to slow the sweep time when measuring long lengths of 
cable. 

Learn more in the FieldFox Supplemental Help at: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm

The actual sweep time is shown on the FieldFox screen. See “Take the FieldFox 
Tour” on page 38. To increase the sweep time, enter a value that is higher than 
the actual sweep time. The increase will not be exactly the amount that you 
enter, as the actual sweep time is the composite of many factors.

How to set Sweep Time

— Press Sweep   3.

— Then Min Swp Time.

— Enter a value using the numeric keypad.

Measurement speed specifications do NOT apply in Temperature Control 
Mode. Learn more in Chapter 1, “Overview.”
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— Press a multiplier key. Learn more in “Multiplier Abbreviations” on page 46.

Output Power

Set the power level out of the FieldFox to High, Low, or manually set power 
level to a value between High and Low. 

Generally, the high power setting is used when measuring passive, high-loss 
devices to place the signal farther from the noise floor. Increasing the power 
can also help reduce trace noise. However, for devices that are sensitive to 
high power levels such as amplifiers, use the Low power setting. 

For best measurement accuracy, use the Manual power setting at -15 dBm. 
After calibration, the power level can be decreased for amplifiers, or increased 
for higher dynamic range.

How to set Output Power

— Press Meas Setup 4.

— Then Power

— Then Output Power

— High Sets output power to the maximum achievable power at all 
displayed frequencies. Output power is NOT FLAT across the 
displayed FieldFox frequency span. Use the High power setting, when 
better dynamic range and lower noise is desired. Please see 
“Specifications/Data Sheet” on page 829 for expected power levels.

— Low Sets output power to approximately –50dBm, FLAT across the 
displayed FieldFox frequency span.

— Man (Default setting) Sets the output power to –15 dBm, FLAT across 
the displayed FieldFox frequency span. If flattened power can NOT be 
achieved, a warning message and beep occurs. To achieve a 
flattened output power, reduce the power level or stop frequency.

— Then press Power Level 

— Then enter a value using the numeric keypad, the  arrows, or the 
rotary knob.

— Press Enter.

Power Level settings in this mode will NOT change Power Level settings in 
other modes. To help prevent damage to your DUT, use caution when 
changing modes with your DUT connected to the FieldFox test ports.
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Interference Rejection

Use this setting when you suspect that other signals in the area are interfering 
with a measurement. Interference may look like a spike or lack of stability in the 
measurement trace. While monitoring a measurement at a specific frequency, 
toggle this setting between ON and OFF. If the measurement result decreases 
while ON, then there is an interfering signal in the area. Continue to make 
measurements with Interference Rejection ON. However, this will slow the 
measurement speed.

Once enabled, up to SIX sweeps may be required before the interfering signal 
is neutralized.

This setting can be changed at any time without affecting calibration accuracy.

How to set Interference Rejection

— Press Meas Setup 4.

— Then Interference Rejection [current setting].

— Then choose from the following: 

— Off No interference rejection and fastest possible sweep speed

— Minimum The lowest level of Interference rejection.

— Medium The medium level of Interference rejection.

— Maximum The highest level of Interference rejection.

Coupled Frequency

This setting, especially useful for a Return Loss & DTF measurement, allows 
both measurements to have different frequency ranges.

How to set Coupled Frequency

With a Return Loss & DTF measurement present:

— Press Meas Setup 4.

— Select the DTF measurement (Tr2) using the  arrows.

— Then choose from the following:

— Coupled Freq ON - Both the Return Loss and DTF traces have the same 
frequency range settings.

— Coupled Freq OFF (default setting) - Both traces are allowed to have 
individual frequency range settings. When set to OFF:

— The Return Loss measurement frequency settings are made in the 
usual manner. Learn how at “Frequency Range” on page 53. When a 
new Start or Stop frequency is selected, Coupled Frequency is 
automatically set to OFF.
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— The DTF measurement is made using the frequencies as determined 
by the DTF Frequency Mode setting. Learn more in “DTF 
Measurement Settings” on page 66.
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Return Loss Measurements
Return loss can be thought of as the absolute value of the reflected power 
compared to the incident power.

When measuring an OPEN or SHORT, all incident power is reflected and 
approximately 0 dB return loss is displayed.

When measuring a LOAD, very little power is reflected and values of 40 dB to 
60 dB are displayed.

The minus sign is usually ignored when conveying return loss. For example, a 
component is said to have 18 dB return loss, rather than –18 dB.

How to Measure Return Loss

— Connect the jumper cable or any adapter used to connect the device under 
test (DUT).

— Select Preset then Preset Returns the FieldFox to known settings

— Select Mode then CAT/TDR (Cable and Antenna Test)

— Then Return Loss (Default measurement).

— Press Freq/Dist and enter Start and Stop frequency values of the 
measurement.

— Press Meas Setup 4 then Settings to make appropriate settings before 
calibrating.

— Disconnect the jumper cable or DUT and press Cal 5 then follow the 
calibration prompts.

— Reconnect the jumper cable or DUT.

— The return loss trace is displayed on the FieldFox screen.

1-Port Cable Loss Measurements
While all cables have inherent loss, weather and time will deteriorate cables 
and cause even more energy to be absorbed by the cable. This makes less 
power available to be transmitted.

A deteriorated cable is not usually apparent in a Distance to Fault 
measurement, where more obvious and dramatic problems are identified. A 
Cable Loss measurement is necessary to measure the accumulated losses 
throughout the length of the cable.
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A 2-port Insertion Loss measurement is usually more accurate than a 1-port 
Cable Loss measurement. However, to perform a 2-port Insertion Loss 
measurement, both ends of the cable must be connected to the FieldFox.

How to make a 1-port Cable Loss Measurement

1. Press Preset then Preset.

2. Then More then Cable Loss (1-Port)

3. Connect the cable to be tested.

4. Press Freq/Dist and enter Start and Stop frequency values of the 
measurement.

5. Press Sweep 3 then Min Swp Time. Increase the Sweep Time until a stable 
trace is visible on the screen. The amount of time that is required increases 
with longer cable lengths. Learn more in the Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

6. Remove the cable to be tested.

7. Press Cal 5, then Mechanical Cal. Mechanical Cal.

8. Follow the prompts to perform calibration at the end of the jumper cable 
or adapter. Learn more about Calibration in “How to Perform a 
Calibration” on page 127 

9. Connect the cable to be tested.

10.Connect a LOAD at the end of the cable to be tested. This limits the 
reflections to faults that are located in the cable under test.

11.Press Trace 6 then Math and Memory then Data->Mem to store the trace 
into Memory.

12.Remove the LOAD and leave the end of the cable to be tested open.

13.Press Data Math then Data – Mem. The ripple in the measurement is 
removed. These minor imperfections in the cable should not be considered 
in the Cable Loss measurement.

In high-loss conditions, a Cable Loss measurement becomes ‘noisy’ as the 
test signal becomes indistinguishable in the FieldFox noise floor. This can 
occur when measuring a very long cable and using relatively high 
measurement frequencies. To help with this condition, use High Power 
(page 57) and Averaging. (page 54).

Low-level standing waves (also known as ‘ripple’) which may be visible in 
reflection measurements, can hide the actual loss of the cable. Steps 10 
through 13 can minimize the ripple. Perform the measurement with and 
without steps 10 through 13 and choose the method with the least amount 
of ripple.
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14.Use Averaging to remove random noise from high-loss measurements. 
Press BW 2 then Average.

The displayed trace shows the Cable Loss values in one direction through the 
cable. A Return Loss measurement would show the loss for both down the 
cable and back. Therefore, a Cable Loss measurement is the same as a Return 
Loss measurement divided by 2.

The average Cable Loss across the specified frequency range is shown on the 
screen below the graticules.

2-Port Insertion Loss Measurements
A 2-port Insertion Loss measurement is used to measure the loss through a 
DUT (device under test) – or cable – over a specified frequency range. The 
FieldFox signal source is transmitted out the RF OUT connector, through the 
DUT, and into the RF IN connector. Both ends of the DUT must be connected 
to the FieldFox, either directly or indirectly using the cable used in the 
normalization cal.

‘Insertion’ loss simply means loss through a device, usually expressed in dB. It 
is exactly the same measurement as “S21 Transmission” in NA Mode.

2-port Insertion Loss measurements are generally more accurate than 1-port 
Cable Loss measurements.

How to make a 2-port Insertion Loss Measurement

— Press Mode then CAT.

— Then More then Insertion Loss (2-Port).

— Press Freq/Dist and enter Start and Stop frequency values of the 
measurement. 

— Press Sweep 3, then select a Resolution setting.

— Press Cal 5, then perform a calibration. Learn more on “How to Perform a 
Calibration” on page 127.

— Connect the DUT and view the insertion loss measurement results.

When measuring very long lengths of cable, it may be necessary to increase 
the sweep time. Learn how on page 56. Learn why in the Supplemental Online 
Help: http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

Exception: In CAT mode, if the TDR data are saved in S1P format, the 
values represent the real part of the complex transform; the imaginary part 
is set to zero. To obtain complex data, either as real/imaginary or 
magnitude/phase pairs, use NA mode.
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4 DTF (Distance to Fault) Measurements

CAT Mode Distance to Fault (DTF) measurements are generally used to locate 
problems, or faults, in a length of cable or transmission line. In this chapter, the 
cable to be tested is referred to as the DUT (Device Under Test).

Settings that are NOT unique to DTF measurements are documented in the 
CAT Mode Chapter 3, “CAT (Cable and Antenna Test) Mode.”

In this Chapter

“How to make DTF Measurements” on page 64

“DTF Settings Table” on page 66

“DTF Measurement (Format)” on page 66

“DTF Start and Stop Distance” on page 67

“Frequency Mode” on page 67
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Optional settings

How to make DTF Measurements
Before starting, you may need the following:

— Jumper cable or adapter to connect the beginning of the DUT to the 
FieldFox.

— LOAD with correct connector type and gender to terminate the end of the 
DUT (if possible).

— The known length and cable type of the DUT. If the cable type is not known, 
then the Cable Loss (dB/Meter) and Velocity Factor of the DUT are required.

1. Connect any necessary jumper cable or adapter to the FieldFox RF OUT 
port. Do NOT connect the DUT.

2. Press Preset then Preset to return the FieldFox to the default settings.

3. Then Mode then CAT. 

4. Then Meas 1 then DTF.

5. Press Freq/Dist, then Stop Distance and enter the length of the DUT. You 
can optionally set the Start Distance

6. Press Cal 5 and follow the Cal prompts. Learn all about Calibration in 
“How to Perform a Calibration” on page 127.

7. Disconnect any components or antenna that should NOT be measured and 
connect a LOAD at the end of the DUT.

8. Press Meas Setup 4 then DTF Cable Specifications.

“Coupled Frequency” on page 68

“Cable (Correction) Specifications” on page 69

“Window Settings” on page 72

“DTF Units” on page 73

“Calculated DTF values” on page 73

“About Alias Faults” on page 73

“All about Markers” on page 700

“All about Limit Lines” on page 715

“Saving and Recalling Files” on page 778

Trace Math is NOT available in DTF Measurements.
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9. Either press Edit/Save/Recall Cables then Recall Cable, or directly enter 
the Velocity Factor/Cable Loss of the DUT using the Velocity Factor and 
Cable Loss keys.

10. Connect the start end of the DUT to the FieldFox.

11. Press Meas Setup 4 then Settings then Next Page. If the Alias-free Range 
setting is False, then you may see Alias faults on the screen. Learn more 
on page 73.
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DTF Measurement Settings

DTF Settings Table

You can set and view all of the DTF settings, including some calculated values, 
on the DTF Settings table. Learn about the calculated values in “Calculated 
DTF values” on page 73.

How to make settings on the DTF settings table

— Press Meas Setup 4.

— Then Settings.

— Press Next Page and Previous Page to view all settings. 

— To change a setting:

— Use the  arrows or rotary knob to highlight a setting.

— Numeric settings can be changed by pressing numbers using the 
numeric keypad. Then press Enter or select a suffix if available.

— Other settings require you to press Edit, then press a softkey to 
change the value.

— When finished changing a value, press Done Edit.

— Press Dock Window to relocate the Settings table to a position relative to 
the trace window. The setting persists through a Preset. Choose from the 
following:

— Full (Default setting) Only the Settings table is shown on the screen. 
The trace window is temporarily not shown.

— Left The Settings table is shown to the left of the trace window.

— Bottom The Settings table is shown below the trace window.

— When finished changing ALL settings, press Done to save your settings.

DTF Measurement (Format)

You can select from 3 different DTF Formats.

— Press Measure 1 

— Then choose from:

— Distance to Fault (dB) Faults are displayed on the Y-axis in return 
loss format, expressed as a positive number in dB.

— DTF (VSWR) Faults are displayed on the Y-axis in SWR. Learn more 
about SWR at the FieldFox Supplemental Online Help: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.ht
m 
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— More then DTF (Lin) Faults are displayed on the Y-axis in linear 
(unitless) format.

DTF Start and Stop Distance

In DTF measurements, you set the physical length of cable or other device to 
be tested. The FieldFox calculates the frequency range of the measurement 
from this distance. The longer the cable to be tested, the lower the frequencies 
that are used. You can also set the frequencies manually using the Frequency 
Mode [Bandpass] setting.

How to set Start and Stop Distance

— With a DTF measurement present, press Freq/Dist. 

— Then choose from the following:

— Start Distance Enter a value using the numeric keypad, the  
arrows, or the rotary knob, then Enter. By default, the Start Distance 
is set to 0 Meters. This means that the measurement will display 
faults starting at the point at which calibration standards are 
connected. 

— Stop Distance Enter a value between the start distance and 5 km (or 

16,404 ft.) using the numeric keypad, the  arrows, or the rotary 
knob, then Enter.

Frequency Mode

All DTF measurements are made with frequency settings and, using Inverse 
Fourier Transform (IFT), the time and distance to faults are calculated.

How to set Frequency Mode

With a DTF measurement present,

— Press Meas Setup 4

— Then Frequency Mode 

— Choose one of the following:

— Lowpass The frequency range of a DTF measurement is set 
automatically based on the Start and Stop Distances. Use Lowpass 
mode when the DUT is a cable ONLY.

The start and stop frequencies for the measurement are always annotated 
on the screen below the start and stop distances.
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— Bandpass (Default setting) The frequency range of a DTF 
measurement is set manually. Use Bandpass mode when the DUT 
contains a diplexer or other filtering device which does not pass 
some frequencies. 

Typically, you will set the frequency range of the measurement to the passband 
of the filter. However, you may also want to test the ability of the filter to reject 
unwanted frequencies. In this case, set the frequency range to include those 
frequencies which the filter may not be adequately rejecting.

How to manually set Frequencies in Bandpass Mode

— Press Freq/Dist 

— Then Min Start Freq and type the start frequency to use for the DTF 
measurement.

— Then Max Stop Freq and type the stop frequency to use for the DTF 
measurement.

— OR 

— Press More

— Then Max Freq Span and type the frequency range to use for the DTF 
measurement.

— Then Center Frequency and type the center frequency of the range to use 
for the DTF measurement. 

When the DTF frequencies are set manually, they may not be the optimum 
frequencies for measuring the distance to fault. The distance may no longer be 
alias-free. Learn more about alias-free range on page 73.

These settings specify the minimum and maximum frequencies to be used for 
the DTF measurement. These exact frequencies may not be used, but a 
narrower frequency range may be used that will still pass through the 
bandpass filter.

Coupled Frequency

When a Return Loss & DTF measurement is present, this setting allows you to 
have different frequency ranges for each measurement. Learn more in 
“Coupled Frequency” on page 58.
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Cable (Correction) Specifications

By default, the FieldFox does NOT correct DTF measurements to account for 
the inherent loss of a cable. However, to make more accurate DTF 
measurements, the Cable Loss and Velocity Factor values should be 
considered.

About Velocity Factor and Cable Loss

— Velocity Factor is a property of the physical material of a cable. A VF of 1.0 
corresponds to the speed of light in a vacuum, or the fastest VF possible. A 
polyethylene dielectric cable has VF = 0.66 and a cable with PTFE dielectric 
has VF = 0.7.

— Cable Loss is specified in dB/meter. In addition to the length of the cable, 
loss is also directly proportional to the frequency of the signal that passes 
through the cable.

The following is an example showing how DTF cable correction works:

The DUT is a 100 meter transmission cable. The Cable Loss value is 
0.1 dB/meter.  This means that a signal traveling ONE WAY through the cable 
will lose 10 dB of power (100 m * 1dB/m). Because the FieldFox performs this 
measurement with 1 port, the test signal travels down the cable and then back, 
for a total loss of 20 dB.

After a calibration has been performed, for the purpose of illustrating this 
point, connect an OPEN to the end of the cable – a maximum-sized fault - for 
100% reflection of the 300 MHz test signal.

Without compensation for the loss of the cable, a –20 dB response would be 
visible at 100 meters, which is the OPEN at the end of the DUT. This is from 
10 dB of loss through the cable in each direction.

With compensation for the loss using the manufacturer’s specification, the 
FieldFox compensates the trace as though the signal traveling through 100 
meters was increased by +20 dB.  Therefore the response will show 0 dB for 
100% reflection.

How to enter Cable Loss and Velocity Factor

Cable Loss and Velocity factor can be entered using one of the following 
methods:

— Manually enter cable loss and velocity factor for the measurement.

— Select or create a cable file which contains the cable loss and velocity 
factor.

With a DTF measurement present:

The following describes Coax Media type. However, you can create or edit 
Waveguide Media Standards. Learn how in “Waveguide Calibrations” on 
page 139.
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— Press Meas Setup 4.

— Then DTF Cable Specifications

— Select Cable Corr

— Auto Use Cable Loss and Velocity Factor values from a Cable file. See 
“How to Edit, Save, and Recall a Cable File” below. This will overwrite 
a manually-entered value.

— Man (Default setting) Manually enter a value for Cable Loss and 
Velocity Factor.

— Then:

— Velocity Factor Using the numeric keypad, enter a value between 
0.01 and 1. Then press Enter. 

— Cable Loss Using the numeric keypad, enter a positive Cable Loss 
value in dB/m, then press Enter. 

How to Edit a Cable File 

The FieldFox includes many predefined cable files with the manufacturer’s 
specifications. You can edit these files or create new cable files using the 
following procedure or using the FieldFox Data Link Software.

The Cable correction data survives a Mode Preset and Preset.

With a DTF measurement present:

— Press Meas Setup 4

— Then DTF Cable Specifications

— Then Edit/Save/Recall Cables 

— Press New Cable then Yes to clear all data from the existing DTF Cable 
table and reset header information to default settings.

— Then Edit Cable to open the Cable Editor.

— Then use the  arrows to select a field,

— When editing Cable Description information, press Edit then modify 
the selected field using the FieldFox labeler. 

— When editing Frequency/Loss pairs, enter numbers using the 
numeric keypad, then select a frequency suffix. Then Enter. Learn 
more about “How the Freq/Loss pairs are applied” below.

— Optionally choose from the following:

— Previous / Next Page Quickly scrolls through pages of Freq/Loss 
data.

— Add Data Add a blank Freq/Loss pair to the table,
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— Delete/Clear then:

— Delete Row Remove the selected Freq/Loss pair from the table. 

— Clear All then Yes. Remove all Freq/Loss pairs from the table and 
resets header information

— Press Done to close the Cable Editor.

How to Save or Recall a Cable

— Press Save Cable to saves your changes to the specified Storage Device. 
Enter a filename using the FieldFox labeler (learn more on “How to use the 
FieldFox labeler ” on page 780). Learn more about Cable files below.

— Press Recall Cable to load a Cable file from the specified Storage Device

— Storage Device Changes the device used to save or recall Cable files. This 
is a different setting from the Save/Recall Storage Device setting. Choose 
from Internal (default setting), USB (must be connected) or SD card.

About Cable files

— Cable files are saved to, and recalled from, the Cables folder. If the folder 
does not already exist on a USB or SD card, it is created automatically 
before storing the file.

— Cable files are stored as *.xml files. Existing cable files that are preloaded 
into the FieldFox firmware can be overwritten. Your edited file will NOT be 
overwritten when firmware is updated.

— To DELETE a Cable file, use the Manage Files feature. Learn more in 
“Manage Files” on page 786.

How the Freq/Loss pairs are applied

When the cable file contains one Freq/Loss pair, that correction value is 
applied to the entire displayed frequency span.

When the cable file contains two or more Freq/Loss pairs, the Loss value that is 
used is interpolated from the Freq/Loss pairs and the DTF center frequency. 
For example, using a cable file with the following Freq/Loss pairs:

1 GHz: 0.1 dB/m

2 GHz: 0.2 dB/m
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The center frequency for the measurement is determined from the 
calculated (Stop – Start) frequency values (seen on the second page of 
DTF Settings):

The Loss value for the measurement is interpolated from the Freq/Loss pairs at 
the Center Freq:

The correction for loss at 5 meters in one direction: 0.18 dB/m * 5m = 0.9 dB. 

All DTF measurements correct for loss for travel down the DUT and back, so 
double the correction: 0.9 dB * 2 = 1.8 dB.

Window Settings

Window settings provide the ability to choose between optimizing DTF 
measurements for resolving closely-spaced faults or for the ability to measure 
low-level faults.

How to select Window settings

— Press Meas Setup 4.

— Then Settings.

— Then press  arrows to move to the Window row.

— Then press Edit.

— Then press Window and choose from the following:

— Maximum (Maximum – Optimized for dynamic range) the noise floor 
is lowered to provide the ability to measure low-level responses. 
(Default setting)

— Medium – Compromise between Minimum and Maximum window 
settings. 

— Minimum – Best Response Resolution, providing the ability to resolve 
between two closely-spaced responses.

— Then press Done Edit.

— Again press Done.

Calculated Start = 2.0 MHz

Calculated Stop = 3.598 GHz

Center Freq = 1.80 GHz

1 GHz = 0.1 dB/m

1.8 GHz = 0.18 dB/m

2 GHz = 0.2 dB/m
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DTF Units

The DTF Units setting is available ONLY on the DTF Settings table.

By default, X-axis units for DTF measurement settings are displayed in Meters.

How to change DTF units

— With a DTF measurement present, press Freq/Dist. 

— Then More then Distance Unit m feet. 

— The current selection is underlined m (meters) Feet.

Calculated DTF values

Press Next Page on the DTF Settings Table to view the following calculated 
Values noted on the FieldFox screen with c - <setting>

Start Frequency – Start frequency that is used to calculate DTF. 

Stop Frequency – Stop frequency that is used to calculate DTF.

Range Resolution. Indicates the accuracy of the distance to fault 
measurement. For example, with range resolution of 500 mm, if the distance to 
fault is 10 meters, this value could be inaccurate by +/- 500 mm or between 
9.5 to 10.5 meters. This value is calculated from frequency span / resolution 
(points).

Response Resolution, not displayed, indicates the distance that could be 
between two faults and still show as separate faults. Learn more in “Window 
Settings” on page 72.

Maximum Distance. The distance that could be viewed with the current 
settings. Defined by: Vf*c*Points/(2*Bandwidth) where:

— Vf = velocity factor

— c = speed of light

— Points = resolution

— Bandwidth = frequency range

Alias-free Range (On/Off)

— On = No Alias images

— Off = Alias images may appear in the response.

About Alias Faults

An alias fault is not a true device response. An alias fault appears because of 
the method used to convert frequency to time.

On the DTF Settings page (above) the c - Alias-free Range = Off setting 
indicates alias images MAY appear on the screen.
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Shorter stop distances (less than 10 meters) and a higher resolution (1001 
points) will be more likely to result in Alias-free Range = Off.

When the Alias-free Range = Off, the following procedure will help to 
determine if a response is true or an alias response: 

1. Put a marker on the response in question and note the distance to the 
fault. 

2. Change the start or stop distance. 

A true fault response will not move in distance. That is, if a true fault is present 
at 10.3 meters, changing the stop distance from 15 m to 20 m will not move 
the fault; the fault will remain at 10.3 meters. However, an alias response will 
appear to move.

An un-terminated cable (with NO perfect load at the end) will show faults that 
appear to be beyond the end of the cable. These are NOT alias faults. These 
faults appear as the signal reflects off the open at the end of the cable and 
travels back down the cable toward the connection at the FieldFox. 
Re-reflections are measured at the FieldFox as mirror images of the original 
faults. The largest fault is the open end of the cable. To avoid confusion, set 
the Stop distance shortly after that fault.
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CAT Mode Time Domain Reflectometry (TDR) measurements are generally 
used to locate problems, and identify the type of problem, in a length of cable 
or transmission line.

Settings that are NOT unique to TDR measurements are documented in 
Chapter 3, “CAT (Cable and Antenna Test) Mode”, on page  49.

In this chapter, the cable to be tested is referred to as the DUT (Device Under 
Test).

In this Chapter

“TDR Measurement (Format)” on page 78

“TDR Settings Table” on page 78

“TDR Start and Stop Distance” on page 79

“TDR Sweep” on page 79
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Optional Settings

How to make TDR Measurements

Before starting, you may need the following:

— Jumper cable or adapter to connect the beginning of the DUT to the 
FieldFox.

— LOAD with correct connector type and gender to terminate the end of the 
DUT (if possible).

— The known length and cable type of the DUT. If the cable type is not known, 
then the Cable Loss (dB/Meter) and Velocity Factor of the DUT are required.

1. Connect any necessary jumper cable or adapter to the FieldFox RF 
OUT port. Do NOT connect the DUT.

2. Press Preset then Preset to return the FieldFox to the default settings.

3. Then Mode then CAT/TDR. 

4. Then Meas 1 then More then DTF (Lin) or TDR (Lin rho) or (ohm).

5. Press Freq/Dist, then Stop Distance and enter the length of the DUT. You 
can optionally set the Start Distance

6. Press Cal 5 and follow the Cal prompts. Learn all about Calibration in 
“How to Perform a Calibration” on page 127.

7. Disconnect any components or antenna that should NOT be measured and 
connect a LOAD at the end of the DUT.

8. Press Meas Setup 4 then DTF Cable Specifications.

“Frequency Mode” on page 80

“Cable (Correction) Specifications” on page 81

“Window Settings” on page 84

“TDR Units” on page 85

“Calculated TDR values” on page 85

“About Alias Faults” on page 86

“How to Prevent Undersampling” on page 87

“All about Markers” on page 700

“All about Limit Lines” on page 715

“Saving and Recalling Files” on page 778

Trace Math is NOT available in DTF Measurements.
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9. Either press Edit/Save/Recall Cables then Recall Cable, or directly enter 
the Velocity Factor/Cable Loss of the DUT using the Velocity Factor and 
Cable Loss keys.

10. Connect the start end of the DUT to the FieldFox.

11. Press Meas Setup 4 then Settings then Next Page. If the Alias-free Range 
setting is Off, then you may see Alias faults on the screen. Learn more in 
“About Alias Faults” on page 86
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TDR Measurement Settings
Select CAT Mode, then TDR before making any setting in this chapter.

How to select CAT Mode

— Press Mode.

— Then CAT/TDR.

TDR Measurement (Format)

You can select from 3 different TDR Formats.

— Press Measure 1 

— Then More.

— Then choose from:

— TDR (Lin rho) The Y-axis of the display is linear, real, unitless values. 
A trace without reflections shows as 0 (zero). Maximum reflections 
from an open or short show as 1.

— TDR (ohm) The Y-axis of the display is impedance (ohms).m 

— DTF (Lin) The Y-axis of the display is linear, real, unitless values. 
X-Axis displays distance to fault in meters.

— TDR & DTF TDR and DTF are displayed.

TDR Settings Table

You can set and view all of the TDR settings, including some calculated values, 
on the TDR Settings table. Learn more in “Calculated TDR values” on page 85.

How to make settings on the TDR settings table

— Press Meas Setup 4.

— Then Settings.

— Press Next Page and Previous Page to view all settings. 

— To change a setting:

— Use the  arrows or rotary knob to highlight a setting.

— Numeric settings can be changed by pressing numbers using the 
numeric keypad. Then press Enter or select a suffix if available.

— Other settings require you to press Edit, then press a softkey to 
change the value.

— When finished changing a value, press Done Edit.
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— Press Dock Window to relocate the Settings table to a position relative to 
the trace window. The setting persists through a Preset. Choose from the 
following:

— Full (Default setting) Only the Settings table is shown on the screen. 
The trace window is temporarily not shown.

— Left The Settings table is shown to the left of the trace window.

— Bottom The Settings table is shown below the trace window.

— When finished changing ALL settings, press Done to save your settings.

The following TDR settings are available ONLY on the settings table:

Mkr Format – The format of marker readout. Choose from:

— Z Magnitude – Impedance (magnitude only)

— Default – The current TDR measurement format.

Auto: Max Freq – When TDR Sweep is set to Auto, this is the maximum stop 
frequency of the measurement. The minimum value of this setting is 100 MHz.

TDR Start and Stop Distance

In TDR measurements, you set the physical length of the DUT. The FieldFox 
calculates the frequency range of the measurement from this distance. The 
longer the DUT, the lower the frequencies that are used.

You can NOT set the frequencies manually in TDR. However, you CAN limit the 
maximum frequency using the TDR Sweep setting. Learn more in “TDR Sweep” 
on page 79.

How to set Start and Stop Distance

— With a TDR measurement present, press Freq/Dist. 

— Then choose from the following:

— Start Distance Enter a value using the numeric keypad, the  
arrows, or the rotary knob, then Enter. By default, the Start Distance 
is set to 0 Meters. This means that the measurement will display 
faults starting at the point at which calibration standards are 
connected. 

— Stop Distance Enter a value between the start distance and 5 km (or 

16,404 ft.) using the numeric keypad, the  arrows, or the rotary 
knob, then Enter.

TDR Sweep

This setting allows you to choose the method by which the Stop Frequency and 
Resolution are set.
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— Press Sweep 3

— Then TDR Sweep 

— Choose one of the following:

—  Auto Low pass frequency settings are calculated based on the 
current number of points. The Stop Frequency and Resolution 
settings can be changed to any value.

——To set Stop Frequency, press Meas 4, then Settings, then 
scroll to Auto: Max Freq. 

——To set Resolution, press Sweep 3, then Resolution.

— Cable Provides a higher resolution measurement. Use when 
under-sampling is suspected. The Stop Frequency is limited to 500 
MHz maximum. The Resolution is fixed to 1601.

Frequency Mode 

All TDR measurements are made with frequency settings and, using Inverse 
Fourier Transform (IFT), the time and distance to faults are calculated.

How to set Frequency Mode

With a TDR measurement present,

— Press Meas Setup 4

— Then Freq Mode 

— Choose one of the following:

— Lowpass The frequency range of a TDR measurement is set 
automatically based on the Start and Stop Distances. Use Lowpass 
mode when the DUT is a cable ONLY.

— Bandpass This setting changes the measurement to DTF. Bandpass 
is NOT ALLOWED with TDR because the DC component is required 
for TDR measurements. 

Because of its greater measurement accuracy, Cable is the default setting. 
Refer to “Preferences” on page 740.

The start and stop frequencies for the measurement are always annotated 
on the screen below the start and stop distances.
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Cable (Correction) Specifications

By default, the FieldFox does NOT correct TDR measurements to account for 
the inherent loss of a cable. However, to make more accurate TDR 
measurements, the Cable Loss and Velocity Factor values should be 
considered.

About Velocity Factor and Cable Loss

— Velocity Factor is a property of the physical material of a cable. A VF of 1.0 
corresponds to the speed of light in a vacuum, or the fastest VF possible. A 
polyethylene dielectric cable has VF = 0.66 and a cable with PTFE dielectric 
has VF = 0.7.

— Cable Loss is specified in dB/meter. In addition to the length of the cable, 
loss is also directly proportional to the frequency of the signal that passes 
through the cable.

The following is an example showing how DTF cable correction works:

The DUT is a 100 meter transmission cable. The Cable Loss value is 0.1 
dB/meter.  This means that a signal traveling ONE WAY through the cable will 
lose 10 dB of power (100 m * 1dB/m). Because the FieldFox performs this 
measurement with 1 port, the test signal travels down the cable and then back, 
for a total loss of 20 dB.

After a calibration has been performed, for the purpose of illustrating this 
point, connect an OPEN to the end of the cable – a maximum-sized fault - for 
100% reflection of the 300 MHz test signal.

Without compensation for the loss of the cable, a –20 dB response would be 
visible at 100 meters, which is the OPEN at the end of the DUT. This is from 10 
dB of loss through the cable in each direction.

With compensation for the loss using the manufacturer’s specification, the 
FieldFox compensates the trace as though the signal traveling through 100 
meters was increased by +20 dB.  Therefore the response will show 0 dB for 
100% reflection.

How to enter Cable Loss and Velocity Factor

Cable Loss and Velocity factor can be entered using one of the following 
methods:

— Manually enter cable loss and velocity factor for the measurement.

— Select or create a cable file which contains the cable loss and velocity 
factor.

With a TDR measurement present:

— Press Meas Setup 4.

The following describes Coax Media type. Waveguide Media can NOT be 
measured with TDR as waveguide is inherently a high pass device.
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— Then DTF Cable Specifications

— Select Cable Corr

— Auto Use Cable Loss and Velocity Factor values from a Cable file. See 
“How to Edit, Save, and Recall a Cable File” below. This will overwrite 
a manually-entered value.

— Man (Default setting) Manually enter a value for Cable Loss and 
Velocity Factor.

— Then:

— Velocity Factor Using the numeric keypad, enter a value between 
0.01 and 1. Then press Enter. 

— Cable Loss Using the numeric keypad, enter a positive Cable Loss 
value in dB/m, then press Enter. 

How to Edit a Cable File 

The FieldFox includes many predefined cable files with the manufacturer’s 
specifications. You can edit these files or create new cable files using the 
following procedure or using the FieldFox Data Link Software.

The Cable correction data survives a Mode Preset and Preset.

With a TDR measurement present:

— Press Meas Setup 4

— Then DTF Cable Specifications

— Then Edit/Save/Recall Cables 

— Press New Cable then Yes to clear all data from the existing DTF Cable 
table and reset header information to default settings.

— Then Edit Cable to open the Cable Editor.

— Then use the  arrows to select a field,

— When editing Cable Description information, press Edit then modify 
the selected field using the FieldFox labeler. 

— When editing Frequency/Loss pairs, enter numbers using the 
numeric keypad, then select a frequency suffix. Then Enter. Learn 
more about “How the Freq/Loss pairs are applied” below.

— Optionally choose from the following:

— Previous / Next Page Quickly scrolls through pages of Freq/Loss 
data.

— Add Data Add a blank Freq/Loss pair to the table,

— Delete/Clear then:

— Delete Row Remove the selected Freq/Loss pair from the table. 
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— Clear All then Yes. Remove all Freq/Loss pairs from the table and 
resets header information

— Press Done to close the Cable Editor.

How to Save or Recall a Cable

— Press Save Cable to save your changes to the specified Storage Device. 
Enter a filename using the FieldFox labeler (see “How to use the FieldFox 
labeler ” on page 780. Learn more about Cable files below

— Press Recall Cable to load a Cable file from the specified Storage Device

— Storage Device Changes the device used to save or recall Cable files. This 
is a different setting from the Save/Recall Storage Device setting. Choose 
from Internal (default setting), USB (must be connected) or SD card.

About Cable files

— Cable files are saved to, and recalled from, the Cables folder. If the folder 
does not already exist on a USB or SD card, it is created automatically 
before storing the file.

— Cable files are stored as *.xml files. Existing cable files that are preloaded 
into the FieldFox firmware can be overwritten. Your edited file will NOT be 
overwritten when firmware is updated.

— To DELETE a Cable file, use the Manage Files feature. Learn more in 
“Manage Files” on page 786.

How the Freq/Loss pairs are applied

When the cable file contains one Freq/Loss pair, that correction value is 
applied to the entire displayed frequency span.

When the cable file contains two or more Freq/Loss pairs, the Loss value that is 
used is interpolated from the Freq/Loss pairs and the TDR center frequency. 
For example, using a cable file with the following Freq/Loss pairs:

The center frequency for the measurement is determined from the calculated 
(Stop – Start) frequency values (seen on the second page of TDR Settings):

1 GHz: 0.1 dB/m

2 GHz: 0.2 dB/m

Calculated Start = 2.0 MHz

Calculated Stop = 3.598 GHz

Center Freq = 1.80 GHz
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The Loss value for the measurement is interpolated from the Freq/Loss pairs at 
the Center Freq:

The correction for loss at 5 meters in one direction: 0.18 dB/m * 5m = 0.9 dB. 

All TDR measurements correct for loss for travel down the DUT and back, so 
double the correction: 0.9 dB * 2 = 1.8 dB.

Window Settings

Window settings provide the ability to choose between optimizing TDR 
measurements for resolving closely-spaced faults or for the ability to measure 
low-level faults.

How to select Window settings

— Press Meas Setup 4.

— Then Settings.

— Then press  arrows to move to the Window row.

— Then press Edit.

— Then press Window and choose from the following:

— Maximum (Maximum – Optimized for dynamic range) the noise floor 
is lowered to provide the ability to measure low-level responses. 
(Default setting)

— Medium – Compromise between Min and Max window settings. 

— Minimum – Best Response Resolution, providing the ability to resolve 
between two closely-spaced responses.

— Then press Done Edit.

— Again press Done.

1 GHz = 0.1 dB/m

1.8 GHz = 0.18 dB/m

2 GHz = 0.2 dB/m
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Network Analyzer Windows Frequency Span and TDR Window 
Selection for Step Rise Time (Approximated)

The following table shows the approximated relationship between the 
frequency span and the window selection for impulse width and step rise time. 
Refer to Figure 5-1 on page 85.

Figure 5-1 Network Analyzer TDR Rise Time

TDR Units

By default, X-axis units for TDR measurement settings are displayed in Meters.

How to change TDR units

— With a TDR measurement present, press Freq/Dist. 

— Then More then Distance Unit m feet. 

— The current selection is underlined m (meters) Feet.

The TDR Units setting is also available on the TDR Settings table.

Calculated TDR values

Press Next Page on the TDR Settings Table to view the following calculated 
Values noted on the FieldFox screen with c - <setting>

Window Low-pass step
(10% to 90%)

Low-pass impulse Bandpass impulse

Minimum 0.45/ f span 0.60 / f span 1.20 / f span

Medium 0.99 / f span 0.98 / f span 1.95 / f span

Maximum 1.48 / f span 1.39 / f span 2.77 / f span
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Start Frequency – Start frequency that is used to calculate TDR. 

Stop Frequency – Stop frequency that is used to calculate TDR.

Range Resolution. Indicates the accuracy of the distance to fault 
measurement. For example, with range resolution of 500 mm, if the distance to 
fault is 10 meters, this value could be inaccurate by +/- 500 mm or between 
9.5 to 10.5 meters. This value is calculated from frequency span / resolution 
(points).

Response Resolution, not displayed, indicates the distance that could be 
between two faults and still show as separate faults. Learn more in Window 
Settings in “Window Settings” on page 84.

Maximum Distance. The distance that could be viewed with the current 
settings. Defined by: Vf*c*Points/(2*Bandwidth) where:

— Vf = velocity factor

— c = speed of light

— Points = resolution

— Bandwidth = frequency range

Alias-free Range (On/Off)

— On = No Alias images

— Off = Alias images may appear in the response.

About Alias Faults

An alias fault is not a true device response. An alias fault appears because of 
the method used to convert frequency to time.

On the TDR Settings page (above) the c - Alias-free Range = Off setting 
indicates alias images MAY appear on the screen.

Shorter stop distances (less than 10 meters) and a higher resolution (1001 
points) will be more likely to result in Alias-free Range = Off.

When the Alias-free Range = Off, the following procedure will help to 
determine if a response is true or an alias response: 

1. Put a marker on the response in question and note the distance to the 
fault. 

2. Change the start or stop distance. 

A true fault response will not move in distance. That is, if a true fault is present 
at 10.3 meters, changing the stop distance from 15 m to 20 m will not move 
the fault; the fault will remain at 10.3 meters. However, an alias response will 
appear to move.
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An un-terminated cable (with NO perfect load at the end) will show faults that 
appear to be beyond the end of the cable. These are NOT alias faults. These 
faults appear as the signal reflects off the open at the end of the cable and 
travels back down the cable toward the connection at the FieldFox. 
Re-reflections are measured at the FieldFox as mirror images of the original 
faults. The largest fault is the open end of the cable. To avoid confusion, set 
the Stop distance shortly after that fault.

How to Prevent Undersampling

Undersampling is when the TDR measurement is inaccurate because the 
frequency step size (resolution) is too large. The predominant symptom of this 
is when the measured impedance is incorrect. For example, when measuring a 
75Ω cable, a marker that is on a part of the trace without reflections shows 
56Ω. 

To prevent undersampling, set TDR Sweep to Cable. If undersampling still 
occurs, set TDR Sweep to Auto. Then set Auto Max Frequency to a lower 
value.   Manually increase the Resolution so that the Start Frequency setting is 
less than about 500 kHz. 
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6 NA (Network Analyzer) Mode

Learn more about NA Mode measurements in the FieldFox Supplemental 
Online Help: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm.

In this Chapter

“About S-parameters” on page 91

“Mixed-Mode S-Parameters” on page 92

“Parameter Conversion” on page 93

“Receiver Measurements” on page 94

“Multi-Trace Configurations” on page 95

“Quick Settings” on page 96

“Calibration Settings” on page 97

“Format” on page 98

“Frequency Range” on page 99

“Scale Settings” on page 99

“Magnitude Offset” on page 100

“Electrical Delay” on page 101

“Phase Offset” on page 101

“Averaging” on page 102

“IF Bandwidth” on page 103

“Smoothing” on page 103

“Single or Continuous Measure” on page 104

“Resolution (Number of Data Points)” on page 104

“Sweep Time” on page 105

“Output Power” on page 107

“System Impedance (Z0)” on page 108
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See Also

“Port Extensions” on page 108

“Velocity Factor” on page 109

“Increase Dynamic Range” on page 112

“Why and When to Calibrate” on page 126

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720

Learn how to make 75Ω (ohm) Measurements in the 
Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHel
p/FieldFox.htm
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NA Mode Settings
Select NA Mode before making any setting in this chapter.

How to select NA Mode

— Press Mode_.

— Then NA.

About S-parameters

S-parameters (scattering parameters) are used to describe the way a device 
modifies a signal. The FieldFox can measure four S-parameters.  The syntax for 
each parameter is described by the following:

S (out | in)

out = FieldFox receiver port

in = FieldFox source port

The FieldFox automatically switches the internal source and receivers to make 
both forward and reverse measurements. Therefore, the FieldFox can measure 
all four S-parameters with a single connection

When the source comes from port 1, the measurement is said to be in the 
forward direction

When the source comes from port 2, the measurement is said to be in the 
reverse direction

S11 and S22 reflection measurements are used to measure the amount of 
reflections off the corresponding DUT port. Low reflections means there is a 
good impedance match between the source and DUT.
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S21 and S12 transmission measurements are used to measure the loss or gain 
through a DUT over a specified frequency range. Both ends of the DUT must be 
connected to the FieldFox. The FieldFox signal source is transmitted out one of 
the test port connectors, through the DUT, and into the other test port 
connector

How to measure S-parameters

1. Press Preset then Mode Preset (Factory)

2. Press Measure 1 then choose from the following:

— S11 Reflection measurement at port 1.

— S21 Forward 2-port transmission measurement.

— S12 Reverse 2-port transmission measurement. May require an 
option. 

— S22 Reflection measurement at port 2. May require an option.

OR select a multi-trace configuration. Learn more on “Multi-Trace 
Configurations” on page 95

3. Press Freq/Dist then either Start and Stop or Center and Span to enter a 
Frequency Range for the measurement.

4. Press BW 2 then IFBW to select the IF Bandwidth for the measurement. 
Narrower bandwidths require more time to sweep, but lowers trace noise.

5. Press Sweep 3 then Resolution to select the number of data points for the 
measurement. More data points require more time to sweep.

6. Press Cal 5 to calibrate the measurement. Learn more in “How to Perform 
a Calibration” on page 127.

7. All other settings can be made AFTER calibration without compromising 
measurement accuracy.

Mixed-Mode S-Parameters

In NA Mode ONLY, mixed-mode S-parameters (also known as Balanced 
measurements) are available with Option 212. 

Because the FieldFox has only two test ports, only reflection measurements are 
available. Connect the balanced input or output of your DUT to the FieldFox 
ports 1 and 2

For highest accuracy, a Full 2-port calibration is required.
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All FieldFox settings and features are supported (except Parameter Conversion) 
with mixed-mode S-parameters.

How to make mixed-mode S-parameter measurements

— Press Measure 1.

— Then More.

— Then choose from the following:

— Scc11 Common reflect/common incident for logical port 1.

— Sdd11 Differential reflect/differential incident for logical port 1.

— Sdc11 Differential reflect/common incident for logical port 1.

— Scd11 Common reflect/differential incident for logical port 1.

To make balanced reflection measurements at the DUT output, connect the 
DUT output to the FieldFox ports.

Parameter Conversion

In NA Mode ONLY, converts the active S-parameter trace to an equivalent 
impedance (Z), admittance (Y), or reciprocal 1/S-parameter

How to select parameter conversions

— Press Measure 1 

— Then select an S-parameter

— Then More

— Then Conversion

— Then choose from the following:

—Off (default) No conversion is performed.

—Z Conv (--) or Y Conv (--) Perform conversion for impedance (Z) or 
admittance (Y). Then choose from the following for either:

——Auto The displayed S-parameter is converted to the 
appropriate Z or Y parameter: Refl for S11 and S22; Trans for 
S21 and S12. When the S-parameter is changed, the 
appropriate conversion changes automatically.

——Refl The displayed S-parameter is converted to Z or Y 
reflection, regardless of whether the S-parameter is reflection 
(S11 or S22) or transmission (S21 or S12).

Learn more about Balanced Measurements with the FieldFox in the 
FieldFox Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm
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——Trans The displayed S-parameter is converted to Z or Y 
transmission, regardless of whether the S-parameter is 
reflection (S11 or S22) or transmission (S21 or S12).

—1/1/S The displayed S-parameter is converted to 1/S-parameter.

Receiver Measurements

In NA Mode ONLY, you can make unratioed, uncorrected receiver 
measurements. These measurements are typically used as diagnostic tools for 
service personnel.

How to make receiver measurements

— Press Measure 1 

— Then More, then Advanced

— Then choose from the following: 

—Auto The FieldFox sets the source port based on the selected receiver. 

—Port 1 Select when measuring transmission at B receiver.

—Port 2 Select when measuring reverse transmission at A receiver.

Learn more about Raw Receiver Measurements at the FieldFox Supplemental 
Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

Receiver measurements are NOT corrected for absolute power. They are 
only useful for making relative measurements. The Y-Axis and markers are 
labeled in dB - NOT dBm. Specifically, R1 and R2, do NOT indicate the 
actual power levels out of the source ports.

A Port-1 test port (*1) B Port-2 test port (*2)

R1 Port-1 reference receiver (*1) R2 Port-2 reference receiver (*2)

(*) indicates the Auto-selected source port for the measurement

Source Port The FieldFox port to provide the source signal. Choose from the 
following:
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Multi-Trace Configurations

In NA Mode you can display multiple traces on the FieldFox screen. 

The graphic above shows a x3H configuration. Tr2 is the ACTIVE trace as 
indicated by the highlighted Tr2.

Trace Setting Notes

— The Frequency Range, IF BW, Resolution, Average, and Output Power 
settings are common for all displayed traces.

— All other trace settings, such as measurement, format, and limit lines, are 
applied individually to the ACTIVE trace in the same manner as when a 
single trace is present.

— By default, a marker is created on ALL traces. However, they can be created 
individually by disabling Coupled Markers. Learn more in “Coupled Markers 
(NA Mode)” on page 703.

IMPORTANT! For CAT and NA modes, limit lines do not apply  
where F1 = F2.



 96                                                                                                                     Keysight N9938-90006 User’s Guide

NA (Network Analyzer) Mode
NA Mode Settings

How to select a multi-trace configuration 

— Press Trace 6

— Then Num of Traces

— Then choose from the following:  
The default measurements depend on the options that are installed

How to activate a trace in order to change a setting

— Use the  arrows OR 

— Press Trace 6 then select Trace 1, Trace 2, Trace 3, or Trace 4, Only traces 
that are shown can be activated.

How to maximize the viewing of the active trace

— Press System 7

— Then Full Screen. 

— Press any key to return to the standard display. 

Quick Settings

Both CAT and NA Modes allow you to view and change most relevant settings 
from a single location. All of these settings are discussed in this chapter and, 
unless otherwise noted, ALL of these settings can also be made using the 
standard softkey menus.

x1 1 trace standard configuration

x2 2 traces overlayed on a single graticule

x2H 2 traces on separate graticules

x3H 3 traces on separate graticules

x3 3 traces overlayed on a single graticule

x4 4 traces overlayed on a single graticule

x4H 4 traces on separate graticules
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How to view and change Quick Settings

— Press Meas Setup 4 

— Then Settings.

— Press Next Page and Previous Page to view all settings. If these softkeys 
are NOT available, then all available settings fit on one page.

— To change a setting:

—Use the  arrows to highlight a setting.

—Then press Edit. The current setting changes to yellow. 

—Some settings require you to press a softkey to change the value. 

Otherwise, use the numeric keypad,  arrows, or rotary knob to 
change the value.

—When finished changing a value, press Done Edit.

— Press Dock Window to relocate the Settings table to a position relative to 
the trace window. The Dock Window setting persists through a Preset. 
Choose from the following:

—Full (Default setting) Only the Settings table is shown on the screen. 
The trace window is temporarily not shown.

—Left The Settings table is shown to the left of the trace window.

—Bottom The Settings table is shown below the trace window.

When finished changing ALL settings, press Done to save your settings.

Calibration Settings

NA Mode has a page specifically for making settings that pertain to Port 
Extensions, including Velocity Factor and Media Type. 

Learn more in “Port Extensions” on page 108.

Learn more about Media Type in “Waveguide Calibrations” on page 139.

See also, Chapter 8 “Calibration for NA, CAT, and VVM Modes” and to “Apply 
Nearest (NA Mode Only)” on page 144.

How to view and change Calibration Settings

— Press Meas Setup 4.

— Then Calibration Settings

— Make these settings in the same manner as Quick Settings in the previous 
section.
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Format

Select the display format in which to present measurement results. This setting 
can be changed at any time without affecting calibration accuracy.

The marker on screen readout can be changed to formats other than the 
display format. Learn more in “Marker Format” on page 705.

How to select a NA Format

— Press Measure 1.

— Then Format [current setting].

— Then choose from the following:

—Log Magnitude Displays magnitude in dB

—Linear Displays positive values only. Y-axis: Unitless (U) for ratioed 
measurements; Watts (W) for unratioed measurements.

—VSWR Used mainly for S11 and S22. Displays unitless reflection data.

—Phase Displays phase in degrees. The trace ‘wraps’ every 360 degrees, 
from +180 to –180, for easy scaling.

—Smith Used mainly for S11 and S22, which are plotted on a Smith 
Chart. Displays series resistance and reactance.

— More then…

—Polar Used mainly for S11 and S22. Displays magnitude and phase

 of the reflection coefficient.

— Group Delay Used mainly for S21 and S12. Displays signal 
transmission (propagation) time through a device in seconds. The 
Group Delay aperture is the current Smoothing aperture. Default is 
1.5% of the X-axis.

——Learn how to set Smoothing aperture on “Smoothing” on 
page 103.

——Learn more about Group Delay measurements at the FieldFox 
Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldF
ox.htm

—Real Displays only the real (resistive) portion of the measured complex 
data. The Y-axis is Unitless. Often used for Time Domain 
measurements.

Learn more about Display Formats in the FieldFox Supplemental Online 
Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm
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—Imaginary Displays only the reactive portion of the measured complex 
data. The Y-axis is Unitless.

—Z Magnitude Displays the effective impedance in ohms.

—Unwrap Phase Same as Phase, but without 180 degree wrapping.

Frequency Range

Set the range of frequencies over which you would like to make measurements.

When the frequency range is changed after a calibration is performed, the cal 
becomes interpolated. Learn more in “Interpolation *” on page 142.

How to set Frequency Range

This can be done in two ways:

— Press Freq/Dist

— Then choose from the following:

— Start and Stop frequencies – Specify the beginning and end of the 
sweep. 

— Center and Span frequencies - Specify the center frequency and 
span of frequencies (half on either side of center).

— Follow each by entering a value using the numeric keypad, the  arrows, 
or the rotary knob.

— After using the  arrows or the rotary knob, press Enter. The increment 
setting of the arrows is based on the current span and can NOT be changed 
in NA Mode.

— After using the keypad, select a multiplier key. Learn more in “Multiplier 
Abbreviations” on page 46.

Scale Settings

Adjust the Y-axis scale to see the relevant portions of the data trace. The Y-axis 
is divided into 10 graticules. 

This setting can be changed at any time without affecting calibration accuracy.

Phase is unwrapped by comparing the phase from one data point to the 
next. If the phase difference between two data points is greater than 180 
degrees, or if the phase of the first data point is greater than 180 degrees 
from DC, than the phase measurement is probably NOT accurate. To 
ensure that the phase measurement is accurate, increase the resolution 
setting. When making a narrow band measurement, reduce the start 
frequency for the unwrapped phase measurement to ensure the first data 
point is less than 180 degrees from DC.
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How to set Scale

— Press Scale / Amptd.

— Then choose from the following method

—Autoscale Automatically adjusts the Y-axis to comfortably fit the 
Minimum and Maximum amplitude of the trace on the screen.

—Autoscale All Autoscales all of the traces on the screen, useful only for 
multi-trace configurations.

—3.Set Scale, acquisition, and Reference Position

——Scale Manually enter a scale per division to view specific areas 
of the trace.

——Ref Level Manually set the value of the reference line. Enter a 
negative value by pressing Run/Hold (+/-) either before or 
after typing a value. 

——Ref Pos Manually set the position of the reference line. Values 
must be between 0 (TOP line) and 10 (BOTTOM line)

Magnitude Offset

Magnitude Offset allows you to offset the magnitude (not phase) data by a 
fixed and/ or sloped value in dB. If the display format is Linear Magnitude or 
Real (unitless), the conversion from dB is performed and the correct amount of 
offset is implemented.

The Magnitude offset setting affects only the active trace.

How to set Magnitude Offset

— Press Scale / Amptd 

— Then More 

— Then Magnitude Offset - Offsets the entire data trace by the specified 
value.

Scale annotation on the FieldFox screen

—Reference Line = red arrow

—Ref Level = –40 dB

—Ref Position = 1 

—Scale = 2 dB per division
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—Then enter a positive or negative offset value in dB using the numeric 

keypad, the  arrows, or the rotary knob. Press a multiplier key. 
Learn about multiplier abbreviations.

— And/or press Slope - Offsets the data trace by a value that changes linearly 
with frequency. The offset slope begins at 0 Hz. and continues to the stop 
frequency. The offset value at the start frequency is then calculated from 0 
Hz.

—Then enter a positive or negative offset slope value in dB/GHz using 

the numeric keypad, the  arrows, or the rotary knob. Press a 
multiplier key. Learn about multiplier abbreviations in “Multiplier 
Abbreviations” on page 46.

Electrical Delay

Electrical delay is a mathematical function that simulates a variable length of 
lossless transmission line. Use the electrical delay feature to compensate for 
the linear phase shift through a device and view only the deviation from linear 
phase of the device.

You can set the electrical delay independently for each measurement trace. To 
apply an electrical delay to all measurement traces, use Port Extensions. Learn 
how in “Port Extensions” on page 108. 

Learn how to set Phase formats in “Phase Offset” on page 101.

How to set Electrical Delay

— Press Scale / Amptd 

— Then More 

— Then Electrical Delay

— Enter a time value using the numeric keypad, the  arrows, or the rotary 
knob.

— Press a multiplier key. Learn about multiplier abbreviations in “Multiplier 
Abbreviations” on page 46.

Electrical Delay can also be set using the Mkr->Delay feature. Learn how on 
“Marker Functions” on page 713. 

Phase Offset

Phase offset mathematically adjusts the phase measurement by a specified 
amount, up to 360°. Use this feature in the following ways:

Improve the display of a phase measurement. This is similar to the way you 
would change the acquisition in an amplitude measurement. Change the 
phase response to center or the response on the screen.



 102                                                                                                                     Keysight N9938-90006 User’s Guide

NA (Network Analyzer) Mode
NA Mode Settings

Emulate a projected phase shift in your measurement. For example, if you 
know that you need to add a cable and that the length of that cable will add a 
certain phase shift to your measurement, you can use phase offset to add that 
amount and simulate the complete device measurement.

You can set the phase offset independently for each measurement trace.

How to set Phase Offset

— Press Scale / Amptd 

— Then More 

— Then Phase Offset

— Enter a value in degrees using the numeric keypad, the  arrows, or the 
rotary knob. Press Enter

Averaging

Averaging helps to reduce the effects of random noise on a measurement. You 
specify the number of measurements to be averaged. The more measurements 
averaged, the greater the amount of noise reduction. An average counter is 
shown in the left edge of the screen as Avg <n> where <n> is the number of 
measurements that are averaged.

Averaging can be set before or after calibration. When set before calibration, 
each calibration standard is measured <n> times and averaged. More time is 
needed to perform the calibration, but there will be less noise in the resulting 
error terms which means that subsequent measurements will also have less 
noise. In addition, noise is further reduced by continuing to average after 
calibration.

How to set Averaging 

— Press BW 2.

— Then Average <n> where <n> is the number of measurements to average.

— Enter a value using the numeric keypad. Enter 1 for NO averaging.

— Press Enter. 

— Then Average Mode Choose from the following:

—Sweep - Each data point is based on the average of the same data 
point being measured over <n> consecutive sweeps. The average 
counter shows the number of previous sweeps that have been 
averaged together to form the current trace. When the counter 
reaches the specified count, then a ‘running average’ of the last <n> 
sweeps is displayed.
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—Point - Each data point is measured <n> times and averaged before 
going to the next data point. On subsequent sweeps, averaging 
restarts by measuring each data point again <n> times. The average 
counter is not updated because data is not displayed until all the 
averages have been applied. 

—Point averaging is usually faster than sweep averaging. However, you 
may need to increase the Point Average count to obtain the same 
level of noise reduction as with sweep averaging.

— While averaging is in process, press Sweep 3 then Restart to restart the 
averaging at 1.

IF Bandwidth

The FieldFox converts the received signal from its source to a lower 
intermediate frequency (IF). The bandwidth of the IF bandpass filter is 
adjustable. Reducing the IF receiver bandwidth reduces the effect of random 
noise on a measurement. However, narrower IF bandwidths cause longer 
sweep times.

How to set IF BW

— Press BW 2.

— Then IF BW 

— Then choose from the following: 

— 10 Hz | 100 Hz | 1 kHz | 10 kHz | 100 kHz  
More 30 Hz | 300 Hz | 3 kHz | 30 kHz

Smoothing

Trace smoothing averages a number of adjacent data points to smooth the 
peak-to-peak noise values on a displayed trace. The number of adjacent data 
points that are averaged is known as the smoothing aperture. Aperture is set 
by specifying a percentage of the X-axis span.

Trace smoothing does NOT significantly increase measurement time.

Smoothing is used in Group Delay measurements, although it can be used with 
any NA formatEXCEPT Polar or Smith Chart. Learn more about NA Mode 
formats, including Group Delay, in “Format” on page 98.

When enabled, Smo appears on the FieldFox screen.

How to set Smoothing

— Press BW 2

— Then Smoothing ON OFF

— Then Sm. Aperture and enter a value between 0 and 25 (percent) using the 
numeric keypad.
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— Press Enter

Single or Continuous Measure

This setting determines whether the FieldFox sweeps continuously or only once 
each time the Single button is pressed. Use Single to conserve battery power 
or to allow you to save or analyze a specific measurement trace.

This setting can be changed at any time without affecting calibration accuracy.

How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

— Single   Automatically sets Continuous OFF and causes FieldFox to 
make ONE sweep, then hold for the next Single key press. Hold is 
annotated in the upper left corner of the display when NOT sweeping, 
and changes to an arrow --> while the sweep occurs.

— Continuous Makes continuous sweeps. This is the typical setting 
when battery power is not critical.

— You can also use Run / Hold +/- to toggle between Single and Continuous.

Resolution (Number of Data Points)

Data points are individual measurements that are made and plotted across the 
X-axis to form a trace. Select more data points to increase measurement 
resolution. However, more data points also takes more time to complete an 
entire measurement sweep.

When the Resolution is changed after a calibration is performed, the cal 
becomes interpolated. Learn more in “Interpolation *” on page 142.

How to set Resolution

— Press Sweep 3.

— Then Resolution. 

— Then choose from the following:  
101 |201 | 401 | 601 | 801 | 1001 | 1601 | 4001 | 10001.

— Using SCPI, Resolution can be set to ANY number of points between 3 and 
10001. See the Programming Guide at 
http://na.support.keysight.com/fieldfox/help/Programming/webhelp/FFP
rogrammingHelp.htm
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Sweep Time

The fastest possible sweep time is always used as the default setting. Use the 
Min Swp Time setting to slow the sweep time when measuring long lengths of 
cable. Learn more at the FieldFox Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

The actual sweep time is shown on the FieldFox screen. See the Screen Tour 
on “Screen Tour” on page 44. To increase the sweep time, enter a value that is 
higher than the actual sweep time. The increase will not be exactly the amount 
that you enter, as the actual sweep time is the composite of many factors.

How to set Sweep Time

— Press Sweep 3.

— Then Min Swp Time.

— Enter a value using the numeric keypad.

— Press a multiplier key. Learn about multiplier abbreviations in “Multiplier 
Abbreviations” on page 46.

Triggering

External triggering (NA and SA modes ONLY) allows you to initiate a sweep 
when an external DC voltage is sensed at the Ref In/Trig In connector on the 
FieldFox top panel. See External Triggering for SA Mode in “Triggering” on 
page 192.

Trigger Source

— Press Sweep 3

— Then Trigger

— Then Trig Source

— Then choose from the following:

—Int (Internal) Sweeps are initiated by the FieldFox internal circuitry. 
When Sweep is set to Continuous, a new sweep begins automatically 
when the previous sweep ends.

—Ext (External) A sweep is initiated on the rising or falling edge of an 
external TTL signal at the Ref In/Trig In connector on the FieldFox top 
panel.

——When the FieldFox is armed for an external trigger signal, Wait 
is annotated on the display.

Measurement speed specifications do NOT apply in Temperature Control 
Mode. Learn more in “Temperature Control Mode” on page 33.
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——A sweep can NOT be initiated by an external signal while a 
sweep is in progress.

——A sweep can NOT be initiated by an external signal when in 
HOLD mode. Learn more about HOLD mode in.

— Pnt (Point) An external trigger type that acquires exactly one point 
per trigger input.

— When the FieldFox is armed for an external trigger signal, Wait is annotated 
on the display.

——A sweep can NOT be initiated by an external signal when in 
HOLD mode. Learn more about HOLD mode in.

Error Handling and Recovery

— Point Mode trigger is not compatible with sweep setups that require 
forward and reverse sweeps such as:

— Full 2port cal

— Cal ready (Full 2Port)

— Multiple displayed parameters that include the requirement for 
forward and reverse sweeps such as S11 and S22 together on the 
display

— When point mode trigger is already enabled, if conditions are changed 
requiring forward and reverse sweeps, an error "Error: Point trigger 
not compatible with 2-port cal." will be displayed and point mode 

IMPORTANT! 

If trigger signals come faster than the FieldFox can process them, some 
triggers may be ignored or lost. 

To ensure triggers are recognized and processed in order, use the external 
trigger output function to indicate when the FieldFox is ready for another 
input trigger. Alternatively, slow the external triggers coming in from 
external equipment to a rate where FieldFox does not miss a trigger. 

The External Trigger output signal is only selectable when Point Mode 
Trigger is enabled. Not supported in other trigger modes. 

External Trigger output signal is sent as soon as FieldFox has processed 
the last trigger signal that was detected.

As each point is acquired, the data will show up on screen. If a trigger has 
not been detected, a yellow Wait indicator will show on the sweep status 
icon area. 
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trigger will revert to Internal trigger. This includes turning on a CAL that 
requires forward and reverse sweeps or displaying multiple parameters that 
would require forward and reverse sweeps.

— If the FieldFox is in a state requiring two sweeps and the user selects point 
mode triggering, an error "Error: Point trigger not compatible 
with 2-port cal." will be displayed and point mode trigger will revert to 
Internal trigger.

Trigger Slope

Determines which edge of an External trigger signal initiates a sweep.

— Press Sweep 3

— Then Trigger 

— Then Trig Slope

— Then choose from the following:

—Positive Sweep is initiated by the rising edge of signal at about 1.7 V.

—Negative Sweep is initiated by the falling edge of signal at about 1.0 V.

Output Power

Set the power level out of the FieldFox to High, Low, or manually set power 
level to a value between High and Low. 

Generally, the high power setting is used when measuring passive, high-loss 
devices to place the signal farther from the noise floor. However, for devices 
that are sensitive to high power levels such as amplifiers, use the Low power 
setting. 

For best measurement accuracy, use the Manual power setting at -15 dBm. 
After calibration, the power level can be decreased for amplifiers, or increased 
for higher dynamic range.

How to set Output Power

— Press Meas Setup 4.

— Then Output Power

— High Sets output power to the maximum achievable power at all 
displayed frequencies. Output power is NOT FLAT across the 
displayed FieldFox frequency span. Please see “Specifications/Data 
Sheet” on page 829 for expected power levels.

Power Level settings in this mode will NOT change Power Level settings in 
other modes. To help prevent damage to your DUT, use caution when 
changing modes with your DUT connected to the FieldFox test ports.
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— Low Sets output power to approximately –50 dBm, FLAT across the 
displayed FieldFox frequency span.

— Man (default setting at -15 dBm) Set output power to an arbitrary 
value, FLAT across the displayed FieldFox frequency span. If flattened 
power can NOT be achieved, a warning message and beep occurs. To 
achieve a flattened output power, reduce the power level or stop 
frequency.

— Then press Power Level 

— Then enter a value using the numeric keypad, the  arrows, or the 
rotary knob.

— Press Enter.

System Impedance (Z0)

To accurately view data presented in Smith Chart format, first set the System 
Impedance.

Learn how to select Smith Chart format in “Format” on page 98.

Learn how to make 75Ω measurements at the FieldFox Supplemental Online 
Help: http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm

How to set System Impedance

— Press Meas Setup 4.

— Then Settings.

— Then scroll to System Z0 and press Edit 

— Then type either 50 or 75 and press Enter 

Port Extensions

Port extensions allow you to electrically move the calibration reference plane 
on either port 1 or port 2 after you have performed a calibration.

Why use Port Extensions

Use port extensions if you are unable to perform a calibration directly at your 
device because the location is not accessible. Perform a calibration at a 
convenient place, then use port extensions to compensate for the time delay 
(phase shift) to the desired reference plane. On the FieldFox, port extensions 
does not compensate for the loss of the additional electrical length, nor any 
mismatch errors beyond the calibration reference plane.

Also use port extensions if you have already performed a calibration, and then 
decide that you need to add a length of transmission line in the measurement 
configuration. Use port extensions to “tell” the FieldFox that you have added 
the length to a specific port.
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— With S11 and S22 reflection measurements, the FieldFox doubles the port 
extension valued that you enter to account for the additional delay in the 
forward and reverse directions.

— With S21 and S12 transmission measurements, the port 1 and port 2 
extensions are added together.  This accounts for the total transmission 
delay going through ports 1 and 2.

Port extensions and Electrical Delay differ in the following ways:

— Electrical delay applies to a specific trace

— Port extensions apply to specific hardware ports

Port Extensions and Electrical Delay can be set independently. When both are 
set, the delay adds together. Learn more about Electrical Delay in “Electrical 
Delay” on page 101.

How to apply Port Extensions

— Press Meas Setup 4.

— Then Port Extensions

— Then Port Extensions ON

— Then Port1 Extension

— Then enter time value using the numeric keypad, the  arrows, or the 
rotary knob. Press Enter or select a seconds (time) multiplier.

You can also set Port Extensions by pressing Meas Setup 4 then Calibration 
(settings).

While setting Port Extension, the physical length of the extension, at the 
current Velocity Factor setting, is visible to the right (red box in above 
image).

Velocity Factor

The electrical delay or port extension value is entered as delay, or electrical 
length, in units of time.

Entering the velocity factor causes the FieldFox to accurately display the 
equivalent physical length in meters (NOT available in feet) that corresponds 
to the entered electrical delay.
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Velocity factor is the ratio of the velocity of wave propagation in a coaxial cable 
to the velocity of wave propagation in free space. This velocity depends on the 
relative permittivity of the cable dielectric (er). 

Velocity factor = 1/sqrt(er)

VF = 0.66 corresponds to wave propagation through a polyethylene dielectric.

VF = 1.0 (default setting) corresponds to wave propagation through free space 
(a vacuum). 

How to set Velocity Factor

— Press Meas Setup 4.

— Then Port Extensions

— Then Velocity Factor 

— Then enter a value between 0.1 and 1 using the numeric keypad, then press 
Enter.

You can also set Velocity Factor by pressing Meas Setup 4 then Calibration 
(settings).

Big Marker Display States (A and B)

This feature, available ONLY in NA Mode, allows you to view up to three Big or 
Super Big marker readouts. This is done by using up to two different display 
states called A and B. Each display state is comprised of the settings listed 
below. When the Big Readout setting is toggled through A and B, these display 
states are recalled.

How to create Big Marker Display States

To have big readouts, markers MUST be created using the following procedure.

If you have already set up your display and do not want to lose it, then save the 
current state to a state file. Learn how in “State Files” on page 782. The 
following procedure will overwrite your display state.

— Press Mkr ->/ Tools

— Then Big Readout

—A or B - The A or B display state is recalled. If none have been defined, 
then the default display state is recalled.

—OFF - The B display state is visible but without the Big Marker 
Readout.

— With A or B selected, then press Edit Big Marker (A or B)

— Then edit the following display state settings:

— Num Traces – Choose the Multi-Trace configuration x1, x2, or x3. Only 
Overlayed configurations are allowed. Learn more in “Multi-Trace 
Configurations” on page 95.
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— Font Size – Choose either Big or Super Big. Super Big marker readout #3 
will cover some of the measurement grid.

— Trace Settings - For each possible trace (1, 2, and 3) select from the 
following:

—Measurement – S-Parameter or Receiver measurement to display. 
S11 is default. Learn more in “About S-parameters” on page 91.

—Meas Format – Log is default. Learn more in “Format” on page 98.

— Bandwidth (ON) – Marker readout for marker bandwidth search. 
OFF is default. Learn how to set BW parameters in “How to Search 
with Markers” on page 706.

— Big Readout - For each marker readout (1, 2, and 3), select from the 
following:

—Marker # - Enter a number from 1 to 6 to create the marker. 1 is 
created by default.

—Trace # - The marker# is created on this trace. Tr1 is selected by 
default. The corresponding Num Traces must first be selected. For 
example, to create a marker on Trace 3, first select Num Traces = x3.

—Format – Format for the marker readout. Select Default to make the 
marker readout format the same as the display format. Default is 
selected by default.

— Mkr Tracking – ON: Select the parameter to track on the standard 
Marker Search menu. OFF is selected by default. When set to ON, 
Peak tracking is set by default. Learn about Marker Tracking in 
“Marker Functions” on page 713.

— State – Choose from Normal, Delta, or OFF. The default marker (1) is 
created in Normal. Learn more in “Marker Functions” on page 713.

—Enabled – Turns the Big Readout of the corresponding marker ON and 
OFF. The default marker (1) is set ON by default.

Notes:

— To move a marker, press Marker, then Marker, then scroll to the marker 
number to be moved. The new marker position can NOT be saved with the A 
or B display state.

— Settings that are NOT listed above are NOT affected by the recalled display 
states. 

— Changes to the above settings outside the Big Readout menu will be 
overwritten when Big Readout (A or B) is selected. For example, suppose 
the display format for the B state is Log. If you change the display format to 
Lin using the standard menu (Meas 1, Format), the setting will show on the 
display. But if you then use the Big Readout (A | B | OFF) setting, when B is 
recalled, the Lin setting will be overwritten with the original Log setting.
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Increase Dynamic Range

Dynamic range is the difference between maximum input power to the 
FieldFox receiver (without compressing the receiver), and the minimum 
measurable power (noise floor). Measurement accuracy is increased when the 
DUT response is at least 10 dB above the noise floor. For a measurement to be 
valid, input signals must be within these boundaries. 

The following settings will increase the dynamic range of your NA mode 
measurement. 

— Increase Power Level: Press Meas 4 then Output Power High

— Lower the IFBW: Press BW 2 then IF BW

— Increase Averaging: Press BW 2 then Average

The following procedure MAY increase the dynamic range of your NA mode 
measurement. The results you see will depend on the performance of your 
DUT. 

With an S21 trace active:

1. With RF OUT (port-2) open, press Trace 6 then Math and Memory then 
Data->Mem

2. Re-connect the DUT.

3. Press Data Math then Data-Mem
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With NA Mode, Time Domain (Opt 010), frequency information is used to 
calculate and display measurements with time as the horizontal display axis. 
The response values appear separated in time allowing a different perspective 
of the test device's performance and limitations.

NA Mode settings that are NOT unique to Time Domain are documented in 
Chapter 6, “NA (Network Analyzer) Mode”, on page  89. 

In This Chapter

Time Domain (Transform) Settings

Trace Settings

“Overview” on page 115

“Transform Settings Table” on page 116

“Start/Stop (Frequency Range) and Points” on page 116

“Stimulus (Mode)” on page 117

“Set Frequency Lowpass” on page 117

“Start/Stop Time” on page 117

“Distance Units” on page 118

“Window Layout” on page 118

“Transform Window” on page 118

“Line Loss and Velocity Factor” on page 119

“Data Chain” on page 120

“Gating Type” on page 123

“Transform Enable” on page 121

“Gate Enable” on page 121
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Gating Settings

“Start, Stop, Center, and Span Gate Times” on 
page 123

“Gating Type” on page 123
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Overview
In normal NA Mode operation, the FieldFox measures the characteristics of a 
test device as a function of frequency. With Time Domain (opt 010), frequency 
information is used to calculate the inverse Fourier transform and display 
measurements with time on the horizontal display axis. The response values 
appear separated in time, allowing a different perspective of the test device's 
performance and limitations.

The graphic below compares the same cable reflection measurement data in 
both the frequency and time domain. The cable has two bends. Each bend 
creates a mismatch or change in the line impedance.

The frequency domain of an S11 measurement shows reflections caused by 
mismatches in the cable. It is impossible to determine where the mismatches 
physically occur in the cable.

The Time Domain response shows both the location and the magnitude of each 
mismatch. The responses indicate that the second cable bend is the location of 
a significant mismatch. This mismatch can be gated out, allowing you to view 
the frequency domain response as if the mismatch were not present. Learn 
more about gating in “Gating” on page 122.

Markers that are created on a Time Domain trace can be used to pinpoint the 
distance of the mismatch from the reference plane. 

For more information on Time Domain theory, see 
https://www.keysight.com/us/en/assets/7018-01451/application-notes/598
9-5723.pdf.
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Time Domain (Transform) Settings
You can set and view most of the Time Domain settings on the Transform 
Settings table. 

Transform Settings Table

The following settings (from Transform Stimulus Settings to Data Processing) 
are listed in the order they appear on the Transform Settings menu selection. 

How to make settings on the Transform settings table

— Press Meas Setup 4.

— Then Transform

— Then Transform Settings.

— Press Next Page and Previous Page to view all settings.

— To change a setting:

— Use the  arrows or rotary knob to highlight a setting. 

— Numeric settings can be changed by pressing numbers using the 
numeric keypad. Then press Enter or select a suffix if available.

— Some settings allow you to press Edit to toggle the value. Other 
settings require that you then press a softkey to change the value.

— When finished changing a value, press Done Edit.

— Press Dock Window to relocate the Settings table to a position relative to 
the trace window. The Dock Window setting persists through a Preset. 
Choose from the following:

— Full (Default setting) Only the Settings table is shown on the screen. 
The trace window is temporarily not shown.

— Left The Settings table is shown to the left of the trace window.

— Bottom The Settings table is shown below the trace window.

— When finished changing ALL settings, press Done to save your settings.

Start/Stop (Frequency Range) and Points

All Time Domain measurements are made in the frequency domain and, using 
Inverse Fourier Transform (IFT), time is calculated. Select the frequency range 
from which Time Domain measurements are calculated. Increasing the data 
points will improve measurement resolution. However, more data points will 
usually result in slower sweep updates.

Set frequency range and points before selecting Stimulus Mode.
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Stimulus (Mode)

— There are three variations on how the Time Domain transform algorithm is 
applied to the frequency domain measurement. Each method has a unique 
application.

— Lowpass Impulse - Highest resolution. Most useful for seeing small 
responses in devices that pass low frequencies, such as cables.

— Lowpass Step - Easiest to identify inductive and capacitive discontinuities 
in devices that pass low frequencies such as cables. 

In both Lowpass modes, frequencies down to DC and negative frequencies are 
extrapolated. Therefore, when either Lowpass mode is selected, Set Freq.Low 
Pass is automatically applied to adjust the start frequency. Learn more about 
Set Frequency Lowpass below.

When the Start Frequency or resolution is changed AFTER selecting a Lowpass 
mode, then Stimulus mode is set to Band Pass and Transform is disabled.

— Bandpass Impulse- Easiest method - can be used with any frequency 
sweep. Most useful for measuring band limited devices such as filters and 
DC blocked cables. This mode does NOT show capacitive and inductive 
reactance. For the same frequency span and number of points, band pass 
mode has twice the impulse width, which hides closely spaced responses 
degrading the response resolution. 

Set Frequency Lowpass

USE ONLY IN LOW PASS MODES. The Low Pass Start frequency is adjusted so 
that the Low Pass Stop frequency is at harmonics of the Low Pass Start 
frequency. Start frequency is computed by the following formula:

Low Pass Start Frequency = Stop Frequency / Number of points.

Start/Stop Time

The following settings adjust the display resolution, allowing you to zoom IN 
or OUT on a response. When the start or stop time is updated, they may be 
automatically adjusted to limit the display to one alias-free response on either 
side of zero time.

How to set Start and Stop time

— Press Measure Setup 4

— Then Transform

— Then Transform Start Stop

This setting is made automatically when either Lowpass mode is selected.
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— Then choose from: 

— Start  Sets the transform start time.

— Stop  Sets the transform stop time. 

Distance Units

When markers are present on a Time Domain trace, marker X-axis values are 
shown both in units of time (seconds) and distance. Select the units in which 
the marker distance data is presented.

Distance Units are also used when setting Time Domain Line Loss. Learn more 
in. “Distance Units” on page 118.

Choose from: m (meters), or Feet.

Window Layout

This setting is used to create additional traces, or select a new layout for traces 
that are already created, 

Choose from: x1, x2, x2H, x3H, x3, x4H.

Learn more about multi-trace configurations in “Multi-Trace Configurations” 
on page 95.

Transform Window

There are abrupt transitions in a frequency domain measurement at the start 
and stop frequencies, causing overshoot and ringing in a Time Domain 
response. The Window setting reduces the abruptness of the frequency domain 
transitions. This causes you to make a trade off in the Time Domain response. 

Zero (0) seconds is always the calibration reference plane. Negative values 
are useful if moving the reference plane.
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The Window setting applies to ALL traces.

How to make Window setting

— Press Measure Setup 4

— Then Transform

— Then More

— Then Transform Window

— A settings table appears that allows you to navigate and select the 
following settings. These settings are made exactly like those made on the 
Transform Settings table. Learn how in “Transform Settings Table” on 
page 116.

Line Loss and Velocity Factor

By default, the FieldFox does NOT correct Time Domain measurements to 
account for the inherent loss of a cable. However, to make more accurate 
measurements, Line Loss and Velocity Factor should be considered. 

Any of the following four methods can be used to make this same Window 
setting. Impulse Width values are calculated from the frequency span and 
Kaiser Beta value.

1.  Window Min Medium Max

2.  Percent 0 50 100

3.  Kaiser Beta 0 6.50 13.00

4.  Impulse Width 100.455 ps 168.501 231.284
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About Velocity Factor and Line Loss

— Velocity Factor is a property of the physical material of a cable. A VF of 1.0 
corresponds to the speed of light in a vacuum, or the fastest VF possible.  A 
polyethylene dielectric cable has VF = 0.66 and a cable with PTFE dielectric 
has VF = 0.7.

— Line Loss is specified in dB/m (or ft). In addition to the length of the cable, 
loss is also directly proportional to the frequency of the signal that passes 
through the cable. 

The following is an example showing how Line Loss works: 

The DUT is a 100 meter transmission cable. The Line Loss value is.1 dB/meter.  
This means that a signal traveling ONE WAY through the cable will lose 10 dB 
of power (100 m *.1dB/m). Because the FieldFox performs this measurement 
with 1 port, the test signal travels down the cable and then back, for a total 
loss of 20 dB.

For the purpose of illustrating this point, connect an OPEN to the end of the 
cable – a maximum-sized fault - for 100% reflection of the 300 MHz test 
signal.

Without compensation for the loss of the cable, a –20 dB response would be 
visible at 100 meters, which is the OPEN at the end of the DUT. This is from 10 
dB of loss through the cable in each direction.

With compensation for the loss using the manufacturer’s specification, the 
FieldFox compensates the trace as though the signal traveling through 100 
meters was increased by +20 dB.  Therefore the response will show 0 dB for 
100% reflection. 

Data Chain

This setting, available only on the Transform Settings Table, reverts to 
Standard when the FieldFox is Preset. Choose from the following:

— Standard – The normal FieldFox data processing chain. Transform 
calculations are performed AFTER error correction and trace math.

— 8510 – The data processing chain used by the Keysight 8510 network 
analyzer. Transform calculations are performed BEFORE error correction 
and trace math. Learn more at the FieldFox Supplemental Online Help 
website: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 
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Trace Settings
The following two settings apply to specific traces.

Transform Enable

Enable Time Domain transform for the specific trace.

— Select the trace.

— Press Measure Setup 4

— Then Transform 

— Then choose from:

— Transform On Trace displays Time Domain data.

— Transform Off Trace displays frequency domain data.

Gate Enable

Enable Gating for the specific trace.

— Select the trace.

— Press Measure Setup 4

— Then Transform

— Then choose from:

— Gating On Trace displays Time Domain data.

— Gating Off Trace displays frequency domain data.
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Gating
Perhaps the most beneficial feature of Time Domain transform is the Gating 
function. When viewing the Time Domain response of a device, the gating 
function can be used to “virtually” remove undesired responses.  You can then 
simultaneously view a frequency domain trace as if the undesired response did 
not exist. This allows you to characterize devices without the effects of external 
devices such as connectors or adapters. 

Gating is best performed while viewing a Time Domain trace. Then, either 
disable Transform, or separately view a frequency domain trace to see the 
trace with the gated effects removed. 

The following image shows how gating can affect measurement results. 

All 4 traces show the same S11 measurement.

Trace 1 shows the frequency response without gating enabled.

Trace 2 shows the transform response without gating enabled.

Trace 3 shows the transform response with gating enabled.

When a discontinuity in a test device reflects energy, that energy will not 
reach subsequent discontinuities. This can “MASK”, or hide, the true 
response which would have occurred if the previous discontinuity were not 
present. The Gating feature does NOT compensate for this.
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Trace 4 shows the frequency response with gating enabled.

How to make Time Domain Gating settings

— Press Measure Setup 4 

— Then Transform

— Then Gating

— Then choose from:

— On Gating is being performed.

— Off Gating is NOT being performed. 

Start, Stop, Center, and Span Gate Times

These settings specify the time in the trace to be gated (in or out). The gate 
times can be specified using either Start and Stop or Center and Span.

— Press Gating Start Stop 

— A settings table appears that allows you to navigate and select the 
following settings. These settings are made exactly like those made on the 
Transform Settings table. Learn how in “Transform Settings Table” on 
page 116.

Gating Type

This setting defines the type of filtering that will be performed for the gating 
function. The gate start and stop flags on the display point toward the part of 
the trace you want to keep.

Choose from the following:

— Bandpass KEEPS the responses within the Gating Start and Stop times.

— Notch REMOVES the responses within the Gating Start and Stop times.
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Gating Shape

This setting defines the filter characteristics of the gate function. Choose from 
Minimum, Normal, Wide, Maximum.

Time domain Gate Shape setting is shown in the graphic above.

Cutoff time is the time between the stop time (-6 dB on the filter skirt) and the 
peak of the first sidelobe.

— T1 is the gate span, which is equal to the stop time minus the start time.
— T2 is the time between the edge of the passband and the 6 dB point, 

representing the cutoff rate of the filter.
— T3 is the time between the 6 dB point and the edge of the gate stopband.

For all filter shapes T2 is equal to T3, and the filter is the same on both sides of 
the center time.

Minimum gate span is twice the cutoff time. Each gate shape has a minimum 
recommended gate span for proper operation. This is a consequence of the 
finite cutoff rate of the gate. If you specify a gate span that is smaller than the 
minimum span, the response will show the following effects:

— distorted gate shape that has no passband
— distorted shape
— incorrect indications of start and stop times
— may have increased sidelobe levels.

Gate Shape Passband 
Ripple

Sidelobe 
Levels

Cutoff Time Minimum Gate 
Span

Minimum ±0.1 dB -48 dB 1.4/Freq Span 2.8/Freq Span

Normal ±0.1 dB -68 dB 2.8/Freq Span 5.6/Freq Span

Wide ±0.1 dB -57 dB 4.4/Freq Span 8.8/Freq Span

Maximum ±0.01 dB -70 dB 12.7/Freq Span 25.4/Freq Span
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8 Calibration for NA, CAT, and VVM Modes

Calibration removes the systematic errors that are associated with 
measurements in NA, CAT, and VVM Modes. Key presses are identical in all of 
these Modes.

In this Chapter

“Why and When to Calibrate” on page 126

“Definitions” on page 126

“CalReady” on page 127

“How to Perform a Calibration” on page 127

“Mechanical Cal” on page 129

“ECal” on page 131

“Simple Response Cals ” on page 134

“View Cal” on page 136

“Calibration Type” on page 136

“Enhanced Response Optimization” on page 141

“Interpolation *” on page 142

“Cal ON? – Questionable Accuracy” on page 142

“Compatible Mode Calibrations” on page 142

“Save the Calibration” on page 142

“CalReady Properties” on page 142

“Apply Nearest (NA Mode Only)” on page 144

“Verify a Calibration” on page 144

“Test the Jumper Cable” on page 145
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See Also

Learn How to Make 75 ohm Measurements at the FieldFox Supplemental 
Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

Why and When to Calibrate

There are well-defined and understood systematic errors that are measured 
and calculated during the calibration process. These errors are caused by 
leakage signals inside the FieldFox, by the frequency response of the FieldFox 
receivers, and by reflections inside the FieldFox that interact with the DUT. 
After calibration, these errors are removed from subsequent measurements.

To maintain highest measurement accuracy, perform a new calibration when 
any of the following changes occur:

— When any of the following measurement settings change: Frequency 
Range, Power Level, IF BW, and Resolution. Therefore, make these 
measurement settings before calibrating. Increased Averaging, lower IF BW, 
and higher Resolution all cause slower sweeps and slower calibration times. 
Learn about Interpolation and Questionable Accuracy in “Interpolation *” 
on page 142.

— When the FieldFox temperature changes more than about 10°F (5°C). Learn 
more in “How to monitor the internal FieldFox temperature:” on page 32.

— When the connection to the DUT changes, requiring a different jumper 
cable or adapter.

Definitions

DUT (Device Under Test) The cable, antenna, transmission line, amplifier, or 
anything else that is connected to the FieldFox that is to be measured.

Calibration Standards - OPEN, SHORT, LOAD, and THRU

— OPEN, SHORT, and LOAD are ‘reflection’ standards that are used during 
calibration. When an RF signal ‘hits’ these components, the signals are 
reflected in a predictable manner. These components can also be used to 
terminate a DUT port during some measurements.

— SHORT and OPEN standards both cause 100% of an RF signal to be 
reflected. The difference between these two standards is what 
happens to the phase of the reflected signal, which is beyond the 
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scope of this discussion. Although an OPEN standard is a precision 
component, simply leaving nothing connected at the end of a cable 
can be a reasonable substitute for an OPEN.

— A LOAD standard absorbs almost ALL of the incident signal and very 
little signal is reflected back to the source. 

— A THRU standard is used during some calibration steps to connect PORT 1 
to PORT 2 in place of the DUT. A Flush THRU connection can be made 
when cables that connect with the DUT can mate with each other. Learn 
more in “Mechanical Cal” on page 129. Otherwise, any reasonably short 
cable can be used as a THRU standard.

Calibration Reference Plane is the point (or points) at which the DUT and cal 
standards are connected during a calibration. This can be at the FieldFox test 
port connectors, or at the end of jumper cables or adapters. 

CalReady

Every FieldFox contains a factory calibration that was performed at the port 1 
and port 2 connectors, with -15 dBm input power, over the entire frequency 
range of the FieldFox using a number of data points that allows reasonable 
interpolation over the FieldFox frequency range. 

This calibration, known as CalReady, allows you to immediately make 
measurements of a DUT that is connected directly at the test ports (PORT 1 
and/or PORT 2). CalReady corrects measurements when the FieldFox is turned 
ON and when a measurement is created with no other correction in place.

When measuring a DUT using a jumper cable or adapter - NOT a direct 
connection to a test port connector – then a Mechanical Cal is recommended. 
CalReady can also be used to check the integrity of the jumper cable that is 
attached to the test ports. 

CalRdy is shown when a measurement is corrected using CalReady. 

You can change the properties of the CalReady calibration. Learn more in 
“CalReady” on page 127.

Learn how to see when your factory CalReady calibration was performed in 
“System Information” on page 769. 

How to Perform a Calibration

In CAT, NA, or VVM Mode, press Cal 5.

Press Esc at any time to end the calibration process.

When performing a calibration that contains a large number of points 
(5000 to 10,001 points) be aware that the calibration progress bar may not 
move for 2 or 3 minutes during the calibration process.
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The following appears:

Choose Calibration Method screen

— Response Cal – Used to quickly calibrate ONE type of measurement using 
mechanical standards. Measurement accuracy is generally low. Learn more 
in “Simple Response Cals ” on page 134.

— Mechanical Cal/ECal – Using mechanical cal standards from a cal kit, 
perform an accurate calibration at one or both test ports, adapters, or 
jumper cables. Full 2-port mechanical calibration is the most accurate 
calibration available with FieldFox. Learn more in “ECal” on page 131.

— User Cal OFF ON – Turns ON and OFF the effects of the user calibration that 
you performed. The OFF state reverts to CalReady. 

— View Cal – Shows the properties of the current calibration. Learn more in 
“View Cal” on page 136.

— More – Learn about Cal Ready Properties in “CalReady” on page 127.

Source Unleveled errors - During calibration, the frequency range of the 
measurement MAY be extended to provide maximum flexibility. During the 
calibration, the output power may become unleveled at the added high 
frequencies. You can ignore the “Source Unleveled” error, or to avoid the 
error, select either High power or -15 dBm before calibrating. Learn more 
about setting Output Power in “Output Power” on page 57.
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Mechanical Cal

Mechanical Calibration is performed using discrete standards from a Cal Kit. 
Several Cal Kit definitions are built into the FieldFox. To learn about Cal Kit 
definitions, refer to the Application Note, “Specifying Calibration Standards 
and Kits for Keysight Vector Network Analyzers,” available online at 
https://www.keysight.com/us/en/assets/7018-01375/application-notes/598
9-4840.pdf.

Mechanical Cals are extremely accurate when performed using the correct Cal 
Kits with standards that are clean and in good repair, and when using correct 
connection procedures. 

How to perform a Mechanical Cal

— Disconnect the DUT from the FieldFox.

— If a jumper cable or adapter is required to connect the DUT to the FieldFox, 
then connect those components to the FieldFox connectors. The effects of 
those components will be measured and removed during the calibration, 
and only the effects of the DUT will be displayed in the measurement 
results. These should be high-quality components! 

— In NA, CAT, or VVM Mode, press Cal 5.

— Then Mechanical Cal 

This page summarizes the Mechanical Cal to be performed and allows you to 
make changes. For best results, review the screen and make changes in the 
following order:

Visit www.keysight.com/find/fieldfoxsupport to see a complete list of 
supported Cal Kits. Also at this website, download Data-Link software that 
allows you to edit Cal Kit definitions or add a new Cal Kit.
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1. S-parameters – Verify that these are all of the S-parameters that you want 
calibrated. If not, press Esc to terminate the calibration process, then 
return to the Trace menu to display all of the traces to be calibrated. Learn 
how in “Multi-Trace Configurations” on page 95

2. DUT Connectors – For each DUT port that is shown, verify the correct type 
and gender of the DUT connector. If a DUT port is not shown, then that 
port is not included in the list of S-parameters to be calibrated. 

3. Cal Kit - Verify the correct Cal Kit for each DUT port to be calibrated. See a 
list of supported Cal Kits in the FieldFox Data Sheet. Learn more in 
Appendix B.

If the DUT connector type, gender, or Cal Kit is NOT correct for the DUT 
ports to be calibrated, then:

— Press Change DUT Connectors to select the correct connector types 
that are on your DUT. 

— For each port:

— Use the  arrows or rotary knob to change the DUT 
connector type. 

— Press Change Gender to change the gender of the DUT 
connector. 

— Then press Next… to confirm the selection and continue 
the process.

— For each port:

— Use the  arrows or rotary knob to select the Cal Kit 
that you have, and are going to use, for the specified ports. 

— Press Next… to confirm the selection and continue the 
process.

— Then press Finish to end the selection process.

4. Calibration Type - The FieldFox always RECOMMENDS a Cal Type that will 
quickly and accurately calibrate all of the displayed S-parameters. 
Change from the RECOMMENDED Cal Type ONLY if you understand the 
implications. Learn more about Cal Types in “Calibration Type” on 
page 136.

To select a different Cal Type:

— Press Change Cal Type. 

— Then using the  arrows or rotary knob, select a Cal Type,

— Then press Select and Finish. 

Begin Calibration
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— Press Start Calibration. 

— Follow the Cal Wizard prompts. Connect the specified standard at the point 
where the DUT will be connected, then press Measure.

— At any time, press Back to re-measure a standard if you feel it was not 
properly connected.

— Press Finish to complete the calibration.

CAL ON U is shown on the screen for all displayed measurements that are 
corrected with the Mechanical Cal.

ECal

ECal is a complete solid-state calibration solution. Every ECal module contains 
electronic standards that are automatically switched into position during a 
calibration. These electronic standards have been measured at the factory and 
the data stored within the memory of the ECal module. The FieldFox uses this 
stored data, along with the measured data, to calculate the error terms for a 
measurement calibration.

If an error appears (“Failure to compute calibration steps…”), check to 
ensure that the frequency range of the Cal Kit covers the frequency range 
of the measurement. You can verify the frequency range of your Cal Kit at: 
www.keysight.com/find/fieldfoxsupport. Click Cal Kits.

ECals each have a recommended input power level. Depending on the 
measurement setup, the FieldFox may default to an input power level that 
exceeds your ECal’s recommended input power level. Refer to the 
reference guide for your ECal module to determine the correct input power 
levels. Exceeding an ECal’s recommended input power level results in a 
compression and an invalid data condition. Refer to 
www.keysight.com/find/ecal. 
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You can perform the following calibrations with ECal:

— 1-Port Reflection calibration

— Full 2-Port calibration

All Keysight USB ECal modules are supported. ECal modules are available in a 
variety of connector types, covering many frequency ranges. For information 
about available ECal modules, see http://www.keysight.com/find/ecal

Select an ECal module that has connectors of the same type and gender as the 
DUT. If such an ECal module is not available, a module with connectors 
different from the DUT can be used by selecting a User Characterization. This 
selection is located on the Mechanical Cal Setup page of the CalWizard. 
However, a User Characterization can NOT be PERFORMED using the 
FieldFox. It must be performed using a bench top Keysight VNA, such as the 
PNA or ENA. Learn more about User Characterization at the PNA Help website: 
http://na.support.keysight.com/pna/help/latest/S3_Cals/ECal_User_Charact
erization.htm.

How to Perform a Calibration Using ECal

— Make measurement settings on the FieldFox (frequency range, number of 
points, etc.)

Simple ECal ON: When choosing Full 2-port calibration, if you are able to 
connect your ECal simultaneously to both device ports, you should use 
Simple ECAL (i.e, this ensures that you are using the correct Thru 
calibration model).  
 
Simple ECal OFF: Set simple ECal to OFF when you have a test setup 
where you cannot connect port 1 and port 2 simultaneously to the ECAL 
module (Then during the calibration when prompted: “Connect port 1 to 
port 2", use a coaxial cable or an appropriate thru adapter to connect port 
1 to port 2). 
 
’Unknown THRU’: When prompted: “Connect port 1 to port 2", then you 
can connect them, using a coaxial cable or an appropriate thru adapter. Do 
NOT use the internal ECal THRU, because the thru calibration will be 
incorrect.  
 
‘Flush THRU’: When prompted: “Connect port 1 directly to port 2", then 
you must connect the ports directly together at the calibration reference 
plane with no adapter or other cabling.  
 
Learn more in “Calibration Type” on page 136.

The frequency range of the measurement MUST be within the frequency 
range of the ECal module or an error will appear when “Calculating Steps” 
during the calibration.
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— Connect the ECal module USB cable to the FieldFox USB. 

— Allow the module to warm up until it indicates READY. This may take several 
minutes.

— Connect the ECal module ports to the FieldFox at the calibration reference 
plane (where the DUT will be connected). 

— Press Cal 5 to start the Calibration. 

— Press Mechanical Cal / ECal

— Press Change DUT Connectors. For each test port to be calibrated, select 
the Connector Type and Gender of the DUT / ECal module. The connected 
ECal module and relevant User Characterizations will appear, with the ECal 
factory default as the default Cal Kit. 

— Optionally press Advanced then ECal Auto Orient.

— ON (default) The FieldFox automatically senses the direction in which 
the ECal module ports are connected to the FieldFox ports. 

— OFF If power to the ECal module is too low, it cannot detect which 
FieldFox ports it is connected to. If you are having this problem, 
select OFF. Then during the calibration, the FieldFox will prompt you 
to connect the ECal module ports to specific FieldFox ports.

— Optionally press Advanced then Extended Cal (N995xB/6xB Only).

— ON The FieldFox Extended Cal measures additional points outside 
the current frequency range in order to enable adjusting the 
frequency range after the calibration procedure. With these extra 
points, the error correction may be applied when it otherwise might 
not. Without extended cal, if you adjust your frequency outside the 
calibrated range after the calibration has been completed, the error 
correction is turned off. 

— OFF (default) The FieldFox does not measure any frequency points 
outside the current displayed frequency range. If the frequency is 
adjusted outside of the set of points calibrated the error correction is 
turned off and the following message is displayed:  
"Error correction disabled. Stimulus outside  
calibrated range."
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— Press Start Calibration. When prompted, verify the ECal module 
connection, then press Measure. The standards within the ECal module are 
automatically connected and measured.

Simple Response Cals 

Simple Response Cals are used to quickly calibrate the magnitude and phase 
of a measurement using any Open, Short, or Thru component. These may be 
calibration standards, but because a Cal Kit is not selected, they are not 
modeled. Measurement accuracy is generally low. Use a Simple Response Cal 
to make quick measurements when using a jumper cable to connect the DUT 
to the FieldFox. Otherwise, CalReady is usually more accurate.

When prompted, choose a standard based on the displayed measurements to 
be calibrated. For example, to calibrate S11, connect either an OPEN or 
SHORT to the port 1 reference plane. 

When Simple Response Cals are performed, the source match and reflection 
tracking terms from CalReady are updated by the measured Short or Open that 
is used during the calibration. 

’Unknown THRU’: When prompted: “Connect port 1 to port 2", then 
connect port and port 2, using a coaxial cable or an appropriate thru 
adapter. Do NOT use the internal ECal THRU, because the ECal thru 
calibration model is incorrect for this calibration type.  
 
‘Flush THRU’: When prompted: “Connect port 1 directly to port 2", then 
you must connect the ports directly together at the calibration reference 
plane with no adapter or other cabling.  
 
Learn more in “Calibration Type” on page 136.

IMPORTANT!

The Simple Response calibration assumes an ideal response for the 
standard. DUT measurements after a Simple Response calibration will 
have a measurement bias equivalent to the deviation of the response of the 
device used as the Simple Response standard from the ideal response. 
Note, that an Open Response is simply a normalization, a Short response is 
a normalization with 180 degree phase offset. When selecting a standard 
from the 85058B calibration kit for a Short Response we suggest using 
short # 1 because it has the smallest delay of the four shorts and would 
thus be most similar to an ideal short. 

For better accuracy, perform a mechanical calibration by referring to 
“Mechanical Cal” on page 129.

You can perform a Simple Response Cal for either: S11, or S22, or S21 AND 
S12.
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1-port response cals are also available from the Mechanical Cal menu. Learn 
more in “Calibration Type” on page 136.

Normalize uses a THRU standard or cable between port 1 and port 2 to cal an 
S21 and S12 Transmission measurement (NA Mode) and a 2-port Insertion 
Loss measurement (CAT Mode). In VVM Mode, this is performed using Zero.

When a Normalization is performed, the forward and reverse transmission 
tracking terms from CalReady are updated to account for the THRU that is 
used during the normalization process.

How to perform a Simple Response Cal

— Select the measurements to be calibrated. See the relevant Mode (NA, CAT, 
or VVM) for measurement selections.

— Press Cal 5 then Response Cal

— For 1-port measurements:

— Select either Open Response or Short Response for the port to be 
calibrated. The availability of this calibration on Port 2 may require an 
option.

— Connect an OPEN or SHORT standard to the specified port and press 
Measure 

— For 2-port measurements:

— Select Normalization 

— Connect a short, high-quality, phase stable cable between the 
FieldFox port 1 and port 2 connectors, then press Measure 

— Press Finish.

— Connect the DUT.

CAL ON U is shown on the screen when a User Cal (Ex: Response Cal) is 
correcting ONLY the appropriate measurement. For example, when an Open 
Response Cal on Port 2 is performed, CAL ON U is shown for an S22 
measurement only. 

With a Normalization Cal, all subsequent insertion loss measurements are 
made relative to the insertion loss of the cable used as the THRU standard. 
For example, if you use a cable with 1 dB of loss, then after Normalization, 
the display will show 0 dB of loss with this cable in place. Therefore, for 
highest accuracy, when measuring the DUT also attach the cable that was 
used in the normalization cal.
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View Cal

From the Choose Calibration screen (see “How to Perform a Calibration” on 
page 127), press View Cal to see the following screen:

The top box shows the properties of the current calibration that you performed 
and the displayed S-parameters that it is correcting.

The bottom box shows the S-parameters that are displayed but NOT corrected 
by the current performed calibration, but rather the CalReady calibration. 
Learn more about CalReady in “CalReady” on page 127.

Calibration Type

The FieldFox simplifies the calibration process by recommending the most 
accurate and efficient calibration type based on the displayed S-parameters. 

However, there may be times when you may want a little more accuracy or a 
little faster sweep time. The following information can help you learn about the 
various calibration choices. 
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Definitions:

Defined THRU – A THRU standard for which there is a Cal Kit definition such as 
in the 8551xA Cal Kits.

Flush THRU (also known as Zero length THRU) – When the test port cables 
mate together when measuring an Insertable DUT. No actual THRU standard is 
required because the test port cables are directly connected. Flush THRU is 
also a Defined THRU with a definition of zero loss and zero length.

Unknown THRU - Any THRU connection between the test ports. For more 
information see the FieldFox Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

Sweep Directions – Both FULL 2-Port Cals listed below result in correction 
that requires background measurements sweeps in both directions, regardless 
of the displayed measurements. The displayed traces are updated at a slower 
rate than Enhanced Response and 1-port calibrations, which require sweeps in 
one direction only. 

1-Port (OSL) 

DUT: No restrictions

S-parameters Corrected: S11 or S22 

Standards: OPEN, SHORT, LOAD

Sweeps in ONE direction.

FULL 2-Port (May require an option)

Most comprehensive calibration. Corrects all S-parameters

DUT: Non-Insertable or Insertable

Standards: OPEN, SHORT, LOAD on BOTH ports. Any THRU between ports. 

Non-insertable DUT – A device whose 
connectors could NOT mate together. They 
either do not have the same type of connector 
or they have the same gender. This also means 
that the test port cables could NOT mate 
together as in the above diagram.

Insertable DUT – A device whose connectors 
could mate together. They have the same type 
of connector and opposite or no gender. This 
also means that the test port cables could 
mate together, as in the above diagram. 
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Based on the SOLR/Unknown THRU calibration. For more information on 
the Unknown THRU process, see the FieldFox Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm

Sweeps in BOTH directions.

FULL 2-Port (QSOLT) – Mechanical Cal ONLY (May require an option)

Quicker to perform QSOLT than Full 2-port. Corrects all S-parameters.

DUT: Insertable only

Standards: OPEN, SHORT, LOAD on port 1. Flush THRU between ports. 

Recommended cal type for Insertable DUTs. A Cal Kit is NOT required for 
port 2.

Sweeps in BOTH directions.

Enhanced Response Cal - Forward OR Reverse (May require an option)

Faster measurements than Full 2-Port. 

DUT: Non-Insertable or Insertable. S-parameters PARTIALLY Corrected: 
S21 and S11 (Forward) OR S12 and S22 (Reverse)

Standards: OPEN, SHORT, LOAD on ONE port. Defined or Flush THRU 
between ports. 

Sweeps in ONE direction.

TRL – Mechanical Cal ONLY

A complete 2-Port calibration with potentially better accuracy than Full 
2-port. Corrects all S-parameters.

DUT: Non-Insertable or Insertable

Standards: Thru, Reflect, Line or variations of these. A TRL Cal Kit MUST be 
selected to see this Cal Type

Sweeps in BOTH directions.

Learn more about TRL Calibration in the Supplemental Online Help: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm

1-port Response Cals (Open or Short)

Calibrate the magnitude and phase of a measurement using ‘modeled’ 
mechanical standards. Measurement accuracy is better than Simple 
Response Cals (available on the main Cal page - see “Calibration Type” on 
page 136) but NOT as good as full 1-port cal. Corrects either S11 or S22. 
Can be used with Isolation (see following section). Learn more in “Simple 
Response Cals ” on page 134

Also select an Enhanced Response Optimization. Learn more in “Enhanced 
Response Optimization” on page 141.



Keysight N9938-90006 User’s Guide                                                                                                                      139

Calibration for NA, CAT, and VVM Modes

DUT: Non-Insertable or Insertable

S-parameters Corrected: S11 or S22 

Standards: OPEN or SHORT on ONE port

Sweeps in BOTH directions.

Isolation Step

The optional isolation step of a calibration corrects for crosstalk which is the 
internal signal leakage between the test ports. The Isolation step measures 
Load standards that are connected to one or both FieldFox test ports. 

Perform an isolation calibration when you are testing a device with high 
insertion loss, such as the stop band of a filter or a switch in the open position.

The isolation step can add noise to the error model when the measurement is 
very close to the noise floor of the analyzer. To improve measurement 
accuracy, set a narrow IF Bandwidth during the calibration.

The Isolation step is NOT allowed with ECal.

How to perform the Isolation step

— Press Cal 5 then Mechanical Cal / ECal

— Then Advanced 

— Then Omit Isolation 

— OFF Perform the Isolation step

— ON (default) Omits the Isolation step

— Then <Back

— Configure and perform the calibration as usual. At the first step of the Cal 
you will be prompted to connect a Load standard to one or both test ports.

— This setting survives an Instrument Preset.

Waveguide Calibrations

In general, calibrating with Waveguide is very similar to calibrating with coax. 
However, most coax mechanical Cal Kits have standards that can be used over 
a very wide frequency range. Waveguide Cal Kits are used over a narrow 

If the first calibration step does NOT prompt you to connect Load 
standards, then the Cal Kit probably does not contain an Isolation 
standard. You can use DataLink software to edit the Cal Kit and add an 
isolation standard using a Load standard. See Data Link Help for more 
information: 
https://na.support.keysight.com/fieldfox/help/DataLinkHelp/DataLink.ht
m
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frequency range. Therefore, it is VERY IMPORTANT to set the frequency range 
of the measurement WITHIN the frequency range of the waveguide Cal Kit. 
Otherwise, an error message will appear during the ‘Calculating Steps’ portion 
of the calibration.

Waveguide Cal Kits

Keysight sells two waveguide Cal Kit series: the premium 11644A series and 
the economy N9911X series. Both are available online at www.Keysight.com

Effective Velocity Factor

Velocity factor is the speed at which an electromagnetic signal passes through 
the transmission medium relative to the speed of light. This value is important 
when distance is being calculated in DTF measurements (CAT mode) and Time 
Domain (NA mode).

When the media is waveguide, the velocity factor changes with frequency. 
FieldFox calculates this ‘effective’ velocity factor automatically. However, the 
settings are different for CAT mode and NA mode.

CAT Mode - How to make Waveguide settings

These settings are necessary ONLY when making DTF measurements.

— Press Measure 1 then Distance to Fault (dB) to select a DTF measurement.

— Press Meas Setup 4

— Then Settings (Learn how to use the Quick Settings table in “How to view 
and change Quick Settings” on page 52.) 

— Set Media = Waveguide. Frequency Mode = BandPass is automatically 
selected for you.

— Scroll down to Waveguide Definitions. Select the Waveguide Standard 
being used. If your waveguide standard is NOT listed:

— Select User Waveguide. Then press Done. 

— Then DTF Cable Specifications, then Edit/Save/Recall Cables, then 
Edit Cable.

— Scroll to set Waveguide Definition. The default setting is VF Corr = 
Auto.

— Set the Min, Max, and Cutoff Frequencies.

— Press Done, then press Back.

— Cable Correction = Auto is the default setting. The Effective Velocity Factor 
is calculated automatically based on the frequencies of the waveguide 
standard. To override this setting, set Cable Corr = Man. 

NA Mode - How to make Waveguide settings
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These settings are necessary ONLY when your measurement requires electrical 
delay or port extensions, or if using Time Domain Transform.

— Press Meas Setup 4

— Then Transform

— Then Transform Settings 

— Under Transform Stimulus Settings, set the Start and Stop frequencies to 
those of the Waveguide.

— Set Stimulus = Bandpass Impulse

— Press Done

— Press Meas Setup 4 or Back 

— Then Calibration Settings 

— Set Media = Waveguide

— Set Cutoff Frequency. This is the absolute minimum frequency of the 
waveguide. This value must be less than the Start Frequency of the 
Waveguide.

Enter the calculated Effective VF value into the Velocity Factor setting.

Enhanced Response Optimization

When Enhanced Response Cal Type is selected, either for one calibration or for 
CalReady, this setting optimizes the calibration based on the type of DUT 
being measured. See also: CalReady Properties in “CalReady” on page 127.

This setting does NOT survive Preset.

— Press Cal 5 then More 

— Then Enh.Response

— Then choose from:

— NonReciprocal (default) An amplifier is a Non-Reciprocal device 
because it has gain in the forward direction, and very high loss 
(isolation) in the reverse direction. This choice provides the best 
correction for non-reciprocal devices, and reasonable correction for 
reciprocal devices.

— Reciprocal A reciprocal DUT is a device in which the insertion loss 
through the device is equal in both the forward (S21) and reverse 
(S12) directions. A cable is a reciprocal device. This choice provides 
the best correction for reciprocal devices. However, S11 
measurements on non-reciprocal devices will appear to have more 
return loss than the non-reciprocal choice.
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Interpolation *

Highest measurement accuracy is achieved when the frequency range or 
resolution settings remain the same during the measurement as when the 
FieldFox was calibrated. If these settings change after performing a calibration, 
the FieldFox will interpolate the calibration so that VERY accurate 
measurements continue to be made. 

Interpolated Calibrations are only slightly less accurate than a calibration 
performed at the measurement settings. Learn more about the relative 
accuracy of FieldFox calibrations in “Cal ON? – Questionable Accuracy” on 
page 142.

When a calibration that you performed is being interpolated, an asterisk is 
added to the Cal annotation. For example: Cal ON U* is shown on the screen 
when the current Response or Mechanical cal is being interpolated. An * is 
never added to a CalRdy.

Cal ON? – Questionable Accuracy

When the Output Power, Interference Rejection, or IF BW (NA Mode ONLY) 
setting is changed AFTER performing a calibration, a question mark is added to 
the Cal annotation.

The resulting measurement accuracy depends on how much the setting has 
changed. For highest accuracy, recalibrate using the new settings.

Compatible Mode Calibrations

The FieldFox can have only ONE calibration present for all modes. Because NA, 
CAT, and VVM modes are very similar, a calibration that is performed in one 
mode can also be applied in the other modes with the same type of 
measurements (1-port or 2-port). 

To apply a Cal that was performed in a different mode, press Cal 5 then select 
User Cal ON. 

Save the Calibration

After performing any type of calibration, you can save the FieldFox settings 
along with the calibration into a STATE (*.sta) file. These settings and 
calibration can then be recalled as necessary. To learn how, see “Saving and 
Recalling Files” on page 778.

CalReady Properties

There are several factory calibrations (CalReady) on every FieldFox. These can 
be selected based on the type of DUT that you measure most often, and the 
compromise that you prefer to make between measurement speed versus 
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measurement accuracy. Remember, CalReady was performed at the test ports. 
Therefore, a CalReady calibration is most accurate when the DUT is directly 
connected to the test ports. Learn more in “CalReady” on page 127. 

This setting does NOT survive Preset or Power ON/OFF.

— Press Cal 5 then More 

— Then press CalReady to toggle between the following selections:

— 2-Port Cal (default) Corrects all four S-parameters. Requires a 
forward and reverse sweep, which causes slower trace 
measurements. Learn why in “Calibration Type” on page 136. 

— Enh. Response Corrects forward (S21 and S11) and reverse (S12 and 
S22) measurements separately. Therefore, when measurements in 
only one direction are required, this choice provides faster trace 
measurements than a full 2-port cal. Also choose an Enhanced 
Response Optimization. Learn more in “Enhanced Response 
Optimization” on page 141.

To find the best choice for your DUT:

— Press Preset then Preset.

— Select the appropriate S-Parameter and other settings (frequency range, 
resolution, and so forth).

— Press Trace 6 then Math and Memory then Data->Mem.

— Press Data & Memory.

— Press Cal 5 then More 

— Select a CalReady Cal to compare with the current setting.

— Press Esc to exit the cal menu. 

— View the differences in the two traces. 
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Apply Nearest (NA Mode Only)

When Apply Nearest is pressed, interpolation is turned off and the nearest 
calibration point is applied when the start stop frequencies are changed for the 
current sweep. 

To use Apply Nearest:

— Press Cal 5 > More > Apply Nearest

Verifying Calibration and Jumper Cable Integrity
After calibrating, it is important to verify that the calibration is good. When 
using a jumper cable, also verify that the cable is of high quality. 

Verify a Calibration

— Connect a LOAD standard at the calibration reference plane (where 
calibration standards were connected). This may be at the end of the 
jumper cable or at FieldFox PORT 1 connector. 

— In CAT Mode, select Return Loss. 

— In NA Mode, select S11 with Log Mag format. 

— For frequencies lower than 9 GHz, observe the trace on the FieldFox 
screen:

— Lower than 35 dB indicates a GOOD calibration.

— Higher than 30 dB indicates that you should recalibrate.

Verifying Phase Accuracy

— Connect a LOAD standard at the calibration reference plane (where 
calibration standards were connected).

— In NA Mode, select a S11 Reflection with Polar or Smith Chart format.

IMPORTANT!

– Apply Nearest needs to re-selected after each pair of start and stop 
frequency points is entered, because the Apply Nearest feature is disabled 
when a new start stop frequency pair is selected.

– Apply Nearest calculates the number of points based on the start and 
stop frequency points entered.

– Apply Nearest will display the following error when there is no valid 
calibration found: 

“Error: 225, The required user calibration is not present.“
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— Because all LOAD standards have delay, you should see a small amount of 
phase rotation as a function of frequency. In general, the measurement 
result should agree with the characteristics of the calibration standard.  

Test the Jumper Cable

With the LOAD standard still connected, move the jumper cable while 
observing the trace. 

— If the measurement trace is relatively stable, the jumper cable is of good 
quality.

— If you observe significant movement in the peaks of the measurement trace 
when moving the cable (>5 dB), the jumper cable may need to be replaced.
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Calibration Method Summary
— Mechanical Full 2-port Cal is ALWAYS the most accurate Cal method. The 

quality of a Mechanical Cal is completely dependent on the quality of the 
OPEN, SHORT, LOAD standards and the quality of the standard 
connections. Use the correct high quality standards to ensure the most 
accurate calibration. 

— Even with the optional Load, phase accuracy begins to degrade when 
the return loss is greater than about 20dB.

— CalReady is accurate ONLY when the DUT is directly connected at the test 
ports and most accurate at room temperature. 

— For highest accuracy, a new Mechanical Cal should be performed:

— When the temperature changes more than about 10°F (5°C)

— When the connection to the DUT requires a different jumper cable or 
adapters. 

— When any of the following measurement settings change: Frequency 
Range, Power Level, IF BW, and Resolution.
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9 SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)

SA Mode measures signals at the SA RF IN connector. 

SA Mode measurements require NO calibration.

For a comprehensive SA mode tutorial, see Spectrum Analysis Basics 
(Application Note 150) at 
https://www.keysight.com/us/en/assets/7018-06714/application-notes/595
2-0292.pdf

For information on using the FieldFox Remote Viewer which enables you to 
view the FieldFox from your iOS device, refer to 
https://www.keysight.com/us/en/assets/7018-04070/application-notes/599
1-2938.pd f

Figure 9-1 SA Display with Markers

To better reflect the enhancements implemented during the alignment 
process, for firmware versions >A.10.15 “IF Flatness Alignment” is now 
referred to as “Channel Equalization” or “Channel Equalization Alignment” 
(ChanEQ Alignment).
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The graphic above shows an SA display with markers. 
Carrier with 5 kHz frequency modulation and deviation of 1 kHz.

In this Chapter

“Frequency Range” on page 151

“Radio Standard” on page 153

“Channel Selection” on page 155

“Reverse Swap” on page 156

“Scale and Units” on page 157

“External Gain” on page 158

“Attenuation Control” on page 159

“Preamplifier Control (Opt 235)” on page 160

“Check for Compressed Measurements” on page 160

“Field Strength Measurements” on page 161

“Using the Antenna/Cable Editor” on page 163

“Source Tracking Offset and Offset Reversal” on page 166

“Tune & Listen (AM/FM)” on page 166

“Analog Demod” on page 170

“Independent Source/Tracking Generator ” on page 181

“Resolution Bandwidth (Res BW)” on page 182

“Video Bandwidth (Video BW)” on page 183

“AF RBW (Audio-Frequency Resolution BW)” on page 184

“Sweep Type” on page 184

“IF Output” on page 185

“Sweep Acquisition” on page 188

“Very Long Sweep Times” on page 190

“Zero Span Measurements” on page 190

“Triggering” on page 192

“FFT Gating (Opt 238)” on page 196

“Single / Continuous / Restart” on page 198

“Points ” on page 198
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See Also

“Trace Display States (SA Mode)” on page 198

“Average Type” on page 199

“Average Count” on page 200

“Alignments” on page 201

“RF Burst Amplitude Alignment” on page 206

“Detection Method” on page 208

“Display Line” on page 210

“Noise Marker” on page 211

“Band/Interval Power Marker” on page 211

“Frequency Counter at Marker” on page 212

“Audio Beep at Marker Power” on page 213

“Meas UNCAL Error” on page 214

“Old Data Indicator (*)” on page 214

“Radio Standards and Channel Measurements” on page 215

“Measurement Preset” on page 215

“Averaging” on page 215

“Traces” on page 216

“Channel Power (CHP)” on page 216

“How to Set Up EMF Settings (Requires EMF (Option 358), GPS (Option 
307), and SA Mode (Option 233–Mixed Analyzers))” on page 226

“Spectrum Emission Mask (SEM) — (SA Mode Only)” on page 238

“IQ Analysis (Requires Option 351 IQ Analyzer and Option 353 IQ 
Streaming, SA Mode Only)” on page 245

“Effective Isotropic Radiated Power (EIRP) – (SA Mode Only)” on page 248

Interference Analyzer:

“Spectrogram Display (SA Option)” on page 514

“Waterfall Display” on page 517

“Record/Playback (SA Option)” on page 519
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Optional Settings:

“All about Markers” on page 700

“All about Limit Lines” on page 715

“Saving and Recalling Files” on page 778
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SA Mode Settings
Select SA Mode before making any setting in this chapter.

Because there is no calibration, these settings can be made in any order.

How to select SA Mode

— Press Mode_ 

— Then SA.

Frequency Range

The X-axis frequency range determines the frequencies that are measured for 
each sweep. The default Start frequency is 0 Hz. However, the Start frequency 
can be set as low as –100 MHz. The internal LO of the FieldFox can be seen at 
0 Hz, which will mask signals that may be present. 

Available ONLY with Opt. 209 and while in Step sweep, SA mode allows reverse 
sweeps. This means the Start frequency can be higher than the Stop 
frequency. In addition, the Reverse Swap feature can be used to quickly 
reverse the Start and Stop frequencies. Learn how in “Reverse Swap” on 
page 156.

The frequency range of the measurement can be changed using the following 
methods:

— Set Center and Span frequencies

— Set Start and Stop frequencies

— Toggle between Zero and Last selected span

— Set Full Span of the FieldFox 

— Using Channel selection. Learn how in “Channel Selection” on page 155.

— Using Marker > Center (frequency). Learn how in “SA Marker Functions” on 
page 714.

How to set Frequency Range

— Press Freq/Dist. 

— Then choose from the following:

Although the start frequency can be set as low as -100 MHz, amplitude 
accuracy is specified above 9 kHz.  Below 9 kHz, frequency accuracy is 
maintained, but amplitude accuracy is degraded. 

The FieldFox can be used with an OML frequency extender. Refer to 
“Utilities” on page 732, the B Series FieldFox Configuration Guide 
5992-3701EN, and to “Contacting Keysight” on page 5.
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—Center and Freq Span frequencies. This is the most common method 
of entering frequency range. Enter the frequency of interest. The 
Center frequency is at the exact center of the X-axis. The Frequency 
Span places half of the frequency range on either side of center. 
When the Center and Frequency Span values are entered, then the 
X-axis annotation on the screen shows the Center and Span 
frequencies. 

—Start and Stop frequencies. Start is the beginning of the X-axis and 
Stop is the end of the X-axis. When the Start and Stop frequencies 
are entered, then the X-axis annotation on the screen shows the Start 
and Stop frequencies. 

— Follow each of these by entering a value using the numeric keypad, the 

 arrows, or the rotary knob.

— When using the  arrows, press Enter. The increment setting of the 
arrows is based on the current span. This can be changed in SA Mode. See 
How to change frequency step size below.

— After using the keypad, select a multiplier key. Learn more in “Multiplier 
Abbreviations” on page 46.

Two more ways to change the frequency range

— Press Freq/Dist

— Then choose from the following:

—Zero/Last Span Each key press toggles the frequency span between 
0 Hz and the last specified frequency span. Learn more about Zero 
Span in “Zero Span Measurements” on page 190.

—More

— Then Full Span Selects the entire frequency span of the FieldFox. The 

Center frequency is set automatically.

Integration BW (IBW) is coupled to the Frequency Span setting. Frequency 
Span is 50% wider than the IBW (e.g., if the IBW value is 1 MHz, then the 
Frequency Span value is 1.5 MHz).

Integration BW (IBW) is coupled to the Frequency Span setting. Frequency 
Span is 50% wider than the IBW (e.g., if the IBW value is 1 MHz, then the 
Frequency Span value is 1.5 MHz).

When in full span, ADC dither raises the noise floor at the edges of the 
120 MHz.
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How to change frequency step size

When using the  arrows to change any of the frequency settings, the size 
of the frequency step can be changed. 

— Press Freq/Dist 

— Then More 

— Then CF Step Auto Manual

—Auto Each press of the  arrows increments or decrements the 
value by 1/10th (one division) of the current frequency span. Note: To 
change this setting from Manual to Auto, press CF Step twice.

—Manual Type a step size value using the numeric keypad, then select a 
multiplier key. Learn more in “Multiplier Abbreviations” on page 46.

How to change from Linear to Log Axis View

— Press Freq/Dist > More

— Then choose from the following:

— Log Freq AxisX enables/disables the log frequency X-axis. Disabling 
the log frequency X-axis, enables the linear frequency X-axis (Default 
= OFF).

— Then Full Span Selects the entire frequency span of the FieldFox. The 

Center frequency is set automatically.

Radio Standard

A Radio Standard is a collection of settings that are applied to the FieldFox for 
specific RF protocols. When a Radio Standard is applied, the FieldFox 
frequency and channel settings change to that of the standard.

By default, the FieldFox locates the center frequency of the standard in the 
middle of the screen and sets the frequency span to cover all of the Uplink and 
Downlink frequencies. The selected Radio Standard name appears in the 
center of the screen below the X-axis. 

After a Radio Standard has been selected, the frequency range can be 
changed by selecting channel numbers rather than frequency. Learn how in 
“How to set Frequency Range” on page 151.

When a Channel Measurement is selected such as ACPR, other relevant 
settings will be changed such as Integration BW. Learn more about Radio 
Standards and Channel Measurements in “Radio Standards and Channel 
Measurements” on page 215.

When in full span, ADC dither raises the noise floor at the edges of the 
120 MHz.
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How to select a Radio Standard

— Press Measure 1 OR Freq/Dist then More 

— Then Radio Standard

— Then Radio Standard

— Then select a standard using the  arrows or rotary knob and press 
Enter.

Custom Radio Standards

Your own custom Radio Standards can be imported into the FieldFox. Custom 
standards are created in *.csv (spreadsheet) format.

A template and instructions for creating your custom Radio Standard is at: 
http://na.support.keysight.com/fieldfox/help/SupHelp/Reference/CustomRa
dioStandard.htm

Once imported, the *.csv file is stored in the FieldFox \User Data\ folder. The 
custom Radio Standards are read and presented at the top of the list of internal 
Radio Standards. 

How to Import and Delete a Custom Radio Standard

First, press Save/Recall and select the Device from which the Radio Standard 
will be read. Most likely this will be USB or SD Card. 

— Press Measure 1 OR Freq/Dist then More 

— Then Radio Standard

— Then Radio Standard

— Then Import Radio Standards

— Then select the *.csv file using the  arrows or rotary knob and press 
Enter. 

— Custom Radio Standards can be removed from the FieldFox by selecting 
Measure 1 then Radio Standard then Delete Radio Standard. 

— Then select the *.csv file to delete using the  arrows or rotary knob and 
press Enter.

To overwrite a custom standard that is already uploaded to the FieldFox, 
you must first delete the *.csv file from the FieldFox, then re-upload the file 
that contains the standard. A predefined internal standard (such as GSM 
450) can NOT be deleted from the FieldFox.
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Channel Selection

After a Radio Standard has been selected, the frequency range can be 
changed by selecting channel numbers rather than frequency. Once enabled, 
the channel number is appended to the X-axis frequency range.

How to Enable Channel selection

— Press Freq/Dist

— Then More 

— Then Unit   Freq Chan 

With Unit = Chan, Channel Direction becomes available and CF Step alters to 
Channel Step.

How to change the Channel Number of the Measurement

With Unit = Chan the FieldFox will NOT allow you to specify channels outside 
of the selected Radio Standard. 

— Press Freq/Dist

— Then choose from the following:

—Center Channel Places the center frequency of the specified channel 
in the middle of the X-axis. 

—Start Channel Places the lowest frequency of the specified channel at 
the beginning of the X-axis. 

—Stop Channel Places the highest frequency of the specified channel at 
the end of the X-axis.

—Freq Span Changes the span of frequencies while the center frequency 
remains unchanged.

—Follow each of the above settings by entering a value using the 
numeric keypad or the rotary knob. 

—Use the  arrows to increment the channel number by an amount 
specified by the Channel Step value (see below).

— Then press Enter or Enter. 

Integration BW (IBW) is coupled to the Frequency Span setting. Frequency 
Span is 50% wider than the IBW (e.g., if the IBW value is 1 MHz, then the 
Frequency Span value is 1.5 MHz).
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Select either Uplink or Downlink Frequencies

Press Freq/Dist then More. Press Chan Direction to toggle between Uplink 
and Downlink. If either of these selections is not available, then the selected 
Radio Standard does not contain those frequencies. In that case, Chan 
Direction is grayed out.

Channel number X-axis annotation

— Dn indicates Downlink channels. 

— Up (not shown) indicates Uplink channels

— (−) indicates that the lowest frequency in the channel (128) is at the left 
edge of the screen. 

— (+) indicates that the highest frequency in the channel (130) is at the right 
edge of the screen. 

— When Center Channel or Freq Span is specified, the X-axis shows the 
Center Freq (Channel) and Frequency Span.

— When Start or Stop Channel is specified, the X-axis shows the Start Freq 
(Channel) and Stop Freq (Channel).

Change Channel Step Size (Optional)

This setting allows you to use the  arrows to increment the channel 
number by the specified value. The Channel Step softkey appears only when it 
is valid. Learn how to make it valid in the section, “See How to change the 
Channel Number of the measurement”?

— Press Freq/Dist then More.

— Press Channel Step

— Enter a step value using the numeric keypad, the  arrows, or the rotary 
knob. Then press Enter. 

Reverse Swap

Available ONLY with Opt. 209 and while in Step sweep mode. Each press of the 
softkey causes the Start and Stop frequencies to swap. The Start becomes the 
Stop and vice versa. Learn more about Step versus FFT sweeps in “FFT Gating 
(Opt 238)” on page 196. 
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— Press Freq/Dist then More.

— Then Reverse Swap

Scale and Units

Adjust the Y-axis scale to see the relevant portions of the data trace. 

The Y-axis is divided into 10 graticules. A acquisition is shown on the screen as 
a solid horizontal bar that can be placed at any graticule.

When RF Attenuation set to Auto, the RF Attenuation is coupled to acquisition. 

How to set Scale

Press Scale / Amptd. Then choose from the following:

— Autoscale Automatically adjusts the Y-axis to comfortably fit the Minimum 
and Maximum amplitude of the trace on the screen.

— Scale Manually adjust the scale per division to view specific areas of the 

current trace. Enter a value using the numeric keypad, the  arrows, or 
the rotary knob. Then press Enter. 

— Ref Level Manually set the value of the reference line. Enter a negative 
value by pressing Run/Hold (+/-) either before or after typing a value. This 
can also change the RF Attenuation setting. See “Attenuation Control” on 
page 159.

— Preamp Refer to “Preamplifier Control (Opt 235)” on page 160.

— RF Atten Refer to “Attenuation Control” on page 159.

— More opens another set of scale softkeys. 

Manually set Scale Type, acquisition, and Reference Position.

— Scale Type [current setting]

—Log Logarithmic scale (default setting). The Y-axis reference line 
represents the specified absolute acquisition in the current Unit 
selection. Y-axis graticules show dB below or above the reference 
line.

—Lin Linear scale. The Y-axis reference line represents the specified 
absolute acquisition in the current Unit selection. Y-axis graticules 
show percent of acquisition (%) below or above the reference line.

— Unit Refer to “How to Set Y-axis Units” on page 158.

— Corrections Refer to “How to select and edit corrections for Field Strength 
measurements” on page 161.
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— External Gain Refer to “External Gain” on page 158.

— Ref Pos Manually set the position of the reference line. Values must be 
between 0 (TOP line) and 10 (BOTTOM line). Default position is zero (top).

How to Set Y-axis Units

The Unit setting appears for the reference line, marker readouts, and trigger 
level. All Unit choices are available in both Log and Linear Scale Types. 

The UNIT setting survives Mode Preset, but NOT Preset.

— Press Scale / Amptd, then More, then Unit 

— Then choose from the following:

—dBm (default setting), dBmV (dB milli Volts), dBuV (dB microVolts), W 
(watts), V (volts), A (amps), dBmA (dB milliAmps), dBuA (dB 
microAmps). 

Antenna correction units are available ONLY by loading or editing an Antenna 
file that contains the desired units setting. Learn more In.

External Gain

When using an external amplifier or attenuator, the SA mode trace amplitude 
values can be offset to compensate for the effect of the external device.  This 
effectively moves the reference plane of the SA measurement port out to just 
beyond the external device. For example, when using an external preamp with 
gain of +10 dB, enter this value for External Gain, and the data trace across the 
displayed frequency span will be adjusted down by 10 dB. 

When RF Atten is set to Auto, you may see a change in the RF Attenuation 
value. This is an attempt to measure the signal at top of screen (the 
acquisition) without overloading the SA first mixer.

How to Set External Gain

— Press Scale/Amptd.

— Then More

— Then External Gain

— Enter a value using the numeric keypad, the  arrows, or the rotary knob 
(positive for gain; negative for loss). Values less than 5 dB must be typed 
using the numeric keypad. Then press Enter

ExtGain xx dB is shown at the top of the screen.
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Attenuation Control

Both the RF Attenuation and Preamp functions control the power level into the 
SA.

When too much power is present at the RF Input port, ADC Over Range 
appears on the FieldFox screen. This does not necessarily mean that damage 
has occurred, but that the measurement is probably compressed. 

When high power levels are present at the RF Input port, internal attenuation 
can be switched in to keep the FieldFox receiver from compressing. At 
extremely high power levels, use external attenuation to protect the internal 
circuitry from being damaged. 

The displayed power level is automatically adjusted for RF Attenuation. As the 
attenuation value changes, the displayed power level should NOT change.

How to set Attenuation

— Press Scale/Amptd.

— Then RF Atten Auto Man.

— Auto RF Attenuation is set by adjusting the acquisition. As the acquisition is 
lowered, for example from –10 dBm to –40 dBm, the FieldFox assumes that 
you are looking at low-level signals. The RF Attenuation value is 
automatically lowered in 5 dB steps to allow low-level signals to be viewed. 
The RF Attenuation value is never automatically lowered below 5 dB.

— Man RF Attenuation is set manually. The default Attenuation setting is 
10 dB. Enter a value between 0 to 40 dB in 5 dB steps using the numeric 

keypad, the  arrows, or the rotary knob. Then press Enter

#Atten xx dB is shown at the top of the screen. (#) means manual setting.

The FieldFox can be damaged with too much power. Refer to the FieldFox 
Data Sheet for your model on 
https://www.keysight.com/us/en/assets/7018-06516/data-sheets/5992-
3702.pdf.

Maximum Input Voltages and Power:

RF Output Connector: 50V DC, +23 dBm RF

Ext Trig/Ref Connector: 5.5 V DC

RF Input: 

    +27 dBm RF, ±50 VDC Max. (N991xA/B, N9925B, N9926A,       
      N9928A, N993xA/B)

    +23 dBm RF, ±50 VDC Max. (N9923A, N9923AN)

    +25 dBm RF, ±40 VDC Max. (N995xA/B, N996xA/B)

DC Input: 19VDC, 4ADC, 60 Watts maximum when charging battery
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Preamplifier Control (Opt 235)

When very low-level signals are analyzed, an internal preamplifier can be used 
to boost the signal level by approximately 22 dB. The gain of the preamp is 
NOT adjustable. The displayed signal level is automatically adjusted for the 
increase in system gain. 

How to control the Preamp

By default, the preamp is OFF. 

— Press Scale/Amptd.

— Then Preamp ON OFF The underlined setting is the current setting. When 
ON, PA is shown to the left of the graticules on the display.

Check for Compressed Measurements

Compression occurs when too much power into an amplifier causes it to no 
longer amplify in a linear manner. When too much power goes into the 
FieldFox RF Input connector, the amplifiers in the SA receiver compress and 
signal power will not be displayed accurately. This can occur even if ADC Over 
Range is not displayed because devices other than the ADC, such as the mixer, 
might be compressed. Increase the RF Attenuation value to prevent the SA 
receiver from being compressed. 

How to Check for a Compressed Measurement

— Using a marker at the signal peak, make note of the signal power level.

— Increase the RF Attenuation level by 5 dB.

—If the signal level does NOT change, then NO compression exists. This 
indicates that the signal is in the linear region of the FieldFox 
receiver. 

—If the signal level DOES increase, then the receiver was compressed. 
Set the RF Attenuation value at the setting when further increases no 
longer result in an increase in the displayed power level. 
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Field Strength Measurements

To measure the strength of any signal transmitted through the air, an antenna 
must be connected to the FieldFox. The Field Strength feature allows you to 
enter the frequency response of the receiving antenna (the Antenna Factor) 
and associated cabling, and then have amplitude corrections automatically 
compensate the displayed trace for that response. 

Field Strength Measurements

Trace 1 - Corrected trace with antenna factor. (Antenna = ON, Apply Corr = 
ON)

Trace 2 - Uncorrected trace (Apply Corr = OFF). The Trace 2 trace state is 
“View.” For information, refer to “Trace Display States (SA Mode)” on page 198

Pink Trace - Current correction factor. See below.

— Learn how to set Y-Axis Units on “How to Set Y-axis Units” on page 158.

— Use a Band Power marker to measure total power over a range of 
frequencies. Learn how in “Band/Interval Power Marker” on page 211 

How to select and edit corrections for Field Strength measurements

The Antenna and Cable correction data survives a Mode Preset and Preset.

All Correction ON/OFF states survive a Mode Preset, but NOT a Preset.

— Press Scale/Amptd > More > Corrections

— Then choose from the following:

— Apply Corrections Auto Disabled Use Auto and Disabled correction 
for all settings. (Default = Auto). 

—  Antenna Off – Opens a softkey menu to enable/disable a antenna 
and edit, save, create a new antenna factors table, recall, and set a 
storage device location.
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— Cable Off – Opens a softkey menu to enable/disable a cable and edit, 
save, create a new cable description table, recall, and set a storage 
device location.

— More – Opens a softkey menu to View Corrections and set the 
Amplitude Correction type for your antenna.

Learn more, see “Selecting and Viewing Corrections” on page 162.

— More – Edit/Recall an Antenna file to be used to transmit.

— RcvrSide Antenna Off / On Edit/Recall an Antenna file to be used to 
receive.

— SrcSide Cable Off / On Edit/Recall a Cable file to be used on the 
Source side.

— RcvrSide Cable Off / On Edit/Recall a Cable file to be used on the 
Receiver side.

Selecting and Viewing Corrections

— Press Scale/Amptd > More > Corrections > More

— View Corrections ON OFF Turn ON and OFF Pink Trace - Antenna/Cable 
corrections. This is a composite of all cable/antenna corrections that are 
currently applied. Available as a useful visual aid, the zero “dB” level (no net 
correction) is mapped to appear at the -50 dBm on-screen level.

— Amp Corr Select [Triaxial XYZ] - then choose one of the following: 

— Default Receiver side only antenna measurements.

— Src/Rcvr Split to work with non-triaxial receiver and source side 
antenna measurements.

— Triaxial XYZ (default, when Channel Power is on and when a 
compatible triaxial antenna’s factors have been imported) for 
measuring channel measurements and EMF. 

How to Use the Antenna Softkeys

The following menu appears when any of the above Antenna Off or Cable 
softkeys are pressed:

— Antenna/Cable ON OFF – Turn correction ON or OFF for this 
Antenna/Cable.

— Edit Antenna/Cable – Edit an Antenna/Cable Correction table. See Using 
the Antenna/Cable Editor (below) for more information. 

— New – Create a new Antenna/Cable. See Using the Antenna/Cable Editor 
(below) for more information.
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— Save Antenna/Cable – Save the modified Antenna/Cable to a file on the 
specified Storage Device.

— Recall Antenna/Cable – Read an existing Antenna/Cable file from the 
specified Storage Device.

— Storage Device – Choose from: Internal, USB, SD. Learn more about these 
selections in “Set File Type and Select Device” on page 783.

When finished, press Back to return to the previous menu.

Using the Antenna/Cable Editor

The Antenna Editor and the Cable Editor menus are very similar. Both tables 
include header information, and a Frequency/Value table. 

Figure 9-2 FieldFox Antenna Editor – E–Field and H-Field Units Displayed

How to use the Antenna/Cable Editor

— Press Scale/Amptd > More > Corrections then choose:

— Antenna Off to open the antenna editing softkeys

— Cable Off to open the cable editing softkeys

Once you have selected Antenna or Cable to edit:

— Press New then Yes to clear all data from the existing Antenna or Cable 
table and reset header information to default settings.

E-Field Units H-Field Units
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— Then Edit Antenna or Edit Cable to open the Antenna / Cable Editor. 
(Antenna must be enabled to view a change in the antenna units.)

— Then use the  arrows to select a field.

— To edit header information, press Edit then modify the selected field 
using the FieldFox labeler.

——Description: Enter a description for the antenna or cable 
correction table. This is NOT the filename used to save the file.

——Antenna Factor Unit (Rcvr-side Antennas only): Units in which 
the measurement will be displayed. Select NONE (default 
setting) to select from standard SA Units on the Scale menu. 
Learn how in “Scale and Units” on page 157. 

——Choose from: dB μV/m - (dB micro Volts per meter), dB μA/m 
- (dB micro Amps per meter), dBG (gauss), dBpT (tesla). 

——Freq Interpolation: Set to LINear and can NOT be edited.

— To edit Frequency/Value pairs, enter numbers using the numeric 
keypad, and a frequency suffix when necessary.

——For both Cable Loss and Antenna Factor values, Positive 
numbers indicate loss (we need ADD something positive to 
compensate for it), and Negative is indicative of some existing 
gain.

——Antenna Factor describes the dB value needed to accurately 
display a far-field signal in terms that are in the units listed 
below. When the antenna has low gain, or low efficiency, the 
dB value to be added is larger.

——Antenna Factor Unit sets the type of antenna factor unit used 
in your measurement (i.e., dB /m or DB S/m).

— When one Freq/Value pair is entered, that correction value is applied 
to the entire displayed frequency span. 

— When two or more Freq/Value pairs are entered, the data points 
between the lowest and highest frequencies are corrected. Linear 
interpolation is applied between frequencies when necessary.

— Optionally choose from the following:

—Previous / Next Page Quickly scrolls through pages of Freq/Value 
data.

— Add Row Add a blank Freq/Value pair to the table,

—Delete/Clear then:

——Delete Row Remove the selected Freq/Value pair from the 
table. 
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——Clear All then Yes Remove all Freq/Value pairs from the table 
and resets header information to default settings.

When the table edits are complete

— Press Done to close the Antenna/Cable Editor.

— Press Save Antenna or Save Cable to save your changes to the specified 
Storage Device. Enter a filename using the FieldFox labeler (learn more in 
“How to use the FieldFox labeler ” on page 780). Learn more about 
Antenna and Cable files below.

— Press Recall Antenna or Recall Cable to load an Antenna or Cable file from 
the specified Storage Device.

— Storage Device Changes the device used to save or recall files. Choose 
from Internal (default setting), USB (must be connected) or SD card. This is 
a different setting from the Save/Recall Storage Device setting.

About Antenna and Cable files

— Cable files are saved and recalled from the Cables folder. 

— Antenna files are saved and recalled from the Antenna folder.

— To DELETE Cable or Antenna files, use the Manage Files feature. Learn more 
in “Manage Files” on page 786.

— If the folder does not already exist on a USB or SD card, it is created 
automatically before storing the file.

— All SA mode Antenna and Cable files are saved and recalled as *.csv files, 
which allows them to also be read by spreadsheet programs. 

— The FieldFox can also read *.ANT (Antenna) files that were created from 
older Keysight Spectrum Analyzers. 

— SA Mode cable or antenna (*.csv or *.ANT) files can NOT be edited in Data 
Link software. 

How to create a Cable file from an S21 (NA mode) or an Insertion Loss 
(CAT mode) measurement

1. Measure the S21 or Insertion Loss of a cable. In NA mode, select either 
LogMag, Linear, or VSWR formats. 

2. Use Manage Folders to change the active folder to CABLES. Learn how in 
“Manage Folders” on page 788.

3. While in NA mode, save the measurement as a *.csv file. Learn how in “How 
to Save a File” on page 778. 
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4. In SA mode, select Corrections, then recall the *.csv file for correction.

Source Tracking Offset and Offset Reversal

This feature requires: 

— N991xB and N995xB FieldFox Combination Analyzers to have Options 209, 
210, and 233

— N993xB and N996xB Spectrum Analyzers to have Options 209 and 220 

Source offset tracking is used to offset the Source frequency from the Receiver 
frequency by a fixed offset at every tune frequency. This feature is used when 
the DUT contains a frequency translation device or mixer.

How to set Tracking Offset and Offset Reversal

— On the Receiver unit, press Measure 1

— Then Source 

— Then Advanced 

— Then choose one or both of the following:

—Tracking Offset Enter an offset value.

—OffsetReversal Determines whether Receiver Freq is added to or 
subtracted from the Offset Freq.

——OFF SourceFreq = Offset + RecFreq. Use to measure 
Upconverters.

——ON SourceFreq = Offset - RecFreq. Use to measure 
Downconverters. The source sweeps in Reverse direction. 
Note: The Offset Freq. MUST be larger than the Receiver Stop 
Freq.

Tune & Listen (AM/FM)

The Tune & Listen feature can be used to identify an interfering AM or FM 
signal.

The demodulated AM or FM signal can be heard through the internal speaker 
or through headphones using the 3.5 mm jack located on the FieldFox side 
panel. 

The Tune & Listen tuner is separate from the SA display. This allows you to 
listen to one frequency while displaying a different range of frequencies. The 
Tune & Listen measurement alternates between normal SA sweeps for the 
display and performing audio demodulation at the Tune Frequency. See the 
Listen Time setting for more information. 
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Figure 9-3 Tune & Listen ON

In the graphic above, Tune & Listen ON with Tune Frequency is indicated by a 
vertical bar (highlighted).

How to select Tune & Listen

— Press Measure 1

— Then Analog Demod Tune & Listen > Tune & Listen

This section contains the following:

“How to select Tune & Listen” on page 167

– “TnL AM SSB Gain” on page 168

“Tune Frequency” on page 168

“Listen Time” on page 169

“To select Listen Time:” on page 169

“Volume Control” on page 169

“Audio Demod ON and OFF” on page 170

“Setting the Marker Counter Precision Softkey” on 
page 170

“Setting the Mkr->TuneFreq Softkey” on page 170
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— Then choose a demodulation type. Select a setting based on the type of 
interfering signal you suspect is being broadcast. 

— Press Meas Setup 4 > Tnl Demod Type then

— AM – Sets AM (Double-sideband with carrier) as the modulation 
type.

— FM Narrow – Sets Frequency Modulation; Narrow bandwidth. 
Choose when interfering transmission consist of voice or data.

— FM Wide – Sets Frequency Modulation; Narrow bandwidth. Choose 
when interfering transmission consist of voice or data.

— AM USB – Sets the modulation type to AM upper sideband. 
Annotation: AM USB @ Center Frequency displayed at the top of 
display. See also, “TnL AM SSB Gain”. 

— AM LSB – Sets the modulation type to AM lower sideband. 
Annotation: AM LSB @ Center Frequency displayed at the top of 
display. See also, “TnL AM SSB Gain”. 

See also, “How to select Analog Demod (Metrics)” on page 172.

TnL AM SSB Gain

When you select AM USB or AM LSB softkeys, the TnL AM SSB Gain softkey 
becomes active.

— Press Meas Setup 4 > More then

— TnL AM SSB Gain – sets the gain in the IF path for TnL SSB measurements 
(the optimal IF path gain is automatically determined/set for regular AM 
and all the other demod types, but it cannot be automatically determined 
for AM SSB so it has to set it manually). 

The goal is to set the gain as high as possible (to take advantage of the 
range of the IF and audio paths) without distorting the audio signal. It is 
recommended that you keep increasing the gain until you hear distortion in 
the audio and then back off until you no longer hear any distortion.  
(Default = 0, Minimum = –50 dB, Maximum = +50 dB)

Tune Frequency

The Tune & Listen tuner is separate from the SA display. This allows you to 
listen to one frequency while displaying a different range of frequencies. 

The system volume setting should still be used to determine the final 
desired volume/level of the audio output. Learn more, see also Chapter 30, 
“System Settings.” and “Audio (Volume) Control” on page 728.
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Set the Tune Frequency using one of three methods:

1. Selecting Preset > Mode Preset, sets Tune Frequency to 3.25 GHz (e.g., for 
a N9914B FieldFox).

2. Specify Tune Frequency:

— Press Meas Setup 4 > Tune Freq

— Enter a value using the numeric keypad,  arrows, or the rotary 
knob. Then select a multiplier key. Learn about multiplier 
abbreviations “Multiplier Abbreviations” on page 46. 

3. Using Mkr->Tune Freq:

— Create a normal marker at the frequency of interest. Learn how in 
“How to create Markers” on page 700. 

— Press Mkr->/Tools

— Then Mkr->TuneFreq to change the Tune Frequency to that of the 
marker.

Listen Time

While Tune & Listen is actively demodulating a signal, the SA does not sweep 
and update the display. Listen Time sets the amount of time that the FieldFox 
demodulates, then stops to perform a single sweep and update the display, 
then again demodulates. 

To select Listen Time:

— Press Meas Setup 4 > Listen Time

— Enter a value using the numeric keypad,  arrows, or the rotary knob. 
Then select a multiplier key. Learn about multiplier abbreviations. 

Volume Control

To increase or decrease the Volume of the demodulated signal:

— Press Meas Setup 4 > Volume

— Enter a value in percent between 0 and 100 (loudest) using the numeric 

keypad,  arrows, or the rotary knob. 

— Volume can also be changed and easily muted from the System menu. 
Learn more in “How to set the FieldFox Volume Control” on page 729.

To improve sound quality, try increasing power by reducing the 
Attenuation setting and, if available, turn ON the Preamplifier. Learn how 
in “Attenuation Control” on page 159
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Audio Demod ON and OFF

To quickly stop the audio demodulation and perform only the normal SA 
sweeps, select the following:

— Press Meas Setup 4 > Audio Demod ON OFF > OFF

Setting the Marker Counter Precision Softkey

When AM Tune & Listen, FM (narrow) Tune & Listen, or FM (wide) Tune & 
Listen are selected, you can choose from the following: 

— Press Marker > Peak

— Press Mkr->/Tools > More > Mkr Properties > Counter Precision – Sets the 
AM or FM Metric demodulated signal’s marker precision (.1 Hz, 1 Hz, 10 Hz; 
default = 0.1 Hz).

The Counter Precision softkey is not available when AM Metric or FM Metric 
are enabled. See also, “Setting the Mkr->TuneFreq Softkey” on page 170.

Setting the Mkr->TuneFreq Softkey

When AM Tune & Listen, FM (narrow) Tune & Listen, or FM (wide) Tune & 
Listen are selected, you can choose from the following: 

— Press Marker > Normal

— Press Mkr->/Tools > Mkr->TuneFreq – The Tune & Listen Frequency 
becomes the frequency of the active marker (When AM Metrics or FM 
Metrics are selected this softkey is inactive).

See also, “How to use Marker Functions” on page 713.

Analog Demod

The Tune & Listen feature can be used to identify an interfering AM or FM 
signal. Also, AM/FM Metrics displays the demodulated signal and the audio 
frequency spectrum.

The demodulated AM or FM signal can be heard through the internal speaker 
or through headphones using the 3.5 mm jack located on the FieldFox side 
panel. 
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The Analog Demod spectrum is displayed alongside the SA displayed trace. 
This enables you to listen and display a carrier frequency and it’s harmonics. 
The Analog Demod measurement displays a normal SA sweeps for the display 
while performing audio demodulation at the carrier Frequency. See the “How 
to select Analog Demod (Metrics)” on page 172 setting for more information. 

Figure 9-4 AM DSB (Metrics) – Demodulation Spectrum

In the graphic above, Analog Demod ON and Demod Metrics is indicated 
above in the x2 displays of carrier spectrum content. For this example, AM 
Modulation Metrics are displayed in the lower half of the display. See also, 
Figure 9-5 on page 179, Figure 9-6 on page 179, Figure 9-7 on page 180, and 
Figure 9-8 on page 180. 

This section contains the following:

“How to select Analog Demod (Metrics)” on page 172

“How to make Analog Demodulation (Metrics) 
Settings” on page 173

“Setting the Alternate Frequency (AF) Freq/Dist 
Softkeys” on page 174

“Setting the Alternate Frequency (AF) RBW Softkey” 
on page 175
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How to select Analog Demod (Metrics)

Analog demodulation can demodulate AM DSB, AM SSB, FM, FM Stereo / 
RDS, PM signals. Under analog demodulation metrics the following 
information is reported for each signal type: Carrier power, modulation rate, 
SINAD, THD, plus deviation, depth, or RMS depending on the signal. Metrics 
also displays the demodulated signal and the audio frequency spectrum.

Learn more, Chapter 26, “AM/FM Metrics (SA Only and Option 355).”

— Press Measure 1 > Analog Demod Tune & Listen > Analog Demodulation

— Demod Type – Then choose a demodulation metric type. Select a setting 
based on the type of interfering signal you suspect is being broadcast. 

— AM – AM (double sideband). Displayed values for AM Modulation 
(metrics) – (i.e., includes AM Mod Depth, AM Demod Waveform, 
SINAD, THD, Carrier Power, Carrier Freq, Modulation rate).

— AM SSB – AM single sideband. Displayed values for AM SSB 
(metrics) – (i.e., includes SSB RMS Level, SSD Demod Waveform, 
SINAD, THD, RF Power, Modulation rate).

— FM – Displayed values for FM Modulation (metrics) (i.e., includes 
Freq Deviation, FM Demod Waveform (Time)/Spectrum (Frequency), 
Carrier Power, Carrier Freq, Modulation Rate, SINAD, THD).

“Setting the Audio Capture Playback Softkeys” on 
page 175

“How to Set the Demod Filters” on page 177

“Setting the Marker Counter Gate Softkey” on 
page 178

IMPORTANT! The FieldFox contains only one speaker that supports mono 
audio output (i.e., if you play a stereo WAVE file, the Left and Right 
channels are output in mono audio). If you want to output a stereo WAVE 
file in stereo (to hear the left and right channels separately on the FieldFox) 
you have to use the headphone jack and stereo headphones (i.e., most 
earbuds, headphones, etcetera support stereo). Learn more, see also 
Chapter 30, “System Settings.” and “Audio (Volume) Control” on page 728.
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— FM Stereo / RDS – Displayed values for FM Stereo / RDS (Radio 
Design System); (Metrics) – (i.e., includes Freq Deviation, FM Demod 
Waveform (Time)/Spectrum (Frequency), Carrier Power, Carrier Freq, 
Modulation Rate, SINAD, THD, Dist/ Total VRMS).

— PM – Displayed values for PM Modulation Metrics (i.e., includes PM 
Deviation, PM Demod Waveform, SINAD, THD, Carrier Power, Carrier 
Freq, Modulation Rate).

— Tune & Listen OFF – Opens a menu of Tune & Listen demod softkeys. Tune 
& Listen can be set when you are in Analog Demodulation mode, so you can 
enable Tune & Listen sweeps in between your Analog Demod sweeps. To 
learn more about the Tune & Listen softkey menu choices, refer to “Tune & 
Listen (AM/FM)” on page 166.

See also, “How to make Analog Demodulation (Metrics) Settings” on 
page 173.

How to make Analog Demodulation (Metrics) Settings

The following softkeys are available when one of the Analog Demodulation 
metrics measurements is pressed. See also, “How to select Tune & Listen” on 
page 167.

If AM DSB, choose from:

— AM Top Y – Determines the Y axis percentage (0% to ±100%) of the AM 
demodulation waveform is displayed (Default = 100%).

If AM SSB, choose from:

— SSB Top Y – Determines the Y axis voltage (0 nV to ±100mV) of the AM 
SSB demodulation waveform is displayed (Default = 100 mV).

If FM, choose from:

— FM Top Y – Determines the Y axis frequency (1 kHz to 1 GHz) of the FM 
demodulation waveform is displayed (Default = 100 kHz).

If FM Stereo / RDS, choose from:

— FM Top Y – Determines the Y axis frequency (1 kHz to 1 GHz) of the FM 
demodulation waveform is displayed (Default = 100 kHz).

If PM, choose from:

When FM Stereo /RDS is selected as the demodulation type, a Warning 
message is displayed for a fews seconds at the start of the sweep; the 
sweep is 30 to 50 seconds long.

The message reads:

"Warning: Slow Measurement. RDS Measurement in Progress."
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— PM Top Y – Determines the Y axis phase (0 to 100 radians) of the PM 
demodulation waveform is displayed (Default = 5).

For any of the following: AM DSB, AM SSB, FM, FM Stereo / RDS, or PM, 
choose from:

Refer to Figure 9-5 on page 179, Figure 9-6 on page 179, Figure 9-7 on 
page 180, and Figure 9-8 on page 180.

— Demod SwpT – Sets the X-axis to display the demodulation sweep time for 
the demodulated waveform (minimum = 50 μs; maximum = 50 ms).

— Peak OFF ON – This adds peak positive and peak negative metrics to the 
main metrics measurement. For example, in FM peak ON will include peak 
positive (Peak +) and negative (Peak -) frequency deviation metrics to 
appear. Peak ON will also enable peak traces on the demodulation 
waveform and audio frequency spectrum (Default = OFF).

— Demod Type – Sets the demodulation type. 

Choose from AM, AM SSB, FM, FM Stereo / RDS, and PM.

— Then, press More – opens a menu of softkeys: Average Type, Average 
Count, and Demod View Time Freq.

— Average Type – Selects the way the demodulated signal values are 
averaged. Choices are Power (#PAvg annotation is displayed), Log (#LgAv 
annotation is displayed), Voltage (#VAvg annotation is displayed). Auto is 
the default and when selected the FieldFox chooses the type of averaging 
that is used based on the current settings.

— Average Count – Determines the amount of averaging used (1 to 10K; 
Default = 10).

— Demod Filters – Refer to “How to Set the Demod Filters” on page 177.

— Demod View Time Freq – Toggles how the demodulated signals are 
displayed (Time (waveform) or Frequency (spectrum)); Default = Time).

— Audio Capture Playback – Refer to “Setting the Audio Capture Playback 
Softkeys” on page 175.

Setting the Alternate Frequency (AF) Freq/Dist Softkeys

When AM DSB, AM SSB, FM, FM Stereo / RDS, or PM are selected and 
Demod View = Freq, you can choose from the following: 

— Press Freq/Dist then choose:

— AF Start Freq – Sets the AF start frequency for the AM or FM demodulated 
signal.
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— AF Stop Freq – Sets the AF stop frequency for the AM or FM demodulated 
signal.

— AF Full Span – Sets the AF full span frequency for the AM or FM 
demodulated signal.

Also, you can set the standard Center, Freq Span, and other frequency 
softkeys.

Setting the Alternate Frequency (AF) RBW Softkey

When AM DSB, AM SSB, FM, FM Stereo / RDS, or PM are selected and 
Demod View = Freq, you can choose from the following: 

— Press BW 2 then choose:

— AF RBW – Sets the audio frequency (AF) resolution BW for the AM or FM 
demodulated signal (Manual or Auto; default = Auto).

Setting the Audio Capture Playback Softkeys

The FieldFox analog demodulation audio capture playback feature allows you 
to capture/record the demodulated audio associated with an analog 
demodulation measurement (AM DSB, AM SSB, FM, FM Stereo or PM) and 
save it as an audio file. It also allows you to recall and playback audio files 
through FieldFox's built-in speaker or headphones.

When Analog Demod is selected, you can choose from the following: 

— Press Meas Setup 4 > More > Audio Capture Playback then

— If you want to initiate an audio capture:

Press Capture

— If you want to stop an audio capture:

Press Stop to stop the current capture of audio data and depending on the 
timing of pressing Stop, possibly prevent the audio data from being stored.

— If you have previously stored an audio file:

Press Playback then 

— Play – to play the last current audio file (*.wave) loaded into memory.

— Stop – to disable playback of the current audio file.

Currently, the audio capture playback feature supports WAVE files with 
mono or stereo LPCM data sampled at 48,000 Hz with 16 bits per sample. 

If you are unable to hear your audio data files (*.wav), verify that your 
System > Preferences > Preferences > Audio is set to On.
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— Volume 0 – to enable disable volume and to adjust the volume from 
0 to 100 (default = 50).

— Load Audio File – to load a previously stored audio (.wave) file.

— Cap Auto–Load File – enable/disables automatically loading of a 
captured audio (.wav) file (default = OFF).

— Press Capture Settings then

— Capture Count – sets the number of audio captures for a 
measurement (Default = 1; Settable: 1 to 10K).

— Capture Time – sets the capture time (Default = 100 ms). 
Minimum/Maximum capture times vary with other settings.

— Stereo Channel – When Demod Type = FM Stereo / RDS, this 
softkey sets the type of audio to be captured and stored: (Choose 
single channel: Mono (L+R), Left (L), Right (R), and Difference (L–R). 
Or choose two channel: Stereo (L&R). Default = Mono (L+R). 

Then Choose:

— Then File Settings then 

— Filename – Opens the filename labeler to specify a filename.

— Timestamp OFF ON – Enables/disables a timestamp label on your 
audio (.wav) filename.

— Storage Device – Sets the storage device location for your audio 
(.wav) file. Select Internal (default), SD Card, or USB.

For more on file settings refer to Chapter 32, “File Management.”

Mono (L+R) Sets the audio recording to Mono (single channel) and 
combining left and right speaker sounds. This is the 
default.

Stereo (L&R) Sets the audio recorded to be stereo (two channels).

Left (L) Sets the audio to be recorded to be the left speaker only.

Right (R) Sets the audio to be recorded to be the right speaker 
only.

Difference (L–R) Sets the audio to be recorded to be the value of the left 
side minus the right side of the audio data (single 
channel).
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How to Set the Demod Filters

The demodulation (Demod) filters and de-emphasis options help you 
accurately recover and analyze the modulating signal. The demod filters apply 
to all demod types (AM DSB, AM SSB, FM, FM Stereo and PM), while the 
de-emphasis options only apply to the FM and FM stereo demod types.

— Press Filters then

— Lowpass Filter None – then choose:

— LPF 3 dB Cutoff 300.000 Hz – When the Lowpass filter is set to 
Custom, sets the customized LPF 3 dB cutoff frequency for the 
lowpass filter (Default = 300 Hz; Minimum = 90 Hz, Maximum = 
5 MHz).

— Highpass Filter None – then choose:

None No lowpass filter is selected.

300 Hz 5-Pole Butterworth LPF with 3 dB cutoff frequency 
of 300 Hz.

3 kHz 5-Pole Butterworth LPF with 3 dB cutoff frequency 
of 3 kHz.

15 kHz 5-Pole Butterworth LPF with 3 dB cutoff frequency 
of 15 kHz.

30 kHz 3-Pole Butterworth LPF with 3 dB cutoff frequency 
of 30 kHz.

80 kHz 3-Pole Butterworth LPF with 3 dB cutoff frequency 
of 80 kHz.

100 kHz 3-Pole Butterworth LPF with 3 dB cutoff frequency 
of 100 kHz.

20 kHz 9-Pole Bessel LPF with 3 dB cutoff frequency of 20 
kHz.

300 kHz 3-Pole Butterworth LPF with 3 dB cutoff frequency 
of 300 kHz.

Custom 5-Pole Butterworth LPF with a custom 3 dB cutoff 
frequency (determined by the LPF 3 dB Cutoff 
setting).

None No highpass filter is selected.

20 Hz 2-Pole Butterworth HPF with 3 dB cutoff frequency 
of 20 Hz.

50 Hz 2-Pole Butterworth HPF with 3 dB cutoff frequency 
of 50 Hz.
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— HPF 3 dB Cutoff 500.000 Hz – When the Highpass Filter is set to 
Custom, sets the customized HPF 3 dB cutoff frequency for the 
highpass filter (Default = 500 Hz; Minimum = 20 Hz, Maximum = 
Varies, depending on the AF Span).

— Bandpass Filter None – Sets the Bandpass Filter for the current 
measurement (Choices: None, CCITT, A-Weighted, C-Weighted, 
C-Message, CCIR-1k Weighted, CCIR-2k Weighted, or CCIR 
Unweighted). Default = None.

— More – FM and FM Stereo only. Opens a softkey menu to 
enable/disable the De-Emphasis softkeys.

——De-Emphasis OFF ON – Enables/disables the de-emphasis 
applied to the demodulated signal.

——De-Emphasis T – Sets the amount of de-emphasis applied to 
the demodulated signal.

 

Setting the Marker Counter Gate Softkey

When AM Metric or FM Metric are selected, you can choose from the 
following: 

— Press Marker > Peak

— Press Mkr->/Tools > More > Mkr Properties > Counter Gate – Sets the AM 
or FM Tune & Listen demodulated signal’s counter window time 
(Minimum = 1 ms and Maximum = 2s; default = 100 ms).

The Counter Gate softkey is not available when AM Tune & Listen, FM 
(narrow) Tune & Listen, or FM (wide) Tune & Listen are enabled. Refer to 
Figure 9-8 on page 180.

See also, “How to use Marker Functions” on page 713.

300 Hz 2-Pole Butterworth HPF with 3 dB cutoff frequency 
of 300 Hz.

400 Hz 10-Pole Butterworth HPF with 3 dB cutoff 
frequency of 400 Hz.

Custom 5-Pole Butterworth HPF with a custom 3 dB cutoff 
frequency (determined by the HPF 3 dB Cutoff 
setting).
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Figure 9-5 AM DSB (Metrics) – Demodulation Waveform

Figure 9-6 FM Metrics – Demodulation Spectrum
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Figure 9-7 FM (Metrics) – Demodulation Waveform

Figure 9-8 FM (Metrics) - Counter Gate and FM Demodulation Waveform
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Independent Source/Tracking Generator 

This feature may require an option. For a comprehensive list, view the FieldFox 
Configuration Guide at: 
https://www.keysight.com/us/en/assets/7018-06515/configuration-guides/
5992-3701.pdf

A tracking generator, a popular option with Spectrum Analyzers, is a source 
which always tracks the SA receiver. 

Like a traditional tracking generator, the Independent Source feature can set 
the internal FieldFox source to track the SA receiver frequency range. It can 
also set the internal source to a CW frequency that is independent of the SA 
frequency.

Independent Source can be enabled ONLY when the FieldFox is in SA mode.

To view the internal source, you must connect a cable or device between the 
RF Output connector and the RF Input connector.

How to make Independent Source Settings

— Press Measure 1 > Source

— Source Enable ON OFF

— ON   Turns ON the internal source. 

— OFF Turns OFF the internal source.

— Source Mode Choose from the following:

— Tracking The internal source frequency can track the SA receiver. 
Center frequency Src is annotated on the screen

— CW The source is set to a CW frequency independent from the SA 
settings. Srcw is annotated on the screen.

— Coupled CW The source is set to a CW frequency, but that frequency 
“tracks” the SA receiver Center Frequency settings. Therefore, the 
signal always appears at center of the display. Srcp is annotated on 
the screen.

—  Normalize ON OFF With Source Enable ON and Source Mode = Tracking, 
Normalize ON stores the current measurement trace into Trace 4 in View 
state as a reference trace.  All subsequent trace measurements subtract 
this Trace 4 reference trace, and therefore become relative to it.  SrcN is 

For best results, when using the independent source feature, InstAlign and 
the battery saver features should be turned off. Refer to “How to Access 
Individual Alignments” on page 205 and “Preferences” on page 740.
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annotated on the screen. Normalize is automatically turned OFF when the 
frequency range or Resolution is changed. Learn more about Trace Display 
States in “Trace Display States (SA Mode)” on page 198.

— Source Power Sets the source power level. Choose from:

— Leveled Enter a value from –50 dBm to 3 dBm using the numeric 

keypad,  arrows, or the rotary knob1. The source power is 
reasonably flat across the frequency span.

— MAX The power level is set to the maximum achievable power level at 
each frequency. This results in the power level NOT being flat across 
the frequency span.

— Source CW Freq Sets the CW frequency that is used when Source Mode is 
set to CW.

To cause the source to stay ON at the end of each sweep, turn battery saver 
OFF. (Learn more in “How to Access Individual Alignments” on page 205.)

— Press System 7 > Preferences > Preferences then

— In the table, select Battery Saver. Press Edit then Battery Saver ON OFF 
To suspend InstAlign: (Learn more in “How to Access Individual 
Alignments” on page 205.)

— Press Cal 5 

— Then Amptd Alignment OFF

Resolution Bandwidth (Res BW)

In SA Mode, the Res BW provides the ability to resolve, or see closely spaced 
signals. The narrower (lower) the Res BW, the better the spectrum analyzer can 
resolve signals. In addition, as the Res BW is narrowed, less noise is measured 
by the spectrum analyzer ADC and the noise floor on the display lowers as a 
result. This allows low level signals to be seen and measured. However, as the 
Res BW is narrowed, the sweep speed becomes slower. See “Very Long Sweep 
Times” on page 190. 

How to set Res BW

— Press BW 2.

— Then Res BW. 

— Then choose from the following:

1. N995xB/6xB cannot have the Leveled value set lower than –35 dBm.

By default, the source output will turn off momentarily at the end of each 
IQA and SA sweep and also every 300 seconds during the InstAlign 
process. 
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—Auto Res BW is coupled to the frequency span. As the frequency span 
is narrowed, the Res BW is also narrowed providing increased ability 
to resolve signals.  
To change this setting from Man to Auto, press Res BW twice.

—Man Enter a Res BW value using the numeric keypad, the  arrows, 
or the rotary knob. Then press a multiplier if necessary or press Enter

The current Res BW setting is shown at the bottom of the screen. 

#Res BW x.xx XHz (#) means manual setting.

This setting could impact the accuracy of the measurement. See Specifications 
in Appendix B. 

Video Bandwidth (Video BW)

Video BW is a smoothing operation that is performed after measurement data 
is acquired. The trace data is effectively smoothed so that the average power 
level of the displayed noise is the same, but the peaks and valleys of adjacent 
data points are smoothed together. More smoothing occurs as the Video BW is 
set lower. However, as the Video BW is narrowed, the sweep speed becomes 
slower.

How to set VBW

— Press BW 2.

— Then Video BW

— Then choose from the following:

—Auto Couples Video BW to the ResBW in a 1-to-1 ratio. 

—Man Enter a Video BW value using the numeric keypad, the  
arrows, or the rotary knob. Then press a multiplier if necessary or 
press Enter. Setting VBW higher than RBW may smooth the trace.

.

The current Video BW setting is shown at the bottom of the screen. 

# VBW x.xx XHz (#) means manual setting. 

When the Res BW/Video BW ratio exceeds 10,000, a Meas UNCAL warning 
may appear to indicate that the Video BW filter has reached the maximum 
capacity for averaging.

The Res BW setting also affects the Sweep Type setting. Learn how in 
“Sweep Type” on page 184 

To change this setting from Man to Auto, press Video BW twice.
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AF RBW (Audio-Frequency Resolution BW)

AF RBW - sets the audio-frequency resolution bandwidth for the selected 
frequency (Default = Auto).

How to set AF RBW

— Press BW 2 > AF RBW

— Then choose from the following:

—Auto Couples AF BW to the Resolution BW in a 1-to-1 ratio. 

—Man Enter a AF BW value using the numeric keypad, the  arrows, 
or the rotary knob. Then press a multiplier if necessary or press Enter. 
Setting AF BW higher than RBW may smooth the trace.

The current AF RBW setting is shown at the bottom of the screen. 

# AF RBW x.xx XHz (#) means manual setting. 

When the Res BW/AF RBW ratio exceeds 10,000, a Meas UNCAL warning may 
appear to indicate that the AF RBW filter has reached the maximum capacity 
for averaging.

Sweep Type

In SA mode, the FieldFox uses two sweep types to process inputs signals. The 
sweep type that is currently being used (FFT or Step) is displayed in the 
lower-left corner of the FieldFox screen. 

For a more comprehensive tutorial, see Spectrum Analysis Basics (App Note 
150) at 
https://www.keysight.com/us/en/assets/7018-06714/application-notes/595
2-0292.pdf

How to set Sweep Type

— Press BW 2.

— Then Advanced

— Then Sweep Type

— Then choose from the following:

—Auto The FieldFox selects the most efficient sweep type based on the 
Res BW. When Res BW is set to 200 kHz and below, FFT sweep type 
is selected. Above 200 kHz, Step sweep type is being performed. 

—FFT The FieldFox uses FFT sweep type regardless of the Res BW. 

To change this setting from Man to Auto, press AF RBW twice.
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—Step The FieldFox uses Step sweep type regardless of the Res BW. 
This is useful for capturing impulsive noise that may be generated 
from nearby electrical equipment.

Oversweep

In SA mode, the FieldFox uses Oversweep to quickly analyze input signals. 
Oversweep is meant to verify that your setup is correct, but Oversweep is not 
meant to be as accurate as FFT and Step sweeps. See also, “How to set Sweep 
Type” on page 184. 

How to set Oversweep

— Press BW 2 > Advanced then

— Press Oversweep – To enable/disable the Oversweep. Over sweep enables 
you to quickly evaluate your setup.

IF Output

The FieldFox IF (intermediate frequency) can be output for external signal 
processing. The signal is available from the IF Out connector on the FieldFox 
right-side panel. See the connector in “Right Side Panel” on page 42.

The IF Out signal, centered at approximately 33.75 MHz (Narrow) or 225 MHz 
(with Wide path Option B04 or Option B10), is simply a down-converted 
version of the RF Input signal that is present at the tuned frequency.

While outputting an IF signal, the FieldFox stops performing the InstAlign 
process. Therefore, the amplitude of traces on the FieldFox screen is NOT 
accurate and Meas UNCAL appears on the screen to indicate this. Learn more 
in “Individual Alignments” on page 204. See also Figure 9-9 on page 186.

Learn more about the IF Output frequencies and bandwidths in the 
Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 
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Figure 9-9 IF Output Wide with CF=225 MHz (Requires Option B04 or Option B10)

How to select IF Output

The IF Output signal is useful only in Zero Span. Learn more about Zero Span in 
“Zero Span Measurements” on page 190.

At least one sweep must be made in order to tune the FieldFox.

— Press BW 2.

— Then Advanced

— Then IF Output Use

— Then choose from the following:

—OFF The translated IF signal at the IF OUT connector is no longer 
guaranteed to be centered at 33.75 (Narrow) or 225 MHz (Wide). 
Requires Option B04 or B10 respectively.

—Narrow The IF output signal has approximately 10 MHz bandwidth. 

—Wide Requires B04 or B10. The IF output signal has approximately 
100 MHz bandwidth with either B04 or Option B10.
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Figure 9-10 SA Display Wide BW IF Out - Center Frequency 4 GHz (Requires Option B10)
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Figure 9-11 SA Display Wide BW IF Out - Center Frequency 10 GHz (Requires Option B10)

Sweep Acquisition

Available only in non-zero span measurements, when Sweep Acquisition is set 
to Auto, the fastest sweep rate is achieved while maintaining full amplitude 
accuracy. 

However, you can adjust this setting in order to increase the probability of 
intercepting and viewing pulsed RF signals. 

For example, with SwpAcquisition set to Auto a pulsed GSM signal is NOT 
visible on the FieldFox screen, as shown in a blue trace in the following image.

While watching the trace, increase the SwpAcquisition value until the pulse 
spectrum rises out of the noise and reaches its maximum level. Increasing the 
SwpAcquisition value beyond this point only slows the update rate (increases 
the actual Sweep time readout) but does not improve measurement quality.

For zero span measurements, refer to “Zero Span Measurements” on 
page 190.
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Figure 9-12 GSM Signal in Framed Data Format

In the graphic above, a GSM signal in a framed data format; timeslot zero ON; 
all others OFF;  
 PRF = 218Hz, Duty Cycle = 12.5%. The pulsed signal becomes visible on every 
sweep update with SwpAcquisition = 50.

How to set Sweep Acquisition

SwpAcquisition is NOT an absolute measure of time, but a relative number 
between 1 (fastest) and 5000 (slowest) sweep time. The actual time that was 
required to complete a sweep is annotated on the screen.

— Press Sweep 3.

— Then SwpAcquisition Auto Man.

— Then choose from the following:

——Auto Sweep is set to the fastest sweep possible with the current 
settings. 

——Man Enter a relative acquisition value between 1 and 5000, 
where:

— Man Enter a relative acquisition value between 1 and 5000, where:

——1 = Fastest sweep possible

——5,000 = Slowest sweep possible

——# is shown in front of the actual sweep time to indicate a 
manual setting.
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Some Detector and Video Bandwidth settings will raise the Auto Sweep 
Acquisition value greater than 1. In these cases, manually setting Sweep 
Acquisition lower than the Auto value may have NO effect.

Learn more about SA mode SwpAcquisition time in the Supplemental Online 
Help:  http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

Very Long Sweep Times

Two primary settings are responsible for the sweep time: Res BW and 
SwAcquisition.

— When the sweep time exceeds 1200 seconds (20 minutes), an informational 
message: Alert:  Very long sweep in progress… is annotated on the screen 
for the duration of the sweep.

— When the sweep time exceeds 4000 seconds (about 1 hour), Meas UNCAL 
is annotated on the screen. Accuracy cannot be guaranteed.

— InstAlign is always performed only at the beginning of the sweep regardless 
of the sweep time. Learn more in “How to Access Individual Alignments” 
on page 205.

Zero Span Measurements

When setting the frequency span to Zero, there is NO spectrum of frequencies 
to display, so the X-axis units becomes Time. The SA becomes like a tunable 
oscilloscope, with the center frequency being the frequency of interest. This 
capability is useful for analyzing modulation characteristics, such as pulsed 
measurements.

Measurement speed specifications do NOT apply in Temperature Control 
Mode. Learn more in “Temperature Control Mode” on page 33.

For non-zero span measurements, refer to “Sweep Acquisition” on 
page 188.
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Figure 9-13 GSM Signal, Framed Data Format

The graphic above shows a GSM signal, framed data format, with timeslot 0 
and 3 “on”. Sweep Time is set to approximately the frame interval. Press Single 
several times until the waveform section of interest is viewable and stable. 
Then markers can be used to measure the timeslot width and interval as 
shown.

How to set Zero Span

— Set Center to the frequency of interest 

— then set Span to 0 Hz

— or select Zero/Last Span. Each key press toggles the frequency span 
between 0 Hz and the last specified frequency span. 

How to change Sweep Time in Zero Span

— Press Sweep 3

— Then Sweep Time 

— Enter a value using the numeric keypad. Sweep time is limited to 1000 
seconds for N991xB/2xB/3xB models.

— Then select a multiplier key. Learn more in “Multiplier Abbreviations” on 
page 46.

Learn more about SA mode Sweep Time in the Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 
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Triggering

External, Video, and RF Burst triggering allows you to initiate an SA mode 
sweep using an external event such as a signal burst. 

All three trigger types can be used in either Zero Span (time domain) or FFT 
frequency sweeps. Learn more in “Zero Span Measurements” on page 190. 
Learn more in “Sweep Type” on page 184.

FFT Gating is available for non-zero span measurements. Learn more about 
FFT Gating in “FFT Gating (Opt 238)” on page 196.

Trigger Type

— Press Sweep 3 > Trigger Settings > Trig Type

— Then choose from the following:

— Free Run Triggering is provided by the FieldFox internal circuitry. A 
new sweep begins when the previous sweep ends. 

— External A sweep is triggered on an external TTL signal at the Ref 
In/Trig In connector on the FieldFox top panel. Choose to trigger on 
the rising slope at about 1.7 V or on the falling slope at about 1.0 V 
using the Trigger Slope setting (below). 

— Periodic sets a trigger that repeats at the period rate entered. 
Periodic trigger's phase can be altered by the Offset value.

The following two selections are similar in that they both trigger a sweep from 
a signal at the SA RF Input connector. Experiment with both selections to find 
the best trigger type for your application.

— Video A sweep is initiated when the displayed amplitude of an incoming 
signal crosses the settable Trigger Level. This selection can detect 
low-amplitude signals, but also has been filtered considerably and may not 
be a true representation of the incoming signal. 

— RF Burst A sweep is initiated when the signal at the third IF (analog) stage 
crosses the settable Trigger Level. This selection offers a wider bandwidth 
and may be a better representation of the incoming signal than Video 
trigger. However, RF Burst is not as sensitive to triggering on low-level 
signals.

Sync

Selects the type of signal the periodic trigger is synchronized.

— None No synchronization is selected for a Periodic trigger.

This softkey is ONLY available when Trigger Type is set to Periodic.
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— External A sweep is triggered on an external TTL signal at the Ref In/Trig In 
connector on the FieldFox top panel. Choose to trigger on the rising slope 
at about 1.7 V or on the falling slope at about 1.0 V using the Trigger Slope 
setting (below).

— RF Burst uses an alignment process which is performed in the background 
to set the detected signal level accuracy. Learn more in “RF Burst 
Amplitude Alignment” on page 206.

— 1 PPS GNSS Periodic trigger is synchronized to a 1 pulse per second GNSS 
signal.

Trigger Slope

Trigger Slope determines which edge of an External, Video, or RF Burst trigger 
signal initiates a sweep. 

— Press Sweep 3

— Then Trigger Settings

— Then Trig Slope

— Then choose from the following:

—Pos Sweep is triggered by the rising (positive) edge of signal.

—Neg Sweep is triggered by the falling (negative) edge of signal.

Trigger Delay

After a valid trigger signal is received, the sweep begins after the specified 
Trigger Delay time.

To see the rising edge of a repetitive signal which is triggered on that edge, 
enter a negative trigger delay value (also known as pre-trigger). Adjust the 
sweep time to observe the pre-trigger time if necessary.

— Press Sweep 3

— Then Trigger Settings

— Then Trig Delay

— Enter a value using the numeric keypad, the  arrows, or the rotary 
knob. 

— Then select a multiplier key or press Enter. Learn more in “Multiplier 
Abbreviations” on page 46.

This softkey is unavailable when Trigger Type is set to Periodic.
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In Zero span, you can use Trigger Position as an easy way to set Trigger Delay 
by positioning the trigger event on the FieldFox screen. See “Triggering” on 
page 192.

Period

Sets the length of time in seconds before a waveform repeats. (default = 
20.00 ms).

Offset

Sets the periodic trigger offset. (default = 0.00 s) 

Trigger Level

Used with Video and RF Burst triggering, a sweep is initiated when an 
incoming signal crosses this level. The units depend on the Units setting. Learn 
more in “Scale and Units” on page 157.

RF Burst Trigger Level uses an alignment process which is performed in the 
background to set the detected signal level accuracy. Learn more in “RF Burst 
Amplitude Alignment” on page 206. Video Trigger Level is a zero span signal 
level comparison. Therefore, the sweep will trigger close to the displayed level 
in zero span measurements. In non-zero span measurements, processing can 
cause broadband signal energy to display at lower power levels than the 
originating time domain signal. Therefore, you may need to set the trigger level 
higher than the displayed level.

— Press Sweep 3

— Then Trigger Settings

— Then Trig Level

— Enter a value using the numeric keypad, the  arrows, or the rotary 
knob. 

— Then select a multiplier key or press Enter. Learn more in “Multiplier 
Abbreviations” on page 46.

This softkey is ONLY available when Trigger Type is set to Periodic.

This softkey is ONLY available when Trigger Type is set to Periodic.
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Auto Trigger Time

While waiting for a valid trigger signal, Wait is annotated in the top left corner 
of the FieldFox screen.

If a valid trigger signal is not received before the specified Auto Trig Time, a 
sweep will occur automatically.

Enter 0 to set Auto Trigger OFF. When Auto Trigger is OFF, the FieldFox does 
NOT sweep unless a valid trigger signal is received.

— Press Sweep 3

— Then Trigger Settings

— Then Auto Trigger [current setting]

— Enter an Auto Trig Time using the numeric keypad. 

— Then select a multiplier key. See “Multiplier Abbreviations” on page 46.

Trigger Position

Available ONLY in zero span measurements, this setting is an easy way to 
automatically set the Trigger Delay by positioning the trigger event (also 
known as T-zero) at any graticule along the X-axis. With T-zero in the center of 
the screen, you can zoom in and out by increasing or decreasing the sweep 
time. Using the Trigger Position and Sweep Time settings is a quick and 
efficient way to examine artifacts of a pulse, much easier than trying to set the 
Trigger Delay manually. 

When Trigger Position is set to OFF, the Trigger Delay softkey is not available. 
The amount of Trigger Delay that is being used is displayed on the softkey. The 
Trigger Position is annotated on the screen. Learn how in the following section.

— Press Sweep 3

— Then Trigger Settings

— Then Trig Position. If Sweep Time is longer than 0.15 sec, this softkey is 
grayed out.

—ON: The position of T-zero is set by the trigger delay.

—OFF: Select, then enter a position value from 0 to 10 using the numeric 

keypad, the  arrows, or the rotary knob.

——0: T-zero occurs at the left graticule. 

——5: T-zero occurs at the center of the screen.

——10: T-zero occurs at the far right graticule. 

— Then press Enter. 
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Trigger Settings Annotation

Trigger settings are annotated on the FieldFox screen as highlighted in red in 
the following image:

— Square: Trig Type (VidT), AutoTrigger (a), Pos Slope (/), Neg Delay (delay-)

— Horizontal arrow: Trig Level (green horizontal graticule at -20 dBm)

— Vertical arrow: Trig Position T-zero indicators (green arrows at 2nd vertical 
graticule)

FFT Gating (Opt 238)

Time-gated spectrum analysis allows you to obtain spectral information about 
signals occupying the same part of the frequency spectrum that are separated 
in the time domain. Using an external trigger signal to coordinate the 
separation of these signals, you can perform the following operations:

— Measure any one of several signals separated in time; for example, you can 
separate the spectra of two radios time-sharing a single frequency.

— Measure the spectrum of a signal in one time slot of a TDMA system.

— Exclude the spectrum of interfering signals, such as periodic pulse edge 
transients that exist for only a limited time.

FFT Gating is a simple, efficient way to set the proper amount of trigger delay 
and capture time so that signal artifacts of a repeating waveform or pulse can 
be examined in the frequency domain. Learn more about trigger settings in 
“Triggering” on page 192.

For best results, Auto Trigger should be used with this feature to ensure that 
the sweep does not wait indefinitely for a trigger.   Set Auto Trigger to a time 
that is longer than the expected periodic rate of the signal.  This is especially 
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important when using RF Burst or Video triggering in wider spans, because the 
signal providing those triggers has limited bandwidth.  Learn more about Auto 
trigger in “Auto Trigger Time” on page 195.

For more conceptual information on this topic, please refer to Spectrum 
Analysis Basics (App Note 150), pages 31 - 35, at 
https://www.keysight.com/us/en/assets/7018-06714/application-notes/595
2-0292.pdf.

How to set FFT Gating

— Create a non-zero span measurement. Wider frequency spans take more 
time to acquire.

— Press Sweep 3

— Then Trigger Settings

— Then FFT Gating Setup

— Then choose from the following:

—Gate View OFF ON When ON, a separate zero span measurement is 
displayed below the non-zero span window. The gate view 
measurement helps to configure the gate width and delay by 
revealing (with green markers) the location of the gate relative to the 
trigger event. The zero span measurement is tuned to the center 
frequency of the non-zero span measurement with about 5 MHz of 
bandwidth. The Y-axis scale is the same for both windows.

—Gate View Time Set the X-axis span for the non-zero span window. 

Enter a value using the numeric keypad, the  arrows, or the 
rotary knob. This value is annotated as Swp (nn) below the window.

—FFT Gating OFF ON When ON, the trigger type, gate width, and delay 
are applied to the non-zero span measurement. The Res BW is set to 
a value that is inversely proportional to the gate width.

—Gate Width Set the width of the gating area within the non-zero span 
window. The gating area is indicated by two vertical green lines. Enter 

a value using the numeric keypad, the  arrows, or the rotary 
knob.

—Gate Delay Effectively moves the gating area left (negative delay) or 
right (positive delay) relative to the trigger event. Enter a value using 

the numeric keypad, the  arrows, or the rotary knob.

When you have properly setup the Gate Trigger, Width, and Delay using the 
Gate View measurement, you can turn Gate View OFF to return to the full 
screen non-zero span measurement with FFT Gating ON, the RBW set, and the 
Trigger settings active.
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Single / Continuous / Restart

This setting determines whether the FieldFox measures continuously or only 
once each time the Single or Run / Hold +/- button is pressed. Use Hold / 
Single or to conserve battery power or to allow you to save or analyze a 
specific trace. 

How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

—Continuous 

——ON Causes the SA to make continuous sweeps. This is the 
typical setting for making measurements. Each Run / Hold +/- 
press causes the SA to toggle between continuous sweep and 
Hold. 

——OFF Causes the SA to Hold. Each Run / Hold +/- or Single 
press causes the SA to make ONE sweep, then Hold. The Hold 
annotation changes to an arrow --> while the sweep occurs.

—Single Automatically sets Continuous OFF and causes the SA to make 
ONE sweep, then Hold.

—Restart Resets the Average counter to 1. The Average counter also is 
used with MaxHold and MinHold Trace States. Learn more in 
“Average Count” on page 200.

Points 

Points is the number of measurements that are displayed along the X-axis. The 
higher number of data points, the better the ability to resolve closely spaced 
signals and the slower the sweep speed. 

How to set number of points

— Press Sweep 3 

— Then Points [current setting] 

— Then choose from: 

— 101 | 201 | 401 | 601 | 801 | 1001

— # Points to enter a trace points value manually (Maximum = 20001). 

Trace Display States (SA Mode)

— In SA Mode you can display up to four of the following types of trace states. 
All SA settings are applied to all displayed traces. See also “Marker Trace 
(IQA and SA Mode)” on page 704. 
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A color-coded legend for displayed traces is visible in the left pane of the SA 
mode screen:

W = Clear/Write; M = MaxHold; m = MinHold; A = Average; V = View

How to display the Trace States

— Press Trace 6. 

— Then Trace 1,2,3,4 repeatedly to select a trace number to display or change 
its state. Traces are displayed in the following colors:

— Trace 1 – Yellow   Trace 2 – Blue

— Trace 3 – Orange  Trace 4 – Green

— Then State [current setting] 

— Then choose from the following Trace States:

—Clr /Wr (Clear/Write) Displays the actual measured data for each 
sweep.

—MaxHold Displays the maximum response of the input signal at each 
data point over multiple sweeps. See also Average Count in “Average 
Count” on page 200.

—MinHold Displays the minimum response of the input signal at each 
data point over multiple sweeps. See also Average Count in “Average 
Count” on page 200.

—Average Each data point is averaged over multiple sweeps as set by 
the Average Count setting. Learn more in “Average Count” on 
page 200.

—View Displays and then holds the last complete measurement trace on 
the screen. This is similar to storing a trace in memory. 

—Blank Displays no trace.

— Press Default All to return all traces to their default settings: Trace 1 
(Clear/Write); all other traces (Blank).

Average Type

In SA Mode, there are four different processes in which Averaging is performed:

— Average Traces – Learn more in “Averaging” on page 215. 

— Detection Method Averaging – Learn more in “Detection Method” on 
page 208.

Trace 4 data WILL be overwritten by the FieldFox when using the 
Independent Source Normalize feature (“Independent Source/Tracking 
Generator ” on page 181) or using Field Strength antenna or cable 
corrections (“Field Strength Measurements” on page 161).
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— Noise Marker Averaging - Learn more in “Noise Marker” on page 211.

— Video BW filtering (for non-Zero Span measurements) - Learn more in 
“Video Bandwidth (Video BW)” on page 183.

There are three types of mathematical averaging that can be performed – Log, 
Linear, or Voltage (see “How to set Average Type” on page 200). Select ONE 
of these types and it is used for all of the above averaging processes. 

How to set Average Type

— Press Meas Setup 4 then Average Type [current setting]

— Then choose from the following:

—Auto - The FieldFox chooses the most appropriate type of averaging 
for the current settings. When Detection Method is set to Average, a 
Noise Marker is present, or a Channel measurement is active, then 
Power Average is ALWAYS selected. Otherwise, Log Average is 
selected.

—Log Averaging – Best for displaying Trace Averaging. LgAv is shown on 
the left side of the FieldFox screen when selected.

—Power (Linear) Averaging – Best for measuring true power levels. Used 
in Detection Average and Noise Marker Average. Mathematically, 
trace noise is 2.5 dB higher than when using Log Average. PAvg is 
shown on the left side of the FieldFox screen when selected.

—Voltage Averaging – Converts the amplitudes to a magnitude unit 
before averaging (e.g., Volts, Amps, microVolts, milliVolts, etc.) VAvg 
annotation is displayed. 

Average Count

The Average Count setting is used mainly with the Average Trace State 
described in “Trace Display States (SA Mode)” on page 198. In this Trace 
State, the Average Count setting determines the number of sweeps to average. 
The higher the average count, the greater the amount of noise reduction. 

When Trace (display) State is set to Average, MaxHold, or MinHold, the 
average counter is shown in the left edge of the screen below the Average 
Type. 

For all three of these Trace States, when Sweep 3 Continuous is set to OFF, 
press Restart to reset the sweep count to 1, perform <n> sweeps, then return 
to Hold.

How to set Average Count

— Press Meas Setup 4 

— Then Average Count
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— Enter a value from 1 to 10,000 using the numeric keypad, the  arrows, 
or the rotary knob.

— Press Enter

Alignments

This section contains the following:

— “Overview” on page 201

— “All Alignment and Align All Now” on page 203

— “Individual Alignments” on page 204

Overview

All Alignment or Align All Now corrects for receiver drift over temperature and 
time. SA measurement applications monitor changes in internal temperature 
and the time since last alignment update and trigger the need for a new 
update when the alignment becomes stale. The alignment is deemed stale 
after a significant change in temperature or a significant time elapsed from the 
last update. The temperature change and time duration necessary to trigger an 
alignment update is predetermined in the factory. Until the update is 
performed, annotation indicating “questionable amplitude” is displayed 
AMPTD?. 

When All Alignment is enabled (by default) the FieldFox performs an 
alignment process using the internal RF source. Although some sweeps are 
delayed, measurement results are never disturbed.

If the Independent Source (tracking generator) is enabled for your 
measurement, it will be borrowed to perform the alignment. Again, the 
measurement results are not disturbed. Learn about the Independent Source in 
“Independent Source/Tracking Generator ” on page 181.

The alignment process can be disabled. You may want to do this, for example, 
if you are analyzing the amplitude stability of a signal. 

SA and all modes built on its infrastructure require three types of alignments:    

— InstAlign Amplitude Alignment 

— RF Burst Amplitude Alignment

— Channel Equalization

These are referred to as Individual Align.

All three or a subset of the individual alignments are required for each specific 
mode, depending on the type of measurement supported by it:

SA:

— InstAlign Amplitude Alignment
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— RF Burst Amplitude Alignment

RTSA:

— InstAlign Amplitude Alignment

— WidePath Burst Trigger Alignment

— Channel Equalization

Channel Scanner:

— InstAlign Amplitude Alignment

EMI Measurements:

— InstAlign Amplitude Alignment

— WidePath Burst Trigger Alignment

— Channel Equalization

ERTA:     

— InstAlign Amplitude Alignment

 IQA:

— InstAlign Amplitude Alignment

— RF Burst Amplitude Alignment

— Channel Equalization

Built-in Power meter

— InstAlign Amplitude Alignment

Default settings and recommended use model for many applications:

— Coupled individual alignments

— Coupled state is Auto

— Individual alignments are not accessible via front panel soft-keys

— Individual alignments cannot be UnCoupled

For special cases, the individual alignments can be accessible via the front 
panel soft-keys using the Preference setting SA - Individual Alignment 
Control  > On/Off. This enables a soft-key for access to Individual Alignments 
when this preference is set to ON: Cal 5 > Individual Align. For more refer to 
“Preferences” on page 740, in Chapter 30 System Settings.
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The individual alignments may be:

— Coupled (default) - when they are in the same state, or

— Uncoupled - when at least one of them is in a different state than the other 
ones 

— Executed on demand, all of them, using the Align All Now softkey.

Each of the individual alignments:

— could be in one of three states:

— Off - the alignment is not applied and is not updated automatically

— Auto (default) - the alignment will be updated over time and 
temperature as needed, no user interaction required

— Hold - the unit holds the alignment values from the last 
alignment-execution and does not execute another alignment 
automatically

— can be updated on demand using the corresponding Align Now soft-key. 
Refer to “Individual Alignments” on page 204.

— The All Alignment soft-key has the following functionality:

— when the individual alignments are Coupled, the state of all of them 
can be changed simultaneously using the All Alignment soft-key 
sub-menus

— when the individual alignments are UnCoupled, they will be coupled 
when using the All Alignment soft-key sub-menus and their state 
will be simultaneously changed accordingly

All Alignment and Align All Now

IMPORTANT! It is recommended that you use Align All Now, because it 
includes the individual alignment InstAlign Amptd Align Now, as well as, 
Burst Align Now, and ChanEQ Align Now. But, if you would prefer to have 
manual control over the individual alignments, then refer to the SA 
Individual Alignment Control setting in “Preferences” on page 740, in 
Chapter 30 System Settings.

The notification AMPTD? displayed on screen means the InstAlign 
amplitude alignment or channel equalization is stale (if its state is Hold) 
and requires an update or it is in the OFF state. This situation does not 
occur when the respective alignment is in the Auto state. To clear this 
notification, press the Align All Now softkey.
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How to set All Alignment and Align All Now

— Press Cal 5 

— Then All Alignment [Auto] (to enable or disable the All Alignment) – 
Default is Auto.

— or

— Then Align All Now (to manually perform an Align All Now.) This performs 
an alignment on all three individual alignments: Amptd Align Now, Burst 
Align Now, and ChanEq Now). Refer to “Individual Alignments” on 
page 204.

— Press Enter

If you want to disable the All Alignment [Auto], you can do so in the FieldFox 
preferences (i.e., you may want to do this, for example, if you are analyzing the 
amplitude stability of a signal). 

Refer to the SA Individual Alignment Control setting in “Preferences” on 
page 740, in Chapter 30 System Settings. See also, “Individual Alignments”.

Individual Alignments

IMPORTANT! It is recommended that you use All Alignment [Auto] or Align 
All Now in lieu of the individual alignments (Amptd Align Now, Burst 
Align Now, and ChanEQ Align Now), because All Alignment [Auto] and 
Align All Now includes the individual alignment InstAlign Amptd Align 
Now, Burst Align Now, and ChanEQ Align Now. But, if you would prefer to 
have manual control over the individual alignments, then refer to the SA 
Individual Alignment Control setting in “Preferences” on page 740, in 
Chapter 30 System Settings.

The Individual Alignment softkey is only available, when the preference SA 
- Individual Alignment Control is set to On in the FieldFox Preferences 
menu. Refer to “Preferences” on page 740, in Chapter 30 System Settings.
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How to Access Individual Alignments

This section assumes access to individual alignments was activated using the 
FieldFox’s system settings’ Preferences. Once enabled, an Individual 
Alignments softkey is displayed. Refer to “Preferences” on page 740, in 
Chapter 30 System Settings. 

— Press Cal 5 

— Then Individual Align 

— Then Amptd Align Now or

— Then Burst Align Now or

— Then ChanEq Align Now 

— Press Enter

How to make Amplitude Alignment settings

SA, IQA, RTSA, and other modes use a proprietary amplitude alignment 
algorithm to make extremely accurate amplitude measurements over the full 
frequency range of the FieldFox.

These settings do NOT survive a Preset or Mode Preset.

— Press Cal 5 

— Then Individual Align 

— Then Amptd Alignment 

— Then choose from the following:

— Auto (Default setting) Alignments are required and are performed 
automatically, when necessary, at times when interrupting the RF 
Output is deemed acceptable. The alignment process is performed 
opportunistically when changes in settings require the measurement 
to stop momentarily and a significant time elapsed since the last 
alignment (predetermined in the factory) or the internal instrument 
temperature has changed sensibly (predetermined in the factory).

During continuous sweep (“acquisition” for IQA) operation, automatic 
Alignments will NOT interrupt the ongoing measurement, but when 
necessary, will occur opportunistically as settings are changed. When no 
automatic alignment updates occur, existing alignments can become stale 
over time and temperature drift, so a warning annotation on the left panel 
will light up indicating that alignments need updating. 
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Some examples of the conditions when alignments occur are: This 
could be a Center frequency change, or it could be as simple as 
requesting a Single sweep. Also, unique alignments are required at 
different FieldFox receiver frequency bands, so even if the 
temperature hasn't changed, an alignment may be required when 
one changes the Center frequency.

If a needed alignment cannot be performed, the user is notified about 
questionable amplitude AMPTD?.

— OFF Alignments are not performed. The most recent alignment result 
is cleared. Only factory corrections are applied to SA Receiver 
measurements. Questionable amplitude AMPTD? is always 
displayed. 

—  Hold The alignment process is stopped, but the last alignment 
values are applied to subsequent sweeps.

— Amptd Align Now An alignment is performed immediately, thus updating 
(clearing) any questionable amplitude status. If the Mode was previously 
Off, it is changed to Hold.

Amptd? is annotated in the lower left corner of the FieldFox screen when 
amplitude alignment is questionable. This is always true when OFF, and is 
conditionally true in Auto or Hold when the most recent alignment is deemed 
stale.

RF Burst Amplitude Alignment

RF Burst alignment calibrates the circuitry to provide accurate external RF 
Burst triggering. Learn more about RF Burst triggering in “Triggering” on 
page 192

When enabled (by default) the FieldFox performs an alignment process using 
the internal RF source. Although some sweeps are delayed, measurement 
results are never disturbed.

If the Independent Source is enabled for your measurement, it will be borrowed 
to perform the alignment. Again, the measurement results are not disturbed. 
Learn about the Independent Source in “Independent Source/Tracking 
Generator ” on page 181.

The alignment process can be disabled. You may want to do this, for example, 
if you are analyzing the amplitude stability of a signal. 

How to make Burst Alignment settings

These settings do NOT survive a Preset or Mode Preset.

— Press Cal 5 

— Then Individual Align
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— Then Burst Alignment 

— Then choose from the following:

— Auto (Default setting) SA measurement applications monitor 
changes in internal temperature and the time since last alignment 
update and trigger the need for a new update when the alignment 
becomes stale. The alignment is deemed stale after a significant 
change in temperature or a significant time elapsed from the last 
update. The temperature change and time duration necessary to 
trigger an alignment update is predetermined in the factory.

— OFF The alignment process is NOT performed. Only factory correction 
values are used.

— Hold The alignment process is stopped, but the last alignment values 
are applied to subsequent sweeps.

Burst Align Now An alignment is performed once and applied to subsequent 
sweeps.

Channel Equalization (IQA and RTSA Only)

IQA and RTSA modes use proprietary channel equalization algorithms to make 
extremely accurate channel measurements over the full frequency range of the 
FieldFox.

How to make Channel Equalization Alignments settings

These settings do NOT survive a Preset or Mode Preset.

— Press Cal 5 

— Then Individual Align

— Then ChanEq Alignment 

— Then choose from the following:

— Auto (Default setting) SA measurement applications monitor 
changes in internal temperature and the time since last alignment 
update and trigger the need for a new update when the alignment 
becomes stale. The alignment is deemed stale after a significant 

During continuous sweep operation for RTSA and continuous acquisition 
for IQA, automatic Alignments will NOT interrupt the ongoing 
measurement, but when necessary, will occur opportunistically as settings 
are changed. When no automatic alignment updates occur, existing 
alignments can become stale over time and temperature drift, so a 
warning annotation on the left panel will light up indicating that 
alignments need updating. When alignments need updating, you will see a 
“Channel Equalization” or “ChanEq” error message displayed.
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change in temperature or a significant time elapsed from the last 
update. The temperature change and time duration necessary to 
trigger an alignment update is predetermined in the factory. 

Some examples of the conditions when alignments occur are: This 
could be a Center frequency change, or it could be as simple as 
requesting a Single sweep. Also, unique alignments are required at 
different FieldFox receiver frequency bands, so even if the 
temperature hasn't changed, an alignment may be required when 
one changes the Center frequency.

—Hold The alignment process is stopped, but the last alignment values 
are applied to subsequent sweeps.

— OFF The alignment process is NOT performed, and the channel 
equalization is deactivated.

— ChanEq Align Now An alignment is performed immediately.

The Amptd? annotation lights up whenever the current channel equalization is 
deemed stale.

Detection Method

In SA Mode, the X-axis is comprised of data points, also known as “buckets”. 
The number of data points is specified using the Points setting. Learn more in 
“Points ” on page 198.

Regardless of how many data points are across the X-axis, each data point 
must represent what has occurred over some frequency range and time 
interval.

From the frequency span of the measurement, the span of each data point is 
calculated as (frequency span / (data points-1)). The detection method allows 
you to choose how the measurements in each bucket are displayed.
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Figure 9-14 Detection using One Bucket 

In the graphic above there is one bucket showing Positive peak, Sample, and 
Negative peak Detection methods.

How to set Detection Method

The current Detection method is labeled on the left edge of the screen. When a 
method is selected manually, a # precedes the label. For example: # Nrm 
means that Normal was selected from the softkeys.

— Press Trace_6  > Detector

— Then choose from the following:

—Auto Displays the most appropriate Detection method based on other 
settings. [# is NOT shown]

—Normal [#Nrm] Provides a better visual display of random noise than 
Positive peak and avoids the missed-signal problem of the Sample 
Mode. Should the signal both rise and fall within the bucket interval, 
then the algorithm classifies the signal as noise. An odd-numbered 
data point displays the maximum value encountered during its 
bucket. An even-numbered data point displays the minimum value 
encountered during its bucket. If the signal is NOT classified as noise 
(does NOT rise and fall) then Normal is equivalent to Positive Peak.

—Positive Peak [#Pk] Displays the maximum value of all the 
measurements in each bucket. This setting ensures that no signal is 
missed. However, it is not a good representation of the random noise 
in each bucket. 

—Negative Peak [#NPk] Displays the minimum value of all the 
measurements in each bucket. 
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—Sample [#Smp] Displays the center measurement of all the 
measurements in each bucket. This setting gives a good 
representation of the random noise in each bucket. However, it does 
not ensure that all signals are represented.

—Average [#RMS] Displays the Root Mean Squared (RMS) average 
power of all the measurements in each bucket. This is the preferred 
method when making power measurements.

Display Line

A display line is a simple, horizontal line that can be placed at any amplitude 
level on the SA screen or set to any level in IQA. Use a display line as mental 
guide for visual feedback. A display line is similar to a Limit Line, except that no 
PASS/FAIL testing occurs. A display line is easier to create than a Limit Line. 
Learn more in “All about Limit Lines” on page 715.

Figure 9-15 Display Line with Annotations

How to create and move a Display Line

— Press Limit_8 

— Then Display Line OFF ON

— Then enter a Y-axis value using the  arrows or the rotary knob, then 
press Enter. Or enter a value using the numeric keypad and press a suffix 
key or press Enter.

Learn more, “All about Limit Lines” on page 715.
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Noise Marker

For comparison purposes, electronic noise measurements are often displayed 
as though the measurement was made in a 1 Hz Res BW. However, making an 
actual measurement at a 1 Hz Res BW is extremely slow.

A Noise Marker, unique to SA Mode, mathematically calculates the noise 
measurement as though it were made using a 1 Hz bandwidth. 

Several data points (or ‘buckets’) are averaged together to calculate the Noise 
Marker readout. To accurately measure noise, the Noise Marker should NOT be 
placed on, or too close to, a signal. The distance from a signal depends on 
several factors. To know if an accurate reading is being made, move the Noise 
Marker until consistent measurements are displayed in adjacent data points. 

In addition, when a Noise Marker is displayed, the Detection method is 
automatically switched to Average and PAvg is shown on the FieldFox screen. 
This occurs only when Detector is set to Auto. Learn more in “Detection 
Method” on page 208.

With a Noise Marker present, the Res BW can be changed and the displayed 
noise floor will also change, but the Noise Marker readout will remain about 
the same.

Noise Markers can be used like regular markers. A Noise Marker is 
distinguished from a regular marker by (1Hz) after the marker readout value. 
Learn more about regular markers in “All about Markers” on page 700.

How to measure Noise with a marker 

— Press Marker to create or select a Normal or Delta marker to use to 
measure Noise. 

— Then More.

— Then Marker Function 

— Then Noise ON OFF.

Band/Interval Power Marker

A Band/Interval Power marker—available in IQA and SA Modes—accumulates 
the power that is measured over several adjacent data points (or ‘buckets’). 
The range of buckets being measured is displayed with vertical posts around 
the marker. This Band Span value is selectable. 

This feature is very similar to a channel power measurement (“Channel Power 
(CHP)” on page 216). 

When the frequency span is set to Zero span, the marker is referred to as an 
Interval Band Marker because it averages power over a specific time interval. 
In this case the range is specified as the Interval Span. Learn more about Zero 
span measurements in “Zero Span Measurements” on page 190.
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If the Detection method and Averaging type are set to Auto when you enable a 
Band/Interval Power marker, the Detection method will change to Average 
(RMS) and Averaging type will change to Power average.  Other Detection 
methods or Averaging type settings will usually cause measurement 
inaccuracy. Learn more about Detection method in “Detection Method” on 
page 208, and Averaging Type in “Average Type” on page 199.

Summary: 

— In Zero span, an Interval Power Marker yields the average power over the 
specified time interval.  

— In non-Zero span, a Band Power Marker yields the total power over the 
specified frequency range.

How to measure Band/Interval Power with a marker 

— Press Marker to create or select a Normal or Delta marker to use to 
measure Band/Interval Power. 

— Then press More

— Then Marker Function

— Then Band/Int Power

— Then Band (or Interval) Span

— Then choose from the following:

—Auto Measures power over 5% of the displayed span, or ½ graticules. 
The Band Span is automatically updated to remain at 5% when you 
change the frequency span.

—Man Enter a frequency or time value using the  arrows or the 
rotary knob, then press Enter. Or enter a value using the numeric 
keypad and select a frequency or time suffix. The Band Span remains 
at the frequency or time value that you set as the span changes.

Frequency Counter at Marker

— Available in SA Mode ONLY. Use any existing marker to make 
highly-accurate frequency counter readings. For highest accuracy, lock the 
FieldFox to a stable external frequency reference. Learn how in “Frequency 
Reference Source” on page 760.

When Frequency Counter is ON, the FieldFox uses background sweeps to 
zoom on the signal, measure the signal peak with 1 Hz resolution, and display 
the frequency of the signal peak in the marker annotation area. The marker 
does not move to the signal peak.

When Freq Counter is ON, measurement sweeps are considerably slower.



Keysight N9938-90006 User’s Guide                                                                                                                      213

SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)
SA Mode Settings

How to use Frequency Counter

— Press Marker.

— Press Normal, Delta, or Peak, or select an existing marker to use as a 
frequency counter.

— Locate the marker somewhere on a CW signal. It does NOT have to be on 
the peak. 

— Then More

— Then Freq Count ON

— With Freq Count ON, you can scroll through the existing markers that are 
located on a discrete CW signal, and read the frequency of the signal peak. 
However, each frequency count update requires another sweep. If the 
FieldFox is in HOLD, press Single to update the frequency count results.

Time Zero Fixed Marker

This feature was created to allow recall of vintage instrument states (older than 
Rev. 7.0) that included Zero span sweep with a trigger delay and at least one 
marker. Before Rev. 7.0, these instrument states were saved and recalled with 
the equivalent of the ON state of this setting. The default setting is OFF. Learn 
more about Triggering with negative delay in “Triggering” on page 192.

— Press Mkr->/Tools 

— Then More 

— Then Mkr Properties

— Then Time Zero Fixed

— Then choose from the following:

— ON Time Zero is fixed at the left-edge of the screen. A marker in 
negative delay resides at this point. This is the vintage behavior.

— OFF (default) Time Zero is located at the T-zero indicators. A marker 
in negative delay appears to the left of T-zero.

Audio Beep at Marker Power

When enabled, the Audio Beep feature emits a repetitive beep sound which 
varies in tone pitch and repetition rate to indicate the relative power level of the 
active marker. The highest tone pitch and fastest beep rate occurs when the 
marker Y-axis position is at the top of the display. Conversely, the lowest pitch 
and repetition rate occurs at the bottom of the display. Therefore, it is 
important to scale the signals that you intend to measure between the top and 
bottom of the screen. Learn more about Scale in “Scale and Units” on 
page 157.
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Audio Beep can be used with any marker type or function, including 
Band/Interval Power. Learn more in “Audio” on page 745.

How to use Audio Beep

— Press Marker

— Optionally, press Marker 1 2 3 4 5 6 to select an existing marker to use with 
Audio Beep. A marker will be created if one does not already exist. 

— Then More

— Then Marker Function 

— Then Audio Beep ON OFF

Audio Beep does NOT beep when the FieldFox is in Hold mode.

While Audio Beep is ON, press Marker 1 2 3 4 5 6 to toggle Audio Beep 
through the existing markers.

To set FieldFox speaker volume control, press System, then Volume. Learn 
more in “Audio” on page 745.

Meas UNCAL Error

Meas UNCAL appears in the lower-left corner of the screen when the FieldFox 
can NOT display accurate measurement results with the current settings. 
Usually, the part of the trace that is inaccurate is shown at –200 dB. 

The following situation can produce Meas UNCAL:

— When the ResBW/VBW ratio exceeds 10,000, causing the VBW filter to 
reach the maximum capacity for averaging.

Old Data Indicator (*)

In SA mode, when the current trace does not exactly match the annotation that 
is on the screen, an asterisk is displayed in the upper-right corner of the screen 
graticule area. This would occur, for example, when the Res BW setting is 
changed while in sweep Hold mode. The annotation is changed immediately, 
but the trace is not updated until the next sweep occurs. Therefore, the current 
data trace does not match the screen annotation. See the asterisk in Figure 
9-1 on page 147.
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Channel Measurements
The following Channel Measurements are offered in SA Mode:

Channel Power               “Channel Power (CHP)” on page 216

Occupied Bandwidth             “Occupied Bandwidth” on page 218

Adjacent Channel Power Ratio “Adjacent Channel Power Ratio (ACPR)” 
on page 220

Radio Standards and Channel Measurements

To tune the frequency range of any of the Channel Measurements using 
channels instead of frequency, first select a Radio Standard, then select Units = 
CHAN. Learn how to select a Radio Standard and channels in “How to select a 
Radio Standard” on page 154.

When you first select a Radio Standard, then select a Channel Measurement:

— With Units = FREQ selected, the center frequency and span will ALWAYS 
change to the full frequency range of that standard (Uplink and Downlink) 
to allow for a quick scan of energy. The X-axis annotation indicates the 
frequency range. 

— With Units = CHAN selected, the FieldFox chooses either the uplink or 
downlink band, and displays that range of frequencies. You can then tune 
within that Standard using Start CHAN, Stop CHAN, or Center CHAN. The 
X-axis annotation indicates the frequency range. 

When you first select a Channel Measurement, then select a Radio Standard, 
the BW, Offset, RRC, Integration BW, and Span settings are changed to those 
of the standard. In addition, Res BW can also change when set to 
‘Auto(couple)’. However, center frequency is NOT changed unless you first 
select Units = CHAN. 

Measurement Preset

Measurement Preset allows you to easily reset any of the channel 
measurements to its default settings. The Center Frequency, Preamp ON|OFF, 
RF Attenuation, Markers, Limits, and Radio Standard settings are NOT reset. 

How to select Measurement Preset:

— Press Preset then Mode Preset

Averaging

By default in ALL Channel measurements, averaging is enabled and set to 
display the average of the last 15 measurements. When enabled, this average 
setting is automatically making the following ‘averaging’ settings in order to 
provide the most accurate power measurements: 
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— Averaging Type is set to Power.

— Trace State is set to Average.

— Detector is set to Average.

— Count is set to 15. 

Any of these settings can be changed manually during a Channel 
measurement. Learn more about these settings starting in “Average Type” on 
page 199.

To change Averaging:

— Press Meas Setup 4.

— Then Average Enable ON OFF OFF effectively sets the Average Count to 1. 

— Then Average Count

— Enter a value between 1 and 10,000 using the numeric keypad,  
arrows, or the rotary knob.

— Press Enter. 

Traces

Only one measurement trace can be displayed in Channel Measurements.

Channel Power (CHP)

Channel Power measures total power over the specified Integrated BW. The 
Integration Bandwidth (IBW) can be adjusted to measure the power over 
multiple channels. 
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Figure 9-16 Channel Power Measurement

The following two Channel Power levels are displayed:

— Channel Power - measures total power over the specified Integrated BW. 

— Power Spectral Density – same measured power, but mathematically 
normalized to a 1 Hz bandwidth using the same algorithm as Noise Marker. 
Learn more about the Noise Marker in “Noise Marker” on page 211.

How to select Channel Power

— Press Measure 1

— Then Channel Measurements

— Then Channel Power

When Channel Power is selected, the following settings are maintained from a 
previous measurement: Center Frequency, Preamp ON|OFF, and RF 
Attenuation. 

Integration Bandwidth

When Channel Power is selected, vertical posts appear on the display to mark 
the current Integration Bandwidth setting. The displayed Channel Power and 
Power Spectral Density values are measured and calculated over the specified 
Integration Bandwidth. 



 218                                                                                                                     Keysight N9938-90006 User’s Guide

SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)
Channel Measurements

By default, the displayed frequency span is automatically coupled to the 
Integration Bandwidth. As you change the Integration Bandwidth, the 
frequency span is adjusted so that the vertical posts appear to NOT move. 
However, when you manually change the frequency span, the Integration 
Bandwidth is no longer coupled to the frequency span. 

When a Radio Standard is selected, the appropriate Integration Bandwidth is 
set automatically. Learn more about Radio Standards in “Radio Standard” on 
page 153.

To change Integration Bandwidth:

— Press Meas Setup 4

— Then Integ BW (Integrating Bandwidth)

— Enter a value between 100 Hz and 5 GHz using the numeric keypad,  
arrows, or the rotary knob.

— Press Enter

Other Channel Power Settings

All relevant FieldFox settings are made automatically to ensure the highest 
accuracy, such as ResBW, VideoBW, and sweep (SwpAcquisition) speed. 
These, and all other SA Mode settings, can be changed manually in a Channel 
Power measurement.

— Learn about Measurement Preset in “Measurement Preset” on page 215.

— Learn about Averaging in “Averaging” on page 215.

— Learn about RRC Weighting in “RRC Weighting” on page 224.

Occupied Bandwidth

Occupied Bandwidth measures the power of the displayed frequency span and 
displays vertical posts at the frequencies between which the specified 
percentage of the power is contained. The frequency span between the two 
vertical posts is the Occupied Bandwidth. The Occupied Power, the power that 
is contained between the two posts, is also displayed in dBm. 
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Figure 9-17 Occupied Bandwidth Measurement

The graphic above shows an OBW measurement; Chan 190 Downlink; GSM850 
Radio Standard

How to Select Occupied Bandwidth

— Press Measure__1

— Then Channel Measurements 

— Then Occupied BW

When Occupied Bandwidth is selected, the following settings are maintained 
from a previous measurement: Center Frequency, Preamp ON|OFF, and RF 
Attenuation. 

Frequency Span

Occupied BW is calculated from power that is measured over the entire 
displayed Frequency Span. The frequency span can be entered using arbitrary 
frequencies or by using a Radio Standard in conjunction with channel 
numbers. Learn how to select a Radio Standard and channels in “Channel 
Selection” on page 155.

To change Frequency Span:

— Press Freq/Dist 
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— Then Freq Span

— Enter a value using the numeric keypad,  arrows, or the rotary knob.

— Press Enter

Power Percent

This setting specifies the percentage of total measured power to display 
between the vertical posts. The measurement defaults to 99% of the occupied 
bandwidth power. The remaining power (1% of default setting) is evenly 
distributed;.5% of the power on the outside of each side of the vertical posts. 

To change Power Percent:

— Press Meas Setup 4

— Then Power Percent

— Enter a value between 10 and 99.99 using the numeric keypad,  
arrows, or the rotary knob.

— Press Enter. 

Other Occupied Bandwidth Settings

All relevant FieldFox settings are made automatically to ensure the highest 
accuracy, such as ResBW, VideoBW, and sweep (SwpAcquisition) speed. 
These, and all other SA Mode settings, can be changed manually in a Occupied 
Bandwidth measurement.

— Learn about Measurement Preset in “Measurement Preset” on page 215.

— Learn about Averaging in “Averaging” on page 215.

Adjacent Channel Power Ratio (ACPR)

ACPR measures the power of a carrier channel and the power in its adjacent 
(offset) channels. The measurement results can help you determine whether 
the carrier power is set correctly and whether the transmitter filter is working 
properly. 

You can measure the channel power in one, two, or three adjacent (offset) 
channels on the low frequency and high frequency side of the carrier channel. 

Limits can be used to quickly see if too much power is measured in the 
adjacent channels.

Integration BW (IBW) is coupled to the Frequency Span setting. Frequency 
Span is 50% wider than the IBW (e.g., if the IBW value is 1 MHz, then the 
Frequency Span value is 1.5 MHz).
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Figure 9-18 GSM 850-Ch 251-Up with one Offset

In the graphic above, red frequencies (MHz) are added to illustrate offset and 
integ BW.

Data in the ACPR graphical chart is always presented in dBm for the carrier, 
and dBc (dB below the carrier) for the offsets. This can NOT be changed. Use 
the Meas Type setting (next page) to change how the data is presented in the 
table below the graph.

How to select ACPR

— Press Measure__1

— Then Channel Measurements 

— Then Adjacent Channel Power 

When ACPR is selected, the following settings are maintained from a previous 
measurement: Center Frequency, Preamp ON|OFF, and RF Attenuation. 
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Frequency Range/Channel

When a Radio Standard is selected, the appropriate center frequency or 
channel and span is set automatically. The frequency or channel number can 
then be changed from the Freq/Dist menu. Learn how to select a Radio 
Standard and channels in “Radio Standard” on page 153. 

The frequency range of an ACPR measurement can also be entered using 
arbitrary frequencies. 

When a Radio Standard is NOT selected, the center frequency of a previous 
measurement is maintained when ACPR is selected. 

Integration Bandwidth 

The Integration Bandwidth of the carrier and offsets is the frequency span over 
which power is measured.

To change Integration Bandwidth:

— Press Meas Setup 4

— Then Integrating BW 

— Enter a value between 100 Hz and 100 MHz using the numeric keypad, 

 arrows, or the rotary knob.

— Press Enter

How to define adjacent (Offset) channels

An offset represents a difference in center frequencies of the carrier channel 
and its adjacent channel to be measured. The frequency range for each offset 
is specified with an Offset Freq and Integ BW. Each offset that is created has a 
Lower (carrier MINUS Offset Freq) and Upper (carrier PLUS Offset Freq) set of 
frequencies. 

— Press Meas Setup 4

— Then Offsets 

— Press Offset 1 2 3 to select an offset. 

— Then Offset State to set that offset ON or OFF.

— Select Offset Freq This is the difference between the carrier center 
frequency and the center frequency of the offset channel. Then enter a 
value using the numeric keypad. 

— Select Offset Integ BW This is the frequency range over which power is 
measured in that offset; half of the range below and half above the Offset 
Freq. 
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How to set limits for adjacent channels

You can set a unique threshold power for each of the offsets that will cause a 
FAIL indication (RED bar). This occurs when the calculated dBc power (on top 
of the offset bar) is ABOVE the specified level. 

To set limits, with an ACPR measurement on the screen:

— Press Limit 8 

— Then Offset (1,2,3)

— Then choose from the following:

—LowerOffsetLimit Sets a limit for the lower-frequency offset.

—Upper OffsetLimit Sets a limit for the higher-frequency offset.

— Then enter a value using the numeric keypad,  arrows, or the rotary 
knob.

— Then Limit Test ON OFF

Measurement Type

This setting determines how the measured carrier and offset power levels in 
the table are presented. (Data in the graphical chart is always presented in 
dBm for the carrier and dBc for the offsets.)

To select Meas Type:

— Press Meas Setup 4.

— Then More

— Then Meas Type

— Then choose from the following:

—Total Pwr Ref – Integrated carrier power is represented in dBm, and 
relative powers between offsets and carrier are represented as dBc 
(dB below the carrier).

—PSD Ref (Power Spectral Density) – Integrated carrier power is 
normalized to a 1 Hz density as dBm/Hz using a similar algorithm as 
Noise Marker. Learn more about the Noise Marker in “Noise Marker” 
on page 211.

For both Meas Types, choose the reference for the offset data.

— Press Ref Value   to toggle between these settings:

—Auto - dB or dBc value is computed by subtracting the measured 
carrier power from the measured offset power.

—Man – dB or dBc value is computed by subtracting the entered 
RefValue from the measured offset power.
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—Then enter a value to be used to reference the data using the numeric 

keypad,  arrows, or the rotary knob. 

Other ACPR Settings

All relevant FieldFox settings are made automatically to ensure the highest 
accuracy, such as ResBW, VideoBW, and sweep (SwpAcquisition) speed. 
These, and all other SA Mode settings, can be changed manually in a ACPR 
measurement.

— Learn about Measurement Preset in “Measurement Preset” on page 215.

— Learn about Averaging in “Averaging” on page 215.

RRC Weighting

RRC, or Root-Raised-Cosign weighting, is offered with Channel Power and 
ACPR measurements. 

When RRC Weighting is applied to transmitted and received power, the edges 
of the channel are ‘smoothed’ to help prevent interference. To accurately 
measure a channel that has RRC weighting, set the same value of RRC 
weighting as that used in the transmitter and receiver.

Figure 9-19 Channel power measurement with.22 RRC applied

RRC Weighting is set and enabled automatically when included in a selected 
radio standard. 

To set and enable RRC Weighting:

— Press Meas Setup 4

— Then RRC Weighting ON OFF 

— Then More 

— Then RRC Alpha [current setting]
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— Enter a value between 0 (no smoothing) and 1 (most smoothing) using the 

numeric keypad,  arrows, or the rotary knob. A standard level of filtering 
is 22.

— Press Enter.
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How to Set Up EMF Settings (Requires EMF (Option 358), GPS (Option 307), 
and SA Mode (Option 233–Mixed Analyzers))

EMF mode measures signals at the SA RF Input Port 2 connector. 

EMF mode requires the FieldFox to have SA mode (Option 233 on combination 
analyzers), or 5G NR Option 378), GPS (Option 307), and CPU2 installed. 

Recommended, but not required, preamplifier (Option 235) to improve receiver 
sensitivity.

With Option 358 (EMF), network designers can measure and verity the RF 
exposure compliance as required by each country. 

If SA mode is licensed for EMF Option 358, the primary measurement 
performed is Channel Power (CHP) which automatically switches amongst the 
3 TriAxial antenna axis (X/Y/Z), to provide a summation of “total power” 
detected, using unique Antenna supplied corrections for the individual axis, 
with results in FieldStrength units. This is accomplished within the existing SA 
Channel Power measurement.

Even without license EMF Option 358, the System Utilities menu enables one 
to Import Corrections and manually drive the Antenna to a particular axis (X, Y, 
or Z). The manual control thus allows any SA Receiver measurement to sweep 
that axis just like any other antenna transducer, however without license the 
imported corrections are not usable from the Apps. But with license the SA 
provides for easy use of the imported XYZ corrections, thus allowing 
presentation of correctly compensated FieldStrength measurements, for 1 axis 
at a time. 

This section reviews the steps in setting up an EMF measurement, using a USB 
antenna. If you are not familiar with this process or would like more 
information, refer to Chapter 15, “USB Antennas – (Full Capability Requires 
EMF Option 358, and either SA mode (Option 233 Mixed Analyzers) or 
OTA—5G NR / 5G NR EVM Conducted Option 378).”

This section consists of:

If OTA or SA mode does not detect an EMF Option 358 license, then the 
EMF application and the USB antenna’s axes must be set up manually. This 
use model is not recommended or supported by Keysight. 

The USB antenna’s cable loss is not included, in the antenna’s correction factors. For an 
accurate EMF measurement, the cable loss values should be accounted for. Refer to “Editing 
Cable Correction Factors and Adding New Cable Factors” on page 235.

IMPORTANT! The USB triaxial antenna—or equivalent—is required for EMF 
measurements. Refer to Chapter 15, “USB Antennas – (Full Capability 
Requires EMF Option 358, and either SA mode (Option 233 Mixed 
Analyzers) or OTA—5G NR / 5G NR EVM Conducted Option 378).”
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— “EMF Features” on page 227

— EMF Setup Procedure

EMF Features

EMF has the following features:

EMF Measurement Results:

— Measure and display corrected field strength in RMS average power

— Antenna control over X, Y, and Z antenna factors downloaded via USB

— Pass/Fail limit testing supported

— External PC not required

EMF uses the following data formats:

— Field Strength units:

— dBµV/m – For use with E-field signals

— dBµA/m – For use with H-field signals

— dBG – dB Gauss

— dBpT - dB Tesla                          
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Figure 9-20 Example of EMF with Triaxial Antenna
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EMF Setup Procedure

1. Setup the FieldFox Spectrum Analyzer for a Channel Power measurement. 

a. Press Mode > SA > 

Press Measure 1 > Channel Measurements > Channel Power

See also, “Channel Measurements” on page 215.

2. Connect a USB antenna’s RF cable to the SA RF Input, port 2 and the USB 
connector to a FieldFox USB port. See also, Figure 9-20 on page 228 and 
to Chapter 15, “USB Antennas – (Full Capability Requires EMF Option 358, 
and either SA mode (Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR 
EVM Conducted Option 378).”

3. Importing and selecting the X/Y/Z antenna factors:

a. Press System > Utilities> USB Antennas 

— Then Import Antenna – to import the antenna factors from the 
antenna’s memory over the USB connection (this may take 5 
seconds or so and vary with the Triaxial antenna). 

— Then USB Antenna [Tri Axial] verify Triaxial (default) is selected. 

— Optional: Press Antenna Axis the antenna axis should be set to Auto 
for default operation. When AUTO is selected the application (e.g., 
Channel Power or OTA) controls the axes and switches as needed. 
With the AUTO setting, all antenna elements (X, Y, and Z) are OFF. 

When the USB antenna correction factors are imported, EMF (Option 358) 
couples many settings to ease setting up the EMF measurement (e.g., 
Apply Corrections is enabled, all X, Y, and Z antenna axes are enabled, and 
Amp Corr Select is set to TriAxial XYZ). 

If necessary, this step can be skipped and done after the USB antenna is 
set up. 

Only Agos Advanced Technologies SDIA–6000 Triaxial Isotropic USB 
antenna is currently compatible with EMF (Option 358). 

If the antenna factor import is successful, the FieldFox displays: “Success: Antenna 
Factors Imported: Tri-Ax Antenna ID: ->[R] Antenna ID: 
SDIA-6000-1006 ->[]“. The last 4-digits will vary for each antenna (i.e., “1006” value will 
vary).

If the FieldFox displays this error Error: USB antenna Error: Not found or 
Unable to communicate with antenna. Ensure it is connected. is 
displayed, verify the USB antenna is connected correctly. See also, “Troubleshooting” on 
page 456.
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— Press Back > Back to exit the USB Antenna softkey menu.

4. Modifying the EMF settings:

Press Meas Setup 4 

— Then More > EMF then

—  EMF Meas OFF ON disable/enable the EMF measurement.

—  EMF Units choose dBuV/m (default) or V/m.

—  Back to exit to the previous softkey menu.

For more details on editing the USB antenna, refer to Chapter 15, “USB 
Antennas – (Full Capability Requires EMF Option 358, and either SA mode 
(Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM Conducted 
Option 378).”

5. Enabling the imported USB antenna factors and Cable factors:

a. Enabling the Channel Power: Press Measure 1 > Channel 
Measurements > Channel Power

b. To enable the Triaxial antenna for EMF: Press Scale/Amptd > Amp 
Corr Select [Default] > TriAxial XYZ 

With Sum all, the field strength from all three axes is summed and 
displayed. The RF measurements are switched between the three 
different antennas (three dipoles), and the resulting summation of 
the total power collected, and averaged.

Alternatively, you can select either of three axes to individually 
measure the field strength in the one direction.

c. Else, if the SysCtrl Triaxial softkey is viewable (i.e., EMF TriAxial 
[OFF] is not viewable). The SysCtrl Triaxial softkey is not editable, 
and indicates the System control softkeys are manually controlling 
a single X, Y, or Z antenna dipole for uncorrected use. [X, Y, or Z] is 
displayed to indicate which one of the X/Y/Z dipole axes is enabled. 
If for example the X axis has been selected in the System > Utilities 
> USB Antenna menu, then USB Antenna [X] is displayed to 
indicate the X axis measurement (i.e., this uncorrected manual 
mode is typically used when no EMF Option 358 is installed). Refer 
to Figure 9-21. See also step f.

Figure 9-21 SysCtrl Triaxial [N] Softkey – With the X–Axis Dipole Selected 

d. Modifying the Amplitude Correction Selection:

Press Scale/Amptd > More > Corrections > More then
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— Amp Corr Select [Triaxial XYZ] - then choose one of the 
following: 

— Default Receiver side only antenna measurements.

— Src/Rcvr Split to work with non-triaxial receiver and 
source side antenna measurements.

— Triaxial XYZ (default, when Channel Power is on and 
when a compatible triaxial antenna’s factors have 
been imported) for measuring channel 
measurements and EMF. 

— Then Back to exit to the previous softkey menu.

e. Optional (Triaxial XYZ Antenna):

Verifying antenna and cable corrections are applied:

i. Press Scale/Amptd > More > Corrections 

— Then verify the Apply Corrections Auto Disabled 
softkey is set to Auto (This is the default setting when a 
compatible USB antenna’s correction factors have been 
imported, via the System softkeys).

— Then verify the X axis Antenna, Y axis Antenna, and Z 
axis Antenna are all ON. These can each be enabled or 
disabled individually, but for EMF measurements all 
three axes should be enabled (i.e., Antenna = Off, the 
applications are setting the X/Y/Z).

— Then Press Cable Off to open the cable correction 
softkeys menu.

Verify Cable is ON. This can be disabled for applications 
where an additional cable has not been connected to 
the triaxial antenna. Before a cable can be used with 
the EMF measurements it needs to have corrections 
loaded. If you are going to use a cable, then choose as 
needed:

— Cable Off to enable a cable for use in your 
antenna measurement.

— Edit Cable displays a cable corrections table 
that you can edit 

— New displays a cable corrections table that 
you can edit with new cable correction 
content.

Yes – Choose Yes to overwrite the current cable 
data
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— Save Cable Opens a menu to name and save 
the cable corrections data

— Recall Cable Recalls the selected cable 
correction file from the \Cables folder.

— Storage Device to select the storage device 
where your cable correction file is located 
(Internal/USB/SD Card)

ii. Optional: Press More then

— Press View Corrections OFF ON to turn ON and OFF 
Pink Trace - Antenna/Cable corrections. This is a 
composite of all cable/antenna corrections that are 
currently applied. Available as a useful visual aid, the 
zero “dB” level (no net correction) is mapped to appear 
at the -50 dBm on-screen level.

— Press Src/Rcv Split - selecting Src/Rcv Split selects 
Source and Receiver side measurements.

f. Optional: Example of editing X, Y, and Z axes manually. 

— Press X axis Antenna – opens the X axis Antenna softkey 
menus. Then choose one or more of the following: 

— X axis Antenna – enable/disable the X axis antenna 
factors (default is coupled to other settings).

— Edit Antenna – to edit the current imported X factor 
(if available). Refer to “Editing Antenna Correction 
Factors and Adding New Antenna Factors” on 
page 233.

— New – to edit/define a new X factor value. Refer to 
“Editing Antenna Correction Factors and Adding 
New Antenna Factors” on page 233.

— Save Antenna – to save either an edited X antenna 
factor or a new X antenna factor. See also See also 
Chapter 30, “System Settings” and then to “Alpha 
Numeric Editing” on page 749.

No – Choose No to exit the cable data edit table 
view

The USB antenna factors stored in the triaxial antenna itself cannot be 
overwritten. The antenna factors on FieldFox imported into FieldFox can be 
modified. To reset the antenna factors in FieldFox to the original factors, 
re-import the antenna factors. 
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— Recall Antenna – to recall a stored X antenna factor. 
See also Chapter 30, “System Settings.”

— Storage Device – to select the location to store your 
new antenna factor. See also Chapter 30, “System 
Settings.”

Editing Antenna Correction Factors and Adding New Antenna Factors

This section contains two procedures illustrating how to edit the Antenna 
Factors settings table values.

1. Selecting an antenna softkey menu:

Press Scale/Amptd > More > Corrections then choose one of these softkey 
menus: 

— X axis Antenna – to open a softkey menu to edit the X axis of a 
triaxial antenna.

— Y axis Antenna – to open a softkey menu to edit the Y axis of a 
triaxial antenna.

— Z axis Antenna – to open a softkey menu to edit the Z axis of a 
triaxial antenna.

— Cable – to open a softkey menu to edit the cable factors for an 
antenna setup. 

 

2. For this example, the X axis Antenna softkey menu has been selected:

a. Then press Edit Antenna to edit the existing X axial antenna factor’s 
Frequency and Antenna Factor table values that are stored in the 
FieldFox [:Internal]:\Antenna\ directory (Refer to Figure 
9-22). Then you can edit the following:

— Description – edits the name of the current antenna settings 
table

— Antenna Factor Unit – edits the units from dB /m electric 
antenna factor to dB S/m for the magnetic antenna factors. 
None is displayed, when no antenna is detected.

— Frequency – edits the frequency value measured that 
corresponds to a particular Antenna Factor.

— Antenna Factor – edits the Antenna Factor (amplitude) that 
corresponds to a particular frequency.

If New is selected under the X, Y, or Z Antenna or Cable softkey menu, 
whatever antenna or cable factors that have been imported as the default 
values and are displayed in the Settings table. 
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Refer to next step for details on editing the antenna Settings 
table.

b. Use the  arrows, the rotary knob, or numeric keypad to select 
the table cell value to be edited (i.e., the Frequency Interpolation 
value is not editable). Then: 

— Press Edit Antenna to edit your existing antenna factors or 

press New to add a a new antenna’s factors or to write over 
your existing antenna’s file (i.e., Overwrite existing Antenna 
data? is displayed above the table). 

— Choose Yes to write over the existing antenna file.

— Choose No to create a new antenna file (default 
filename is Example). 

— Press Add Row to create additional Frequency and Antenna 
Factor values.

— Press Delete/Clear then choose one of these:

— Delete Row – when pressed this choice deletes the 
currently selected row of Frequency and Antenna 
Factors (i.e., you must press Yes to delete a row or 
No to exit the current softkey menu). 

— Clear All – when pressed this choice deletes all of 
the currently selected rows of Frequency and 
Antenna Factors (i.e., you must press Yes to deleted 
the rows or No to exit the current softkey menu). 

— Back – To exit to previous softkey menu.

— Press Done when finished editing to exit. 

c. Press Save Antenna to save your changes. See also Chapter , “File 
Saving Naming Options” and then to “Alpha Numeric Editing” on 
page 749.

For more information:

— See also “GNSS (GPS+) and GPS” on page 756.
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Figure 9-22 Example Editing and Adding a New X axis antenna is shown.

Editing Cable Correction Factors and Adding New Cable Factors

This section contains two procedures illustrating how to edit the Cable Factors 
settings table values.

1. Selecting an cable softkey menu:

Press Scale/Amptd > More > Corrections then choose one of these softkey 
menus: 

— Cable Off – to open a softkey menu to edit the cable factors for an 
antenna setup. 

 

2. For this example, the Cable Off softkey menu has been selected:

If New is selected under the X, Y, or Z Antenna or Cable softkey menu, 
whatever antenna or cable factors that have been imported as the default 
values and are displayed in the Settings table. 
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a. Then press Cable Off > Edit Cable to edit the existing cable’s 
Frequency and Cable Loss table values that are stored in the 
FieldFox [:Internal]:\Cable\ directory (Refer to Figure 9-22). 
Then you can edit the following:

— Description – edits the name of the current cable correction 
settings table

— Frequency Interpolation – sets the frequency interpolation to 
linear or to log.

— Frequency – edits the frequency value measured that 
corresponds to a particular Cable Loss.

— Cable Loss – edits the Cable Loss value that corresponds to a 
particular frequency.

Refer to next step for details on editing the cable Settings 
table.

b. Use the  arrows, the rotary knob, or numeric keypad to select 
the table cell value to be edited (i.e., the Frequency Interpolation 
value is not editable). Then: 

— Press Edit Cable to edit your existing cable loss data or 

press New to add a a new antenna’s factors or to write over 
your existing antenna’s file (i.e., Overwrite existing Cable 
data? is displayed above the table). 

— Choose Yes to write over the existing cable file.

— Choose No to create a new cable file (default 
filename is Example). 

— Press Add Row to create additional Frequency and Cable Loss 
values.

— Press Delete/Clear then choose one of these:

— Delete Row – when pressed this choice deletes the 
currently selected row of Frequency and Cable Loss 
(i.e., you must press Yes to delete a row or No to exit 
the current softkey menu). 

— Clear All – when pressed this choice deletes all of 
the currently selected rows of Frequency and Cable 
Loss (i.e., you must press Yes to deleted the rows or 
No to exit the current softkey menu). 

— Back – To exit to previous softkey menu.

— Press Done when finished editing to exit. 
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c. Press Save Cable to save your changes. See also Chapter , “File 
Saving Naming Options” and then to “Alpha Numeric Editing” on 
page 749.

For more information:

— See also “GNSS (GPS+) and GPS” on page 756.

Figure 9-23 Example: Editing and Adding a New X axis antenna is shown. But, the Cable 
Loss table is similar.
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Spectrum Emission Mask (SEM) — (SA Mode Only)
This section explains how to make the spectrum emission mask, (SEM), 
measurement. SEM compares the total power level within the defined carrier 
bandwidth and offset channels on both sides of the carrier frequency, to levels 
allowed by standard. Results of the measurement of each offset segment can 
be viewed separately.

Purpose

The Spectrum Emission Mask measurement includes the in-band and 
out-of-band spurious emissions. It is the power contained in a specified 
frequency bandwidth at certain offsets relative to the total carrier power. It 
may also be expressed as a ratio of power spectral densities between the 
carrier and the specified offset frequency band.

The spectrum emission mask measurement is a composite measurement of 
out-of-channel emissions, combining both in-band and out-of-band 
specifications. It provides useful figures-of-merit for the spectral regrowth and 
emissions produced by components and circuit blocks.

Measurement Method

The spectrum emission mask measurement measures spurious signal levels in 
up to 8 pairs of offset/region frequencies and relates them to the carrier power.

The integration bandwidth method is used to perform a data acquisition. The 
reference channel integration bandwidth (Meas BW) is analyzed using the user 
defined resolution bandwidth (Res BW), which is much narrower than the 
channel bandwidth. The measurement computes an average power of the 
channel or offset/region over a specified number of data acquisitions, 
automatically compensating for resolution bandwidth and noise bandwidth.

This measurement requires the user to specify the measurement bandwidths of 
carrier channel and each of the offset/region frequency pairs up to 12 (A - L). 
Each pair may be defined with unique measurement bandwidths. The results 
are displayed both as relative power in dBc and as absolute power in dBm.

Summary

Similar to other Radio Channel measurements, SEM sweeps and measures the 
total power within a Reference channel. It also optionally performs sweeps of 
user defined offset segments both above and below the reference channel. The 
peak signals within the offsets are compared against limits, to determine PASS 
or FAIL results. Tabular data is presented showing individual offset segment 
results, one row for each offset. A final trace is displayed that contains all of 
offset segment sweeps and the reference channel sweep is formed and plotted 
along with the limits.

The following are displayed:

— Total Power Ref (dBm / Hz) - measures total power over the specified 
Integrated BW. 
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— Spectrum Emission Mask Pass/Fail – A PASS indicates the displayed SEM 
is within the current boundaries specified. A FAIL indicates the current 
signal fails with the specified parameters.

Figure 9-24 SEM Example
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Figure 9-25 SEM Example FAIL Data - Absolute Limit (Blue), Relative Limit (Violet), Trace 
(Yellow), and Tabular Data

How to select Spectrum Emission Mask (SEM) Measurement

— Press Measure 1

— Then Channel Measurements

— Then Spectrum Emission Mask 

When SEM is selected, the following settings are maintained from a previous 
measurement: Center Frequency, Preamp ON|OFF, and RF Attenuation. 

Setting up the FieldFox for Spectrum Emission Mask (SEM) Measurement

1. Press Measure 1 > Channel Measurements > Spectrum Emission Mask

2. Press Meas Setup 4 then optionally select:

— Averaging Enable/disables averaging and sets the number of trace 
averages (Default is OFF).

— Meas Type Then select one of the following: 
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Measurement Type (Meas Type) enables the user to select the 
method used to calculate the reference power level. 

— Total Pwr Ref (Default is Total Pwr Ref) is the total 
integrated reference channel power (dBm) is measured 
and used as the Auto Power Ref value. Peaks found in 
Offset segments remain in (dBm) units for direct 
comparison with (dBm) limits.

— PSD Ref the power spectral density (dBm/Hz) is measured 
and used as the Auto Power Ref value. Absolute Limits and 
Peaks found in Offset segments are normalized to their 
equivalent PSD value (dBm/Hz).

— Spec Pk Ref the spectral peak value measured within the 
reference channel (dBm) is used as the Auto Power Ref 
value. Peaks found in Offset segments remain in (dBm) 
units for direct comparison with (dBm) limits. Values in the 
table are compared to the peak power of the spectrum.

— Ref Channel Opens the Reference Channel softkey menu. Then 
select one of the following:

— Integ BW Sets the Integrated bandwidth. 

— Ref Chan Span Sets the reference channel span. usually 
set equal or greater than the Integ BW, it is simply a way to 
reserve additional freq range to be measured for display 
presentation, if that range is not overlapped by the offset 
regions. The reference channel is always measured 
completely as specified, but only the central part of the 
reference channel that is NOT overlapped by active offset 
regions is displayed. (Minimum = 10 Hz/ Maximum = Value 
varies with model and options). 

— Carrier Center Tracks currently displayed carrier center 
frequency (Default = TrackCF). Set to Hold to disable the 
carrier frequency tracking.

— Res BW Auto/Manual (Default is Auto). Sets the resolution 
bandwidth. See also, “Resolution Bandwidth (Res BW)” 
on page 182.

— Offsets Opens the frequency Offsets softkey menu. Then select one 
of the following:

— Offset Sets the number of pairs of frequencies to be offset 
(up to eight pairs can be selected). 

The displayed green power (dBm)/frequency (Hz) text changes as the 
Meas Type is toggled. 
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— Ofst Enable Enables/disables the currently selected 
Frequency Start/Stop Offset values.

— Ofst Freq Start Sets the offset frequency start value. 
(Default/Maximum = Value varies with model and options, 
Minimum = 0 Hz).

— Ofst Freq Stop Sets the offset frequency stop value. 
(Default/Maximum = Value varies with model and options, 
Minimum = 0 Hz). 

— Res BW Auto/Manual (Default is Auto). Sets the current 
resolution bandwidth value. See also, “Resolution 
Bandwidth (Res BW)” on page 182. 

— Offset Side Neg Both Pos (Default is Both). Sets the offset 
side measurement value. Select Negative (Neg) to 
measure the negative side of the spectrum. Select Positive 
to measure the positive side of the spectrum.

— Offset Freq Def then select one of the following:

— Carrier Center (Default) applies the frequency offsets to 
the current carrier center frequency.

— Carrier Edge Selects the edge of the carrier for frequency 
offset definition.

— Power Ref – the reference power value can be fixed (which also 
fixes the Relative Limit line), but the user must then consider the 
unit being used (dBm or dBm/Hz) depending on the Meas Type 
selected. If Power Ref is left AUTO (Default) then its value will track 
the Meas Type and change units automatically. Both fixed and Auto 
settings display the power reference value measured. 

3. Setting Center Frequency and Span

Press Freq/Dist then

— Center - sets the center frequency.

— SEM Auto Span - Enables/disables the SEM Auto Span. 

— Freq Span - sets the frequency span of the SEM measurement.

Frequency control menu (Center and Span) provides an SEM Auto Span 
control (defaulted to ON) which automatically tracks the necessary span to 
cover all enabled offset segments. In the example in Figure 9-25 on 
page 240, the necessary span is 16 MHz. But the you can de-couple the 
span simply by narrowing or widening Span it in order to zoom. 

The Carrier Frequency (Ref Channel Center) by default tracks the specified 
Center Frequency, but can be forced to “Hold” at a particular location 
which would then allow the user Center Frequency to pan above or below 
for reasons similar to zooming with span.
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— More - optional to set Radio Standard controls. Refer to “Radio 
Standard” on page 153.

4. Setting the Limit Lines

Two Limit traces are available, an Absolute Limit and a Relative Limit. Both 
are defined and applied only over the Offset measurement regions. There 
is no Limit definition or application for the Reference Channel itself. The 
final Limit Trace displayed is a concatenation of all the individual Offset 
Limit segments, just as the final measurement trace is. Success or Failure 
is determined by Fail Mask per offset, to be based on either Relative or 
Absolute limits, Both (Abs AND Rel), or Either (Abs OR Rel).

Press Limit 8 then

— Offset - selects the offset region to be edited. 

The Limits per offset are determined by Start/Stop Amplitude level 
endpoints, which correspond exactly to the user specified 
Start/Stop frequency locations in the Offsets sub-menu. So each 
offset segment is a LINE defined by its two endpoints. In the Limit 
“Auto” means to match the Start limit value, hence creating a FLAT 
(horizontal) Limit Line segment. But the Stop value can be manually 
set as well, creating sloped Limit segments.

— Abs Start - Sets the start of an absolute limit line segment.

— Abs Stop - Sets the stop of an absolute limit line segment.

— Rel Start - Sets the amplitude limit at the start frequency of the 

offset, relative to the reference power level.

— Rel Stop - Sets the amplitude limit at the stop frequency of the 
offset, relative to the reference power level. 

— Fail Mask - Sets the Fail Mask offset parameters for the 
measurement. Then choose:

— Absolute - The absolute mask is tested for all offsets.

— Relative - The relative mask is tested for all offsets.

— Abs OR Rel - Either Absolute or Relative data failure 
generates a fail message.

The reference power level is displayed in green. The reference power level 
type can be selected through Measure 1 > Meas Type, and the reference 
power settings defined through Meas Setup > Ref Channel.

Example: If the reference power level reads -15 dBm, and Rel Start is set 
to -10 dB, the level is -25 dBm. Since this limit line type is relative, it 
moves with the reference power reading.



 244                                                                                                                     Keysight N9938-90006 User’s Guide

SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)
Spectrum Emission Mask (SEM) — (SA Mode Only)

— Abs AND Rel - Requires a relative and an absolute data 
failure to generate a fail message.

5. Setting the Detectors

 

The Trace menu shows that two Detector controls are available, one for 
the Reference Channel (default Auto is Average to facilitate the Power 
Integration), and another for all the Offset segments (default Auto is PEAK, 
to facilitate finding PEAK signal energy when comparing against Limits).   
There is only 1 Trace available, and like the other Channel Measurements, 
it is set to average. 

Press Trace 6 then

— State - sets the measurement state. Refer to “Trace Display States 
(SA Mode)” on page 198.

— Default All - Sets the SEM settings to default 

— Chan Detector - Sets the Reference Channel detector (default Auto 
is Average to facilitate the Power Integration). See also “Detection 
Method” on page 208.

— Offset Detector - Sets all of the Offset segments (default Auto is 
Peak, to facilitate finding peak signal energy when comparing 
against the Limits). See also “Detection Method” on page 208.

— Record Playback - Refer to “Record/Playback (SA Option)” on 
page 519.
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IQ Analysis (Requires Option 351 IQ Analyzer and Option 353 IQ Streaming, SA 
Mode Only)

How to Select IQ Analysis

— Press Meas Setup 4

— Then IQ Analysis then choose from

— Then General – 

— Then Streaming – to emit a sequence of packets from a specific 
location in a VRT (VITA49) enabled architecture (e.g., VRT packet 
class with a defined packet attribute used in one or more places in a a 
architecture to create packet streams). 

When IQ Analysis is selected, the following settings are maintained from a 
previous measurement: Center Frequency, Span, BW, Sample Rate, Preamp 
ON|OFF, and RF Attenuation. 

This feature’s intended use is that the Streamed data will be sent to 
another computer. That computer or another one will act as a SCPI 
controller and is required for actually controlling the streaming, in 
particular setting up network configuration data and starting and stopping 
the streaming.

IMPORTANT!

- IQ Streaming is used by configuring the desired setup and then starting 
the acquisition/data stream. In order to make measurement changes 
(bandwidth, center frequency, etcetera) streaming must be stopped, the 
new setup configured, and then streaming restarted.

- During streaming, the data displayed on the FieldFox is not updated.

- For both Decodio and VITA49, FieldFox encodes all streamed I and IQ 
data as 32-bit IEEE 754 floating point values. 

- FieldFox does not support TCP networking.

- Data for both protocols is 2 floating point values per sample (I and Q).

– Except for the 32-bit floating point only option for I and Q data, FieldFox 
implements VITA 49A a subset of the VITA 49.2 protocol.

– While in any IQ Analysis mode, the sample rate to frequency span will 
stay locked/coupled in a ratio of 1.25:1.
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How to Setup IQ Analysis General

General setup for IQ Analysis:

1. Press Meas Setup 4 > IQ Analysis > General

2. Press IQE Sample Rate > Auto (default). 

3. Press Average Count > 10 (default). Learn more refer to “Adjusting the 
Measurement Setup Settings” on page 299.

4. Press Average Type > Auto (default). Learn more refer to “Adjusting the 
Measurement Setup Settings” on page 299.

5. Press Freq/Dist > Center > 1 GHz 

6. Press Freq Span > 1 MHz (default). 

How to Setup IQ Analysis Streaming

The feature provides continuous streaming of IQ data up to 1.25 MSamples/sec 
over the Ethernet port in either VITA49A or Decodio formats.

If locked to GPS, will populate the timestamp applied to streamed data 
packets. If not locked to GPS, the system clock time is used to stamp the 
streamed data packets. Refer to Chapter 30, “System Settings” and to 
“Frequency Reference” on page 748.

General setup for IQ Streaming:

1. Press Meas Setup 4 > IQ Analysis > Streaming

2. Then IQE SampRate > Manual > 1.25 MHz (default when set to Auto). 

Setting the IQE sample rate to Manual, forces the Span to be:  
Span = 0.8 * Sample rate.

3. Configure Center Frequency, Span, Preamp, and RF Attenuation 

a. Press Freq/Dist > Center > 1 GHz 

b. Press Freq Span > 1 MHz (default). 

This forces the Span to be: 
Span = 1.25 * Span.

This feature’s intended use is that the Streamed data will be sent to 
another computer. That computer or another one will act as a SCPI 
controller and is required for actually controlling the streaming, in 
particular setting up network data and starting and stopping the 
streaming.



Keysight N9938-90006 User’s Guide                                                                                                                      247

SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)
IQ Analysis (Requires Option 351 IQ Analyzer and Option 353 IQ Streaming, SA Mode 
Only)

a. Then to adjust receiver gain:

Press Scale/Amptd then

— To configure automatically: Press Ref Level – adjust as 
needed.

or 

To adjust manually:

— Press Preamp ON (default = OFF)

— Press RF Atten > Manual > 15 dB (default)

4. Setup IQ Streaming protocol, destination host, and port:

To set the destination host, IQ streaming protocol, and samples per 
packet, refer to the [:SENS]:IQST subsystem commands in the FieldFox 
Handheld Analyzer SCPI Programming Guide on www.keysight.com. 

— Destination Host

— Destination Port – (default is 4991) 

— Protocol – Choose Vita or Decodio

— Samples per packet

5. Start Streaming: Refer to the FieldFox Handheld Analyzer SCPI 
Programming Guide on www.keysight.com. 

6. When done press Exc to stop streaming or refer to the FieldFox Handheld 
Analyzer SCPI Programming Guide on www.keysight.com.

Or via the FieldFox front panel, choose:

— Press Meas Setup 4 > IQ Analysis > None

Or simply choose:

— Press Measure 1 > All Meas Off

Typically, the goal is to be able to see the desired signal that you want to 
capture as close as possible to the top of the display grid on the screen, 
without causing an ADC over range to be displayed. This maximizes the 
signal-to-noise ratio.
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Effective Isotropic Radiated Power (EIRP) – (SA Mode Only)

How to Select Effective Isotropic Radiated Power (EIRP)

— Press Measure 1

— Then Channel Measurements > More > EIRP to open a menu of softkeys to 
set up EIRP.

How to Setup EIRP (Effective Isotropic Radiated Power)

General setup and an example for EIRP:

For this example we are using an isotropic antenna with the following 
specifications:

— Frequency range: 9 kHz to 9 GHz isotropic antenna

— Preamp stages: 2 (+15 dB each (@2 GHz)

— Chop/Switch speed rate: 1 Hz to 50 kHz

— Assume: 600 Series 50 ꭥ coaxial cable with 2.5 dB/100 feet

1. Press Measure 1 > Channel Measurements > Channel Power > More > 
EIRP then choose from the following: 

— EIRP Meas – Enables and disables the EIRP measurement.

— Rx Ant Gain – Enter the receiver ant gain (–100 db to 100 db; 
default = 0 dB). 

For this example: 30 dB > Enter.

— Dist to Ant – Enter the distance between the receiving and 
transmitting antennas (0 m to 25 km; default = 100m) 

For this example: 100m (default)

— Rx Cable Loss – Enter the receiver cable loss (0 to –100 dB; default 
= 0 dB). 

For this example: 2.5 dB

— Margin Comp – Enter the margin compensation to remove known 
self-interference, antenna efficiency, fading and other errors 
(–100 db to 100 db; default = 0 dB).

— Then More and choose from the following:

— Restart – Press this softkey to restart an antenna measurement.
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— Save Horizontal – Saves the current horizontal EIRP value (dBm).

— Save Vertical – Saves the current vertical EIRP value (dBm).

— Clear H & V –Clears the saved horizontal and vertical EIRP values 
(dBm).

2. Configure Center frequency, Span, Preamp, and RF Attenuation 

— Press Freq/Dist > Center > 2 GHz 

— Press Freq Span > 3 MHz (default) 

— Press Scale Amptd > Preamp > ON (default = OFF)

— Press RF Atten Auto (default = Auto)

3. Summary of EIRP setup, per step 1.

— Press Rx Ant Gain For this example: 30 dB > Enter.). 

— Press Dist to Ant For this example: 100m (default)

— Press Rx Cable Loss For this example: 2.5 dB

— Press Margin Comp 

4. Start EIRP: Press Restart

5. When done press: 

Save Horizontal and

Save Vertical

6. Optional: To clear the saved horizontal and vertical EIRP values press: 

Clear H & V 
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10 RTSA (Real-time Spectrum Analyzer) Mode—Option 350

RTSA Mode measures signals at the SA RF IN connector. 

For a comprehensive RTSA mode tutorial, see Understanding and Applying 
Probability of Intercept in Real-time Spectrum Analysis (App Note) at 
https://www.keysight.com/us/en/assets/7018-04381/application-notes/599
1-4317.pdf.

Figure 10-1 RTSA Display using Markers

The graphic above shows an RTSA display of a Bluetooth signal using 
markers.
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Figure 10-2 

The graphic above shows an RTSA display shows an RTSA display of an 
80 MHz linear FM chirp with a center frequency of 1 GHz (requires Option 
B10).
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In this Chapter:

See Also

“Frequency Range” on page 254

“Scale and Units” on page 256

“External Gain” on page 256

“Attenuation Control” on page 257

“Preamplifier Control (Opt 235)” on page 258

“Check for Compressed Measurements” on page 258

“Resolution Bandwidth (Res BW)” on page 263

“Triggering” on page 264

“Single / Continuous / Restart / Time Per Div” on page 267

“Points (not user settable)” on page 268

“Trace Display States (RTSA)” on page 269

“Average Count, Show Density, Blue, and Red Percentage Limits” on 
page 271

“Average Count” on page 272

“Alignments” on page 272

“Detection Method” on page 270

“Display Line” on page 272

“Spectrogram Display (RTSA Option)” on page 274

“Record/Playback (RTSA Option)” on page 276

Optional Settings:

“All about Markers” on page 700

“All about Limit Lines” on page 715

“Saving and Recalling Files” on page 778
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RTSA Mode Settings
Select RTSA Mode before making any setting in this chapter.

Because there is no calibration, these settings can be made in any order.

How to select RTSA Mode

— Press Mode_ 

— Then Real-Time SA.

Frequency Range

The X-axis frequency range determines the frequencies that are measured for 
each sweep. The default Start frequency is 950 MHz. However, the Start 
frequency can be set as low as –150 MHz. The internal LO of the FieldFox can 
be seen at 0 Hz, which will mask signals that may be present. 

The frequency range of the measurement can be changed using the following 
methods:

— Set Center and Span frequencies (Frequency Span varies with instrument 
model)

— Set Start and Stop frequencies

— Toggle between Zero and Last selected span

— Using Marker -> Center

When you initially select I/Q Analyzer, Real-time SA, or some of the other 
spectrum settings (such as center frequency) a factory channel 
Equalization measurement is applied to the signal. During channel 
equalization measurement, the FieldFox displays a “Start Channel 
Equalization”. Stopping channel equalization is not permitted. See also, 
“Alignments” on page 201, in Chapter 9, “SA (Spectrum Analyzer) Mode 
(Option 233–Mixed Analyzers).”

Although the start frequency can be set as low as -150 MHz, amplitude 
accuracy is specified above 9 kHz (depending on your model).  Below 
9 kHz (depending on model), frequency accuracy is maintained, but 
amplitude accuracy is degraded. Refer to 
https://www.keysight.com/us/en/assets/7018-03314/data-sheets/5990-
9783.pdf. 

The FieldFox can be used with an OML frequency extender. Refer to 
“Utilities” on page 732, the B Series FieldFox Configuration Guide 
5992-3701EN, and to “Contacting Keysight” on page 5.
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How to set Frequency Range

— Press Freq/Dist. 

— Then choose from the following:

—Center and Freq Span frequencies. This is the most common method 
of entering frequency range. Enter the frequency of interest. The 
Center frequency is at the exact center of the X-axis. The Frequency 
Span places half of the frequency range on either side of center. 
When the Center and Frequency Span values are entered, then the 
X-axis annotation on the screen shows the Center and Span 
frequencies. 

—Start and Stop frequencies. Start is the beginning of the X-axis and 
Stop is the end of the X-axis. When the Start and Stop frequencies 
are entered, then the X-axis annotation on the screen shows the Start 
and Stop frequencies. 

— Optionally, press More then:

——CF Step then type a step size value using the numeric keypad, 
then select a multiplier key.

——Freq Annotation and one of the following:

——Full Span the frequency span changes the instrument’s full 

frequency span (frequency span is model dependent).

— Follow each of these, when prompted, by entering a value using the 

numeric keypad, the  arrows, or the rotary knob.

— When using the  arrows, press Enter. The increment setting of the 
arrows is based on the current span. This can be changed in RTSA Mode.

— After using the keypad, select a multiplier key. Learn more in “Multiplier 
Abbreviations” on page 46.

AutoSelect (Default) – The FieldFox selects a frequency annotation 
setting (CenterSpan or StartStop).

CenterSpan -The center frequency and span are displayed.

StartStop - The start and stop frequencies of the frequency span are 
displayed.

When in full span, ADC dither raises the noise floor at the edges of the 
120 MHz.
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Scale and Units

Adjust the Y-axis scale to see the relevant portions of the data trace. 

The Y-axis is divided into 10 graticules. A acquisition is shown on the screen as 
a solid horizontal bar that can be placed at any graticule.

RTSA always uses logarithmic scale. The Y-axis reference line represents the 
specified absolute acquisition (dBm). Y-axis graticules show dB below or above 
the reference line.

When RF Attenuation set to Auto, the RF Attenuation is coupled to acquisition. 

How to set Scale

Press Scale / Amptd. Then choose from the following:

Manually set Scale, acquisition, and Reference Position.

— Scale Manually adjust the dB scale per division to view specific areas of the 

current trace. Enter a value using the numeric keypad, the  arrows, or 
the rotary knob. Then press Enter.

— Ref Level Manually set the value of the reference line. Enter a negative 
value by pressing Run/Hold (+/-) either before or after typing a value. This 
can also change the RF Attenuation setting. See “Attenuation Control” on 
page 257.

— Ref Pos Manually set the position of the reference line. Values must be 
between 0 (top line) and 10 (bottom line). Default position is zero (top).

External Gain

When using an external amplifier or attenuator, the RTSA mode trace 
amplitude values can be offset to compensate for the effect of the external 
device. This effectively moves the reference plane of the RTSA measurement 
port out to just beyond the external device. For example, when using an 
external preamp with gain of +10 dB, enter this value for External Gain, and the 
data trace across the displayed frequency span will be adjusted down by 
10 dB. 

When RF Atten is set to Auto, you may see a change in the RF Attenuation 
value. This is an attempt to measure the signal at top of screen (the 
acquisition) without overloading the RTSA first mixer.

How to Set External Gain

— Press Scale/Amptd.

— Then External Gain
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— Enter a value using the numeric keypad, the  arrows, or the rotary knob 
(positive for gain; negative for loss). Values in increments less than 5 dB 
must be typed using the numeric keypad. Then press Enter

ExtGain xx dB is shown at the top of the screen.

Attenuation Control

Both the RF Attenuation and Preamp functions control the power level into the 
RTSA.

When too much power is present at the RF Input port, ADC Over Range 
appears on the FieldFox screen. This does not necessarily mean that damage 
has occurred, but that the measurement is probably compressed. 

When high power levels are present at the RF Input port, internal attenuation 
can be switched in to keep the FieldFox receiver from compressing. At 
extremely high power levels, use external attenuation to protect the internal 
circuitry from being damaged. 

The displayed power level is automatically adjusted for RF Attenuation. As the 
attenuation value changes, the displayed power level should NOT change.

How to set Attenuation

— Press Scale/Amptd.

— Then RF Atten Man Auto

— Auto RF Attenuation is set by adjusting the acquisition. As the acquisition is 
lowered, for example from –10 dBm to –40 dBm, the FieldFox assumes that 
you are looking at low-level signals. The RF Attenuation value is 
automatically lowered in 5 dB steps to allow low-level signals to be viewed.

The FieldFox can be damaged with too much power. Refer to the FieldFox 
Data Sheet for your model on 
https://www.keysight.com/us/en/assets/7018-06516/data-sheets/5992-
3702.pdf.  
Maximum Input Voltages and Power:

RF Output Connector: 50V DC, +23 dBm RF

Ext Trig/Ref Connector: 5.5 V DC

RF Input: 

    +27 dBm RF, ±50 VDC Max. (N991xA/B, N9925B, N9926A,       
      N9928A, N993xA/B)

    +23 dBm RF, ±50 VDC Max. (N9923A, N9923AN)

    +25 dBm RF, ±40 VDC Max. (N995xA/B, N996xA/B)

DC Input: 19VDC, 4ADC, 60 Watts maximum when charging battery
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— Man RF Attenuation is set manually. Enter a value between 0 to 40 dB in 

5 dB steps using the numeric keypad, the  arrows, or the rotary knob. 
Then press Enter.

#Atten xx dB is shown at the top of the screen. (#) means manual setting.

Preamplifier Control (Opt 235)

When very low-level signals are analyzed, an internal preamplifier can be used 
to boost the signal level by approximately 15 to 20 dB (depending on model). 
The gain of the preamp is NOT adjustable. The displayed signal level is 
automatically adjusted for the increase in system gain, therefore turning the 
Preamp ON should NOT cause a change to the displayed signal. 

How to control the Preamp

By default, the preamp is OFF. 

— Press Scale/Amptd.

— Preamp ON OFF When ON, PA is shown to the left of the graticules on the 
display. 

— Auto When Auto is selected, the preamp setting is coupled to the RF 
attenuation and to the acquisition. When the acquisition reaches a certain 
value, the preamp is turned on and PA is shown to the left of the graticules 
on the display.

Check for Compressed Measurements

Compression occurs when too much power into an amplifier causes it to no 
longer amplify in a linear manner. When too much power goes into the 
FieldFox RF Input connector, the amplifiers in the RTSA receiver compress and 
signal power will not be displayed accurately. This can occur even if ADC Over 
Range is not displayed because devices other than the ADC, such as the mixer, 
might be compressed. Increase the RF Attenuation value to prevent the RTSA 
receiver from being compressed. 

How to Check for a Compressed Measurement

— Using a marker at the signal peak, make note of the signal power level.

— Increase the RF Attenuation level by 5 dB.

—If the signal level does NOT change, then NO compression exists. This 
indicates that the signal is in the linear region of the FieldFox 
receiver. 

—If the signal level DOES increase, then the receiver was compressed. 
Set the RF Attenuation value at the setting when further increases no 
longer result in an increase in the displayed power level. 
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Spectrum Selection 

To select the spectrum-type for your measurement:

How to make Spectrum Settings

— Press Measure 1

— Then Press:

— Density Spectrum The signal displayed is a real-time spectrum with 
a histogram bitmap. Refer to Figure 10-3 on page 260 and Figure 
10-4 on page 261.

— Spectrogram The signal is displayed is a real-time spectrum with a 
spectrogram bitmap. Spectrogram views are valuable in capturing 
signals that include both time and frequency variations. Refer to 
Figure 10-5 on page 261.

— Real-time Spectrum The signal is displayed as a real-time spectrum. 
Use real-time spectrogram to quickly display measurements. Refer to 
Figure 10-6 on page 262.

In all three spectrum measurements, there are four available traces 
for representation of the real-time spectrum.

Density Spectrum and Spectrogram data is lost when you change modes, 
because the FieldFox optimizes the instrument’s resources during mode 
changes.
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Figure 10-3 Density Spectrum (Histogram) FM Signal with 1 MHz FM Deviation & 400 Hz 
FM Rate
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Figure 10-4 Density Spectrum (Histogram) with 2 Pulses, 100 MHz Span (Blue color 
indicates pulse that occurs less frequently)

Figure 10-5 Spectrogram (100 MHz Span)
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Figure 10-6 Real-time Spectrum
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Setting the IF Path

How to check or set the IF Path. By default the IF Path is set to Auto.

— Press BW 2.

— Then IF Path The underlined setting is the current setting. Choose Auto, 
10 MHz, or 100 MHz (100 MHz requires Option B04 or B10). 

Optional: After you click 100 MHz, you can use the Freq/Dist hard key and 

the number pad or using the numeric keypad, the  arrows, to increase 

your IF path bandwidth to 120 MHz.

Resolution Bandwidth (Res BW)

In RTSA Mode, the Res BW provides the ability to resolve, or see closely 
spaced signals. The narrower (lower) the Res BW, the better the spectrum 
analyzer can resolve signals. In addition, as the Res BW is narrowed, less noise 
is measured by the spectrum analyzer ADC and the noise floor on the display 
lowers as a result. This allows low level signals to be seen and measured. 

How to set Res BW 

— Press BW 2.

— Then Res BW. 

— Then choose from the following:

— Auto Res BW is coupled to the frequency span. As the frequency 
span is narrowed, the Res BW is also narrowed providing increased 
ability to resolve signals.  
To change this setting from Man to Auto, press Res BW twice.

When in full span, ADC dither raises the noise floor at the edges of the 
120 MHz.

For best results, use the AUTO setting for the Res BW values. Increasing 
the resolution BW could reduce pulse measurement capability by 
affecting the 100% POI duration and the minimum detectable signal level. 
The resolution BW must be as narrow as possible to maintain gapless 
measurements. 

When Manual RBW is selected, the FieldFox attempts to set the RBW to 
the setting you request, but this setting is coupled to the current span 
settings. If the manually set RBW is not settable with the current 
frequency span value, the FieldFox defaults to the nearest achievable 
RBW setting to meet the manual RBW value. 
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— Man Enter a Res BW value using the numeric keypad, the  
arrows, or the rotary knob. Then press a multiplier if necessary or 
press Enter

The current Res BW setting is shown at the bottom of the screen. 

#Res BW x.xx XHz (#) means manual setting.

This setting could impact the accuracy of the measurement. See Specifications 
in Appendix B. 

Triggering

External, Video, and RF Burst triggering enable you to initiate an RTSA mode 
sweep using an external event such as a signal burst. 

Trigger Type

— Press Sweep 3

— Then Trigger Settings

— Then Trig Type

— Then choose from the following:

— Free Run Triggering is provided by the FieldFox internal circuitry. A new 
sweep begins when the previous sweep ends. 

— External A sweep is triggered on an external TTL signal at the Ref In/Trig In 
connector on the FieldFox top panel. Choose to trigger on the rising slope 
at about 1.7 V or on the falling slope at about 1.0 V using the Trigger Slope 
setting (below). 

— Periodic sets a trigger that repeats at the period rate entered. Periodic 
trigger's phase can be altered by the Offset value.

The following two selections are similar in that they both trigger a sweep from 
a signal at the SA RF Input connector. Experiment with both selections to find 
the best trigger type for your application.

Triggering only applies to Density Spectrum and Real-time Spectrum.
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— Video A sweep is initiated when the amplitude of an incoming signal 
crosses the settable trigger level. The comparison is done in the time 
domain, before conversion to frequency domain. Refer to “Trigger Slope”, 
“Trigger Delay”, “Trigger Level” on page 266, “Auto Trigger Time” on 
page 266, and to “Trigger Hold-Off” on page 267.

— RF Burst A sweep is initiated when the signal at the third IF (analog) stage 
crosses the settable Trigger Level. This selection reacts to a wider 
bandwidth of the incoming signal than Video Trigger, which could be 
beneficial. However, RF Burst is not as sensitive to triggering on low-level 
signals. Refer to “Trigger Slope”, “Trigger Delay”, “Trigger Level” on 
page 266, “Auto Trigger Time” on page 266, and to “Trigger Hold-Off” on 
page 267.

— Periodic Trigger repeats at the period rate entered. Periodic trigger’s phase 
can be altered by the Offset value.

Then choose from the following:

— Period Enter a value for the trigger to repeat (100 ns to 400 ms). 

— Offset Enter a offset value to offset the phase of the periodic trigger 
(–100 ms to 100 ms).

— Reset Offset Display Resets Offset to default 0.000000 s.

Trigger Slope          

Trigger Slope determines which edge of an External, Video, or RF Burst trigger 
signal initiates a sweep. 

— Press Sweep 3

— Then Trigger Settings

— Then Trig Slope

— Then choose from the following:

— Pos Sweep is triggered by the rising (positive) edge of signal.

— Neg Sweep is triggered by the falling (negative) edge of signal.

Trigger Delay 

After a valid trigger signal is received, the sweep begins after the specified 
Trigger Delay time.

— Press Sweep 3

If your trigger level is set too high for the current measurement gain setup, 
you will see an error message, similar to this one, displayed: “Video 
TrigLevel was HW Limited, it is x.xx dB above current capability”. Adjust 
your trigger level settings until the message is no longer displayed. 
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— Then Trigger Settings

— Then Trig Delay

— Enter a value using the numeric keypad, the  arrows, or the rotary 
knob. (0 to 10 seconds)

— Then select a multiplier key or press Enter. Learn more in “Multiplier 
Abbreviations” on page 46.

Trigger Level 

Used with Video and RF Burst triggering, a sweep is initiated when an 
incoming signal crosses this level. See also “Scale and Units” on page 256.

RF Burst Trigger Level uses an alignment process which is performed in the 
background to set the detected signal level accuracy. Video Trigger Level is a 
comparison done on the time domain signal, before conversion to the spectral 
frequency domain. Processing from the time to frequency domain can cause 
broadband (e.g., pulsed) signal energy to display at lower power levels than 
the peak power levels of the time domain signal. Therefore you may need to 
the set trigger level higher than the displayed spectral level.

— Press Sweep 3

— Then Trigger Settings

— Then Trig Level

— Enter a value using the numeric keypad, the  arrows, or the rotary 
knob. (–210 to 30 dBm)

— Then select a multiplier key or press Enter. Learn more in “Multiplier 
Abbreviations” on page 46.

Auto Trigger Time

While waiting for a valid trigger signal, Wait is annotated in the top left corner 
of the FieldFox screen.

If a valid trigger signal is not received before the specified Auto Trig Time, a 
sweep will occur automatically.

When Auto Trigger is OFF, the FieldFox does NOT sweep unless a valid trigger 
signal is received.

— Press Sweep 3

— Then Trigger Settings

— Then Auto Trigger

— Enter an Auto Trig Time using the numeric keypad. (1 ms to 100 seconds)

— Then select a multiplier key. See “Multiplier Abbreviations” on page 46.
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— Enter 0 to set Auto Trigger OFF or press the Auto Trigger softkey a second 
time to turn OFF Auto Trigger.

Trigger Hold-Off 

Used with External, Video, and RF Burst triggering, sets the hold-off time 
between triggers. (Range: 0.000000 to 10.000000 seconds)

Once a trigger occurs, future triggers are ignored until the trigger hold-off time 
expires. Setting the trigger hold-off to zero, essentially turns off the trigger 
hold-off feature. Also, you can press Trig Hold-Off > OFF.

Trigger Settings Annotation

Trigger settings are annotated on the FieldFox screen as shown in the following 
figure:

— Trig Type (VidT), AutoTrigger (a), Pos Slope (/)

— Horizontal arrow: Trig Level (green horizontal graticule at -35 dBm)

Single / Continuous / Restart / Time Per Div

This setting determines whether the FieldFox measures continuously or only 
once each time the Single or Run / Hold +/- button is pressed. Use Hold / 
Single to conserve battery power or to allow you to save or analyze a specific 
trace. 

— To conserve battery power, in addition to using Hold / Single, you must 
also, set the System > preferences >Preferences > Battery Saver to On. 
For more, refer to the System Settings chapter and “Preferences” on 
page 740. 
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How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

— Continuous 

——ON Causes the RTSA to make continuous sweeps. This is the 
typical setting for making measurements. Each Run / Hold +/- 
press causes the RTSA to toggle between continuous sweep 
and Hold. 

——OFF Causes the RTSA to Hold. Each Run / Hold +/- or Single 
press causes the RTSA to make ONE sweep, then Hold. The 
Hold annotation changes to an arrow --> while the sweep 
occurs.

— Single Automatically sets Continuous OFF and causes the RTSA to 
make ONE sweep, then Hold.

— Restart Resets the average counter to 1. If Continuous sweep is OFF, 
it also causes Average Count (n) sweeps to occur if any Trace State is 
set to RMS Average, MinHold, or MaxHold. This softkey is also used 
to clear the Spectrogram display. Learn more in “Average Count” on 
page 272.

Acq Time

Use the Acq Time setting to adjust acquisition time interval for each trace 
update in Density or Real-time Spectrum measurements. 

How to set Acq Time

— Press Sweep 3.

— Then choose:

— Acq Time Acq Time affects the quantity of information being 
captured during a density or real-time spectrum measurement. 

——Auto (default) the FieldFox chooses the optimum Acq Time 
based on the span setting (default is 20 ms, when span is set 
to full span). 

——Manual enables user settable acquisition time values.

Points (not user settable)

Points is the number of measurements that are displayed along the X-axis. 
RTSA automatically sets the points to 821 and is not user settable.
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Trace Display States (RTSA)

In RTSA Mode you can display up to four of the following types of trace states. 
All RTSA settings are applied to all displayed traces. These traces represent the 
Real-time Spectrum in each of the three measurement modes. 

A color-coded legend for displayed traces is visible in the left pane of the RTSA 
mode screen:

W = Clear/Write; M = MaxHold; m = MinHold; A = Average; V = View

How to display the Trace States

— Press Trace 6. 

— Then Trace 1,2,3,4 repeatedly to select a trace number to display or change 
its state. Traces are displayed in the following default colors (i.e., the colors 
are user settable): 

— Trace 1 – Yellow   Trace 2 – Blue

— Trace 3 – Orange  Trace 4 – Green

— Then State [current setting] 

— Then choose from the following Trace States:

—Clr /Wr [W] (Clear/Write) Displays the actual measured data for each 
sweep.

—MaxHold [M] Displays the maximum response of the input signal at 
each data point over multiple sweeps. See also Average Count in 
“Average Count” on page 272.

—MinHold [m] Displays the minimum response of the input signal at 
each data point over multiple sweeps. See also Average Count in 
“Average Count” on page 272.

—RMS Average [A] Each data point is averaged over multiple sweeps as 
set by the Average Count setting. Learn more in “Average Count” on 
page 272.

—View [V] Displays and then holds the last complete measurement trace 
on the screen. This is similar to storing a trace in memory. 

—Blank Displays no trace.

You can use the FieldFox’s Remote Server mode (89600 VSA software 
connectivity) to parse playback files and captured data as MATLAB files 
(*.mat). Learn more about FieldFox and 89600 VSA software, refer to 
Chapter 17, “Remote Server Mode (Requires SA Hardware/SA Option 
233)” and to 
http://rfmw.em.keysight.com/wireless/helpfiles/89600B/WebHelp/89600
.htm.
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— Press Default All to return all traces to their default settings: Trace 1 
(Clear/Write); all other traces, including trace detectors (Blank).

Detection Method

In RTSA Mode, the X-axis is comprised of data points, also known as “buckets”. 
Learn more in “Points (not user settable)” on page 268.

Regardless of how many data points are across the X-axis, each data point 
must represent what has occurred over some frequency range and time 
interval.

From the frequency span of the measurement, the span of each data point is 
calculated as (frequency span / (data points-1)). The detection method allows 
you to choose how the measurements in each bucket are displayed.

Using the RTSA feature, each of the four available traces can have an 
independent detection method.

How to set Detection Method

The current Detection method for each trace is labeled on the left edge of the 
screen. A corresponding letter appears below the corresponding Trace number 
selected. For example: N means that Normal was the selected detector.

— Press Trace_6 

— Then Detector

— Then choose from the following:

—Auto [...] Displays the most appropriate Detection method based on 
other settings. 

— Normal [N] Provides a better visual display of random noise than 
Positive peak and avoids the missed-signal problem of the Sample 
Mode. Should the signal both rise and fall within the bucket interval, 
then the algorithm classifies the signal as noise. An odd-numbered 
data point displays the maximum value encountered during its 
bucket. An even-numbered data point displays the minimum value 
encountered during its bucket. If the signal is NOT classified as noise 
(does NOT rise and fall) then Normal behaves equivalently as Positive 
Peak.

—Positive Peak [P] Displays the maximum value of all the measurements 
in each bucket. This setting ensures that no signal is missed. 
However, it is not a good representation of the random noise in each 
bucket. 

—Negative Peak [p] Displays the minimum value of all the 
measurements in each bucket. 



Keysight N9938-90006 User’s Guide                                                                                                                      271

RTSA (Real-time Spectrum Analyzer) Mode—Option 350
RTSA Mode Settings

—Sample [S] Displays the center measurement of all the measurements 
in each bucket. This setting gives a good representation of the 
random noise in each bucket. However, it does not ensure that all 
signals are represented.

—RMS Average [A] Displays the Root Mean Squared (RMS) average 
power of all the measurements in each bucket. This is the preferred 
method when making power measurements.

Repeat the detection setup process as needed for up to 4 traces and 4 
detection methods.

Average Count, Show Density, Blue, and Red Percentage Limits 

How to set:

— Press Meas Setup 4

Then choose one of the following:

— Average Count – Changes the quantity of traces averaged for certain 
trace states (i.e., MaxHold, MinHold, or RMS Average). Refer to 
“Average Count”.

— Show Density – (Density Spectrum Only) Displays a histogram image 
of the traces. 

— Blue Limit % – (Density Spectrum Only) Changes the percentage of 
the trace that has a blue limit (0.05% to 100%, default is 0.05%). This 
setting is coupled to the color bar in the upper right corner of the 
FieldFox display.

— Red Limit % – (Density Spectrum Only) Changes the percentage of 
the trace that has a blue limit (0.05% to 100%, default is 100%). This 
setting is coupled to the color bar in the upper right corner of the 
FieldFox display.

— Blue Limit dBm – (Spectrogram Only) Changes the power level 
(dBm) of the trace that has a blue limit (–210 dBm to 30, default is 
–90 dBm). This setting is coupled to the color bar in the upper right 
corner of the FieldFox display.

— Red Limit dBm% – (Spectrogram Only) Changes the power level 
(dBm) of the trace that has a blue limit (–210 dBm to 30, default is 
–50 dBm). This setting is coupled to the color bar in the upper right 
corner of the FieldFox display.

Blue limit and red limit percentages are coupled to the density percentage 
limit bar in the upper right of the FieldFox display. Or, for the blue limit and 
red limit power levels (dBm) are coupled to the Spectrogram power level 
(dBm) limit bar in the upper right of the FieldFox display. 
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Average Count 

The Average Count setting is used mainly with the RMS Average Trace State 
described in “Trace Display States (RTSA)” on page 269. (But, also applies to 
the MaxHold or MinHold trace states.) In the RMS Average Trace State, the 
Average Count setting determines the number of sweeps to average. The 
higher the average count, the greater the amount of noise reduction. 

For all three of these Trace States (RMS Average, MaxHold, or MinHold), when 
Sweep 3 Continuous is set to OFF, press Restart to reset the sweep count to 1, 
perform <n> sweeps, then return to Hold.

How to set Average Count

— Press Meas Setup 4 

— Then Average Count

— Enter a value from 1 to 10,000 using the numeric keypad, the  arrows, 
or the rotary knob.

— Press Enter

Alignments 

The RTSA mode requires all three alignment types: amplitude, RF burst, and 
channel equalization. Refer the SA chapter’s “Alignments” on page 201 for 
information on all Alignments.

Display Line

A display line is a simple, horizontal line that can be placed at any amplitude 
level on the RTSA screen. Use a display line as mental guide for visual 
feedback. 
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Figure 10-7 Display Line with Annotations

How to create and move a Display Line

— Press Limit __8 

— Then Display Line OFF ON

— Then enter a Y-axis value using the  arrows or the rotary knob, then 
press Enter. Or enter a value using the numeric keypad and press a suffix 
key or press Enter.

Learn more, “All about Limit Lines” on page 715.
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Spectrogram Display
Spectrogram display provides a visual history of the measured spectrum. This 
display type can be used to locate intermittent signals or to view signal levels 
and frequencies over time.

This display can NOT be used with Channel Measurements.

Spectrogram Display (RTSA Option)

Spectrogram draws the most recent trace record at the bottom of the stack of 
previously-drawn trace records. Drawing the live trace on the display is 
optional. 

Figure 10-8 Spectrogram display- Overlay view 

How to select Spectrogram

— Press Meas 1 

— Then Spectrogram

How to modify the Spectrogram

You can change how the spectrogram is displayed relative to the data trace. 
This setting affects the total number of trace records that can be displayed. 

For RTSA Mode:

— Press Meas Setup 4.

— Then Spectrogram View

— Then choose from the following:

— Overlay Displays the data trace over the spectrogram with NO 
graticules. Total trace records: 340.
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— Top Displays the data trace below the spectrogram. Total trace 
records: 130.

— Bottom Displays the data trace above the spectrogram. Total trace 
records: 130.

Common Settings for Spectrogram

Set Red and Blue Limits

The colors displayed on the Waterfall and Spectrogram represent the various 
measured power levels:

— Red = Highest power levels

— Blue = Lowest power levels

Adjust the Red and Blue limits to the power levels that you expect to measure.

The Blue limit must always be less than the Red limit. 

For RTSA Mode:

— Press Meas Setup 4.

— Then choose from the following: 

— Red Limit Using the  arrows, rotary knob, or keypad, select the 
HIGHEST power level that you expect to measure. This power level, 
and those measured higher than this level, appear Red.

— Blue Limit Using the  arrows, rotary knob, or keypad, select the 
LOWEST power levels that you expect to measure. This power level, 
and those measured lower than this level, appear Blue. 

How to Restart the Spectrogram

Press Sweep 3 then Restart

The full Red-to-Blue color spectrum is visible only with Indoor display 
colors. Learn more in “Display Colors” on page 729.



 276                                                                                                                     Keysight N9938-90006 User’s Guide

RTSA (Real-time Spectrum Analyzer) Mode—Option 350
Record/Playback (RTSA Option)

Record/Playback (RTSA Option)

Record Playback allows you to record RTSA trace sweeps and play them back 
at a later time. Use this feature to monitor spectrum activity over a period of 
time.

You can record traces continuously or record a specified number of traces 
(segments).

When GPS is enabled, the current location and elevation are saved and played 
back with traces.

Recordings can be saved to the FieldFox Internal memory, an SD Card, or a 
USB flash drive. 

About Sessions

A Recording Session is a collection of recorded traces and the instrument 
states that generated them.

Before recording can occur, a new session must be initiated or an existing 
session must be opened. Sessions can later be opened for playing or continued 
recording. Only one session can be open at a time. 

You close the session when finished recording or playing. A session is also 
closed when the FieldFox is Preset (or Mode Preset), an Instrument State is 
recalled, or when Mode is changed from RTSA.

Each session is saved as a folder containing a set of files on the specified 
storage device.

How long can a recording session last?

There are many variables that determine the possible length of a recording 
session. But one key variable is the amount of available memory. 

When a session is opened or a new session is initiated, an estimate is made of 
the maximum number of traces that can be saved based on the available disk 
space and the current number of data points (resolution). Recording will stop 
when that number is reached. This estimate always keeps 4 MB of available 
disk space on the specified storage device. You can decrease the number of 
traces to further limit recording.

To maximize the amount of space that is available, save recorded traces to a 
USB Flash drive or SD card. Learn how in “Manage Sessions” on page 283.

Density Spectrum information is not recorded. Only the trace data is 
saved. See “How to Record a Session” on page 279. 

Record/Playback is only available in Density Spectrum and Real-time 
Spectrum measurements. Record/Playback is not supported on 
Spectrogram. See “How to Record a Session” on page 279. 
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You can determine the length of time over which recording can occur by 
setting the Record Interval (the time between recorded traces) and other 
settings. Learn more in “Recording Configuration” on page 281. 

To view and edit the maximum number of records

Just after opening or initiating a session...

— Press Session Data 

— Then TraceRecordLimit <n> (n = Max number of traces that can be 
recorded).

— Clear All Records Empties that session of recorded traces. Learn more in 

“Manage Sessions” on page 283.

FieldFox Setting Changes during Record and Playback

During Recording

When any of the following State settings are changed during recording, the 
State counter is incremented (“About State and User Tags” on page 278) and 
the settings are saved to the Session file along with the first trace to be 
recorded with the new setting. During playback, the trace and display 
annotation will reflect the change on the screen.

State settings: 

Refer to Table 10-1 on page 278 for a list of the applicable state settings for 
the RTSA options.

IMPORTANT! Pressing Clear All Records causes a loss of ALL of the session 
data. 
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Other display settings, such as Scale and acquisition, can also be changed 
during recording but are not saved with the session file. Think of these as 
settings that help YOU see the recording and playback activity. They do NOT 
change the data that is recorded.

During Playback

Changes to the states listed above are NOT allowed during playback.

However, all other display settings can be changed during playback to help 
you analyze the recorded data. 

In RTSA mode, trace recordings are played back as is and the Trace State 
cannot be modified. No measurement post processing is allowed, and no 
Density or Spectrogram information can be recovered. This is because RTSA’s 
Real-time Spectrum and Density displays are not derived from the trace data, 
but instead require independent high speed hardware acquisition.

Record/Playback Exceptions

Markers can be activated and moved to help analyze recorded data. However, 
marker position control is only available when playback is Paused. 

About State and User Tags

When any of the State settings (listed above) are changed during a recording, 
a ‘state tag’ is inserted at the first trace number to be recorded with the new 
setting. 

Table 10-1 Summary of RTSA State Settings

Option Settings

RTSA

Acquisition Time

Detector(s)

External Gain

Frequency Range 

Preamp On/Off

Resolution BW

RF Attenuation

Trace State(s)

Trigger Settings
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In addition, you can insert a ‘User Tag’ at any time during a recording session 
to indicate an external event, such as when an antenna is moved. During 
playback, you can move quickly to any of these tags, or scroll through these 
tags. 

A symbol is used on the screen annotation to distinguish a User Tag from a 
State Tag when scrolling through tags during playback.

Screen Annotation

During a record or playback session, the following is displayed in the top-left 
area of the screen:

—  AutoSession02: 92/95 (state 4/5)_*_ 
Sep.22.2018 09:15:15 AM    

where:

— AutoSession is an auto-generated name for sessions. 02 is the 
auto-generated number, incremented with each new session. The name 
can be changed using Manage Sessions. Learn more in “Manage Sessions” 
on page 283. 

— 92/95 is the current and total trace number: currently trace is 92 of 95 total 
traces.

— state 4/5 is the current and total state tag or user tag number: 4 of 5 total 
tags. 

— * (Asterisk) indicates that a state has changed. # (Pound) indicates that a 
User Tag has been inserted.

— Sep.22... is the date and time of recording.

When GPS is enabled`, the current location and elevation are annotated at the 
bottom of the playback display. Learn more in “GPS” on page 746.

How to Record a Session

— Press Trace 6

— Then Record Playback

— Then either:

If Recording or Playback is not occurring when you think it should, check 
the following:

— Is the sweep in HOLD? (upper-left annotation), or check the Sweep 
menu for Continuous set to OFF.

— Is Recording or Playback Paused? (mid-left annotation)

— Is the Record or Playback Interval set too long? (Configuration 
settings.)
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— New Session OR

— Recall Session then Open and select a session. 

— Then Recorder Player

— Then Record

REC is displayed in the left of screen graticules.

During recording, choose from the following: 

— Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue recording. 

— Stop Immediately stops recording. Then choose from the following:

— Press Play to start replaying the recording from the beginning.

— Press Record to continue recording.

— User Tag Press to insert a User Tag at the current recorded trace. This 
allows you to quickly move to this location during playback. Learn more in 
About State and User Tags in “About State and User Tags” on page 278.

How to Playback a Session

— Press Trace 6

— If the session is already open, skip the following step. Otherwise: 

— Then Record Playback Setup

— Press Recall Session Then select a session to playback and press 
Open.

— Then Recorder Player

— Then Play

PLAY is displayed in the left of screen graticules during playback. When the 
end of the recording is reached, playback begins again at trace 1 and 
continues to loop indefinitely. 

During playback, choose from the following: 

— Pause Resume   Temporarily halts playback. Then choose from the 
following:

— Pause Resume   Press to continue playing. 

If these are large recordings on a device, it could take several seconds for 
the FieldFox to display the list.
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— Playback State/Tag Allows you to continue playback from a state 
tag, or scroll through the state tags. Enter a value between 1 and the 

total number of state tags using the numeric keypad,  arrows, or 
the rotary knob. Active when playback is paused. Learn more in 
About State and User Tags in “About State and User Tags” on 
page 278.

— Playback Trace Activated automatically when Paused. Allows you to 
continue playback from a specific trace, or scroll through traces 
manually. Enter a value between 1 and the total number of traces 

using the numeric keypad,  arrows, or the rotary knob. 

— Stop Immediately stops playback. Then choose from the following:

— Play Start playback from trace 1.

— Record Resume recording from the last recorded trace.

— Record Playback Setup Return to the setup menu to change 
Configuration settings or Close the session.

Recording Configuration

To change Recording Configuration settings:

— Press Trace 6

— Then Record Playback

— Then New Session or Recall an existing session.

— Then Recording Configuration

Then choose from the following:

— Record Time Sets the amount of time to record traces. Default is MAX, 
which is to record indefinitely. Enter a value between 1s and 1 Ms (million) 

seconds using the numeric keypad,  arrows, or the rotary knob. When 
set, a timer appears during recording in the lower-left corner which counts 
DOWN from the specified time.

— Record Source Determines which trace is recorded. Sets where, in the 
FieldFox data flow, data is recorded. Learn more in “Record Source” on 
page 282. Choose from the following:

— First Active Trace (Default) This setting automatically selects the first 
active trace (1,2, 3 or 4) (i.e., any state other than View or Blank).

— Trace 1,2,3,4 Records data from the corresponding trace in its 
current state. 
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— Record Interval Sets the amount of time to wait between individual trace 
recordings. Default is MIN, which is to wait 0 seconds (record traces as fast 
as possible). Enter a value in seconds between 0 (no delay) and 10,000 

seconds - about 3 hrs) using the numeric keypad,  arrows, or the rotary 
knob. 

— Segment Count Sets the number of traces to record, after which the 
recording will automatically pause. Press Pause/Resume or Record to 
capture another N traces, or Stop to end recording. Default is OFF, which is 
NO limit to the number of traces to be recorded. 

When set, a counter appears in the lower-left corner which counts UP to 
the specified number of recordings. 

Record Source

Figure 10-9 FieldFox RTSA Mode: Data Flow and Record Playback Data Points

RTSA Data Recording:

— Data is recorded at the trace state processing block.

— Data can be recorded from Traces 1,2,3, or 4 which includes the trace state 
(Max Hold, Min Hold, and so forth).

For this discussion, it is important to understand Trace States. Learn more 
in “Trace Display States (SA Mode)” on page 198. 

Density Spectrum information is not recorded. Only the trace data is saved.
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— Data is ALWAYS played back into the same trace number that was 
recorded. If four traces were active during the recording, but only one trace 
was recorded, then during Playback only that one recorded trace is visible. 

Playback Configuration

By default, trace sweeps are played back as fast as the trace can be drawn on 
the screen. The following setting allows you to slow playback. In addition, you 
can manually scroll through individual traces using Playback Trace, or scroll 
through State and User Tags using Playback State/Tag. Learn more in How to 
Playback a Session in “How to Playback a Session” on page 280.

To slow playback of a session:

— Record a new session or Open an existing session.

— Press Playback Configuration

— Then Playback Interval

— Enter a value in seconds between 0 (no delay) and 100 using the numeric 

keypad,  arrows, or the rotary knob. After using the keypad, select a 
multiplier key. Learn about multiplier abbreviations.

— Press Enter

Manage Sessions

— Press Trace 6

— Then Record Playback

— Then Record Playback Setup The following selections are available ONLY 
when a session is NOT open. 

— Then Storage Device to select the media which stores the sessions to be 
managed. This is a different setting from the Save/Recall Storage Device 
setting. 

— Then choose from the following:

— Internal FieldFox memory (default)

— SD Card An external SD Card (must be inserted) 

— USB An external USB flash drive (must be inserted)

— Then Manage Sessions

— Then choose from the following:

If these are large recordings on a device, it could take several seconds for 
the FieldFox to display the list.
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— Rename Using the FieldFox labeler, change the name of the session. 
AutoSession (n) is the default name where (n) is the next-available number. 
Learn more in “How to use the FieldFox labeler ” on page 780.

— Sort Arrange the listing of sessions by Name, by Date, or by Size. 
Sort can also be used during a Recall Session, before choosing a 
session to open.

— Delete After a confirmation prompt, removes the contents of the 
selected session from the list.

— Copy Copies the selected session to a different storage device, or the 
same storage device with ‘Copy(n)_’ appended to the beginning of 
the name so that duplication is prevented.

— Copy All Copies ALL of the listed sessions to a different storage 
device, or the same storage device with ‘Copy(n)_’ appended to the 
beginning of the names so that duplication is prevented.

— Delete All Deletes ALL of the listed sessions.

Record Playback Example (RTSA Mode Only)

The following “Interval Recording” example shows how you can record spectral 
activity over a longer period of time with less trace storage.

— Press Trace 6

— Then Record Playback

— Then New Session

— Then Recording Configuration

— Then Record Source to Trace1

— Then Back

— Then Recorder Player

— Then Record let the recorder run for several seconds. 

— Then Stop to end the recording.

This session can be played back: For example:

— Press Trace 6 

— Then Record Playback

— Then Play
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IQA mode measures signals at the SA RF IN connector. 

IQA mode requires the FieldFox to have SA mode installed.

Figure 11-1 IQ Analyzer (IQA) Display - LTE–TDD signal captured using the FieldFox’s I/Q 
analyzer

IMPORTANT!

85571A-028 (28 GHz 5G Phased Array Antenna) accessories not suitable 
for use in wet locations.

The FieldFox can be used with an OML frequency extender. Refer to 
“Utilities” on page 732, the B Series FieldFox Configuration Guide 
5992-3701EN, and to “Contacting Keysight” on page 5.
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Figure 11-2 IQ Analyzer (IQA) Display - Window Shape Flat Top spur free 1 GHz center frequency 
(span=100 MHz) captured using the FieldFox’s I/Q analyzer (Requires Option 
B10)
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In this Chapter

“About I/Q Analyzer (IQA) Measurements” on page 289

“I/Q Analyzer (IQA) Mode Settings” on page 290

— “How to Make Measurements Using the I/Q Analyzer Mode” on 
page 290

— “How to Capture I/Q Data to a File” on page 291

— “How to modify the I/Q data measurement parameters” on page 294

“Using Markers (IQA)” on page 305

— “Noise Marker” on page 305

— “Band/Interval Power Marker” on page 306

— “Band Span Marker (Spectrum Only)” on page 307

— “Interval Span Marker (Waveform Only)” on page 307

— “Coupled Markers (Waveform Only)” on page 307

— “Continuous Peak Search Marker” on page 309

“Alignments” on page 310

“Trace Display States (IQA Mode)” on page 310

— “How to display the Trace States” on page 310

“Other Features Available” on page 312

— External Gain (SA chapter) – “External Gain” on page 158

— Display lines (SA chapter) –“Display Line” on page 210 

— Limit Lines (Data Analysis chapter) – “All about Limit Lines” on page 715



 288                                                                                                                     Keysight N9938-90006 User’s Guide

  IQ Analyzer (IQA) – Option 351

See Also

“Why and When to Calibrate” on page 126

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720

Chapter 29, “Data Analysis Features.”

Chapter 32, “File Management.”
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About I/Q Analyzer (IQA) Measurements
The I/Q Analyzer Mode makes general purpose frequency domain and time 
domain measurements. The mode enables two types of I/Q measurements: 

— frequency domain and 

— time domain measurements

In order to ensure consistent results between frequency domain and time 
domain, spectrum measurement and waveform measurement are based on the 
same I/Q acquisition. The following acquisition parameters are automatically 
calculated to satisfy these requirements:

1. RBW and IF BW specified in Spectrum measurement BW (BW 2) menu.

2. Start time and Stop time specified in Waveform measurement Sweep 
(Sweep 3) menu and IF BW specified in Waveform measurement BW  
(BW 2) menu.

3. I/Q signal capture related parameters specified in the Measurement Setup 
(Meas Setup 4) menu.

Some measurement parameters are auto-coupled and are not user-settable.

Noise level in time-domain measurements are higher for IF-BW >100 MHz 
due to raised noise levels at the edges of the 120 MHz bandwidth.
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I/Q Analyzer (IQA) Mode Settings

Select IQA Mode before making any settings in this chapter.

How to select IQA Mode

— Press Mode_.

— Then More (may not be available—number of installed options dependent)

— Then IQ Analyzer.

How to Make Measurements Using the I/Q Analyzer Mode

The Measure menu is used to set common parameters, predefined views 
selection, and measurement switching.

Spectrum has only one predefined view and Waveform measurement has two 
predefined views. There is a User Defined measurement, which can be used to 
display up to four different views (windows) simultaneously on the display 
screen. You can select which type of data to display in each of the views from 
the Trace menu.

See also, “How to Capture I/Q Data to a File” on page 291.

1. Press Preset then Mode Preset (Factory)

2. Press Measure 1 then choose from the following:

— Spectrum (Freq Domain) (Default) – Selects frequency spectrum as 
the current displayed measurement.

— Waveform then choose one of the following:

— RF Envelope Selects log RF envelope in time domain 

(default). 

— IQ Waveform Selects linear Real and imaginary I/Q 
waveform values.

— User Defined Selects a default user defined 4-quadrant display 
showing the following data:

When you initially select I/Q Analyzer, Real-Time SA, or some of the other 
spectrum settings (such as center frequency) a factory channel 
Equalization measurement is applied to the signal. During channel 
equalization measurement, the FieldFox displays a “Start Channel 
Equalization”. Stopping channel equalization is not permitted. See also, 
“Alignments” on page 201, in Chapter 9, “SA (Spectrum Analyzer) Mode 
(Option 233–Mixed Analyzers).”

Noise level in time-domain measurements are higher for IF-BW >100 MHz 
due to raised noise levels at the edges of the 120 MHz bandwidth.
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— Log magnitude of the spectrum of the I/Q data versus 
frequency

— Log magnitude of the I/Q data (RF Envelope) versus time

— The real component of the I/Q data versus time

— The imaginary component of the I/Q data versus time

The user defined measurement can be modified to change the 
number of displays from 4 to 3, 2, or 1.

— Capture Data File Opens a menu to enable saving I/Q data to a file. 
When you press the Start capture softkey the data is saved to a file 
and the default file IQDataFile.csv is stored in the internal 
memory. Refer to “How to Capture I/Q Data to a File” on page 291.

How to Capture I/Q Data to a File

There are two I/Q data file count capture modes, Single and Multiple. To 
capture your IQA data measurements:

— Press Measure 1 > Capture Data File then choose one of the following: 

—  File Settings Opens a menu to set the file choices:

——File Count File count can be set to Single or 1 (all data saved 
into a single file for the current displayed data) or Multiple. 
When using Multiple as the file count, the user can enter the 
number of files to save, and the FieldFox is auto-coupled to 
Continuous acquisition mode and to Multiple capture and all 
data is saved to either an external SD card or USB storage 
device. Each acquisition is saved, before the next data 
acquisition occurs. (default: 1, minimum: 1, maximum: 
1,000,000,000)

——Single capture example (default): IQDataFile.csv

——Multiple capture (default):  
Example is: IQDataFile_20171031 14.33.26.1050.csv).  
(format is: IQDataFile_yyyymmdd hh.mm.ss.ffff.csv). 

——Refer to the Start softkey on page 292 and to the 
“Example:” on page 293.

——File Type Selects the format of the output data file (CSV, TXT, 
SDF, or MAT). (Default: CSV)

——Device Selects the storage location for your data files (Internal, 
SD Card, or USB). Internal is not available, if the File Count is 
set to Multiple (default: Internal). 

I/Q data cannot be recalled or displayed in the FieldFox instrument. The 
data file is intended for use in a PC. 
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If you do not have an external device connected and attempt to 
save your data, a warning message is displayed: "Warning: 
Only an external storage device can be used in 
multiple file mode."

Then select:

——Internal (default) Selects the internal memory of the 
FieldFox as the storage location for all data files. Internal 
is only available when File Count is set to Single.

——SD Card Selects the external SD card slot as the storage 
location for all data files.

——USB Selects an external USB storage device as the 
storage location for all data files.

——Filename Opens a file manager Labeler menu that enables you 
to customize your data filenames. Refer to “File Management” 
on page 777 (default: IQDataFile).

——Back Returns to the previous softkey menu.

— Capture Settings then choose one of the following:

——Capture Time Sets the length of the I/Q trace capture time 
(default: 100 μs, range: 80 ns to dynamic (i.e., Maximum 
capture time is 1.07374s, which is associated with a sample 
rate of 125 MHz)). 

——Sample Rate Sets the I/Q data sample rate value (default: 
125 MHz, maximum: 125 MHz, couplings: 1.25 * IF 
Bandwidth).

——Sample Period Sets the 1/Sample Rate value (default: 8 ns, 
maximum: 80 ms, couplings: Sample Rate).

——Capture Samples Sets the capture length using a sample 
number (default: 12501, minimum: 1, maximum: 134217728, 
couplings: Capture Time).

——Back Returns to the previous softkey menu.

— Start Starts the I/Q data capture and stores the data into a default 
file and location (internal). Filenames and storage location can be 
customized. See also, the “Example:” on page 293 and to Chapter 
32, “File Management.” 

——Refer to the File Count softkey on page 291.
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— Stop immediately stops the I/Q data file capture and stops writing 
data to the current I/Q data file (no data is saved). If the I/Q data was 
being saved when the Stop softkey is pressed, the file is deleted. 
Refer to “Example:” on page 293.

Example:

Single:

——If the Capture Time is set to 100 µs, and you press the Start 
softkey, in Single mode the FieldFox saves 100 µs of the 
current I/Q data.

Multiple:-

——If the File Count is set to 200, and you press the Start softkey, 
the FieldFox saves your 200 I/Q data files and stops. The I/Q 
data files are saved into 200 files similar to:  
IQDataFile_yyyymmdd hh.mm.ss.ffff.csv. 

——If you press Stop, before the 200 I/Q data files have been 
saved, the FieldFox stops (interrupts) the multiple I/Q data file 
saving at the number of the current file. So, if you press Stop 
on file number 175, the saving process stops. If file number 175 
has not been saved, it is deleted. But, I/Q data files 1 through 
174 that have been saved prior to pressing Stop, are still saved 
for reference.

See also, Chapter 32, “File Management.”

Each time you press the Start softkey the I/Q data writes to the current 
filename (i.e., Single capture default is IQDataFile.csv or for Multiple 
format is IQDataFile_yyyymmdd hh.mm.ss.ffff.csv). To avoid overwriting 
your Single capture data or to add a unique filename for Single or Multiple 
capture data, use the Measure 1 > Capture Data Settings > File Settings > 
Filename softkey to modify your filename Refer to the File Count softkey 
on page 291.
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How to modify the I/Q data measurement parameters

The following sections assume you have already selected your I/Q data 
measurement type (i.e., Spectrum, Waveform (RF Envelope or I/Q Waveform), 
or User Defined).

This section contains the following:

Adjusting the Bandwidth Settings

— Press BW 2.

— Then choose from the following:

— Res BW (Spectrum only) – Sets the resolution bandwidth of the FFT 
analysis. Changing this value changes the FFT window size, analysis 
length, and the sweep time (data acquisition capture length). This 
softkey is only available when IQA is set to Spectrum (Freq Domain). 
When the resolution bandwidth value is set to Auto (default) the 
FieldFox automatically sets the optimum resolution bandwidth value.  
(Default: 100 Hz, Minimum: 10 Hz, maximum: 100 MHz).

— Analysis Length Sets the FFT analysis length that is the length of the 
complex I/Q data points (I/Q–pairs) vector that is used for spectrum 
analysis, expressed in the number of samples. (Couplings: In Auto, 
this setting is directly coupled to the Res BW and to Span. Minimum: 
8, Maximum: 524,288. Where each FFT length “point” is equal to 1 I 
and 1 Q point. So, 237 is equal to 237 I and 237 Q points).

“Adjusting the Bandwidth Settings” on page 294

“Changing between the Continuous and Single captures and 
adjusting the Trigger settings” on page 296

“Adjusting the Measurement Setup Settings” on page 299

“Adjusting the Trace Settings” on page 300

“Adjusting the Frequency Settings” on page 301

“Adjusting the Scale and Amplitude Settings” on page 301

“Preamplifier Control (Opt 235)” on page 304

There is a significant difference between resolution BW in FFT 
measurements and the resolution BW of a traditional “sweeping” 
spectrum analyzer (SA) measurement. The resolution BW in FFT 
measurements does not directly control the IF BW like a traditional SA 
swept measurement. Resolution bandwidth is directly related to the 
analysis length (window) and or data acquisition capture length (sweep 
time).
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— FFT Window Sets the FFT filtering window (spectrum analysis 
window) shape for the I/Q data. Default: Flat Top

Then select one of the following:

FFT Window Description

Uniform No windowing

Triangular Barlett windowing

Hanning This is a Hann window, sometimes called Hanning or “raised 
cosine”.

Hamming This window has lower side-lobe peaks than the Hann window, 
but has worse main-lobe flatness and poor side-lobe roll-off. 

Blackman This window is similar to the three-term Blackman-Harris 
window, but it has simpler fixed-form coefficients and better 
side-lobe roll-off.

Blackman Harris 3 This is the three-term Blackman-Harris window. This has the 
minimum side-lobe level for a three-term cosine window. 

Blackman Harris This is the four-term Blackman-Harris window. This has the 
minimum side-lobe level for a four-term cosine window with 
60 dB/decade roll-off.

Gaussian Top This is a five-term cosine window that resembles a Gaussian 
window. 

Flat 4 This is a four-term flat-top window.

Flat Top (default) This is the five-term flat-top window.

Flat 6 This is a six-term flat-top window.

Flat 7 This is a seven-term flat-top window.

P501 This is an alternative six-term flat-top window.

P601 This is an alternative seven-term flat-top window.

K-B (70 dB) This is a Kaiser-Bessel window whose maximum side-lobe 
level is -70 dB.

K-B (80 dB) This is a Kaiser-Bessel window whose maximum side-lobe 
level is -80 dB.

K-B (90 dB) This is a Kaiser-Bessel window whose maximum side-lobe 
level is -90 dB.

K-B (100 dB) This is a Kaiser-Bessel window whose maximum side-lobe 
level is -100 dB.

K-B (110 dB) This is a Kaiser-Bessel window whose maximum side-lobe 
level is -110 dB.
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— IF BW Sets the Digital IF bandwidth of the instrument. The 
relationship between the IF bandwidth and sample rate can be 
described by the following equation: 
 sample rate = 1.25 * IF BW.

 (Default: 10 MHz, minimum: 10 Hz, maximum: 120 MHz)

Changing between the Continuous and Single captures and adjusting 
the Trigger settings

— Press Sweep 3.

— Then choose from the following:

— Single When pressed, Single automatically sets Continuous to OFF 
and causes the application to make one acquisition.

— Continuous Toggles Continuous between ON and OFF. When 
Continuous is ON, each Run/Hold press causes the application to 
toggle between continuous acquisitions and Hold. When Continuous 
is OFF, each Run/Hold or Single press causes the application to 
make one acquisition.

— Restart When pressed, Restart causes the FieldFox to restart trace 
averaging at count of 1. When in Single sweep mode, the IQA will 
perform a complete set of averages before returning to the hold 
state.

K-B (120 dB) This is a Kaiser-Bessel window whose maximum side-lobe 
level is -120 dB.

Gaussian (60 dB) This is a Gaussian window whose maximum side-lobe level is 
-60 dB.

Gaussian (70 dB) This is a Gaussian window whose maximum side-lobe level is 
-70 dB.

Gaussian (80 dB) This is a Gaussian window whose maximum side-lobe level is 
-80 dB.

Sinc This window is the central lobe of the sin(x)/x (often called 
sinc(x)) function.

Tukey25 This is a tukey (cosine-tapered) window with alpha equal to 
0.25. 

FFT Window Description

When in full span, ADC dither raises the noise floor at the edges of the 
120 MHz.
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— Start Time (Waveform only) Sets the start time of the waveform 
measurement (default: 0s, minimum: 0s, maximum: dynamic). In 
Waveform mode Setting the Start and stop time enables you to 
display a subset of the data on the display in order to speed up the 
refresh rate when the acquisition time is long. Changing the Start 
Time changes which data point is displayed on the left side of the 
screen.

Couplings: When the change of Stop Time makes time domain 
display length exceed the limitation, the Start Time will change to 
satisfy time domain display length limitation:

——The maximum value is determined by current Sample Rate and 
the maximum capture samples.

——Start Time is adjusted to the nearest sample point based on 
the Sample Period.

——The maximum time domain display length is 524,288 points.

Time Domain Display Length [pts] = {[Sample 
Rate[pts/s] x (Stop Time[s] - Start Time[s])] + 
1}
Where:

pts = points

s = seconds 

— Stop Time (Waveform only) Sets the stop time for the waveform 
display (default: 100 μs, minimum: 0s, maximum: dynamic). In 
Waveform mode Setting the Start and stop time enables you to 
display a subset of the data on the display in order to speed up the 
refresh rate when the acquisition time is long. Changing the Stop 
Time changes which data point is displayed on the right side of the 
screen.

Couplings: When the change of Stop Time makes time domain 
display length exceed the limitation, the Start Time will change to 
satisfy time domain display length limitation:

——The maximum value is determined by current Sample Rate and 
the maximum capture samples.

——Stop Time is adjusted to the nearest sample point based on the 
Sample Period.

——The maximum time domain display length is 524,288 points.

Time Domain Display Length [pts] = {[Sample 
Rate[pts/s] x (Stop Time[s] - Start Time[s])] + 
1}
Where:
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pts = points

s = seconds 

— Trigger Settings Opens the Trigger Settings softkey menu.

Then:

——Trig Type Then select one of the following:

——Then depending on the trigger type selected, choose from the 
following:

Trig Level – Sets the trigger level. This softkey is only active for 
Video or RF Burst (default: –25 dBm, minimum: –210 dBm, 
maximum: 30 dBm).

Trig Slope – Sets the negative/positive trigger slope. This 
softkey is only active for External, Video, or RF Burst (default: 
Pos).

Trig Delay – Sets the trigger delay. This softkey is only active 
for External, Video, or RF Burst (default: 0s, minimum:  
–150 ms, maximum: 500 ms).

Softkey Description

Free Run (Default.) – Triggering is provided by the FieldFox internal 
circuitry. A new acquisition begins when the previous 
acquisition ends.

External An acquisition is triggered on an external TTL signal at the 
Ref In/Trig In connector on the FieldFox top panel. 
Choose to trigger on the rising slope at about 1.7 V or on 
the falling slope at about 1.0 V using the Trigger Slope 
setting (below).

Video An acquisition is initiated when the displayed amplitude 
of an incoming signal crosses the settable Trigger Level. 
This selection can detect low-amplitude signals, but also 
has been filtered considerably and may not be a true 
representation of the incoming signal. 

RF Burst An acquisition is initiated when the signal at the third IF 
(analog) stage crosses the settable Trigger Level. This 
selection offers a wider bandwidth and may be a better 
representation of the incoming signal than Video trigger. 
However, RF Burst is not as sensitive to triggering on 
low-level signals.

Periodic Periodic sets a trigger that repeats at the period rate 
entered. Periodic trigger's phase can be altered by the 
Offset value.
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Glitch Mask – Enables the glitch mask to reduce incorrect 
triggering due to fast changes/glitches in the signal level that 
can be mistaken to be the edge of the RF burst. This softkey is 
only active for RF Burst (default: 0 ms, minimum: 0s, 
maximum: 5 ms).

Auto Trigger – While waiting for a valid trigger signal, Wait is 
annotated in the top left corner of the FieldFox screen.

If a valid trigger signal is not received before the specified Auto 
Trig Time, a acquisition will occur automatically.

Enter 0 to set Auto Trigger OFF. When Auto Trigger is OFF, the 
FieldFox does NOT perform an acquisition unless a valid 
trigger signal is received.

(Default: 100 ms, minimum: 1 ms, maximum: 100s)

Adjusting the Measurement Setup Settings

— Press Meas Setup 4.

— Then choose from the following:

— Average Type Opens a menu of averaging softkeys.

Then select one of the following:

——Power (Linear) Averaging – Best for measuring true power 
levels. Used in Noise Marker Average. Mathematically, trace 
noise is 2.5 dB higher than when using Log Average. PAvg 
annotation is displayed.

——Log Averaging (default) – Best for displaying Trace Averaging. 
Also known as video averaging. LgAvg annotation is displayed.

——Voltage (Magnitude) Averaging – Converts the amplitudes to a 
magnitude unit before averaging (e.g., Volts, Amps, 
microVolts, milliVolts, etc.) VAvg annotation is displayed.

— Average Count The Average Count setting is used with the Average 
Trace State. In this Trace State, the Average Count setting 
determines the number of acquisitions to average. The higher the 
average count, the greater the amount of noise reduction (default: 
10, minimum: 1, maximum: 10000).

— Sample Rate Sets the I/Q data sample rate value (default: 125 MHz, 
maximum: 125 MHz, couplings: 1.25 * IF Bandwidth).

— Sample Period Sets the 1/Sample Rate value (default: 8 ns, 
minimum: 8 ns, maximum: 80 ms, couplings: 1/Sample Rate).



 300                                                                                                                     Keysight N9938-90006 User’s Guide

  IQ Analyzer (IQA) – Option 351
I/Q Analyzer (IQA) Mode Settings

Adjusting the Trace Settings

The Trace menu is used to modify the existing predefined view, or create a 
customized view. Window and Win State softkeys are used to modify layout of 
view, the Data softkey is used to specify the displayed data results for the 
current window. Please note only in User Defined measurement are all of the 
data results from Spectrum measurement and Waveform measurement 
available. Otherwise, only the data results from the current measurement 
(Spectrum or Waveform) are available. See also “Trace Display States (IQA 
Mode)” on page 310.

The Trace and Trace State keys are used to choose how many traces of the 
data result are displayed, and the trace data type (Clr/Wr, MaxHold, MinHold, 
Average, View, or Blank) that are displayed for each measurement.

— Press Trace 6.

— Then choose from the following:

— Window 1 2 3 4 Changes the selected window (default: 1). 

Then select one of the following:

— Win State ON OFF Enables or disables the current Window (1, 2, 3, 
or 4) selected by the Window 1 2 3 4 softkey (default: Window 1 is set 
to ON).

— Data Sets the data type displayed. 

Then select one of the following:

For Spectrum Measurement: 

For Waveform Measurement:

Mag Spectrum

Time Summary – Time Summary result includes 
the capture time, spectrum analysis time and 
waveform start/stop time. 

I vs. Time – Imaginary vs. Time

Q vs. Time – Quadrature vs. Time

Q vs. I – Quadrature vs. Imaginary

RF Envelope

Phase vs. Time

Unwrapped Phase vs. Time

Time Summary – Time Summary result includes 
the capture time, spectrum analysis time and 
waveform start/stop time. 
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— Trace 1 2 3 4 Pressing the Trace key enables you to select a different 
trace number. This softkey is active when Data is set to Spectrum or 
RF Envelope.

— Trace State Sets a different trace state to each of four traces. This 
softkey is active when the data is set to Spectrum or RF Envelope 
(Log). Pressing the Trace State softkey enables you to change the 
State of the selected Trace number of the Trace Data (default: Clr/Wr 
– assigned to trace 1. Traces 2, 3, and 4 are set to Blank).

Adjusting the Frequency Settings

— Press Freq/Dist.

— Then select from the following:

— Center Sets the center frequency of the measurement trace (default: 
1 GHz, minimum: 0 Hz, maximum: FieldFox model dependent).

— Freq Span (Spectrum Only) Sets the frequency span of the 
measurement trace. The analyzer's digital IF bandwidth is always 
equal to this value. 

Changing the span causes the IF bandwidth and the sample rate to 
change automatically:

Span = IF bandwidth, sample rate = 1.25 * IF bandwidth

Res BW = Span /50, if resolution bandwidth = Auto.

Default: 100 MHz, minimum: 10 Hz, maximum: 120 MHz

Adjusting the Scale and Amplitude Settings

Enables you to change attenuation settings. When RF Attenuation Auto is ON, 
the RF Attenuation is set by adjusting the acquisition. As the acquisition is 
lowered, for example from -10 dBm to -40 dBm, the FieldFox assumes that you 

Spectrum and RF Envelope have six markers that can be applied to any of 
the 4 traces. 
Waveform’s six markers can be applied to RF Envelope, Real, Imaginary, 
Phase, Unwrapped Phase, and Q vs. I. 

— RF Envelope has four traces. 

— Real, Imaginary, Phase, Unwrapped Phase, and Q vs. I have 1 trace 
each. 

When in full span, ADC dither raises the noise floor at the edges of the 
120 MHz.
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are looking at low-level signals. The RF Attenuation value is automatically 
lowered in 5 dB steps to allow low-level signals to be viewed. The RF 
Attenuation value is never automatically lowered below 5 dB.

How to set Scale/Amptd

— Press Scale/Amptd.

Manually set Log or Linear Scale Type (Spectrum and RF Envelope Only)

Then select from the following:

— More 

——Scale Type [current setting] (Spectrum and RF Envelope) 
—Only)

——Log Logarithmic scale (default setting). The Y-axis 
reference line represents the specified absolute 
acquisition in the current Unit selection. Y-axis 
graticules show dB below or above the reference line 
(default: 10 dB, minimum: 0.01 dB, maximum: 20 dB).

——Lin Linear scale. The Y-axis reference line represents the 
specified absolute acquisition in the current Unit 
selection. 

——Y-axis graticules show percent of acquisition (%) 
below or above the reference line (Spectrum).

——Y-axis graticules show voltage (V) – (RF 
Envelope).

Manually set Scale, Unit, Acquisition, and Reference Position.

— Autoscale Automatically adjusts the Y-axis to comfortably fit the Minimum 
and Maximum amplitude of the trace on the screen. Also, optimizes the 
FieldFox’s signal level at the mixer and adjusts the reference level to with 
the autoscale settings. 

— Scale/Div Manually adjust the scale per division to view specific areas of 

the current trace. Enter a value using the numeric keypad, the  arrows, 
or the rotary knob. Then press Enter.

— Ref Level Manually set the value of the reference line. Enter a negative 
value by pressing Run/Hold (+/-) either before or after typing a value. Use 
acquisition in combination with the RF attenuator and the Preamp so that 
the signal at the acquisition is at the optimum level for the FieldFox 
(Spectrum and RF Envelope Only). This can also change the RF Attenuation 
setting (default: 0). See “Attenuation Control” on page 303.
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— Ref Pos Manually set the position of the reference line. Values must be 
between 0 (TOP line) and 10 (BOTTOM line). Default position is zero (top) 
(default: 0, minimum: 0, maximum: 10).

— More, then 

— Unit Sets the display units.

Attenuation Control

Both the RF Attenuation and Preamp functions control the power level into 
the FieldFox mixer.

When too much power is present at the RF Input port, ADC Over Range 
appears on the FieldFox screen. This does not necessarily mean that damage 
has occurred, but that the receiver is probably compressed. 

When high power levels are present at the RF Input port, internal attenuation 
can be switched in to keep the FieldFox receiver from compressing. At 
extremely high power levels, use external attenuation to protect the internal 
circuitry from being damaged. 

The displayed power level is automatically adjusted for RF Attenuation. As the 
attenuation value changes, the displayed power level should NOT change.

How to set Attenuation

— Press Scale/Amptd.

— Then RF Atten Auto Man.

— Auto RF Attenuation is set by adjusting the input power level. As the 
acquisition is lowered, for example from –10 dBm to –40 dBm, the FieldFox 
assumes that you are looking at low-level signals. The RF Attenuation value 
is automatically lowered in 5 dB steps to allow low-level signals to be 
viewed.

— Man RF Attenuation is set manually. The default Attenuation setting is 
15 dB. Enter a value between 0 to 40 dB in 5 dB steps using the numeric 

keypad, the  arrows, or the rotary knob. Then press Enter

#Atten xx dB is shown at the top of the screen. (#) means manual setting.

(Default: 15 dB, minimum: 0 dB, maximum: 40 dB.)

The FieldFox can be damaged with too much power. Refer to the FieldFox 
Data Sheet for your model on 
https://www.keysight.com/us/en/assets/7018-06516/data-sheets/5992-
3702.pdf. 

RF Damage Level: +27 dBm

DC Damage Level: ±50 VDC 
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Preamplifier Control (Opt 235)

When very low-level signals are analyzed, an internal preamplifier can be used 
to boost the signal level by approximately 18 to 22 dB. The gain of the preamp 
is NOT adjustable. The displayed signal level is automatically adjusted for the 
increase in system gain. 

How to control the Preamp

By default, the preamp is OFF. 

— Press Scale/Amptd.

— Then More 

— Then Preamp Off The displayed setting is the current setting. When ON, PA 
is shown to the left of the graticules on the display (default: OFF). When 
OFF, nothing is displayed in the left graticules. 

When Auto is selected, the preamp setting is determined by the RF 
attenuation and to the input power level. When the input power level 
reaches a certain value, the preamp is turned on and PA is shown to the left 
of the graticules on the display.
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Using Markers (IQA)
The markers described here are for I/Q Analyzer mode (exceptions are noted). 
For additional marker features, refer to “All about Markers” on page 700.

This section contains the following:

Noise Marker

For comparison purposes, electronic noise measurements are often displayed 
as though the measurement was made in a 1 Hz Res BW. However, making an 
actual measurement at a 1 Hz Res BW is extremely slow.

A Noise Marker mathematically calculates the noise measurement as though it 
were made using a 1 Hz bandwidth. 

Several data points are averaged together to calculate the Noise Marker 
readout. To accurately measure noise, the Noise Marker should NOT be placed 
on, or too close to, a signal. The distance from a signal depends on several 
factors. To know if an accurate reading is being made, move the Noise Marker 
until consistent measurements are displayed in adjacent data points. 

With a Noise Marker present, the Res BW can be changed and the displayed 
noise floor will also change, but the Noise Marker readout will remain about 
the same.

IMPORTANT! When using I/Q markers, it is important to either be in Single 
acquisition mode or for Continuous acquisition mode, to set the 
measurement in advance on the FieldFox to Waveform or to Spectrum. 
Refer to “How to Make Measurements Using the I/Q Analyzer Mode” on 
page 290. 

The spectrum measurement’s six markers can only be applied to a single 
displayed set of traces (Magnitude Spectrum).

 
The waveform measurement’s six markers can be applied to any of the six 
displayed parameter traces (RF Envelope, I (Imaginary), Q (Real), Phase, 
Unwrapped Phase, or Polar).   
See also “Trace Display States (IQA Mode)” on page 310. 

“Noise Marker” on page 305

“Band/Interval Power Marker” on page 306

“Band Span Marker (Spectrum Only)” on page 307

“Interval Span Marker (Waveform Only)” on page 307

“Coupled Markers (Waveform Only)” on page 307

“Continuous Peak Search Marker” on page 309
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Noise Markers can be used like regular markers. A Noise Marker is 
distinguished from a regular marker by (1Hz) after the marker readout value. 
Learn more about regular markers in “All about Markers” on page 700.

How to measure Noise with a marker 

— Press Marker to create or select a Normal or Delta marker to use to 
measure Noise. 

— Then More.

— Then Marker Function 

— Then Noise.

Band/Interval Power Marker

A Band/Interval Power marker—available in IQA and SA Modes—integrates the 
power that is measured over several adjacent data points. The range of points 
being measured is displayed with vertical posts around the marker. This Band 
Span value is selectable. 

This feature is very similar to a channel power measurement (see SA chapter, 
“Channel Power (CHP)” on page 216). 

When the IQA is set to a waveform measurement, the marker is referred to as 
an Interval Marker because it averages power over a specific time interval. In 
this case the range is specified as the Interval Span.

How to measure Band/Interval Power with a marker 

— Press Marker to create or select a Normal or Delta marker to use to 
measure Band/Interval power. 

— Then press More

— Then Marker Function

— Then Band/Int Power

— Then Band Span (Spectrum) or Interval/Span (Waveform)

— Then choose from the following:

—Auto Measures power over 5% of the displayed span, or ½ graticule. 
The Band Span is automatically updated to remain at 5% when you 
change the frequency span.

—Man Enter a frequency or time value using the  arrows or the 
rotary knob, then press Enter. Or enter a value using the numeric 
keypad and select a frequency or time suffix. The Band Span remains 
at the frequency or time value that you set as the span changes.
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Band Span Marker (Spectrum Only)

Sets the width of the span (Hz) for the selected marker. 

How to measure with the Band Span marker 

— Press Marker to create or select a Normal or Delta marker to use to 
measure Band/Interval Power. 

— Then press More

— Then Marker Function

— Band Span Enables or disables the Band Span marker (default: 500 kHz, 
minimum: 1 Hz, maximum: 10 MHz). 

Interval Span Marker (Waveform Only)

Sets the width of the interval span (seconds) for the selected marker.

How to measure with the Interval Span marker 

— Press Marker to create or select a Normal or Delta marker to use to 
measure Band/Interval power. 

— Then press More

— Then Marker Function

— Band/Int Power Enables or disables the Band Interval Power marker 
(default: 5% of the (start time – stop time), minimum: 1 ns, maximum: 10s. 

Coupled Markers (Waveform Only)

When a Coupled marker is enabled in a window on the FieldFox, the current 
active marker in that window is enabled as the ’reference’ coupled marker on 
the current trace and the x-axis value of any other active waveform markers on 
any other traces in other windows are updated to track that of the ’reference’ 
coupled marker. Refer to Figure 11-3 on page 308. 

How to measure with the Coupled marker

— Press Marker to create or select a Normal, Delta, or Peak marker to use the 
Coupled Marker.

— Then More

— Then Coupled Markers Enables or disables the coupled marker (default: 
OFF). 

Procedure to set coupled markers (Refer to Figure 11-3 on page 308):

1. Press Preset > Mode Preset (Factory)

2. Press Measure 1 > User Defined
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Four windows are displayed (Spectrum, Waveform, Real, and Imaginary)

3. Using the  arrows or the rotary knob, move so Window 2 Waveform is 
selected (green border).

4. Press Marker > Marker 1 > Normal

5. Press Esc

6. Repeat steps 3 through 5 while selecting the other measurement windows 
and markers:

— Real using marker 2 and 

— Imaginary using marker 3 

7. Press Marker > More > Coupled Markers ON

8. Press Marker and use the  arrows or the rotary knob to move the 
coupled markers along the traces in Window 2 (Waveform), Window 3 
(Real), and Window 4 (Imaginary).

Figure 11-3 IQ Analyzer (IQA) Display - Coupled markers with Waveform (marker 1), Real 
(marker 2), and Imaginary (marker 3) displays
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Continuous Peak Search Marker 

When the Continuous Peak Search marker is on, a peak search is automatically 
performed for the selected marker after each acquisition. For additional marker 
functionality, refer to “All about Markers” on page 700.

Summary: 

— Cont Peak Search Enables or disables the continuous peak search 

— The rules for finding the peak are exactly the same as for Peak Search, 
including the use of peak criteria rules.

How to measure with the Continuous Peak Search marker 

— Press Mkr->/Tools to create or select a Normal or Delta marker to use the 
Continuous Peak Search marker. 

— Then press More (RF Spectrum Only)

— Then press Mkr Properties

— Then Peak Criteria

— Then Cont Peak Search Enables or disables the Continuous peak search 
marker (default: OFF). 
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Alignments 
The IQA mode requires all three alignment types: amplitude, RF burst, and 
channel equalization. Refer to the SA chapter’s “Alignments” on page 201 for 
information on all alignments.

Trace Display States (IQA Mode)

— In IQA Mode you can display up to four of the following types of trace 
states. All IQA settings are applied to all displayed traces. See also “Marker 
Trace (IQA and SA Mode)” on page 704.

A color-coded legend for displayed traces is visible in the left pane of the SA 
mode screen:

W = Clear/Write; M = MaxHold; m = MinHold; A = Average; V = View

How to display the Trace States

— Press Trace 6. 

— Then Trace 1,2,3,4 repeatedly to select a trace number to display or change 
its state. Traces are displayed in the following colors:

— Trace 1 – Yellow   Trace 2 – Blue

— Trace 3 – Orange  Trace 4 – Green

— Then State [current setting] 

— Then choose from the following Trace States:

—Clr /Wr (Clear/Write) Displays the actual measured data for each 
acquisition.

—MaxHold Displays the maximum response of the input signal at each 
data point over multiple acquisitions. See also Average Count in 
“Adjusting the Measurement Setup Settings” on page 299.

If you have Option 351 I/Q Analyzer option, you can directly save your data 
as MATLAB files (*.mat). Refer to Chapter 11, “  IQ Analyzer (IQA) – Option 
351”, on page  285 and to Chapter 32, “File Management”, on page  777.

If you have the FieldFox’s Remote Server mode (89600 VSA software 
connectivity), you can use the VSA software to capture and record your 
data as MATLAB files (*.mat). Learn more about FieldFox and 89600 VSA 
software, refer to Chapter 17, “Remote Server Mode (Requires SA 
Hardware/SA Option 233)” and to 
http://rfmw.em.keysight.com/wireless/helpfiles/89600B/WebHelp/89600
.htm.
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—MinHold Displays the minimum response of the input signal at each 
data point over multiple acquisitions. See also Average Count in 
“Adjusting the Measurement Setup Settings” on page 299.

—Average Each data point is averaged over multiple acquisitions as set 
by the Average Count setting. Learn more in “Adjusting the 
Measurement Setup Settings” on page 299.

—View Displays and then holds the last complete measurement trace on 
the screen. This is similar to storing a trace in memory. 

—Blank Displays no trace.
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Other Features Available
— External Gain - Refer to refer to the SA chapter’s section, “External Gain” 

on page 158.

— Limit Lines - For information on using Limit Lines, refer to “All about Limit 
Lines” on page 715.

— Display Lines - For information on using Limit Lines, refer to the SA 
chapter’s section, “Display Line” on page 210.
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12 Electromagnetic Interference (EMI) Measurements – 
Option 361

Requirements

— EMI mode measures signals at the SA RF Input Port 2 connector. 

— EMI mode requires the FieldFox to have SA mode (Option 233 on 
combination analyzers) installed.

Recommended, but not required:

— EMI chamber. 

— Preamplifier (Option 235) to improve receiver sensitivity.

— Filters

— Line impedance stabilization network (LISN) – conducted emissions testing

— Transient limiter – conducted emissions testing

— Calibrated antenna – radiated emissions testing

— Signal generator (e.g., EXG, MXG)

— Set of antennas 

— Set of near field probes (e.g., Keysight N9311X Series of antennas and field 
probes.)

EMI Option 361 measures radiated and conducted emissions. With EMI you 
can measure the unintentional generation, propagation, and reception of 
electromagnetic energy that might cause your device to violate 
pre-compliance/compliance testing. This includes the emissions and immunity 
(susceptibility) levels of electromagnetic energy.
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In this Chapter

The following outline of this chapter is separated into two main sections:

— “EMI Measurements” and 

— “Chapter Overview of EMI Measurements”

EMI Measurements

“Using EMI Measurements (Option 361)” on page 317

“EMI Measurements Mode Settings” on page 318

— “How to select EMI Measurements Mode” on page 318

— “Scale and Units” on page 320

— “CISPR (International Special Committee on Radio Interference) 
Control” on page 321

— “Resolution Bandwidth (Res BW)” on page 326

— “Single / Continuous / Restart” on page 327

— “Points” on page 328

— “Trace Display States (EMI Mode)” on page 328

— “Detection Method” on page 330

— “Input – (Trace Input for APD Measurements)” on page 331

“About Electromagnetic Interference (EMI) Measurements” on page 333

— “EMI Measurement Features (Option 361)” on page 333

“How to Set Up Electromagnetic Interference (EMI) Mode Settings” on 
page 335

— “EMI Measurement Mode Setup Procedure” on page 335

“Glossary (EMI)” on page 336
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Chapter Overview of EMI Measurements

“Using EMI Measurements (Option 361)” on page 315 – see “EMI 
Measurements” on page 314

“EMI Measurements Mode Settings” on page 316 – see “EMI 
Measurements” on page 314

— “How to Select EMI Measurements Mode” on page 318 – see “EMI 
Measurements” on page 314

— “Frequency Range” on page 318

— “Scale and Units” on page 318 – see “EMI Measurements” on page 314

— “External Gain” on page 320

— “Attenuation Control” on page 321

— “CISPR (International Special Committee on Radio Interference) 
Control” on page 318 – see “EMI Measurements” on page 314

— “Preamplifier Control (Opt 235)” on page 326

— “Resolution Bandwidth (Res BW)” on page 323 – see “EMI 
Measurements”

— “Single / Continuous / Restart” on page 324 – see “EMI Measurements” 
on page 314 

— “Points” on page 325 – see “EMI Measurements” on page 314

— “Trace Display States (EMI Mode)” on page 325 – see “EMI 
Measurements” on page 314

— “Trace Averaging” on page 330

— “Alignments” on page 330

— “Detection Method” on page 328 – see “EMI Measurements” on 
page 314

— “Input” on page 330 – see “EMI Measurements” on page 314

“About Electromagnetic Interference (EMI) Measurements” on page 332 – 
see “EMI Measurements” on page 314

— “EMI Measurement Features (Option 361)” on page 333 – see “EMI 
Measurements” on page 314

“How to Set Up Electromagnetic Interference (EMI) Mode Settings” on 
page 335 – see “EMI Measurements” on page 314
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See Also

— “EMI Measurement Mode Setup Procedure” on page 335 – see “EMI 
Measurements” on page 314

“Glossary (EMI)” on page 337 – see “EMI Measurements” on page 314

Other Features Available – Refer to Chapter 9, “SA (Spectrum Analyzer) 
Mode (Option 233–Mixed Analyzers)” and Chapter 29, “Data Analysis 
Features”:

— Alignments (SA) – “Alignments” on page 201

— Attenuation Control (SA) – “Attenuation Control” on page 159

— External Gain (SA) – “External Gain” on page 158

— Field Strength Corrections (SA) – “How to select and edit corrections 
for Field Strength measurements” on page 161

— Preamp Control (SA) – “Preamplifier Control (Opt 235)” on page 160

— Source Tracking Offset and Offset Reversal (SA) – “Source Tracking 
Offset and Offset Reversal” on page 166.

— Independent Source/Tracking Generator (SA) – “Independent 
Source/Tracking Generator ” on page 181

— Scale Settings (SA and Data Analysis) – “Scale and Units” on page 157 
and “All about Scale Settings” on page 722

Optional Settings:

“All about Markers” on page 700

“All about Limit Lines” on page 715

“Saving and Recalling Files” on page 778

“Why and When to Calibrate” on page 126

Chapter 30, “System Settings.” (Changing display colors)

Chapter 32, “File Management.”
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Using EMI Measurements (Option 361)
EMI enables you to do the following:

Measure and display emission signals to verify your device/instrument’s pre-compliance 
performance

Electromagnetic Interference Features (EMI) – (Option 361) 

— Amplitude Probability Distribution (APD) 
Statistics, both CCDF and Histogram

— Selectable CISPR bands (A, B, C, D, 
E) 

— Fast SA Scan for quick setup check 

— Frequency range coupled to CISPR bands

— Logarithmic frequency axis 

— 200 Hz, 9 kHz, 120 kHz 6 dB resolution 
bandwidths, and 1 MHz impulse 
bandwidth, auto–coupled to CISPR bands

— EMI Detector settings, selectable per 
trace

— Quasi-Peak

— EMI Average

— Positive Peak

— Simple Color coded Trace/Detector 
pair controls
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EMI Measurements Mode Settings
This section contains content unique to EMI measurements mode and some 
features that are similar to SA mode settings. Unique Option 361 EMI 
measurements content can be found in this chapter. But, when EMI/SA mode’s 
shared feature content is referenced, you are referred to Chapter 9, “SA 
(Spectrum Analyzer) Mode (Option 233–Mixed Analyzers).”

How to select EMI Measurements Mode

— Press Mode_ > EMI Measurements

Learn more see, “CISPR (International Special Committee on Radio 
Interference) Control” on page 321.

Frequency Range

The X-axis frequency range determines the frequencies that are measured for 
each sweep. The default Start and stop frequencies are dependent on the 
CISPR band selected. 

The frequency range of the measurement can be changed using the following 
methods:

— Set Center and Span frequencies (Frequency Span varies with instrument 
model)

— Set Start and Stop frequencies

— Using Marker > Center

When you initially select EMI, I/Q Analyzer, Real-time SA, or some of the 
other spectrum settings (such as center frequency) a factory channel 
Equalization measurement is applied to the signal. During a channel 
equalization measurement, the FieldFox displays a “Start Channel 
Equalization”. Stopping channel equalization is not permitted. See also, 
“Alignments” on page 201, in Chapter 9, “SA (Spectrum Analyzer) Mode 
(Option 233–Mixed Analyzers).”

Although the start frequency can be set as low as -100 MHz, amplitude 
accuracy is specified above 9 kHz (depending on your model).  Below 
9 kHz (depending on model), frequency accuracy is maintained, but 
amplitude accuracy is degraded. Refer to 
https://www.keysight.com/us/en/assets/7018-06516/data-sheets/5992-
3702.pdf. 
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How to set Frequency Range and Frequency Context

For EMI mode, you are able to change the center, frequency span, start, and 
stop frequencies or select a specific CISPR band. See also, “CISPR 
(International Special Committee on Radio Interference) Control” on 
page 321.

— Press Freq/Dist. 

— Then choose from the following:

— Center and Freq Span frequencies. This is the most common method 
of entering frequency range. Enter the frequency of interest. The 
Center frequency is at the exact center of the X-axis. The Frequency 
Span places half of the frequency range on either side of center. 
When the Center and Frequency Span values are entered, then the 
X-axis annotation on the screen shows the Center and Span 
frequencies. 

— Start and Stop frequencies. Start is the beginning of the X-axis and 
Stop is the end of the X-axis. When the Start and Stop frequencies 
are entered, then the X-axis annotation on the screen shows the Start 
and Stop frequencies. Start and Stop are not active choices for 
CISPR Zero Scan (i.e., for CISPR Band Scan and CISPR Zero Scan 
ZSpan in the lower right of the display indicates you are at the span 
limit).

— Zero/Last Span For EMI mode, which defaults to log sweep, this 
softkey toggles between log (FFT) – previous screen and start/stop 
frequencies and linear (Time) – in zero Span. 

— Optionally, press More then:

——Freq Annotation and one of the following:

In the CISPR Band Scan measurement, the default span is the full range of 
the particular CISPR band selected. The Span can be changed, to examine 
part of the CISPR band in more detail, but the Span can never exceed the 
full width of the CISPR band, and never be less than the minimum span 
which CISPR Zoom Scan achieves. The Full Span button causes a CISPR 
Band Scan to return to the default full range of the particular CISPR band. 
Learn more, see “CISPR (International Special Committee on Radio 
Interference) Control” on page 321. 

AutoSelect (Default) – The FieldFox selects a frequency annotation 
setting (Center Span or Start Stop).

CenterSpan -The center frequency and span are displayed.

StartStop - The start and stop frequencies of the frequency span are 
displayed.
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——Log Freq AxisX enables/disables the log frequency X-axis. 
Disabling the log frequency X-axis, enables the linear 
frequency X-axis (Default = ON).

——CF Step then type a step size value using the numeric keypad, 
then select a frequency unit terminator key (Default = Auto).

——Full Span the frequency span changes the instrument’s full 
frequency span (frequency span is model & Option dependent).

This softkey is inactive (grayed out), for CISPR Zoom Scan and 
APD Statistics, because RF tuning is fixed and Span changes 
are not allowed.

For CISPR Band Scan the Full Span varies based on the 6 dB 
resolution BW setting:

— Follow each of these, when prompted, by entering a value using the 

numeric keypad, the  arrows, or the rotary knob.

— When using the  arrows, press Enter. The increment setting of the 
arrows is based on the current span.

— After using the keypad, select a multiplier key. Learn more in Chapter 2, 
“Preparing for Initial Use of Your New FieldFox” and “Multiplier 
Abbreviations” on page 46.

Scale and Units

Learn more, refer to “Scale and Units” on page 157. 

External Gain

Learn more, refer to “External Gain” on page 158.

If the 6dB Resolution BW is auto-coupled, Full Span changes the span 
to match the Full CISPR Band you have selected. Learn more see, “How 
to Set the EMI Measurement Settings (Fast SA Scan, CISPR 
Band Scan, CISPR Zoom Scan, and APD Statistics)” on 
page 321.

If the 6 dB resolution BW is set to manual, Full Span changes the span 
to the maximum span limits described in the table in “Resolution 
Bandwidth (Res BW)” on page 326.

EMI Measurements mode defaults to Scale Type: Log.
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Attenuation Control

Learn more, refer to “Attenuation Control” on page 159.

CISPR (International Special Committee on Radio Interference) Control

This section describes the FieldFox EMI measurement mode’s instrument 
controls for evaluating pre-compliance EMI of the equipment under test.

After EMI mode is selected or after a Mode Preset, the Measure menu is 
displayed. Two primary controls are available:

CISPR band and Measurement – there are 5 CISPR bands (A/ B/ C/ D/ E) 
which, when selected, automatically set the instrument to a CISPR defined 
frequency range and CISPR defined measurement bandwidth. Learn more, see 
“Resolution Bandwidth (Res BW)” on page 326.

For this section, refer to Figure 12-1 on page 323, Figure 12-2 on page 324, 
Figure 12-4 on page 325, and Figure 12-5 on page 325.

This section contains:

— “How to Set the EMI Measurement Settings (Fast SA Scan, CISPR Band 
Scan, CISPR Zoom Scan, and APD Statistics)” on page 321

— “How to set a CISPR Band” on page 323

Learn more, see “How to set the EMI Traces” on page 328.

How to Set the EMI Measurement Settings (Fast SA Scan, CISPR Band 
Scan, CISPR Zoom Scan, and APD Statistics)

Screen defaults to Log sweep, but you can toggle using Freq/Dist > Zero/Last 
Span. Learn more, see “Frequency Range” on page 318 and “How to set the 

EMI Traces” on page 328.

Point quantities are not manually controllable within CISPR Band Scans or 
CISPR Zoom Scans. Rather, they are automatically derived from the 
bandwidths and Spans being used. CISPR Band E requires the most points 
to achieve the full band scan, but in all cases, total point quantity will not 
be allowed to exceed 75001. For manually coupled EMI Resolution BW, 
this hard limit on point quantity results in Span limitations (e.g., If the 9 
kHz BW is used in CISPR band E, the hard point limit will cause the Span to 
be limited far short of the expected 17 GHz full range of CISPR band E).
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— Press Measure 1 > Measurement [Fast SA Scan] then choose:

— Fast SA Scan – (Default) Sets the Fast SA Scan. Fast SA Scan applies 
peak detection and is used to do a quick verification of your EMI 
measurement setup check similar to a normal SA speed sweep. Pk 
annotation is displayed when enabled.

— CISPR Band Scan – Sets the primary EMI measurement which: 
sweeps over the specified CISPR band frequency range, uses CISPR 
defined specific EMI 6 dB Resolution bandwidths ((200 Hz, 9 kHz, 
and 120 kHz), and 1 MHz impulse bandwidth), with 3 specific 
detectors (Positive Peak, EMI Average, or Quasi Peak) which can be 
independently set per Trace. Individual trace annotation is displayed 
for the three traces (P, Q, and A). See also, “How to set the EMI 
Traces” on page 328.

— CISPR Zoom Scan – When set, behaves the same as CISPR Band 
Scan, except it represents the minimum Span setting, for any EMI 
resolution bandwidth selected, where the RF tuning can remain 
stationary (i.e., like Zero Span). While in CISPR Zoom Scan, you 
cannot change the Span, because it is meant to provide the fastest 
updates of the CISPR bandwidths and Detectors while targeting a 
specific RF frequency within the current CISPR band (i.e., 
A/B/C/D/E). Individual trace annotation is displayed for the three 
traces (P, Q, and A) and ZSpan is displayed in the lower right side of 
the display. See also, “How to set the EMI Traces” on page 328. 

— APD Statistics – Sets a measurement that evaluates pulses 
statistically. APD statistics is essentially a Zero Span measurement of 
the Center Frequency. APD statistics uses a specific APD 6 dB 
resolution bandwidth (APD Res BW) to measure the power level 
detected while creating a histogram of those power levels over the 
APD Dwell Time. Next APD Statistics uses that histogram data to 
create a set of values to define that probability that the signal power 
is above a certain level (CCDF == complementary cumulative density 
function). The graphical axis changes radically, to reveal that 

When selected, CISPR Band and Zoom Scan measurements use one of the 
5 CISPR band frequency ranges to set the frequency range (Start and 
Stop) on the FieldFox. CISPR Zoom Scan selects a limited fix span (<entire 
band range). Learn more, see “Resolution Bandwidth (Res BW)” on 
page 326 and “How to set Frequency Range and Frequency Context” on 
page 319.

Hint!

With any of the EMI measurement settings described in this section, you 
can toggle Zero Span and back (i.e., back to your previous measurement) 
using the “Zero / Last Span” softkey. Learn more, see “How to set 
Frequency Range and Frequency Context” on page 319.
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probability (i.e., a fraction from 0 to 1.0) on the Y axis, vs. Power on 
the X axis. Markers adapt correspondingly. Histogram and CCDF 
become the Input choices per trace, replacing Detector on the Trace 
menu. APD annotation is displayed on the left side when enabled. 
See also, “Input – (Trace Input for APD Measurements)” on page 331 
and “How to set the EMI Traces” on page 328.

How to set a CISPR Band

By default, the preamp is OFF. 

— Press Measure 1 > CISPR Band then choose:

— A – 9 kHz to 150 kHz

— B – 150 kHz to 30 MHz

— C – 30 MHz to 300 MHz (Default)

— D – 300 MHz to 1 GHz

— E – 1 GHz to 18 GHz

Learn more, see “Resolution Bandwidth (Res BW)” on page 326.

Figure 12-1 CISPR Band C Example
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Figure 12-2 CISPR Band C Zoom Example 1 – Response to Pulse

Figure 12-3 CISPR Band C Example 2 – Response to CW Signal
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Figure 12-4 APD Statistics Example 1 – Pulse 5µS/1mS

Figure 12-5 APD Statistics Example 2 – CW
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Preamplifier Control (Opt 235)

Learn more, see Chapter 9 refer to “Preamplifier Control (Opt 235)” on 
page 160.

Resolution Bandwidth (Res BW)

EMI mode has a different resolution bandwidth type for each type of EMI 
measurement: 

— CISPR Band Scan, CISPR Zoom Scan, and APD Statistics have of set 
values of 6 dB resolution bandwidths ((i.e., 200 Hz, 9 kHz, 120 kHz), and 
1 MHz impulse bandwidth). “6 dB” is displayed in the Res BW value on the 
bottom left side of the display (e.g., Res BW (6 dB) 120 kHz).

The EMI Resolution bandwidth is auto-coupled to keep frequency range 
with the selected CISPR band. If the Start or Stop frequencies are 
changed, the FieldFox displays a reminder message about the CISPR band 
limits.

Example of CISPR messages: “CISPR band StartFreq limited to 
30000000" and “CISPR band StopFreq limited to 300000000".

CISPR Banda EMI 6 dB Resolution 
Bandwidthd

CISPR Band Scan 
Maximum Span 
Valueb,a,c

CISPR Zoom Scan 
Minimum  Span 
Valued,e

A – (9 kHz to 150 kHz) 200 Hz 3.735 MHz 19.6 kHz

B – (150 kHz to 30 MHz) 9 kHz 168.1 MHz 882 kHz

C – (30 MHz to 300 MHz) 120 kHz 2.243 GHz 11.76 MHz

D – (300 MHz to 1 GHz) 120 kHz 2.243 GHz 11.76 MHz

E – (1 GHz to 18 GHz) 1 MHz (impulse BW) 17.6 GHz 7.895 MHz

a. The maximum spans displayed in the CISPR Band table, are only achievable when one manually couples the reso-
lution bandwidth (Res BW). Typically, the entire CISPR Band span (displayed in the first column) is used with 
auto-coupled resolution bandwidth (Res BW). The CISPR Band Scan Maximum Span Values (displayed in 
the third column) are actually the 75001 point limit applied to each resolution bandwidth (Res BW) when manual 
coupling (Manual) is used. When manual coupling (Manual) is used, you can go outside the selected CISPR 
Band. 

b. The maximum number of points for a CISPR Band Scan is 75001 points.
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— But, when using Fast SA Scan, you have a standard 3 dB resolution 
bandwidth over the entire range of 1 Hz to 5 MHz.

Learn more, see Chapter 9 and then “Resolution Bandwidth (Res BW)” on 
page 182.

Single / Continuous / Restart

This setting determines whether the FieldFox measures continuously or only 
once each time the Single or Run / Hold +/- button is pressed. Use Hold / 
Single or to conserve battery power or to allow you to save or analyze a 
specific trace. 

How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

— Continuous 

——ON Causes the EMI to make continuous sweeps. This is the 
typical setting for making measurements. Each Run / Hold +/- 
press causes the SA to toggle between continuous sweep and 
Hold. 

——OFF Causes the EMI to Hold. Each Run / Hold +/- or Single 
press causes the SA to make ONE sweep, then Hold. The Hold 
annotation changes to an arrow --> while the sweep occurs.

— Single Automatically sets Continuous OFF and causes the SA to 
make ONE sweep, then Hold.

— Restart Resets the Average counter to 1. The Average counter also is 
used with MaxHold and MinHold Trace States. Learn more in “” on 
page 330.

c. The 75001 point limit is put in place, to keep the mode from trying to build traces that are any bigger than neces-
sary. Basically, enough to cover CISPR Band E (1 GHz to 18 GHz) with its 1 MHz bandwidth, plus a little extra mar-
gin. This same point limit (75001) is applied to the other resolution bandwidths (Res BW), and also to the other 
CISPR Band Scan Maximum Span Values (displayed in the third column). There is no direct control permit-
ted over the number of points used in the EMI scans. But, indirectly the SPAN and resolution bandwidth (Res BW) 
values, determine the number of points.  
Exception: When using Fast SA Scan measurement (displayed in the fourth column), then you can control the 
number of points, similar to SA mode, where the point limit then becomes 20001.

d. The Zoom scan span limits are associated with the EMI 6 dB Resolution Bandwidth(s) (Res BW (6 dB)) that 
are (displayed in the second column). The auto-coupled bandwidth choices match those CISPR Bands (displayed 
in the first column), but you can also choose to manual couple (Manual) the bandwidth. When the bandwidth is 
set to manual couple (Manual), the Zoom scan span limit follows the resolution bandwidth (Res BW), not the 
CISPR band.

e. The Zoom scan span limits are actually the width of the FFT that is being used for the EMI 6 dB Resolution 
Bandwidth (minimum == 1 FFT, so the span is limited to 1 FFT width). 
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— Dwell /Point (Active when the CISPR Measurement type == CISPR 
Band Scan or CISPR Zoom Scan.) Specifies a settling time (in 
seconds) between sweeps.

— SwpAcquisition – (Active only for Fast SA Scan) Specifies a the 
number of sweep acquisitions. Press manual to enter a sweep 
acquisition value. (Default = Auto). Learn more, see Chapter 9 and 
then “Sweep Acquisition” on page 188.

— APD Dwell Time – (Active only when the CISPR Measurement type = 
APD Statistics.) Sets the time to acquire statistics each cycle, and 
Trace Points (control grayed out) are derived from the total Amplitude 
range displayed on the X axis.

Points

In the EMI measurements mode, the Points softkey is only active when the 
Measurement CISPR softkey is set to Fast SA Scan. Otherwise EMI mode 
automatically sets the points (Default = 401). Learn more, see Chapter 9 and 
then “Points ” on page 198.

Trace Display States (EMI Mode)

The behavior of EMI mode is similar to SA mode. This section describes the 
softkeys that have similar, but also different behaviors than SA mode. Learn 
more, refer to Chapter 9, “SA (Spectrum Analyzer) Mode (Option 233–Mixed 
Analyzers).”. See also “Marker Trace (IQA and SA Mode)” on page 704. 

How to display the Trace States

— Press Trace 6 > Default All is measurement specific and returns all traces to 
their default settings. For EMI mode the defaults are: Trace 1 (PosPeak T1), 
Trace 2 (QuasiPeak T2), Trace 3 (EMI Average T3); Trace 4 (Off, but defaults 
to Pos Peak).

How to set the EMI Traces

When the EMI measurement type is set to CISPR Band Scan or CISPR Zoom 
Scan Trace 1, Trace 2, Trace 3 have default values assigned. The trace can be 
disabled under the Measure 1 (toggle to enable/disable) or the Trace 6 

For EMI measurements mode, this section defines the four trace state 
choices for the Fast SA Scan and for CISPR Band Scan, CISPR Zoom Scan, 
and APD Statistics choices. Also, this section defines the 4th trace display 
state choices. Learn more, see “How to set the EMI Traces” on page 328.
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hardkeys or re-assigned to measure a different value on the trace by using the 
Trace 6 hardkey (e.g., you can re-assign trace 1 to measure Quasi-peak or EMI 
averaging). These detector choices are inactive when the EMI measurement 
type is set to, Fast SA Scan or APD Statistics. (i.e., APD statistics does not uses 
detection; it uses inputs. Refer to “Measure 1 Hardkey – EMI ’Convenience’ 
Softkeys” on page 329 and “Input – (Trace Input for APD Measurements)” on 
page 331). 

Learn more, see “How to Set the EMI Measurement Settings (Fast SA Scan, 
CISPR Band Scan, CISPR Zoom Scan, and APD Statistics)” on page 321.

Measure 1 Hardkey – EMI ’Convenience’ Softkeys

— Press Measure 1 then choose:

— PosPeak T1 – Enable/Disable trace 1 to display positive peak data 
and retains the peak value of a signal, indicating the worst-case 
summary data (Default = on). P annotation is displayed. This softkey 
is inactive, when APD Statics is ON.

— QuasiPeak T2 – Enable/Disable trace 2 to display quasi-Peak data 
that weighs each component based on its repetition rate: the faster 
repetition rate, the higher the weight given to that component 
(Default = on). Q annotation is displayed. This softkey is inactive, 
when APD Statics is ON and or CISPR Band E is selected.

— EMIAverage T3 – Enable/Disable trace 3 to display EMI average data 
displays the average amplitude of each signal component across its 
period (Default = on). A annotation is displayed. This softkey is 
inactive, when APD Statics is ON.

These softkeys are inactive when the EMI measurement choices are Fast 
SA Scan or APD Statistics. Learn more, see “Input – (Trace Input for APD 
Measurements)” on page 331.

IMPORTANT!

When you press the Measure 1 hardkey a softkey menu is displayed and 
has, as a convenience, fixed values for Trace 1 (PosPeak T1), Trace 2 
(QuasiPeak T2), Trace 3 (EMIAverage T3) assigned. While the softkey 
labels cannot be re-assigned, the trace values can be changed manually 
under the Traces 6 hardkey using the Detector softkey. Learn more, refer 
to “How to set Detection Method” on page 330.
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Trace Averaging

Within EMI mode, the detectors provide the critical necessary averaging (i.e., 
EMI Average and Quasi Peak), but similar to SA mode, if needed, you can 
perform Trace Averaging. Refer to “Average Type” on page 199 and “Average 
Count” on page 200 in Chapter 9, “SA (Spectrum Analyzer) Mode (Option 
233–Mixed Analyzers).”

Alignments 

EMI measurements mode uses amplitude alignment and channel equalization. 
Learn more, refer to the SA chapter’s “Alignments” on page 201 for 
information on all alignments.

Detection Method

Using the EMI feature, can have one of three specific independent detection 
methods: Fast SA Scan, is similar to the original detection method used in SA 
mode that can use only one detector. CISPR Band Scan and CISPR Zoom 
Scan use a newer detection method that uses one detector per trace (e.g., up 
to three detectors and three traces simultaneously). Learn more, refer to 
“Trace Display States (EMI Mode)” on page 328.

APD Statistics uses trace inputs in lieu of detection. Learn more, refer to “Input 
– (Trace Input for APD Measurements)” on page 331.

How to set Detection Method

The current Detection method for each trace is labeled on the left edge of the 
screen. A corresponding letter appears below the corresponding Trace number 
selected. For example: P means that Positive Peak was the selected detector.

— Press Trace_6 > Detector 

— Then choose from the following:

The following softkeys are available when CISPR Band is set to Fast SA 
Scan:

— Auto Displays the most appropriate Detection method based on 
other settings. [# is NOT shown]

— Normal [#Nrm also referred to as Rosenfell] Provides a better visual 
display of random noise than Positive peak and avoids the 
missed-signal problem of the Sample Mode. Should the signal both 
rise and fall within the bucket interval, then the algorithm classifies 
the signal as noise. An odd-numbered data point displays the 
maximum value encountered during its bucket. An even-numbered 
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data point displays the minimum value encountered during its 
bucket. If the signal is NOT classified as noise (does NOT rise and fall) 
then Normal is equivalent to Positive Peak.

— Negative Peak [#NPk] Displays the minimum value of all the 
measurements in each bucket. 

— Sample [#Smp] Displays the center measurement of all the energy 
detected in each bucket. This setting gives a good representation of 
the random noise in each bucket. However, it does not ensure that all 
signals are represented.

— Average [#RMS] Displays the Root Mean Squared (RMS) average 
power of all the measurements in each bucket. This is the preferred 
method when making power measurements.

The following softkey is available for most CISPR Band choices, but not 
APD Statistics:

— Positive Peak [P] Displays the maximum value of all the 
measurements in each bucket. This setting ensures that no signal is 
missed. However, it is not a good representation of the random noise 
in each bucket. 

The following softkeys are only available when the CISPR Band softkey is 
set to CISPR Band Scan scan or CISPR Band Zoom Scan.

— Quasi Peak [Q] Displays the quasi-peak response, as defined by 
CISPR 16. 

— EMI Average [A] Displays the Root Mean Squared (RMS) average 
power of all the EMI measurements in each bucket. This is the 
preferred method when making power measurements.

Repeat the detection setup process as needed for up to 4 traces and 3 
detection methods.

Input – (Trace Input for APD Measurements)

This softkey is active when APD Statistics is the selected CISPR Measurement. 
See also, “CISPR (International Special Committee on Radio Interference) 
Control” on page 321.

— Press Trace 6 > Input – Selects the type of data type that is used to display 
the APD statistics trace based on the APD Dwell Time. Then choose: 

— CCDF – A CCDF curve shows how much time the signal spends at or 
above a given power level. The power level is expressed in dB relative 
to the average power. The percentage of time a signal spends at or 
above each line defines the probability for that particular power level. 
A CCDF curve is a plot of relative power levels versus probability. 
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— Histogram – Displays the power levels detected over the APD Dwell 
Time.
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About Electromagnetic Interference (EMI) Measurements
EMI mode enables you to make the following types measurements: 

— Radiated – wireless EMI signals

— Conducted – emissions from wires or other conducted paths.

Some measurement parameters are auto-coupled and are not user-settable.

EMI Measurement Features (Option 361)

The EMI Resolution bandwidth is auto-coupled to keep frequency range 
with the selected CISPR band. If the Start or Stop frequencies are 
changed, the FieldFox displays a reminder message about the CISPR band 
limits.

Example of CISPR messages: “CISPR band StartFreq limited to 
30000000" and “CISPR band StopFreq limited to 300000000".

In the CISPR Band Scan measurement, the Span can be changed. (Exception: 
CISPR Zoom Scan cannot change the Span.) As the SPAN changes, the resultant 
trace point quantity also changes proportionally, since every FFT spectral sample 
measured undergoes detection by the FieldFox firmware and becomes part of the 
trace (Maximum points == 75001). Learn more, see “CISPR (International 
Special Committee on Radio Interference) Control” on page 321. 

When selected, CISPR Band and Zoom Scan measurements use one of the 
5 CISPR band frequency ranges to set the frequency range (Start and 
Stop) on the FieldFox. CISPR Zoom Scan selects a limited fix span (<entire 
band range). Learn more, see “Resolution Bandwidth (Res BW)” on 
page 326 and “How to set Frequency Range and Frequency Context” on 
page 319.

Hint!

With any of the EMI measurement settings described in this section, you 
can toggle Zero Span and back (i.e., back to your previous measurement) 
using the “Zero / Last Span” softkey. Learn more, see “How to set 
Frequency Range and Frequency Context” on page 319.

For EMI measurements mode, this section defines the four trace state 
choices for the Fast SA Scan trace display states and for CISPR Band 
Scan, CISPR Zoom Scan, and APD Statistics choices, it defines the 4th 
trace display state choices. Learn more, see “How to set the EMI Traces” 
on page 328.
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EMI has the following features:

EMI Measurement Results:

— Amplitude Probability Distribution Statistics (APD)

— Histogram

— CCDF traces displayed

— Center frequency (active with APD Statistics)

— Selectable CISPR Bands (A, B, C, D, or E)

— Positive Peak trace (active with APD Statistics OFF)

— Quasi-Peak trace (active with APD Statistics OFF)

— EMI Average trace (active with APD Statistics OFF)

— 200 Hz, 9 kHz, 120 kHz 6 dB resolution bandwidths, and 1 MHz impulse 
bandwidth

— Frequency bands can be coupled to CISPR bands

— Logarithmic frequency axis

Refer to “EMI Measurement Mode Setup Procedure” on page 335.   
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How to Set Up Electromagnetic Interference (EMI) Mode Settings

This section reviews the steps in setting up an example EMI measurement. If 
you are not familiar with this process or would like more information, refer to 
“Using EMI Measurements (Option 361)” on page 317. 

EMI Measurement Mode Setup Procedure

1.  Selecting EMI Measurement mode:

Press Mode > More (Depends on number of Options) > EMI Measurements

2. Setting the EMI Measurement type:

For this example, press Measure 1 > Measurement > CISPR Band Scan 

— The display updates to show three traces: PosPeak T1 (P), 
QuasiPeak T2 (Q), and EmiAverageT3 (A). Learn more, see “CISPR 
(International Special Committee on Radio Interference) Control” on 
page 321.

3. Setting the CISPR Band:

For CISPR Band Scan, these traces become active and begin sweeping. 
Optional: for this example, press PosPeak T1, QuasiPeak T2, or 
EmiAverage T3 to enable/disable each detector/trace. (default = all on.)

Learn more, see “How to set the EMI Traces” on page 328.

4. Setting the EMI detectors for each trace:

For this example, press CISPR Band > C 30 – 300 MHz (default).

Learn more, see “How to set a CISPR Band” on page 323.

5. Setting the Log Freq AxisX state for the displayed trace:

For this example, press Log Freq AxisX > ON (default). Optional: Press to 
OFF to change display to linear view.

Learn more, see “How to set Frequency Range and Frequency Context” on 
page 319.

IMPORTANT! See also, “Alignments” on page 201, in SA mode, Chapter 9, 
“SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers).”

The EMI Resolution bandwidth is auto-coupled to keep frequency range 
with the selected CISPR band. If the Start or Stop frequencies are 
changed, the FieldFox displays a reminder message about the CISPR band 
limits.

Example of CISPR messages: "CISPR band StartFreq limited to 
30000000" and "CISPR band StopFreq limited to 300000000".
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6. Setting the EMI resolution bandwidth state for the displayed trace:

For this example, press EMI Res BW > Manual (default = Auto). 120 kHz is 
displayed, but you can set other fixed resolution bandwidths (i.e., 200 Hz, 
9 kHz, and 1 MHz). 

Learn more, see “Resolution Bandwidth (Res BW)” on page 326.

7. Setting the Dwell Time: 

For this example, press Sweep 3 > Dwell Time >100 ms (default). 

Glossary (EMI)
This section provides a description of some of the terms used in the FieldFox’s 
EMI mode.

Table 12-1 EMI Abbreviations and Descriptions

Abbreviation Description

APD Statistics Amplitude Probability Distribution Statistics – Evaluates pulses statistically. Measurement done in zero 
span, at the specified center frequency, with a specific APD dB resolution bandwidth.

– CCDF Complementary Cumulative Density Function – The probability of the signal power being above a certain 
level generated from the APD statistics’ histogram results.

– Histogram Results of the APD statistics measurement and the power levels detected over the APD specified dwell 
time used to generate a CCDF results.

CISPR International Special Committee on Radio Interference
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13 Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE 
TDD Option 371, 5G TF Option 377, 5G NR / 5G NR EVM 
Conducted Option 378

OTA mode measures signals at the SA RF Input Port 2 connector. 

OTA mode requires the FieldFox to have SA mode (Option 233 on combination 
analyzers), GPS (Option 307), and CPU2 installed.

5G NR requires 100 MHz wide path Option B10. 

Recommended, but not required:

— Preamplifier (Option 235) to improve receiver sensitivity.

— EMF (Option 358) to measure the EMF levels of 5G signals.

With Options 370 (LTE FDD), LTE TDD (Option 371), 5G TF (Option 377), and 
5G NR (Option 378) network designers can ensure that networks have enough 
resources to carry out handovers (re-selection) when users move between cell 
towers on the same 5G network as well as in between 5G and 4G networks 
(intra/inter-radio access technology). 

The FieldFox OTA measurements support LTE FDD (Option 370), LTE TDD 
(Option 371), Verizon 5G TF (Option 377), and 5G NR (Option 378) over-the-air 
demodulation for single or multiple component carriers (CCs) and multiple cell 
towers for each CC. Additionally, 5G NR EVM Conducted provides EVM 
measurement capabilities for conducted signals. The FieldFox display can be 
configured to show data formats such as table, bar chart, spectrum and strip 
chart of key performance indicators (KPI's). 

By integrating over-the-air (OTA) measurements with cable and antenna test 
(CAT), full 2-port vector network analysis, spectrum analysis, and real-time 
spectrum analysis (RTSA), the FieldFox can be used for base station setup and 
verification.

Some examples in this chapter include the electromagnetic field (EMF) 
mode. EMF requires Option 358. See also, Chapter 9, “SA (Spectrum 
Analyzer) Mode (Option 233–Mixed Analyzers)” and Chapter 13, 
“Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 
371, 5G TF Option 377, 5G NR / 5G NR EVM Conducted Option 378.”
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In this Chapter

“Using OTA (Options 370 – LTE FDD, 372 – TDD, 377 – 5G TF, and Option 
378 – 5G NR / 5G NR Conducted)” on page 340

“About Over–the–Air (OTA) Measurements” on page 342

— “LTE FDD and LTE TDD Features (Option 370 and Option 371)” on 
page 342

— “5G TF Features (Option 377)” on page 348

— “5G NR Features (Option 378)” on page 349

— “5G NR EVM Conducted Features (P/O: Option 378)” on page 352

“How to Set Up Over–the–Air (OTA) Mode Settings” on page 353

— “OTA Setup Procedure” on page 353

— “Optional: Using RTSA to verify the signal quality (Requires Option 350 
and Preamp Option 235)” on page 370

— “How to Define a Cell or Cell(s) and Use OTA” on page 371

“How to Set Up EMF Mode Settings (Requires EMF (Option 358) and 5G NR 
(Option 378))” on page 387

“How to Use Data Logging (OTA Options 370, 372, 377, and 378)” on 
page 394

— “Screen Annotation” on page 394

— “How to Record a Data Log Procedure” on page 395

— “To change Data Logging Configuration settings:” on page 396

— “How to Play a Data Log” on page 397

“Other Features Available” on page 398

— Alignments (SA chapter) – “Alignments” on page 201

— External Gain (SA chapter) – “External Gain” on page 158

“Troubleshooting” on page 399

“Glossary (OTA)” on page 400
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See Also

“Why and When to Calibrate” on page 126

Chapter 30, “System Settings.” (Changing display colors)

Chapter 32, “File Management.”
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Using OTA (Options 370 – LTE FDD, 372 – TDD, 377 – 5G TF, and Option 378 – 
5G NR / 5G NR Conducted) 

OTA enables you to do the following:

Measure and display one component carrier (CC) with multiple cells or multiple component 
carriers (CCs) with a single cellab

Four Display Types:

— Bar chart (color coded based on the 
selected scheme CC | PCC | Level)

— Table

— Strip Chart

— Spectrum

Color Coded Display Types:

— Specify high and low power with color bars 

Flexible Data Sorting:

— LTE FDD: Sort Cells, component carriers 
(CCs), Frequency, RSRP, RSRQ, RSSI, PSS, 
SSS, and SINR scan results displayed by 
low to high, or high to low, or Auto (no 
order is involved)

— LTE TDD: Sort Cells, component carriers 
(CCs), Frequency, RSRP, RSRQ, RSSI, PSS, 
SSS, and SINR scan results displayed by 
low to high, or high to low, or Auto (no 
order is involved)

— 5G NR: Sort Cells, component carriers 
(CCs), Frequency, RSRP, RSRQ, RSSI, 
SINR, PSS, SSS, DMRS, Freq Error, SSB 
Index, and Time Offset (us) scan results 
displayed by low to high, or high to low, or 
Auto (no order is involved)

— 5G TF: Sort Carrier Info, PSS, SSS, Sync 
Correlation (%) scan results displayed by 
low to high, or high to low, or Auto (no 
order is involved)

— 5G NR EVM Conducted: Sort Carrier Info 
RSRP, RSRQ, RSSI, PSS, SSS, PBCH, 
DMRS, Power, Sync Corr, Freq Error, Time 
Offset, PSS EVM, SSS EVM, PBCH EVM, 
DMRS EVM, Composite EVM scan results 
displayed by low to high, or high to low, or 
Auto (no order is involved)

— All: Sort Carrier Info, PCI (aka Cell 
IDs), Power scan results displayed by 
low to high, or high to low, or Auto 
(no order is involved)

Data Logging GPS stamped data measurements

— Define measurement interval by time or 
distance

— Show results in Table or Bar Chart

— Display files (KML) on Google Maps or 
Google Earth

New Radio Features (Option 378) 
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— FR1 (410 MHz to 7.125 GHz) and 

— FR2 (24.25 GHz to 5.26 GHzc) 

— EMF measurements (Requires Option 358)

— EVM synchronization signal measurements

— Single acquisition multiple simultaneous 
measurements

— Measure CC, Cell IDs, and KPI’s for 
multiple cells

— SSB Beam index

a. When multiple component carriers are selected, the results of the component carrier 
(CC) with the highest power is displayed.

b. LTE FDD, LTE TDD, and 5G NR can measure and display multiple cells. 5G TF and 5G NR 
EVM Conducted only have the ability to measure and display a single cell.

c. With frequency extension via OML downconverter. Refer to Chapter 30, “System 
Settings.” and then “Utilities” on page 732.
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About Over–the–Air (OTA) Measurements
OTA mode supports these standards: 

— LTE FDD 

— LTE TDD 

— 5G TF measurements

— 5G NR

— 5G NR EVM Conducted

Some measurement parameters are auto-coupled and are not user-settable.

LTE FDD and LTE TDD Features (Option 370 and Option 371)

LTE FDD and LTE TDD have the following features:

Cell Scan Results:

— Center frequency

— Physical Cell Indentifier (PCI) – (Cell ID–Sector ID–Group ID) – (C/S/G)

— RSRP (Reference Signal Received Power) (dBm)

— RSRQ (Reference Signal Received Quality) (dB)

— RSSI (Received Signal Strength Indicator) (dBm)

— PSS (Primary Synchronization Signal) (dBm)

— SSS (Secondary Synchronization Signal) (dBm)

— SINR (Signal to Interference & Noise Ratio) (dB)

— Frequency error (Hz)

Refer to step 11 in the “OTA Setup Procedure” on page 353.   

Display Types:

User can set up and display 1, 2, 3 or 4 simultaneous measurements of key 
performance indicators (KPI's) for any component carrier (CC0 through CC4), 
up to 5 carriers, in any combination of the following:

IMPORTANT! LTE FDD, LTE TDD, and 5G TF only demodulate PSS and SSS 
signals using the FieldFox’s 10 MHz demodulation path. User data 
channels are not demodulated.

IMPORTANT! LTE FDD and LTE TDD generally have similar cell features, but 
the Band and Channel choices are different for the Channel Table settings.
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— Table – Cell scan numeric results, including PCI, RSRP, RSRQ, RSSI, PSS, 
SSS, SINR and Freq Err, for up to 5 CCs or 6 cells

— Bar Chart – Vertical power bar graph of selectable cell scan result metric 
with adjustable color “heat” amplitude scale, for up to 5 CCs or 6 cells. And, 
color coded based on the selected scheme (i.e., CC, PCC, and Level). Refer 
to Figure 13-2 on page 344, Figure 13-3 on page 344, and Figure 13-4 on 
page 345.

— Spectrum – Magnitude frequency spectrum (fixed span) for a selected CC

— Strip Chart – Magnitude of selectable cell scan result metric graphed over 
time, for up to 5 CCs or 6 cells                            

Figure 13-1 Example of the LTE FDD with Four Multiple Display Options – (LTE TDD is 
similar)
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Figure 13-2 LTE FDD Bar Chart – CC Example 

Figure 13-3 LTE FDD Bar Chart – PCC Example 
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Figure 13-4 LTE FDD Bar Chart – Level Example 

Figure 13-5 Example of the 5G TF with Four Multiple Display Options 



 346                                                                                                                     Keysight N9938-90006 User’s Guide

Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 371, 5G TF 
Option 377, 5G NR / 5G NR EVM Conducted Option 378
About Over–the–Air (OTA) Measurements

Figure 13-6 Spectral Emission Mask Example 

Figure 13-7 SSB Index Example 
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Figure 13-8 5G NR Center Frequency and SSB Offset, Before Multiple Cell IDs Example 

Figure 13-9 5G NR Center Frequency and SSB Offset and SSB Index and PCI Single With 
Multiple Cell IDs Example 
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5G TF Features (Option 377)

5G TF has the following features:

Cell Scan Results:

— Center frequency

— Physical Cell Information (PCI) – (Cell ID)

— Power (Channel Power) (dBm)

— PSS (Primary Synchronization Signal) (dBm)

— SSS (Secondary Synchronization Signal) (dBm)

— Sync correlation (%)

Refer to step 11 in the “OTA Setup Procedure” on page 353. 

Data Formats:

User can set up and display 1, 2, 3 or 4 simultaneous measurements of key 
performance indicators (KPI's) for any component carrier (CC0 through CC7), 
up to 8 carriers, in any combination of the following:

— Table – Cell scan numeric results (for up to 6 cell sites (ID's) including Cell 
ID, Channel Power, PSS, SSS, Sync Corr 

— Bar Chart – Vertical power bar graph of selectable cell scan result metric 
for up to 8 cell sites with adjustable color “heat” amplitude scale. And, color 
coded based on the selected scheme (i.e., CC, PCC, and Level). See also, 
Figure 13-2 on page 344, Figure 13-3 on page 344, and Figure 13-4 on 
page 345.

— Spectrum – Magnitude spectrum frequency domain (fixed span). You can 
only view a single component carrier at a time with Spectrum (e.g., CC0 or 
CC2, etcetera).

— Strip Chart – Magnitude of selectable cell scan result metric graphed over 
time

IMPORTANT! LTE FDD, LTE TDD, and 5G TF only demodulate PSS and SSS 
signals using the FieldFox’s 10 MHz demodulation path. User data 
channels are not demodulated.
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Figure 13-10 Example of 5G TF Single Carrier and Single Cell

5G NR Features (Option 378)

5G NR has the following features:

 Refer to step 11 and “5G NR:” on page 360. See also, “5G NR EVM Conducted 
Features (P/O: Option 378)” on page 352.

Cell Scan Results:

— Center frequency

— PCI (Physical Cell Identifier) – (Cell ID-Sector ID-Group ID) – (C-S-G) 

— SSB (Synchronization Signal Block) Index

— RSRP (Reference Signal Received Power) (dBm)

— RSRQ (Reference Signal Received Quality) (dB)

IMPORTANT! 5G NR only demodulates PSS, SSS and PBCH DMRS signals 
using the FieldFox's 100 MHz demodulation path. User data channels are 
not demodulated.
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— RSSI (Received Signal Strength Indicator) (dBm)

— SINR (Signal to Interference & Noise Ratio) (dB)

— PSS (Primary Synchronization Signal) (dBm)

— SSS (Secondary Synchronization Signal) (dBm)

— DMRS (Physical Broadcast Channel Demodulation Reference Signal) (dBm)

— Frequency error (Hz)

— Time Offset (us) – Not shown in the 5G NR figures, but is part of the Carrier 
Info scan results.

Display Types:

User can set up and display 1, 2, 3 or 4 simultaneous measurements of key 
performance indicators (KPI's) for any component carrier (CC0 through CC7), 
up to 8 carriers, in any combination of the following:

— Table – Cell scan numeric results, including PCI, RSRP, RSRQ, RSSI, PSS, 
SSS, SINR and Freq Err, for up to 8 CCs and 6 cells for each CC

— Bar Chart – Vertical power bar graph of selectable cell scan result metric 
with adjustable color “heat” amplitude scale, for up to 8 CCs and 6 cells for 
each CC. And, color coded based on the selected scheme (i.e., CC, PCC, 
and Level). See also, Figure 13-2 on page 344, Figure 13-3 on page 344, 
and Figure 13-4 on page 345.

— Spectrum – Magnitude frequency spectrum (fixed span) for a selected CC

— Strip Chart – Magnitude of selectable cell scan result metric graphed over 
time, for up to 8 CCs and 6 cells for each CC
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Figure 13-11 Example of 5G NR Single Carrier and Single Cell

Figure 13-12 Example of 5G NR Multi-Beam – Displaying Multiple Beams From Cell Site 378
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5G NR EVM Conducted Features (P/O: Option 378)

FieldFox EVM Measurements

5G NR EVM Conducted can make EVM measurements of 5G NR signal 
synchronization channels. Refer to step 11, and “5G NR EVM Conducted NR:” 
on page 361, in section “OTA Setup Procedure” on page 353. 

The FieldFox’s 5G NR EVM Conducted measurements are similar to the 
X-Series Multi-touch Signal Analyzers. For more on making FieldFox 
EVM-related measurements with the X-Series Multi-touch Signal Analyzers, 
refer to 
http://rfmw.em.keysight.com/wireless/helpfiles/5GNRMode/FlexUI.htm and 
then 
http://rfmw.em.keysight.com/wireless/helpfiles/5GNRMode/FlexUI.htm#me
as_5gnr_evm/Modulation Analysis.htm content.

The FieldFox can make more comprehensive EVM measurements with the 
89600 VSA software using the FieldFox's Remote Server feature. See the 
Chapter 17, “Remote Server Mode (Requires SA Hardware/SA Option 233).” 

IMPORTANT! 5G NR only demodulates PSS, SSS, PBCH and PBCH DMRS 
signals using the FieldFox's 100 MHz demodulation path. User data 
channels are not demodulated.

The FieldFox 5G NR EVM Conducted (p/o Option 378) does not have all of 
the features of a X-Series Multi-touch Signal Analyzers.
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How to Set Up Over–the–Air (OTA) Mode Settings

This section reviews the steps in setting up an OTA measurement. If you are not 
familiar with this process or would like more information, refer to “How to 
Define a Cell or Cell(s) and Use OTA”

This section consists of:

— “OTA Setup Procedure”

— “Optional: Using RTSA to verify the signal quality (Requires Option 350 
and Preamp Option 235)”

OTA Setup Procedure 

1.  Modifying the Frequency Reference and GPS settings:

Press System 

— Then System Configuration) > GNSS (GPS+) > GNSS Receiver > 
Internal > Esc

— The left portion of the screen displays satellites and the 
corresponding number on the adjacent Satellite Power 
chart.

— The right portion of the screen displays Satellite Power 
Carrier to Noise (C/No) dBHz values on the tops of the 
satellite power chart.

— Then System > System Configuration > Frequency Ref > Freq Ref 
Source [GPS] >Back

For more information:

— Refer to Figure 13-14 called, “Example of the LTE FDD Scan Results 
Table (Five CCs and one cell) – LTE TDD is similar,” on page 366.

— And, refer to Figure 13-15 called, “Example of the 5G TF Scan 
Results Table (Two cc and one cell),” on page 367.

— And, refer to Figure 13-12 called, “Example of 5G NR Multi-Beam – 
Displaying Multiple Beams From Cell Site 378,” on page 351.

IMPORTANT! See also, “Alignments” on page 201, in NA mode,Chapter 9, 
“SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers).”.

The FieldFox can be used with an OML frequency extender. Refer to 
“Utilities” on page 732, the B Series FieldFox Configuration Guide 
5992-3701EN, and to “Contacting Keysight” on page 5.

IMPORTANT! It is not sufficient to be locked to the GNSS satellite, the 
frequency reference must be locked to GPS.
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— See also “GNSS (GPS+) and GPS” on page 756.

2. Selecting OTA mode:

— Press Mode_.

— Then More (may not be available—number of installed options 
dependent)

— Then OTA.

3. Selecting an OTA format: 

Press Measure – (When you initially select OTA mode, the FieldFox 
defaults to the Measure menu.)

— The Measure menu is used to select an OTA format (e.g., Option 370 
LTE FDD, Option 371 LTE TDD, Option 377 5G TF, etcetera):

(Available modes are Option dependent.) 

— LTE FDD (default) or

— LTE TDD

— 5G TF

— 5G NR

— 5G NR EVM Conducted

The OTA format chosen begins scanning for signals. 
Additional FieldFox setting changes are required for OTA to 
display the available signals. Refer to the steps below and 
see also, “How to Define a Cell or Cell(s) and Use OTA” on 
page 371. 

4. Define some carrier and cell measurement information. See also, “How to 
Define a Cell or Cell(s) and Use OTA”.

Then modify the carrier and cells based on the selected OTA technology 
(i.e., LTE FDD, LTE TDD, 5G TF, 5G NR, and 5G NR EVM Conducted).

5. Press Freq/Dist

— Then CC CC0 (Default is CC0) – Selects the CC number to be 
displayed (LTE FDD/LTE TDD choices: CC0-CC4, 5G NR Choices: 
CC0-CC7). If only one CC is selected, the FieldFox will not allow you 
to disable the scan. See also, the Trace hardkey in step 7. 

If after making the setting changes in the steps below, no data is 
displayed, refer to “Troubleshooting” on page 399.

Display does not update (refresh), until all active component carriers (CCs) 
have been scanned.
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— Then Enabled ON (Default is ON) – Enables/disables the CC scan 
results. If only one CC is selected, the FieldFox will not allow you to 
disable the scan.

— Then Center – You can enter a center frequency, or for LTE FDD, LTE 
TDD, and 5G NR (only) you can use the Channel Table menu to enter 
an auto-coupled Center frequency (see LTE FDD, LTE TDD, and 5G 
NR Channel Table softkey menus below).

— Then Offset (Option 578 – 5G NR Only) – You can enter an 
synchronization signal block (SSB) offset frequency.

6. Optional (Option 370 – LTE FDD, Option 371 – LTE TDD, and Option 378 – 
5G NR Only): Press Freq/Dist > Freq Mode > Chan

This changes the Center frequency value.

Press Channel Table opens a softkey menu, where you can select define 
your carrier, by Band and Channel. The Center frequency value is 
auto-coupled to the Band/Channel entered.

Option 370 LTE FDD and Option 371 LTE TDD Only:

— Then Band > n > Enter  
(The Channel, Band, and the Center values are auto-coupled.)

— Then Favorites List (Option 370 LTE FDD and Option 371 LTE TDD 
Only) opens a softkey menu, where you can save your current Band 
and Channel setup.

— Then Setup 1 In the Favorites list softkey menu, the 
softkey displays the current Band and Channel displayed 
(e.g., Setup 1 3,1200). Select the Favorites List softkey 
again to observe the updated Setup 1 softkey.

— Then Back

Option 5G NR Only:

— Then Band > n > Enter  
(The Channel, Band, and the Center values are auto-coupled. 
frequency Offset is settable.)

— Then Channel Raster (Option 378 5G NR Only) opens the Channel 
Raster softkey menu.

— Then Channel ARFCN Sets the Absolute Radio-Frequency 
Channel Number signal to be measured. Setting an ARFCN 
automatically sets a corresponding Center frequency for 
the component carrier. 

Band and Channel values vary between LTE FDD and LTE TDD. 
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— Then Center sets the ARFCN center frequency.

— Then Offset sets the offset from the Center frequency.

— Then Sync Raster (Option 378 5G NR Only) opens a softkey menu, 
where you can set the Global Synchronization raster Channel using 
wider SSB frequency search. Sync ARFCN is coupled with Sync 
GSCN. ARFCN and GSCN minimum and maximum values vary with 
band setting and licensed frequency.

— Then Sync ARFCN sets the ARFCN reference signals to be 
synchronized.

— Then Sync GSCN sets the GSCN signals to be 
synchronized.

— Then Center sets the GSCN center frequency.

— Then Offset sets the offset from the Center frequency.

— Then Back

7. Select Trace 6—choose:

— Window 1 2 3 4 

—  Then Win State OFF ON to ON

—  Then Display Type  

— Table or

— Bar Chart or

— Spectrum or

— Strip Chart

—  Then CC (select component carriers)

— All (Not applicable for Spectrum. When All is specified, for 
Spectrum, the FieldFox defaults to CC0) or

— CC0, CC1, CC2, CC3, or CC4 (i.e., 5G TF and 5G NR have 
up to eight component carrier choices (CC5, CC6, and 
CC7))

The Spectrum view in 5G TF uses a center frequency that is +2.6 MHz 
offset from the carrier’s center frequency. This is done so that FieldFox can 
capture the necessary xPBCH (physical broadcast channel) information to 
demodulate the signal. Be aware that all of the instrument’s displayed 
numbers are rounded to three significant digits (e.g., 5.0026 GHz is 
displayed as 5.003 GHz). 



Keysight N9938-90006 User’s Guide                                                                                                                      357

Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 371, 5G TF 
Option 377, 5G NR / 5G NR EVM Conducted Option 378
How to Set Up Over–the–Air (OTA) Mode Settings

Repeat process as needed for additional Windows, Data, and CC settings.

8. Select a substep:

a. All OTA Options: Press Trace 6 > More 

— Then Data RSRP – Then select the data type: 

LTE FDD and LTE TDD: RSRP, RSRQ, RSSI, SINR, PSS, SSS 
(Default = RSRP).

5G TF: PSS, SSS or Power (Default = PSS).

5G NR: RSRP, RSRQ, RSSI, SINR, PSS, SSS or DMRS (Default 
= RSRP).

5G NR EVM: RSRP, RSRQ, RSSI, PSS, SSS, PBCH, DMRS, or 
Power (Default = RSRP).

— Then Sort Order and choose Up or Down (Default: Auto). 
Refer to “About Over–the–Air (OTA) Measurements” on 
page 342. This softkey is inactive when Sort Order is set to 
Auto. 

— Then Sort Data RSRP – Then select the type of data to be 
sorted: 

LTE FDD and LTE TDD: RSRP, RSRQ, RSSI, SINR, PSS, SSS, 
Freq Error.

5G TF: PSS, SSS, Power, Sync Corr.

5G NR: RSRP, RSRQ, RSSI, SINR, PSS, SSS, DMRS, Freq Error, 
SSB Index.

5G NR EVM: RSRP, RSRQ, RSSI, PSS, SSS, PBCH, DMRS, 
Power, Sync Error, Time Offset, PSS EVM, SSS EVM, PBCH 
EVM, DMRS EVM, Composite EVM.

— Then Data Logging – to record data. Refer to “How to Use 
Data Logging (OTA Options 370, 372, 377, and 378)” on 
page 394.

b. 5G NR Only: 

Press More

— Then SSB Index All Single when the SSB value is set, the SSB 
Index mode is automatically set to single. SSB Index values 
are for the currently displayed cell results.

IMPORTANT! When multiple component carriers are selected, the results 
of the component carrier (CC) with the highest power are displayed. Refer 
to Figure 13-13 on page 366.
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Enabling and disabling multi-beam display is useful when 
displaying the results from multiple cells.   

— Then Multi-Beam OFF ON enable/disable Multi-Beam. 
Enables/disables displaying multiple beams (SSB results) for 
the currently displayed cell results.

Enabling and disabling multi-beam display is useful when 
displaying the results from multiple cells.   

— Then Next Result Set updates the Scan Results table with the 
next set of scanned data

9. Optional: Display Type Table – Different softkey menus are displayed for 
the four different Display Types: Table (default), Bar Chart, Spectrum, and 
Strip Chart: 

a. Optional (When Display Type = Table or the More softkey is pressed 
for the other Display Types): Modify RF attenuator, Preamp, and 
other settings:

If Display Type = Table, then press Scale/Amptd or

If Display Type = Bar Chart, Spectrum, or Strip Chart, then press 
More, if 

Then press the following:

— RF Atten to set the attenuator power (default: –10 dB). Set to 
0 dB.

— Preamp change to ON.

— Range to set the absolute power (dBm) 

— Others (optional): External Gain

b. Optional (When Display Type = Bar Chart): Modify scale and specify 
color bar limit values—Modify the bar chart display color coding 
scheme for the power channels (bars): 

Press Trace > More > Bar Color Coding 

Then one of the following:

— CC to set the CC (Component Carrier) associated with each 
bar.

— PCI to set the PCI (Physical Cell Identifier) associated with 
each bar.

— Level to set the level of the value associated with each bar. 

When level is selected, you can set the channels’ red and blue 
power level limits with the Scale/Amptd softkeys:

Press Scale/Amptd

Then one of the following:
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— Red Limit to set the power level and color scale for high 
power channels.

— Blue Limit to set the power level and color scale for low 
power channels.

— Others: Scale, Ref Level, etcetera as desired.

— More opens a menu of softkeys that are the same as those 
that are defined when the Display Type = Table.

— Others (optional): Autoscale

c. Optional (When Display Type = Spectrum): Modify RF attenuator, 
Preamp, and other settings:

Press Scale/Amptd 

Then press the following:

— Ref Pos Manually set the position of the reference line. Values 
must be between 0 (TOP line) and 10 (BOTTOM line).

— Scale Manually enter a scale per division to view specific 
areas of the trace.

— Ref Level Manually set the value of the reference line. Enter a 
negative value by pressing Run/Hold (+/-) either before or 
after typing a value. 

— More opens a menu of softkeys that are the same as those 
that are defined when the Display Type = Table.

— Others (optional): Autoscale

d. Optional (When Display Type = Strip Chart): Modify RF attenuator, 
Preamp, and other settings:

Press Scale/Amptd 

Then press the following:

— Scale Manually enter a scale per division to view specific 
areas of the trace.

— Ref Level Manually set the value of the reference line. Enter a 
negative value by pressing Run/Hold (+/-) either before or 
after typing a value. 

— More opens a menu of softkeys that are the same as those 
that are defined when the Display Type = Table.

— Others (optional): Autoscale

10. Optional: Modify scale and specify color bar limit values—Modify the scale 
and assign colors to low and high power channels (bars):

Press Scale/Amptd
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Then one of the following:

— Red Limit to set the power level and color scale for high power 
channels.

— Blue Limit to set the power level and color scale for low power 
channels.

— Others: Scale, Ref Level, etcetera as desired.

11. Optional (i.e., If the Scan Results table does not populate): Press Meas 
Setup 4 

— LTE FDD and LTE TDD: 

— Then FreqError Th > 5 kHz (enables data with larger 
frequency error to be displayed)

or Extend Freq Lock > ON (disables FreqError Th softkey 
and displays all available cell results. (This may result in 
longer scan times, because display does not update until 
all potential cells and their frequency offsets are detected 
between signal and the OTA center frequency.)

— LTE TDD (Only): UL-DL Config (selects the type of 
Uplink-Downlink switch-point periodicity configuration). 
Choose from Config 0 (default) through Config 6.

— MBSFN (opens a menu to configure the Multi–broadcast 
Single Frequency Network (MBSFN) frames to transmit 5G 
NR control channels (SSBs) and can be used to enable 
dynamic spectrum sharing (DSS)). 

——MBSFN OFF ON – Enables the MBSFN frames for 
NR control channels (SSBs). (Default = OFF.) 

——Toggle All Subframes – Enables or disables all of 
the MBSFN frames. Enabled by default when 
MBSFN is set to ON. 

——Subframe 3 OFF ON – Enables or disables 
subframe 3 as one of the MBSFN frames for NR 
control channels (SSBs). Subframe 4 OFF ON, 
Subframe 7 OFF ON, Subframe 8 OFF ON, and 
Subframe 9 OFF ON are similar to Subframe 3.

——More – Opens a menu to enable/disable the 
Subframe 8 and Subframe 9 MBSFN frames that 
are NR control channels.

— 5G TF: Then SyncCorr Th > 0% (enables data with greater than 0% 
of the specified Sync Correlation percentage to be displayed)

— 5G NR: 
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— Then FreqError Th > 7.5 kHz (enables data with larger 
frequency error to be displayed)

— Then SCS Sets the data channel sub-carrier spacing: 
15 kHz, 30 kHz, 120 kHz, or 240 kHz (Default = 30 kHz).

The SCS is coupled to the Center Frequency setting based 
on the 5G NR FR1 & FR2 frequency ranges.

— Then SSB Case Sets the signal SSB case: A, B, C, D, or E 
(Default = Auto).

— Then Lmax Sets the current half frame SS/PBCH blocks 
indexing in ascending order in time 0 to (Lmax – 1). Choices 
are 4, 8, or 64 (Default = Auto).

— Then More opens a menu for Capture Length, Drive Speed, 
SS Meas DMRS, SSB Offset Detection, LTE Coexistence 
(NSA / DSS), EMF, Advanced. See also, “How to Define a 
Cell or Cell(s) and Use OTA” on page 371.

——Then Advanced opens a menu for Capture 
Length, Drive Speed, Phase Comp, SS Meas 
DMRS. See also, “How to Define a Cell or Cell(s) 
and Use OTA” on page 371.

— 5G NR EVM Conducted NR: 

— Then Cell ID Auto Sets the Cell ID to Auto or to Manual 
(default = Auto). 

— Then Bandwidth Sets the FR1 / FR2 bandwidth (Default = 
FR1 100 MHz).

— Then Resource Grid Opens a softkey menu to select the 
component carrier and optionally export scan results to 5G 
NR.

——Then SCS Auto - the SCS value is coupled to the 
center frequency and FR1 and FR2. Manual 
choices are 15 kHz and 30 kHz. Default = Auto. 

—— Then Grid Start only settable when SSB Auto is 
set to OFF. Default = 0.

—— Then Grid Size only settable when SSB Auto is 
set to OFF. Default = 273.

——Then Export to 5G NR Setup – Export the current 
scanned table of information to 5G NR. 

— Then SSB Opens a softkey menu to select the SSB settings 
that are coupled to the Resource Grid SCS setting.



 362                                                                                                                     Keysight N9938-90006 User’s Guide

Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 371, 5G TF 
Option 377, 5G NR / 5G NR EVM Conducted Option 378
How to Set Up Over–the–Air (OTA) Mode Settings

——Then SSB Auto-Detect OFF ON - 
Enables/disables SSB Auto-Detect state. When 
SSB auto-detection is enabled, the SSB offset, 
SSB Case, Lmax, Periodicity and, optionally, SCS 
are all auto-detected in the measurement. When 
disabled, the settings can be set manually. 
Default = ON.

——Then SSB Offset - Opens a menu to set the SCS 
values.

——Then SSB Case – Sets the SSB Case when SSB 
Auto-Detect is disabled. This setting is coupled 
to the Resource Grid SCS setting. Choices: 
15 kHz SCS - Case A, 30 kHz SCS - Case B & C, 
120 kHz SCS - Case D, and 240 kHz SCS - Case 
E.

——Then Lmax – Sets the Lmax when SSB 
Auto-Detect is disabled. This setting is coupled 
to the Bandwidth setting. Choices: an FR1 
bandwidth is selected, 4 and 8; When an FR2 
bandwidth is selected, 64 is available.

——Then SSB Periodicity – Sets the SSB Case when 
SSB Auto-Detect is disabled. Choices: 5 ms, 
10 ms, and 20 ms.

SCS Common The signal sub-Carrier Spacing 
Common setting is coupled to the 
Bandwidth setting. When an FR1 
bandwidth is selected, 15 kHz & 
30 kHz SCS are available; When an 
FR2 bandwidth is selected, 60 kHz 
SCS & 120 kHz SCS are available.

RB Offset Sets the Resource Block (RB) offset 
of the signal SSB relative to CRB0. 
Choices: Min: Dynamic. Varies based 
on the Resource Grid Start setting.

Max: Dynamic. Varies based on the 
Resource Grid Start and Grid Size 
settings.

kSSB Sets the kSSB of the signal SSB. 
Choices: Min: 0

Max: Dynamic. Varies based on the 
Resource Grid SCS setting.
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— Then Results –> Setup Opens a softkey menu to select the 
component carrier and optionally export scan results to 5G 
NR.

——Then CC CC0 - Selects the cc signal information 
to be scanned (CC0 to CC4). Default = CC0.

——Then Copy to Manual Setup - Selects the cc 
signal information to be copied to the manual 
SSB.

——Then Export to 5G NR Setup – Export the current 
scanned table of information to 5G NR. 

— Then Advanced Opens an Advanced softkey menu.Then 
Phase Comp- Enables/disables phase compensation.

— Once the table populates, enter the desired frequency error (LTE 
FDD, LTE TDD, and 5G NR), Sync Correlation (5G TF) threshold for 
your measurement (LTE FDD and LTE TDD: Default = 900 Hz, i.e., if a 
carrier signal’s error is greater than 900 Hz, no data is displayed. 5G 
TF/5G NR/5G NR EVM Conducted: Default = 1%, i.e., if a carrier 
signal’s sync correlation is smaller than 1%, no data is displayed).

12. Enable the Data Logging settings: 

— Press Trace 6 > More (All Modes) > More (5G NR only) then Data 
Logging to view the Data Logging softkeys and set the Record 
Settings, Record Save/Recall, and Indoor Map Data Logging

— Record (Outdoor Logging) or

— Play (If you have previously stored data recordings.) 

If after making the setting changes in this section, no data is displayed, 
refer to “Troubleshooting” on page 399.

Display does not update (refresh), until all active component carriers (CCs) 
have been scanned.

Spectrum and Strip Chart information is not recorded. Only the Table and 
Bar Chart data are saved. See “How to Record a Data Log Procedure” on 
page 395. 

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are 
save-recalled to: "[CurrentDevice]\RecordPlayback\OTA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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a. To set the Record Settings (Outdoor Mapping only) — then choose:

— Then Meas Interval > ON

— Then Interval Type > choose Time or Distance.

— Then, if applicable Time Interval enter time interval in 
seconds. 

Or

— Then, if applicable Distance Interval enter distance interval in 
miters. 

— Then Back

b. Then press Record Save/Recall To set file settings choose

— Save Log File to save the current Table data (i.e., default save 
device is Internal). i.e., *.KML or *.CSV (default) files are saved 
to the file name and device type. See Settings below and “To 
change Data Logging Configuration settings:” on page 396

— Recall Log File select a filename from the list

— File Folder  
Default - selects [Internal]:RecordPlayback\OTA 
(default) or System - selects [Internal] top of internal 
directory.

— Device choose where to store your data files

— File Type > CSV or KML choose a file type (Default: CSV)

— Auto Save OFF (default)/ON. When enabled, a temporary log 
file (e.g. TempAutoSave.csv) is automatically saved after 
each new record is recorded to guard against data lose in the 
case of an unexpected shutdown. The temporary log file is 
automatically deleted after you stop recording and manually 
save the log file.

or

— Back

c. Indoor Map Data Logging - then Record Indoor Data or Recall 
Indoor Log File. 

— Then choose Navigate OFF ON, Data Selection, Zoom, Pan, 
Record Data, More

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” 
on page 486. See also, Chapter 32, “File Management.”

Learn more about file settings, refer to Chapter 32, “File Management.”
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13. Outdoor Mapping only: If recording, then:

— View Map OFF ON To enable/disable the current map view (default 
= latitude/longitude = 0.00/00. Need GPS to view current location 
(default = OFF).

—  Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue 
recording.

— Stop Immediately stops recording and a “Save the Log File” menu 
opens to rename and save your data log file.

— (Press Record to begin a new recording.)

— Then Maps To enable map view and related features (e.g., Data 
Selection, Red/Blue Limits, Labels & Icons, Zoom). 

— Data Selection Opens a softkey menu to set the active 
data channel, sort type, and sort order. See also previous 
step 8 above.

— Red/Blue Limits Opens a softkey menu to assign power 
values to the red (high power limits) and blue (low power 
limits) heat map display limits (defaults: Red Limit = 
–20 dBm, Blue limit = –90 dBm).

— Labels & Icons Opens a softkey menu to enable/disable 
map data point labels and icon types.

—  Save Image (PNG) Saves the current displayed map to a *.png file 
(default filename is “MapImageFile”).

14. Export KML file into 3rd party mapping software (i.e., Google Map or 
Google Earth). Refer to “Step 6: Import and Play back KML Files into 3rd 
Party Software (Example: Google Earth with Animation Tool)” on page 385.

Labels OFF ON Enables/Disables map data point labels. When 
enabled, a label is displayed for every map data point 
(e.g., “Data 1”). When disabled, labels are not 
displayed for the map data points.

Icons  
Flag Point Line

Sets the type of icon that is used to display a map’s 
data points (default = Flag).

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are 
save-recalled to: "[CurrentDevice]\RecordPlayback\OTA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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Figure 13-13 Single cell selected, but other cells displayed when CC0 to CCn has been 
enabled. If ALL is selected, only the CC with the highest power is displayed. 
(Not all of the detected data is displayed.)

Figure 13-14 Example of the LTE FDD Scan Results Table (Five CCs and one cell) – LTE TDD 

is similar1

1. When multiple component carriers are selected, the results of the component carrier (CC) with the highest 
power is displayed.
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Figure 13-15 Example of the 5G TF Scan Results Table (Two cc and one cell)
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Additional LTE FDD Examples (LTE TDD is Similar)

Figure 13-16 Example of LTE FDD with Single Carrier, Multiple Cell Sites, KPIs
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Figure 13-17 Example of LTE FDD with Multiple Carriers, Single Cell Site, and KPI’s
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Optional: Using RTSA to verify the signal quality (Requires Option 350 and 
Preamp Option 235)

— Press Mode > RTSA

— Then Density Spectrum (Default)

— Press Freq/Dist > Center (Default) > 751 MHz

(For this example, Center = 751 MHz.) 

— Press Scale/Amptd 

— Then Preamp [ON]

— Then Ref Level (Default). Then use the  arrows, the rotary knob, 
or numeric keypad to position the trace for optimum viewing on the 
FieldFox display. Refer to Figure 13-18 on page 370.

You should see a ~20 dB or greater LTE FDD signal–to–noise level. If not 
refer to “Troubleshooting” on page 399. 

Figure 13-18 Using RTSA to verify LTE FDD 751 MHz signal quality–20 dB Signal to Noise 
Displayed (Requires Option 350 and Preamp Option 235) 
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How to Define a Cell or Cell(s) and Use OTA 

LTE FDD, LTE TDD, 5G TF, 5G NR, and 5G NR EVM Conducted have only one 
predefined view (Table). You can define measurements, which can be used to 
display up to four different views (windows) simultaneously on the display 
screen. You can select which type of data to display in each of the views from 
the Trace menu.

Cell definitions consist of the following:

— Set frequency according to DUT requirements 

— Define cell settings

— Define component carrier(s) (CCs) settings

Example: Using OTA LTE FDD or 5G TF, refer to:

— “Step 1: LTE FDD (Option 370), LTE TDD (Option 371), 5G TF (Option 377), 
and 5G NR (Option 578): Component Carrier (CC) and Cell Defined” on 
page 371

Then:

— “Step 2: Select Trace Type” on page 377

— “Step 3. Modify Scale and the Display Color Bar Settings” on page 379

— “Step 4: Enable Data Logging and Playback the Results” on page 380

— “Save 5: Save the Log Results:” on page 384

— “Step 6: Import and Play back KML Files into 3rd Party Software (Example: 
Google Earth with Animation Tool)” on page 385

Figure 13-19 Cell Definition (LTE FDD) – (LTE TDD is similar)

Step 1: LTE FDD (Option 370), LTE TDD (Option 371), 5G TF (Option 
377), and 5G NR (Option 578): Component Carrier (CC) and Cell 
Defined

1. Press Preset then Mode Preset (Factory)
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2. Selecting and OTA mode: Press Measure > LTE FDD or LTE TDD or 5G TF or 
5G NR or 5G NR EVM Conducted 

3. Optimizing the FieldFox to scan for signals:

— Set the System > System Configuration > Frequency Ref > Freq Ref 
Source [GPS] >Back

— Set the GNSS (GPS+) > GNSS Receiver > Internal > Esc

See also “GNSS (GPS+) and GPS” on page 756.

— Set the Scale/Amptd to: 

— RF Atten > 0 dB

— Preamp > ON

— Set the Freq/Dist > then optionally: 

All Measurement Setups:

— Press CC CCO 

— Press Enabled OFF ON Enable/disable selected 
component carriers. If only one CC is enabled, the OFF key 
press is ignored (default = ON).

— Press Center to select the currently displayed component 
carrier center frequency.

For LTE FDD and LTE TDD (instrument dependent)

— Optional (LTE FDD and LTE TDD only):

——Freq Mode > Chan

——Then Channel Table – Opens a menu to choose 
your CC, Band, Channel, and then use Favorites 
List, to open a softkey menu to save your Setup 
n. 

For 5G NR (instrument dependent)

— Optional (5G NR only):

——Offset frequency offset of the measurement 
frequency from the center frequency

——Freq Mode > Chan

——Then Channel Table – Opens a menu to choose 
your CC, Band, Raster Mode Chan Sync, and 
then use Channel Raster to open a softkey menu:

Then Channel ARFCN, Center, or Offset 

Else
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then use Sync Raster, to open a softkey menu:

Then Sync ARFCN, Sync GSCN, Center, or Offset 

For 5G TF and 5G NR EVM Conducted (instrument dependent). For 
more on 5G NR EVM Conducted, refer to “FieldFox EVM 
Measurements” on page 352.

4. Select Trace 6—choose:

— Window 1 2 3 4 

—  Then Win State OFF ON to ON

—  Then Display Type  

— Table or

— Bar Chart or

— Spectrum or

— Strip Chart

—  Then CC (select component carriers)

— All (Not applicable for Spectrum. When All is specified, for 
Spectrum, the FieldFox defaults to CC0) or

— CC0, CC1, CC2, CC3, or CC4 (i.e., 5G TF and 5G NR has up 
to seven component carrier choices).

—  Then PCI All (select PCIs)

— All (Not applicable for Spectrum. When All is specified, for 
Spectrum, PCI is set to single). For all other display types, 
the results for any cells with any PCI are displayed (default 
= All).

— Single displays the results for the selected PCI.

The Spectrum view in 5G TF uses a center frequency that is +2.6 MHz 
offset from the carrier’s center frequency. This is done so that FieldFox can 
capture the necessary xPBCH (physical broadcast channel) information to 
demodulate the signal. Be aware that all of the instrument’s displayed 
numbers are rounded to three significant digits (e.g., 5.0026 GHz is 
displayed as 5.003 GHz).
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Repeat process as needed for additional Windows, Data, and CC settings.

5. Optional: Press Sweep 3 and modify/select items:

— Single

— Continuous OFF ON to ON (default)

— Restart

— Strip Points

— Log Meas Status OFF ON

6. Press Trigger Settings

— Freerun (default) or

— External sets a sweep to trigger on an external TTL signal at the 
External Trigger connector. External trigger is available only after 
initial setting. 

— Periodic sets a trigger that repeats at the period rate entered. 
Periodic trigger's phase can be altered by the Offset value.

7. Optional: Press Meas Setup 4 – LTE FDD, LTE TDD, and 5G TF softkeys are 
only required if scan does not display data. 

— LTE FDD and LTE TDD: Press FreqError Th and change to 5 kHz – 
Wait a few seconds until Table populates or set FreqLock Range to 
Extended.

— Then change back to the desired Frequency Error 
Threshold for your measurement. 

— 5G TF: Press SyncCorr Th and change to 0% – wait a few seconds 
until the Table populates and

— Then change back to the desired Sync Correlation 
Threshold for your measurement. 

— 5G NR: Press FreqError Th and change to 7.5 kHz (default)– Wait a 
few seconds until the Table populates or set SCS, SSB Case, or 
Lmax values. 

— Then press More 

——Then SSB Offset Detection opens the SSB offset 
detection softkey menu):

IMPORTANT! When you select multiple CCs (e.g., CC0, CC1, etcetera) and 
record data, you may actually see other cell signals that do not have 
sufficient power to be displayed, but are still detectable. When you select 
ALL, multiple component carriers are selected, but the results of the 
component carrier (CC) with the highest power is displayed. Refer to 
Figure 13-13 on page 366.
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 Then SSB Offset Detection OFF ON 
Enables/disables the SSB Offset Detection 
(Default = OFF). Determines whether the 
measurement is a normal 5G NR measurement or 
an SSB offset measurement. When disabled, the 
measurement will be a normal 5G NR 
measurement. When enabled, the measurement 
will be an SSB offset measurement.

 Then Bandwidth Sets the FR1 and FR2 
bandwidth. FR1/FR2 active bandwidths are 
coupled to the currently selected SCS value. 

 Then Snap Sync Raster When enabled this 
softkey, determines whether or not the results 
from the SSB offset detection measurement are 
automatically snapped to the synchronization 
raster. When the results are snapped to the 
synchronization raster, the ARFCN / GSCN is 
included in the results. 

Then Results -> Setup opens a menu of SSB 
offset copy-related softkeys of to copy the 
selected SSB offset, and SSB Freq to the selected 
component carrier(s) center frequency.

Then choose: 

——Then LTE Coexistence (NSA / DSS) opens the LTE 
Coexistence softkey menu):

 Then NSA / DSS OFF ON Enables/disables the 
NSA /DSS feature and softkeys (Default = OFF). 
Determines whether the measurement is a 
normal 5G NR measurement or an NSA / DSS 
measurement. When disabled, the measurement 
will be a normal 5G NR measurement. When 
enabled, the measurement will be an LTE 
Coexistence measurement.

CC ALL  
(Default = All)

Selects the active SSB offset 
component carriers for copying SSB 
offset or SSB frequency information 
(CC0 to CC7 or All).

Copy SSB 
Offset

Copies the SSB offset result values to 
the selected component carriers 
(CCs).

Copy SSB Freq Copies the SSB frequency result 
values to the selected component 
carriers (CCs).
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Then LTE Duplex Mode FDD TDD Selects the type 
of LTE signal to be used in the LTE Coexistence 
measurement (LTE FDD or TDD). Default = FDD. 

Then CC All Selects the which component 
carriers are used in the measurement (CC0 to 
CC7). Default = All. 

Then Display Type Table Bar Selects how the 
data is displayed (Table or Bar). Default = All. 

Then LTE Setup opens a menu of softkey menu 
choices to set the 5G NR signal values 
(Freq/Dist, Meas Setup, and Trace. For details on 
these softkey menus, refer to the hardkey 
descriptions and their related softkeys in steps 5, 
6, 7, and 11.

Then 5G NR Setup opens a menu of softkey 
menu choices to set the LTE signal values 
(Freq/Dist, Meas Setup, and Trace. For details on 
these softkey menus, refer to the hardkey 
descriptions and their related softkeys in steps 5, 
6, 7, and 11.

——Then EMF opens the EMF softkey menu (See 
also, “How to Set Up EMF Mode Settings 
(Requires EMF (Option 358) and 5G NR (Option 
378))” on page 387):

 Then EMF Meas OFF ON Enables/disables EMF 
measurements (Default = OFF).

 Then EMF Triaxial [Sum All] ON Sets the axis (X, 
Y, or Z) or axes (Sum All) of the Triaxial antenna 
to be used in the EMF measurements (Default = 
Sum All).

 Then EMF Units dBuV/m Sets the EMF units 
(dBuV/m)

——Then Advanced opens the advanced softkey 
menu:

Then Capture Length Sets the length in frames 
for the current scan 4, 8, 16 24, 32, or 40 frames 
are the choices (Default = 4 Frames). 

Then Drive Speed Sets the scan rate. Choices are 
Low, Medium, or High (Default = Low). Use 
slower speeds higher-mobility cases to track 
faster changes in channel.
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Then Phase Comp OFF ON Enables/disables the 
phase compensation to compensate for phase 
differences between symbols during the 
upconversion or downconversion.

Then SS Meas DMRS OFF ON Enables/disables 
the current synchronized signal’s demodulation 
reference signal.

8. Press Trace 6 

— And, set up your Windows and component carriers (CCs) as 
indicated in “How to Set Up Over–the–Air (OTA) Mode Settings” on 
page 353. 

9. Press System 

— Press GNSS > GNSS Receiver > Internal > Esc

— Press System > FrequencyRef > Internal > Back

Step 2: Select Trace Type

Select one of the following display orientations:

— Press Trace 6—choose:

— Table or

— Bar Chart or

— Spectrum or

— Strip Chart or

IMPORTANT! It is not sufficient to be locked to the GNSS satellite, the 
frequency reference must be locked to GPS.
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Figure 13-20 Table and Bar Chart Display Types – LTE FDD – (LTE TDD is similar)

Figure 13-21 Spectrum and Strip Chart Display Type – 5G TF 
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Figure 13-22 Spectrum and Table Type (SSB Offset Detection Softkeys) – 5G NR 

Step 3. Modify Scale and the Display Color Bar Settings

To assign colors to low and high power values:

1. Press Scale/Amptd > Red Limit to set high power values and to set the 
color.

2. Press Blue Limit to set low power values and to set the color.

3. And, then press System > Display > Display Colors, to set Indoor, Outdoor, 
or other display colors. See also Chapter 30, “System Settings.”

If Freq then: Meas Setup > More > SSB Offset Detection

If Chan then: Meas Setup > More 

Freq/Dist > Freq Mode > Chan or Freq
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Figure 13-23 Outdoor Display Colors

Figure 13-24 Indoor Display Colors

Step 4: Enable Data Logging and Playback the Results

Spectrum and Strip Chart information is not recorded. Only the Table and 
Bar Chart data are saved. See “How to Record a Data Log Procedure” on 
page 395. 
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Data Logging creates a record of your data with a timestamp and GPS stamp 
(refer to “GNSS (GPS+) and GPS” on page 756). GPS must be enabled for the 
log results to include a GPS stamp or use Preferences to enable the timestamp. 
Refer to Chapter 30, “System Settings.”

Features

— Log files contain cell results for different component carriers (CCs) 
including timestamps and/or distance stamps.

— Timestamps are included in log files with or without GPS.

— GPS must be enabled for log altitude results.

See also “GNSS (GPS+) and GPS” on page 756.

— Data results can be logged

— Data results can be saved to a *.CSV or *.KML file. Refer to “Save 5: Save 
the Log Results:” on page 384.

— User specifies how often results are stored. 

— Time: Store results every “n” seconds 

— Altitude: Store results every “n” meters. GPS must be enabled to 
store results by altitude.

Procedure

1. Press Trace 6 > More > Data Logging to view the Data Logging softkeys 
and set the Record Settings, Record Save/Recall, and Indoor Map Data 
Logging 

— Record (Outdoor Logging) or

— Play (If you have previously stored data recordings.)

a. Outdoor Mapping only: To set the Record Settings—choose:

— Meas Interval

— Interval Time

— Time Interval or

— Distance Interval 

b. Then press Record Save/Recall 

— Then File Folder Default System

— Default – Sets the default User Folder path: 

——List files (*.csv and *.kml) are save-recalled 
to: 
"[CurrentDevice]:\RecordPlayback\
OTA\"
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——Data Log-Play files are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\
OTA\" 
 
Or

— System – Sets the User Folder to the user defined 
system folder path/name: 

——List files are save to-from 
"CurrentDevice\<UserSelectedFolde
r>\" 

——Data Log-Play files are save-recalled to: 
"CurrentDevice\<UserSelectedFolde
r>\"

Refer to “File Management” on page 777. 

— Then File Type

— KML (default) or

— CSV

— Then Save Log File.

or

— Then Recall Log File.

— Auto Save OFF ON - (default = OFF) Press to toggle to ON to 
enable Auto Save.

— Then Back

c. Optional: Press Indoor Map Data Logging then 

—  Record Indoor Data or Recall Indoor Log File. Refer to “How 
to Use Data Logging (OTA Options 370, 372, 377, and 378)” 
on page 394.

Learn more, refer to Chapter 16 Mapping and “Option 352 
Indoor Maps Setup Procedure” on page 474 and “Setting up 
Data Logging” on page 486.

2. Press Back to return to previous menu.

3. Outdoor Mapping: Press Record to begin a new recording and then

— Then Maps To enable map view and related features (e.g., Data 
Selection, Red/Blue Limits, Labels & Icons, Zoom). 

—  View Map OFF ON Displays the current GPS location.
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— Data Selection Opens a softkey menu to set the active 
data channel, sort type, and sort order. See also previous 
step 8 in “How to Set Up Over–the–Air (OTA) Mode 
Settings” on page 353.

— Red/Blue Limits Opens a softkey menu to assign power 
values to the red (high power limits) and blue (low power 
limits) heat map display limits (defaults: Red Limit = 
–20 dBm, Blue limit = –90 dBm).

— Labels & Icons Opens a softkey menu to enable/disable 
map data point labels and icon types.

—  Save Image (PNG) Saves the current displayed map to a 
*.png file (default filename is “Pilgrimage”).

4. When done press Stop. The log file is automatically saved to the defined 
Device Type and File Type (i.e., when you press Done). 

Else, edit the file name, and then press Done.

See also, Chapter 16 Mapping and “Setting up Data Logging” on 
page 486.

5. Press Back

Playing a Data Log and Viewing the Data

To play the log results: 

1. Press Record Save/Recall > Recall Log File

And, use the Use the RPG or the  arrow keys to highlight the file to be 
played.

2. Press Recall File > Back > Play

3. Optional: Press Scale/Ampltd 

Then choose:

Labels OFF ON Enables/Disables map data point labels. When enabled, 
a label is displayed for every map data point (e.g., “Data 
1”). When disabled, labels are not displayed for the map 
data points.

Icons  
Flag Point Line

Sets the type of icon that is used to display a map’s data 
points (default = Flag).

Learn more about file settings, refer to Chapter 32, “File Management.”
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— Optional (Bar Chart and Spectrum only): To adjust the following, use 

the RPG (fine adjust) or the  arrow keys (coarse adjust) to 
change the color bar.

— Autoscale to have the FieldFox optimize the scale for the 
current measurement.

— Ref Pos to change the reference line position (0 to 10).

— Scale to change the reference line position (0.01 to 
100 dB).

— Ref Level to change the top reference position in the Bar 
Chart, Strip Chart, and Spectrum. 

— Red Limit to change the red color high power value (dBm). 
Bar chart only.

— Blue Limit to change the blue color low power value 
(dBm). Bar chart only.

4. Press Stop to exit the log playing.

To pause the log play:

1. Press Pause Resume to pause or resume the log playing.

2. Press Stop to exit the log playing.

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486.

Save 5: Save the Log Results:

Two file types are supported for save or recall log results:

— KML file format

— Files stored in this format can be imported into 3rd party applications 
like Google Earth or Google Maps.

— CSV file format. Files stored into this format can be imported into 
spreadsheet applications.
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Procedure:

1. Press When done press Stop. Immediately stops recording and a “Save 
the Log File” menu opens to rename and save your data log file.

2. In the “Save the log file” window that opens, optionally change the name 
of the default file displayed, else press Done. 

Saves the file and exits the current softkey menu.

3. ‘To begin recording: Press Record 

4. When done press Stop. The file is automatically saved to the defined 
Device Type and File Type.

Else, edit the file name and folder path, under Record Save/Recall > File 
Folder where the file results will be stored.

5. Press Back 

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486.

Step 6: Import and Play back KML Files into 3rd Party Software 
(Example: Google Earth with Animation Tool)

Features

Use the Playback Slider to replay measurement results. See also Google Maps 
and or Google Earth’s help.

— Open the FieldFox *.KML file in Google Earth. Time Slider appears in upper 
left of the map.

— Manual Mode – Move the time slider cursor to see color-coded icons 
pop-up according to the timestamp.

— Loop mode has a Fast-Slow Replay Option.

Record-Play files are saved to:

— If File Folder is set to Default then Record-Play files are 
save-recalled to: "[CurrentDevice]\RecordPlayback\[Current 
mode]\"

— If File Folders are set to System, then Record-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   

Learn more about file settings, refer to Chapter 32, “File Management.”
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— Click on each color coded balloon to see the table of measurement results 
for that location.

Figure 13-25 Importing a KML File Into Google Earth
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How to Set Up EMF Mode Settings (Requires EMF (Option 358) and 5G NR 
(Option 378))

EMF mode measures signals at the SA RF Input Port 2 connector. 

EMF mode requires the FieldFox to have SA mode (Option 233 on combination 
analyzers), or 5G NR Option 378), and CPU2 installed. 

Recommended, but not required, preamplifier (Option 235) to improve receiver 
sensitivity.

With Option 358 (EMF), network designers can measure and verity the RF 
exposure compliance as required by each country. 

This section reviews the steps in setting up an EMF measurement, using a USB 
antenna. If you are not familiar with this process or would like more 
information, refer to Chapter 15, “USB Antennas – (Full Capability Requires 
EMF Option 358, and either SA mode (Option 233 Mixed Analyzers) or 
OTA—5G NR / 5G NR EVM Conducted Option 378).”

This section consists of:

— “EMF Features”

— “EMF Setup Procedure”

EMF Features

EMF has the following features:

EMF Measurement Results:

— Measure and display corrected field strength in RMS average power

— Antenna control over X, Y, and Z antenna factors downloaded via USB

— Pass/Fail limit testing supported

— External PC not required

If OTA or SA mode does not detect an EMF Option 358 license, then the 
EMF application and the USB antenna’s axes must be set up manually. This 
use model is not recommended or supported by Keysight. 

The USB antenna’s cable loss is not included, in the antenna’s correction 
factors. For an accurate EMF measurement, the cable loss values should 
be accounted for. Refer to “EMF Setup Procedure” on page 229.

IMPORTANT! The USB triaxial antenna—or equivalent—is required for EMF 
measurements. Refer to Chapter 15, “USB Antennas – (Full Capability 
Requires EMF Option 358, and either SA mode (Option 233 Mixed 
Analyzers) or OTA—5G NR / 5G NR EVM Conducted Option 378).”
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EMF uses the following data formats:

— Field Strength units:

— dBµV/m – For use with E-field signals

— dBµA/m – For use with H-field signals

— dBG – dB Gauss

— dBpT - dB Tesla                          
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Figure 13-26 Example of EMF with Triaxial Antenna
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EMF Setup Procedure

1. Setup the FieldFox Spectrum Analyzer for a Channel Power measurement. 

a. Press Mode > OTA > 

Press Measure 1 then one of the following:

— LTE FDD 

— LTE TDD 

— 5G TF 

— 5G NR 

— 5G NR EVM Conducted 

2. Connect the USB antenna to the SA RF Input, port 2 and to a FieldFox USB 
port. See also, Chapter 15, “USB Antennas – (Full Capability Requires EMF 
Option 358, and either SA mode (Option 233 Mixed Analyzers) or OTA—5G 
NR / 5G NR EVM Conducted Option 378)” and to Chapter Figure 15-1, 
“FieldFox With USB Antenna”.

3. Importing and selecting X/Y/Z antenna factors:

Press System > Utilities > USB Antennas 

When the USB antenna correction factors are imported, EMF (Option 358) 
couples many settings to ease setting up the EMF measurement (e.g., 
Apply Corrections is enabled, all X, Y, and Z antenna axes are enabled, and 
Amp Corr Select is set to TriAxial XYZ).

If necessary, this step can be skipped and done after the USB antenna is 
set up. 

Only Agos Advanced Technologies SDIA–6000 Triaxial Isotropic USB 
antenna is compatible with EMF (Option 358). 



Keysight N9938-90006 User’s Guide                                                                                                                      391

Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 371, 5G TF 
Option 377, 5G NR / 5G NR EVM Conducted Option 378
How to Set Up EMF Mode Settings (Requires EMF (Option 358) and 5G NR (Option 
378))

— Press Import Antenna to import the antenna factors from the 
antenna’s memory over the USB connection (this may take 5 
seconds or so and vary with the Triaxial antenna). 

— Press USB Antenna then: 

— Then USB Antenna [Tri Axial] verify Tri Axial (default) is 
selected. 

— Optional: Press Antenna Axis the antenna axis should be 
set to Auto for default operation. When AUTO is selected 
the application (e.g., Channel Power or OTA) controls the 
axes and switches themas needed. With the AUTO setting, 
all antenna elements (X, Y, and Z) are OFF. 

— Press Back > Back to exit the USB Antenna softkey menu.

4. Modifying the EMF settings:

Press Meas Setup 4 

— Then More > EMF then

—  EMF Meas OFF ON disable/enable the EMF measurement.

—  EMF Units choose dBuV/m (default) or V/m.

—  Back to exit to the previous softkey menu.

For more details on editing the USB antenna, refer to Chapter 15, “USB 
Antennas – (Full Capability Requires EMF Option 358, and either SA mode 
(Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM Conducted 
Option 378).”

5. Once you have finished with your USB antenna setup:

a. Press Sweep 3 > Single > Restart 

The FieldFox should display in order Analyzing CCO X-Axis, 
Analyzing CCO Y-Axis, and  Analyzing CCO X-Axis and then 
do a square root sum of the X, Y, and Z measurement values in the 
FieldFox. Multi-cell measurements are done similarly for each cell 
ID (i.e., Cell CC0 to CCn). Refer to Figure 13-27 on page 392.

b. Verify OTA 5G NR X, Y, and Z Axes Factors in SA Mode (e.g., 3.5 GHz 
signal)). Refer to Figure 13-28 on page 393.

If the antenna factor import is successful, the FieldFox displays: 
"Success: Antenna Factors Imported: Tri-Ax Antenna ID: 
->[R] Antenna ID: SDIA-6000-1006 ->[]". The last 4-digits will vary 
for each antenna (i.e., “1006” is changeable).

If the FieldFox displays this error Error: USB antenna Error: Not 
found or Unable to communicate with antenna. Ensure it is 
connected. is displayed, verify the USB antenna is connected correctly. 
Refer to “Troubleshooting” on page 399.
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i. Press Mode > SA then

ii. Press Freq/Dist > Center > 3.5 GHz then

iii. Press Freq Span > 120 GHz then

iv. Press System > Utilities > USB Antennas then

v. Press Antenna Axis X to view the X axis

vi. Press Antenna Axis Y to view the Y axis and

vii.Press Antenna Axis Z to view the Z axis

6. Verify EMF in 5G NR Mode:

a. Press Mode > OTA > 5G NR then

b. Press Meas Setup 4 > More > EMF > dBuV/m

(i.e., For this example. Other units are selectable.) 

For more information:

— Refer to Figure 13-27 on page 392.

— See also “GNSS (GPS+) and GPS” on page 756.

Figure 13-27 Example Summing of Triaxial Values
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Figure 13-28 Using SA Mode (Example) to Verify the Triaxial Values – Axis Y is Displayed
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How to Use Data Logging (OTA Options 370, 372, 377, and 378) 

Data Logging allows you to record OTA trace data and play them back at a 
later time. Use this feature to monitor table data activity over a period of time.

Data logs can be saved to the FieldFox Internal memory, an SD Card, or a USB 
flash drive.

This section assumes you have already completed the initial setup and have 
either an LTE FDD, LTE TDD cell, or 5G TF setup displayed on the FieldFox. 

Screen Annotation

During a record or playback session, the following is displayed in the 
top-center area of the screen:

—  Rec: 55/55 2018-12-31 03:26:11 PM    

where:

— 55/55 is the current and total trace number: currently trace is 55 of 55 total 
scans.

— 2018-12-3103:26:11 PM is the date and time of recording.

— The name of a recording can be changed using Manage Sessions. Learn 
more in “To change Data Logging Configuration settings:” on page 396.

See also Chapter 30, “System Settings.” 

Spectrum and Strip Chart information is not recorded. Only the Table data 
is saved. See “How to Record a Data Log Procedure” on page 395. 

While the Record/Play softkey is displayed in all measurements, 
Record/Play only logs and plays back Table and Bar Chart data. See “How 
to Record a Data Log Procedure” on page 395. 

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\OTA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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When GPS is enabled, GPS R is indicated at the bottom of the FieldFox 
display. Learn more in “GNSS (GPS+) and GPS” on page 756.

How to Record a Data Log Procedure

— Press Trace 6 > More > Data Logging >

— Then for Outdoor Logging, press Record

 is displayed in the left of screen graticules.

During recording, choose from the following: 

— Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue recording. See 
also “How to Play a Data Log” on page 397.

— Stop Immediately stops recording and opens a menu to name/rename and 
save your data log. For more, refer to “How to use the FieldFox labeler ” on 
page 780.

— Record Settings (Outdoor Mapping only) opens a softkey menu to enable 
you change your record related settings. For more, refer to “To change Data 
Logging Configuration settings:” on page 396.

— Recall Save/Recall opens a softkey menu to enable you to save and recall 
your data log and related file settings. For more, refer to “To change Data 
Logging Configuration settings:” on page 396.

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486

If Data Logging or Playback is not occurring when you think it should, 
check the following:

— Is the sweep in HOLD? (upper-left annotation), or check the Sweep 
menu for Continuous set to OFF.

— Is Recording or Playback Paused? (mid-left annotation)

— Is the Data Logging or Playback Interval set too long? (Configuration 
settings.)

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\OTA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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To change Data Logging Configuration settings:

1. Press Trace 6 > More > Data Logging

2. Then choose from the following:

a. To set the Record Settings (Outdoor Mapping only)—choose:

— Meas Interval OFF ON Enable to make the measurement 
interval softkeys active (default = OFF).

— Interval Type Choose: Time or Distance

— If applicable, Time Interval Enter time in seconds (1s to 
3.6 ks) or

— If applicable, Distance Interval Enter time in miters (10m to 
10 km)

b. To set the Record Save/Recall 

— File Folder Default System

— Default – Sets the default User Folder path: 

——List files (*.csv and *.kml) are save-recalled 
to: 
"[CurrentDevice]:\RecordPlayback\
CS\"

——Data Log-Play files are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\
CS\" 
 
Or

— System – Sets the User Folder to the user defined 
system folder path/name: 

——List files are save to-from 
"CurrentDevice\<UserSelectedFolde
r>\" 

——Data Log-Play files are save-recalled to: 
"CurrentDevice\<UserSelectedFolde
r>\"

Refer to “File Management” on page 777. 

— Then File Type

— KML (default) or

— CSV

— Then Save Log File.

or 
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— Then Recall Log File.

— Auto Save (default = OFF) 

— Then Back

c. Optional: Press Indoor Map Data Logging then 

—  Record Indoor Data or Recall Indoor Log File. Learn more, 
refer to Chapter 16 Mapping and “Option 352 Indoor Maps 
Setup Procedure” on page 474.

— Then choose Navigate OFF ON, Data Selection, Zoom, Pan, 
Record Data, More

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486. See also, Chapter 32, “File Management.”

How to Play a Data Log

— Press Trace 6

— If the session is already open, skip the following step. Otherwise: 

— Then More > Data Logging > Playback

— Then Recall Log File and select a file

——Then Recall File 

— Then Play to playback your Table data.

 is displayed in the left of screen graticules during playback. When the 
end of the recording is reached, playback begins again at trace 1 and 
continues to loop indefinitely. 

During playback, choose from the following: 

— Pause Resume Temporarily halts playback. Then choose from the following:

— Pause Resume   Press to continue playing. 

— Stop Immediately stops playback. Then choose from the following:

— Play Start playback from trace 1.

— Recall Log File Opens a list of stored data files.

Select a file to playback. 

— Recall File 

If these are large recordings on a device, it could take several seconds for 
the FieldFox to display the list.
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— Back 

— PlayTrace ID Auto resume playing by selecting a trace number to 
playback between 1 and the record length (MAXimum = 2000 
(multiple CC) and 1000 (single CC)).

Other Features Available
— Alignments - For information on using alignments, refer to the SA chapter’s 

section, “Alignments” on page 201.

— Scale Settings – For information on using scale settings, refer to the Data 
Analysis chapter’s section, “All about Scale Settings” on page 722 (not all 
settings apply to OTA Options 370 and 377).

— External Gain - Refer to refer to the SA chapter’s section, “External Gain” 
on page 158.
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Troubleshooting
If your OTA setup is not behaving as expected:

— Verify setup is correct by referring to “How to Set Up Over–the–Air (OTA) 
Mode Settings” on page 353.

— Attenuator set to 0 dB

— Preamplifier set to ON

— Correct Band, Channel, and Center Frequency entered

— GNSS set to Internal

— Frequency Ref set to GPS

— For LTE FDD and LTE TDD: Verify that the Frequency Error Threshold 
(dB)—(FreqError Th) value is large enough or not too large

— For LTE FDD and LTE TDD: Verify that the Extend Freq Lock value is 
enabled and then adjust settings to improve your measurement. For 
5G TF: Check that the Frequency Correction Threshold value (%)— 
(Sync Corr Th %) is small enough or not too large.

— ADC errors: Use Scale/Amptd > Range to adjust the absolute power 
level (dBm). 

For some data views, you need to press More to view the Range 
softkey.

— No data displayed: Press Meas Setup 4 – Only required if scan does 
not display data. 

——LTE FDD and LTE TDD: Press FreqError Th and change to 5 kHz 
– Wait a few seconds until table populates or set FreqLock 
Range to Extended. 

——Then change back to the desired Frequency Error 
Threshold for your measurement. 

——5G TF: Press SyncCorr Th and change to 0% – wait a few 
seconds until the Table populates and

——Then change back to the desired Sync Correlation 
Threshold for your measurement. 

 



 400                                                                                                                     Keysight N9938-90006 User’s Guide

Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 371, 5G TF 
Option 377, 5G NR / 5G NR EVM Conducted Option 378
Glossary (OTA)

Glossary (OTA)
This section provides a description of some of the terms used in the FieldFox’s 
OTA mode.

Table 13-1 OTA Abbreviations and Descriptions

Abbreviation Description

LTE FDD &  
LTE TDD

Center 
Frequency

The specified LTE FDD carrier center frequency.

C/S/G Physical Cell information (PCI), or Cell ID – C/ S /G

Cell ID (PCI) Physical cell ID – The Primary Sync Signal and Secondary Sync Signal largely define the PCI. PCI is also 
referred to sometimes as Cell ID.

PSS PSS (dBm) is the Primary Synchronization signal for an LTE downlink frame.

RSRP Reference Symbol Received Power (dBm)

RSRQ Reference Signal Received Quality (dBm)

RSSI Reference Signal Strength Indicator (dBm)

SINR Signal to Interference & Noise Ratio (dB)

SSS SSS is the Secondary Synchronization signal for an LTE downlink frame (dBm).

Freq Error Th LTE FDD and LTE TDD Frequency Error Threshold (Hz). Any data that is does not meet the defined 
Frequency Error value, is not displayed. 

5G TF

Center 
Frequency

The specified 5G TF carrier center frequency.

Cell ID (PCI) Physical cell ID – The Primary Sync Signal and Secondary Sync Signal largely define the PCI. PCI is also 
referred to sometimes as Cell ID.

Power (Channel Power) (dBm)

PSS PSS (dBm) is the Primary Synchronization signal for an LTE downlink frame.

SSS SSS is the Secondary Synchronization signal for an 5G TF downlink frame (dBm).

SyncCorr Th 5G TF Synchronization Correlation Threshold (%). Any data with errors that are less than the 
Synchronization Correlation Threshold (%) are not displayed.

5G NR

Center 
Frequency

The specified 5G NR carrier center frequency.
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Cell ID (PCI 
(C-S-G))

Physical cell ID – The Primary Sync Signal and Secondary Sync Signal largely define the PCI. PCI is also 
referred to sometimes as Cell ID.

SSB Index 
(dBm)

Synchronization Signal Block Index

SS-RSRP 
/RSRP (dBm)

Synchronization Signal Reference Signal Received Power – The linear average over the power 
contributions (in [W]) of the resource elements that carry cell-specific reference signals within the 
considered measurement frequency bandwidth.

For RSRP determination the cell-specific reference signals R0 according TS 36.211 [3] shall be used. If 
the UE can reliably detect that R1 is available it may use R1 in addition to R0 to determine RSRP.

The reference point for the RSRP shall be the antenna connector of the UE.

SS-RSRQ 
/RSRQ (dB)

Synchronization Signal Reference Signal Received Quality

RSSI (dBm) Received Signal Strength Indicator measures the average received power found only in OFDM symbols 
that for an antenna port that are part of the measurement bandwidth over N resource blocks.

SS-SINR /SINR 
(dB)

Synchronization Signal-to-Noise and Interference Ratio – Reference Signal to interference and noise 
ratio – indicates the values measured over the same bandwidth and normalized to one subcarrier 
bandwidth.

PSS (dBm) PSS (dBm) is the Primary Synchronization signal for a 5G NR frame.

SSS (dBm) SSS is the Secondary Synchronization signal for a 5G NR downlink frame (dBm).

DMRS (dBm) Physical Broadcast Channel Demodulation Reference Signal (dBm). Used by 5G NR receiver to produce 
channel estimates for demodulation of associated physical channel. 

Freq Error (Hz) Frequency error is the difference of the transmitted signal quality from the ideal (Hz).

Chan Freq Chan Freq is the channel frequency, when SSB Offset Detection has been enabled.

SSB Offset Determines whether the measurement is a normal 5G NR measurement or an SSB offset measurement. 
When disabled, the measurement will be a normal 5G NR measurement; When enabled, the 
measurement will be an SSB offset measurement.

The purpose of the SSB offset measurement is to measure the offset of the SSB from the current Center 
Frequency. Once you measure the SSB offset, you can use the results to update the Offset Frequency 
and make a normal 5G NR measurement.

SSB Freq This is the SSB center frequency (the offset of the SSB from the channel center frequency). 

ARFCN/GSCN The synchronization raster ARFCN / GSCN associated with the SSB frequency (only displayed when Snap 
Sync Raster is enable).

Time Offset (us) Time offset is defined as the time difference between the NR frame boundary and the beginning of the 
capture. And, is meant to be used with a “frame trigger” (GPS synced periodic trigger when measuring 
base station OTA signals). The frame boundary closest to the beginning of the capture is always used for 
the measurement (NR signals are periodic; so a single capture contains multiple frame boundaries).

Table 13-1 OTA Abbreviations and Descriptions

Abbreviation Description
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5G NR EMF 
Conducted

Center 
Frequency

The specified 5G NR carrier center frequency.

Cell ID (PCI) Physical cell ID – The Primary Sync Signal and Secondary Sync Signal largely define the PCI. PCI is also 
referred to sometimes as Cell ID.

SSB 
Numerology

Synchronization Signal Block (SSB) 

ScsCommon Subcarrier spacing common (ScsCommon)

SSB Case Synchronization Signal Block Case (SSB Case) 

SSB Lmax Synchronization Signal Block (SSB Lmax) is the maximum number of SSBs within a SSB. 

SSB Periodicity 
(ms)

Synchronization Signal Block Periodicity (SSB Periodicity (ms)) 

SSB RB Offset Synchronization Signal Block Resource Block Offset (SB RB Offset)

SSB SC Offset Synchronization Signal Block (SSB SC Offset) 

SSB Delta 
Center (kHz)

Synchronization Signal Block Delta Center (SSB Delta Center (kHz)) 

Sync Corr (%) Synchronization Correlation (Sync Corr (%))

Channel Power 
(dBm)

Channel power

Freq Error (Hz) Frequency error (Hz)

Time Offset 
(ms)

Time Offset (ms) is one of the required EVM calculations.

PSS EVM 
(%rms)

PSS EVM (%rms) is the Primary Synchronization signal for 5G NR EVM.

SSS EVM 
(%rms)

SSS is the Secondary Synchronization signal for a 5G NR EVM (%rms).

PBCH DMRS 
EVM (%rms)

Physical Broadcast Channel Demodulation Reference Signal for EVM (%rms).

Composite 
EVM (%rms)

Composite EVM (%rms) analyzes the output of the combined signal from multiple transmit antennas.

SS-RSRP 
(dBm)

Synchronization signal reference signal received power (SS -RSRP) is defined as the linear average over 
the power contributions (in [W]) of the resource elements that carry secondary synchronization signals 
(SS).

Table 13-1 OTA Abbreviations and Descriptions

Abbreviation Description
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SS-RSRQ (dB) Synchronization signal reference signal received quality (SS -RSRQ) is defined as the ratio of N x 
SS-RSRP/NR carrier RSSI. Here N refers to number of resource blocks in NR carrier RSSI measurement 
Bandwidth. The measurements in N (Numerator) and D (Denominator) are made over the same set of 
resource blocks (RBs)

RSSI (dBm) Received Signal Strength Indicator measures the average received power found only in OFDM symbols 
that for an antenna port that are part of the measurement bandwidth over N resource blocks.

Table 13-1 OTA Abbreviations and Descriptions

Abbreviation Description
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Keysight Handheld Analyzers
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14 5G Rapid Prototype Phased Array Antenna – Option 360

Option 360 measures signals at the SA RF Input Port 2 connector. 

Option 360 requires the FieldFox to have SA mode (Option 233 on combination 
analyzers), and GPS (Option 307) installed. 

Recommended, but not required, preamplifier (Option 235) to improve receiver 
sensitivity.

Keysight's FieldFox handheld analyzer (with Option 360) combined with a Ball 
Aerospace / Anokiwave 64-element antenna array provides a unique, portable 
solution for measuring and analyzing the 5G air interface in the field.

— Reduce measurement complexity with integrated RF probe and phased 
array solution to capture energy radiated from gNB 

— Calibrated metrology milli-meter wave phased array antenna simulates 5G 
UE antenna performance

— Troubleshoot the 5G radio access network with 3D test coverage and path 
loss measurements utilizing the built-in CW generator

— Phased array performance verification showing bore sight, polar antenna 
pattern with compass, heat map and beam sweep to map display views

In this Chapter

IMPORTANT! 

85571A-028 (28 GHz 5G Phased Array Antenna) accessories not suitable 
for use in wet locations.

PAA mode is compatible with the frequency converter heads, but cannot 
apply or edit the frequency head corrections. Refer to “Utilities” on 
page 732.

The FieldFox can be used with an OML frequency extender. Refer to 
“Utilities” on page 732, the B Series FieldFox Configuration Guide 
5992-3701EN, and to “Contacting Keysight” on page 5.

“Using the Phased Array Antenna (Option 360)” on page 407

“About Phased Array Antenna Measurements” on page 408
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See Also

— “Phased Array Antenna Features (Option 360)” on page 408

“How to Set Up Phased Array Antenna Settings” on page 417

— “Option 360 Setup Procedure” on page 417

— “How to Define a Set Up a Scan and Use Option 360” on page 429

“How to Use Data Logging/Playback (Option 360)” on page 438

— “Screen Annotation” on page 438

— “How to Record a Data Log” on page 440

— “To change Data Logging Configuration settings:” on page 440

— “How to Playback a Data Log” on page 441

“Using Mapping” on page 442 

“Other Features Available” on page 442

— Alignments (SA chapter) – “Alignments” on page 201

— External Gain (SA chapter) – “External Gain” on page 158

— Field Strength Corrections (SA) – “How to select and edit corrections 
for Field Strength measurements” on page 161

— Scale Settings (Data Analysis) – “All about Scale Settings” on page 722

“Troubleshooting” on page 443

“Why and When to Calibrate” on page 126

Chapter 16, “Indoor and Outdoor Mapping – Option 
352 (Requires Spectrum Analyzer Mode (Option 233), 
and GPS Receiver (Option 307)).”

Chapter 30, “System Settings.” (Changing display colors)

Chapter 32, “File Management.”
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Using the Phased Array Antenna (Option 360)
Option 360 enables you to do the following:

Measure and display phased array antenna elevation and azimuth 

Four Display Types:

— Bore-Site

— Heat Map

— Polar Antenna

— Park Antenna

— Polar with Image Overlay

Color Coded Display Types:

— Specify high and low power with 
color bars 

Azimuth and Elevation:

— 8 x 8 phased array antenna — Covers beam sweep –60 to +60 
degrees azimuth, 90-degree 
elevation with 1 degree per step

— Individually factory characterized 
elements, magnitude and phase

Data Logging GPS stamped data measurements

— Define measurement interval by time 
or distance

— Show results in TableChart

— Display files (KML) on Google Maps 
or Google Earth
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About Phased Array Antenna Measurements

Some measurement parameters are auto-coupled and are not user-settable.

Phased Array Antenna Features (Option 360)

Phased array antenna has the following features:

Scan Results:

— 28 GHz operation

— gNB RF parametric test over-the-air in the field

— Measure EIRP (effective isotropic radiated power) 

— Milli-meter wave beam sweep survey with map

— Support for real-time spectrum analysis, transmitter power and spectrum 
emission mask (SEM)

Data Formats:

User can set up and display the following:

— Bore-Sight – Elevation angle is fixed. Scan azimuth –60 degrees to +60 
degrees.

— Heat Map – Scan both elevation and azimuth angle with adjustable color 
“heat” amplitude scale.

— Polar ANT – Scan azimuth angle. Elevation is fixed.

— Park ANT – Polar image overlay load image:                            

— Resize polar coordinates

— Specify alignment angles

— Specify compass true north

— Define antenna direction (azimuth degrees)

IMPORTANT! Option 360 antenna requires a static IP address. If it is 
required to have available an IP address that can be accessed over your 
company’s network, work with your company’s IT team to set up a static IP 
that works over the network.

IMPORTANT! If you forget you N9910X-028 Ball Antenna’s static IP 
address, refer to this link and the Support tab for assistance: 
www.keysight.com/find/fieldfox and then to the Phase Array Antenna 
Support Document.
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Figure 14-1 Example of local point-to-point LAN connection

Tripod not 
included.
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Figure 14-2 Bore-Sight Scan – CW RF

Figure 14-3 Polar Scan with compass displayed
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Figure 14-4 Heat Map (Azimuth vs. Elevation) - Parked Antenna
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Figure 14-5 Heat Map and Undocked Active Entry – Parked Antenna

Scan elevation angles ±90 degrees and azimuth ±60 degrees 
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Figure 14-6 Polar Assign Orientation and Polar with Compass Orientation 
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Figure 14-7 Polar Measurement with Compass with Recalled Image of Indoor Auditorium
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CW vs. Pulsed RF Measurements

Figure 14-8 Bore-Site Measurement with CW RF (Dwell Time=10 ms, Max Hold=OFF)

IMPORTANT! For pulsed RF measurements, increasing the Dwell Time is 
recommended for faster throughput and accurate signal capture in a single 
sweep.
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Figure 14-9 Bore-Site Measurement with Pulsed RF (Dwell Time=10 ms, Max Hold=OFF)

Figure 14-10 Bore-Site Measurement with Pulsed RF (Dwell Time=100 ms, Max Hold=OFF)



Keysight N9938-90006 User’s Guide                                                                                                                   417

5G Rapid Prototype Phased Array Antenna – Option 360
How to Set Up Phased Array Antenna Settings

How to Set Up Phased Array Antenna Settings

This section reviews the steps in setting up an Option 360 measurement. If you 
are not familiar with this process or would like more information, refer to “How 
to Define a Set Up a Scan and Use Option 360”

This section consists of:

— “Option 360 Setup Procedure”

Figure 14-11 Setting Up Option 360 Using Other Modes

Option 360 Setup Procedure 

1. Connect your equipment similar to Figure 14-1 on page 409.

2. Set FieldFox to use static IP address:

Press System 

— Then System Configuration > More > LAN 

a. In the Setting screen, use the  arrows, the rotary knob, 
or numeric keypad to highlight Obtain IP.

b. Press Edit >Obtain IP Static

IMPORTANT! See also, “Alignments” on page 201, in NA mode,Chapter 9, 
“SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers).”
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c. Press Done Edit > Done

3. Selecting phased array antenna mode using the Antenna Wizard:

a. Press Measure.

b. Then Antenna Wizard 

c. Follow the prompts. See Figure 14-12.

Figure 14-12 Antenna Wizard Screen

4. Aligning the antenna’s azimuth and elevation orientation: 

Refer to Figure 14-14 on page 420.

IMPORTANT! The LAN address for first 3 fields must match the Static IP 
address of FieldFox. For example, if the Ball Antenna IP address is 
192.168.1.10, set FieldFox Static IP address to 192.168.1.xx.   “xx” must be 
different number than shown in the last field of the for Ball Antenna. Refer 
to Figure 14-15 on page 427.

IMPORTANT! If you forget you N9910X-028 Ball Antenna’s static IP 
address, refer to this link and the Support tab for assistance: 
www.keysight.com/find/fieldfox and then to the Phase Array Antenna 
Support Document.

Once the connect is correct, the FieldFox’s displayed annotation indicating 
"Check LAN connection. Check IP address." is no longer displayed 
during pinging of the Host IP address.
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Figure 14-13 Site Wide LAN Configurations and Field Measurements Configurations
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Figure 14-14 Site Wide LAN Configurations and Field Measurements Configurations

Azimuth and Elevation Alignment Orientation Diagram
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5. Entering the phased array antenna measurement type:

Refer to “Data Formats:” on page 408.

Select Measure:

— Measure—choose:

— Bore-Sight or

— Heat Map or

— Polar ANT or

— Park ANT

6. Using the table to enter phased array antenna settings, presetting the 
antenna, setting the antenna LAN IP, and clearing the graphics:

Refer to Figure 14-16 on page 428.

Select Meas Setup:

— Antenna Settings—choose:

— Ball Antenna > LAN Address

— Settings–choose:

——Res BW or

——Video BW

——Beam Width

— Array Antenna–choose:

——Center

——Azimuth Ref

——Elevation Ref

— Polar Display >Ref

— Sweep > Dwell Time (Optional. For pulsed RF 
measurements it is recommended that the Dwell Time is 
increased.)

— Sweep > Max Hold (Optional. For pulsed RF 
measurements it is recommended that Max Hold is set to 
OFF when using the Heat Map display. (Default = OFF).)

— Preset Antenna presets the antenna settings factory defaults.

— Ant LAN IP enter the Ball antenna’s LAN IP. First three fields must 
match the FieldFox’s static IP address (default: 192.168.1.10). Refer 
to Figure 14-15 on page 427. 
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— Clear Graphics If applicable, this clears the current displayed PNG 
graphic from the screen.

7. User markers to identify azimuth and elevations settings:

Select Marker –choose:

— Marker 1 2 3 4 5 6 – You can set up to six markers. The OFF, Normal, 
Delta, or Peak softkey is black to indicate the current setting of each 
marker.

— Normal displays a marker.

— Delta displays a marker relative to another active marker.

— Peak displays a marker on the peak point of the displayed trace.

— More – choose.

— Marker Trace – You can set up to four traces.

— Marker Table – Enable or disable the marker table that displays the 
current markers and their values. 

Learn more about markers. Refer to the Chapter 29, “Data Analysis 
Features.”.

See also Figure 14-5 on page 412. 

8.  Enable the Data Logging settings: 

— Press Trace 6 > Data Logging then

— Record (Outdoor Logging) or

— Play (If you have previously stored data recordings.) or

— To set Data Logging—choose:

a. Record Settings (Outdoor Mapping only) – then choose:

— Optional: Then Meas Interval > ON

— Then Interval Type > choose Time or Distance.

— Then, if applicable Time Interval enter time 
interval in seconds. 

Or

— Then, if applicable Distance Interval enter 
distance interval in miters. 

— Then Back

If after making the setting changes in the steps below, no data is 
displayed, refer to “Troubleshooting” on page 443.
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b. Record Save/Recall (If you have previously stored data 
recordings.)

— Save Log File or

— Recall Log File or

— User Folder Def System (Default = Default) or

— File Type (Default = KML) CVS or DREC (DREC is 
only available with Option 360 only)

— Then Auto Save OFF ON (Default = OFF). 

c. Indoor Map Data Logging - then Record Indoor Data or 
Recall Indoor Log File. 

— Then choose Navigate OFF ON, Data Selection, 
Zoom, Pan, Record Data, More

9. Press Back to return to previous menu.

10. If recording, then:

—  Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue 
recording.

— Stop Immediately

— The Save the log file menu opens. Edit the filename and 
press Done to exit menu. See Settings below and “To 
change Data Logging Configuration settings:” on 
page 440.

— To change your file settings or measurement interval. 
Learn more, refer to “To change Data Logging 
Configuration settings:” on page 440.

— (Press Record to begin a new recording.)

Spectrum information is not recorded. Only the TableChart data are saved. 
See “How to Record a Data Log” on page 440. 

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\PAA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   

Learn more about file settings, refer to Chapter 32, “File Management.”.
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— Then Maps To enable map view and related features (e.g., Data 
Selection, Red/Blue Limits, Labels & Icons, Zoom). 

Then choose from the following:

— View Map OFF ON To enable/disable the current map view 
(default = latitude/longitude = 0.00/00. Need GPS to view 
current location (default = OFF).

— Data Selection Opens a softkey menu to set the active 
data channel, sort type, and sort order. 

Learn more, refer to Chapter 16 Mapping and “Setting up 
Data Logging” on page 486. See also, Chapter 32, “File 
Management.”

— Red/Blue Limits Opens a softkey menu to assign power 
values to the red (high power limits) and blue (low power 
limits) heat map display limits (defaults: Red Limit = 
–20 dBm, Blue limit = –90 dBm).

— Labels & Icons Opens a softkey menu to enable/disable 
map data point labels and icon types.

—  Save Image (PNG) Saves the current displayed map to a *.png file 
(default filename is “MapImageFile”).

11. Export KML file into 3rd party mapping software (i.e., Google Map or 
Google Earth). Refer to “Step 7: Import and Play back KML Files into 3rd 
Party Software (Example: Google Earth with Animation Tool)” on page 437.

12. Select Trace 6—choose:

 For this step, refer to Figure 14-6 on page 413.

— Polar Size Max Med Min Sets the size of the polar display. Smaller 
sizes used to overlay PNG maps. (Default = Max) 

Labels OFF ON Enables/Disables map data point labels. When 
enabled, a label is displayed for every map data point 
(e.g., “Data 1”). When disabled, labels are not 
displayed for the map data points.

Icons  
Flag Point Line

Sets the type of icon that is used to display a map’s 
data points.

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are 
save-recalled to: "[CurrentDevice]\RecordPlayback\PAA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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— Polar Orientation Aligns the antenna polar display to a selected 
direction.

— Image Enable OFF ON (Optional to overlay antenna bore-sight 
direction. Only active if you have recalled a PNG image to display on 
the FieldFox as a map. (Default = OFF)

— Recall Image Use to recall PNG map to overlay antenna direction.  

— Compass Image OFF ON To display a compass indicating true north 
for antenna. (Default = ON) 

— Compass North Use this softkey to align the compass’ true north 
value in degrees.

Repeat process as needed for additional settings.

13. Optional: Press Freq/Dist 

— Press Antenna Settings opens the table antenna settings softkey 
menu, where you can define your phased array antenna settings, 
Ball Antenna: LAN address, Settings: Resolution BW, Video BW, 
Beam Width, Array Antenna: Center frequency, Azimuth Ref, 
Elevation Ref, and Polar Display: Ref. For details, refer to step 6 
above.

— Then Start Azimuth +/-45 degrees. (Default = 45 degrees)

— Then Stop Azimuth +/-45 degrees. (Default = 45 degrees)

— Then Ref Elevation +/-45 degrees. (Default = 0 degrees)

14. Optional: choose change sweep, dwell time, and max hold settings:

Press Sweep 

Then choose:

— Dwell Time to set the delay between the antenna positioning from 
1 ms to 10 seconds (default: 10 ms). For pulsed RF measurements it 
is recommended that you increase the Dwell Time to ~100 ms.

— Max Hold For pulsed RF measurements, it is recommended that Max 
Hold is set to OFF when using the Heat Map display.  
(Default = OFF)

— Single 

— Continuous to enable or disable the continuous sweep (default: 
ON).

Learn more, refer to Chapter 9, “SA (Spectrum Analyzer) Mode 
(Option 233–Mixed Analyzers).”

— Restart 

15. Optional: choose devices and save files:

Press Save/Recall 
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Then choose:

— Save to set the attenuator power (default: –10 dB). Set to 0 dB.

— Recall change to ON.

— Device to set the absolute power (dBm) 

— File Type then choose:

— State Saves the current state settings

— Trace+State Saves the current Trace+State information

— Picture (PNG) to save the current displayed trace as a PNG

— Data (CSV) save files as a CSV file 

Learn more, refer to Chapter 32, “File Management.”

16. Optional: Modify scale and amplitude values:

Press Scale/Amptd

Then one of the following:

— Autoscale Automatically adjusts the Y-axis minimum and maximum 
values.

— Scale Manually enter a scale per division values.

— Others: Scale, Ref Level, etcetera as desired.

Learn more, refer to Chapter 29, “Data Analysis Features.”

17. Optional: Modify the averaging and Integrated BW settings:

Press BW

Then one of the following:

— Average Enable OFF ON 

— Average Count 

— Integ BW 

Learn more, refer to Chapter 29, “Data Analysis Features” and Chapter 9, 
“SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers).”
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Figure 14-15 Example of Phased Array Antenna and FieldFox Static IP Setup - First Three 
Static IP Fields Are the Same

Setting the phased array antenna IP address

Setting the FieldFox static IP address - First three fields the same as the antenna
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Figure 14-16 Example Antenna Settings Table
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How to Define a Set Up a Scan and Use Option 360 

You can define measurements by selecting which type of data to display.

Data definitions consist of the following:

— Select the measurement type 

— Define the antenna setting, using the antenna settings table

— Define other optional marker, sweep, averaging, bandwidth settings

Example: Refer to:

— “Step 1. Connect Your Equipment” on page 429

— “Step 2. Set FieldFox to Use Static IP with Your Ball Antenna” on page 429

— “Step 3. Define the measurement” on page 430

Then:

— “Step 4: Select Polar Settings” on page 432

— “Step 5. Modify Scale and Attenuator Settings” on page 432

— “Step 6: Enable Data Logging and Playback the Results” on page 433

— “Step 7: Import and Play back KML Files into 3rd Party Software (Example: 
Google Earth with Animation Tool)” on page 437

Step 1. Connect Your Equipment

Connect your equipment similar to Figure 14-1 on page 409.

Step 2. Set FieldFox to Use Static IP with Your Ball Antenna

— The Ball antenna’s default static IP address is: 192.168.1.10
— Set FieldFox to use static IP address:

Press System 

— Then System Configuration > More > LAN 

IMPORTANT! The LAN address for first 3 fields must match the Static IP 
address of FieldFox. For example, the Ball Antenna’s factory IP address is 
192.168.0.10, set FieldFox Static IP address to 192.168.0.xx.   “xx” must be 
different number than shown in the last field of the for Ball Antenna. Refer 
to Figure 14-15 on page 427.

IMPORTANT! If you forget you N9910X-028 Ball Antenna’s static IP 
address, refer to this link and the Support tab for assistance: 
www.keysight.com/find/fieldfox and then to the Phase Array Antenna 
Support Document.
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1. In the Setting screen, use the  arrows, the rotary knob, or 
numeric keypad to highlight Obtain IP.

2. Press Obtain IP Static

3. Press Clear, then set the Static IP Address to: 192.168.1.2 

and

4. Press Done

5. Press Clear, then set the Static Subnet Mask to: 
255.255.255.0
and

6. Press Done

7. Press Clear, then set the Static Gateway to: 192.168.1.254
and

8. Press Done

9. Using the  arrows, the rotary knob, or numeric keypad to 
select Apply Settings. 

10.  Press Edit, then select Now.

11.  Press Done Edit > Done

Step 3. Define the measurement

1. Press Preset then Mode Preset (Factory)

2. Selecting Phased Array Antenna mode: Press Mode > Phased Array 
Antenna. Depending on the number of options loaded on your FieldFox, it 
may be necessary to press More.

3. Optimizing the FieldFox to scan for signals:

a. Run the Antenna Wizard: Measure > Antenna Wizard and follow the 
prompts.

b. Set the Measure type (i.e., Bore-Sight, Heat Map, Polar ANT, or Park 
ANT).

See also “How to Set Up Phased Array Antenna Settings” on 
page 417.

c. Set the Meas Setup > Antenna Settings table: 

— Ball Antenna: LAN address

— Settings: Res BW, Video BW, and Beam Width
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— Array Antenna: Center frequency, Azimuth Ref, and Elevation 
Ref

— Polar Display: Ref

See also “How to Set Up Phased Array Antenna Settings” on 
page 417.

d. Optional: Measure > Data Logging:

— Record Settings (Outdoor Mapping only) then choose

— Measure Interval OFF ON

— Interval Type Time Distance

—  Time Interval if applicable (only active when 
Interval Type = Time) or

— Distance Interval if applicable (only active when 
Interval Type = Distance) 

— Auto Save OFF ON 

— Back to return to previous menu

e. Record Save/Recall (Save Log File, Recall or

f. Record or

g. Play if you have a previously stored data scan

See also “How to Set Up Phased Array Antenna Settings” on 
page 417 and “Step 6: Enable Data Logging and Playback the 
Results” on page 433. 

Learn more, refer to Chapter 16 Mapping and “Setting up Data 
Logging” on page 486

h. Optional: Press Sweep 3 and modify/select items:

— Single

— Continuous OFF ON to ON (default)

— Restart

— Dwell Time For pulsed RF measurements, it is recommended 
that the Dwell Time is increased to ~100 ms.  
Default = 10 ms. 

— Max Hold For pulsed RF measurements, it is recommended 
that Max Hold is set to OFF when using the Heat Map display.  
(Default = OFF)

IMPORTANT! It is not sufficient to be locked to the GNSS satellite, the 
frequency reference must be locked to GPS. Refer to Chapter 30, “System 
Settings” and then to “How to make GPS settings” on page 756.
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Step 4: Select Polar Settings

Select one of the following display orientations:

 Select Trace 6—choose:

 For this step, refer to Figure 14-6 on page 413 and see also “How to Set Up 
Phased Array Antenna Settings” on page 417. 

— Polar Size Max Med Min or

— Polar Orientation or

— Image Enable OFF ON or

— Recall Image or

— Compass Image OFF ON or

— Compass North or

Step 5. Modify Scale and Attenuator Settings

To set the scan’s scaling and receiver corrections:

Learn more, see “How to select and edit corrections for Field Strength 
measurements” on page 161.

1. Press Scale/Amptd >Corrections then choose:

— Apply Corrections OFF ON 

— RcvrSide Antenna then choose:

— Antenna OFF ON 

— Edit Antenna 

— New 

— Save Antenna   

— Recall Antenna 

— Storage Device 

— RcvrSide Cable then choose:

— Cable OFF ON 

— Edit Cable 

— New 

— Save Cable 

— Recall Cable 
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— Storage Device 

2. Press Scale/Amptd then choose:

— Autoscale 

— Unit dBm 

— External Gain 

— External Gain 

Step 6: Enable Data Logging and Playback the Results

Data Logging creates a record of your data with a timestamp and GPS stamp 
(refer to “GNSS (GPS+) and GPS” on page 756). GPS must be enabled for the 
log results to include a GPS stamp or use Preferences to enable the timestamp. 
Refer to Chapter 30, “System Settings.”

Features

— Log files contain cell results for different component carriers (CCs) 
including timestamps and/or distance stamps.

— Timestamps are included in log files with or without GPS.

— GPS must be enabled for log altitude results.

See also “GNSS (GPS+) and GPS” on page 756.

— Data results can be logged

— Data results can be saved to a *.CSV, DREC (Option 360 only), or *.KML file. 
Refer to “” on page 437.

— User specifies how often results are stored. 

— Time: Store results every “n” seconds 

— Altitude: Store results every “n” meters. GPS must be enabled to 
store results by altitude.

Procedure

1. Press Trace 6 > Data Logging to view the Data Logging softkeys and set 
the Record Settings, Record Save/Recall, and Indoor Map Data Logging. 

— Record (Outdoor Logging) or

— Play (If you have previously stored data recordings.) 

a. Outdoor Mapping only: To set the Record Settings—choose:

Spectrum and Strip Chart information is not recorded. Only the Table and 
Bar Chart data are saved. See “How to Record a Data Log” on page 440. 
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— Meas Interval

— Interval Type Time or Distance

— Time Interval or

— Distance Interval 

b. Then press Record Save/Recall 

— Then File Folder Default System

— Default – Sets the default User Folder path: 

——List files (*.csv and *.kml) are save-recalled 
to: 
"[CurrentDevice]:\RecordPlayback\
PAA\"

——Data Log-Play files are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\
PAA\" 
 
Or

— System – Sets the User Folder to the user defined 
system folder path/name: 

——List files are save to-from 
"CurrentDevice\<UserSelectedFolde
r>\" 

——Data Log-Play files are save-recalled to: 
"CurrentDevice\<UserSelectedFolde
r>\"

Refer to “File Management” on page 777. 

— Then File Type

— KML (default) or

— CSV
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— DCREC (Option 360 only) 

— Then Save Log File.

or

— Then Recall Log File.

— Auto Save (default = OFF) 

— Then Back

c. Optional: Press Indoor Map Data Logging then 

—  Record Indoor Data or Recall Indoor Log File. Learn more, 
refer to “How to Use Data Logging/Playback (Option 360)” on 
page 438, Chapter 16 Mapping and “Option 352 Indoor Maps 
Setup Procedure” on page 474.

— Then choose from Navigate OFF ON, Data Selection, Zoom, 
Pan, Record Data, More

— Learn more, refer to Chapter 16 Mapping and “Setting up 
Data Logging” on page 486.

2. Press Back to return to previous menu.

3. Outdoor Mapping: Press Record to begin a new recording and then

—  Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue 
recording.

— Stop Immediately stops recording and a “Save the Log File” menu 
opens to rename and save your data log file.

— (Press Record to begin a new recording.)

— Then Maps To enable map view and related features (e.g., Data 
Selection, Red/Blue Limits, Labels & Icons, Zoom). 

—  View Map OFF ON Displays the current GPS location.

Three file types are supported for save or recall log results:

— KML file format

——Files stored in this format can be imported into 3rd 
party applications like Google Earth or Google Maps.

— CSV file format. Files stored into this format can be imported into 
spreadsheet applications.

— DREC file format. This file type is a binary file. File contains 
recorded state and trace data, with GPS time and locations 
stamps if enabled. Available with Option 360 only.
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— Data Selection Opens a softkey menu to set the active 
data channel, sort type, and sort order. See also previous 
steps 10 in “How to Set Up Phased Array Antenna 
Settings” on page 417.

— Red/Blue Limits Opens a softkey menu to assign power 
values to the red (high power limits) and blue (low power 
limits) heat map display limits (defaults: Red Limit = 
–20 dBm, Blue limit = –90 dBm).

— Labels & Icons Opens a softkey menu to enable/disable 
map data point labels and icon types.

—  Save Image (PNG) Saves the current displayed map to a 
*.png file (default filename is “MapImageFile”).

4. When done press Stop. The log file is automatically saved to the defined 
Device Type and File Type.

Else, edit the User Folder and File Type, under Record Save/Recall where 
the file results will be stored.

5. Press Back 

Playing a Data Log and Viewing the Data

To play the log results: 

1. Press Record Save/Recall > Recall Log File

And, use the Use the RPG or the  arrow keys to highlight the file to be 
played.

2. Press Recall File > Back > Play

3. Press Stop to exit the log playing.

To pause the log play:

Labels OFF ON Enables/Disables map data point labels. When enabled, 
a label is displayed for every map data point (e.g., “Data 
1”). When disabled, labels are not displayed for the map 
data points.

Icons  
Flag Point Line

Sets the type of icon that is used to display a map’s data 
points (default = Flag).

Learn more about file settings, refer to the Chapter 32, “File Management”.
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1. Press Pause Resume to pause or resume the log playing.

2. Press Stop to stop the log playing.

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486. See also, Chapter 32, “File Management.”

Step 7: Import and Play back KML Files into 3rd Party Software 
(Example: Google Earth with Animation Tool)

Features

Use the Playback Slider to replay measurement results. See also Google Maps 
and or Google Earth’s help. Refer to Figure 14-17 on page 437.

— Open the FieldFox *.KML file in Google Earth. The time slider appears in 
upper left of the map.

— Manual Mode – Move the time slider cursor to see color-coded icons 
pop-up according to the timestamp.

— Loop mode has a Fast-Slow Replay Option.

— Click on each color coded balloon to see the table of measurement results 
for that location.

Figure 14-17 Importing a KML File Into Google Earth
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How to Use Data Logging/Playback (Option 360) 

Data Logging and Playback enables you to log phased array antenna trace 
data and play them back at a later time. Use this feature to monitor table data 
activity over a period of time.

Data logs can be saved to the FieldFox Internal memory, an SD Card, or a USB 
flash drive.

This section assumes you have already completed the initial setup and have a 
phased array antenna scan displayed on the FieldFox. 

Screen Annotation

During a data logging or playback session, the following is displayed in the 
top-center area of the screen:

—  Rec: 55/55 2018-12-31 03:26:11 PM    

where:

— 55/55 is the current and total trace number: currently trace is 55 of 55 total 
scans.

— 2018-12-3103:26:11 PM is the date and time of recording.

— The name of a recording can be changed using Manage Sessions. Learn 
more in “To change Data Logging Configuration settings:” on page 440.

See also, the FieldFox User’s Guide’s “System Settings” chapter. 

When GPS is enabled, GPS R is indicated at the bottom of the FieldFox 
display. Learn more, see the FieldFox User’s Guide’s “System Settings” 
chapter.

The Phased Array Antenna mode can display and be data logging/played back 
in field strength units, when the units are changed: 

— Press Scale /Amptd > More > Unit then choose:

— dBmV, dBuV, W, V, A, dBmA, or dbuA (Default Units: dBm)

See Figure 14-18 on page 439.

Data log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\PAA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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Figure 14-18 Field Strength Annotation that can be Logged and Played Back

If Data Logging or Playback is not occurring when you think it should, 
check the following:

— Is the sweep in HOLD? (upper-left annotation), or check the Sweep 
menu for Continuous set to OFF.

— Is Recording or Playback Paused? (mid-left annotation)

— Is the Data Logging or Playback Interval set too long? (Configuration 
settings.)
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How to Record a Data Log

— Press Trace 6

— Then Data Logging

— Then Record

 is displayed in the left of screen graticules.

During recording, choose from the following: 

— Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue recording. 

— Stop Immediately stops recording. Then choose from the following:

— Then Record Save/Recall To save a log file, recall log file, or change 
your file settings. Learn more, refer to “To change Data Logging 
Configuration settings:” on page 440.

——Press Save Log File to save the current Table data (i.e., default 
save device is Internal).

— Then Record Settings (Outdoor Logging) To change your 
measurement interval settings. Learn more, refer to “To change Data 
Logging Configuration settings:” on page 440.

To change Data Logging Configuration settings:

— Press Trace 6

— Then Data Logging then choose:

— Then Record Settings (Outdoor Mapping Only)

— Optional: Then Meas Interval > ON

——Then Interval Type > choose Time or Distance.

——Then, if applicable Time Interval enter time interval in seconds. 

Or

——Then, if applicable Distance Interval enter distance interval in 
miters. 

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\PAA"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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— Then Record Save/Recall 

— Then Device (Internal (default), SD Card, or USB)

— Then File Type (CSV, DREC (Option 360 only), or KML (default))

Learn more, refer to the Chapter 32, “File Management”. 

How to Playback a Data Log

— Press Trace 6

— If the session is already open, skip the following step. Otherwise: 

— Then Data Logging > Record Save/Recall

— Then Recall Log File use the Use the RPG or the  arrow keys to 
highlight the file to be played.

——Then Recall File 

——Then Back 

— Then Play to playback your Table data.

 is displayed in the left of screen graticules during playback. When the 
end of the recording is reached, playback begins at the start of scan and 
continues to loop indefinitely. 

During playback, choose from the following: 

— Pause Resume Temporarily halts playback. Then choose from the following:

— Pause Resume Press to continue playing. 

— Stop Immediately stops playback. Then choose from the following:

— Play Start playback from start of scan.

— Recall Log File Opens a list of stored data files.

Select a file to playback. 

— Recall File 

— Back 

— Cursor Position use this softkey to move the data log play cursor in the 
current data log being played (i.e., Cursor Position is active only when 
playback is paused).

If these are large recordings on a device, it could take several seconds for 
the FieldFox to display the list.
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This softkey is only available in Channel Scanner and Phased Array Antenna 
modes (i.e., The Cursor Position softkey is not available for OTA mode).

— Red Limit to edit the red limit dBm value.

— Blue Limit to edit the blue limit dBm value.

Using Mapping
The Phased Array Antenna mode has indoor and outdoor mapping capability. 
Refer to Chapter 16, “Indoor and Outdoor Mapping – Option 352 (Requires 
Spectrum Analyzer Mode (Option 233), and GPS Receiver (Option 307)).”

Other Features Available

— Alignments - For information on using alignments, refer to the SA chapter’s 
section, “Alignments” on page 201.

— External Gain - Refer to refer to the SA chapter’s section, “External Gain” 
on page 158.

— Field Strength Corrections – “How to select and edit corrections for Field 
Strength measurements” on page 161

— Scale Settings – For information on using scale settings, refer to the Data 
Analysis chapter’s section, “All about Scale Settings” on page 722 (not all 
of the settings apply to OTA Option 360).
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Troubleshooting
If your Phased Array Antenna setup is not behaving as expected:

— Verify setup is correct by referring to “How to Set Up Phased Array Antenna 
Settings” on page 417.

— Attenuator set to 0 dB

— Preamplifier set to ON

— Correct Band, Channel, and Center Frequency entered

— GNSS set to Internal

— Frequency Ref set to GPS

— ADC errors: Use Scale/Amptd > Range to adjust the absolute power 
level (dBm). 

For some data views, you need to press More to view the Range 
softkey.

— No data displayed: Press Meas Setup 4 then

——Verify the correct Antenna Settings have been entered.

— The FieldFox’s displayed annotation indicates "Check LAN 
connection. Check IP address." during pinging. 

Verify:

——The LAN address for first 3 fields matches the Static IP address 
of FieldFox. For example, if the Ball Antenna IP address is 
192.168.1.10, set FieldFox Static IP address to 192.168.1.xx.   
“xx” must be different number than shown in the last field of 
the for Ball Antenna. Refer to Figure 14-15 on page 427. 

——Power is connected to the PAA. If the power is not connected 

indicator is flashing ( ) on the left side of the FieldFox 
display, verify your connections.

IMPORTANT! If you forget you N9910X-028 Ball Antenna’s static IP 
address, refer to this link and the Support tab for assistance: 
www.keysight.com/find/fieldfox and then to the Phase Array Antenna 
Support Document.
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15 USB Antennas – (Full Capability Requires EMF Option 358, and 
either SA mode (Option 233 Mixed Analyzers) or OTA—5G NR / 
5G NR EVM Conducted Option 378)

USB antennas measures signals at the SA RF Input Port 2 connector. 

USB antennas mode requires the FieldFox to have SA mode (Option 233 on 
combination analyzers), EMF (Option 358), GPS (Option 307), and CPU2 
installed. 

Recommended, but not required, preamplifier (Option 235) to improve receiver 
sensitivity.

With USB antennas, 377 (5G TF), and 378 (5G NR) network designers can 
ensure that networks have enough resources to carry out handovers 
(re-selection) when users move between cell towers on the same 5G network 
as well as in between 5G and 4G networks (intra/inter-radio access 
technology). The FieldFox OTA measurements support 5G NR (Option 578) / 
5G NR EVM Conducted (P/O: Option 578) and over-the-air demodulation of 
single acquisition, multiple cell towers, or multiple acquisitions for multiple 
component carriers (CCs). Additionally, 5G NR / 5G NR EVM Conducted 
among other 5G NR capabilities, has new FR1 and FR2 spectrums. The 
FieldFox display can be configured to show data formats such as table, bar 
chart, spectrum and strip chart of key performance indicators (KPI's). 

By integrating over-the-air (OTA) measurements with cable and antenna test 
(CAT), full 2-port vector network analysis, spectrum analysis, and real-time 
spectrum analysis (RTSA), the FieldFox can be used for base station setup and 
verification.

Triaxial USB antennas can be used without EMF Option 358, but with 
limited capability and doing so is not recommended or supported by 
Keysight.

IMPORTANT! EMF is only compatible with 5G NR/5G NR EVM Conducted 
(Option 378) and SA Mode (Requires Option 233—combination analyzers). 
User data channels are not demodulated.

For more information on the SDIA-6000 Triaxial Lsotropic Antenna, refer to 
http://en.agos.co.kr/emf_measurement.do.
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With USB Antennas (p/o EMF measurements – Option 358):

— Reduce measurement complexity with a triaxial antenna to capture energy 
radiated from gNB 

— Calibrated metrology milli-meter wave triaxial antenna simulates 5G UE 
antenna performance

— Troubleshoot the 5G radio access network with 3D test coverage and path 
loss measurements utilizing the built-in CW generator

— Triaxial antenna performance verification showing bore sight, polar antenna 
pattern with compass, heat map and beam sweep to map display views

— Measure and display corrected field strength in RMS average power

— Antenna control and X, Y, and Z antenna factors can be downloaded via a 
USB

Figure 15-1 FieldFox With USB Antenna
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In this Chapter

See Also

“Using USB Antennas” on page 448

“About USB Antenna Measurements” on page 449

— “USB Antenna Features” on page 449

“How to Set Up a USB Antenna” on page 451

— “USB Antenna Setup Procedure” on page 451

“Other Features Available” on page 455

— Alignments (SA chapter) – “Alignments” on page 201

— External Gain (SA chapter) – “External Gain” on page 158

— Record Playback – “Record/Playback (SA Option)” on page 519

— Scale Settings – “All about Scale Settings” on page 722

“Troubleshooting” on page 456

“Why and When to Calibrate” on page 126

Chapter 30, “System Settings.” (Changing display colors)

Chapter 32, “File Management.”



 448                                                                                                                     Keysight N9938-90006 User’s Guide

USB Antennas – (Full Capability Requires EMF Option 358, and either SA mode (Option 
233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM Conducted Option 378)
Using USB Antennas

Using USB Antennas 

USB antennas enables you to do the following:

Triaxial USB antennas can be used without EMF Option 358, but with 
limited capability and doing so is not recommended by Keysight.

Measures electro-magnetic fields (EMF) for radio frequencies in proximity of radio and television 
stations, and repeaters for cell phonesa

a. Requires Option 358 for EMF measurements. Else, antenna can be used manually with 
X/Y/Z axis.

 Seven Independent Antenna/Cable Amplitude Correction Types: 

— Triaxial antenna (X/Y/Z)

— Cable – triaxial connection

— Cable – Receiver Side

— Antenna – Receiver side 

— Cable – Source Side 

— Antenna – Source Side

— Antenna – (Triaxial off )

— Source and 

— Receiver sides

Color Coded Display Types:

— Specify high and low power with 
color bars 

Features:

— Automatic detection of previously imported 
USB antenna corrections (i.e., to view pre 
Apply Corrections)

— OTA (5G NR) mode can connect to the USB 
antenna, when an Option 358 license is 
detected

— Automatic selection of field strength units, 
when USB antenna corrections are applied

— Auto selection provides ability to cycle 
through each axis (X, Y, and Z) to provide 
RMS average of the three axes results in 
trace and channel power

Record GPS stamped data measurements

— Define measurement interval by time 
or distance

— Show results in Table or Bar Chart 
(Channel Power)

— Display files (KML) on Google Maps 
or Google Earth
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About USB Antenna Measurements
USB antenna feature supports these standards: 

— SA

— OTA — 5G NR

Some measurement parameters are auto-coupled and are not user-settable.

USB Antenna Features

USB antenna feature has the following features:

— SA mode automatically detect if Import antenna factors are present applies 
correct X/Y/Z antenna amplitude corrections for EMF measurements

— SA mode X/Y/Z factors—if available—are enabled by default

— OTA mode 5G NR – EMF can be manually enabled

Figure 15-2 Example Summing of Triaxial Values

For more information on the SDIA-6000 Triaxial Lsotropic Antenna, refer to 
http://en.agos.co.kr/emf_measurement.do.
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Figure 15-3 Example Verifying the Triaxial Values – Axis Y is Displayed
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How to Set Up a USB Antenna

This section reviews some general high level steps in setting up a USB antenna 
measurement. If you are not familiar with this process or would like more 
information on specific EMF measurement setups, refer to: 

— SA Mode: “How to Set Up EMF Settings (Requires EMF (Option 358), GPS 
(Option 307), and SA Mode (Option 233–Mixed Analyzers))” on page 226

— OTA Mode: “How to Set Up EMF Mode Settings (Requires EMF (Option 
358) and 5G NR (Option 378))” on page 387

USB Antenna Setup Procedure 

1. Select the mode and set up your measurement. Refer to Chapter 13, 
“Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 
371, 5G TF Option 377, 5G NR / 5G NR EVM Conducted Option 378” or to 
Chapter 9, “SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)”.

2. Connect a USB antenna. Refer to Figure 15-1.

3. Importing and selecting the X/Y/Z antenna factors:

a. OTA – 5G NR and SA Mode:

Press System > Utilities> USB Antennas 

IMPORTANT! See also, “Alignments” on page 201, in NA mode,Chapter 9, 
“SA (Spectrum Analyzer) Mode (Option 233–Mixed Analyzers).” 

If necessary, this step can be skipped and done after the USB antenna is 
set up. 

Only Agos Advanced Technologies SDIA–6000 Triaxial Lsotropic USB 
antenna is compatible with EMF (Option 358). See also Chapter 9, “SA 
(Spectrum Analyzer) Mode (Option 233–Mixed Analyzers)” and Chapter 13, 
“Over–the–Air Measurements (OTA) – LTE FDD Option 370, LTE TDD Option 
371, 5G TF Option 377, 5G NR / 5G NR EVM Conducted Option 378”.
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— Then Import Antenna – to import the antenna factors from the USB 
antenna connected to the FieldFox.

— Then USB Antenna [Tri Axial] verify Tri Axial (default) is selected. 
Only compatible USB triaxial antennas can be used for EMF 
measurements.

— Optional: Press Antenna Axis with Auto (default) selected the 
FieldFox determines the X/Y/Z settings for the current 
measurement. Alternately, you can select either X, Y, or Z to enable 
and to edit a position manually (i.e., an example of editing X, Y, and 
Z axes is covered in step 5).

4. If you have not selected a mode and set up your measurement, then do so 
now. Refer to step 1.

5. Enabling the imported USB antenna factors and Cable factors:

Choose one of these:

— SA Mode: “How to Set Up EMF Settings (Requires EMF (Option 358), 
GPS (Option 307), and SA Mode (Option 233–Mixed Analyzers))” on 
page 226

— OTA Mode: “How to Set Up EMF Mode Settings (Requires EMF 
(Option 358) and 5G NR (Option 378))” on page 387

6. If you need to edit or add new antenna factors or cable factors, then 
repeat step 5 as required for Y, Z, and the Cable Factors. See also, “How to 
Set Up EMF Settings (Requires EMF (Option 358), GPS (Option 307), and 
SA Mode (Option 233–Mixed Analyzers))” on page 226 and “How to Set Up 
EMF Mode Settings (Requires EMF (Option 358) and 5G NR (Option 378))” 
on page 387.

7. Once you have finished with your USB antenna setup:

a. Press Sweep 3 > Single > Restart 

If the antenna factor import is successful, the FieldFox displays: 
"Success: Antenna Factors Imported: Tri-Ax Antenna ID: 
->[R] Antenna ID: SDIA-6000-1006 ->[]". The last 4-digits will vary 
for each antenna (i.e., “1006” is changeable).

If the FieldFox displays this error Error: USB antenna Error: Not 
found or Unable to communicate with antenna. Ensure it is 
connected. is displayed, verify the USB antenna is connected correctly. 
Refer to “Troubleshooting” on page 456.
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The FieldFox should display in order Analyzing CCO X-Axis, 
Analyzing CCO Y-Axis, and  Analyzing CCO X-Axis and then 
do a square root sum of the X, Y, and Z measurement values in the 
FieldFox. Multi-cell measurements are done similarly for each cell 
ID (i.e., Cell CC0 to CCn). Refer to Figure 15-4 on page 453.

Figure 15-4 Example Summing of Triaxial Values
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Figure 15-5 Example Verifying EMF 

Editing Antenna Correction Factors and Adding New Antenna Factors 

For procedures illustrating how to edit the Antenna Factors settings table 
values, refer to:

— SA Mode: “How to Set Up EMF Settings (Requires EMF (Option 358), GPS 
(Option 307), and SA Mode (Option 233–Mixed Analyzers))” on page 226

— OTA Mode: “How to Set Up EMF Mode Settings (Requires EMF (Option 
358) and 5G NR (Option 378))” on page 387

Keysight does not recommend editing a USB antenna’s correction factors. 

If New is selected under the X, Y, or Z Antenna or Cable softkey menu, 
whatever antenna or cable factors that have been imported as the default 
values and are displayed in the Settings table. 
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Figure 15-6 SA Mode – Example Editing and Adding a New X axis antenna 

Other Features Available
— Alignments - For information on using alignments, refer to the SA chapter’s 

section, “Alignments” on page 201.

— Scale Settings – For information on using scale settings, refer to the Data 
Analysis chapter’s section, “All about Scale Settings” on page 722 (not all 
settings apply to a USB antenna.

— External Gain - Refer to refer to the SA chapter’s section, “External Gain” 
on page 158.

— Record Playback - Refer to refer to the Interference Analyzer chapter’s 
section, “Record/Playback (SA Option)” on page 519 and to the OTA 
chapter’s “How to Use Data Logging (OTA Options 370, 372, 377, and 
378)” on page 394.



 456                                                                                                                     Keysight N9938-90006 User’s Guide

USB Antennas – (Full Capability Requires EMF Option 358, and either SA mode (Option 
233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM Conducted Option 378)
Troubleshooting

Troubleshooting
If your USB antenna setup is not behaving as expected:

— Verify setup is correct by referring to “How to Set Up a USB Antenna” on 
page 451.

— If the FieldFox displays this error  Error: USB antenna Error: 
Not found is displayed, verify the USB antenna is 
connected correctly or Unable to communicate with 
antenna. Ensure it is connected. Verify the antenna 
connection (i.e., Disconnect and reconnect the USB cable).

Press USB Antennas > Import Antenna

If the FieldFox still displays the USB antenna error, try a different USB 
antenna.

— If you are unable to view the X,Y, and Z antenna correction factors, 
then: 

Press Scale/Amptd > Corrections > Amp Corr Select > TriAxis XYZ

— If you are having problems with your measurement, verify the antenna 
corrections have been enabled: 

Press Scale/Amptd > Corrections > Apply Corrections > ON 

Preamplifier set to ON
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16 Indoor and Outdoor Mapping – Option 352 (Requires Spectrum 
Analyzer Mode (Option 233), and GPS Receiver (Option 307))

Option 352 maps signals that were measured using the SA RF Input Port 2 
connector. 

The FieldFox requires Option 352 for outdoor mapping and GPS (Option 307) 
installed. And, one of the following, an Over–the–air (OTA) mode (LTE FDD 
Option 370, 5G TF Option 377, or 5G NR / 5G NR EVM Conducted Option 378), 
or Channel Scanner mode (Option 312), or Phased Array Antenna (Option 360). 
Also, requires browser that supports HTML5 (i.e., web browsers not supported: 
IE6, IE7, and IE8).

Recommended, but not required, preamplifier (Option 235) to improve receiver 
sensitivity.

Keysight's FieldFox handheld analyzer (with Option 352) combined with a USB 
triaxial antenna (p/o EMF Measurements – Option 358) provides a unique, 
portable solution for indoor and outdoor mappings in the field. Option 352 
adds indoor and outdoor mapping capability to FieldFox analyzers, so that 
FieldFox can import maps from OpenStreetMap (OSM) for data collection and 
data plotting to the map directly on the FieldFox instrument display. The 
FieldFox Map Explorer resides at the System level and enables you to 
download, import/export, and view outdoor maps. All of the other data 
logging, record/playback, plotting data on indoor/outdoor maps can be 
enabled within the following modes: 

— Channel Scanner (Option 312)

— Phased Array Antenna Support (Option 360) 

— Over-the-Air (OTA) LTE FDD (Option 370)

— Over-the-Air (OTA) LTE TDD (Option 372)

IMPORTANT! 

B Model FieldFoxes measurements require an OML heada. Refer to 
https://www.omlinc.com/. 

a. Requires external mixer to down convert millimeter wave frequency to intermediate frequency (IF). Recommend 
OML Inc. WR-28 26.5 to 40 GHz harmonic mixer, model number M28H2A1DC. Contact OML directly 
www.omlinc.com for ordering information.
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— Over-the-Air (OTA) 5G TF (Option 377)

— Over-the-Air (OTA) 5G NR (Option 378)

Using a direct wired LAN connection with access to a network and the internet, 
FieldFox will automatically access OSM once location coordinates (latitude and 
longitude) and zoom levels are entered the Map Explorer menu. If using the 
FieldFox Map Support Tool, OSM map files can be downloaded to a *.zip file 
and imported to FieldFox internal memory. If the FieldFox GPS receiver is 
enabled and OSM maps have been previously saved to FieldFox with those 
GPS coordinates, FieldFox will automatically load the corresponding map to 
match the GPS coordinates.

With Indoor Mapping:

Using the FieldFox:

— Import floor plans or site maps from picture files (PNG, JPG, BMP)

— Interactive Walk Test data collection with location pointer.

— Save Indoor Map files (kDAT)

— Indoor Map file Viewer with results presentation options

With RF Coverage Mapping:

Using the FieldFox:

— Begin with Data Logging recorded data results 

— Overlay GPS-stamped located measured results onto maps on FieldFox

— LAN connection optional. GPS is required.

— Built-in Longitude, Latitude map search

— Save KML or CSV files

— Built-in Map Viewer with results presentation options

Using Google Earth or other software:

— View KML files

In this Chapter

“How to Install Node.js and Running the FieldFox Mapping Software” on 
page 462

“Downloading and Using the FieldFox Map Support Tool” on page 464

“Importing a .zip File to the FieldFox” on page 469
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See Also

“How to Set Up Mapping Settings” on page 471

— “How to Set Up Mapping When the FieldFox Is On The LAN” on 
page 472

— “Option 352 Indoor Maps Setup Procedure” on page 474

— “Option 352 Outdoor Maps Setup Procedure” on page 478

— “Setting up Data Logging” on page 486

“How to Use Data Logging (Option 352)” on page 494

— “Screen Annotation” on page 494

— “How to Add Directional Finding (DF) Bearing” on page 496

— “How to Record a Data Log (Outdoor Logging Only)” on page 499

— “To change Data Logging Configuration settings:” on page 500

— “How to Play a Data Log” on page 500

— “Update Available Message” on page 505

“Troubleshooting” on page 501

— “General Troubleshooting” on page 503

— “Port 5000 in Use Error” on page 503

— “Miscellaneous Mapping Errors” on page 506

Other Features Available:

— Alignments (SA chapter) – “Alignments” on page 201

— External Gain (SA chapter) – “External Gain” on 
page 158

— Scale Settings (Data Analysis chapter) – “All about 
Scale Settings” on page 722

“Why and When to Calibrate” on page 126

Chapter 30, “System Settings.” (Changing display colors)

Chapter 32, “File Management.”
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Option 352 enables you to do the following:

Figure 16-1 Maps (Outdoor) With Line Feature Enabled

Measure and display indoor and outdoor mapping 

Two Mapping Types:

— Indoor Maps — Outdoor Maps (Requires Option 307)

Color Coded Display Types:

— Specify high and low power with 
color bars 

Store Geo-location to external or connect to 
LAN and Download to PC memory:

— SD card — Connect to LAN and download to PC 
memory

— USB card

Data Logging GPS stamped data measurements

— Define measurement interval by time 
or distance

— Show results in TableChart

— Add Directional Finding bearing

— Display files (KML) on Google Maps 
or Google Earth
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Figure 16-2 Maps With Current Position Marker Displayed - (OpenStreetMaps)

Figure 16-3 Using Mapping (Option 352) - Satellite View for Indoor Mapping 
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How to Install Node.js and Running the FieldFox Mapping Software 

This section contains the procedure to download Node.js to access 
OpenStreetMap files and to process and save those files using the FieldFox 
mapping software. For details on how to use these files once they are 
downloaded to the FieldFox, refer to “How to Set Up Mapping Settings” on 
page 471. 

1. Open an HTML5 compatible browser and download Node.js to a PC (e.g., 
Google Chrome, Mozilla Firefox, Safari, or Microsoft Edge): 

https://nodejs.org/en/download

2. Run the Node.JS installation file, by accepting the wizard’s defaults (i.e., 
including leaving the "Automatically install the necessary 
tools. Note that..." checkbox empty (unchecked)). Refer to Figure 
16-4 and Figure 16-5 on page 463. 

IMPORTANT! If your FieldFox is connected directly to the LAN, you can skip 
the section on downloading Node.js and go to “How to Set Up Mapping 
When the FieldFox Is On The LAN” on page 472.

IMPORTANT! 

Do not change the default name of the directory path for downloading the 
Node.js program, because FieldFox uses the default program path name to 
run the Mapping feature. Refer to Figure 16-4.

Examples of Web Browsers that not supported are Internet Explorer 6, 7, 
and 8.
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Figure 16-4 Downloading the Node.js Installer to a PC

Figure 16-5 Default Download Path for Node.js Installer to a PC

IMPORTANT! Do not change path.
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Downloading and Using the FieldFox Map Support Tool
1. Download the FieldFox Mapping software (“FFMapSupportInstall.msi”) to 

a PC’s Downloads folder. Refer to www.keysight.com/find/fieldfoxsupport 
and then download the FieldFoxMapping.zip. 

Refer to Figure 16-7.

2. Run the FieldFox Map Support Tool software’s, installation software by 
going to the folder where the FieldFox Tool software is installed and 
double-click Run.bat. 

Refer to Figure 16-6 on page 464.

3. Paste and Enter the address into a HTML5 compatible browser. Refer to 
Figure 16-7 (The Mapping software is not compatible with Internet 
Explorer). 

Figure 16-6 Command Window Opens With Address Copied to Clipboard
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Figure 16-7 FieldFox Mapping Opens in HTML5 Compatible Browser (Overview)

4. If the FieldFox is connected directly to the LAN, begin here: Select Draw 
An Area to map and download the selected area:

For this step and sub-steps, refer to Figure 16-8 on page 467. 

a. Step 1. Select Draw An Area to map: 

— Enter a location in the search area and click on the map and 

use the Zoom In/Zoom Out buttons ( ) to select the area to 
map. Also, your mouse scroll wheel can be used for zooming 
in and out.

 Hint: The larger the map area selected for final mapping, the 
longer it takes for the file download. 

— Click on the box button ( ) and click and drag to select the 
map area.

Hint: To clear and redraw the box choices, click the trashcan 

button ( ). 

b. Step 2. Select Zoom Levels to Save and Download:

IMPORTANT! 

The more Zoom boxes that you check, the more data is selected for 
download. For faster downloads click Zoom boxes. Refer to Figure 16-8 on 
page 467.
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— Select all Zoom levels of the map you wish to save.

Hint: 

— To select Zoom levels, click the zoom boxes.

— The more Zoom levels checked, the more map 
images that have to be saved and it will take longer 
to download the images. 

c. Step 3. Input a filename to store your requested images from 
OpenStreetMaps. The *.zip file is then stored in your PC’s 
Downloads folder.
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Figure 16-8 FieldFox Mapping Opens in HTML5 Compatible Browser (Zoom)

5. Saving your *.zip file to a storage device and importing your *.zip to the 
FieldFox: 

a. Insert an SD card or USB storage device into your PC.

b. Open the PC’s Downloads folder and find your *.zip file. (e.g., 
MapsZIP_Example_1). Refer to Figure 16-9 on page 468. 

For FTP, refer to Refer to Using FTP with FieldFox and to the FieldFox 
Programming Guide one www.keysight.com.
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c. Copy the *.zip file to your SD card or USB storage device.

d. Remove the SD card/USB storage device from your PC.

e. Insert the SD card/USB storage device into the FieldFox.

Figure 16-9 New Maps Zip File – MapExample_1

IMPORTANT! 

In the folder that contains your unzipped files, do not change any of the 
Map file folders or filenames. Doing so will prevent the FieldFox from being 
able to recognize the map files.

New downloaded Map folders, for the same map locations and zoom 
levels, will overwrite any existing folders on the FieldFox.
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Importing a .zip File to the FieldFox

On the FieldFox: 

Press System 7 > Utilities > Mapping > Map Explorer (Get Maps)

1. Press Import Maps

2. Verify your SD card/USB Source Device is selected.

If not then:

Press Source Device [Internal] > SD Card | USB

3. Press Import Maps (ZIP)

4. In the "Select .zip file to import" window that opens, if there is 
more than one .zip file listed, select the .zip file you want to load by using 

the  arrows, or the rotary knob and then press Recall File.

Refer to Figure 16-11 on page 470 and Figure 16-11 on page 470.

5. Press Back to return to the previous menu.

Figure 16-10 Example of a Maps *.zip Being Recalled From a USB Storage Device

For FTP, refer to Using FTP with FieldFox and to the FieldFox Programming 
Guide on www.keysight.com. See also, “How to Set Up Mapping When the 
FieldFox Is On The LAN” on page 472.
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Figure 16-11 Example of Maps Folder Containing Imported Maps *.zip Files to the 
FieldFox’s InternalSD\UserData\Maps Folder 
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How to Set Up Mapping Settings

This section reviews the steps in setting up an Option 352 Mapping 
measurement.

This section consists of:

— “How to Set Up Mapping When the FieldFox Is On The LAN”

— “Option 352 Indoor Maps Setup Procedure”

Figure 16-12 Overview – Setting Up Option 352 (Indoor Mapping) Using Other Modes

— “Option 352 Outdoor Maps Setup Procedure” (Requires GPS Option 307)

Figure 16-13 Overview – Setting Up Option 352 (Outdoor Mapping) Using Other Modes

IMPORTANT! See also, “Alignments” on page 201, in SA mode.
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How to Set Up Mapping When the FieldFox Is On The LAN

If your FieldFox is connected directly to the LAN, you can view your maps by 
using OpenStreetMaps directly (i.e., no need to use the FieldFox Map Support 
Tool to download the maps as a *.zip file). But, you will need a valid GPS signal 
(Option 307 required). Refer to “Display a Map File” on page 472.

 

Display a Map File

1. Press System 7 > Utilities > Mapping > Map Explorer (Get Maps)

2. Then choose from the following:

— Press Edit

— Enter a Zoom by using the RPG or the  arrow keys to 
highlight Zoom and then enter a value between 4 and 17.

— Press Go to GPS Location – sets the current displayed map to the 
current GPS location. 

— Press Zoom – opens a menu of Zoom In and Zoom Out softkeys

— Press Pan – Opens a menu of softkeys to move East, West, North, 
and South on the current displayed map area

— Save Image (PNG) – To save the current map as a PNG file. When 
selected, the "Save Map picture file" feature opens to the 
current storage location (default = [INTERNAL]:) where you can 
name and save your current displayed map area. 

3. Enter a Zoom by using the RPG or the  arrow keys to highlight Zoom 
and then enter a value between 4 and 17.

4.  If you do not see your Map on the FieldFox display: 

— Use the RPG or the  arrow keys to highlight Latitude and 
Longitude and then enter a value for latitude and longitude that 
corresponds closely to the “Current Area Center” value displayed in 
the FieldFox Mapping software.

— Use the Go to GPS Location softkey.

 Refer to Figure 16-14.

Optional: If you want to stop the "Reading map..." process, press Esc to 
stop map search.

If a "Warning: GPS data invalid - GPS data must be valid to 
show current GPS location" is displayed, verify your GPS signal is 
connected and working properly.
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5.  Repeat step 4 for Longitude.

Figure 16-14 Example of Current Area Center Latitude and Longitude Values
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Option 352 Indoor Maps Setup Procedure 

1.  Set up your measurements in Channel Scanner, OTA, or Phased Array 
Antenna. See also, Chapter 13, “Over–the–Air Measurements (OTA) – LTE 
FDD Option 370, LTE TDD Option 371, 5G TF Option 377, 5G NR / 5G NR 
EVM Conducted Option 378,”   and Chapter 27, “Channel Scanner (Option 
312).” 

One or more are required:

— For setting up a phased array antenna, refer to Chapter 14, “5G 
Rapid Prototype Phased Array Antenna – Option 360.”

— For setting up a USB antenna, refer to Chapter 15, “USB Antennas – 
(Full Capability Requires EMF Option 358, and either SA mode 
(Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM 
Conducted Option 378).”

Optional:

— For setting up GPS Option 307, refer to Chapter 30, “System 
Settings,” and then “GNSS (GPS+) and GPS” on page 756.

2. Plan your Indoor Map:

a. Save mapping pictures to the FieldFox using USB storage device, SD 
card, or connect to LAN with internet and download.

b. Import floor plans or site maps to the FieldFox from pictures (PNG, 
JPG, and BMP). 

Press System 7 > Utilities > Mapping > Map Explorer (Get Maps) > 
Import Maps > Import Maps (ZIP)

Optional:

— Press Source Device [Internal] – Internal (default), SD Card, 
USB, or CD Drive

— Press Destination Device [Internal] – Internal (default), SD 
Card, USB, or CD Drive

c. Recommended: Do an interactive Walk Test data collection using 
the location pointer.

IMPORTANT! 

85571A-028 (28 GHz 5G Phased Array Antenna) accessories not suitable 
for use in wet locations.

Import your floor plan, before the locations are going to be measured.
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3. If you are using an antenna with your measurements, then Connect your 
equipment similar to Figure 14-1 on page 409 in Chapter 14, “5G Rapid 
Prototype Phased Array Antenna – Option 360” or to Figure 15-1 on 
page 446 in Chapter 15, “USB Antennas – (Full Capability Requires EMF 
Option 358, and either SA mode (Option 233 Mixed Analyzers) or OTA—5G 
NR / 5G NR EVM Conducted Option 378)”.

4. Then press Esc > Back > Measure 1 or Trace 6 > More (required for OTA 
only) > Data Logging to view the Data Logging softkeys and set the Record 
Settings, Record Save/Recall, and More > Indoor Map Data Logging or 
Signal Locate.

— For Outdoor Mapping: Record Save/Recall > File Folder Default 
System

— Default – Sets the default User Folder path: 

——List files (*.csv and *.kml) are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\CS\"

——Record-Play files are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\CS\" 
 
Or

— System – Sets the User Folder to the user defined system 
folder path/name: 

——List files are save to-from 
"CurrentDevice\<UserSelectedFolder>\" 

——Record-Play files are save-recalled to: 
"CurrentDevice\<UserSelectedFolder>\"

Refer to “File Management” on page 777. 

— Then File Type

— KML (default) or

— CSV

— Then Save Log File.

or

— Then Recall Log File.

— Optional Auto Save ON (default = OFF). To avoid loss of data, if 
power loss occurs.

— Then Back

5. Set up indoor mapping press More > Indoor Map Data Logging then 
choose
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— Press Record Indoor Data – opens a menu of previously stored PNG 
files to select to record a new data log.

a. Scroll to indoor floor plan *.png file.

b. Press Recall File - enables you to recall previously stored *.kdat file 
that you can view or modify.

c. Move the position cursor to current location:

— Then press Pan to open a menu of softkey to enable you to 
move the position cursor to current location and mark data 
points, using East, West, North, and South softkeys.

— Or you can use the  arrows, the rotary knob, or 
numeric keypad locate the position cursor to current location.

d.  Then press Record Data when pointer is in desired position to enter 

a new data point. 

e.  Repeat step c and d for all other required position locations.

Else, continue to next step.

f.  When done, press Back (If you used the Pan softkey menu) > More 
> Save Map to save results to a *.KDAT file.

If a "Error: This data point not ready..." is displayed, verify the 
measurement setup, including the antenna setup, if applicable, and 
ensure the measurement is successful.

A KDAT file is the file FieldFox uses to recall an indoor mapping/data 
logging session (“Recall Indoor Log File”). It's an archive file that contains 
information about the original image file, the location of the recorded data 
on the image and the actual recorded data. KDAT files can only be opened 
with FieldFox itself. KDAT files cannot be opened via Data Link. 

An auxiliary CSV data file is generated automatically, each time a KDAT file 
is saved during an indoor mapping session. The CSV contains the recorded 
data, without the image, location of the recorded data, etcetera.
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Figure 16-15 Example of an Indoor Building Map with Single Icon and Bore Sight Pointer
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Option 352 Outdoor Maps Setup Procedure 

Outdoor mapping requires GPS Option 307.

1. Set up your measurements in Channel Scanner, OTA, or Phased Array 
Antenna. See also, Chapter 13, “Over–the–Air Measurements (OTA) – LTE 
FDD Option 370, LTE TDD Option 371, 5G TF Option 377, 5G NR / 5G NR 
EVM Conducted Option 378,” and Chapter 27, “Channel Scanner (Option 
312).”

One or more are required:

— For setting up GPS Option 307, refer to Chapter 30, “System 
Settings,” and then “GNSS (GPS+) and GPS” on page 756.

— For setting up a phased array antenna, refer to Chapter 14, “5G 
Rapid Prototype Phased Array Antenna – Option 360.”

— For setting up a USB antenna, refer to Chapter 15, “USB Antennas – 
(Full Capability Requires EMF Option 358, and either SA mode 
(Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM 
Conducted Option 378).”

2. Plan the area you want to map with GPS Option 307 enabled. 

a. Optional (Can be done later): Save mapping pictures to the FieldFox 
using USB storage device, SD card, or connect to LAN with internet 
and download. Refer to “How to Install Node.js and Running the 
FieldFox Mapping Software” on page 462. For FTP, refer to 
http://na.support.keysight.com/fieldfox/help/Programming/webhel
p/FFProgrammingHelp.htm.

b. Optional (Can be done later): 

IMPORTANT! 

85571A-028 (28 GHz 5G Phased Array Antenna) accessories not suitable 
for use in wet locations.

Saving and importing maps can be done now or after the outdoor map 
locations have been measured. Before you can save and import maps via 
the internet, your PC requires the FieldFoxMapping software. Refer to 
“How to Install Node.js and Running the FieldFox Mapping Software” on 
page 462.

Saving and importing maps can be done now or after the outdoor map 
locations have been measured. Refer to “How to Install Node.js and 
Running the FieldFox Mapping Software” on page 462.
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— Set up the Record Settings (Outdoor Mapping only): Press 
Trace 6 > More (OTA mode) > Data Logging > Record Settings 
> Meas Interval ON > Interval Type Time Distance (select one 
of these) then Back, to exit the Record Settings menu.

— To enable Auto Save to avoid loss of data, if loss of power 
occurs: Press Record Save/Recall > Auto Save OFF ON > ON 

c. Walk or drive around the area you want to map. 

d. Optional: If you know your route, and have already downloaded a zip 
file of your mapping location or are connected to the LAN, then 
press System 7 > Utilities > Mapping > Map Explorer (Get Maps) 
then:

— Move the position cursor to current location:

— Then use the  arrows, the rotary knob, or 
numeric keypad locate the position cursor to current 
location.

— Then Edit to change the value of:

— Zoom – If a zoom value is not found, the FieldFox 
ignores the entered value and returns to the 
previously displayed Zoom setting (i.e., values must 
be between 4 and 17).

— Latitude – If a latitude value is not found the 
FieldFox displays a gray grid.

— Longitude – If a longitude value is not found the 
FieldFox displays a gray grid.

— Easting – Enter an eastern measured distance  
(i.e, x Cartesian coordinate).

— Northing – Enter an northward-measured distance 
(i.e., y Cartesian coordinate).

— Grid Reference – Valid in UK only.

— Red Limit – Determines the dBm value of the red 
limit (default = –20 dBm).

— Blue Limit – Determines the dBm value of the blue 
limit (default = –90 dBm).

When done entering each setting, press Enter.
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Figure 16-16 Example of England Displayed Text

e. Else, to import a *zip file (i.e., you can come back and do this later 
after the mapping route is defined).

i. Press System 7 > Utilities > Mapping 

ii. Then to import map pictures, press Map Explorer (Get Maps) 
> Import Maps

iii. Press Import Maps (ZIP) > Recall File and change latitude and 
longitude values to view site maps from pictures (KML). 

3. If not done, connect your equipment similar to Chapter 14, “5G Rapid 
Prototype Phased Array Antenna – Option 360”, Chapter 15, “USB 
Antennas – (Full Capability Requires EMF Option 358, and either SA mode 
(Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM Conducted 
Option 378)”, and to Figure 14-1 on page 409

See also, 

— For setting up GPS Option 307, refer to Chapter 30, “System 
Settings,” and then “GNSS (GPS+) and GPS” on page 756.

— For setting up a phased array antenna, refer to Chapter 14, “5G 
Rapid Prototype Phased Array Antenna – Option 360.”

Import ZIP file using FieldFox Map Support Tool with Import Maps (ZIP) 
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— For setting up a USB antenna, refer to Chapter 15, “USB Antennas – 
(Full Capability Requires EMF Option 358, and either SA mode 
(Option 233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM 
Conducted Option 378).”

4. Install street maps into the FieldFox. Refer to “How to Install Node.js and 
Running the FieldFox Mapping Software” on page 462.

Downloading map options:

— Store the maps *.zip file onto USB or SD card and the FieldFox can 
load from USB, SD card, or internal drive (if the maps are saved to 
the FieldFox).

— Connect the FieldFox to the LAN with internet access and use the 
FieldFox Mapping software to download a maps image *.zip file.

— If necessary, you can download the maps at later time.

5. Using Discrete Colors softkey Menu, set the red (maximum) and blue 
(minimum) values. For setting color coded bar scale preferences, refer to 
Chapter 30, “System Settings,” and “Using the Discrete Colors Softkey 
Menu” on page 754.

a. Press System 7 > Utilities > Mapping > Map Explorer (Get Maps)

b. Optional: Select the Red or Blue Limits to edit by using the  
arrows, the rotary knob, or numeric keypad to position the trace for 
optimum viewing on the FieldFox display. 

Then Edit (the color coded bar scale Red or Blue limits are at the 
top of the FieldFox display).
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Figure 16-17 Using Maps Explorer to Set the Red and Blue Power Limits

c. Optional: Then Preferences > Discrete Colors > Discrete Colors > 
Discrete Colors and change value as desired (Maximum = 6).

Figure 16-18 Display Example: Color Coded Bar Scale Before Selecting x6 Colors

Figure 16-19 Display Example: Color Coded Bar Scale After Selecting x6 Colors

6. Verify you have enabled GPS. Refer to your measurements procedure and 
to “GNSS (GPS+) and GPS” on page 756. 

7. Then press Esc > Back > Trace 6 > More (required for OTA only) > Data 
Logging > Record Save/Recall 

— Then File Folder Default System

— Default – Sets the default User Folder path: 
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——List files (*.csv and *.kml) are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\CS\"

——Record-Play files are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\CS\" 
 
Or

— System – Sets the User Folder to the user defined system 
folder path/name: 

——List files are save to-from 
"CurrentDevice\<UserSelectedFolder>\" 

——Record-Play files are save-recalled to: 
"CurrentDevice\<UserSelectedFolder>\"

Refer to “File Management” on page 777. 

— Then File Type

— KML or

— CSV (default)

— Then Save Log File.

or

— Then Recall Log File.

— Optional Auto Save ON (default = OFF). To avoid loss of data, if 
power loss occurs.

— Then Back

8. Set up the outdoor mapping:

a. Press Trace 6 > Data Logging 

b. Then press Record

c. When done, Stop

d. Save results to KML file.

9. View KML with map tools. 

— On the FieldFox, see the data results overlaying OpenStreetMaps’ 
pictures. 

Or use Google Maps or similar to view your maps on your PC. Refer 
to “Import and Play back KML Files into 3rd Party Software 
(Example: Google Earth with Animation Tool)” on page 484.
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Figure 16-20 FieldFox Display with View Map ON and OFF Displayed

Import and Play back KML Files into 3rd Party Software (Example: 
Google Earth with Animation Tool)

Features

Use the Playback Slider to replay measurement results. See also Google Maps 
and or Google Earth’s help. Refer to Figure 16-21 on page 485.
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— Open the FieldFox *.KML file in Google Earth. The time slider appears in 
upper left of the map.

— Manual Mode – Move the time slider cursor to see color-coded icons 
pop-up according to the timestamp.

— Loop mode has a Fast-Slow Replay Option.

— Click on each color coded balloon to see the table of measurement results 
for that location.

Figure 16-21 Importing a KML File Into Google Earth
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Setting up Data Logging

There are two types of data logging:

“Enabling Outdoor Map Logging” on page 486 and

“Enabling and Setting Up Indoor Map Logging” on page 489

See also, “Option 352 Indoor Maps Setup Procedure” on page 474 and 
“Option 352 Outdoor Maps Setup Procedure” on page 478.

Opening the Data Logging settings: 

— Press Mode (Channel Scanner (Option 312) only) > More (Depending 
on the number of options installed, may not be necessary) > Channel 
Scanner 

— Press Measure 1 (Channel Scanner (Option 312) only) or Trace 6 > 
Data Logging 

Enabling Outdoor Map Logging

If you have already setup your outdoor or indoor map logging:

— Then Record to being logging data or

— Then Play If this softkey is active, you are currently recording or you have 
recalled a previously stored data logging file 

When Play is pressed, then choose:

— Cursor Position use this softkey to move the data log play cursor in 
the current data log being played (i.e., Cursor Position is active only 
when playback is paused).

This softkey is only available in Channel Scanner and Phased Array 
Antenna modes (i.e., The Cursor Position softkey is not available for 
OTA mode).

— Maps – to open a softkey menu enable map view and related features 
(e.g., Data Selection, Red/Blue Limits, Zoom, and Labels & Icons). 
Learn more, refer to step 3. 

or

— Then View (available in Channel Scanner mode and with Outdoor Mapping 
only)

Then choose:

— Exit to leave the current View softkey menu and return to the previous 
menu.

— Zoom use this softkey zoom in/out.
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This softkey is only available in Channel Scanner and Phased Array 
Antenna modes (i.e., The Cursor Position softkey is not available for 
OTA mode).

— Red Limit to edit the red maximum power limit dBm value.

— Blue Limit to edit the blue minimum power limit dBm value.

Setting up Outdoor Mapping

1. Press Record Settings — then choose:

— Meas Interval OFF ON Enable to make the measurement interval 
softkeys active (default = OFF).

— Interval Type choose Time or Distance.

— Time Interval Enter time in seconds (1s to 3.6 ks) or

— Distance Interval Enter time in miters (10m to 10 km)

2. Press Record Save/Recall Opens a softkey menu to manage your data 
logging filenames and file folder locations

— Save Log File or

— Recall Log File (if you have previously stored data)

— File Folder Default System (Default = Default) or

— File Type (Default = CSV) KML or DREC (DREC applies to Option 360 
only)

— Auto Save OFF ON To enable/disable auto save to protect your data, 
if power is lost (Default = OFF)

— Then Back

3. Then choose from the following:

— Press Record to begin a new data log recording.

— Press Pause Resume (only displayed after Record has been pressed) 
Temporarily halts recording until pressed again. The incoming trace 
continues to sweep. Press again to continue recording.

— Press Play If this softkey is active, you are doing a new recording or 
you have recalled a previously stored data logging file.

— Press Stop Immediately

— The Save the log file menu opens. Edit the filename and 
press Done to exit menu. See Settings below and “To 
change Data Logging Configuration settings:” on 
page 500.
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— To change your file settings or measurement interval. 
Learn more, refer to “To change Data Logging 
Configuration settings:” on page 500.

— Press Maps – to open a softkey menu enable map view and related 
features (e.g., Data Selection, Red/Blue Limits, Labels & Icons, 
Zoom). 

Then choose from the following:

——View Map OFF ON To enable/disable the current 
map view (default = latitude/longitude = 0.00/00. 
Need GPS to view current location (default = 
OFF).

——Data Selection Opens a softkey menu to set the 
active data channel, sort type, and sort order. 

Then Choose:

——Red/Blue Limits Opens a softkey menu to assign 
power values to the red (high power limits) and 
blue (low power limits) heat map display limits 
(defaults: Red Limit = –20 dBm, Blue limit = –90 
dBm).

——Zoom Zoom in/out on the map displayed.

——Labels & Icons Opens a softkey menu to 
enable/disable map data point labels and icon 
types. 

Then choose from the following:

Channel 1 Sets the data channel being recorded. 
Available channels will vary within each 
mode.

Sort  
Power Freq

Sets the type of measurement displayed 
(Power or Frequency).

Sort Order  
Up Down

Sets the sort order to ascending (Up) 
greater power/frequencies displayed first 
or descending (Down) lowest power or 
frequency values displayed first.

Back Returns to previous softkey menu.

Labels  
OFF ON

Enables/Disables map data point labels. 
When enabled, a label is displayed for every 
map data point (e.g., “Data 1”). When 
disabled, labels are not displayed for the 
map data points.
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—— Save Image (PNG) Saves the current displayed 
map to a *.png file (default filename is 
“MapImageFile”). This softkey is available (active) 
when View Maps = ON.

Enabling and Setting Up Indoor Map Logging

1. Press Measure 1 > Data Logging > More

2. Press Indoor Map Data Logging — then choose:

— Record Indoor Data – Use this option to load a new floor–plan image 
to plot data points and lines of bearing to emitter signals. 

— Recall Indoor Log File – (if you have previously stored data (*.kdat)). 
You can recall a log file and add/delete directional finding lines of 
bearing and map data to previously saved files. Re-save them and 
resume data collection at a later time. 

After a *.png is opened for a new recording or a *.kdat file is recalled 
for editing and displayed on the FieldFox, then choose from the 
following:

Icons  
Flag Point 
Line

Sets the type of icon that is used to display a 
map’s data points.

Record-Play files are saved to:

— If File Folder is set to Default then Record-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\[Current mode]\"

— If File Folders are set to System, then Record-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   

Learn more about file settings, refer to Chapter 32, “File Management.”

IMPORTANT! 

When you recall a *.kdat file, you are able to add mapping points, but you 
will only be able to save the changes as a *.png. file. Optionally, if you save 
a file as a *.png file and then recall the file, you can add data points and 
save the changes as a *.kdat file.
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— Navigate OFF ON To enable/disable map location changes 
using arrow keys and the RPG (when ON). When OFF the 
arrow keys and RPG enable you to highlight and Edit the 
Navigate, Red Limit, and Blue Limits in the Setting table. 
(Default = OFF)

— Pan Navigate map East, West, North, South using arrow 
keys).

— Zoom Zoom in/out on the map displayed. 

— Bearing Line This similar to the outdoor direction finding 
feature. It allows a “Bearing line” to be on or off, the angle 
of Bearing Line to be setup, and its length to be set. All 
very similar to the outdoor direction finding procedure. 
From this Bearing Line menu, you can also select a point to 
edit/change.

— Record Data To record a data point in the specified 
intervals using currently selected labels and icons.

A KDAT file is the file FieldFox uses to recall an indoor mapping/data 
logging session (“Recall Indoor Log File”). It's an archive file that contains 
information about the original image file, the location of the recorded data 
on the image and the actual recorded data. KDAT files can only be opened 
with FieldFox itself. KDAT files cannot be opened via Data Link. 

An auxiliary CSV data file is generated automatically, each time a KDAT file 
is saved during an indoor mapping session. The CSV contains the recorded 
data, without the image, location of the recorded data, etcetera.

Before you can set a Bearing Line value, you first must “Record” a point, before you can turn its 
bearing line on or off, change its length, and angle. See also, “How to Add Directional 
Finding (DF) Bearing” on page 496. 

Bearing Line 
OFF ON

Enables and disables the Bearing Line between 
two points.

Angle Sets the angle of the Bearing Line (default = 0°, 0 
to 360°).

Line Length Sets the length of the Bearing Line to connect two 
points (default = 100).

Select Point Sets the point to be edited.

Back Takes you back to the previous softkey menu.
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To enable the Record Data softkey, move the cursor using 
the arrow hardkeys or the RPG to highlight the Location: 
Value cell in the table. Begin walking with an antenna and 
press Record Data as required to map a location.

— More Opens a menu of softkeys to Undo, set Labels & 
Icons, RPG actions, Save Image, and Back.

Labels & Icons Opens a softkey menu where you can 
enable/disable and select map icons:

——Labels OFF ON - 
Enables/Disables map data 
point labels. When enabled, a 
label is displayed for every map 
data point (e.g., “Data 1”). When 
disabled, labels are not 
displayed for the map data 
points.

——Icons Flag Point Line - Sets 
the type of icon that is used to 
display a map’s data points.

——Pointer OFF ON- 
Enables/disables the bore sight 
pointer.

Undo To undo last indoor map setting change

RPG [Zoom] Opens a menu to set the RPG’s functionality for 
mapping. Choose from: 

——Zoom - (default) Zooms in/out.

——<––> - RPG knob moves the 
map East or West.

——^|v - RPG knob moves the map 
north or south.
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3. Press Record Save/Recall Opens a softkey menu to manage your data 
logging filenames and file folder locations

— Save Log File or

— Recall Log File (if you have previously stored data)

Data Selection Opens a softkey menu to set the active data 
channel, sort type, and sort order. 

——Channel 1 - Sets the data 
channel being recorded. 
Available channels will vary 
within each mode.

——Sort Power Freq - Sets the 
type of measurement displayed 
(Power or Frequency).

——Sort Order Up Down - Sets the 
sort order to ascending (Up) 
greater power/frequencies 
displayed first or descending 
(Down) lowest power or 
frequency values displayed first.

Save Opens a softkey menu to enable you to save your 
map (.kdat) or your image (.png).

——Save Map - Opens “Save the 
log file” where you can name 
and save your map file (kDAT). 
Softkey is only visible when data 
is recorded on a *.png file using 
Labels & Icons feature and the 
Record softkey.

——Save Image (PNG) - Saves the 
current displayed map to a *.png 
file (default filename is 
“MapImageFile”). This softkey is 
on active when View Maps = O.

Back Returns to previous softkey menu.

A KDAT file is the file FieldFox uses to recall an indoor mapping/data 
logging session (“Recall Indoor Log File”). It's an archive file that contains 
information about the original image file, the location of the recorded data 
on the image and the actual recorded data. KDAT files can only be opened 
with FieldFox itself. KDAT files cannot be opened via Data Link. 

An auxiliary CSV data file is generated automatically, each time a KDAT file 
is saved during an indoor mapping session. The CSV contains the recorded 
data, without the image, location of the recorded data, etcetera.
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— File Folder Default System (Default = Default) or

— File Type (Default = CSV) KML or DREC (DREC applies to Option 360 
only)

— Auto Save OFF ON To enable/disable auto save to protect your data, 
if power is lost (Default = OFF)

— Then Back

Outdoor Mapping Only: Export KML File Into 3rd Party Mapping 
Software

—  Export KML file into 3rd party mapping software (i.e., Google Map or 
Google Earth). Refer to “Import and Play back KML Files into 3rd Party 
Software (Example: Google Earth with Animation Tool)” on page 484.

Record-Play files are saved to:

— If File Folder is set to Default then Record-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\[Current mode]\"

— If File Folders are set to System, then Record-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   

Learn more about file settings, refer to Chapter 32, “File Management.”
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How to Use Data Logging (Option 352)   

Data Logging enables you to use GPS mapping data and play them back at a 
later time. Use this feature to overlay Maps pointers on your indoor or outdoor 
files.

Data logs can be saved to the FieldFox Internal memory, an SD Card, or a USB 
flash drive.

This section assumes you have already completed the initial setup and have a 
measurement setup in the FieldFox. 

This section contains the following sections:

—  “Screen Annotation” on page 494

—  “How to Add Directional Finding (DF) Bearing” on page 496

—  “How to Record a Data Log (Outdoor Logging Only)” on page 499

—  “To change Data Logging Configuration settings:” on page 500

—  “How to Play a Data Log” on page 500

Screen Annotation

During a record or playback session, the following is displayed in the 
top-center area of the screen:

—  Rec: 55/55 2018-12-31 03:26:11 PM    

where:

— 55/55 is the current and total trace number: currently trace is 55 of 55 total 
scans.

— 2018-12-3103:26:11 PM is the date and time of recording.

— The name of a recording can be changed using Manage Sessions. Learn 
more in “To change Data Logging Configuration settings:” on page 500.

See also, the FieldFox User’s Guide’s Settings” chapter. 

When GPS is enabled, GPS R is indicated at the bottom of the FieldFox 
display. Learn more, see the FieldFox User’s Guide’s “System Settings” 
chapter.

The Mapping mode can display and be data logging can be recorded/played 
back in field strength units (Option 360 only), when the units are changed: 

Data Log-Play files are saved to:

— If File Folder is set to Default then Record-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\[Current mode]\"

— If File Folders are set to System, then Record-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\"
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— Press Scale /Amptd > More > Unit then choose:

— dBmV, dBuV, W, V, A, dBmA, or dbuA (Default Units: dBm)

See Figure 16-22 on page 495.

Figure 16-22 Field Strength Annotation that can be Recorded and Played Back

If Data Logging or playback is not occurring when you think it should, 
check the following:

— Is the sweep in HOLD? (upper-left annotation), or check the Sweep menu 
for Continuous set to OFF.

— Is Recording or Playback Paused? (mid-left annotation)

— Is the Data Logging measurement Interval set too long? (Configuration 
settings.)
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How to Add Directional Finding (DF) Bearing

DF Bearing adds the ability add points to the map at your current location 
indicating a signal emitter's strength and direction relative to your position. 
Refer to Figure 16-23 on page 498 and Figure 16-24 on page 499.

See also, “Downloading and Using the FieldFox Map Support Tool” on 
page 464.

— Press Mode > More (Depending on installed options, may not be 
necessary.) > Channel Scanner 

— Press Measure 1 > Data Logging > More 

— Optional (Ignore for Outdoor Mapping): Press Indoor Map Data Logging 
then choose:

— Press Record Indoor Data – Use this softkey to load a new floor-plan 
image (*.png) to plot data points and lines of bearing to emitter 
signals or

— Press Recall Indoor Log File– (if you have previously stored data 
(*.kdat)). You can recall a log file and add/delete directional finding 
lines of bearing and map data to previously saved files. Re-save them 
and resume data collection at a later time. 

Indoor and Outdoor Data Logging

— Then Signal Locate 

— Then Add Point – adds a new bearing location then:

— Press Direction Line OFF ON – Enables/disables the line of bearing 
(default = OFF).

— Press Adjust Angle – Enters the angle of the current point’s line. 
Rotate the line about the current point (your current location) to point 
towards the highest signal strength seen by your directional antenna. 
You can rotate the knob to rotate the line, or you can type an angle 
into the active entry directly.

IMPORTANT! You must be in Channel Scanner Mode to use this feature.

IMPORTANT! 

When you recall a *.kdat file, you are able to add mapping points, but you 
will only be able to save the changes as a *.png. file. Optionally, if you save 
a file as a *.png file and then recall the file, you can add data points and 
save the changes as a *.kdat file.
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— Press Line Length – Enters a value for the line’s length. Adjusts the 
length of the line of bearing to extend it far enough to allow other 
points to cross, indicating a possible emitter location. 

— Press Accept Point or Back – verifies the new point is to be added 
and returns to the previous menu.

— Then Edit Points – Opens up menu of bearing point editing softkeys. 
Choose from:

— Press Select Point – Enter the point you want to edit. Then you can 

directly enter a new angle or line length or use the  arrows, or 
the rotary knob to edit these values.

— Press Direction Line OFF ON – Enables/disables the direction line 
(default = OFF).

— Press Adjust Angle – Enters the angle of the current point’s line. 
Rotate the line about the current point (your current location) to point 
towards the highest signal strength seen by your directional antenna. 
You can rotate the knob to rotate the line, or you can type an angle 
into the active entry directly.

— Press Adjust Angle – Enters a value for the line’s length. Adjusts the 
length of the line of bearing to extend it far enough to allow other 
points to cross, indicating a possible emitter location. 

— Delete Point – deletes the currently selected point.

— Then Clear Points – Deletes all of the displayed bearing points and lines.
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Figure 16-23 Directional Finding (DF) Bearing – Outdoor Map Data Logging Example
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Figure 16-24 Directional Finding (DF) Bearing – Indoor Map Data Logging Example

How to Record a Data Log (Outdoor Logging Only)

For Indoor Logging, refer to “Enabling and Setting Up Indoor Map Logging” on 
page 489.

— Press Trace 6

— Then Data Logging

— Then Record (Outdoor Logging Only)

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are save-recalled 
to: "[CurrentDevice]\RecordPlayback\[Current mode]\"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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 is displayed in the left of screen graticules.

During recording, choose from the following: 

— Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue recording. 

— Stop Immediately stops recording. Then choose from the following:

— Then Record Save/Recall To save a log file, recall a log file, or 
change your file settings. Learn more, refer to “To change Data 
Logging Configuration settings:” on page 500.

——Press Save Log File to save the current Table data (i.e., default 
save device is Internal).

— Then Record Settings (Outdoor Mapping only) To change your 
measurement interval settings. Learn more, refer to “To change Data 
Logging Configuration settings:” on page 500.

To change Data Logging Configuration settings: 

— Press Trace 6

— Then Data Logging then choose:

— Then Record Settings (Outdoor Mapping only)

— Optional: Then Meas Interval > ON

——Then Interval Type > choose Time or Distance.

——Then, if applicable Time Interval enter time interval in seconds. 

Or

——Then, if applicable Distance Interval enter distance interval in 
miters. 

— Then Record Save/Recall 

— Then Device (Internal (default), SD Card, or USB)

— Then File Type (CSV (default), DREC (Option 360 Only), or KML)

Learn more, refer to the Chapter 32, “File Management”. 

How to Play a Data Log

— Press Trace 6

— If the session is already open, skip the following step. Otherwise: 
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— Then Data Logging > Record Save/Recall

— Then Recall Log File use the Use the RPG or the  arrow keys to 
highlight the file to be played.

——Then Recall File 

——Then Back 

— Then Play to playback your Table data.

 is displayed in the left of screen graticules during playback. When the 
end of the recording is reached, playback begins at the start of scan and 
continues to loop indefinitely. 

During playback, choose from the following: 

— Pause Resume Temporarily halts playback. Then choose from the following:

— Pause Resume Press to continue playing. 

— Stop Immediately stops playback. Then choose from the following:

— Play Start playback from start of scan.

— Recall Log File Opens a list of stored data files.

Select a file to playback. 

— Recall File 

— Back 

— Cursor Position use this softkey to move the data log play cursor in the 
current data log being played (i.e., Cursor Position is active only when 
playback is paused).

This softkey is only available in Channel Scanner and Phased Array Antenna 
modes (i.e., The Cursor Position softkey is not available for OTA mode).

— Red Limit to edit the red limit dBm value.

— Blue Limit to edit the blue limit dBm value.

Troubleshooting
This section contains the following:

— “General Troubleshooting”

If these are large recordings on a device, it could take several seconds for 
the FieldFox to display the list.
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— “Port 5000 in Use Error” on page 503

— “Miscellaneous Mapping Errors” on page 506

IMPORTANT! 

Do not change the default name of the directory path for downloading the 
Node.js program, because FieldFox uses the default program path name to 
run the Mapping feature. Refer to Figure 16-4.

Examples of Web Browsers that not supported are Internet Explorer 6, 7, 
and 8.
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General Troubleshooting

If your Mapping setup is not behaving as expected:

— Verify setup is correct by referring to “How to Set Up Mapping Settings” on 
page 471.

— Attenuator set to 0 dB

— Preamplifier set to ON

— Correct Band, Channel, and Center Frequency entered

— GNSS set to Internal

— Frequency Ref set to GPS

— ADC errors: Use Scale/Amptd > Range to adjust the absolute power 
level (dBm). 

For some data views, you need to press More to view the Range 
softkey.

— No data displayed: Press Meas Setup 4 then

——Verify the correct Antenna Settings have been entered.

— The FieldFox’s displayed annotation indicates "Check LAN 
connection. Check IP address." during pinging. 

Verify:

——The LAN address for first 3 fields matches the Static IP address 
of FieldFox. For example, if the Ball Antenna IP address is 
192.168.1.10, set FieldFox Static IP address to 192.168.1.xx.   
“xx” must be different number than shown in the last field of 
the for Ball Antenna. Refer to Figure 14-15 on page 427. 

Port 5000 in Use Error

— If the cmd.exe window displays a "This port was picked because 
5000 is in use." error, then:

a.  Type Ctrl + c in the command window

b. Press Enter

c. The command window should display text “Terminate batch job? 
(Y/N)”: 

IMPORTANT! If you forget you N9910X-028 Ball Antenna’s static IP 
address, refer to this link and the Support tab for assistance: 
www.keysight.com/find/fieldfox and then to the Phase Array Antenna 
Support Document.
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Type Y and then press Enter

The command window should display message confirming the 
termination of the batch job and close.

Refer to Figure 16-25.

Figure 16-25  Example of “This port...because 5000 is in use.” Error

If the Map Support Tool displays the error shown in Figure 16-26, it means 
the selected map area is outside the current viewable area. 

— You can either:

——Move the map area by clicking the left mouse to the area you 
have selected or

——Click the “Red X” to cancel the download

Figure 16-26  Example of “This port...because 5000 is in use.” Error
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Update Available Message

— If you see this message after opening and running the Run.bat file, ignore 
it and follow the procedure listed in,“Downloading and Using the FieldFox 
Map Support Tool” on page 464.

If you are unsuccessful in opening and running the FieldFox Map Support 
Tool when using the Run.bat then refer to, “Contacting Keysight” on 
page 5. 

Refer to Figure 16-27.

Figure 16-27  Example of “UPDATE AVAILABLE” Message
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Miscellaneous Mapping Errors

When you are you are on step 3. Save Map Images, you may see a “fetch” error 
or a ’checkerboard’ map displayed. Refer to Figure 16-28 and Figure 16-29 on 
page 506.

If you see a “fetch”, ’checkerboard’, or other map errors:

1. Close your current browser window with OpenStreetMaps.org.

2. Open a different browser.

3. If necessary, re-run the FieldFox mapping script (run.bat) to re-copy the 
“localhost:5000” address into your clipboard. 

4. Paste the “localhost:5000” address into a different browser and use 
OpenStreeMaps.org to save your Map image zip file.

Figure 16-28  Example of “This site says... Got error: Failed to fetch” Error

Figure 16-29  Example of ’Checkerboard’ Mapping Error
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17 Remote Server Mode (Requires SA Hardware/SA Option 233) 

Remote server mode enables you to connect your FieldFox to compatible 
PC-based licensed software applications (e.g., 89600 VSA software1). Refer to 
http://www.keysight.com/find/assist.

1. To order the 89600 VSA Software, refer to http://www.keysight.com/find/assist.

89600 VSA (via the Remote Server feature) are compatible with the 
frequency converter heads, but cannot apply or edit the frequency head 
corrections. Refer to “Utilities” on page 732.

The FieldFox can be used with an OML frequency extender. Refer to 
“Utilities” on page 732, the B Series FieldFox Configuration Guide 
5992-3701EN, and to “Contacting Keysight” on page 5.

FieldFox with a Remote Server mode (available with FieldFox firmware 
≥A.10.00) does not display a mode softkey, because Remote Server mode 
is only enabled when you have a SA Option 233 on the FieldFox, 
compatible 89600 VSA software license loaded and running on a remote 
PC, and connected via LAN to your FieldFox. (i.e., Requires 89600 VSA 
software version ≥22.01). Refer to http://www.keysight.com/find/assist.

When in Remote Server mode, most of the front panel hardkeys are locked 
and will beep, but perform no actions when pressed (i.e., the FieldFox front 
panel hardkeys are not relevant when connected via LAN to the 89600 VSA 
software on your remote PC). In Remote Server mode only:

— System 7 hardkey lets you change the system settings

— Esc (escape) hardkey lets you forcefully disconnect from the PC-based 
software

To gracefully disconnect (recommended) from the software, exit using the 
PC-based software’s disconnect option or shutdown the software. Refer to 
“Initial Waiting for a Connection from a PC-based and Compatible 
Licensed Software or No Remote Connection” on page 509.

If you to attempt connect a non-compatible FieldFox you will see the 
following error message: 

“Error: 38, The requested functionality is not available.” 
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In this Chapter:

See Also

“Connecting Using Remote Server” on page 509

“89600 VSA Software Overview (Requires N991xB/3xB/5xB/6xB and SA 
Option 233)” on page 511

Optional Settings:

“LAN Settings” on page 765

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720
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Connecting Using Remote Server

This section provides an overview of the FieldFox’s Remote Server mode 
instrument display messages that occur during the remote connection 
process. For more information on specific compatible PC-based licensed 
procedures refer to:

— “89600 VSA Software Overview (Requires N991xB/3xB/5xB/6xB and SA 
Option 233)” on page 511

Figure 17-1 Initial Waiting for a Connection from a PC-based and Compatible Licensed 
Software or No Remote Connection

The graphic above shows the FieldFox in the process of connecting to a 
PC-based and compatible licensed software.

IMPORTANT! 

When using a frequency converter head with remote server and 89600A 
VSA software, first verify the head has been selected in SA mode, before 
connecting to the VSA using IO Libraries. See also, “Utilities” on page 732. 
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Figure 17-2 FieldFox Display When Remotely Connected to a PC-based Software

The graphic above shows the FieldFox successfully connected to a PC—with 
an example hostname “PC123”—and to a compatible licensed PC-based 
software.

Changing Frequency Converter Head Settings

If you want to change the frequency converter head settings while using the 
VSA, first it is necessary to disconnect from the 89600A VSA:

1. Disconnect from the 89600A VSA software, using the VSA’s disconnect 

icon ( ). 

2. Change modes to another frequency converter compatible mode (e.g., 
SA/RTSA/IQA/...)

3. Change the settings on your frequency converter head. 

The frequency range in the VSA should always reflect the frequency 
converter head settings when you last connected.

4. Reconnect the FieldFox to the VSA using the VSA’s software ( ).

For more information, refer to “89600 VSA Software Overview (Requires 
N991xB/3xB/5xB/6xB and SA Option 233)” on page 511.
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89600 VSA Software Overview (Requires N991xB/3xB/5xB/6xB and SA Option 
233)

Connecting the FieldFox remotely to a PC running the 89600 VSA software, will 
start the FieldFox’s Remote Server mode. The 89600 VSA software is powerful, 
PC-based software, offering the industry's most sophisticated general purpose 
and standards specific signal evaluation and troubleshooting tools for R&D 
engineers. Even for proprietary and non-standard signals in SATCOM or 
MILCOM applications, you can make signal quality measurements with 
customized IQ constellation. Reach deeper into signals, gather more data on 
signal problems, and gain greater insight. 

— General-purpose analog and digital demodulators ranging from 2FSK to 
4096QAM 

— Flexible and custom IQ and OFDM signal analysis

— Standards specific modulation analysis including:

— Cellular: 5G, LTE & LTE-Advanced (FDD, TDD), W-CDMA, 
GSM/EDGE, cdma2000, 1xEV-DO, TD-SCDMA,

— Wireless connectivity: 802.11ax, 802.11n/ac, 802.11a/b/g/j/p, 
802.16 WiMAX (fixed/mobile), 802.15.4 Wi-SUN

— RFID

— Digital satellite video and other satellite signals, radar, LMDS

— Up to 400K bin FFT, for the highest resolution spectrum analysis

— A full suite of time domain analysis tools, including signal capture and 
playback, time gating, and CCDF measurements

— Unlimited trace displays and the industry's most complete set of marker 
functions

IMPORTANT! The following is a description of the 89600 VSA Software’s 
overall capabilities. Your instrument may not have all of the hardware and 
firmware required to use all of the 89600 VSA Software’s listed features.

The FieldFox remote server mode, requires 89600 VSA Software with 
firmware version ≥22.01.

If you have the FieldFox’s Remote Server (89600 VSA software 
connectivity), you can use the VSA software to capture and record your 
data as MATLAB files (*.mat). Learn more about FieldFox and 89600 VSA 
software, refer to http://www.keysight.com/find/assist.

If you have Option 351 I/Q Analyzer option, you can directly save your data 
as MATLAB files (*.mat). Refer to Chapter 11, “  IQ Analyzer (IQA) – Option 
351”, on page  285 and to Chapter 32, “File Management”, on page  777.
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— Easy-to-use Microsoft Windows graphical user interface

For a comprehensive FieldFox VSA mode help, refer to 
http://rfmw.em.keysight.com/wireless/helpfiles/89600B/WebHelp/89600.ht
m

For additional information on the 89600 VSA Software brochure, refer to 
https://www.keysight.com/us/en/assets/7018-02714/brochures/5990-6553.
pdf

For Technical Overview, refer to 
https://www.keysight.com/us/en/assets/7018-02679/technical-overviews/5
990-6405.pdf
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18 Interference Analyzer (SA Mode) – Option 236 

Option 236 provides Spectrogram display, Waterfall display, and 
Record/Playback.

In this Chapter

“Spectrogram Display (SA Option)” on page 514

“Common Settings for Waterfall and Spectrogram” on page 516

“Waterfall Display” on page 517

“About Sessions” on page 519

“FieldFox Setting Changes during Record and Playback” on 
page 520

“About State and User Tags” on page 521

“How to Record a Session” on page 522

“How to Playback a Session” on page 523

“Recording Configuration” on page 523

“Playback Configuration” on page 527

“Manage Sessions” on page 527

“Record Playback Example (SA Only)” on page 528
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Spectrogram and Waterfall Displays
Spectrogram and Waterfall displays provide a visual history of the measured 
spectrum. Each display type can be used to locate intermittent signals or to 
view signal levels and frequencies over time.

Spectrogram is a single horizontal line of color-coded power while Waterfall 
uses a 3-D color-coded display. The functional difference between these two 
displays is that Spectrogram provides less trace detail than Waterfall display. 
However, it also allows more traces to be viewed. 

These two displays can NOT be used with Channel Measurements.

In SA mode, Traces can be recorded from, or played back into, any 
measurement type (such as Channel Power or Occupied BW) or any display 
type (such as Spectrogram and Waterfall). See “How to Record a Session” on 
page 522 to learn how to save traces.

Spectrogram Display (SA Option)

Spectrogram draws the most recent trace record at the bottom of the stack of 
previously-drawn trace records. Drawing the live trace on the display is 
optional. 

Figure 18-1 Spectrogram display- Overlay view- with time markers 23 seconds apart. 

The following settings all contribute to the sweep time of an individual trace, 
and therefore, the total elapsed time that can appear on the screen in 
Spectrogram display:

— Frequency Range. Learn more in “Frequency Range” on page 151.

— Resolution BW and Video BW. Learn more in “Resolution Bandwidth (Res 
BW)” on page 182 and “Video Bandwidth (Video BW)” on page 183.

— Sweep Time (Acquisition). Learn more in.“Sweep Acquisition” on page 188
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— Resolution (Number of Points). Learn more in “Points ” on page 198.

How to select Spectrogram

— Press Meas 1 

— Then Interference Analysis

— Then Spectrogram

How to modify the Spectrogram

You can change how the spectrogram is displayed relative to the data trace. 
This setting affects the total number of trace records that can be displayed. 

For SA Mode:

— Press Meas Setup 4.

— Then Spectrogram Settings 

— Then Spectrogram View

— Then choose from the following:

— Overlay Displays the data trace over the spectrogram with NO 
graticules. Total trace records: 340.

— Full Screen Displays the spectrogram with NO data trace. Total trace 
records: 340.

——Top Displays the data trace below the spectrogram. Total trace 
records: 130.

——Bottom Displays the data trace above the spectrogram. Total 
trace records: 130.

How to create Time Markers (SA Only)

Use Time Markers to determine the elapsed time between any two displayed 
records. The most recent record appears at the bottom of the screen. 

— Press Meas Setup 4

— Then Time Markers 

— Then Time 

— Then enter a value from 0 (the most recent sweep record) to the maximum 

value, using the numeric keypad,  arrows, or the rotary knob. A “>” 
indicates the Time Marker.

— Then Delta

— Then enter a value from 0 (the most recent sweep record) to the maximum 

value, using the numeric keypad,  arrows, or the rotary knob. A “>>” 
indicates the Delta Marker.
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— At the current sweep speed, the difference in time between these two 
markers appears at the upper-right corner of the view as Delta Time: 
hh:mm:ss Sec.

— An invalid number (very large positive or negative) appears when a trace 
record is not available at either marker. 00:00:00 Sec appears when both 
markers are not available.

Common Settings for Waterfall and Spectrogram

Set Red and Blue Limits

The colors displayed on the Waterfall and Spectrogram represent the various 
measured power levels:

— Red = Highest power levels

— Blue = Lowest power levels

Adjust the Red and Blue limits to the power levels that you expect to measure.

The Blue limit must always be less than the Red limit. 

For SA Mode:

— Press Meas Setup 4.

— Then Spectrogram Settings or Waterfall Settings

— Then choose from the following: 

— Red Limit Using the  arrows, rotary knob, or keypad, select the 
HIGHEST power level that you expect to measure. This power level, 
and those measured higher than this level, appear Red.

— Blue Limit Using the  arrows, rotary knob, or keypad, select the 
LOWEST power levels that you expect to measure. This power level, 
and those measured lower than this level, appear Blue. 

How to Restart the Spectrogram/Waterfall

Press Sweep 3 then Restart

Waterfall settings only apply to the SA option.

The full Red-to-Blue color spectrum is visible only with Indoor display 
colors. Learn more in “Display Colors” on page 729.
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Averaging

Averaging can be enabled on the underlying measurement. Press Meas 4 then 
Average Type. Learn more in “Average Type” on page 199.

Mode Preset

Mode Preset resets ONLY the Spectrogram and Waterfall display settings. It 
does not reset the measurement settings.

— Press Preset 

— Then Mode Preset

Waterfall Display

The live trace is always drawn on a Waterfall display. Older trace records scroll 
up from the displayed trace and eventually off the screen. Because of this, 
locate the live trace on the bottom of the screen using the scale and reference 
settings. Learn how in “Scale and Units” on page 157. 

The following settings all contribute to the sweep time of an individual trace, 
and therefore, the total elapsed time that can appear on the screen in Waterfall 
display:

— Frequency Range. Learn more in “Frequency Range” on page 151.

— Resolution BW and Video BW. Learn more in “Resolution Bandwidth (Res 
BW)” on page 182 and “Video Bandwidth (Video BW)” on page 183.

— Sweep Time (Acquisition). Learn more in.“Sweep Acquisition” on page 188

— Resolution (Number of Points). Learn more in “Points ” on page 198.

Waterfall Angle

This setting allows you to show more or less detail. More detail provides fewer 
(time) records.

— Press Meas Setup 4

— Then Waterfall Settings 

— Then Waterfall Angle

— Then choose from the following: 

— Moderate Compromise between detail and number of records.

— Steep Least detail with highest number of records.

— Gradual Most detail with lowest number of records.

Although this document refers to past traces as ‘records’ these traces are 
not saved. They are only drawn on the FieldFox screen. See “Record 
Playback Example (SA Only)” on page 528 for how to save traces.
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— Wide Angle Moderate angle with increased space between records. 

Learn how to set Red and Blue Limits in “Set Red and Blue Limits” on 
page 516.
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Record/Playback (SA Option)
Record Playback allows you to record SA trace sweeps and play them back at a 
later time. Use this feature to monitor spectrum activity over a period of time.

You can record traces continuously, record a specified number of traces 
(segments), or record when triggered by a specified power level.

Traces can be recorded from, or played back into, any measurement type (such 
as Channel Power or Occupied BW) or any display type (such as Spectrogram 
and Waterfall).

When GPS is enabled, the current location and elevation are saved and played 
back with traces.

Recordings can be saved to the FieldFox Internal memory, an SD Card, or a 
USB flash drive. 

About Sessions

A Recording Session is a collection of recorded traces and the instrument 
states that generated them.

Before recording can occur, a new session must be initiated or an existing 
session must be opened. Sessions can later be opened for playing or continued 
recording. Only one session can be open at a time. 

You close the session when finished recording or playing. A session is also 
closed when the FieldFox is Preset (or Mode Preset), an Instrument State is 
recalled, or when Mode is changed from SA.

Each session is saved as a folder containing a set of files on the specified 
storage device.

How long can a recording session last?

There are many variables that determine the possible length of a recording 
session. But one key variable is the amount of available memory. 

When a session is opened or a new session is initiated, an estimate is made of 
the maximum number of traces that can be saved based on the available disk 
space and the current number of data points (resolution). Recording will stop 
when that number is reached. This estimate always keeps 4 MB of available 
disk space on the specified storage device. You can decrease the number of 
traces to further limit recording. The resolution setting can NOT be changed 
after a session is opened.

To maximize the amount of space that is available, save recorded traces to a 
USB Flash drive or SD card. Learn how in “Manage Sessions” on page 527.

You can determine the length of time over which recording can occur by 
setting the Record Interval (the time between recorded traces) and other 
settings. Learn more in “Recording Configuration” on page 523. 
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To view and edit the maximum number of records

Just after opening or initiating a session...

— Press Session Data 

— Then TraceRecordLimit <n> (n = Max number of traces that can be 
recorded).

— Clear All Records Empties that session of recorded traces. Learn more in 
“Manage Sessions” on page 527.

FieldFox Setting Changes during Record and Playback

During Recording

When any of the following State settings are changed during recording, the 
State counter is incremented (“About State and User Tags” on page 521) and 
the settings are saved to the Session file along with the first trace to be 
recorded with the new setting. During playback, the trace and display 
annotation will reflect the change on the screen.

State settings: 

Refer to Table 18-1 for a list of the applicable state settings for the SA option.

Table 18-1 Summary of SA State Settings

Option Settings

SA

Average Type

Detector(s)

External Gain

Frequency Range 

Preamp On/Off

Resolution BW

RF Attenuation

Source Settings

Sweep Acquisition

Trigger Settings

Video BW

Zero Span Sweep Time
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Other display settings, such as Scale and acquisition, can also be changed 
during recording but are not saved with the session file. Think of these as 
settings that help YOU see the recording and playback activity. They do NOT 
change the data that is recorded.

During Playback

The State setting changes listed above are NOT allowed during playback.

However, all other display settings can be changed during playback to help 
you analyze the recorded data. 

In SA mode, when recordings are played back further trace processing is 
possible. The Trace State(s) can be modified for post processing, and different 
measurements such as Channel Power, Occupied BW, Spectrogram, and 
Waterfall can be activated. This is because in SA all these measurements are 
derived from the raw traces. If not compatible with the measurement type, a 
MEAS UNCAL message will appear on the screen.

Record/Playback Exceptions

— Markers can be activated and moved to help analyze recorded data. 
However, marker position control is only available when playback is Paused. 

— Field Strength Corrections is saved with the session file and it is also 
allowed during playback. Learn about this Field Strength Corrections in 
“Field Strength Measurements” on page 161.

— Frequency Counter at Marker is NOT allowed during Recording or Playback. 
Learn about this feature in “Frequency Counter at Marker” on page 212.

About State and User Tags

When any of the State settings (listed above) are changed during a recording, 
a ‘state tag’ is inserted at the first trace number to be recorded with the new 
setting. 

In addition, you can insert a ‘User Tag’ at any time during a recording session 
to indicate an external event, such as when an antenna is moved. During 
playback, you can move quickly to any of these tags, or scroll through these 
tags. 

A symbol is used on the screen annotation to distinguish a User Tag from a 
State Tag when scrolling through tags during playback.

Screen Annotation

During a record or playback session, the following is displayed in the top-left 
area of the screen:

—  AutoSession02: 92/95 (state 4/5)_*_ 
Sep.22.2018 09:15:15 AM    

where:
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— AutoSession is an auto-generated name for sessions. 02 is the 
auto-generated number, incremented with each new session. The name 
can be changed using Manage Sessions. Learn more in “Manage Sessions” 
on page 527. 

— 92/95 is the current and total trace number: currently trace is 92 of 95 total 
traces.

— state 4/5 is the current and total state tag or user tag number: 4 of 5 total 
tags. 

— * (Asterisk) indicates that a state has changed. # (Pound) indicates that a 
User Tag has been inserted.

— Sep.22... is the date and time of recording.

When GPS is enabled`, the current location and elevation are annotated at the 
bottom of the playback display. Learn more in “GPS” on page 746.

— Is the sweep in HOLD? (upper-left annotation)

— Is Recording or Playback Paused? (mid-left annotation)

— Is the Record or Playback Interval set too long? (Configuration settings.)

How to Record a Session

— Press Trace 6

— Then Record Playback

— SA Only: Optionally set resolution (points). Learn how in “Points ” on 
page 198. This can NOT be changed after a session is opened. 

— Then either:

— New Session OR

— Recall Session then Open and select a session. 

— Then Recorder Player

— Then Record

REC is displayed in the left of screen graticules.

During recording, choose from the following: 

— Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue recording. 

— Stop Immediately stops recording. Then choose from the following:

— Press Play to start replaying the recording from the beginning.

If Recording or Playback is not occurring when you think it should, check 
the following:
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— Press Record to continue recording.

How to Playback a Session

— Press Trace 6

— If the session is already open, skip the following step. Otherwise: 

— Then Record Playback Setup

— Press Recall Session Then select a session to playback and press 
Open.

— Then Recorder Player

— Then Play

PLAY is displayed in the left of screen graticules during playback. When the 
end of the recording is reached, playback begins again at trace 1 and 
continues to loop indefinitely. 

During playback, choose from the following: 

— Pause Resume   Temporarily halts playback. Then choose from the 
following:

— Pause Resume   Press to continue playing. 

— Playback State/Tag Allows you to continue playback from a state 
tag, or scroll through the state tags. Enter a value between 1 and the 

total number of state tags using the numeric keypad,  arrows, or 
the rotary knob. Active when playback is paused. Learn more in 
About State and User Tags in “About State and User Tags” on 
page 521.

— Playback Trace Activated automatically when Paused. Allows you to 
continue playback from a specific trace, or scroll through traces 
manually. Enter a value between 1 and the total number of traces 

using the numeric keypad,  arrows, or the rotary knob. 

— Stop Immediately stops playback. Then choose from the following:

— Play Start playback from trace 1.

— Record Resume recording from the last recorded trace.

— Record Playback Setup Return to the setup menu to change 
Configuration settings or Close the session.

Recording Configuration

To change Recording Configuration settings:

— Press Trace 6
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— Then Record Playback

— Then New Session or Recall an existing session.

If New Session is selected:

— Then Session Data and choose one of the following:

— Then CSV SaveStyle

——Single Trace (default) saves the currently displayed trace.

——Range Traces saves the currently displayed trace. This 
selection requires you to manually select a range of traces to 
be recorded in the Playback Configuration menu. Refer to 
“Playback Configuration” on page 527.

——AllTraces saves all traces.

— Then TraceRecordLimit to change the maximum recording file size.

— Then Clear AllRecords to clear all traces out of memory.

— Then Back to return to previous menu.

— Then Recording Configuration

Then choose from the following:

— Record Time Sets the amount of time to record traces. Default is MAX, 
which is to record indefinitely. Enter a value between 1s and 1 Ms (million) 

seconds using the numeric keypad,  arrows, or the rotary knob. When 
set, a timer appears during recording in the lower-left corner which counts 
DOWN from the specified time.

— Record Source Sets where, in the FieldFox data flow, data is recorded. 
Learn more in “Record Source” on page 526. Choose from the following:

— RawMeas Records raw measurement data.

— Trace 1,2,3,4 Records data from the corresponding trace in its 
current state. 

— Record Interval Sets the amount of time to wait between individual trace 
recordings. Default is MIN, which is to wait 0 seconds (record traces as fast 
as possible). Enter a value in seconds between 0 (no delay) and 10,000 

seconds - about 3 hrs) using the numeric keypad,  arrows, or the rotary 
knob. 

— Segment Count Sets the number of traces to record, after which the 
recording will automatically pause. Press Pause/Resume or Record to 
capture another N traces, or Stop to end recording. Default is OFF, which is 
NO limit to the number of traces to be recorded. 

When set, a counter appears in the lower-left corner which counts UP to 
the specified number of recordings. 
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— FreqMaskTrigger OFF ON 

Sets the power level which will trigger a recording. Set these power levels 
(mask) exactly as you would set Limit Lines. (See “All about Limit Lines” on 
page 715.) With Record ON, when any data point measurement is higher 
than an upper limit, or lower than a lower limit, recording begins. See 
Frequency Mask Trigger Configuration in the following section to learn how 
to configure the mask.

Typically you would use FreqMaskTrigger with Segment Count, but it can also 
be used with Record Time and Record Interval.

When used with Segment Count:

— When a mask limit is exceeded, subsequent traces are recorded until the 
specified segment count is reached. Once segment count is reached, 
exceeding another mask limit will again cause traces to be recorded until 
the segment count is reached, and so forth.

— To record only those traces that exceed the limit, set Segment Count to 1

— To record ALL traces after a limit is exceeded, set Segment Count OFF.

When used with Record Time, the timer counts down even when traces are not 
being recorded (limits are not being exceeded). Recording starts when a limit is 
exceeded and stops when the timer reaches 0.

When used with Record Interval, a trace is recorded when a limit is exceeded, 
then no recordings during the specified ‘wait’ interval, then the next trace is 
recorded, followed by another time delay, and so forth.  This pattern repeats 
indefinitely if Segment Count is OFF, or (if ON) until Segment Count is reached.

Frequency Mask Trigger Configuration (SA Mode Only)

Create or recall a Frequency Mask to be used with the FreqMaskTrigger 
feature.

A mask that is in use during a recording is NOT saved with the recording and 
does NOT automatically appear during playback. Like Limits Lines, it is saved 
and recalled with a state file. 

Although they are created in the same manner, Limit Line files and FreqMask 
files can NOT be used interchangeably.

Frequency Mask Trigger only applies to SA mode.

The Mask file is saved to, and recalled from, the Save /Recall Storage 
Device location – NOT from the Record Playback Storage Device location. 
These are two different settings. Learn how to set the Save /Recall Storage 
Device in “Set File Type and Select Device” on page 783. 
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— Press Trace 6

— Then Record Playback

— Then New Session or Recall an existing session. The current mask appears 
as soon as a session is opened. 

— Then FreqMaskTrigger Configuration

— Then choose from the following

— Edit Mask Create or modify the current mask. Learn how to edit the 
Mask / Limit Line table in “All about Limit Lines” on page 715. 

— Save Mask Saves the current mask to a file. 

— Recall Mask Loads a mask file.

Record Source

For SA mode, the simplest way to use Record Playback is to record RawMeas 
data, which can then be played back into all of the current Trace States. 

However, for more complicated processing, refer to the following diagrams. 
These figures illustrate where in the FieldFox data flow data is recorded and 
played back.

Figure 18-2 FieldFox SA Mode: Data Flow and Record Playback Data Points

The RawMeas data setting only applies to SA Mode. 

For this discussion, it is important to understand Trace States. Learn more 
in “Trace Display States (SA Mode)” on page 198. 
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SA Data Recording:

— Data can be recorded at the Raw Meas block where data is acquired after 
ResBW, VideoBW, and Detector processing, but before any trace state 
processing.

— Data can be recorded from Traces 1,2,3, or 4 which includes the trace state 
(Max Hold, Min Hold, and so forth).

— Recording from a Clear/Write trace yields exactly the same data as 
recording from the Raw Meas block. 

— Data is ALWAYS played back at the same location in the data flow: just after 
the Raw Meas block, through all currently active Traces, and onto the 
display. 

— See an example using Record Playback with Max Hold traces in “Record 
Playback Example (SA Only)” on page 528.

Playback Configuration

By default, trace sweeps are played back as fast as the trace can be drawn on 
the screen. The following setting allows you to slow playback. In addition, you 
can manually scroll through individual traces using Playback Trace, or scroll 
through State and User Tags using Playback State/Tag. Learn more in How to 
Playback a Session in “How to Playback a Session” on page 523.

To slow playback of a session:

— Record a new session or Open an existing session.

— Press Playback Configuration

— Then Playback Interval

— Enter a value in seconds between 0 (no delay) and 100 using the 

numeric keypad,  arrows, or the rotary knob. After using the 
keypad, select a multiplier key. Learn about multiplier abbreviations.

— Press Enter

— First Trace to define the first trace in a Range of traces to be 
recorded/played/saved.

Manage Sessions

— Press Trace 6

— Then Record Playback

— Then Record Playback SetupThe following selections are available ONLY 
when a session is NOT open. 
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— Then Storage Device to select the media which stores the sessions to be 
managed. This is a different setting from the Save/Recall Storage Device 
setting. 

— Then choose from the following:

— Internal FieldFox memory (default)

— SD Card An external SD Card (must be inserted) 

— USB An external USB flash drive (must be inserted)

— Then Manage Sessions

— Then choose from the following:

— Rename Using the FieldFox labeler, change the name of the session. 
AutoSession (n) is the default name where (n) is the next-available number. 
Learn more in “How to use the FieldFox labeler ” on page 780.

— Sort Arrange the listing of sessions by Name, by Date, or by Size. 

— Delete After a confirmation prompt, removes the contents of the 
selected session from the list.

— Copy Copies the selected session to a different storage device, or the 
same storage device with ‘Copy(n)_’ appended to the beginning of 
the name so that duplication is prevented.

— Copy All Copies ALL of the listed sessions to a different storage 
device, or the same storage device with ‘Copy(n)_’ appended to the 
beginning of the names so that duplication is prevented.

— Delete All Deletes ALL of the listed sessions.

Record Playback Example (SA Only)

The following “Interval Recording” example shows how you can record spectral 
activity over a longer period of time with less trace storage.

— Press Trace 6 then, with Trace = 1, press State then Max Hold

— Then Record Playback

— Then New Session

— Then Recording Configuration

— Then Record Source to Trace1

— Then Record Interval to 10 s (seconds).

— Then Back

— Then Recorder Player

— Then Record At the end of each 10 second record interval, the Max Hold 
trace is recorded and the Max Hold processing is reset for the next 10 
second record interval. 
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— Then Stop to end the recording.

This session can be played back into any Trace State. For example:

Play the Max Hold recording into a Clear/Write trace to see the data exactly as 
it was recorded.

— Press Trace 6 then with Trace = 1 and press State then Clr/Wr

— Then Record Playback

— Then Play

Play the Max Hold recording into a Max Hold trace to show the accumulation 
of “Max Hold” activity over the entire recording.

— Press Trace 6 then with Trace = 1 and press State then Max Hold

— Then Record Player

— Then Play
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This feature may require an option. Please view the FieldFox Configuration 
Guide at: 
https://www.keysight.com/us/en/assets/7018-06515/configuration-guides/
5992-3701.pdf.

Reflection Mode measurements are very similar to CAT mode reflection 
measurements. They provide 1-port scalar reflection measurements in selected 
FieldFox SA-Only models. The FieldFox source is routed internally to Port 1 
and used to stimulate a Device Under Test (DUT). The energy that is reflected 
off the DUT is measured and displayed on the screen.

Option 320 requires Option 220 Tracking Generator. N9938B models 
require Option 100 3.5 mm connectors and Option 220. 

— Option 100 3.5 mm connectors must be installed by the factory. Option 
100 is only available on N9938B at the time of purchase. It is not 
available as a trial/upgrade.

— Option 220 Tracking Generator can be ordered via software license on 
www.keysight.com.

Option 320 is not available on N991xB, N992xB, or N995xB models.
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SA mode reflection measurements are CalReady. Learn more in “CalReady” on 
page 127. In addition, Normalization is available. Learn how “Normalize” on 
page 534. However, other calibration types are NOT offered.

In this Chapter

“How to select Reflection Mode” on page 534

“Measurement Selection” on page 534

“Normalize” on page 534
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The following settings are available exactly as they function in CAT mode:

“Frequency Range” on page 53

“Scale Settings” on page 53

“Averaging” on page 54

“Single or Continuous Measure” on page 55

“Resolution (Number of Data Points)” on page 56

“Sweep Time” on page 56

“Output Power” on page 57

“Interference Rejection” on page 58

“All about Markers” on page 700

“All about Limit Lines” on page 715
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Reflection Mode Settings 
Select Reflection Mode before making any setting in this chapter.

How to select Reflection Mode

— Press Mode

— Then Reflection

Measurement Selection

How to select a Reflection Mode Measurement

Learn more about these two measurements in the Supplemental Online Help:  
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm 

— Press Measure 1

— Then choose one of the following: These softkeys also appear after 
Reflection Mode is selected.

— Return Loss 1-port scalar reflection measurement that displays the 
amount of incident signal energy MINUS the amount of energy that is 
reflected. The higher the trace is on the screen, the more energy 
being reflected back to the FieldFox.

— VSWR (Voltage Standing Wave Ratio – also known as SWR) 1-port 
reflection measurement that displays the ratio of the maximum 
reflected voltage over the minimum reflected voltage. The higher the 
trace is on the screen, the more energy being reflected back to the 
FieldFox. 

Normalize

Normalization can be used to effectively ‘Zero’ a trace, which removes 
frequency response errors introduced by the components of the test setup 
before making the measurement.  To normalize a reflection measurement, the 
DUT is removed and a known device is connected to Port 1. When you choose 
Normalize, the displayed trace is stored into memory and then the displayed 
data is divided by the memory trace. The displayed data trace now shows the 
difference between the stored memory response and the measured response. 

You could normalize while measuring the reflection response of any type of 
device. For example, the device could be:

— An Open or Short (with maximum reflection)

How to perform Normalization

To Port 1, connect a known device (usually an Open or Short) to which 
reflection measurements are to be normalized.
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— Press Trace 6

— Then Normalize

The yellow data trace displays the current measurement with trace math 
applied. The math operation symbol [D/M] is displayed on the lower left corner 
of the screen. Learn more about Trace Math in “All about Trace Math” on 
page 720.

Data interpolation is NOT supported. If the Resolution setting is changed 
with Trace Math enabled, the FieldFox will disable the math operation. 
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Built-in Power Meter (also known as Channel Power Meter) uses the SA input 
connector to make quick and simple power measurements over a selectable 
frequency band. A power sensor is NOT required.

In this Chapter

See Also

The following Built-in Power Meter settings are identical to the standard Power 
Meter settings:

“Frequency/ Span / Step” on page 539

“Radio Standard” on page 540

“How to set Attenuation” on page 540

“Scale” on page 549

“Relative and Offset Power Measurements” on page 550

“Display Units” on page 551

“Averaging” on page 552

“Single or Continuous Measure” on page 552
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“Limits” on page 553

The following Built-in Power Meter settings are identical to SA Mode 
settings:

“Radio Standard” on page 540

“How to Access Individual Alignments” on page 205
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Built-in Power Meter Settings
Select Built-in Power Meter Mode before making any setting in this section.

How to select Built-in Power Meter Mode

— Press Mode

— Then More

— Then Power Meter (Built-in)

Frequency/ Span / Step

Valid Built-in Power Meter measurements can be made over the entire 
frequency range of the FieldFox. Although it is possible to enter a center 
frequency below the FieldFox minimum frequency, the LO feed-thru of the 
internal SA hardware will invalidate these Built-in Power Meter measurements.

The measurement span (also known as Channel Width and Integration BW) is 
the frequency range, half above and half below the center frequency, over 
which power is detected and displayed. The maximum measurement span is 
100 MHz. 

How to enter center frequency, step size, and span 

The default frequency is 50 MHz.

— Press Freq/Dist

— Then Center 

— Then type a value using the numeric keypad. Then press a multiplier key. 
Learn about multiplier abbreviations “Multiplier Abbreviations” on page 46. 
The current frequency (f) is shown on the FieldFox screen. 

— Optionally, use the  arrows or rotary knob to quickly change Center 
frequency. The size of the frequency step can also be changed. Press CF 
Step then type a step size value using the numeric keypad, then select a 
multiplier key. 

— Optionally press Span Type a value using the numeric keypad. Then press a 
multiplier key. The default span is 20 MHz. The maximum span is 100 MHz. 
The current span setting is shown as the dividend in the digital display. For 
example: -10 dBm / 1.00 MHz

Please observe the SA RF Input port damage level.

+27 dBm (320 mW) average

+33 dBm peak (2 W) <10μs

+50 VDC
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Radio Standard

A Radio Standard can used to integrate power within specific radio channels. 
When a Radio Standard is selected, the Span setting is automatically coupled 
to the defined Channel Width for that standard. (Width is the same for all 
channels within a standard.) Also, Unit is set to Chan, and CF is set to the 
nearest specific Channel defined in the standard. 

Learn more about Radio Standards, including Importing and Deleting Custom 
Radio Standards, beginning in “Custom Radio Standards” on page 154

How to select a Radio Standard

— Press Measure 1 OR Freq/Dist
— Then Radio Standard

— Then select a standard using the  arrows or rotary knob and press 
Enter.

Attenuation

The Attenuation setting controls the power level into the FieldFox.

To compare Built-in Power Meter Mode measurements to SA Channel Power 
measurements, use the same attenuation settings. Built-in Power Meter Mode 
defaults to 30 dB attenuation, while SA mode defaults to 10 dB attention. In 
Built-in Power Meter, the attenuation setting is NOT annotated on the screen. 

How to set Attenuation

— Press Scale/Amptd
— Then More
— Then RF Atten

— Then use the  arrows or rotary knob to choose from either 30 dB or 
10 dB 

The following Built-in Power Meter settings are identical to the standard 
Power Meter settings. To learn about these settings, please refer to the 
following pages:

“Relative and Offset Power Measurements” on page 550

“Display Units” on page 551

“Averaging” on page 552

“Scale” on page 549

“Limits” on page 553
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21 Power Meter (USB/LAN) Mode - Option 302

Power Meter measurements, available with Option 302, are made with 
Keysight USB power sensors. Power readings are displayed on the FieldFox 
screen.

In this Chapter

“Supported Power Sensors” on page 543

“How to Connect a USB Power Sensor” on page 543

“How to Connect a LAN Power Sensor” on page 544

“How to select Power Meter Mode” on page 546

“Average / Peak” on page 547

“Zeroing” on page 547

“Frequency” on page 548

“Source Control” on page 548

“Source Power Measurements” on page 550

“Relative and Offset Power Measurements” on 
page 550

“Display Units” on page 551
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See Also

“Resolution” on page 551

“Averaging” on page 552

“Single or Continuous Measure” on page 552

“Step Detection Mode” on page 553

“Limits” on page 553

“Troubleshooting” on page 554

“FOPS Settings” on page 561

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720

“All about Scale Settings” on 
page 722
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Supported Power Sensors

For a complete list of supported Keysight USB and LAN Power Sensors, please 
visit: www.keysight.com/find/usbsensorsforfieldfox

How to Connect a USB Power Sensor

Connect your Power Sensor to one of the FieldFox USB ports.

A sequence of status lights are displayed on the base of the power sensor, 
when the FieldFox is in Power Meter (USB Sensor) mode. 

— Green blinking light indicates the power sensor is communicating or 
self-tests are being performed. Because the FieldFox is usually 
communicating with the power sensor when it is connected, this is the 
normal mode of operation.

— Amber light indicates Zeroing is being performed.

The FieldFox does NOT support the following Keysight USB and LAN Power 
Sensor features: External Triggering (Time Gated Burst Power 
Measurement), Power Sweep Operation, and Frequency Sweep Operation. 
External Zeroing is NOT allowed on the U2020 X-series Power Sensors.

Please refer to your USB and LAN Power Sensor User’s Guide and observe 
the damage levels of your device. 

IMPORTANT! When a USB power sensor is initially connected to the 
FieldFox, it may take ~10 seconds for the USB power sensor to finish 
zeroing and for the FieldFox to recognize the USB power sensor. If your 
USB power sensor is not operating as expected:

— Verify the latest firmware is loaded on the FieldFox. Refer to 
www.keysight.com\find\fieldfoxsupport.

— Verify the latest firmware is loaded on the Power Sensor. Refer to 
https://www.keysight.com/main/editorial.

— Remove and re-connect the USB power sensor

Use an attenuator between the DUT and the power sensor when 
measuring power levels that are higher than +20 dBm. The attenuator 
value can be subtracted from the measurement using the Offset feature, 
discussed in “Relative and Offset Power Measurements” on page 550.
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— Red light indicates an error has occurred with the power sensor. Refer to 
power sensor documentation.

— No light indicates the FieldFox is not communicating with the power 
sensor. This is the case when in Hold mode or when NOT in Power Meter 
Mode.

How to Connect a LAN Power Sensor

Connect the LAN power sensor to a LAN port. This section provides some 
general LAN power sensor connection information and some specific 
FieldFox-related LAN connection information. For more details, refer to your 
LAN power sensor’s User’s Guide.

Connect the LAN sensor via any of the following LAN operating modes: 

— Dynamic IP (Dynamic Host Configuration Protocol or DHCP) 

— Auto IP (Local PC control or isolated (non-site) LAN) 

— Static IP (Manual mode) 

The default LAN operating mode of the LAN sensor is Dynamic IP. 

Dynamic IP and Auto IP are enabled on the LAN sensor shipped from Keysight. 
This allows the LAN sensor to automatically obtain an address on the network.

The LAN sensor communicates with the DHCP server to obtain the LAN 
interface configuration. If the DHCP server is not detected, then either the 
DHCP server is not present or it does not allow the LAN sensor to obtain an IP 
address. The LAN sensor will then try to obtain the LAN configuration using 
AutoIP if enabled, otherwise the LAN sensor will try to use the static IP set in 
the LAN sensor. If required, push the LAN reset switch to reset the LAN sensor 
LAN configuration to a known default state. 

LAN Sensor Settings 

The LAN Sensor settings enable you to 

— Select your model of sensor

— Enter your Sensor I.D. via DNS serial number or IP address

Disconnecting a LAN sensor from its cable or disconnecting a LAN sensor 
while communicating with the FieldFox is not recommended. Either of 
these actions causes the LAN sensor to lose its internal state settings. 
Learn more, refer to “LAN Sensor Settings” on page 544 and to 
“Troubleshooting” on page 554.

IMPORTANT!

LAN sensors require that the FieldFox has a CPU2 installed.
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Learn more, refer to “USB and LAN Power Meter Settings” on page 546.

To access the LAN Sensor Settings:

— Press Meas Setup 4 > More > LAN Sensor Settings 

Using the LAN Sensor Settings

— Press Sensor Name [U2049XA] – then select your LAN sensor model from 
the drop down list.

— Press Sensor ID – then choose

— DNS Ser num – Enter the DNS Serial Number’s last 5 digits as a way 
for the FieldFox to connect with your LAN power sensor.

— IP Address – Enter the IP address of your LAN power sensor as a way 
for the FieldFox to connect with your LAN power sensor.

— Press DNS Ser Num – to enter a DNS serial number’s last 5 digits to enable 
the FieldFox to identify a LAN power sensor. This softkey is inactive Sensor 
I.D. is set to IP Address.

— Press LAN IP Addrs Not Specified – to enter an IP address to enable the 
FieldFox to identify a LAN power sensor. This softkey is inactive Sensor I.D. 
is set to DNS Ser Num.

— Press Reconnect – While it is not recommended to remove the LAN cable 
from either the Sensor or the FieldFox during a LAN Sensor based 
measurement, the Reconnect button should allow the measurements to 
resume if they are lost. Learn more, refer to “Troubleshooting” on page 554.

The LED indicator will turn red indicating the following error when the 
DHCP server is not detected: –310, "System error; The sensor could 
not obtain a LAN configuration using DHCP. The sensor will 
try to obtain IP address using AutoIP if enabled". For more 
information on LAN instrument connectivity, refer to the Keysight IO 
Libraries Suite Connectivity Guide.
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A sequence of status lights are displayed on the base of the power sensor, 
when the FieldFox is in Power Meter (LAN Sensor) mode. 

— Green / Green blinking light indicates the power sensor’s identification 
indicator is communicating. After successful identification, the green LED 
stops blinking. No indication when the operating speed is 10 Mbps or 
during line isolation.

— Amber light indicates Zeroing is being performed. And, blinks when a valid 
link activity is detected.

— Red light indicates an error has occurred with the power sensor. Refer to 
power sensor documentation.

— No light indicates the FieldFox is not communicating with the power 
sensor. This is the case when in Hold mode or when NOT in Power Meter 
Mode.

USB and LAN Power Meter Settings
Select Power Meter Mode before making any setting in this section.

How to select Power Meter Mode

— Press Mode_. 

— Then Power Meter (USB/LAN Sensor).

IMPORTANT! When a LAN power sensor is initially connected to the LAN, it 
may take ~10 seconds for the LAN power sensor to finish zeroing and for 
the FieldFox to recognize the LAN power sensor. If your LAN power sensor 
is not operating as expected:

— Verify the latest firmware is loaded on the FieldFox. Refer to 
www.keysight.com\find\fieldfoxsupport.

— Verify the latest firmware is loaded on the Power Sensor. Refer to 
https://www.keysight.com/main/editorial.

— Press the LAN reset switch to reset the LAN sensor LAN configuration 
to a known default state

— Remove and re-connect the LAN power sensor

Use an attenuator between the DUT and the power sensor when 
measuring power levels that are higher than +20 dBm. The attenuator 
value can be subtracted from the measurement using the Offset feature, 
discussed in “Relative and Offset Power Measurements” on page 550.
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How to select a Sensor Type

— Press Meas Setup 4. 

— Then Sensor Type USB LAN (Default = USB). 

Average / Peak

— Press Measure 1

— Then choose from the following:

— Average Measures and reports the average of the power 
measurements.

— Peak Available ONLY on some of the X-Series power sensors. 
Measures and reports peak power detected at sensor input. See also, 
Table 23-1, “Pulse Measurement X-Series USB and LAN Power 
Sensors,” on page 569.

 

Zeroing

The Keysight USB and LAN Power Sensors perform Internal Zeroing 
automatically. Because Keysight USB and LAN Power Sensors have an internal 
switch, Internal Zeroing does NOT require that the power source be turned 
OFF. 

For highest measurement accuracy, when measuring power levels below 
–30 dBm, External Zeroing should be performed. 

During External Zeroing, the power source MUST be turned OFF or the power 
sensor disconnected from the power source (device under test). Power is OFF 
when power sensor measurements are below –60 dBm (–50 dBm for LAN 
sensors). When power higher than this is detected at the sensor, a warning 
message is shown on the FieldFox and External Zeroing will not proceed.

How to perform External Zeroing

— Press Cal 5.

— Then External Zero.

While either Internal or External Zeroing is being performed, “Zeroing...” is 
shown on the FieldFox screen. While this message is present, do NOT make 
any changes to the FieldFox. 

External Zeroing is NOT allowed on the U2020 X-series Power Sensors.
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In addition, once External Zeroing has started, the power source must be OFF 
for the entire time that the Zeroing message is present. Otherwise, the 
calibration will be compromised but NO warning is shown.

Frequency

A table of correction factors versus frequency is stored within Keysight Power 
Sensors. The frequency of the power to be measured is entered in the FieldFox 
so that the appropriate correction factor can be used. 

The Source Control feature (see following section) will determine the frequency 
range of the power measurement. 

How to enter Frequency of the Power Measurement 

— Press Freq/Dist 

— Then Src Center 

— Then type a value using the numeric keypad. The default frequency is 
50 MHz.

— Then press a multiplier key. Learn about multiplier abbreviations in 
“Multiplier Abbreviations” on page 46.

The current frequency is shown on the FieldFox screen. 

Source Control

This feature may require an option on some FieldFox models.

With the FieldFox internal source enabled, these settings allow you to make 
simple, absolute power measurements. The source and the power sensor can 
be physically separated by a long distance when using a long USB cable. 

Set the internal source frequency by setting the frequency of the power 
measurement. Learn how in the previous section.

Power Meter measurements are limited by the combined frequency ranges of 
the internal source when enabled and the frequency range of the power 
sensor. For example, assume the frequency range of your sensor is 9 kHz to 
18 GHz and the frequency range of the FieldFox is 2 MHz to 6 GHz.

— With the Source ON, measurements are limited to 2 MHz to 6 GHz.

— With the Source OFF, measurements are allowed from 9 kHz to 18 GHz.
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How to Set Source Control and Power Level 

— Press Sweep 3 > Advanced 

— Then Source Enable

— ON Turn ON the internal source

— OFF Turn OFF the internal source

Optionally set the power level.

— Press Src Nom Power (-15 dBm default setting) Set output power to an 
arbitrary value at the displayed CW frequency.

— Then enter a value using the numeric keypad, the  arrows, or the rotary 
knob. 

— Press Enter

Scale

The scale of the Power Meter display can be set manually or automatically. The 
major and minor ticks are set automatically and can NOT be changed. 
Although the scale settings are limited, you can view measurements beyond 
these settings by performing Autoscale. 

How to Scale the Power Meter Display

These softkeys are not available when Rx Power is enabled. See also “Source 
Power Measurements” on page 550.

Manually:

— Press Scale / Amptd.

— Then choose from the following:

— Scale Min   Sets the low power level of the power meter display. Type 
a number and select the units or press Enter. This value is limited to 

–100 dBm.

— Scale Max   Sets the high power level of the power meter display. 
Type a number and select the units or press Enter. This value is 
limited to 100 dBm.

Autoscale:

When Option 208 (FOPS) is enabled, to access Source Control, press 
Sweep 3, then Power Setup. Learn more about FOPS beginning on page 
Chapter 22, “Frequency Offset Using Power Sensor (FOPS) – Option 208”, 
on page  557.
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Using Autoscale, the current reading is used for the center of the scale, and 
Min and Max values are set accordingly.

— Press Scale / Amptd.

— Then Autoscale. 

Source Power Measurements

Before making a source power measurement, a calibration is required. Requires 
a compatible USB power sensor. Learn more about supported Keysight USB 
and LAN Power Sensors, please visit: 
www.keysight.com/find/usbsensorsforfieldfox.

How to make a Source Power Measurement

— Press Measure 1 > Src Power Measure to open the Source Power Measure 
wizard.

— Follow the Source Power Measure Wizard’s instructions.

When you select the Src Power Measure softkey the Rx Power is enabled 
and the Average (default) is disabled. And, the displayed power meter is 
replaced by a Power vs. Frequency grid display of the source and receiver 
power. 

— Press Src Power Memory - to store the source power measurement

— Press Gain - applies the stored source power measure

Relative and Offset Power Measurements

Power measurements can be made that are relative to another reading or that 
are offset by a fixed value.

— Use Relative to measure the difference between power levels. 

— Use Offset to account for components or a long length of cable that is used 
before the power sensor. For example, if using a 10 dB attenuator to protect 
the FieldFox, enter an Offset Value of 10 to read the power as it would 
appear without attenuation. If using a 10 dB amplifier, enter an Offset Value 
of –10 to read the power as it would appear without amplification.

How to set Relative and Offset Power Measurements

— Press Scale / Amptd.

— Then choose from the following:

— Relative Off On When switched to ON, the FieldFox measures and 
stores the current power level. Subsequent power measurements 
display a power level which is relative to the stored value. When 
relative is ON, the units change from dBm to dB or from Watts to %. 
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This softkey is not available when Rx Power is enabled. See also 
“Source Power Measurements” on page 550.

— Offset Off On Toggles ON and OFF the displayed power level using 
the Offset value (default = Off (0.000 dB)). 

This softkey is not available when Rx Power is enabled. See also 
“Source Power Measurements” on page 550.

— Offset Val Value by which the power meter display is offset. A 
positive value compensates for a component with loss. A negative 
value compensates for a component with gain. Offset values are 
limited to +/– 100 dB (default = 0.000 dB). 

Display Units

Select whether to display power in dBm or Watts. When making relative power 
measurements, these change to dB and %. 

These softkeys are not available when Rx Power is enabled. See also “Source 
Power Measurements” on page 550.

How to set Power Meter display units 

— Press Meas Setup 4 or Scale / Amptd, More

— Then Unit.

— Then choose from the following:

— dBm (dB) Sets Power Meter display to dBm or dB.

— Watt (%) Sets Power Meter display to Watts or %.

Resolution

Resolution sets the number of digits to display after the decimal point on the 
digital power meter display.

These softkeys are not available when Rx Power is enabled. See also “Source 
Power Measurements” on page 550.

How to set Resolution

— Press Scale / Amptd.

— Then More.

— Then, in Resolution, choose from 0, 1, 2, or 3. 
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Averaging

Averaging is used to improve measurement accuracy in low power or noisy 
power situations. Increased averaging improves measurement accuracy, but 
also reduces measurement speed. 

How to set Power Meter Averaging

— Press BW 2 or Meas Setup 4.

— Then choose from the following:

— Averaging Auto Man Off 

— Auto Allows the USB Power Sensor to use its Auto Averaging 
settings. See the USB Power Sensor documentation for details.

— Man Manually enter an averaging count by setting Num Averages.

— OFF Performs NO averaging. 

— Num Averages Sets the number of Power Meter readings to be 
averaged before a valid reading is displayed. When the number is 
changed, Averaging is automatically set to Man.

Single or Continuous Measure

This setting determines whether the FieldFox measures continuously or only 
once each time the Single button is pressed. Use Single to conserve battery 
power or to allow you to save or analyze a specific measurement. 

This setting can be changed at any time without affecting calibration accuracy.

How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

— Single Automatically sets Continuous OFF and causes FieldFox to 
make ONE measurement, then hold for the next Single key press. 
When a data trace is displayed, the entire trace is measured, then 
holds. The Hold annotation changes to an arrow --> while the 
measurement occurs.

— Continuous OFF ON Makes continuous measurements. This is the 
typical setting when battery power is not critical.

You can also use Run / Hold +/- to toggle between Single and Continuous. 
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Step Detection Mode

The FieldFox supports the Step Detection feature that is present in Keysight 
USB power sensors. When enabled, this feature reduces settling time after a 
significant step in the measured power. For more information, please refer to 
the USB Power Meter documentation.

How to set Step Detection mode

— Press Meas Setup 4.

— Then Step Detection OFF ON 

— Then choose from the following:

— ON Enables step detection (default setting)

— OFF Disables step detection

Limits

In Power Meter Mode, Minimum and Maximum limits set a visible range of 
acceptable readings between these two values. Readings that are below the 
minimum or above the maximum are clearly visible on the power meter display.

How to set Limits

— Press Limit 8.

— Then choose from the following:

— Min Limit OFF ON Toggles the display of the Minimum limit ON and 
OFF.

— Min Limit Value Sets the Minimum limit power value. Power reading 
lower than this will exceed the limit.

— Max Limit OFF ON Toggles the display of the Maximum limit ON and 
OFF.

— Max Limit Value Sets the Maximum limit power value. Power reading 
higher than this will exceed the limit.
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Troubleshooting
This section contains the following:

LAN Sensors

— “If the FieldFox LAN is removed during the use of the LAN sensor, the 
following steps can be taken to re-establish control of the Sensor:” on 
page 554

— “If the Sensor LAN is removed during the use of the LAN sensor, the 
following steps can be taken to re-establish control over the 
measurement:” on page 554

LAN Sensors

If a LAN sensor cable or LAN sensor is not communicating properly with the 
FieldFox:

If the FieldFox LAN is removed during the use of the LAN sensor, the 
following steps can be taken to re-establish control of the Sensor:

1. Reconnect the LAN sensor to the FieldFox and await confirmation the 
FieldFox has obtained its IP address via the connection. 

A self-assigned IP address may be shown briefly while FieldFox tries to get 
connected to the LAN again after it has been removed. Before proceeding 
to the next step, ensure the correct IP has been obtained by the FieldFox. 

a. You can view the IP address by selecting:  
System > System Configuration > More > LAN to display the current 
IP address.

b. Press Done to exit the LAN menu.

2. Once FieldFox has obtained its IP address again, press the Reconnect 
button:

Press Meas Setup 4 > More > LAN Sensor Settings > Reconnect location 
in the softkey menu.

The FieldFox will attempt to restore the connection and the settings for the 
sensor.

If the Sensor LAN is removed during the use of the LAN sensor, the 
following steps can be taken to re-establish control over the 
measurement:

1. Reconnect the LAN cable to the sensor. 

2. Observe the LEDs near the LAN cable connection: 

a. The PWR LED will turn on while the Sensor is waking up and 
initializing. 
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b. The PWR LED will turn off when the Sensor is ready to be 
reconnected. The other LED next to it should be off as well. 

c. Then press, Meas Setup 4 > More > LAN Sensor Settings > 
Reconnect.

The LEDs may turn on and off during the reconnection, and the sensor may report “Zeroing” or 
“Attempting to connect” messages. This reconnection attempt could take up to a minute or so. 
The data acquisition will resume once the connection is re-established.
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22 Frequency Offset Using Power Sensor (FOPS) – Option 
208

FOPS is accessed through (and requires) Option 302 USB Power Meter Mode. 
With both options installed, you can send a signal with the FieldFox internal 
source at one frequency, and measure this signal with a Keysight U-Series USB 
Power Sensor at another frequency.

Figure 22-1 Display for FOPS

In this Chapter

“How to select Power Meter (USB Sensor)” on 
page 561

“Measurement Selection” on page 561

“Sweep Type and Frequency” on page 562

“Power Sensor Settling” on page 564

“Sweep Settings” on page 564
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See Also

“Amplitude Markers” on page 565

“Trace Math” on page 565

“All about Trace Math” on page 720
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Overview
This feature allows the FieldFox source frequency to be set independently from 
the power sensor (receiver) frequency. With frequency offset using power 
sensor (FOPS), the frequency of both the source and receiver are swept, and 
the two track each other. The offset frequency can be negative, zero, or 
positive.

FOPS can be used to characterize the scalar transmission response of devices 
such as mixers and converters. This frequency offset capability is necessary for 
conversion loss/gain measurements on frequency-translating devices since, by 
definition, the input and output frequencies of the DUT are different. The 
FieldFox source stimulates the DUT and the power sensor is used as the 
measurement receiver.

Since power sensors are inherently broadband devices (not 
frequency-selective), it is your responsibility to ensure that ONLY the signal of 
interest is present at the power sensor input and that all others signals are 
filtered appropriately.

For some DUTs, the output frequency may sweep in a reverse direction, as 
compared to the source frequency. The FieldFox analyzer includes an offset 
calculator that ensures a fast measurement setup.

The following shows a typical use case for FOPS:

— The DUT is a long section of cable and a frequency converter. 

— The FieldFox source is tuned to the RF frequency. 

— The USB power sensor, with an equally long USB/LAN cable, is connected 
to the IF Output. USB/LAN extenders are NOT provided with the FieldFox or 
Keysight USB power sensors.

— Conversion gain/loss is measured at power sensor.
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The dynamic range with FOPS may be significantly different when using 
various power sensors. In general, the lower frequency range sensors have 
better dynamic range. 
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FOPS Settings
The following settings are unique to FOPS. Standard USB Power Meter mode 
settings, which may be useful with FOPS, are documented in that chapter 
starting in “USB and LAN Power Meter Settings” on page 546 

Select Power Meter (USB Sensor) before making any setting in this section. 

How to select Power Meter (USB Sensor)

— Press Mode 

— Then Power Meter (USB Sensor) 

— Then connect a USB Power Sensor to either FieldFox USB port.

— For a complete list of supported Keysight USB Power Sensors, please visit: 
www.keysight.com/find/usbsensorsforfieldfox

Measurement Selection

— Press Measure 1

— Then choose from the following:

— Src Power Measure Similar to a ‘normalization’ cal, this selection guides 
you through the following steps to make a measurement at the reference 
plane and then store the data trace into memory.

— Connect the power sensor to the measurement reference plane. This 
is the location to where power measurements are to be referenced. 
For example, to measure only the conversion loss through a 
converter, attach the power sensor to the cable that connects to the 
converter input.

— Press Measure. When finished, press Src Data -> Mem to store the 
measured data into FieldFox memory. Preset or Mode Preset will 
clear the stored memory.

— 3.Optionally choose from the following:

——Re-Measure Make another measurement

——Src Data View only the re-measured data.

——Src Memory View only the stored memory data.

——Src Data & Memory View both the re-measured data and the 
stored memory data.

— 4.Press Done

— Src Power Memory Not available until source data is stored into memory. 
Displays only the source power memory trace.
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— Gain Not available until source data is stored into memory. Displays the 
Output power / Source power (memory trace).

— Rx Power Displays the raw received power at the USB power sensor.

Sweep Type and Frequency

Set the source and receiver frequencies for the FOPS measurements. The 
receiver is a Keysight U-Series Power Sensor. These are broadband 
measurement devices, which means that they measure power over a very wide 
frequency range. Tables of frequency and power correction factors are stored 
within the power sensors. The receiver (Rx) frequencies are used ONLY to apply 
the appropriate correction factors to the power levels measured with the power 
sensor. 

How to set Sweep Type and Frequency

— Press Freq/Dist

— Then Sweep Type

— Then choose from the following:

— CW Used to make standard (non-offset) power meter measurements at a 
single frequency. Learn more in “USB and LAN Power Meter Settings” on 
page 546.

— Swept Used to make swept FOPS measurements.

—— Then enter source (Src) frequencies as either Center and Span 
or Start and Stop. Both methods set the FieldFox internal 
source sweep range out the Port 1 RF Output connector.

——The frequency limits are determined by the limits of both the 
FieldFox and the power sensor.

——The LOW frequency is limited by the higher of either the 
FieldFox or the power sensor minimum frequencies.

——The HIGH frequency is limited by the lower of either the 
FieldFox or the power sensor maximum frequencies.

——Then More. 

It is YOUR responsibility to ensure that ONLY the signal of interest is 
present at the power sensor. All other signals MUST be filtered 
appropriately.

To make FOPS measurements at a single frequency, choose Swept, then 
enter a Src Center frequency, then Span = 0 Hz.
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——Then Freq Display. This determines how the receiver 
frequencies below the graticules are displayed. Choose from 
the following:

——Start Annotated as Start and Stop frequencies.

——Center Annotated as Center and Span frequencies.

——Then choose from the following two methods to determine the 
offset frequency (the frequency that the receiver is offset from 
the source). This is typically the frequency of the LO that is 
used with the frequency converter. The frequency offset may 
be positive, negative, or zero.

——Freq Offset Enter an Offset frequency. The receiver frequencies 
are calculated.

——Offset Calculator Enter the Receiver Start and Stop 
frequencies. Then press Calculate Offset. 

——Press Rx Sweep to select the receiver sweep direction.

——Fwd Used for systems for which the output frequency is 
Offs + Src. The output frequency of the DUT and the 
receiver sweeps in the same direction as the source.

——Rev Used for systems for which the output frequency is 
Offs - Src. The output frequency of the DUT and the 
receiver sweeps in reverse direction as compared to the 
source. 

Invalid Settings

Violations of the following conditions will return an error message:

— The frequency span for the source and receiver must be the same. 

— Both the source and receiver frequencies must be positive. 

FOPS Configuration Examples

Negative Offset, RxSwp = Fwd (Offs + Src)

Src = 2 GHz to 3 GHz

Offset = -1 GHz

Rx = 1 GHz to 2 GHz

Positive Offset, RxSwp = Rev (Offs - Src)

Src = 2 GHz to 3 GHz

Offset = 3.8 GHz 

Rx = 1.800 GHz to 800 MHz

Positive Offset, RxSwp = Fwd (Offs + Src)
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Src = 2 GHz to 3 GHz

Offset = 3.8 GHz

Rx = 5.8 GHz to 6.8 GHz 

Power Sensor Settling

The following two settings work together to allow you to choose the right 
compromise between measurement speed and accuracy.

Each power sensor reading is considered “settled” when either:

— The difference between two consecutive readings are within the Tolerance 
value.

— Or the Max (number of) Readings has been made.

The readings that were taken are averaged together to become the displayed 
reading.

How to choose Power Sensor settling 

— Press BW 2 

— Then Tolerance. Enter a value in dB between 0 and 10 using the numeric 

keypad, the  arrows, or the rotary knob. Tolerance of 0 will never be 
achieved, so the Max Readings will always be made. Press Enter

— Then Max Readings. Enter a value between 1 and 20 using the numeric 

keypad, the  arrows, or the rotary knob. Press Enter

Sweep Settings

These settings provide added control of the FOPS measurement.

How to make additional sweep settings 

— Press Sweep 3 

— Then choose from the following:

— Power Setup

— Source Enable

——ON Turn ON the internal source (required for FOPS).

——OFF Turn OFF the internal source

— Src Nom Power (-15 dBm default setting) Set output power to an 
arbitrary value at the source CW frequency. Then enter a value using 

the numeric keypad, the  arrows, or the rotary knob. Press Enter
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— Num Points or Freq Step Size Both settings control the number of power 
sensor measurements between the Start and Stop frequencies. Enter one 
setting and the other will be changed automatically. There must be at least 
two data points.

— Dwell /Point Specifies a settling time (in seconds) after the internal source 
steps to the next frequency and before the power sensor makes a 
measurement.

Amplitude Markers

Amplitude markers are horizontal dotted lines that you can move to any 
amplitude level on the screen. The two amplitude markers can be set 
independently or used as a pair of delta markers. Amplitude markers can be 
used as a visual comparison aid with the data trace.

How to make Amplitude Marker settings

— Press Marker 
— Then More 
— Then Ampl Markers
— Then choose from the following:

— OFF Amplitude markers are NOT displayed.
— ON Amplitude markers ARE displayed at their previous positions.

— Then Ampl Mkr 1 or 2

— Enter a value in dBm for the marker using the numeric keypad, the  
arrows, or the rotary knob.

— Press Delta Ampl Mkr
— Then choose from the following:

— ON AmplMkr 2 value is relative to AmplMkr 1. When AmplMkr 1 is 
moved, AmplMkr 2 also moves to maintain the AmplMkr 2 value 
between them.

— OFF The two amplitude markers move independent of one another.

Trace Math

Trace Math allows you to compare data traces and perform simple math. Learn 
how to use Trace Math in “All about Trace Math” on page 720. All Data and 
Memory features work as documented EXCEPT for the following:

To Compare Src Power (Input) and Rx Power (Output): 

1. Meas Rx Power
2. Store to memory

When Trace, then Data -> Mem is pressed, if a Src Power trace is active, 
then RxPower is actually stored into memory. 
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3. View Data & Memory
4. Meas Src Power.
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Pulsed power meter measurements, available with Option 330, are made with 
Keysight X-Series USB and LAN Peak Power Sensors. These sensors are 
capable of detecting, measuring, and storing data from a train of pulses at the 
RF input. This data is queried from the USB and LAN Power Sensor and 
displayed on the FieldFox screen. You can then analyze the data using several 
selectable settings. Refer to Table 23-1 on page 569.

In this Chapter

“Supported Power Sensors” on page 569

“Measurement Selection” on page 573

“Frequency / Time” on page 573

“Zoom Window” on page 574

“Scale” on page 575

“Averaging ” on page 575

“Video Bandwidth” on page 576

“Single or Continuous Measure” on page 577

“Resolution” on page 577
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See Also

“Triggering” on page 577

“Marker Settings” on page 580

“Amplitude Markers” on page 581

“How to Search with Markers” on page 581

“How to enable Auto Analysis” on page 583

“Pulse Top” on page 583

“Grid” on page 583

“Trace Memory” on page 584

“FOPS Settings” on page 561

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720

“All about Scale Settings” on 
page 722

Many of the features included with the FieldFox Pulse Measurements 
Mode are discussed in detail in the following documents:

USB Power Sensorsa

— Keysight U2020 X-Series USB Peak Power Sensors User’s Guide (U2021-90002). 
https://www.keysight.com/us/en/assets/9018-02579/user-manuals/9018-02
579.pdf

— Keysight U2020 X-Series USB Peak Power Sensors Programmer’s Guide 
(U2021-90003). 
https://www.keysight.com/us/en/assets/9018-06011/programming-guides/9
018-06011.pdf

LAN Power Sensorsa

— Keysight U2050/60 X-Series USB Peak Power Sensors User’s Guide 
(U2063-90002). 
https://www.keysight.com/us/en/assets/9018-04734/user-manuals/9018-04
734.pdf

— Keysight U2050/60 X-Series USB Peak Power Sensors Programmer’s Guide 
(U2063-90003). 
https://www.keysight.com/us/en/assets/9018-04755/programming-guides/9
018-04755.pdf
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Supported Power Sensors
Pulse measurements are made using any of the Keysight the following X-Series 
USB and LAN Peak Power Sensors. 

Zeroing of the compatible X-Series USB and LAN Peak Power Sensors is 
performed automatically at power up, every 5 seconds, and prior to measuring 
low level signals. 

Switching between Pulse Measurement Mode and Power Meter Mode

NOT Supported - Using a single USB or LAN Peak Power Sensor and 
switching between Power Meter Mode and Pulse Measurement Mode. Both 
modes will attempt to program the sensor, which could cause one or both 
modes to hang, or at least report inaccurate data. 

Supported - Using one X-Series Average Power Sensor connected to the 
top USB port for Power Meter Mode, and one X-Series Peak Power Sensor 
connected to the bottom USB port for Pulse Measurement Mode.

USB and LAN Power Sensorsa

— “Best Practices For Making The Most Accurate Radar Pulse Measurements” 
https://www.keysight.com/us/en/assets/7018-03483/application-notes/5991
-0434.pdf

a. Learn more, refer to the User’s Guide and Programming Guide for your USB or LAN 
model power sensor.

Table 23-1 Pulse Measurement X-Series USB and LAN Power Sensors

USB Power Sensor Model Numbers LAN Power Sensor Model Numbersa

U2021XA L2061XA

U2022XA L2062XA

U2042XA U2063XA

U2044XA L2064XA

U2049XA L2065XA

U2062XA L2065XT

U2063XA

U2065XA

a. LAN power sensors require FieldFoxes to have CPU2 installed.
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How to Connect the USB Power Sensor

Connect your Power Sensor to one of the FieldFox USB ports.

A sequence of status lights are displayed on the base of the power sensor. 

— Green blinking light indicates the power sensor is communicating or 
self-tests are being performed. Because the FieldFox is usually 
communicating with the power sensor when it is connected, this is the 
normal mode of operation.

— Amber light indicates Zeroing is being performed.

— Red light indicates an error has occurred with the power sensor. Refer to 
power sensor documentation.

— No light indicates the FieldFox is not communicating with the power 
sensor. This is the case when in Hold mode or when NOT in Pulsed 
Measurement Mode.

How to Connect the LAN Power Sensor

Connect the LAN power sensor to a LAN port. This section provides some 
general LAN power sensor connection information and some specific 
FieldFox-related LAN connection information. For more details, refer to your 
LAN power sensor’s User’s Guide.

Connect the LAN sensor via any of the following LAN operating modes: 

— Dynamic IP (Dynamic Host Configuration Protocol or DHCP) 

— Auto IP (Local PC control or isolated (non-site) LAN) 

— Static IP (Manual mode) 

The default LAN operating mode of the LAN sensor is Dynamic IP. 

Dynamic IP and Auto IP are enabled on the LAN sensor shipped from Keysight. 
This allows the LAN sensor to automatically obtain an address on the network.

The LAN sensor communicates with the DHCP server to obtain the LAN 
interface configuration. If the DHCP server is not detected, then either the 
DHCP server is not present or it does not allow the LAN sensor to obtain an IP 
address. The LAN sensor will then try to obtain the LAN configuration using 
AutoIP if enabled, otherwise the LAN sensor will try to use the static IP set in 
the LAN sensor. If required, push the LAN reset switch to reset the LAN sensor 
LAN configuration to a known default state. 

Use an attenuator between the DUT and the power sensor when 
measuring power levels that are higher than +20 dBm. The attenuator 
value can be subtracted from the measurement using the Offset feature, 
discussed in “Relative and Offset Power Measurements” on page 550.
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LAN Sensor Settings 

The LAN Sensor settings enable you to 

— Select your model of sensor

— Enter your Sensor I.D. via DNS serial number or IP address

Learn more, refer to “USB and LAN Power Meter Settings” on page 546.

To access the LAN Sensor Settings:

— Press Meas Setup 4 > More > LAN Sensor Settings 

Using the LAN Sensor Settings

— Press Sensor Name [U2049XA] – then select your LAN sensor model from 
the drop down list.

— Press Sensor ID – then choose

— DNS Ser num – Enter the DNS Serial Number’s last 5 digits as a way 
for the FieldFox to connect with your LAN power sensor.

— IP Address – Enter the IP address of your LAN power sensor as a way 
for the FieldFox to connect with your LAN power sensor.

— Press DNS Ser Num – to enter a DNS serial number’s last 5 digits to enable 
the FieldFox to identify a LAN power sensor. This softkey is inactive Sensor 
I.D. is set to IP Address.

— Press LAN IP Addrs Not Specified – to enter an IP address to enable the 
FieldFox to identify a LAN power sensor. This softkey is inactive Sensor I.D. 
is set to DNS Ser Num.

The LED indicator will turn red indicating the following error when the 
DHCP server is not detected: –310, "System error; The sensor could 
not obtain a LAN configuration using DHCP. The sensor will 
try to obtain IP address using AutoIP if enabled". For more 
information on LAN instrument connectivity, refer to the Keysight IO 
Libraries Suite Connectivity Guide.
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A sequence of status lights are displayed on the base of the power sensor, 
when the FieldFox is in Power Meter (LAN Sensor) mode. 

— Green / Green blinking light indicates the power sensor’s identification 
indicator is communicating. After successful identification, the green LED 
stops blinking. No indication when the operating speed is 10 Mbps or 
during line isolation.

— Amber light indicates Zeroing is being performed. And, blinks when a valid 
link activity is detected.

— Red light indicates an error has occurred with the power sensor. Refer to 
power sensor documentation.

— No light indicates the FieldFox is not communicating with the power 
sensor. This is the case when in Hold mode or when NOT in Power Meter 
Mode.

IMPORTANT! When a LAN power sensor is initially connected to the LAN, it 
may take ~10 seconds for the LAN power sensor to finish zeroing and for 
the FieldFox to recognize the LAN power sensor. If your LAN power sensor 
is not operating as expected:

— Verify the latest firmware is loaded on the FieldFox. Refer to 
www.keysight.com\find\fieldfoxsupport.

— Verify the latest firmware is loaded on the Power Sensor. Refer to 
https://www.keysight.com/main/editorial.

— Press the LAN reset switch to reset the LAN sensor LAN configuration 
to a known default state

— Remove and re-connect the LAN power sensor

Use an attenuator between the DUT and the power sensor when 
measuring power levels that are higher than +20 dBm. The attenuator 
value can be subtracted from the measurement using the Offset feature, 
discussed in “Relative and Offset Power Measurements” on page 550.
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Pulse Measurement Settings
Select Pulse Measurement Mode before making any setting in this section.

How to select Pulse Measurement Mode

— Press Mode

— Then More if your FieldFox contains more than five measurement modes.

— Then Pulse Measurements

Measurement Selection

The pulse measurement results are presented as either a traditional power 
meter display or as a trace graph.

How to select the Measurement

— Press Measure 1

— Then choose from the following:

— Average Average power (Meter display)

— Peak Peak power (Meter display)

— Pk to Avg Displays the difference between the above two                       
measurements (Meter display)

— Trace Graph (default) The primary trace (Tr 1) plots pulse data in 
amplitude versus time. Optionally, you can enable a secondary 
‘zoom’ trace. Learn how in “Zoom Window” on page 574.

— When a ‘Meter display’ measurement is selected, the following Pulse 
Measurement Mode settings are identical to the standard USB Power 
Meter Mode settings. 

— Learn how to set Scale in “Scale” on page 575.

— Learn how to set Relative and Offset Power in “Relative and Offset 
Power Measurements” on page 550.

— Learn how to set Display Units in “Display Units” on page 551.

— Learn how to set Limits in “Limits” on page 553.

Frequency / Time

How to set Frequency

— Press Freq/Dist

— Then choose from the following:
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— Frequency Sets the center frequency of the carrier on which pulse 
modulation resides. This is used to set amplitude correction of the 
USB Power Sensor.

How to set Time

Specify the time over which data will be acquired by the USB Power Sensor. 
When Trace Graph is selected, Tr 1 is annotated with these values. Time can 
be specified using either of the following pairs of values:

— Center 1 and Time/div 1 Specify the center time and time per division.

— Start Time and Time Length Specify the start time and length of 
acquisition. 

— A positive start time indicates a delay after the sensor detects a pulse 
signal. 

— A negative start time displays data that is acquired BEFORE the sensor 
detects a pulse signal (or T-zero).

— Follow each by entering a value using the numeric keypad, the  arrows, 
or the rotary knob.

— After using the keypad, select a multiplier key. Learn about multiplier 
abbreviations. 

Zoom Window

When Trace Graph is selected as the measurement, a secondary Zoom Trace 
can be used to view a zoomed portion of Tr 1. When Zoom Window is ON, blue 
vertical posts appear on Tr 1 to indicate the current start, center, and stop 
times of the zoom window. The zoom window can be scaled using the standard 
Scale settings.

How to make Zoom Window settings

— Press Measure 

— Then Trace Graph 

— Press Trace 6 or Freq/Dist > More

— Then Zoom Window OFF ON

— Then choose from the following:

— ON Opens the zoom window on the bottom half of the FieldFox 
screen. The window includes the zoomed trace. 

— OFF Closes the zoom window.

— Zoom Center While monitoring the T within the blue vertical posts on Tr 1, 

enter a value for the center time using the numeric keypad, the  
arrows, or the rotary knob.
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— Zoom Time/div While monitoring the blue vertical posts on the primary 
trace, enter a value for the zoom window span using the numeric keypad, 
the ?|? arrows, or the rotary knob.

— Trace 1 (Only available under the Trace 6 hardkey.) Press to select Tr 1. This 

can also be done by using the  arrows. Select a trace before making 
trace settings, such as Scale.

— Zoom Trace (Only available under the Trace 6 hardkey.) Press to select the 
zoom trace.

Scale

For Meter-style measurements, learn how to set Scale, Relative and Offset 
Power, display Units, and Resolution beginning in “Scale” on page 575. 

How to set Scale for Trace Graph measurements

— Select a trace to scale using the  arrows.

— Press Scale / Amptd

— Then choose from the following methods:

— Autoscale Automatically adjusts the Y-axis to comfortably fit the Minimum 
and Maximum amplitude of the trace on the screen.

— Set Scale, acquisition, and Reference Position:

— Scale Manually enter a scale per division to view specific areas of 
the trace.

— Ref Level Manually set the value of the reference line. Enter a 
negative value by pressing Run/Hold (+/-) either before or after 
typing a value. 

— Ref Pos Manually set the position of the reference line. Values must 
be between 0 (TOP line) and 10 (BOTTOM line).

— Offset ON Enable Offset. When only trace 1 is visible, Offset ON 
appears to the left of the trace. 

— Offset Val Enter a value by which all amplitude values will be offset. 
This can have the effect of virtually removing a component from the 
measurement path. A positive value compensates for a component 
with loss. A negative value compensates for a component with gain. 
Offset values are limited to +/- 100 dB. 

Averaging 

Averaging helps to reduce the effects of random noise on a measurement. The 
more measurements that are averaged, the greater the amount of noise 
reduction. Averaging is allowed for all pulse measurements. 
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Averaging is performed in the USB and LAN Power Sensors before the data is 
sent to the FieldFox. 

Annotation in the left pane shows the state of the Average setting. When 
Manual is selected, the ‘Num of Averages’ is setting is also shown. 

How to set Averaging 

— Press BW 2. 

— Then Averaging

— Then choose from the following:

— Auto Averaging is set to a reasonable value by the USB Power 
Sensor.

— Man Averaging is set to the value specified in the ‘Num Averages’ 
setting.

— Off Averaging is OFF

— Num Averages Select a value using the numeric keypad, then press Enter. 

Video Bandwidth

The Video Bandwidth setting enables an FIR (finite impulse response) filter 
within the USB Power Sensor. The filter setting affects the appearance of the 
trace results.

Video Bandwidth is allowed for all pulse measurements

How to set Video Bandwidth 

— Press BW 2. 

— Then Video Bandwidth 

— Then choose from the following:

— Off Video Bandwidth is disabled. 

— Low   Similar to a low pass filter, ripple in the pass band is minimized 
but allows higher side-lobes on the filter skirt.

— Medium   Smooth pass band with reasonable transition ripple. 

— High  The pass band ripple is similar to the OFF setting, but the 
transition skirts are smoother.
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Single or Continuous Measure

This setting determines whether the FieldFox continuously queries the USB 
Power Sensor for data, or only once each time the Single button is pressed. 
Use Single to conserve battery power or to allow you to save or analyze 
specific data.

How to set Single or Continuous

— Press Sweep 3

— Then choose one of the following:

— Single   Automatically sets Continuous OFF and causes the FieldFox 
to query the USB Power Sensor ONCE, then hold for the next Single 
key press. Hold is annotated in the upper left corner of the display.

— Continuous OFF ON Queries the USB Power Sensor whenever a valid 
trigger signal is present. This is the typical setting when battery 
power is not critical.

You can also use Run / Hold +/- to toggle between Single and Continuous.

Resolution

Resolution is the number of individual acquisitions that occur in the USB 
Power Sensor. This data is read by the FieldFox and plotted across the X-axis 
to form a trace. More data points increases measurement resolution. However, 
more data points requires more time to acquire, query, and plot.

How to set Resolution

— Press Sweep 3

— Then Resolution 

— Then choose from the following:

— Low 240 data points.

— Medium 1000 data points.

— High Calculated value - approximately 8000 data points.

Triggering

For pulse measurements, a trigger signal refers to the event that causes the 
USB Peak Power Sensor to initiate measurement acquisition. It does NOT refer 
to triggering the FieldFox. 

Trigger settings can be used with ALL pulse measurements unless stated 
otherwise.
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A Waiting for Trigger message on the FieldFox screen is posted on behalf of 
the USB Power Sensor when it is waiting for a pulse signal at the RF Input 
(Internal) or a TTL signal at the USB Sensor External Trigger input.

How to make Trigger settings

— Press Sweep 3

— Then Trigger

— Then Trig Type

— Then choose from the following:

— Freerun The USB Power Sensor acquires data without waiting for a 
trigger. This mode is NOT supported for Trace Graph measurements.

— Internal The USB Power Sensor acquires data when a valid pulse 
signal is detected at the RF input. The following Trigger settings 
determine the validity of the trigger signal.

— External The USB Power Sensor acquires data when a valid TTL 
signal is detected at the USB Power Sensor external trigger input. 

Trigger Edge

This setting determines which edge of a trigger signal initiates data 
acquisition. 

— Press Sweep 3

— Then Trigger 

— Then Trigger Edge

— Then choose from the following:

— Pos Acquisition is triggered by the rising (positive) edge of a valid 
signal.

— Neg Acquisition is triggered by the falling (negative) edge of a valid 
signal.

Trigger Delay

After a valid trigger signal is received at the USB Power Sensor, data 
acquisition begins after the specified Trigger Delay time PLUS the specified 
Start time. See the Pulse Timing diagram in “Trigger Settings Annotation” on 
page 580 for more information.

— Press Sweep 3

— Then Trigger

— Then Trigger Delay
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— Then enter a value using the numeric keypad, the  arrows, or the rotary 
knob. 

Auto Trigger

Used ONLY when Trigger Type = Internal, this setting determines whether the 
trigger level is set manually or is set to the default level in the USB Power 
Sensor firmware.

— Press Sweep 3

— Then Trigger

— Then Auto Trigger

— Then choose from the following:

— ON Trigger level is determined by the USB Power Sensor firmware.

— OFF The trigger level is set manually using the Trigger Level setting.

Trigger Level

Used when Trigger Type = Internal AND Auto Trigger = OFF (Manual). 

— Press Sweep 3

— Then Trigger 

— Then Trig Level

— Then set the trigger level using the numeric keypad, the  arrows, or the 
rotary knob. A line appears on Tr 1 at the current trigger level setting. Data 
acquisition occurs when the RF input signal crosses the line. This setting 
can be used with either Positive or Negative edge triggering. 

Qualification

Use the qualification setting to avoid triggering on false pulses and to aid in 
stabilizing the power trace. 

The qualification time defines the time the signal has to remain below the 
trigger threshold before a transition through the threshold will qualify as a 
trigger. This can help stabilize a power trace, particularly with digitally 
modulated pulses that may have many transitions through the trigger 
threshold. By setting the qualification time longer than the short transitions of 
the data signal the sensor will reliably trigger on the pulse and not on the data. 
It will also eliminate triggering on very short noise spikes when the trigger level 
has to be set to low power.

— Press Sweep 3

It may be may be necessary to set the qualification time to the minimum 
20 ns in order to trigger on very short pulses.
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— Then Trigger 

— Then Qualification

— Then set the qualification value using the numeric keypad or the rotary knob 
(default: 100 ns, minimum: 25 ns, maximum: 50 μs). 

Trigger Settings Annotation

Trigger settings are annotated on the FieldFox screen as highlighted in red in 
the following image:

In the previous graphic, the settings are: Trig Level = -10 dBm, Trig Type (Int), 
Pos Slope (/), Delay

 

Marker Settings

Markers are not allowed with Meter-style measurements.

Markers are displayed on Tr 1 and also on the zoom trace if the marker is 
within the zoom window time span.
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Up to six standard markers can be used to provide readouts of the Y-axis 
amplitude at the current X-axis location. 

The six standard markers can also be used as Delta Markers. 

Learn more about standard markers in “All about Markers” on page 700.

Amplitude Markers

Amplitude markers are horizontal dotted lines that you can move to any 
amplitude level on the screen. The two amplitude markers can be set 
independently or used as a pair of delta markers.

Amplitude markers can be used as a visual comparison aid with the pulse 
measurement traces.

How to make Amplitude Marker settings

— Press Marker 

— Then More 

— Then Ampl Markers

— Then choose from the following:

— OFF Amplitude markers are NOT displayed.

— ON Amplitude markers ARE displayed at their previous positions.

— Then Ampl Mkr 1 or 2

— Enter a value in dBm for the marker using the numeric keypad, the  
arrows, or the rotary knob.

— Press Delta Ampl Mkr

— Then choose from the following:

— ON AmplMkr 2 value is relative to AmplMkr 1. When AmplMkr 1 is 
moved, AmplMkr 2 also moves to maintain the AmplMkr 2 value 
between them.

— OFF The two amplitude markers move independent of one another.

Marker Search

Use Marker Search to find and move markers to locations on the Tr 1 trace. 

How to Search with Markers

— Activate the marker to be used for the search 

— Then press Mkr ->/Tools.

— Then Marker Search
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— Then Zone Search 

— Then choose from the following:

— ON Available ONLY when the zoom window is enabled, the search is 
limited to the zone defined by the zoom window.

— OFF The search is performed over the entire Tr 1 trace.

Then choose from the following: 

— Target, Peak, and Minimum. Learn more about these standard features 
beginning in “Searching with Markers” on page 706.

— Rise Time Select, then set a value in dB. Delta markers are created and 
placed at the Peak and at the specified value BEFORE the Peak.

— Fall Time Select, then set a value in dB. Delta markers are created and 
placed at the Peak and at the specified value AFTER the Peak.

Auto Analysis

Auto Analysis reports the following TEN pulse measurements:

Rise and Fall time in Marker Search uses different criteria than in Auto 
Analysis and will therefore result in different reported values.

For more information on peak power measurements refer to the 
documentation for your power sensor. Learn more, 
https://www.keysight.com/us/en/assets/7018-03076/application-notes/
5990-8708.pdf.

1 - Average Power Average power level of all measured data 
points

2 - Peak Power Highest reading of all measured data 
points

3 - Peak minus Average Difference between the above two results

4 - Pulse Top Power value based on the specified Pulse 
Top setting.

5 - Rise Time The time it takes for a pulse to rise from 
10% to 90% of its peak value.
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How to enable Auto Analysis

— Press Mkr ->/Tools.

— Then Auto Analysis 

— Then choose from the following:

— OFF Analysis OFF

— ON The Analysis values appear below trace 1.

Pulse Top

Pulse Top is NOT the same as the pulse Peak. Pulse Top is used to set and 
report the reference power level. You enter a value in percent, and the Pulse 
Top value is reported in the Auto Analysis table in dB down from 100% of the 
reference power level.

How to set Pulse Top

— Press Mkr ->/Tools

— Then Pulse Top 

— Then enter a percent value between 0 and 100 using the numeric keypad, 

the  arrows, or the rotary knob. 

— When set to 10%, 10 dB down from the 100% acquisition is reported.

— When set to 50%, 3 dB down from the 100% acquisition is reported.

— When set to 90%, 0.5 dB down from the 100% acquisition is reported.

Grid

Enables and disables the display of a 10 x 10 grid on the FieldFox screen.

How to enable Grid display

— Press Mkr ->/Tools

6 - Fall Time The time it takes for a pulse to fall from 
90% to 10% of its peak value.

7 - Pulse Width The time between the rising edge and 
falling edge of a pulse.

8 - Pulse Period The time of one complete pulse cycle

9 - Duty Cycle The ratio of the pulse width / pulse period. 

10 - Pulse Rep Freq The rate, in pulses / sec, at which pulses 
recur.
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— Then Grid 

— OFF Grid OFF

— ON A grid of X/Y lines appears on the screen.

Trace Memory

A memory trace is a pulse measurement Tr 1 data trace (NOT the trace in the 
Zoom window) that has been stored in the FieldFox volatile memory. It then 
becomes static, meaning it is not updated with normal pulse measurements. It 
can be displayed on the screen by itself, or with a pulse trace for comparison 
purposes.

The Tr 1 data trace is displayed in yellow.

The memory trace is displayed in blue. 

How to display data and memory traces

— Press Trace 6.

— Then Trace Memory 

— Then Data->Mem to store the current live trace into memory. A ‘beep’ 
sounds to confirm the data trace has been saved to memory. There is no 
display annotation that indicates that the memory trace has been stored. 

— Press Data to view only the data trace.

— Press Memory to view only the memory trace.

— Press Data & Memory to view both the live trace and the stored 
memory trace. 
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24 VVM (Vector Voltmeter) Mode - Option 308

VVM Mode (Option 308) measures the electrical length of cables and other 
devices. The 1-Port Cable Trimming and 2-Port Transmission measurement 
displays the electrical length in both Magnitude and Phase.

Figure 24-1 Display for the 1-Port Cable Trimming measurement

In this Chapter

“Overview” on page 587

“Measurement Selection” on page 588

“Frequency Selection” on page 588

“Display Resolution” on page 588

“IF Bandwidth” on page 589

“Output Power” on page 589

“Averaging” on page 590

“Single or Continuous Measure” on page 591

“VVM Calibration” on page 591

“Zeroing” on page 591
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Procedures

“1-Port Cable Trimming Measurements ” on page 593

“2-Port Transmission Measurements” on page 595

“A/B and B/A Measurements” on page 596
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Overview
In the FieldFox, both 1-port and 2-port measurement types use a different 
configuration setup from the HP/Keysight 8508A Vector Voltmeter.

Figure 24-2 Typical 8508A measurement configuration –as shown in the 8508A manual.

The above block diagram requires an external source and directional coupler to 
measure the electrical length of a DUT or cable to be trimmed. Separate paths 
are used to measure the Incident signal (A) and Reflected signal (B). To 
measure the ratio of the Reflected/Incident signals, you were required to select 
B/A for both the Magnitude and Phase display.

In the FieldFox, the source and directional coupler are inside the instrument. 
This allows you to connect the DUT to ONLY the FieldFox PORT 1, with NO 
external instruments, in order to make Cable Trimming measurements. 

See the FieldFox block diagram and Cable Trimming procedures beginning in 
“1-Port Cable Trimming Measurements ” on page 593. 
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VVM Mode Settings
Select VVM Mode before making any setting in this section. 

How to select VVM Mode

— Press Mode 

— Then VVM 

Measurement Selection

How to select a VVM Measurement

— Press Measure 1

— Then choose from the following:

— 1-Port Cable Trimming 1-port reflection measurement. Learn how to 
make this measurement in “1-Port Cable Trimming Measurements ” 
on page 593.

— 2-Port Transmission 2-port transmission measurement. Learn how 
to make this measurement in “2-Port Transmission Measurements” 
on page 595. 

— B/A and A/B 2-port ratioed receiver measurements using external 
sources. Learn more in “A/B and B/A Measurements” on page 596. 

Frequency Selection

How to set Frequency

— Press Freq/Dist 

— Then Frequency

— Enter a value using the numeric keypad, the  arrows, or the rotary 
knob.

— After using the  arrows or the rotary knob, press Enter. The increment 
setting of the arrows is based on the current span and can NOT be changed 
in VVM Mode.

— After using the keypad, select a multiplier key. Learn about multiplier 
abbreviations in“Multiplier Abbreviations” on page 46. 

Display Resolution

You can display either one digit or two digits after the decimal point for both 
magnitude and phase readings.
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This setting survives a Preset and Mode Preset.

How to set Resolution

— Press Scale/Amptd 

— Then Resolution

— Then choose: 

— 1   0.0 (default) 

— 2   0.00 

IF Bandwidth

Reducing the IF receiver bandwidth reduces the effect of random noise on a 
measurement. However, narrower IF bandwidths cause longer measurement 
times. 

For highest accuracy, Zero AFTER changing the IF Bandwidth. Learn about 
Zeroing in “Zeroing” on page 591.

How to set IF BW

— Press BW 2

— Then IF BW 

— Then choose from the following:

— 10 Hz | 100 Hz | 1 kHz | 10 kHz | 100 kHz  
More 30 Hz | 300 Hz | 3 kHz | 30 kHz

Output Power

Set the power level out of the FieldFox to High, Low, or manually set power 
level to a value between High and Low. 

Generally, the high power setting is used when measuring passive, high-loss 
devices to place the signal farther from the noise floor. Increasing the power 
can also help reduce trace noise. However, for devices that are sensitive to 
high power levels such as amplifiers, use the Low power setting.

For best measurement accuracy, use the Manual power setting at -15 dBm. 
After calibration, the power level can be decreased for amplifiers, or increased 
for higher dynamic range.

Power Level settings in this mode will NOT change Power Level settings in 
other modes. To help prevent damage to your DUT, use caution when 
changing modes with your DUT connected to the FieldFox test ports. 
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How to set Output Power

— Press Meas Setup 4.

— Then More

— Then Output Power

— High Sets output power to the maximum achievable power at all 
displayed frequencies. Output power is NOT FLAT across the 
displayed FieldFox frequency span. Use the High power setting, when 
better dynamic range and lower noise is desired. Please see 
“Specifications/Data Sheet” on page 829 for expected power levels.

— Low Sets output power to approximately –50 dBm. 

— Man (Default setting) Sets the output power to –15 dBm, FLAT across 
the displayed FieldFox frequency span. If flattened power can NOT be 
achieved, a warning message and beep occurs. To achieve a 
flattened output power, reduce the power level or stop frequency.

— Then press Power Level 

— Then enter a value using the numeric keypad, the  arrows, or the 
rotary knob. 

— Press Enter.

Averaging

Averaging helps to reduce the effects of random noise on a measurement. The 
FieldFox computes the displayed value over several consecutive readings. 
Average count determines the number of readings to average. The higher the 
average count, the greater the amount of noise reduction. 

An average counter is shown in the left edge of the screen as Avg N. This 
shows the number of previous readings that have been averaged together. 
When the counter reaches the specified count, then a ‘running average’ of the 
last N readings is displayed.

Average count = 1 means there is NO averaging. 

This setting can be changed at any time without affecting calibration accuracy.

How to set Averaging

— Press Meas Setup 4

— Then More

— Then Avg N where N is the current count setting.

— Enter a value using the numeric keypad. Enter 1 for NO averaging. 

— Press Enter. 
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To restart the averaging process, press Meas Setup 4, then More, then Restart 

Single or Continuous Measure

This setting determines whether the FieldFox measures continuously or only 
once each time the Single button is pressed. Use Single to conserve battery 
power or to allow you to save or analyze a specific measurement. 

This setting can be changed at any time without affecting calibration accuracy.

How to set Single or Continuous

— Press Meas Setup 4 

— Then choose one of the following:   

— Single Automatically sets Continuous OFF and causes the FieldFox to 
make ONE measurement, then hold for the next Single key press. The 
Hold annotation changes to an arrow --> while the measurement 
occurs.

— Continuous OFF and Hold both put the FieldFox in Hold mode.

— Continuous ON Makes continuous measurements. This is the typical 
setting when battery power is not critical.

— You can also use Run / Hold +/- to toggle between Single and Continuous.

VVM Calibration

CalReady is accurate for most zeroed VVM measurements at frequencies 
below about 6 GHz. For the very highest accuracy, especially above 6 GHz, 
then perform a Mechanical Cal. Learn more in “How to Perform a Calibration” 
on page 127. 

Press Zero OFF before calibrating (sets Zero to OFF).

Zeroing

Zeroing, also known as Normalization, or Data/Memory, simply “Zeroes” the 
Magnitude and Phase display when Zero ON is pressed. All subsequent 
measurements are relative to the measurement that was made when Zero was 
pressed.

When an instrument state is saved with Zero ON, the zeroing data is saved with 
the state file, similar to how a calibration is saved with a state file.

— When performing a 1-Port Cable Trimming operation, a reference cable is 
connected and measured. Then Zero is pressed, and subsequent cables are 
measured and trimmed to match electrical length of the reference cable. 



 592                                                                                                                     Keysight N9938-90006 User’s Guide

VVM (Vector Voltmeter) Mode - Option 308
VVM Mode Settings

— For 2-port measurements, Zero is typically pressed when a THRU 
connection is made in place of a DUT. Learn more in “2-Port Transmission 
Measurements” on page 595.

Press Zero OFF before performing a Mechanical Cal (sets Zero to OFF).

How to select Zeroing

— Press Meas Setup 4 

— Then Zero Ref

— Open – select to display Phase = 0.0 Deg when zeroed.

— Short - select to display Phase = 180.0 Deg when zeroed. 

— Then Zero ON

— Select Zero OFF to turn zeroing off. 
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1-Port Cable Trimming Measurements 
A 1-Port Cable Trimming measurement is used in a cable fabrication procedure 
to validate proper electrical length. 

How to make a 1-Port Cable Trimming Measurement

1. Press Mode then VVM then 1-Port Cable Trimming.

2. Press Freq/Dist then enter the frequency for the measurement. 

3. To improve measurement stability, change the IF Bandwidth, Output 
Power, and Averaging settings as needed.

4. 4.Press Meas Setup 4 then Zero OFF.

5. Optionally calibrate the FieldFox. Learn more about VVM calibration in 
“VVM Calibration” on page 591.

6. To ensure that the calibration is adequate, perform the following optional 
Measurement Verification procedure.

a. Connect a short standard to PORT 1 where cables to be trimmed 
will be connected. 

b. Press Meas Setup 4 and press Zero.

c. Remove the short standard and connect the open standard.

d. Confirm that magnitude measurement is less than –0.1 dB and that 
the phase value reads 180° degrees.

7. Attach the shortest cable to the FieldFox PORT 1 connector. This cable is 
the reference cable. Leave the end of the reference cable open 
(unterminated).

8. Press Meas Setup 4 then press Zero. 

— The R receiver measures incident 
signal (green line) out of the source. 

— The A receiver measures reflected 
signal (red line) from the end of the 
DUT (black line). 

—  In VVM mode, the display ALWAYS 
shows ratioed (A/R) measurements 
which is the electrical length of the 
DUT.

This measurement verification procedure is suitable for low frequency 
measurements. However, for high frequency measurements, a more 
sophisticated procedure is required.
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9. Remove the reference cable from the FieldFox PORT 1 connector.

10.Connect an unterminated, longer cable to the FieldFox PORT 1 connector.

11.Observe the displayed phase difference between the reference cable and 
the untrimmed cable.

12.Carefully trim the cable until the phase shift reads zero. The attached 
cable’s electrical length is now matched to the reference cable.

13.Repeat steps 10 through 12 for the remaining cables to be trimmed.

The VVM phase reading shows a maximum of ±180°. Therefore, the 
electrical length of the untrimmed cable MUST be within 180° of the 
reference cable. 
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2-Port Transmission Measurements
A 2-Port Transmission measurement is used for measuring electrical length, 
insertion loss, gain, or isolation of a DUT at a single CW frequency. The 
FieldFox signal source is transmitted out the port 1 connector, through the 
DUT, and into the port 2 connector. In the following image, the gain of an 
amplifier is being measured. 

Figure 24-3 2-Port Transmission measurement of an amplifier

How to make a 2-Port Transmission Measurement

1. Press Mode then VVM then 2-Port Transmission.

2. Press Freq/Dist and enter the measurement frequency.

3. Press Meas Setup 4 then More then Output Power. Select High for passive 
devices. Select Low for amplifiers. 

4. Calibrate the FieldFox using one of the methods described in “VVM 
Calibration” on page 591. Before performing a Mechanical Cal, press Meas 
Setup 4 then Zero OFF. 

5. Connect the DUT.

Notes:

— The magnitude value is the gain (positive value) or the loss (negative value) 
of the DUT. 

— The phase value is the difference in phase (in degrees) between the DUT 
input and output.

— To measure isolation of the amplifier, reverse the connection to the amplifier 
(PORT 1 to the amplifier output).
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A/B and B/A Measurements
These measurements allow you to use the FieldFox A and B receivers, along 
with an external source, to make ratioed measurements. 

The image below shows a typical configuration for a B/A magnitude and phase 
measurement of a 2-port DUT. This DUT can be an antenna / probe setup. 
Using network analyzer terms, the image shows the A receiver as the reference 
receiver which measures the signal that is applied to the DUT. The B receiver is 
the test port receiver which measures the DUT response. 

Figure 24-4 B/A Transmission measurement with external source

Procedure 

1. Connect the external source’s frequency reference output to the FieldFox 
Freq Ref IN on the top panel. If you are unable to use a common frequency 
reference, then increase the IFBW to ensure you are measuring the peak of 
the correct signal. After locating and tuning to the signal, you may be able 
to lower the IFBW to reduce noise.

2. On the FieldFox, select System 7, then System Configuration, then 
Frequency Ref, then Freq Ref Source then Ext.

3. Press Mode, then VVM, then B/A or A/B

4. The FieldFox internal source is NOT used, so the output power setting is 
not relevant. 

5. To calibrate, replace the DUT with a THRU connection, preferably by 
connecting together the two Power Splitters (shown in green). For low 
frequency measurements, TEEs can be used. 

6. Press Meas Setup 4, then Zero.

7. Connect the DUT and measure.

These measurements require the “Full 2-port S-parameters” option.
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25 ERTA (Extended Range Transmission Analysis) Mode - Option 
209

ERTA (also known as FoxTrot) uses two FieldFox units to make long-distance 
scalar transmission measurements. One unit is the source and the other unit is 
the Receiver.

In this Chapter

“Overview” on page 598

“Requirements and Limitations” on page 599

“Start Connection Wizard” on page 600

“Configure Measurement Settings” on page 604

“Select Measurement” on page 604

“Normalize” on page 605

“Source Tracking Offset and Offset Reversal” on page 605

“Improve Dynamic Range” on page 606

“Source Enable and Source Mode” on page 606
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Overview
ERTA uses two FieldFox units to make long-distance scalar, tracking 
transmission measurements. One unit is the source and the other unit is the 
Receiver.

Communication takes place between the two units with a LAN connection and 
hard-wired trigger signals. Once the two units are synchronized, the Receiver 
unit becomes the primary and measures the output of a DUT, while the Source 
unit responds as secondary supplying signal at the DUT input. The two units, 
possibly separated by hundreds of meters, step together through the selected 
frequency range making measurements such as long cable characterization.

With a power splitter at the Source unit, the SA Receiver can be used to 
measure the reference signal to make a true B/R ratio measurement. Because 
the reference trace is updated on every sweep, there is no need for static trace 
normalization. Accuracy is further enhanced with input and output cable 
corrections. Furthermore, the alignment process keeps the SA receivers 
calibrated. For information on alignments, refer to the SA mode chapter’s 
section, “Alignments” on page 201.
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Requirements and Limitations

Requirements

— Two FieldFox units with option 209 installed. SA Mode is required for option 
209.

— Ethernet LAN cable(s). Either TWO cables that are used to connect both 
units to the internet or ONE cable that is long enough to connect the two 
FieldFox units. This may require a cross-over cable.

— Two trigger cables that are long enough to connect the two FieldFox units, 
each with SMB (m) to SMA (f) connectors.

— RF cabling to and from DUT.

— Power Splitter (Optional) for enhanced B/R ratio measurements.

Limitations

The following SA features are removed in ERTA mode (Option 209):

— Channel Measurements, Tune and Listen, Interference Analysis, Radio 
Standards, and Sweep Triggering.

The following SA features are disabled during partnership synchronization: 

— Video BW, SwpAcquisition, Frequency Count, Record/Playback, and certain 
Amplitude Units.

— The only keystrokes allowed on the Source unit are Send Text Message and 
Exit.

When you change network connections, it may take up to 2 minutes for 
the old address to be replaced by the new address. If the FieldFox was 
initially assigned an IP address by a DHCP server, and then the FieldFox 
LAN connection with a DHCP server is removed and is the FieldFox is 
reconnected to a LAN segment with no DHCP server (such as a direct 
connect to another FieldFox), the FieldFox may take up to two minutes to 
self-assign an automatic private IP address. During this connection time 
the last recognized DHCP address is displayed on the FieldFox, but is 
invalid. 
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Start Connection Wizard
Use the FieldFox Connection Wizard to guide you through the following 
physical setup.

On the Receiver unit:

— Press Mode then ERTA 

— Then Meas Setup 4 then Connection Wizard then Start.

STEP 1: Select [Start] when ready

— Press Start

— At any step, press Exit to end the wizard.

STEP 2: Connect Trigger and LAN cables

— LAN: Connect a LAN cable to each unit. The units can either both be 
connected to the internet on the same network through a switch or router, 
or they can be connected directly to each other (a crossover cable may be 
necessary).

— Trigger signals: On each unit, connect the Ref/Trig Out SMB (m) connector 
on the FieldFox side panel to the Ref/Trig In SMA (f) connector on the other 
FieldFox top panel. 

— RF connections

Preferred method (pictured above): 
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— On the Source unit, connect the Port 1 RF Output connector to the 
input of a power splitter. 

— Connect one power splitter output to the Source unit Port 2 RF Input.

— Connect the other power splitter output to the DUT input.

— Connect the DUT output to the Port 2 RF Input of the Receiver unit.

Simplified method (not shown):

— Omit the power splitter. Connect the Source unit Port 1 RF Output 
connector to the DUT input. The measurement is a raw B receiver. 
Specs do NOT apply.

STEP 3: Select LAN address of ERTA Partner

The Receiver unit is the primary partner, annotated with RCVR Primary.

The Source unit is the secondary partner, annotated with SRC Secondary.

On the Receiver unit:

— Press ERTA Partner (not specified). The IP addresses of potential FieldFox 
units are displayed. Select the IP address of the Source unit. If 10.10.10.1 
appears, then NO FieldFox units were found. The LAN setting “Obtain IP 
Address using” MUST be set to DCHP. Learn more in “LAN Settings” on 
page 765. Also be sure that Opt. 209 has been installed correctly on the 
Source unit. 

— Press Continue.

STEP 4: Test Partnership

— Press Test Partnership. If the Source unit is NOT already in ERTA mode, it 
will be started, which may take a several seconds. When successful, LAN 
OK and Trigger OK will appear on the screen.

— If either the LAN or Trigger test fails, then press Clear Test, then Test 
Partnership to retry the test.

— Optional: Press Send Text Message, then enter a message to send to the 
Receiver unit. A LAN connection is necessary. For quick communication, 
custom Keywords can be setup using the FieldFox labeler. Learn how in 
“Edit Keywords” on page 789.

Any of the following will end the partnership:

— Press EXIT Partnership

— Select Global or Mode Preset

— Change Modes

— Recalling a non-ERTA State file. Recalling an ERTA State file can 
re-establish a partnership if the Source unit is still on the network at the 
same location.
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— Press Continue.

STEP 5: Measure Jumper Cables

These steps can be used to characterize an Input and Output jumper cable that 
may be connect the DUT to the FieldFox. The loss of the characterized jumper 
cables can then be removed from the DUT measurements. The measurements 
are stored to the internal Cables folder using an auto-generated *.csv filename. 

— The Input cable is attached between the Source/splitter output and the 
DUT input.

— The Output cable is attached between the DUT output and the Receiver 
unit. 

Figure 25-1 Input and Output jumper cables are measured on the Receiver unit

If your DUT input AND output is connected directly to the FieldFox, or you 
choose to ignore the loss of BOTH jumper cables, then press Skip this step. 

Otherwise, press Measure Jumper Cables. 

Do the following for both the Input and Output jumper cables:

— Press Skip this step to skip the cable measurement.

— Otherwise, connect the Input / Output jumper cable as shown below, then 
press Measure Input (or Output) Cable. 

For optimum flexibility, use the Scale, then More, then Corrections menu to 
measure, save, and recall cable characterizations. These softkeys are 
duplicated from the SA Field Strength - Antenna/Cable characterization. 
Learn more in “Field Strength Measurements” on page 161.
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— Press Re-measure or Continue.

— Press Apply Corrections Auto to remove the jumper cables from 
subsequent DUT measurements (Default = Auto).

— Press Done to exit the Connection Wizard.

— On the Receiver unit, press Primary ERTA Partnership. The Source unit 
enters ERTA mode as the secondary.
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Configure Measurement Settings
On the Receiver unit, select measurement settings such as Frequency range, 
Res Be, Points, and so forth. Zeros pan frequency is allowed even though the 
frequency is fixed and no stepping is required. 

Learn about these settings in “SA Mode Settings” on page 151.

Select Measurement

The following traces are provided for your convenience. They are all configured 
as Clear/Write. 

Press Meas 1, then choose one or more of the following:

Figure 25-2 Input power, Output power, and gain measurement traces

To change the trace numbers of these three measurements, or to select a trace 
state other than Clear/Write, press Trace 6.

Softkey Shown on screen Description

Input Power 
 R

2 
w 
r 

R receiver. Reference power 
measured by the Source unit 
before entering the DUT.

Output Power    
B

3 
w 
B

B receiver. Power out of the 
DUT measured at the 
Receiver unit.

Gain or Loss  
B/R

1 
w 
G

Gain or Insertion Loss. The B 
receiver data divided by the 
R receiver data (B/R)

This measurement can be 
displayed accurately with, or 
without, displaying the R or 
B measurements.
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Learn more about Trace Display States in “Trace Display States (SA Mode)” on 
page 198.

Normalize

Normalize can be used to quickly provide ‘zeroing’ for any of the ERTA (B, R, or 
G) traces. On the sweep AFTER selecting Normalize, Trace 1 is copied to 
Trace4. It is then put into View state and subtracted from that input on 
subsequent sweeps. Any trace (1, 2, or 3) which is set to process that same 
input (B, R, or G) will therefore be processing normalized measurement data. 
This continues as long as the frequency span, number of points, and the trace 
input (B, R, or G) is NOT changed. If any of these settings change, Normalize is 
deactivated.

How to Normalize the B trace

— Press Meas Setup 4

— Then Remote Source 

— Then Normalize ON

Source Tracking Offset and Offset Reversal

Source offset tracking is used to offset the Source frequency from the Receiver 
frequency by a fixed offset at every tune frequency. This feature is used when 
the DUT contains a frequency converter.

How to set Tracking Offset and Offset Reversal

— On the Receiver unit, press Meas Setup 4, 

— Then Remote Source 

— Then Advanced 

— Then choose one or both of the following:

— Tracking Offset Enter an offset value.

— OfsTrkReversal Determines whether Receiver Freq is added to or 
subtracted from the Offset Freq.

——OFF SourceFreq = Offset + RecFreq. Use to measure 
Upconverters.

——ON SourceFreq = Offset - RecFreq. Use to measure 
Downconverters. The source sweeps in Reverse direction.

The Offset Freq. MUST be larger than the Receiver Stop Freq.
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Improve Dynamic Range

The following settings can be made to reduce measurement noise which 
improves Dynamic Range.

Increase source power as much as possible while maintaining a leveled source.

How to set Source Power

— Press Meas Setup 4 

— Then Remote Source 

— Then Source Power

— Then either Max Power or Leveled - Increase source power until the 
unleveled warning appears. Then decrease power until power is again 
leveled.

To further reduce measurement noise, on the Receiver unit:

— Reduce Attenuation to 5 dB, then turn the Preamp ON. Learn how in 
“Preamplifier Control (Opt 235)” on page 160. 

— Decrease the Res BW. Learn how in “Resolution Bandwidth (Res BW)” on 
page 182.

— Set Frequency Reference to GPS on both units. This requires Option 307 
(Built-in GPS) and two GPS antennae. The GPS reference can be enabled 
for several sweeps. Then if you move to a location without an adequate GPS 
signal, Hold-over Mode will occur. Learn more about GPS as a frequency 
reference in “Frequency Reference Source” on page 760.

Source Enable and Source Mode

When Source Enable [OFF] is selected, or when Source Mode [CW or 
CoupledCW] is selected, then synchronization ends and the two partner units 
revert to general SA (non-tracking) sweeps. However, the units are still in 
partnership, and other settings continue to be synchronized such as 
Frequencies, ResBw, and Points.
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In this Chapter

Using AM/FM Metrics
Using FieldFox’s analog demodulation, users maintaining AM/FM radio 
systems can demodulate and characterize AM and FM signals. They can tune 
to the signal and listen to the audio tones using FieldFox’s built-in speakers or 
a headphone. They can also display the RF spectrum, the demodulated 
waveform and AM/FM metrics such as carrier power, modulation rate, and 
SINAD.

AM/FM Metrics enables you to make the following measurements:

And, can be enabled/disabled simultaneously with Tune and Listen.

Overview of Measurement Types

If you are familiar with the AM/FM measurements and terms, skip to “How to 
Set Up AM/FM Metrics” on page 610.

The FieldFox assumes you have manually set up the CF, span, and 
amplitude settings. Refer to Chapter 9, “SA (Spectrum Analyzer) Mode 
(Option 233–Mixed Analyzers).”

“Using AM/FM Metrics” on page 607

“SINAD and THD Calculations” on page 614

“Interpreting AM/FM Metrics Error Messages” on page 617

AM Measurements: — AM Measurements: Carrier power, AM rate, AM modulation 
index

FM Measurements: — FM deviation (peak and RMS), Modulation Rate, Carrier power, 
Demodulated voltage, SINAD, THD (total harmonic distortion)
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Table 26-1 Measurement Details

Measurement details

Modulation Rate The modulation rate quantifies how fast the modulation is and equates to the 
frequency of the baseband signal that modulates the carrier.

SINAD (Signal to Noise 
and Distortion Ratio)

Another commonly used distortion measure is signal to noise and distortion 
ratio (SINAD). SINAD, in nature, is the reciprocal of the modulation distortion 
provided by the “distortion/total Vrms,” but the SINAD is usually expressed in 
a logarithmic term as follows:

Where: 

S = Signal Power

D = 

N = Noise

SINAD = [(S + D + N) / (D + N)] OR

Refer to “SINAD and THD Calculations” on page 614. 

THD (Total Harmonic 
Distortion) 

The total harmonic distortion (THD) measurement further isolates the total 
harmonic distortion component from the noise component in the total 
unwanted signal. It helps the user to troubleshoot the root causes of 
modulation distortion.

S = Signal Power

D = 

N = Noise

THD = [(D + N) / (S + D + N)]

RF spectrum of the 
modulated signal

This is the most traditional spectrum analyzer measurement viewing the 
modulated carrier signal power in frequency domain. Prior to being 
modulated, the signal power of a sinusoidal carrier concentrates at the carrier 
frequency. By contrast, modulation causes sidebands indicating the power 
redistribution over frequencies. The pattern of the sidebands depends upon 
the modulation format.

Demod waveform This measurement retrieves the baseband signal from the modulated signal 
via the demodulation process, and displays the baseband signal in a pattern of 
modulation depth/deviation versus time. Since the modulation 
depth/deviation is directly proportional to the instantaneous amplitude of the 
baseband signal, the measurement result helps to intuitively evaluate the 
quality of the baseband signal. 

AM modulation depth AM modulation depth = (Peak-to-Peak / 2)
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Modulation Metrics

FM deviation The FM deviation reflects the amount of the frequency modulation to which 
the baseband signal modulates the carrier signal. The quantity being 
measured is the peak frequency deviation that is the maximum frequency 
excursion from the carrier frequency.

Carrier power This measures the power of the carrier signal without the modulation. Ideally, 
power for a sinusoidal carrier signal is concentrated around its carrier 
frequency.

Table 26-1 Measurement Details
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How to Set Up AM/FM Metrics

— Connect a test tone to the FieldFox SA Port 2 (Port 2)

— Press Measure > Analog Demod Tune & Listen > Analog Demod

Left display - Frequency Spectrum (Power vs. Frequency)

Right display - Demodulated waveform vs. time where Demod SwpT sets 
the width of the demod window.

— Then Freq/Dist > Center to set the carrier frequency.

— Set Freq Span so that all sidebands above -60 dB are displayed in the left 
window.

— Optionally, adjust the AF Res BW to better identify audio frequency side 
bands. Learn more, refer to Chapter 9, “SA (Spectrum Analyzer) Mode 
(Option 233–Mixed Analyzers)” and “AF RBW (Audio-Frequency 
Resolution BW)” on page 184.

— Optionally, Freq/Dist > Tune & Listen OFF – Opens a menu of Tune & Listen 
demod softkeys. Tune & Listen can be set when you are in Analog 
Demodulation mode, so you can enable Tune & Listen sweeps in between 
your Analog Demod sweeps. To learn more about the Tune & Listen softkey 
menu choices, refer to “Tune & Listen (AM/FM)” on page 166.

Metrics are displayed in the AM/FM Modulation Metrics table on the 
FieldFox. For AM and FM Metrics examples, refer to Figure 26-1 through 
Figure 26-8 on page 619.

Selecting FM Wide vs. FM Narrow does not effect the displayed waveforms 
or metrics. But, if you are using the Audio Demod feature and listening to 
the demodulated waveform, then select the appropriate FM type, because 
the tones do differ based on the FM type selected. Refer to Table 26-1 on 
page 608.

See also, Chapter 9, “SA (Spectrum Analyzer) Mode (Option 233–Mixed 
Analyzers)” and to “Analog Demod” on page 170.
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Figure 26-1 AM Metrics - Example 1
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Figure 26-2 AM Metrics - Example 2
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Figure 26-3 FM Metrics - Wide band Example
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SINAD and THD Calculations
— FieldFox converts the audio waveform to the audio frequency spectrum 

using an FFT (i.e., The FFT result is not displayed). Refer to Figure 26-4 on 
page 614. 

— The FFT waveform is used to calculate SINAD and THD distortion metrics

— The fundamental signal, harmonics, and noise from 0 Hz to 24 kHz are 
applied to the formulas. Refer to Figure 26-5 on page 615.   

— For more on calculations, refer to “Overview of Measurement Types” on 
page 607.

— See also, 
https://www.keysight.com/us/en/assets/7018-04493/application-notes/
5991-4913.pdf.

Figure 26-4 Audio Waveform with FFT Calculations
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Figure 26-5 SINAD and THD Results - Example 1
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Figure 26-6 SINAD and THD Results - Example 2
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Interpreting AM/FM Metrics Error Messages
This section discusses possible AM/FM Metrics error messages and how to 
correct them.

Test Tone Not Found

A Test Tone Not Found message is displayed under the following 
circumstances: 

— FieldFox frequency span is too wide

— No side lobes are displayed in the results

Refer to the examples in “Test Tone Not Found - Example” on page 618 and 
“Test Tone Not Found - Corrected Example” on page 619.
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Test Tone Not Found - Example

The following response had the following settings:

— Source CF: 140 MHz

— FM Deviation: 18 kHz

— Modulation Rate: 1 kHz

Reasons for error:

— Frequency span of 1.0 MHz is too wide

— No side lobes displayed, so test tone not found

Figure 26-7 Test Tone Not Found - Example
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Test Tone Not Found - Corrected Example

The following response was corrected with these setting changes:

— Frequency set to narrower frequency span of 50 kHz

— Ideally the frequency span should show the modulation envelope down to 
–60 dB below the RF power level

Response corrected, because:

— Narrowing the frequency span enables the modulation envelope’s side 
lobes to be identified

— FM algorithm identifies the side lobes

— The algorithm matches the modulation envelope to the mathematically 
calculated FM modulation or distortion patterns

Figure 26-8 Test Tone Not Found - Corrected Example
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27 Channel Scanner (Option 312)

In this Chapter:

See Also

“Using Channel Scanner” on page 622

“How to Set Up Channel Scanner” on page 623

— “Field Strength Measurements” on page 640

— “Using the Antenna/Cable Editor” on page 646

— “Using Mapping” on page 648

“Why and When to Calibrate” on page 126

Chapter 16, “Indoor and Outdoor Mapping – Option 
352 (Requires Spectrum Analyzer Mode (Option 233), 
and GPS Receiver (Option 307)).”

Chapter 30, “System Settings.” (Changing display colors)

Chapter 32, “File Management.” 
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Using Channel Scanner
Channel Scanner enables you to do the following: 

Figure 27-1 Display Example: Measure 5 Channels Spaced 2 MHz Apart

Measure and display channel power vs. frequency for up to 20 channels simultaneously.

Six Display Types:

— Bar graph vertical display orientation

— Bar graph horizontal display 
orientation

— Channel Power

— Strip Chart

— Strip Chart and Overlay

— Scan & Listen

Color Coded Display Types:

— Specify high and low power with 
color bars 

Flexible Data Sorting:

— Sort results displayed by power or 
frequency, low to high, or high to low

Data Logging GPS stamped data measurements

— Define measurement interval by time 
or distance

— Show results in spectrogram

— Replay files on Google Maps or 
Google Earth

— Manual directional mapping
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How to Set Up Channel Scanner
This section briefly reviews the steps in setting up a channel scan 
measurement. If you are not familiar with this process or would like more 
information, refer to “How to Define a Channel and Use Channel Scanner”.

1. Define some channels (refer to “How to Define a Channel and Use Channel 
Scanner”).

a. Select a Scan Mode—choose:

— Range Specify total channels, channel spacing or

— Custom List Specify a list of channels from an editor

b. Then modify channels based on the selected scan mode

2. Select Display Type—choose:

— Bar ChartV or

— Bar ChartH or

— Channel Pow or

— Strip Chart or

— Then More and

— Chart Overlay or

— Scan&Listen

3. Modify scale and specify color bar coding—Modify the scale and assign 
colors to low and high power channels (bars):

Press Scale/Amptd

Then one of the following:

— Red Limit to set the power level and color scale for high power 
channels.

— Blue Limit to set the power level and color scale for low power 
channels.

— Others: Scale, Ref Level, RF Atten, etcetera as desired.

4. Enable Data Logging Settings: Press Measure 1 or Trace 6 > Data Logging 
to view the Data Logging softkeys and set the Record Settings, Record 
Save/Recall, and More > Indoor Map Data Logging or Signal Locate. 

— Record (Outdoor Logging) or

— Play (If you have previously stored data recordings.) or

— View

a. To set the Record Settings (Outdoor Mapping only)—choose:
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— Meas Interval

— Interval Type Time or Distance

— Time Interval or

— Distance Interval

— Then Back

b. Then press Record Save/Recall 

— Then File Folder Default System

— Default – Sets the default User Folder path: 

——List files (*.csv and *.kml) are save-recalled 
to: 
"[CurrentDevice]:\RecordPlayback\
CS\"

——Data Log-Play files are save-recalled to: 
"[CurrentDevice]:\RecordPlayback\
CS\" 
 
Or

— System – Sets the User Folder to the user defined 
system folder path/name: 

——List files are save to-from 
"CurrentDevice\<UserSelectedFolde
r>\" 

——Data Log-Play files are save-recalled to: 
"CurrentDevice\<UserSelectedFolde
r>\"

Refer to “File Management” on page 777. 

— Then File Type

— KML (default) or

— CSV

— Then Save Log File.

or

— Then Recall Log File.

— Auto Save (default = OFF) 

— Then Back

c. Optional: Press Indoor Map Data Logging then 
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—  Record Indoor Data or Recall Indoor Log File. Learn more, 
refer to Chapter 16 Mapping and “Option 352 Indoor Maps 
Setup Procedure” on page 474 ans “Setting up Data Logging” 
on page 486.

d. Optional: Press Signal Locate – Opens a softkey menu of directional 
finding (DF) bearing softkeys. Learn more, refer to Chapter 16 
Mapping and “How to Add Directional Finding (DF) Bearing” on 
page 496.

5. Press Back to return to previous menu.

6.  Outdoor Mapping only: If recording, then:

— View Map OFF ON To enable/disable the current map view (default 
= latitude/longitude = 0.00/00. Need GPS to view current location 
(default = OFF).

— Pause Resume Temporarily halts recording until pressed again. The 
incoming trace continues to sweep. Press again to continue 
recording.

— Stop Immediately stops recording and a “Save the Log File” menu 
opens to rename and save your data log file.

— (Press Record to begin a new recording.)

— Then Maps To enable map view and related features (e.g., Data 
Selection, Red/Blue Limits, Labels & Icons, Zoom). 

— Data Selection Opens a softkey menu to set the active 
data channel, sort type, and sort order. 

Learn more, refer to Chapter 16 Mapping and “Setting up 
Data Logging” on page 486. See also, Chapter 32, “File 
Management.”

— Red/Blue Limits Opens a softkey menu to assign power 
values to the red (high power limits) and blue (low power 
limits) heat map display limits (defaults: Red Limit = 
–20 dBm, Blue limit = –90 dBm).

— Labels & Icons Opens a softkey menu to enable/disable 
map data point labels and icon types.

Labels  
OFF ON

Enables/Disables map data point labels. When 
enabled, a label is displayed for every map data point 
(e.g., “Data 1”). When disabled, labels are not 
displayed for the map data points.

Icons  
Flag Point Line

Sets the type of icon that is used to display a map’s 
data points (default = Flag).
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—  Save Image (PNG) Saves the current displayed map to a 
*.png file (default filename is “MapImageFile”).

7. Outdoor Mapping: Export KML file into 3rd party mapping software (i.e., 
Google or Google Earth)

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486. See also, Chapter 32, “File Management.”

How to Define a Channel and Use Channel Scanner

Channel definitions consist of the following:

— Each channel is defined by CF and Integration BW. 

— Frequency span is set automatically to 1.5 x Integration BW

— Power is measured over the Integration BW

Using Channel Scanner, refer to:

— “Step 1A: Scan Mode: Range Channel Defined” on page 627 or 

— “Step 1B: Scan Mode: Custom List Channel Defined” on page 628 

Then:

— “Step 2: Select Display Type” on page 629

— “Step 3. Modify Scale and the Display Color Bar Settings” on page 633

— “Step 4: Enable Data Logging and Play Results” on page 634

— “Step 5: Save the Log Results:” on page 637

— “Step 6: Import and Play back KML Files into 3rd Party Software (Example: 
Google Earth with Animation Tool)” on page 639

Data Log-Play files are saved to:

— If File Folder is set to Default then Data Log-Play files are 
save-recalled to: "[CurrentDevice]\RecordPlayback\CS"

— If File Folders are set to System, then Data Log-Play files are 
save-recalled to: "CurrentDevice\<UserSelectedFolder>\   
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Figure 27-2 Channel Definition

Step 1A: Scan Mode: Range Channel Defined

1. Define some channels: Press Measure > Scan Mode > Range

2. Press Edit Range and modify table items:

— Total Channels

— Search Count

— Start Channel CF

— CF Step Size
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Figure 27-3 Range Table Settings

3. Press Done

Step 1B: Scan Mode: Custom List Channel Defined

1. Define some channels: Press Measure > Scan Mode > Custom List

2. Press Edit Custom List and modify table items:

— Add table rows

— Then for each row:

— Edit Center Frequency (CF)

— Edit Integration BW (IBW)

Integration BW (IBW) is coupled to the Frequency Span setting. Frequency 
Span is 50% wider than the IBW (e.g., if the IBW value is 1 MHz, then the 
Frequency Span value is 1.5 MHz).
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Figure 27-4 Custom List Table Settings

3. Press Done

4. Press Save Recall List > Save List to save a custom list. See also “How to 
use the FieldFox labeler ” on page 780.

Step 2: Select Display Type

Select one of the following display orientations:

— Select Display Type—choose:

— Bar ChartV or

— Bar ChartH or

— Channel Pow or

— Strip Chart or

— Chart Overlay or

— Scan&Listen

Press Recall List to bring back a previously stored custom list
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Figure 27-5 Bar Chart Vertical Display Type

Figure 27-6 Bar Chart Horizontal Display Type



Keysight N9938-90006 User’s Guide                                                                                                                      631

Channel Scanner (Option 312)
How to Set Up Channel Scanner

Figure 27-7 Channel Power Display Type

Figure 27-8 Strip Chart Display Type
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Figure 27-9 Strip Chart Overlay Display Type

Figure 27-10 Scan & Listen Display Type
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Step 3. Modify Scale and the Display Color Bar Settings

To assign colors to low and high power values:

1. Press Scale/Amptd > Red Limit to set high power values and to set the 
color.

2. Press Blue Limit to set low power values and to set the color.

3. And, then press System > Display > Display Colors, to set Indoor, Outdoor, 
or other display colors. See also Chapter 27, “Channel Scanner (Option 
312)”, on page  621.

Figure 27-11 Outdoor Display Colors
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Figure 27-12 Indoor Display Colors

Step 4: Enable Data Logging and Play Results

Data logging records your data with a timestamp and GPS stamp (refer to 
“GPS” on page 746). GPS must be enabled for the log results to include a GPS 
stamp.

Features

— Log files contain measured channel results including timestamps and/or 
distance stamps.

— Timestamps are included in log files with or without GPS.

— GPS must be enabled for log results to include distance stamps.

— Data results can be logged

— Data results can be saved to a *.CSV or *.KML file. Refer to “Step 5: Save 
the Log Results:” on page 637.

— User specifies how often results are stored. 

— Time: Store results every “n” seconds 

— Distance: Store results every “n” meters. GPS must be enabled to 
store results by distance.
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Outdoor Mapping Procedure

For Indoor Mapping and more on Outdoor Mapping, see also Chapter 16 
Mapping and “Option 352 Indoor Maps Setup Procedure” on page 474, 
“Option 352 Outdoor Maps Setup Procedure” on page 478, and “Setting up 
Data Logging” on page 486. See also, Chapter 32, “File Management.”

1. Press Measure 1 or Trace 6 > Data Logging 

2. Outdoor Mapping Only: Press Record Settings then: 

— Meas Interval OFF ON (default = OFF) - set to ON

— Interval Type Time Distance (default = Time) - choose a setting

— Time Interval 1 sec to 3,600 seconds or

— Distance Interval from 1m to 10 km

— When done, press Back 

3. Press Record Save/Recall then:

— Recall Log File 

— File Folder Default System - (default = Default).

— File Type - CSV or KLM

— Auto Save OFF ON - (default = OFF). Press to enable/disable.

— then Back

Learn more, see “How to Set Up Channel Scanner” on page 623, step b. 

4. To begin outdoor logging recording: Press Record 

If Auto Save is On (default = OFF) Measurements are stored automatically 
accorded to the specified time or distance interval values. Refer to step 5.

5. Optional: Auto Save OFF (default)—When Auto Save is on, during 
recording, the FieldFox stores intermediate results in a temporary file. If 
the power fails during recording you can retrieve the results. Select Recall 
Log File. Select the temporary file name.

Press Record Save/Recall > Auto Save On Off

6. When done press Stop or Esc. The files save dialog is displayed. Edit the 
file name where the file results will be stored.

7. Press Done

Learn more, refer to Chapter 16 Mapping and “Option 352 Outdoor Maps 
Setup Procedure” on page 478 and “Setting up Data Logging” on page 486. 
See also, Chapter 32, “File Management.”



 636                                                                                                                     Keysight N9938-90006 User’s Guide

Channel Scanner (Option 312)
How to Set Up Channel Scanner

Playing a Data Log and Viewing the Spectrogram

To play the log results:

Refer to Figure 27-13 on page 637. 

1. Press Data Logging > Play

2. Then choose:

— Optional: Use the RPG (fine adjust) or the arrow keys (coarse adjust) 
to change the color bar.

See also, “How to Set Up Channel Scanner” on page 623.

3. Press Stop or Esc to exit the log recording.

To pause the log play:

1. Optional: Press Pause Resume to pause or resume the log recording.

2. Then choose:

— Optional: Use the RPG (fine adjust) or the arrow keys (coarse adjust) 
to change the color bar.

— Cursor Position to change the position along the time 
record’s results (i.e., Cursor Position is active only when 
playback is paused).

— Maps > Red/Blue Limits then

——Red Limit to change the color bar.

——Blue Limit to change the color bar.

3. Press Stop or Esc to stop the log recording.

To View the spectrogram of recorded results:

1. Press View (Applies to Option 312 Only)

2. Then choose:

— Zoom to zoom in on spectrogram time record results.

— Red Limit to change the color bar.

— Blue Limit to change the color bar.

3. Press Exit or Esc to exit view.



Keysight N9938-90006 User’s Guide                                                                                                                      637

Channel Scanner (Option 312)
How to Set Up Channel Scanner

Figure 27-13 Spectrogram View

Step 5: Save the Log Results:

Two file types are supported for save or recall log results:

— KML file format

— Files include bar color

— Files stored in this format can be imported into 3rd party applications 
like Google Earth or Google Maps.

— CSV file format. Files stored into this format can be imported into 
spreadsheet applications.

1. Press Record Save/Recall > File Type CSV or KLM > Back

2. To begin recording: Press Record 

Measurements are stored automatically according to the specified time or 
distance interval values.

3. When done press Stop. The files save dialog is displayed. Edit the file 
name where the file results will be stored.

4. Press Done
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5. Optional: Auto Save ON (OFF = default)—When Auto Save is on, during 
recording, the FieldFox stores intermediate results in a temporary file. If 
the power fails during recording you can retrieve the results. Select Recall 
Log File. Select the temporary file name.

Press Record Save/Recall > Auto Save On Off >On

Optional Step: Indoor Map Data Logging

Once you have selected a channel to measure, you can record data logging 
using Indoor Mapping. Refer to “Step 1A: Scan Mode: Range Channel 
Defined” on page 627.

Learn more, see “How to Set Up Channel Scanner” on page 623, step 4. 

1. Press Measure 1 > Data Logging > More then

2. Press Indoor Map Data Logging then

— Record Indoor Data (new indoor mapping file (*.png)) or Recall 
Indoor Log File (recall a previously stored *.kdat, to modify). Learn 
more, refer to Chapter 16 Mapping and “Option 352 Indoor Maps 
Setup Procedure” on page 474 and “Setting up Data Logging” on 
page 486.

3. Measurements are displayed on the current indoor map in the specified 
intervals. 

— Use More > Data Selection softkey menu to select the Channel 
displayed, the Sort Power Freq, and the Sort Order Up Down.

Then Back.

— Use the Labels & Icons softkey menu to select Labels OFF ON, Icons 
Flag Point Line, and Pointer OFF ON.

Then Back.

Learn more, refer to Chapter 16 Mapping and to “Enabling and 
Setting Up Indoor Map Logging” on page 489.

Use the Labels & Icons, RPG [Zoom] settings, Save Map, and Save 
Image (PNG).

Learn more, refer to Chapter 16 Mapping and to “Enabling and 
Setting Up Indoor Map Logging” on page 489.

— Use the PAN softkey menu to change locations on the indoor map.

4. To begin recording (add a data point): Press Record Data.

5. Optional: Set Bearing Line, refer to “Enabling and Setting Up Indoor Map 
Logging” on page 489.

6. Repeat steps 4 and 5 as necessary.
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7. When done press Back or Esc. The files save dialog is displayed. Edit the 
file name where the file results will be stored as a *.kdat file.

8. Press Done

Learn more, refer to Chapter 16 Mapping and “Setting up Data Logging” on 
page 486. See also, Chapter 32, “File Management.”

Step 6: Import and Play back KML Files into 3rd Party Software 
(Example: Google Earth with Animation Tool)

Features

Use the Playback Slider to replay measurement results. See also Google Maps 
and or Google Earth’s help.

— Open the FieldFox *.KML file in Google Earth. Time Slider appears in upper 
left of the map.

— Manual Mode – Move the time slider cursor to see color-coded icons 
pop-up according to the timestamp.

— Loop mode has a Fast-Slow Replay Option.

— Click on each color coded balloon to see the table of measurement results 
for that location.

Figure 27-14 Importing a KML File Into Google Earth
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Field Strength Measurements

To measure the strength of any signal transmitted through the air, an antenna 
must be connected to the FieldFox. The Field Strength feature allows you to 
enter the frequency response of the receiving antenna (the Antenna Factor) 
and associated cabling, and then have amplitude corrections automatically 
compensate the displayed trace for that response. 

Figure 27-15 Overview of Field Strength for Channel Scanner (See also, Figure 27-16 on 
page 641.) 

FieldFox Field Strength Channel Scanner

Refer to Figure 27-16 on page 641
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Figure 27-16 Editing Antenna Factor (See also, Figure 27-15 on page 640.)
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Figure 27-17 Yellow Trace with Cable and Antenna Corrections

Field Strength Measurements

Yellow Trace - Corrected trace with antenna factor. This correction, includes 
the sum of the antenna correction and the cable correction (These corrections 
are linearly interpolated). (Antenna = ON, Apply Corr = ON). Refer to Figure 
27-17 on page 642.

For information, refer to “Trace Display States (SA Mode)” on page 198

— Learn how to set Y-Axis Units on “How to Set Y-axis Units” on page 158.

— Use a Band Power marker to measure total power over a range of 
frequencies. Learn how in “Band/Interval Power Marker” on page 211 

How to select and edit corrections for Field Strength measurements

The Antenna and Cable correction data survives a Mode Preset and Preset.

All Correction ON/OFF states survive a Mode Preset, but NOT a Preset.

— Press Scale/Amptd.

— Then More

— Then Corrections

— Then choose from the following:

—Apply Corrections Auto Disabled Use Auto and Disabled correction for 
all settings.

—RcvrSide Antenna Off / On Edit/Recall an Antenna file to be used on 
the receiver side.

—RcvrSide Cable Off / On Edit/Recall a Cable file to be used on the 
Receiver side.

 
 
 
 
 
 
 
Yellow trace: 
Cable correction, 
which is the sum 
of the antenna 
correction and 
the cable 
correction (These 
corrections are 
linearly 
interpolated).
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—  View Corrections > View Corrections ON OFF Turn ON and OFF 
Yellow Trace - Antenna/Cable corrections. This is a composite of all 
cable/antenna corrections that are currently applied. Available as a 
useful visual aid, the zero “dB” level (no net correction) is mapped to 
appear at the -50 dBm on-screen level.

The following menu appears when any of the above Antenna or Cable softkeys 
are pressed:

— Antenna/Cable ON OFF Turn correction ON or OFF for this Antenna/Cable.

— Edit Antenna/Cable Edit an Antenna/Cable Correction table. See Using the 
Antenna/Cable Editor (below) for more information.

— New Create a new Antenna/Cable. See Using the Antenna/Cable Editor 
(below) for more information.

— Save Antenna/Cable Save the modified Antenna/Cable to a file on the 
specified Storage Device.

— Recall Antenna/Cable Read an existing Antenna/Cable file from the 
specified Storage Device.

— Storage Device Choose from: Internal, USB, SD. Learn more about these 
selections in “Set File Type and Select Device” on page 783.

When finished, press Back to return to the previous menu.

Field Strength Correction Examples

Refer to Figure 27-18 on page 644 and Figure 27-19 on page 645.
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Figure 27-18 Apply Corrections Set to Auto
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Figure 27-19 Apply Corrections Set to Disabled
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Using the Antenna/Cable Editor 

The Antenna Editor and the Cable Editor menus are very similar. Both tables 
include header information, and a Frequency/Value table. 

Figure 27-20 FieldFox Antenna Editor

How to use the Antenna/Cable Editor

— Press New then Yes to clear all data from the existing Antenna or Cable 
table and reset header information to default settings.

— Then Edit Antenna or Edit Cable to open the Antenna / Cable Editor.

— Then use the  arrows to select a field.

— To edit header information, press Edit then modify the selected field 
using the FieldFox labeler.

——Description: Enter a description for the antenna or cable 
correction table. This is NOT the filename used to save the file.

——Antenna Factor Unit (Rcvr-side Antennas only): Units in 
which the measurement will be displayed. Select NONE 
(default setting) to select from standard Channel Scanner 
Units on the Scale menu. Learn how in “Scale and Units” on 
page 157. 

——Choose from: dB μV/m - (dB micro Volts per meter), dB μA/m 
- (dB micro Amps per meter), dBG (gauss), dBpT (tesla). 

——Freq Interpolation: Set to LINear and can NOT be edited.

— To edit Frequency/Value pairs, enter numbers using the numeric 
keypad, and a frequency suffix when necessary.



Keysight N9938-90006 User’s Guide                                                                                                                      647

Channel Scanner (Option 312)
How to Set Up Channel Scanner

——For both Cable and Antenna correction, Positive numbers 
indicate loss (we need ADD something positive to compensate 
for it), and Negative is indicative of some existing gain.

——Antenna Factor describes the dB value needed to accurately 
display a far-field signal in terms that are in the units listed 
below. When the antenna has low gain, or low efficiency, the 
dB value to be added is larger. 

—When one Freq/Value pair is entered, that correction value is applied 
to the entire displayed frequency span. 

—When two or more Freq/Value pairs are entered, the data points 
between the lowest and highest frequencies are corrected. Linear 
interpolation is applied between frequencies when necessary.

— Optionally choose from the following:

—Previous / Next Page Quickly scrolls through pages of Freq/Value 
data.

— Add Row Add a blank Freq/Value pair to the table,

—Delete/Clear then:

——Delete Row Remove the selected Freq/Value pair from the 
table. 

——Clear All then Yes Remove all Freq/Value pairs from the table 
and resets header information to default settings.

When the table edits are complete

— Press Done to close the Antenna/Cable Editor.

— Press Save Antenna or Save Cable to save your changes to the specified 
Storage Device. Enter a filename using the FieldFox labeler (learn more in 
“How to use the FieldFox labeler ” on page 780). Learn more about 
Antenna and Cable files below.

— Press Recall Antenna or Recall Cable to load an Antenna or Cable file from 
the specified Storage Device.

— Storage Device Changes the device used to save or recall files. Choose 
from Internal (default setting), USB (must be connected) or SD card. This is 
a different setting from the Save/Recall Storage Device setting.

About Antenna and Cable files

— Cable files are saved and recalled from the Cables folder. 

— Antenna files are saved and recalled from the Antenna folder.

— To DELETE Cable or Antenna files, use the Manage Files feature. Learn more 
in “Manage Files” on page 786.

— If the folder does not already exist on a USB or SD card, it is created 
automatically before storing the file.
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— All Channel Scanner mode Antenna and Cable files are saved and recalled 
as *.csv files, which allows them to also be read by spreadsheet programs. 

— The FieldFox can also read *.ANT (Antenna) files that were created from 
older Keysight Spectrum Analyzers. 

— Channel Scanner Mode cable or antenna (*.csv or *.ANT) files can NOT be 
edited in Data Link software. 

How to create a Cable file from an S21 (NA mode) or an Insertion Loss 
(CAT mode) measurement

1. Measure the S21 or Insertion Loss of a cable. In NA mode, select either 
LogMag, Linear, or VSWR formats. 

2. Use Manage Folders to change the active folder to CABLES. Learn how in 
“Manage Folders” on page 788.

3. While in NA mode, save the measurement as a *.csv file. Learn how in “How 
to Save a File” on page 778. 

4. In Channel Scanner mode, select Corrections, then recall the *.csv file for 
correction.

Using Mapping

Channel Scanner mode has indoor and outdoor mapping capability. Refer to 
Chapter 16, “Indoor and Outdoor Mapping – Option 352 (Requires Spectrum 
Analyzer Mode (Option 233), and GPS Receiver (Option 307)).”

Using Resolution Bandwidth Tradeoff (Res BW Tradeoff )

This feature controls the resolution bandwidth for the current measurement.

To use this feature, press BW 2 > Res BW Tradeoff then choose from the 
following:

— High Sensitivity – Use this setting for greatest accuracy (Res BW = 1500).

— Medium – This is the default setting (Res BW = 450).

— Speed – When you want the fastest possible measurement (Res BW = 150).
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28 Noise Figure Mode (Option 356)

IMPORTANT! Noise Figure mode uses DC variable voltage source (VVS) – 
(Option 309) during the measurements. The voltage might be as high as 
28V during the measurement. During the noise figure measurement, 
always make sure there are no voltage sensitive devices connected to the 
DC SMB output port. When you exit the Noise Figure mode, the VVS 
voltage is reset to 1V to avoid potentially damaging your devices. Refer to 
“Variable Voltage Source (Opt. 309)” on page 762.

When you initially change the FieldFox m ode to Noise Figure, the FieldFox 
displays the following message for ten seconds: 
"Ensure your Noise Source is connected to the VVS DC Output 
It (VVS) will be driven up to +28V during the measurement". 

Noise figure requires these options: 

— Spectrum analyzer mode (Option 233—Combination Analyzers Only)

— Preamplifier (Option 235)

— DC variable voltage source (Option 309)

— Noise source (Refer to 
https://www.keysight.com/us/en/assets/7018-03314/data-sheets/59
90-9783.pdf)

Not required, but recommended for improved accuracy: 

— External preamplifier (U7227A/C/F and U7228A/C/F). Refer to 
www.keysight.com/find/usb-preamp.

Noise figure mode sets the sweep to Continuous OFF to allow time for 
connecting a noise source, before beginning any measurements.
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Figure 28-1 Example of Jitter Uncertainty (21 points)—with Uncertainty Bars. Learn more 
in “How to use Auto-Integration” on page 690.

Figure 28-2 Example of Jitter Uncertainty (21 points)—with Uncertainty Bars Disabled. 
Learn more in “How to use Auto-Integration” on page 690. 
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In this Chapter:

See Also

“Using Noise Figure” on page 652

“How to Define a Noise Figure Measurement” on page 656

— “Example: Typical Noise Figure Measurement Procedure” 
on page 656

— “Overview of Softkey Menus” on page 657

— “How to Use DUT Measurement Setups” on page 664

— “Single / Continuous / Restart” on page 676

— “Points ” on page 676

— “Alignments” on page 677

— “Calculating Noise Figure Measurement Uncertainty” on 
page 678

— “Using ENR Tables” on page 683

— “About ENR (*.enr), Preamplifier (*.amp), and DUT (*.dut) 
Files” on page 684

— “Using Markers (Noise Figure)” on page 686

“Calibration Wizard” on page 687

“How to use Auto-Integration” on page 690

“Other Features Available” on page 696

“Troubleshooting” on page 697

“All about Markers” on page 700

“All about Limit Lines” on page 715

“All about Trace Math” on page 720

“All about Scale Settings” on page 722

Chapter 29, “Data Analysis Features.”

Chapter 32, “File Management.”
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Using Noise Figure
Noise Figure enables you to do the following: 

Select Noise Figure Mode before making any setting in this chapter.

How to select Noise Figure Mode: 

— Press Mode_.

— Then More.

— Then Noise Figure.

The FieldFox uses the Y-Factor technique to accurately verify and characterize the noise figure 
of devices. Option 356 has these features:

Five Measurement Types

— Noise Figure

— Noise Factor

— Gain

— Noise Temperature

— Y-Factor

Four Measurement Setup Types

— Noise Source

— DUT 

— Integration

— Uncertainty

Four Pre-configured DUT Measurement Types

— Amplifier

— Downconverter 

— Upconverter

— Multi-Stage Converter

Uncertainty Contribution Values can be Customized for Your Device

— Jitter uncertainty

— ENR uncertainty

— Uncertainty bars

— Mismatch uncertainty 

— User calibration uncertainty 
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Figure 28-3 Display Annotation—Overview
1. Variable Voltage Source 
(VVS) Status (appears when 
VVS is on. Refer to “Variable 
Voltage Source (Opt. 309)” on 
page 762.

2. Calibration Status

3. Excess Noise Ratio (ENR) 
Status

4. Frequency Context

5. DUT Type 

6. Excess Noise Ratio (ENR) 
Mode

7. Sweep point caret (shows 
last point measured)

1. Variable Voltage Source (VVS) 
Status line (appears when the 
VVS status line is turned on in the 
system menu). Refer to “Variable 
Voltage Source (Opt. 309)” on 
page 762.

 
2. Uncertainty status annotation 
(displayed when the uncertainty 
bars are enabled)  
 
3. Questionable Amplitude 
annotation (displayed when the 
Amplitude Alignment is stale)

4. External Reference annotation 
(displayed when external 
reference is selected)

5. Warning message annotation. 
Used to display the following 
warnings:

    –Invalid frequency settings 
    –VVS trip 
    –ADC Over Range 
    –Ext Ref unlock



 654                                                                                                                     Keysight N9938-90006 User’s Guide

Noise Figure Mode (Option 356)
Using Noise Figure

Figure 28-4 Dual Window Display Annotation

Figure 28-5 Calibration Annotation

1. In the dual-window  
layout, non-trace-specific 
annotations are moved from 
the left of the traces to the 
bottom of the traces

1. No Cal = No calibration 
applied

2. Rcvr Cal = Only receiver 
calibration applied

3. ~User Cal = Receiver Cal + 
User Cal applied, but User 
Cal is interpolated (the 
calibration frequency points 
do not match up with sweep 
frequency points)

4. User Cal = Receiver cal + 
User Cal applied and User 
Cal is not interpolated (the 
calibration frequency points 
match up with sweep 
frequency points)
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Figure 28-6 ENR Status and Mode Annotation

Figure 28-7 Uncertainty Annotation

ENR Status annotation

1. ~ENR = Using ENR table, 
but it’s extrapolated (the 
sweep frequency range goes 
beyond the table frequency 
range)

2. ENR = Using ENR table 
and it’s not extrapolated (the 
sweep frequency range is 
within the table frequency 
range) or using spot ENR

ENR Mode annotation

3. Table (346C) = ENR table 
is selected (the mode 
number is pulled from the 
current ENR table)

4. Spot (15.000 dB) = Spot 
ENR table is selected (the 
value is the current spot 
ENR) 

Uncertainty Status annotation 
(Only displayed when the 
Uncertainty bars have been 
enabled)

1. Uncertainty Bars are disabled.

 
2. Unc? = Uncertainty bars are 
enabled and uncertainty values 
are questionable (not all 
uncertainty contributions are 
turned on or one or more of the 
contributions was calculated to 
be 0.00 based on the ENR, DUT, 
and Preamp uncertainty values). 
If you see that your uncertainty 
values are questionable, make 
sure all contributions are turned 
on (if you’re not using a 
preamplifier and User 
Calibration (User Cal), you do 
not have to turn on the User Cal 
contribution) and you have 
entered uncertainty values for 
your noise source, DUT, and 
preamplifier if applicable.  
 
3. Unc = Uncertainty bars are on 
and uncertainty values are valid. 
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How to Define a Noise Figure Measurement
The Option 356 Noise Figure mode uses the Y-factor method to calculate the 
noise figure. 

This section contains the following:

— “Example: Typical Noise Figure Measurement Procedure” on page 656

— “Overview of Softkey Menus” on page 657

— “How to Use DUT Measurement Setups” on page 664

— “Single / Continuous / Restart” on page 676

— “Points ” on page 676

— “Resolution Bandwidth (Res BW)” on page 677

— “Alignments” on page 677

— “Calculating Noise Figure Measurement Uncertainty” on page 678

— “Using ENR Tables” on page 683

— “Using Markers (Noise Figure)” on page 686

Example: Typical Noise Figure Measurement Procedure

This section briefly reviews the steps in setting up a noise figure measurement. 
If you are not familiar with this process or would like more information, refer to 
“Overview of Softkey Menus” on page 657 and “How to Use DUT 
Measurement Setups” on page 664.

1. Set up a Noise Source ENR Table:  
(Meas Setup > Noise Source > ENR Table Edit/Save/Recall). 

2. Set the resolution bandwidth: BW > Res BW

3. Set the frequency range: Freq/Dist > 

— Start,

— Stop,

— Center, and

— Span

4. Set the number of points: Sweep > Points (minimum = 3 points, maximum 
= 1001 points, default = 21)

5. Use Meas Setup > Integration Setup Integration (See also “How to use 
Auto-Integration” on page 690.)

— Max. Time/Pt. (Available when Mode = Auto) or

— Time/Pt. (available when Mode = Fixed)
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6. Perform a Receiver Calibration: (Cal > Run Receiver Cal and follow 
prompts).

7. Enter DUT setup type: Meas Setup > DUT > Type

— Amplifier (default), 

— Downconverter, 

— Upconverter, or 

— Multi-Stage Converter

8. Run a User Calibration (i.e., If you are using an external preamp).  
(Cal >Run User Cal and follow prompts). 

9. Use Measure to select the type of noise figure measurement:

— Noise Figure, 

— Noise Factor, 

— Gain, 

— Noise Temperature, or

— Y-Factor

10.Use Meas Setup > Uncertainty > Uncert Contributions to Enable/Disable 
Uncertainty Contributions:

— Jitter Uncert OFF ON, 

— ENR Uncert OFF ON,

— Mismatch Uncert OFF ON,

— User Cal Uncert OFF ON (applies the current User Cal uncertainty to 
the current measurement’s uncertainty calculations), and

— Then Back > Uncert Bars to ON.

Overview of Softkey Menus

This sections describes the Noise Figure’s Measure, Measure Setup softkeys, 
and related sub-menu softkeys.

1. Define a measurement type.

a. Select a Measure—choose:

— Noise Figure Specify Noise Figure (default) or

— Noise Factor Specify a Noise Factor or

Noise Figure has asymmetrical uncertainty (i.e., log measurement). Noise 
Factor and Noise Temperature have symmetrical uncertainty (i.e., linear 
measurement). Uncertainty is not displayed for Gain and Y-Factor.
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— Gain Specify Gain or 

— Noise Temperature Specify Noise Temperature or

— YFactor Specify Y-Factor

b. Then modify the settings based on the selected noise figure type

2. Select Measure Setup—choose:

— Noise Source or “DUT or” on page 660, “Integration or” on 
page 661, or “Uncertainty” on page 661.

Opens a menu of softkeys to define the Noise Figure’s ENR Mode 
Spot or Table and uncertainty values.

Then choose:

— ENR Mode Spot Table You can enter ENR data for the 
noise source you are using as a table of values or as a 
single spot value. The values held in the table can be used 
for measurements at a range of frequencies as well as at a 
fixed frequency. 

The single spot value is used either for measurements at a 
single frequency, or for measurements across a range of 
frequencies that is narrow enough such that the ENR value 
does not change significantly across that range. (Default is 
Table).

— ENR Spot Values Opens a menu to enter a spot value 
either for measurements at a single frequency or for 
measurements across a range of frequencies that is narrow 
enough such that the ENR value does not change 
significantly across that range (Inactive with ENR Mode set 
to Table).

Then choose:

——ENR sets the ENR spot value in dB (default is 
15 dB).

——ENR Uncert. sets the ENR spot uncertainty value 
in dB (default is 0.000 dB).

——On | Γ| sets the On value (hot) of the ENR spot 
value’s 50Ω match, Γ (0.000 to 1.000).

——Off | Γ| sets the Off value (cold) of the ENR spot 
value’s 50Ω match, Γ (0.000 to 1.000).

——ENR Uncert. Cov. [2σ] Opens a menu to set the 
value of the ENR uncertainty coverage.

Then choose: 1σ, 2σ (default), or 3σ. 
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——More opens additional ENR Spot Value softkey 
menu choices

——Γ Spec. Style [95th %ile] Opens a menu of 
softkeys to set the Γ specification style.

Then choose Maximum, 95th %ile (default), 80th 
%ile, Median, Mean, or Fixed.

——Γ Distribution [Rayleigh] Opens a menu of 
softkeys to set the type of Γ distribution.

Then select Rayleigh (default), Fixed, or Uniform 
in Circle.

— ENR Table Edit/Save/Recall Opens the ENR table menu to 
edit, save, or recall noise source values (Not active with 
ENR Mode set to Spot).

Then choose:

——Edit ENR Table Opens the currently selected 
table of noise source values (generic default 
noise source values are populated for quick 
check). Enter your noise source’s values for more 
accurate measurements. 

——New ENR Table opens a new ENR table for 
entering and saving additional noise source 
values. 

——Save ENR Table Opens a menu of softkeys to 
enable you to enter a unique noise source 
filename.

——Recall ENR Table Opens a menu of file recall 
softkeys and displays a list of stored noise source 
files.

——Storage Device [Internal] Opens a menu of 
softkeys to set the storage location for your files.

Then choose Internal (default), SD Card, or USB.

——Back to return to previous menu.

IMPORTANT! Save your noise source table with a unique filename to avoid 
loss of table data. All noise figure files are saved with *.enr type suffixes. 

The FieldFox displays Replace existing file?, because the displayed 
default filename is the one last saved. Enter a unique filename to avoid 
loss of table data (i.e., all noise figure files are saved with *.enr type 
suffixes).
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— T Cold Default When making measurements at different 
ambient temperatures, you can set the Tcold value in 
Kelvin (K) manually (User). When set to Default, the Tcold 
value is set to the 296.5 K (Default = Default).

— Back to return to previous menu.

— DUT or

Opens a menu of softkeys to define your DUT Type (Amplifier, 
Downconverter, Upconverter, or Multi-Stage Converter), frequency 
context, and loss compensation. Refer to “How to Use DUT 
Measurement Setups” on page 664.
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— Integration or

Opens a menu of softkeys to define the Integration’s Mode Auto or 
Fixed and Jitter values.

Then choose:

— Mode Auto Fixed Select Auto (default) to let the FieldFox 
select the optimum coupled instrument settings. Changes 
can be made to the Jitter Goal and Max Time/Pt. values. 
When integration Mode is set to Fixed, the Time/Pt. 
softkey is active and can be modified. 

— JItter Goal Sets the maximum peak-to-peak jitter value. 
Values greater than this value triggers the Jitter Warning 
(i.e., if Jitter Warning = ON). (Only active when  
Mode = Auto.) (Default is 0.5 dB.)

— Max Time/Pt. Sets the maximum amount of time the jitter 
is measured at a given point to attempt to reach the Jitter 
Goal value (i.e., the measurement time per point is 
automatically adjusted to the minimum time required, but 
will never exceed the displayed Max Time/Pt.). After this 
time, values in excess of the jitter Goal value trigger the 
Jitter Warning. 

— Jitter Warning Enables/Disables the Jitter Warning. The 
Jitter Warning displays when the Jitter value exceeds the 
Jitter Goal value. (Default = ON.) 

— Time/Pt. Sets the Time/Pt. when Mode is set to Fixed. 
(Only active when Mode = Fixed.)

— Back to return to previous menu.

— Uncertainty 

Opens a menu of uncertainty softkeys for setting the DUT, Preamp, 
and Uncert. Contributions.

Then choose:

— DUT Sets the DUT Mode to either Spot (default) or Table.

Then choose:

——DUT Mode Set to Spot (default) or to Table

For DUT MODE Spot choose:

For optimum speed and performance measurement results, it is 
recommended that auto-integration is used in all noise figure 
measurements.



 662                                                                                                                     Keysight N9938-90006 User’s Guide

Noise Figure Mode (Option 356)
How to Define a Noise Figure Measurement

——DUT Spot Values (Only active when DUT 
Mode = Spot). 

Then choose:

——Input |Γ| Sets the input Γvalue.

——Output |Γ| Sets the output Γvalue.

——Γ Spec. Style [Fixed] Opens a menu of softkeys 
to set the Γ specification style.

Then choose Maximum, 95th %ile, 80th %ile, 
Median, Mean, or Fixed (default).

——Γ Distribution [Fixed] Opens a menu of softkeys 
to set the type of Γ distribution.

Then select Rayleigh, Fixed (default), or Uniform 
in Circle.

——Back to return to previous menu.

——DUT Table Edit/Save/Recall (Only active when 
DUT Mode = Table). 

Then choose:

——Import DUT Data Opens a menu of softkeys 
where you can select a DUT *.csv or *.snp data 
file to import into your table.

Then choose Recall File, Sort by File Name, Sort 
by Date, Next Page, Previous Page, or Cancel.

——Edit DUT Data Opens a menu of softkeys where 
you can edit the current selected DUT table data 
file (e.g., serial number, model number, Γ Spec. 
Style, Γ Distribution, Input |Γ|, Output |Γ|, and 
frequencies).

Then choose Edit, Next Page, Previous Page, 
Add Row (only active for Frequency), 
Delete/Clear (only active for Frequency), or 
Done.

——New DUT Table Opens a menu of softkeys to 
choose a new DUT table.

IMPORTANT! The FieldFox displays Replace existing file?, because 
the displayed default filename is the one last saved. Enter a unique 
filename to avoid loss of table data.
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——Save DUT Table Opens a Create a filename menu 
of softkeys to enter a DUT table filename and 
then to save the file.

——Recall DUT Table Opens a Select a file menu of 
softkeys to enter a DUT table filename to recall.

——Storage Device [Internal] Opens a set of softkeys 
to select where your DUT table is saved.

Then choose Internal, SD Card, or USB.

— Back to return to previous menu.

— Preamp Sets the DUT Mode to either Spot (default) or 
Table.

Then choose:

——Preamp Mode Set to Spot (default) or to Table.

For Preamp MODE Spot choose:

——Preamp Spot Values (Only active when DUT 
Mode = Spot). 

Refer to similar “DUT Spot Values (Only active 
when DUT Mode = Spot).” on page 662.

——Back to return to previous menu.

——Preamp Table Edit/Save/Recall (Only active 
when Preamp Mode = Table). 

Refer to similar “DUT Table Edit/Save/Recall 
(Only active when DUT Mode = Table).” on 
page 662.

——Back to return to previous menu.

— Uncert Contributions Opens a menu of uncertainty 
contribution softkeys.

Then choose:

——Jitter Uncert. Enable/disable the Jitter 
Uncertainty.

——ENR Uncert. Enable/disable the ENR 
Uncertainty. 

——Mismatch Uncert. Enable/disable the Mismatch 
Uncertainty. 
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——User Cal Uncert. Enable/disable the User Cal 
Uncertainty. 

——Back to return to previous menu.

— Uncert Cover Sets the uncertainty coverage value for the 
current settings.

Then choose: 1σ, 2σ (default), or 3σ. 

— Uncert Bars Enables/disables the uncertainty calculator 
uncertainty bars values for the current settings.

— Back to return to previous menu.

How to Use DUT Measurement Setups

Noise figure Option 356 has four predefined measurement setups:

— Amplifier

— Downconverter

— Upconverter

— Multi-Stage Converter

Refer to “Using Measure Setup to Choose DUT Type” on page 664.

Each of the four measurements has frequency context and loss compensation 
softkeys that can used to optimize the DUT’s noise figure measurement. Refer 
to “DUT Type and Frequency Context” on page 669 and to “DUT Type Loss 
Compensation” on page 674.

Using Measure Setup to Choose DUT Type

This section contains the following:

— Setting DUT > Type [Amplifier], see Figure 28-8 on page 665

— Setting DUT > Type [Downconverter], see Figure 28-9 on page 666

— Setting DUT > Type [Upconverter], see Figure 28-10 on page 667

— Setting DUT > Type [Multi-Stage Converter], see Figure 28-11 on 
page 668
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Figure 28-8 DUT – Measurement Setup – Type [Amplifier] Screen

Used for setting up DUT 
parameters without an 
external preamplifier 
(LNA)

– Type [Amplifier]

––DUT displays does not 
display LO if not frequency 
converting

––Displays preamp (LNA), if 
User Cal is available. See 
next image this figure.

Used for setting up DUT 
parameters with an 
external preamplifier 
(LNA)

DUT – Measurement Setup – Type [Amplifier] 

DUT – Measurement Setup – Type [Amplifier] with External Amplifier (LNA) and User 
Calibration 
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Figure 28-9 DUT Measurement Setup – Type [Downconverter] Screen

Used for setting up DUT 
parameters without an 
external preamp

– Type [Downconverter]

––Performs internal 
frequency downconversion 
(converts RF down to IF)

–Sideband: 
––LSB: Lower Sideband 
(available for downconverter 
and upconverter)

––USB: Upper Sideband 
(available for downconverter 
and upconverter)

––DSB: Double Sideband 
(available for 
downconverter; averages 
LSB and USB ENR values)

DUT – Measurement Setup – Type [Downconverter] 

Used for setting up DUT 
parameters with an 
external preamp

DUT – Measurement Setup – Type [Downconverter] with External Amplifier (LNA) and User 
Calibration
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Figure 28-10 DUT Measurement Setup – Type [Upconverter] Screen

Used for setting up DUT 
parameters without an 
external preamp

–Type [Upconverter] 
––Performs internal 
frequency upconversion 
(technically, converts IF up 
to RF, but for this case RF 
always = DUT In and IF 
always = DUT Out and so, 
converts RF up to IF)

–Sideband

––LSB: Lower Sideband 
(available for downconverter 
and upconverter)

––USB: Upper Sideband 
(available for downconverter 
and upconverter)

Used for setting up DUT 
parameters with an 
external preamp

DUT – Measurement Setup – Type [Upconverter] 

DUT – Measurement Setup – Type [Upconverter] with External Amplifier (LNA) and User 
Calibration

Preamp
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Figure 28-11 DUT Measurement Setup – Type [Multi-Stage Converter] Screen

Used for setting up DUT 
parameters

– Type [Multi-Stage 
Converter] 
––Multi-Stage Converter: 
Performs multi-stage 
frequency conversion 
(converts RF down/up to IF)

DUT – Measurement Setup – Type [Multi-Stage Converter] 

Used for setting up DUT 
parameters with preamp 
and User Cal 

DUT – Measurement Setup – Type [Multi-Stage Converter] with External Preamp (LNA) and User 
Calibration
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DUT Type and Frequency Context

Noise figure enables you to define the frequency context for your noise figure 
measurements:

—  RF (DUT In):

— Start

— Stop

— Center

— Span

— Freq Context—(Inactive for Amplifier):

— RF

— IF

— LO—(Inactive for Amplifier)

— IF (DUT Out)—(Inactive for Amplifier)

— Start

— Stop

— Center

— Span

This section contains the following:

— Setting Meas Setup > DUT > Next > RF (OUT in), see Figure 28-12 on 
page 670

— Setting Meas Setup > DUT > Next > IF (DUT Out), see Figure 28-13 on 
page 671

— Setting Meas Setup > DUT > Freq Context [IF], see Figure 28-14 on 
page 672
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Frequency Context – RF (DUT In)

The RF (DUT In) softkey can be used to define the DUT Type’s RF Start, Stop, 
Center, and Span frequencies. Refer to “Frequency Range and Frequency 
Context” on page 673.

Figure 28-12 DUT >Type [Amplifier] and [Multi-Stage Converter] > RF (DUT In)—Frequency 
Context 

Used for setting up Start, 
Stop, Center, and Span 
frequency context for a 
DUT

– Type [Amplifier] and 
[Multi-Stage Converter] 
 
 
 
 
 
 
 
 
 
 
 
 
--Set the frequency context 
based on the DUT Type 
 
 
––Enter the RF (DUT In) 
values for Start, Stop, 
Center, and Span 
frequencies

DUT – Measurement Setup – Type [Amplifier] and [Multi-Stage Converter] 
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Frequency Context – IF (DUT Out) – Inactive for Type [Amplifier]

The IF (DUT Out) softkey can be used to define the DUT Type’s IF Start, Stop, 
Center, and Span frequencies. Refer to “Frequency Range and Frequency 
Context” on page 673.

Figure 28-13 DUT >Type [Downconverter], [Upconverter], and [Multi-Stage Converter] > IF 
(DUT Out)—Frequency Context (Inactive for Type [Amplifier]

Used for setting up Start, 
Stop, Center, and Span 
frequency context for a 
DUT

– Type [Downconverter], 
[Upconverter], and 
[Multi-Stage Converter] 
 
 
 
 
 
 
 
 
 
 
--Set the frequency context 
based on the DUT Type 
 
 
––Enter the RF (DUT In) 
values for Start, Stop, 
Center, and Span 
frequencies

DUT – Measurement Setup – Type [Downconverter], [Upconverter], and [Multi-Stage Converter] 
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DUT Type—Freq Context (IF or RF)—(Inactive for DUT Type [Amplifier])

Frequency context can be used to define the DUT Type’s RF Context IF 
(default) and RF values. Refer to “Frequency Range and Frequency Context” 
on page 673.

Figure 28-14 DUT >Type [Downconverter], [Upconverter], and [Multi-Stage Converter] > 
Freq Context [IF] or [RF]—(Inactive for Type [Amplifier])

Used for setting up 
frequency context for a 
DUT

– Type [Downconverter], 
[Upconverter], and 
[Multi-Stage Converter] 
 
 
 
 
 
 
 
 
 
 
 
 
--Set the frequency context 
based on the DUT Type 
 
 
––Enter the frequency 
context IF (default) or RF

DUT – Measurement Setup – Type [Downconverter], [Upconverter], and [Multi-Stage Converter] 
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Frequency Range and Frequency Context

Set the range of frequencies over which you would like to make DUT type 
measurements and frequency context for noise measurements.

When the frequency range is changed after a calibration is performed, the cal 
becomes interpolated. Learn more in “Interpolation *” on page 142.

How to set Frequency Range and Frequency Context

— Press Freq/Dist (Measurement) or

for Frequency Context:

— Press Meas Setup > DUT) > RF (DUT In) and IF (DUT Out)

— Then Freq/Dist and choose from the following

— Start and Stop frequencies - beginning and end of the sweep.

— Center and Span frequencies – the center frequency and span of 
frequencies (half on either side of center).

— Freq Annotation and one of the following:

— Follow each setting by entering a value using the numeric keypad,  
arrows, or the rotary knob.

— After using the keypad, select a multiplier key. Learn about multiplier 
abbreviations in Chapter 1, “Overview.” 

— After use the  arrows or the rotary knob, press Enter. 

AutoSelect (Default) – The FieldFox selects a frequency annotation 
setting (CenterSpan or StartStop).

CenterSpan -The center frequency and span are displayed.

StartStop - The start and stop frequencies of the frequency span are 
displayed.



 674                                                                                                                     Keysight N9938-90006 User’s Guide

Noise Figure Mode (Option 356)
How to Define a Noise Figure Measurement

Figure 28-15 

DUT Type Loss Compensation

For all of the DUT Types (Amplifier, Downconverter, Upconverter, and 
Multi-Stage Converter) the loss compensation, before the DUT (BeforeDUT) 
and after the DUT (AfterDUT) can be enabled or disabled for loss and for 
temperature.

Loss compensation can be used to compensate for double sidebands (DSB). 
Loss compensation can be used in the case of DSB measurements to 
compensate for the doubling of the measured noise level (i.e., 3.01 dB 
increase). For all sideband cases you can enable or disable Loss (device loss) 
and Temperature (device temperature). Refer to Figure 28-16 on page 675.

This section contains the following:

— Setting Meas Setup > DUT > Loss Compensation > Before DUT and After 
DUT, see Figure 28-16 on page 675.
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Setting DUT Loss Compensation 

Figure 28-16 DUT Loss Compensation

Used for setting up loss 
compensation for a DUT

– Type [Amplifier], 
[Downconverter], 
[Upconverter], and 
[Multi-Stage Converter] 
 
 
 
 
 
 
 
 
 
 
 
 
––Loss compensation can be 
set before and after the DUT 
 
 
 
 
––Enable or disable the Loss 
(device loss) and the 
temperature (device 
temperature) 

DUT – Measurement Setup – Type [Amplifier], [Downconverter], [Upconverter], and [Multi-Stage 
Converter] 
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Single / Continuous / Restart

This setting determines whether the FieldFox measures continuously or only 
once each time the Single or Run / Hold +/- button is pressed. Use Hold / 
Single or to conserve battery power or to allow you to save or analyze a 
specific trace. 

How to set Single or Continuous

— Press Sweep 3.

— Then choose one of the following:

—Continuous 

——ON Causes noise figure (NF) to make continuous sweeps. This 
is the typical setting for making measurements. Each Run / 
Hold +/- press causes NF to toggle between continuous sweep 
and Hold. 

——OFF Causes NF to Hold. Each Run / Hold +/- or Single press 
causes NF to make ONE sweep, then Hold. The Hold 
annotation changes to an arrow --> while the sweep occurs.

—Single Automatically sets Continuous OFF and causes NF to make 
ONE sweep, then Hold.

—Restart Resets the sweep to the current defined start frequency point.

Points 

Points is the number of measurements that are measured and displayed along 
the X-axis. The higher number of data points, the better the ability to resolve 
closely spaced signals and the slower the sweep speed. 

How to set number of points

— Press Sweep 3 

— Then Points [current setting] 

— Then choose from: 03 | 05 | 11 | 21 | 51 | 101 | 201 | 401 | 601 | 801 | 1001
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Resolution Bandwidth (Res BW)

In NF Mode, the Res BW settings increase the measurement speed and quality 
of a measured noise figure. The wider (higher) the Res BW, the faster and 
better the noise figure measurement. However, as the Res BW is narrowed, the 
sweep speed becomes slower and the measurement quality is degraded. 

So: Wider Res BW = better noise measurement and faster measurement time 

How to set Res BW

— Press BW 2.

— Then Res BW. 

— Then choose from the following:

— 300 kHz | 1 MHz | 3 MHz | 5 MHz Press the desired resolution 
bandwidth.

The current Res BW setting is shown at the bottom of the screen. 

This setting could impact the accuracy of the measurement. See Specifications 
in 
https://www.keysight.com/us/en/assets/7018-03314/data-sheets/5990-97
83.pdf. 

Alignments 

The Noise Figure mode requires alignment types: amplitude. Refer to the SA 
chapter’s “Alignments” on page 201 for information on all alignments.

Avoid setting the resolution bandwidth (Res BW) greater than the 
bandwidth of the measured DUT.
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Calculating Noise Figure Measurement Uncertainty

The Noise Figure mode can calculate and display the uncertainty of the noise 
measurement, whether it is a Noise Figure, Noise Factor, or Noise Temperature 
measurement. 

The uncertainty calculation accounts for the following sources of uncertainty, 
both in the measurement and in the user calibration (Run User Cal): 

— Noise power uncertainty caused by finite sample size (Jitter)

— Noise power uncertainty caused by mismatch

— ENR uncertainty of the noise standard

The following are not included because they have been determined to be 
insignificant:

— Linearity (i.e., due to the linear wide dynamic range receiver, the automatic 
gain adjustment, and the small power excursions of the hot/cold 
measurement)

— Residual temperature drift of the FieldFox (i.e., due to the internal reference 
switch)

Other possible causes of uncertainty that are not included in the uncertainty 
analysis are temperature drift of the following:

— DUT, 

— Noise source, or 

— Preamplifier

Refer to ENR “Using ENR Tables” on page 683.

Reverse noise wave generation by the DUT or preamplifier

All amplifiers, including the DUT and preamplifiers used in the noise figure 
measurement, are active devices which may generate noise power from both 
their input and output ports. The Noise Figure mode uncertainty calculation 
does not account for uncertainties caused when the input generated noise 
reflects back into the amplifier and adds to the total measured noise power. 
These types of uncertainties are minimized by using well matched noise 

Generally, the drift immunity of the Y-factor noise figure measurement is 
quite good. Nevertheless, caution is advised when temperature changes 
are significant between the user calibration and measurement.

When any one of the four uncertainty values reads all “0.00” across the 
band, a yellow UNC? annotation is displayed on the left side of the FieldFox 
display. 
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sources in the measurement and in the user calibration. And, in the case of 
very low power output DUTs (<15 dB gain + noise figure), by using an isolator 
on the input of the preamplifier.

Electromagnetic interference

DUTs, preamplifiers, noise sources, and connectors may all potentially be 
affected by radiated signals present in the test environment. Care should be 
taken to establish an appropriate test environment for the noise figure 
measurement.

DUT oscillations, microphonic behavior, etcetera

Any instability in the DUT will cause unaccounted noise measurement 
uncertainties. 

Entering Uncertainty Information

In addition to information gathered during the measurement, the following 
information must be provided by the user in order to determine the noise 
measurement uncertainty:

— DUT Reflection Coefficient

For this section, see also “Overview of Softkey Menus” on page 657 
(Uncertainty > DUT on page 661).

DUT Reflection Coefficients values may be imported to a DUT table from 
*.snp or *.csv Files, entered by editing a DUT table, recalled as a previously 
saved DUT table (in a *.dut file), or set as a spot value to be applied across 
all frequencies.

DUT and preamplifier *.snp files may be generated in the FieldFox VNA 
mode, and then imported into the Noise Figure mode. 
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Specified Style (Spec Style): Following the GUM method for Type B 
evaluation of standard uncertainty described in Reference[1]1, the 
uncertainty calculation takes into account not only the entered value of the 
reflection coefficient, but also the nature of this value. This can either be a 
measured value for the DUT, or some form of specified value. This is 
indicated by the Spec Style setting. Specified Styles may be either a 
percentile value, maximum, fixed, median or mean. This value indicates the 
nature of the entered value relative to the population of values it represents. 
Refer to Table 28-1 on page 680.

Distribution: Distribution settings refer to the population distribution of the  
| Γ| values for the device. Refer to Table 28-2 on page 680.

1. Reference [1]: GUM 1995 with minor corrections Evaluation of measurement data - 
Guide to the expression of uncertainty in measurement JCGM 100:2008 First Edition 
September 2008.

Table 28-1 Specify Style — of the entered value relative to the represented population

Style Description

Maximum Use this if this value represents the largest possible reflection coefficient for the population of 
devices to which the DUT belongs. This is true for “does not exceed” specifications.

Fixed Use this if the value is a measured value for the DUT.

Median / Mean Use this if this value represents the median / mean reflection coefficient for the population of 
devices to which the DUT belongs.

95th %ile Use this if 95% of the population has a lower reflection coefficient than the value entered. This is 
the case for “2 standard deviation” (2σ) type specifications.

80th %ile Use this if 80% of the population has a lower reflection coefficient than the value entered.

Table 28-2 Distribution — of the population of the reflection coefficients

Distribution Description

Fixed The reflection coefficient magnitude is always at the given level. This is often the case when 
measured values are used.

Rayleigh The probability density function (pdf) of the magnitude of the reflection coefficient is a Rayleigh 
distribution. This is normally the case for specified values when the overall mismatch is due to 
several interacting impedance transitions within the device.

Uniform (within a 
Circle)

A distribution that was historically used in the industry, before the Rayleigh research, as 
documented in Keysight Application Note 1449-3, but is rarely accurate. Refer to 
https://www.keysight.com/us/en/assets/7018-01152/application-notes/5988-92
15.pdf.



Keysight N9938-90006 User’s Guide                                                                                                                      681

Noise Figure Mode (Option 356)
How to Define a Noise Figure Measurement

— Noise Source Reflection Coefficient, ENR Uncertainties, and ENR values:

For this section, see also “Overview of Softkey Menus” on page 657 (Noise 
Source on page 658) and “Using ENR Tables” on page 683.

Noise source reflection coefficients, ENR Uncertainties, and ENR values 
may be entered by Recalling a previously generated *.enr file, editing an 
ENR table, or set as a spot value to be applied across all frequencies. Note 
that any *.enr file which uses the standard *.enr file format may be recalled 
by the Noise Figure mode.

As in the case of the DUT, in addition to entering the magnitude reflection 
coefficient values, the uncertainty calculation takes into account the 
distribution and specified style for the noise source reflection coefficient 
value. Additionally, the ENR table requires a value for the ENR uncertainty 
coverage (Uncert Coverage), which states how the entered ENR uncertainty 
(ENR Uncert) value is related to the population of possible ENR 
uncertainties. This is typically set to 2σ which means that 95% of the time, 
the actual ENR is within the range of ENR +/- ENR Uncertainty. 

— Preamplifier Reflection Coefficients (User Calibration Only):

For this section, see also “Overview of Softkey Menus” on page 657 
(Uncertainty > Preamp on page 663).

When a user calibration is performed, the Preamplifier Reflection 
Coefficient values may be imported to a Preamp table from *.snp or *.csv 
files, entered by editing a preamplifier table (Preamp Table), recalled as a 
previously saved preamp table (in a *.amp file), or set as a spot value to be 
applied across all frequencies.

Template *.enr files for several common models of noise sources may be 
found in the default ENR table directory of the FieldFox. In these files, the 
reflection coefficients have been set to the values specified for the 
respective model numbers, but the values for the ENR or ENR uncertainty 
will need to be entered at each frequency. Refer to “ENR (*.enr) Files” on 
page 684.

Template preamplifier (*.amp) files for several common models of 
preamplifiers may be found in the default Preamp table directory of the 
FieldFox. In these files, the reflection coefficients have been set to the 
values specified for the respective model numbers. 

DUT and preamplifier *.snp files may be generated in the FieldFox VNA 
mode, and then imported into the Noise Figure mode. 
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As in the case of the DUT, In addition to entering the magnitude reflection 
coefficient values, the uncertainty calculation takes into account the 
distribution (Γ Distribution) and specified style (Spec Style) for the 
preamplifier reflection coefficient value. 

— User Calibration Noise Source Reflection Coefficient, ENR Uncertainties 
and ENR values (User Calibration Only):

These are identical to the noise source values entered for the measurement, 
but are entered prior to performing the user calibration (Run User Cal).

— Controlling the Uncertainty Calculation and Display 

For this section, see also “Overview of Softkey Menus” on page 657 
(Uncertainty > Uncert Contributions on page 663).

When enabled, uncertainty bars are displayed on the data trace, indicating 
the uncertainty range for the current Noise Figure, Noise Factor, or Noise 
Temperature measurement. By default, the displayed uncertainty range is 
the measured data +/- the default coverage factor of two times the 
calculated standard deviation (2σ), which is based on all included 
uncertainties. Optionally, the coverage factor may be changed to 1σ, 2σ or 
3σ. Also, as an aid in determining the cause of measurement uncertainty, 
any of the individual contributors (user calibration (User Cal Uncert), 
mismatch uncertainty (Mismatch Uncert), ENR uncertainty (ENR Uncert), or 
jitter uncertainty (Jitter Uncert) may be excluded from the uncertainty 
analysis.
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Using ENR Tables

ENR tables are used to define the noise source(s) used in DUT measurements, 
receiver, and user calibration(s). Additionally, ENR tables are used along with 
DUT tables, preamplifier tables, and information collected during the 
measurement to compute the measurement uncertainty. Refer to Figure 28-17 
on page 684.

— Both gain and noise figure measurement accuracy will be enhanced by 
using a noise source with as low a reflection coefficient as possible for both 
the noise figure measurement and the user calibration.

— It is not necessary to use the same noise source in the user calibration as 
will be used in the measurement. In some cases, it might be better to use a 
different noise source in the user calibration than will be used in the 
measurement. If this is done, it is important to select the ENR table for the 
calibration noise source prior to the calibration. And, then to select the ENR 
table for the measurement noise source prior to measuring the DUT.

See also, “Calibration Wizard” on page 687.

How to Create an ENR Table

To create an ENR table:

This procedure assumes you have previously set your frequency, resolution 
bandwidth, and number of points. Refer to “Example: Typical Noise Figure 
Measurement Procedure” on page 656. 

For this procedure, refer to Figure 28-17 on page 684.

1. Press Measure > Noise Source > ENR Mode Table (default)

2. Then ENR Table Edit/Save/Recall 

3. Then choose:

Edit ENR Table (to modify the currently loaded ENR table)

New ENR Table (to create a new table)

Save ENR Table (to save any changes to the currently loaded ENR table)

Recall ENR Table (to recall a previously saved table)

Back (to return to previous softkey menu)

4. Then edit the table as necessary for your devices and measurements by 
entering in Header, Auto-populate, ENR, ENR uncertainty, On |Γ|, and Off 
|Γ|. Refer to Figure 28-17 on page 684.  
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Figure 28-17 Editing ENR Tables

About ENR (*.enr), Preamplifier (*.amp), and DUT (*.dut) Files

This section contains the following:

— “ENR (*.enr) Files” on page 684

— “Preamplifier (*.amp) Files” on page 685

— “DUT (*.dut) Files” on page 685

ENR (*.enr) Files

— ENR files are saved to, and recalled from, the NoiseFigure\ENR folder. If the 
folder does not already exist on a USB or SD card, it is created 
automatically before storing the file.

— ENR files are stored as *.enr files. Existing ENR files that are loaded into the 
FieldFox can be overwritten. Your edited file will NOT be overwritten when 
firmware is updated.

— To DELETE a *.enr file, use the Manage Files feature. Learn more in 
“Manage Files” on page 786.

Uses existing ENR file format Refer 
to 
https://www.keysight.com/us/en/a
ssets/9018-01420/user-manuals/9
018-01420.pdf.

1. Three additional header fields 
(used for uncertainty calculations)

   —ENR Uncert Cov

    –Γ Spec Style

    –Γ Distribution

2. Auto Populate fields are not part 
of the file. These fields are only 
used to assist in filling the table 
values.
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Preamplifier (*.amp) Files

— Preamplifier (*.amp) files are saved to, and recalled from, the 
NoiseFigure\Preamp folder. If the folder does not already exist on a USB or 
SD card, it is created automatically before storing the file.

— Preamplifier files are stored as *.amp files. Existing *.amp files that are 
loaded into the FieldFox can be overwritten. Your edited file will NOT be 
overwritten when firmware is updated.

— To DELETE a *.amp file, use the Manage Files feature. Learn more in 
“Manage Files” on page 786.

DUT (*.dut) Files

— DUT (*.dut) files are saved to, and recalled from, the NoiseFigure\DUT 
folder. If the folder does not already exist on a USB or SD card, it is created 
automatically before storing the file.

— DUT files are stored as *.dut files. Existing *.dut files that are loaded into the 
FieldFox can be overwritten. Your edited file will NOT be overwritten when 
firmware is updated.

— To DELETE a *.dut file, use the Manage Files feature. Learn more in 
“Manage Files” on page 786.
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Using Markers (Noise Figure)

In addition to the features shown here, noise figure has many of the same 
marker features as other FieldFox modes. See also “All about Markers” on 
page 700.

Figure 28-18 Marker Annotation 

Figure 28-19 Marker Table Annotation 

Marker annotation

– Marker readout in top right 
corner of graticule.

– Displays uncertainty values 
for select measurements.

  
IMPORTANT! Noise Figure 
has asymmetric uncertainty 
(see red box in figure). Noise 
Factor and  
Noise Temperature have 
symmetric uncertainty.

Marker table annotation 
under the graticule.

– Marker table data under 
the graticule.

– Displays uncertainty values 
for select measurements.

  
IMPORTANT! Noise Figure 
has asymmetric uncertainty 
(see red box in figure). Noise 
Factor and  
Noise Temperature have 
symmetric uncertainty.
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Calibration Wizard 
The Noise Figure mode has two types of calibration wizard softkeys: Receiver 
Cal and User Cal.

To access the calibration wizards:

— Press Cal then

— Run Receiver Cal or

— Run User Cal and then

— follow the prompts

When to Calibrate

Noise Figure has two different calibrations that are important to run, 
depending on the type of measurement you are using:

— Receiver calibrations (required for all measurements). 

— User calibrations (required, if the setup uses an external preamplifier).

Understanding Receiver and User Calibrations 

This section contains the following:

— “Receiver Calibration (Receiver Cal):”

— “User Calibration (User Cal):”

— “User Calibration (User Cal):”

— “Optimizing Measurement Accuracy:”

 

Receiver Calibration (Receiver Cal):

The receiver calibration's purpose is to establish the true measurement 
bandwidth of the receiver when making noise measurements. This bandwidth 
information is used to calculate the gain of the DUT when there is no user 
calibration. But, if there is a user calibration, the gain calculation is 
independent of the receiver bandwidth from the receiver calibration. The 

A receiver calibration is required for a user calibration. On the Fieldfox, 
after you have completed a user calibration, the User Cal (User Cal) 
annotation overwrites the displayed Receiver Cal (Rcvr Cal) annotation.

When there is no preamplifier in the measurement, only a receiver 
calibration is required. 
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receiver calibration has virtually no influence on the noise figure measurement, 
either with or without a user calibration. The receiver calibration only effects 
the gain measurement, and only when there is no user calibration.

As already stated, the receiver calibration measures the measurement 
bandwidth of the receiver. In most cases, this is set primarily by the digital 
processing of the receiver. The receiver calibration is needed, because it is 
influenced by the IF analog circuitry of the FieldFox. Additionally, the 
bandwidth is extremely stable, and does not vary significantly with time or 
temperature. So, once the receiver calibration has been successfully performed 
there is no need to repeat the receiver calibration. 

Exceptions: Re-do the receiver calibration when the FieldFox receiver 
hardware is changed (factory repair) or in the rare case where a filter is added 
to the measurement system which has a narrower bandwidth than the receiver 
(i.e., the external bandwidth is less than the lowest resolution bandwidth (Res 
BW) setting of 300 kHz). 

User Calibration (User Cal): 

In general, a user calibration should be performed whenever a preamplifier is 
used in the noise figure measurement. If there is no preamplifier, the user 
calibration is not necessary. 

Although it will be interpolated if other frequencies are used, when a user 
calibration is performed, it should be made at the same frequencies as the 
measurement. The user calibration also needs to be performed with the same 
resolution bandwidth as is used in the measurement. The user calibration 
determines the noise contribution of the preamplifier, so that it can be removed 
from the measurement when computing the noise figure of the DUT. Also, the 
user calibration establishes the power gain of the receiver—preamplifier system 
so that the reported gain of the DUT will be the gain between input of the DUT 
(where the noise source is connected during the measurement) and the 
calibration plane (which is the point where the noise source is connected 
during the user calibration). Therefore, for the best gain accuracy, the noise 
source used in the calibration, should be connected at the same point as the 
DUT will be during the measurement. 

Optimizing Measurement Accuracy:

— Both gain and noise figure measurement accuracy will be enhanced by 
using a noise source with as low a reflection coefficient as possible for the 
user calibration.

Performing a user calibration is recommended only when the 
measurement setup includes a preamplifier. The user calibration is 
unnecessary for accurate measurements when no preamplifier is used.
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— When the DUT output noise power is relatively low (i.e., the gain plus noise 
figure of the DUT is less than 15 dB), measurement accuracy may also be 
improved by using a low loss isolator on the preamplifier input. Due to the 
output reflection coefficient of the DUT, reverse noise waves from the 
preamplifier, when present, will contribute a different amount of noise 
power during the measurement of the DUT than during the user calibration. 
And, this change in receiver noise power can impact the measurement 
accuracy.

— It is not necessary to use the same noise source in the user calibration as 
will be used in the measurement. In some cases, it might be better to use a 
different noise source in the user calibration than will be used in the 
measurement. If this is done, it is important to set the ENR table for the 
calibration noise source prior to the calibration, and to set the measurement 
noise source prior to measuring the DUT.

— Prior to starting a user calibration, it is a good practice to connect the 
preamplifier and noise source that will be used during the user calibration 
and perform a noise figure measurement of the preamplifier itself (without a 
user calibration). Use the same bandwidth and frequency settings that will 
be used in the user calibration. A successful noise figure measurement 
ensures that all of the connections (bias, control, and RF) have been made 
properly. The user calibration can be started immediately following the 
successful noise figure measurement of the preamplifier, with no change to 
the setup.
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How to use Auto-Integration

This section provides an example procedure for measuring a device using noise 
figures’ auto integration feature. This example does not use an external preamp 
and was performed over a long time duration. Auto-integration is 
recommended to achieve greater accuracy and speed for all of your device 
measurements. Refer to Figure 28-21 on page 694 and Figure 28-21 on 
page 694.

For the following example, these settings were used on the FieldFox with a 
Keysight 346C K01 noise source that had the following characteristics:

About Auto-Integration

With auto integration, the FieldFox Noise Figure application chooses the 
optimum integration time for each of the noise power measurements needed 
(i.e., noise source on, noise source off, and receiver reference) to compute the 
device's noise figure with the selected amount of measurement jitter in the 
shortest possible time. The auto integration feature calculates the time 
required to satisfy the jitter goal from the relative power levels as they are 
measured. One significant advantage of auto integration is that it ensures that 
the best possible instrument speed is used in achieving the necessary jitter 
requirement.

If, on the other hand, it is determined that the time required to meet the jitter 
goal exceeds the maximum allowed time set by the user, auto integration will 
divide the maximum allowed time between the power measurements in order 
to produce the smallest possible jitter in the noise figure measurement. In 

For optimum speed and performance measurement results, it is 
recommended that auto-integration is used in all noise figure 
measurements.

Keysight 346C K01 characteristics at 50 GHz

ENR of 11. 8 dB 

Noise figure 8.7 dB

Gain 9.5 dB

Total Noise = 18.2 dB above kTB.

FieldFox N9952B noise figure (as tested): 39.3 dB

For this example, the cold noise generation of the 346C 
K01 is 21.1 dB below the FieldFox’s noise power (i.e., 
39.3 dB – 18.2 dB = 21.1 dB).
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these cases, since the jitter goal has not been reached, a jitter warning marker 
will appear on the data trace (unless disabled by the user), indicating that the 
jitter goal could not be achieved within the selected time constraint. 

Due to the stability of the FieldFox receiver with its internal reference switch 
and the design of the auto integration feature, it is possible to achieve a stable, 
accurate, low jitter measurement results even under challenging measurement 
conditions, such as when measuring low noise power output devices at high 
frequencies with no pre-amplifier, by setting very long maximum integration 
times. For example, stable measurements with 0.1 dB jitter and no discernible 
drift have been demonstrated measuring a low gain, low noise amplifier at 
50 GHz using maximum integration times of 5000 seconds per point, in spite of 
ambient temperature drift of several degrees Centigrade over the course of the 
measurement.

While auto integration can achieve very low jitter measurements, it is a good 
practice to consider the contribution of the jitter uncertainty to the total 
measurement uncertainty when selecting a jitter goal. If the measurement 
uncertainty from other contributors is known to be 0.5 dB, for example, it 
would make little sense to set a jitter goal of 0.1 dB. Setting a jitter goal of 
0.3 dB in this case would only increase the RSS uncertainty to 0.58 dB, and 
would potentially speed up the measurement by a factor of 9 relative to a jitter 
goal of 0.1 dB. Auto integration makes it possible to select the jitter level with 
confidence, and is therefore a valuable tool in obtaining the required level of 
accuracy with the fastest possible measurement time.

Auto-Integration Procedure

No user cal was performed for this measurement, because no external preamp 
was used.

Set the equipment up in an area where it will remain undisturbed for the 
determined amount of measurement time. Refer to Figure 28-20 on page 693 
and Figure 28-21 on page 694. See also, Figure 28-1 on page 650 and Figure 
28-1 on page 650.

1. Enter the Measurement type:

Select Measure > Noise Figure (default)

2. Enter the Noise Source ENR information into a table:

Select Measure Setup

Then choose:

— Noise Source then 

— ENR Mode Table (default) 

If you have previously saved your noise source’s ENR information into a 
table, skip this step and proceed to step 4.
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— ENR Table Edit/Save/Recall 

— Edit ENR Table 

— Enter the serial number and model number of your noise source. If 
desired, enter other information (e.g., Options, Cal Date, etcetera).

Enter a value using the numeric keypad, the  arrows, or the 
rotary knob.

— Done to finish table and return to previous menu.

3. Save the ENR table: 

If you are not familiar with saving and recalling files, refer to Chapter 32, 
“File Management.” and then to “Saving and Recalling Files” on page 778.

Choose:

— Save ENR Table 

Enter the filename of your noise source.

Enter a value using the numeric keypad, the  arrows, or the 
rotary knob.

— Done to finish table and return to previous menu.

4. Enter the noise figure measurement’s frequency, number of points, and 
span settings: 

— Freq/Dist > Center > 50 GHz

— Sweep 3 > More > 401 points 

— BW 2 > Span > 0 Hz 

5. Define the noise figure’s integration settings:

Meas Setup 4 > Integration

Then choose

—  Mode Auto (default)

— Jitter Goal > 0.10 dB 

— Max. Time/Pt > 300s 

— Jitter Warning ON (default) 

— Back to return to previous menu

Press Uncertainty then

— Uncert. Bars ON

6. Leave the setup to run for desired time.
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Figure 28-20 Example of Jitter Uncertainty (401 points)—with Uncertainty Bars
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Figure 28-21 Example of Jitter Uncertainty (401 points)—without the Uncertainty Bars
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Figure 28-22 shows an example of a noise figure visual Jitter Warning 
elements that can be enabled/disabled (i.e, blue circles around points where 
the jitter goal was exceeded). 

— Press to toggle Jitter Warning OFF ON (default = ON)

Figure 28-22 Example of Jitter Uncertainty—with Jitter Uncertainty Trace
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Other Features Available
— Limit Lines - For information on using Limit Lines, refer to “All about Limit 

Lines” on page 715.

— Display Lines - For information on using Limit Lines, refer to the SA 
chapter’s section, “Display Line” on page 210.

— Scale Settings – For information on using Autoscale, Autoscale All, and 
Scale settings, “All about Scale Settings” on page 722.
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Troubleshooting
Some measurements can result in invalid results (NaNs). In these cases the 
FieldFox’s Noise Figure Option 356 displays the following:

— Red X on the NaN point

— Marker readout displays: “–––”

— SCPI will return its NaN representation (i.e., 9.91E+37)

Figure 28-23 Example of an invalid measurement
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29 Data Analysis Features

The following features can be used after a measurement to analyze the results.

In this Chapter

“How to create Markers” on page 700

“How to move a Marker after it is created” on page 700

“About Delta Markers” on page 701

“Marker Table” on page 702

“Coupled Markers (NA Mode)” on page 703

“Marker Trace (CAT, NA, NF Modes)” on page 704

“Marker Trace (IQA and SA Mode)” on page 704

“Marker Format” on page 705

“Searching with Markers” on page 706

“What Is a ‘Peak’” on page 711

“Marker Functions” on page 713

“SA Marker Functions” on page 714

“How to Create Fixed Limit Lines” on page 715

“Relative Limit Lines” on page 716

“Build From Trace” on page 716

“Limit Options” on page 717

“How to Save and Recall Limits” on page 718

“How to display data and memory traces” on page 720

“How to perform Trace Math ” on page 720

“About Math Operations” on page 721

“How to Use Scale Settings” on page 722
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All about Markers
Markers move along the X-axis range of the measurement trace to provide a numerical readout of 
each measured data point. Markers also allow you to search for specific Y-axis values. 

A trace can contain up to six markers. 

The marker readout on the FieldFox screen displays X and Y-axis information for the current active 
marker ONLY.

A Marker Table can be displayed that allows you to simultaneously view X and Y-axis information 
for all markers. 

Markers can be used in CAT, I/Q Analyzer, NA, NF, RTSA, SA, and Pulse Measurements Modes. 

How to create Markers

— Press Marker. 

— Then Markers 1...6 to select a marker to activate.

— Then Normal to activate that marker. A marker is created on the trace in the middle of the 
X-axis. That marker is now active. 

— Then move the marker using the rotary knob, the  arrows, or by entering an X-axis position 
with the number keys. 

— Then press Enter.

How to move a Marker after it is created

— Press Marker.

— Then Markers 1...6 repeatedly until the marker of interest is selected. The OFF, Normal, or Delta 
softkey is black to indicate the current setting of each marker.

— Then move the marker as when it was first created. 

— Markers can also be moved using one of the marker search functions. Refer to “Searching with 
Markers” on page 706.
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Figure 29-1 Marker 2 is Active, marker 1 is NOT active.

About Delta Markers

A Delta marker provides X-and Y-axis readout information that is relative to a ‘reference’ marker. 

A Delta marker is created with a Δ (delta symbol) to distinguish it from the reference marker.

All six markers can be a Delta marker pair. 

Peak search functions can be performed using delta markers. 

Figure 29-2 A Delta marker and its associated reference marker. 

In the graphic above, the marker readout shows the difference between the two markers in 
frequency and amplitude.
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How to Create a Delta Marker

— Create a Normal marker and move it to the reference position. 

— Press Delta. The marker becomes the reference marker and fixed in its X-Axis position. 

— Move the Delta marker using the numeric keypad, the  arrows, or the rotary knob. 

— Press Enter when finished. 

How to move the Reference marker

— Press Normal to turn the Delta marker OFF. 

— Move the marker to the new position.

— Then press Delta again, to turn the Delta marker back ON.

Fix the position of the Reference marker (I/Q Analyzer, RTSA, and SA Modes ONLY)

In SA mode, the reference marker can be fixed at the Y-axis position of the data trace when the 
marker was created, or it can ‘float’ with each sweep at the Y-axis position of the data trace. In CAT 
and NA mode, the reference marker always floats with the data trace.

— Create a Delta marker.

— From the Mkr ->/Tools menu, press More (SA mode only), then Marker Properties, then Delta 
Ref Fixed 

— OFF – The reference marker floats at the data trace Y-axis position.

— ON – The reference marker is fixed at the Y-axis position of the data trace when the 
marker was created (default IQA and SA modes). 

Signal Track Marker (NF and SA Mode ONLY)

In NF and SA mode, the marker can be peaked at the Y-axis position of the data trace and the 
marker is centered on the screen. This setting applies to all NF and SA markers.

— Create a Signal Track marker (peak).

— From the Mkr ->/Tools menu, press More, then Marker Search 

— OFF – The reference marker floats at the data trace Y-axis position.

— ON – The reference marker is peaked at the Y-axis position of the data trace and the 
marker is centered on the screen. 

Marker Table

The Marker Table can be displayed at the bottom of the FieldFox screen. It can display information 
for up to 6 markers in a full-width window, and up to 3 markers for a half-width window (NA mode). 
The marker table “squeezes” the graticule area when activated.
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How to display the Marker table 

— Press Marker.

— Then More

— Then Marker Table On Off.

Coupled Markers (NA Mode)

Coupled Markers, available in NA mode only1 and allows you to simultaneously create and move 
markers that have the same number for all traces. For example, when marker 2 is created on a 
trace, a marker 2 is created for ALL traces. When any marker 2 is moved, they all move together to 
the same X-axis position.

— Coupled markers are allowed only in NA mode and are relevant only in multi-trace 
configurations.

— You can have markers that are coupled and others that are uncoupled.

— Peak functions move the marker to the peak on the active trace, while all other markers move to 
the same X-axis position.

Figure 29-3 Coupled Markers move on ALL traces at the same time (NA shown).

I/Q Analyzer (IQA) mode has coupled markers. but the behavior is different 
than the NA mode Coupled Markers behavior. Refer to “Coupled Markers 
(Waveform Only)” on page 307.

1. IQA mode has coupled markers, but the behavior is different than NA mode’s coupled markers. Refer to 
“Coupled Markers (Waveform Only)” on page 307.
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How to create Uncoupled Markers

To create markers that are NOT coupled (move independently on each trace): 

— Press Marker 

— Then More 

— Then Coupled Markers OFF 

Marker Colors

As shown in the above image, in NA and CAT Modes, markers are the same color as the trace to 
which they are assigned. In SA Mode, the marker color is NOT the same as the trace.

Marker colors can NOT be changed. 

Marker Trace (CAT, NA, NF Modes)

The Marker Trace setting is used to move markers between the data trace and memory trace. 

When Coupled Markers is ON, this setting applies to the active marker for ALL traces that are 
coupled. Otherwise, this setting applies to the active marker on only the active trace.

How to move a CAT, NA, and NF mode marker between traces

— With at least one marker present, press Marker then More.

— Then select the marker to move using Marker 1,2,3,4,5,6.

— Then toggle Marker Trace Auto Data Mem.

— Auto - Marker resides on data trace when it is visible. Marker resides on memory trace 
when only IT is visible (Default setting).

— Data - Marker resides on data trace, even when not visible. 

— Mem - Marker resides on memory trace, even when not visible. 

Marker Trace (IQA and SA Mode)

Marker Trace determines the trace number on which a marker resides. A marker is created on, or 
can later be changed to, the trace number specified by the Marker Trace selection. When changed, 
a marker moves to the same X-axis location on the specified trace. 

Learn more about IQA Traces in “Trace Display States (IQA Mode)” on page 310. 

Learn more about SA Traces in “Trace Display States (SA Mode)” on page 198. 

Markers are coupled by default.
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How to move an IQ and SA mode marker between traces

— With two or more traces present, press Marker and Enter to create a marker. The marker is 
created on the current Marker Trace selection (default setting is 1).

— Then More 

— Then select the marker to move using Marker 1,2,3,4,5,6.

— Then toggle Marker Trace 1,2,3,4

— The selected marker is moved to the specified trace. 

— When a marker is moved to a ‘blank’ trace (not visible) the marker moves to the same 
X-axis position at either the Y-axis position of the last data, or to the ZERO position. 

Marker Format

The Marker Format setting allows you to choose the format of the marker readout that appears in 
the upper-right corner of the screen and in the marker table. The marker format can be 
independent of the trace format, and can be set independently for each trace. All markers on a 
trace have the same marker format.

How to choose marker format

— Press Marker

— Then More

— Then Marker Format 

— For NA Mode measurements, choose from the following:

Selection Example Y-axis value

Default Same as displayed format

R + jX Complex impedance format 
(3rd number is distance for Time Domain)

22.8Ω -j61.4Ω 

          287.9fF     

Z Magnitude Impedance Mag. 66.08Ω

Phase 73.8° 

Real 0.2003

More

Imaginary -0.6727

Mag & Phase 0.705, -73.7°

dB Angle -2.1 dB, -138.2°
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There are more trace formats available than marker formats. To display marker readouts in more 
formats than are shown here, change the trace format, then select Default. Learn how to change 
format in “Format” on page 98.

— For TDR (CAT) Mode, choose from Default and Z Mag.

Searching with Markers

Marker Searches are used to move markers to locations on the trace which exhibits the 
characteristics of the search criteria. Learn ‘What is a Peak” in “What Is a ‘Peak’” on page 711.

How to Search with Markers

The following menu structure applies to NA Mode. Keystrokes will be slightly different for CAT, Pulse 
Measurements, and SA Modes.

— Activate the marker to be used for the search (NOT necessary with Bandwidth search.)

— Then press Mkr ->/Tools.

— Then choose one of the following: 

— Tracking ON OFF (NA Mode ONLY)

——ON causes the active marker to search for the specified criteria with each new 
sweep. Search criteria can include: Target, Bandwidth, Peak, Min. The searches 
begin with the first sweep after Tracking is turned ON, based on the current search 
type. Trk appears next to the marker number.

——OFF causes a new marker search only when the search feature is re-executed.

— Peak Moves the active marker to the HIGHEST amplitude data point of the trace. Peak 
Excursion and Peak Threshold value is ignored. In SA Mode, the LO feed-through signal (0 
Hz) is also ignored.

— Next Peak Moves the active marker to the next highest amplitude data point of the trace. 
Peak Excursion value is ignored.

— Mkr -> Center Moves the current active selected marker to the center frequency for the 
current frequency range displayed.

— Mkr -> RefLev Moves the current active marker to the acquisition.

— Minimum (Not available in DTF, RTSA, SA, or I/Q Analyzer) Moves the active marker to 
the LOWEST amplitude data point of the trace.

— Min Search (I/Q Analyzer, RTSA, and SA modes Only) Moves the active marker to the 
LOWEST amplitude data point of the trace. If a marker is turned off, it is turned on before 
the minimum search is performed.

— Target (NA Mode and Pulse Measurements ONLY) Enter the Target value. The marker 
moves to the first occurrence of the Target value to the right of its current position. The 
FieldFox interpolates between measured data points to find the exact Target value to two 
decimal points. The interpolated X-axis value is displayed in the marker readout or marker 
table. Subsequent presses of the Target softkey cause the marker to move to the right to 
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find the next occurrence of the Target value. When the marker reaches the end of the 
stimulus range, it “wraps around” and continues the search from the beginning of the 
stimulus range. 

— Bandwidth ON OFF (NA Mode ONLY) Use to quickly toggle BW Markers ON and OFF. 
When OFF, the marker table appears showing the X and Y-axis positions of all enabled 
markers.

— Bandwidth (NA Mode ONLY) Specify the level in dB from the peak or valley where 
bandwidth is measured. 

——Negative numbers search for a Peak bandpass, such as a filter S21 response.

——Either of the following TWO methods can be used to search for a Valley or Notch 
filter, such as the S11 response of a bandpass filter. 

——Negative values search down from the TOP (MAX) of the response.

——Positive values search up from the BOTTOM (MIN) of the notch.

——If you first enter Negative, then Positive values, it may be necessary to press 
Marker, then More, then Markers All Off.

Figure 29-4 S21 of a filter with BW Markers and associated readout values. The search 
criteria is -3 dB.
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Figure 29-5 S11 of the same filter with same search criteria: -3 dB.  
The same values would result from a search criteria of approximately +30.4 
dB.

After pressing Bandwidth, four markers are automatically created to find the first negative or 
positive bandpass over the displayed frequency range.

Bandwidth Search can be used ONLY with Log Mag display format.

— The following six values are displayed for Bandwidth Search:

— BW:  Width of the filter. (marker 2 freq) minus (marker 3 freq).

— Center: Marker 4 frequency. Mathematical midpoint between marker 2 and marker 3.

— Q:  Center Frequency / Bandwidth. 

— Loss:  Marker 1 amplitude. 

— Left: Frequency of marker 2 or 3 (to left of marker 1).

— Right: Frequency of marker 2 or 3 (to right of marker 1).

— Press Back to return to the previous menu.

Press Peak Search then choose from the following:

— Peak Moves the active marker to the HIGHEST amplitude data point of the trace. Peak Excursion 
value is ignored. In SA Mode, the LO feed-through signal (0 Hz) is also ignored. 

— Next Peak Moves the active marker to the next highest amplitude peak from where it currently 
resides. 

— Peak Left (Not IQA) Moves the active marker to the next data point to the left that meets the 
‘Peak’ criteria. When no data points to the left meet the ‘Peak’ criteria, the marker does not 
move. 
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— Peak Right (Not IQA) Moves the active marker to the next data point to the right that meets the 
‘Peak’ criteria. When no data points to the right meet the ‘Peak’ criteria, the marker does not 
move. 

The following applies to DTF Measurements ONLY:

— More then: 

— Track Peaks ON OFF When Track Peaks is ON, markers will find the new peak with every 
sweep. While in this Mode, the markers can NOT be turned OFF or moved. 

— Find 3 Peaks Three markers are created and find the highest peaks (faults) on the trace.

The following applies to IQA Measurements ONLY:

— More then: 

— Min Search Moves the active marker to the minimum frequency (IQA displays time) currently 
displayed on the screen.

— Mkr Properties then: 

— Peak Criteria then refer to “How to set Peak Criteria” on page 711: 

— Delta Ref Fixed Enables or disables the delta reference fixed marker. 

— Peak Left (IQA Spectrum Only) Moves the active marker to the next data point to the left that 
meets the ‘Peak’ criteria. When no data points to the left meet the ‘Peak’ criteria, the marker 
does not move. 

— Peak Right (IQA Spectrum Only) Moves the active marker to the next data point to the right that 
meets the ‘Peak’ criteria. When no data points to the right meet the ‘Peak’ criteria, the marker 
does not move. 

Using Mkr5/Mkr6 to find mins/maxs between Mkr1 and Mkr2 / Mkr3 and Mkr4 (CAT and NA 
Mode)

Use this feature to search minimum and maximum values within sub-spans defined by Mkr1 and 
Mkr2, and Mkr3 and Mkr4. This facilitates measuring minimum and maximum values on your uplink 
and downlink channels, or only in the passband of a DUT. Use in conjunction with marker table and 
limit lines to verify your DUT’s signals and to adjust or tune as needed. See also, “All about Limit 
Lines” on page 715.
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When markers are set to Normal, Mkr5 and Mkr6 can be used to find the minimum and or 
maximum values between Mkr1 and Mkr2 (using Mkr5) and Mkr3 and Mkr4 (using Mkr6). Refer to 
Figure 29-6 on page 711.

How to use the Mkr5 and Mkr6 markers to find maximums and minimums between your Normal 
markers (CAT and NA Mode):

This section assumes you understand the previous marker features. And, that you have previously 
positioned your markers (Mkr1 and Mkr2 or and Mkr3 and Mk4) and set the markers up as Normal 
markers using “How to create Markers” on page 700 and other previous marker sections. For 
example, if your markers are set to Delta, change to Normal, and verify the marker positions are 
correct. Refer to Figure 29-6 on page 711.

— Then press Mkr ->/Tools.

— Then More (For DTF, TDR measurements, and NA Mode, skip this step and proceed to the next 
step.)

— Then Mkr5 & Mkr6 Search

— For Mkr1 & Mkr2 maximum or minimum value search:

— Then Mkr5 Peak or

— Mkr5 Min

Or for Mkr3 & Mkr4 maximum or minimum value search:

— Then Mkr6 Peak or

— Mkr6 Min

If your Markers are positioned and in Normal marker mode, no changes are 
made to the Mkr1 through Mkr4 settings.  
 
If your Markers are not previously positioned and in Normal marker mode, 
when you select the Mkr5 and Mkr6 maximum and minimum setting, your 
markers are set as follows:

— Markers are all set to Normal

— Mkr1 and Mkr3 are set to 1/4 full span

— Mkr2 and Mkr4 are set to 3/4 full span
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Figure 29-6 CAT Mode Mkr5 and Mkr6 Search Example

What Is a ‘Peak’

You define what the FieldFox considers a “peak” by setting the Peak Threshold and Peak Excursion 
and for I/Q Analyzer Only Cont Peak Search. 

These two peak criteria settings are set individually for each trace and for each mode (CAT, SA, or 
NA).

These settings do NOT survive a FieldFox or Mode Preset. 

How to set Peak Criteria

— Press Mkr ->/Tools. 

— In CAT and NA modes:

— Then Peak Search.

— Then Peak Criteria

The Peak Threshold and Excursion settings are NOT available in DTF 
measurements. To make these settings, create a non-DTF CAT mode 
measurement, then change the measurement back to DTF.
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— In IQA (Spectrum) and SA mode:

— Then More

——Then Mkr Properties

——Then Peak Criteria

— In IQA (Waveform) mode:

— Then Mkr Properties

——Then Peak Criteria

After selecting Peak Criteria for CAT, IQA, NA, or SA mode:

——Then select the following: 

——Peak Threshold Minimum amplitude (dB). To be considered valid, the peak 
must be above the threshold level. The valley on either side can be below the 
threshold level.  
Default =  –190 for CAT and NA Modes; –90 for SA Mode.

——Peak Excursion The vertical distance (dB) between the peak and the valleys 
on both sides. To be considered a peak, data values must “fall off” from the 
peak on both sides by the excursion value. Default = 0.5 dB for CAT and NA 
Modes; 6 dB for SA Mode.

——Cont Peak Search (I/Q Analyzer Only) Enables or disables the Continuous 
Peak Search marker. When Continuous Peak Search is on, a peak search is 
automatically performed for the selected marker after each sweep. The rules 
for finding the peak are exactly the same as for Peak Search, including the 
use of peak criteria rules. See also, “Using Markers (IQA)” on page 305.

——Delta Ref Fixed Enables or disables the delta reference fixed marker. 

CAT mode Loss measurements are displayed in positive values. In these 
cases, the Peak Threshold setting is inverted. For example, Peak Threshold 
= -20 will consider any peak that has less Loss than 20 dB to be valid.
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Peak Excursion and Peak Threshold example—the settings for the trace in the following 
image are:

——Threshold: –10 dB

——Excursion: 1 dB

——Scale = 1 dB / Division.

Peak A = Valid Peak (Above Threshold and Excursion Settings)

Peak B = Invalid Peak (Below 1 dB Excursion Setting)

Peak C = Invalid Peak (Below –10 dB Threshold Setting)

Marker Functions

Marker functions are used to change FieldFox frequency or distance settings to those of the active 
marker.

How to use Marker Functions

— Activate the marker to move.

— Then press Mkr ->/Tools

— Then Mkr -> (this step not required for all modes)

Then choose one of the following:

— Mkr -> Center (Not available in DTF, I/Q Analyzer (waveform), or SA mode with zero span) The 
center frequency of the measurement becomes the value of the active marker. The frequency 
span is adjusted accordingly.

— Mkr -> Delay (NA mode ONLY.) The group delay value of the active marker becomes the 
electrical delay setting of the trace. Learn how to set group delay format in “Calibration 
Settings” on page 97. Learn more about electrical delay in “Electrical Delay” on page 101. 

— Mkr-> RefLev (IQ Analyzer (NOT waveform) and SA mode ONLY) The acquisition becomes the 
magnitude of the active marker.

— Mkr->TuneFreq (SA mode with Tune & Listen ONLY) The Tune & Listen Frequency becomes the 
frequency of the active marker (When AM Metrics or FM Metrics are selected this softkey is 
inactive).

The following applies to DTF Measurements ONLY:
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— More then: 

— Mkr->Start Distance The Start Distance of the measurement becomes the value of the active 
marker. Markers that would no longer appear on the screen are moved to the new Start 
Distance.

— Mkr->Stop Distance The Stop Distance of the measurement becomes the value of the active 
marker. Markers that would no longer appear on the screen are moved to the new Stop 
Distance. 

I/Q Analyzer (IQA) Marker Functions

The following Marker Functions are available in I/Q Analyzer Mode ONLY (exceptions are noted): 

— Noise Marker (Available in SA mode)

— Band/Interval Power Marker (Available in SA mode)

— Coupled Markers

— Band Span

— Interval Band Span

— Continuous Peak Search

Learn more about Noise and Band/Interval Power marker functions starting in the IQA chapter here: 
“Noise Marker” on page 305.

SA Marker Functions

The following Marker Functions are available in SA Mode ONLY (exceptions are noted): 

— Noise Marker (Available in I/Q Analyzer mode)

— Band/Interval Power Marker (Available in I/Q Analyzer mode)

— Frequency Counter at Marker

— Audio Beep with Marker

— Time Zero Fixed Marker

Learn more about these marker functions starting in the SA chapter here: “Noise Marker” on 
page 211.
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All about Limit Lines
Limit lines are visual representations, drawn on the FieldFox screen, of the specified limits for a 
measurement. With this capability, you can easily compare measured data versus specifications. 
Optionally, you can enable an audible beep and display Pass or Fail information for each 
measurement.

— You can have up to as many limit line segments as there are data points for each measurement 
trace allowing you to test all aspects of your measurements.

— Limit lines are available in CAT Mode, NA Mode, NF Mode, and SA Mode. Power Meter Mode 
uses different limit settings. Learn more in “Limits” on page 553.

— Limit lines and limit testing are NOT allowed in NA Mode with Smith Chart or Polar display 
formats.

— A simple Display Line is also available in I/Q Analyzer, NF, and SA Modes ONLY. Learn more in 
“Display Line (I/Q, NF, and SA Modes Only)” on page 719.

— Limit lines can be saved and recalled with an *.sta file. Learn more in“How to Save and Recall 
Limits” on page 718. They can also be saved and recalled independently from the Limit softkeys. 
Learn more in“How to Save and Recall Limits” on page 718.

How to Create Fixed Limit Lines

There are two ways to build a Fixed limit line:

1. 1. Build (limits) From a Trace. Learn how in “Build From Trace” on page 716.

2. Enter X/Y data points into the on-screen editor. The limit line is formed as the FieldFox 
‘connects the dots’ on the screen. To create frequency gaps that are NOT tested, use separate 
limit lines. The X-axis values for two lines can overlap. 

— Press Limit 8. 

— Then Edit Limits. A limit line table appears.

— Use the Up / Down arrows and rotary knob to navigate the cursor to the following editable cells. 

— Description - Press Edit, then enter a description for the limit line using the FieldFox 
labeler. Learn how in “How to use the FieldFox labeler ” on page 780.

— Fixed/Relative – Press Edit to toggle between the following:

——Fixed - (Default) the limit line does not move. The X/Y coordinates are absolute 
locations on the screen.

——Relative - the limit line moves relative to the center frequency and acquisition. 
Note: It is easiest to first create Fixed Limits, then change this setting to Relative. 
Learn more “Relative Limit Lines” on page 716.

— Upper/Lower – Press Edit to toggle between the following:

IMPORTANT! For CAT and NA modes, limit lines do not apply  
where F1 = F2.
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——Upper - (Default) FAILS any measured data point ABOVE the line. 

——Lower - FAILS any measured data point BELOW the line.

— Off/On – Press Edit to toggle between the following:

——On - Limit line is drawn on the screen and PASS/FAIL testing occurs.

——Off - Limit line is NOT drawn on the screen and testing does NOT occur.

— Frequency – Enter a numeric X-axis value of the data point.

— Amplitude – Enter a numeric Y-axis value of the data point.

— Press Add then choose from the following:

— Add Point - Adds a blank X/Y data point below the cursor.

— Add Limit - Adds a default limit line below the current limit.

— Press Clear then choose from the following:

— Clear Point - Removes the X/Y data point on which the cursor resides.

— Clear Limit - Removes the limit Line on which the cursor resides.

— Clear All - Removes ALL limit lines.

— Press <Back to return to the Limit menu.

Relative Limit Lines

Relative limit lines are X/Y coordinates that are referenced to the center frequency (X-axis) and 
acquisition (Y-axis). 

Use relative limits to test devices or signals that are identical except for the center frequency or 
amplitude. With relative limit lines in place, you change the center frequency of the measurement 
and the limits look as though they are in the same location. 

The same is true for acquisition. When you expect to measure a different power level, instead of 
changing the Y-axis value of all of the fixed limits, simply change to relative limits. The limits will 
then remain a constant Y-axis distance from the acquisition.

Each limit line can be changed at any time from Fixed to Relative, and Relative to Fixed.

How to Create a Relative Limit Line

The easiest way to create a Relative limit line is to create a Fixed Limit at a specific center frequency 
and acquisition. Learn how “Relative Limit Lines” on page 716. Then change the limit line to 
Relative. The X/Y data points will be re-calculated relative to the center frequency and acquisition.

Build From Trace

A limit line can be built from an existing trace. One X/Y point is made from each measured data 
point. Then, using an offset value, you can shift the limit line UP for upper limits or DOWN for lower 
limits.
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Once limit lines have been built from the trace, changes that you make to the trace, such as 
frequency range, do NOT change the limits. However, the limit line properties can be edited just like 
standard limit lines.

Figure 29-7 A lower limit line (red) built from the trace (yellow) shifted down 5 dB.

How to Build Limit Lines from a Trace

— Select the trace from which limits will be built.

— Press Limit 8. 

— Then Edit. 

— Then Build From Trace. A limit line table appears.

— Use the  arrows to select ON.

— Use Offset to shift the limit line UP or DOWN. Learn how below.

Limit Options

How to set Limit Options

— Press Exit if the limit table is visible.

— Then Options.

— Then choose from the following:

— Beep

——On Pass Audible beep sounds when a sweep passes.

Build from Trace is NOT allowed for traces with more than 1001 data 
points.
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——On Fail Audible beep sounds when a sweep fails.

——Off No audible beep sounds.

— Warning On Off Shows Pass or Fail indication on the display with each sweep. Data 
points that fail are highlighted.

— Limit Type Then Fixed or Relative.

— Offset Shifts the limit line up or down. Enter an offset value using the rotary knob, the 

 arrows, or by entering a value with the number keys.

——Enter a positive offset to shift the limit line UP, usually used with UPPER limits.

——Enter a negative offset to shift the limit line DOWN, usually used with LOWER 
limits.

— Margin Shifts the limit line up or down like an offset, but only virtually. The limit line does 

NOT appear to move. Enter a Margin value using the rotary knob, the  arrows, or by 
entering a value with the number keys.

Enter a positive margin to virtually shift the limit line UP.

Enter a negative margin to virtually shift the limit line DOWN.

How to Save and Recall Limits

— Press Save/Recall then Device to set the Device (Internal, SD card, or USB flash drive) to be 
used for the Save or Recall. Learn more in “Set File Type and Select Device” on page 783.

— Then press Limit.

— Then choose from the following:

— Save Limits After limit lines have been defined, this saves the line definition to a file on the 
specified device.

— Recall Limits Recalls a limit Line definition from the specified device.
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Display Line (I/Q, NF, and SA Modes Only)

A display line is a simple, horizontal line that can be placed at any amplitude level on the SA screen 
or set to any level in IQA. Use a display line as mental guide for visual feedback. A display line is 
similar to a Limit Line, except that no PASS/FAIL testing occurs. A display line is easier to create 
than a Limit Line. Learn more in “All about Limit Lines” on page 715.

Figure 29-8 Display Line with Annotations (SA mode shown, but others are similar)

How to create and move a Display Line

— Press Limit __8 

— Then Display Line OFF ON

— Then enter a Y-axis value using the  arrows or the rotary knob, then press Enter. Or enter a 
value using the numeric keypad and press a suffix key or press Enter.



Data Analysis Features
All about Trace Math

 720                                                                                                                     Keysight N9938-90006 User’s Guide

All about Trace Math
Trace Math is available in CAT (excluding DTF measurements), NA Mode, and FOPS (under USB 
Power Meter mode).

A trace is a series of measurement data points that are connected to form a line. This ‘live’ data 
trace is updated as data points are measured. 

A memory trace is a live trace that has been stored in the FieldFox volatile memory. It then becomes 
static, meaning it is not updated with measurements. It can be displayed on the screen by itself, or 
with a data trace for comparison purposes. 

— In NA mode, memory traces are the same color as data). 

— In CAT mode and FOPS, the data trace is displayed in yellow and the memory trace is displayed 
in blue. 

How to display data and memory traces

— Press Trace 6.

— Press Math and Memory then Data->Mem to store the current live trace into memory. A ‘beep’ 
sounds to confirm the data trace has been saved to memory. There is no display annotation that 
indicates that the memory trace has been stored. 

— Press Data to view only the data trace.

— Press Memory to view only the memory trace.

— Press Data & Memory to view both the live trace and the stored memory trace. 

How to perform Trace Math 

Trace math is performed between a live trace and a memory trace. When one of the following math 
operations are selected, the yellow data trace displays the current measurement with the selected 
trace math applied. The math operation symbol indicated below in [brackets] is displayed on the 
lower left corner of the screen.

— Press Trace 6.

— If not already stored, press Data->Mem to store the current live trace into memory.

— Then Data Math. 

— Then choose one of the following:

— Data + Mem [D+M] Current measurement data is added to the data in memory. 

— Data – Mem D-M] Current measurement data is subtracted from the data in memory. 

Noise Figure (NF—Opt. 356) does not have trace math, but does have the 
ability to display data and memory traces. Refer to “How to display data 
and memory traces”.
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— Data / Mem [D/M] Current measurement data is divided by the data in memory.

— Math Off [Data] Displays trace data with NO math applied.

About Math Operations

Data / Memory and Data - Memory math operations are performed on complex linear data before it 
is formatted. Because data is often viewed in log format, it is not always clear which of the two 
math operations should be used. Remember: dividing linear data is the same as subtracting 
logarithmic data. The following illustrates, in general, when to use each operation.

Use Data / Memory for normalization purposes, such as when comparing traces “before” and 
“after” a change is made or when measuring trace noise. In the following table, the Data/Mem 
values intuitively show the differences between traces. It is not obvious what Data-Mem is 
displaying.

Use Data - Memory to show the relative differences between two signals. Use for comparison of 
very small signals, such as the S11 match of two connectors. 

In the following table, Data/Mem shows both pairs of connectors to have the same 2 dB difference. 
However, the second pair of connectors have much better S11 performance (–50 and –52). The 
relative significance is shown in Data-Mem. 

Values to compare Data/Mem Data-Mem

0.5 dB and 0.6 dB 0.1 dB –39 dB

0.5 dB and 0.7 dB 0.2 dB –33 dB

Values to compare Data/Mem Data-Mem

–10 dB and –12 dB 2 dB –24 dB

 –50 dB and –52 dB 2 dB –64 dB
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All about Scale Settings

How to Use Scale Settings

Adjust the Y-axis scale to see the relevant portions of the data trace. The Y-axis is divided into 10 
graticules.

This setting can be changed at any time without affecting calibration accuracy.

How to set Scale

— Press Scale / Amptd.

— Then choose from the following three methods:

1. Autoscale Automatically adjusts the Y-axis to comfortably fit the Minimum and Maximum 
amplitude of the trace on the screen.

2. Set Scale, acquisition, and Reference Position:

— Scale Manually enter a scale per division to view specific areas of the trace

— Ref Level Manually set the value of the reference line. Enter a negative value 
by pressing Run/Hold (+/-) either before or after typing a value

— Ref Pos Manually set the position of the reference line. Values must be 
between 0 (TOP line) and 10 (BOTTOM line)

3. Set Top and Bottom graticule values. The scale per division is calculated.

— Top to set the value of the Top graticule.

— Bottom to set the value of the Bottom graticule.

— Enter a negative value by pressing Run/Hold (+/-) either before or after typing 
a value.

Averaging (CAT, NA, Power Meter, Channel Scanner, and Pulse Measurement 
Modes Only)

Trace Averaging helps to smooth a trace to reduce the effects of random noise on a measurement. 
The FieldFox computes each data point based on the average of the same data point over several 
consecutive sweeps.

Scale annotation on the FieldFox screen

Reference Line = red arrow

Ref Level = -40 dB

Ref Position = 1 

Scale = 2 dB per division
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Average Count determines the number of sweeps to average; the higher the average count, the 
greater the amount of noise reduction. 

An average counter is shown in the left edge of the screen as Avg N. This shows the number of 
previous sweeps that have been averaged together to form the current trace. When the counter 
reaches the specified count, then a ‘running average’ of the last N sweeps is displayed. Average 
Count = 1 means there is NO averaging. 

This setting can be changed at any time without affecting calibration accuracy.

How to Enable/Disable Averaging

— Press BW   2.

— Then Average OFF ON change to ON to enable averaging (Default = OFF).

— Press Enter.

— Refer to “How to set Trace Averaging” on page 723.

How to set Trace Averaging

— Press BW   2.

— Then Average N where N is the current count setting.

— Enter a value using the numeric keypad. Enter 1 for NO averaging.

— Press Enter.

— While Trace Averaging is in process, press Sweep 3 then Restart to restart the averaging at 1.

Averaging is often used to increase the dynamic range of a measurement. 
To achieve the highest dynamic range, select NA mode and reduce the IF 
Bandwidth setting. Learn more about dynamic range in “Increase Dynamic 
Range” on page 112.
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30 System Settings

In this Chapter

“Run/Hold” on page 726

“Preset” on page 727

“User Preset” on page 727

“Audio (Volume) Control” on page 728

“Display (Settings)” on page 729

“Display Brightness” on page 729

“Display Colors” on page 729

“Trace Width” on page 730

“Title” on page 730

“Edit Keywords” on page 731

“Full Screen Mode” on page 731

“Utilities” on page 732

“How to view and change Utilities Settings” on page 732

——“Utilities Softkey Choices” on page 732

——“How to view and change the Frequency Extender (Freq 
Extnd) Settings” on page 733

“Preferences” on page 740

“Quick Settings Table” on page 740

“Save and Reset Preferences” on page 742

“Global Settings (Overview)” on page 742

——“Language” on page 743

——“Battery Saver” on page 743

——“Startup Mode” on page 744

“File folders” on page 748

“Alpha Numeric Editing” on page 749
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“File Saving Naming Options” on page 749

“System Configuration” on page 754

“Options (Licensing)” on page 754

“GNSS (GPS+) and GPS” on page 756

“Frequency Reference Source” on page 760

“Variable Voltage Source (Opt. 309)” on page 762

“Security Level” on page 763

“Date and Time, Format, and Time Zone Settings” on page 764

“LAN Settings” on page 765

“Power ON” on page 767

“FieldFox Package Installer” on page 767

“Date and Time, Format, and Time Zone Settings” on page 764

“Service Diagnostics” on page 769

“Understanding the Fan Controls” on page 772

See Also:

“Install the Lithium-Ion Battery” on page 30

“FieldFox High Temperature Protection” on page 32

Run/Hold
The Run/Hold key determines whether the FieldFox sweeps continuously or 
does NOT sweep, but holds the display results of the last sweep that was 
performed. 

Use Hold to conserve battery power or to allow you to save or analyze the 
results of a specific measurement sweep. 

The current sweep mode is shown on the screen as: 

—  Continuous

— Hold 

—  is displayed while a single sweep occurs.

How to perform a single sweep while in Hold

— Press Sweep 3.

— Then choose one of the following:
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— Single Automatically sets Continuous OFF (Hold) and causes 
FieldFox to make ONE measurement sweep, then hold for the next 
Single key press.

— SA Mode ONLY – With Continuous OFF each successive Run/Hold 
press also causes a single sweep.

— Continuous ON OFF Makes continuous sweeps. This is the typical 
setting when battery power is not critical.

Preset
The Preset key restores the FieldFox measurement settings to a known 
condition. You can preset the entire instrument, or just the current Mode (CAT, 
SA, and so forth).

When Preset, the FieldFox CalReady calibration is recalled for use in CAT and 
NA Modes. Learn more in “CalReady” on page 127.

In addition to all Preference settings, the following settings always survive 
Preset and Mode Preset:

— External Reference state (see “Frequency Reference Source” on page 760)

— SA Scale and Units (see “Scale and Units” on page 157)

— SA Correction states (see “Field Strength Measurements” on page 161)

— VVM Display Resolution (see “Display Resolution” on page 588)

— Marker Peak Excursion and Threshold (see “What Is a ‘Peak’” on page 711)

How to Preset the FieldFox

— Press Preset.

— Then choose one of the following:

— Preset Returns ALL Modes to the factory default settings. 

— Mode Preset Returns only the current Mode to the factory default 
settings. The current settings for all other Modes remain.

User Preset
User Preset allows you to store custom settings for each mode, then recall the 
settings when the Preset key is pressed. Your custom settings are saved to a 
standard State file (UserPreset.sta). However, unlike State files, calibration 
data is NOT saved. Learn more ab0out State files in “Set File Type and Select 
Device” on page 783.
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How to set User Preset 

— Make your custom settings for all modes.

— When finished, press Preset.

— Then Save User Preset, then select Yes to confirm.

— Then User Preset ON

How to recall User Preset 

— Press Preset.

— Then choose from the following:

— Preset (User) The entire UserPreset.sta file is recalled. ALL modes 
assume the settings that were in place when the User Preset was 
saved. The active mode is the mode that was visible when the file was 
saved.

— Mode Preset (User) The settings for only the current mode are 
recalled from UserPreset.sta.

Audio (Volume) Control
System volume control is a FieldFox global setting which sets speaker volume 
for ALL success beeps, key press clicks, and individual features that use the 
FieldFox speaker, such as SA Mode Tune and Listen.

The volume control setting remains through a FieldFox Preset. To cause your 
volume control setting to remain through a FieldFox shut down, save the 
setting as a Preference. Learn how in “Save and Reset Preferences” on 
page 742.

— Only the instrument settings are saved to UserPreset.sta. No trace data 
or calibration data is saved. 

— User Preset ON / OFF is saved as a Preference setting. Like all 
preferences, this setting survives a FieldFox shut down and power ON. 
Therefore, when User Preset is ON during shut down, the FieldFox will 
load UserPreset.sta when it is powered ON. 

— To return to Factory Preset, select User Preset OFF. The contents of 
UserPreset.sta remain stored on the FieldFox. When User Preset is OFF, 
you can also set the Startup Mode preference that determines which 
mode will be visible after powering ON. Learn more in “Startup Mode” 
on page 744.

.
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How to set the FieldFox Volume Control

— Press System 7

— Then Volume

— Then use the  arrows, the rotary knob, or numeric keypad to enter a 
value between 0 (lowest volume) and 100 (highest volume).

— Press Volume again and select Mute to quickly turn OFF the speaker 
volume. 

— Press Volume again to set volume ON to the previous volume control.

Display (Settings)
You can adjust the FieldFox for optimum viewing in a wide range of lighting 
conditions.

Display settings are persistent after a FieldFox shut down. Save the display 
settings as Preferences. Learn how in “Save and Reset Preferences” on 
page 742.

Display Brightness

Change the brightness of the background.

How to set Display Brightness 

— Press System 7

— Then Display

— Then Brightness

— Use the  arrows, the rotary knob, or numeric keypad to enter a 
value between 0 and 100%.

Display Colors

Change Display Colors to alter the viewing scheme.

How to set Display Colors

— Press System 7

— Then Display

Clean the transflective screen with gentle and minimal wiping using 
Isopropyl alcohol applied to a lint-free cloth. 
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— Then Display Colors

— Then choose one of the following:

Trace Width

You can set width of all displayed traces on the FieldFox. This may allow better 
viewing or enhance the look of screen images. This setting can be saved with 
Preferences.

How to set Trace Width

— Press System 7

— Then Display

— Then Display Colors

— Then More

— Then Trace Width

— Then choose one of the following:

— Normal - Standard width.Wide

— Wide - Enhanced width

Title

A custom title can be made to appear in the upper-left corner of the FieldFox 
screen. The title can contain up to approximately 65 alpha-numeric characters. 
To view the Title area, see the Screen Tour in “Screen Tour” on page 44.

Indoor

Outdoor Dusk

Outdoor Clouds

Outdoor Sun

Night Vision
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How to add or edit a Title

— Press System 7

— Then Display

— Then Title

— Then enter or edit a title using the FieldFox labeler. This is the same labeler 
function that is used to name files. Learn how to use the labeler in “How to 
use the FieldFox labeler ” on page 780.

— Then Title ON OFF to make the title appear and disappear from the screen.

Edit Keywords

During a file save operation, keywords can be quickly appended to other text to 
create unique filenames. The Edit Keywords feature allows you to create 
custom keywords. Learn all about Edit Keywords in “Edit Keywords” on 
page 789.

Full Screen Mode

Full Screen Mode maximizes the display of trace. The screen annotations and 
the soft keys are removed. 

— Press System 7

— Then Full Screen

To Exit full screen Mode, press any key.
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Utilities
FieldFox utilities settings will not survive a shut down. When your FieldFox is 
turned OFF, then back ON, these settings default to their factory settings.

How to view and change Utilities Settings

— Press System 7

— Then Utilities Opens the Utilities softkey menu.

Utilities Softkey Choices

Then choose one of the following:

— Mapping – (Requires Option 352) opens a menu of softkeys that enables 
the Indoor / Outdoor on–the–box mapping features. Refer to Chapter 16, 
“Indoor and Outdoor Mapping – Option 352 (Requires Spectrum Analyzer 
Mode (Option 233), and GPS Receiver (Option 307)).”

— Phased Array Antenna (PAA – Requires Option 360) - opens a menu of 
softkeys that enables the PAA measurements. Refer to Chapter 14, “5G 
Rapid Prototype Phased Array Antenna – Option 360.” 

— USB Antennas – opens a menu of softkeys that enables the triaxial antenna 
feature, for use in EMF measurements. Refer to Chapter 15, “USB Antennas 
– (Full Capability Requires EMF Option 358, and either SA mode (Option 
233 Mixed Analyzers) or OTA—5G NR / 5G NR EVM Conducted Option 
378).”

— Freq Extnd – opens a menu of softkeys that enables frequency extender 
feature, for use with OML heads. Refer to “How to view and change the 
Frequency Extender (Freq Extnd) Settings” on page 733.

For information on the Phase Array Antenna and USB antennas softkeys, 
refer to Chapter 14, “5G Rapid Prototype Phased Array Antenna – Option 
360.” and “USB Antennas” an Chapter 15. 

IMPORTANT!

The Frequency Extender (Freq Extnd) is only active (available) when one of 
the following modes are enabled: SA/RTSA/IQA/OTA/PAA/VSA (via the 
Remote Server feature).

When OML millimeterwave extenders are used, Cable and Antenna 
corrections, if On, are included in eCorr, or Extended Corrections.
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How to view and change the Frequency Extender (Freq Extnd) Settings 

The following are the only supported modes for the frequency extender feature: 
SA (Option 233), mixed analyzers, RTSA (Option 350), IQA (Option 351), OTA 
(Option 370/377/378), PAA (Option 360) modes, and VSA (via the Remote 

Server feature). 

For this section, refer to Figure 30-1 on page 737, Figure 30-2 on page 738, 
Figure 30-3 on page 738, Figure 30-4 on page 739, Figure 30-5 on page 739, 
and Figure 30-6 on page 740.

These settings are used to set up a frequency extender head (e.g., OML head). 
The frequency extender feature can be used in OTA FR2 measurements. See 
also, Chapter 13, “Over–the–Air Measurements (OTA) – LTE FDD Option 370, 
LTE TDD Option 371, 5G TF Option 377, 5G NR / 5G NR EVM Conducted 
Option 378.”

IMPORTANT!

When using a frequency extender with the FieldFox you need to manually 
set the LO power:

– When using the mixer, the LO power should be reduced to –12 dBm and

– Reduce frequency span to make measurements until the “unleveled 
power” message goes away (requires ≥A.12.40 firmware) 

 
If you upgrade your FieldFox firmware to ≥A.12.40, but find you are unable 
to adjust the LO power level to –12 dBm, refer to “Erase User Data” on 
page 770. 

IMPORTANT!

Due to limitations in the OML hardware, the heads have a 6 GHz frequency 
span.

Examples

Using a 24 to 40 GHz mixer, you can sweep:

— 24 to 30 GHz and 25 to 31 GHz, but not

— 24 to 31 GHz

Assuming the same 24 to 40 GHz mixer, using OTA mode, you can 

— Set a CCO to 24 GHz and CC1 to 31 GHz, but not

— CC0 to 4 GHz and CC1 to 32 GHz, because you have to remain within 
the mixer’s band

PAA and 89600 VSA (via the Remote Server feature) are compatible with 
the frequency converter heads, but cannot apply or edit the frequency 
head corrections.
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The frequency extender heads are an external down converter that extends the 
FieldFox's range. The frequency extender head makes use of the FieldFox's 
source and uses USB port for power. The FieldFox support for the frequency 
extender head includes:

— The frequency extender heads are compatible with to SA, IQA, OTA, PAA, 
RTSA, and 89600 VSA (via the Remote Server feature—with VSA license).

— The USB ports are used to supply power to the head

— Port 1 is used to supply an LO signal to the head. The LO signal is 
automatically generated, using the internal source. Therefore the 
application disables normal Port 1 access to the internal source. But, 
automatic alignments of the SA Receiver still remain active using an 
internal path for the source.

— Port 2 is where the head delivers the downconverted signal to the SA 
receiver.

— High Sensitivity ON OFF selection: able to choose between showing largest 
span (wide) available (6 GHz) or best noise floor (narrow).

PAA and 89600 VSA (via the Remote Server feature) is compatible with the 
frequency converter heads, but cannot apply or edit the frequency head 
corrections.

The OML frequency extenders have approximately 4 to 10 dB of gain 
depending on the mixer and frequency.
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Frequency Extender Procedure:

General Comment on Frequency Converter Usage:

OML heads are limited to 6 GHz span.

Example:

If you are using a 24–40 GHz OML head you can sweep:

24–30 GHz and 25–31 GHz, but not:

24–31 GHz

But, in OTA mode, because each frequency is set separately, you can set CC0 
to 24 GHz and CC1 to 31 GHz. 

But, you cannot set CC0 to 4 GHz and CC1 to 32 GHz. You have to stay within 
the band of the OML mixer (24-40 in this example), if you are enabling an 
external head.  

1. Press System 7 > Utilities > Freq Extnd > Select Freq Extnd Head then

2. To select the frequency extender head, use the numeric keypad,  
arrows, or rotary knob to change the value.

3. Press Recall File to make the highlighted head the current selection.

4. Press Freq Extnd ON OFF to ON to enable the frequency extender head. 
When a compatible mode is enabled, all supported modes annotate Freq 
Extnd at the bottom of the display. See also, step 8. 

5. Optional: Press High Sensitivity ON OFF OFF is selected for maximum span 
(up to 6 GHz). Narrow is selected for lowest noise floor for a given RF input 
(100 MHz). Default is OFF (maximum span – 6 GHz). 

6. Optional: Press Setup Corr Auto Edit SA when Auto is selected the default 
corrections for a frequency converter head are automatically loaded 
("...Default.csv"). These corrections are defaults for the specific head, 
to improve nominal accuracy of the amplitude readings, but this accuracy 
is not specified. Press Edit SA, when you want to view or edit the 
corrections using the SA mode corrections. This state stops all 
auto-loading of the default corrections. Refer to step 8.

The other non-SA supported modes do not allow viewing or editing of the 
corrections, but they all share the same corrections. 

Therefore, any manual changes to the corrections (using SA via Edit SA) 
are then used by other supported modes (RTSA/IQA/OTA) as well.

7. Optional: Press Apply Corr ON OFF OFF is selected to not apply the default 
nominal file corrections. Press to apply corrections for the Converter, all 
supported modes will apply corrections and annotate "eCorr" in the left 
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panel. The corrections applied (regardless of mode) are either 
default/nominal (if Auto loading was used) or custom/specific (if manual 
editing Edit SA was used). Default is OFF. 

8. Press Mode > and then your preferred mode for testing.

— Optional: If you pressed Edit SA in step 6 above and want to display 
and to edit a "*.csv" corrections file then:

— Press Scale/Amptd > More > Corrections > OML Converter 
then:

a. Converter to enable/disable the frequency 
converter corrections. 

b. Edit Converter to opens a corrections table of the 
currently selected file (*.csv). 

To select a setting/value to edit, use the numeric 

keypad,  arrows, or rotary knob to change 
the value.

Refer to Figure 30-4 on page 739.

c. New to opens a corrections table of the currently 
selected file (*.csv), but enables you to create a 
new converter corrections file. Displays 
"Overwrite existing Converter data?" 
Then choose: 

——Yes to clear all of the frequency 
converter correction table’s values and 
enter your own.

——No to leave the current correction table 
values and edit just some of the entries.

To select a setting/value to edit, use the numeric 

keypad,  arrows, or rotary knob to change 
the value.

Refer to Figure 30-4 on page 739.

IMPORTANT! The softkey menu for editing of the frequency converter 
correction files is only available when the FieldFox is in SA mode. 

It is important to save any changes that are made to the Settings table. If 
the Setup Corr softkey is reset to Auto, it will recall the last 
"...Default.csv" used, and any unsaved changes will be lost.
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d. Save Converter opens a ’labeler’ menu where 
you can name and save your frequency converter 
corrections file (*.csv) to the default 
[INTERNAL]:\Converter folder.

e. Recall Converter opens a menu where you can 
recall a frequency converter corrections file 
(*.csv).

Storage Device opens a menu where you can 
change the storage location of your frequency 
converter correction files (*csv). (Default = 
Internal. Else, SD Card or USB.)

See also, Chapter 13, “Over–the–Air Measurements (OTA) – LTE FDD 
Option 370, LTE TDD Option 371, 5G TF Option 377, 5G NR / 5G NR EVM 
Conducted Option 378.”

Figure 30-1 FieldFox with OML Downconverter
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Figure 30-2 FieldFox Frequency Converter High Sensitivity (ON: Narrow—Lowest Noise 
Floor—Displayed)

Figure 30-3 FieldFox Frequency Extender Select Frequency Extender Head
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Figure 30-4 FieldFox Frequency Converter Corrections Table 

Figure 30-5 FieldFox Frequency Converter (Freq Extend) On And Corrections (eCorr) 
Enabled (SA mode shown; other compatible modes are similar.)
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Figure 30-6 FieldFox Frequency Converter (Freq Extend) On And Corrections (eCorr) 
Enabled (RTSA mode shown; other compatible modes are similar.)

Preferences
FieldFox preferences are settings that survive a shut down. When your FieldFox 
is turned OFF, then back ON, these settings remain. All preference settings can 
be restored to their factory defaults. Learn how in “Save and Reset 
Preferences” on page 742. 

There are two ways to make FieldFox preference settings:

— From softkey selections throughout the FieldFox menu structure. Do this to 
temporarily try a setting, then press Save Current Preferences. Learn how 
in the next section.

— From the Quick Settings table.

— Also, refer to: “Audio (Volume) Control” on page 728 and “Display 
(Settings)” on page 729. 

Quick Settings Table

All preferences can be set from the Quick Settings table. They are immediately 
saved as Preferences when Done is pressed.
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How to view and change Preference Quick Settings

— Press System 7

— Then Preferences 

— Then Preferences

— Press Next Page and Previous Page to view all settings. 

— To change a setting:

— Use the arrows to highlight a setting. 

— Then press Edit. The current setting changes to yellow. 

— Some settings require you to press a softkey to change the value. 

Otherwise, use the numeric keypad,  arrows, or rotary knob 
to change the value.

— When finished changing a value, press Done Edit.

— When finished changing ALL preferences, press Done. All changes are 
immediately saved as Preferences.

— To exit the editing session without saving changes, press Esc at any time.

Learn more about these preference settings:

Settings 

“Global Settings (Overview)” on page 742

— “Language” on page 743

— “Battery Saver” on page 743

— “Startup Mode” on page 744

“Display (Settings)” on page 729

“Audio (Volume) Control” on page 728 and “Audio” on page 745

“Date and Time” on page 746

“GNSS (GPS+) and GPS” on page 756

“Frequency Reference Source” on page 760

“File folders” on page 748

“Alpha Numeric Editing” on page 749 (i.e., ABC/Qwerty keyboard styles)

“File Saving Naming Options” on page 749

“Quick Save Editing” on page 749

“Group Save File Types Editing” on page 750
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Save and Reset Preferences

All preference settings can be made at one time from the Quick Settings table. 

All settings that can be saved as preferences (except Battery Saver and Startup 
Mode) can also be made from individual softkey selections throughout the 
FieldFox menu structure. However, they remain through a FieldFox shut down 
ONLY when the current settings are saved as preferences. 

The table above shows a list of all of these settings and where they are 
discussed in this User’s Guide.

How to save current settings as Preferences

— Using softkeys, configure the settings as you would like them to remain. 

— Press System 7

— Then Preferences

— Then Save Current Settings There is a beep when your settings have been 
saved.

— Press Reset Preferences to restore the factory default settings.

Global Settings (Overview)

Choose the Global Settings values (Language, Batter Saver, and Startup 
Mode). See also “Quick Settings Table” on page 740.

How to select Global Settings:

— Press System 7

— Then Preferences

— Then Preferences 

— Then use arrow softkeys or the knob to select Global Settings

— Then Edit for each of the following: 

— Language (see)

— Batter Save Mode (see)

“CAT (Distance Units)” on page 751

“CAT/NA” on page 752

“SA” on page 753

“Discrete Colors Softkey Menu” on page 754 - Part of Preferences softkey 
menu.

Settings 
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——On

——Off (default)

— Startup Mode (see)

— Then Done Edit (for each change in setting)

Language

Choose the language in which to display FieldFox softkeys and other 
messages. Select Save Current Settings to set this language as a preference.

How to select a Language

— Press System 7

— Then Preferences 

— Then Language

— Then choose from the following:

— English 

— Espanol – Spanish

— Deutsch – German

— Italiano – Italian

— Francais – French

— Russian

— Japanese

— Chinese

— Turkish

Battery Saver

When the battery saver is OFF, the RF source power is left ON at the end of the 
sweep which consumes more battery power. This feature is used in CAT, NA, 
VVM modes, and SA mode when the internal source is turned ON.

Battery Saver is the ONLY FieldFox setting that must be made as a Preference 
from the Quick Settings table. This setting remains until you change it again.

How to set Battery Saver

— Press System 7

The FieldFox internal temps will run 2°C – 5°C cooler with the Battery 
Saver on (the temperature range is dependent on the ambient temp).
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— Then Preferences 

— Then Preferences

— Then scroll to Global Settings > Battery Saver

— ON – To conserve battery power, the RF source power is turned OFF 
at the end of each CAT, NA, and VVM mode sweep.  This behavior 
does not impact FieldFox measurements.

— OFF – Source power is kept ON at all times, including during trigger 
Hold mode and between single sweep acquisitions. The RF source 
stays at the stop frequency until another sweep begins. This provides 
a constant, uninterrupted RF output from the RF OUT port. This 
behavior also provides the highest trace stability sweep-to-sweep 
which may only be evident while using either single sweep or 
Run/Hold.  With Battery Saver OFF, the use of a full battery charge is 
reduced by approximately 45 minutes.

Startup Mode

The Startup Mode setting determines the mode that becomes active (visible) 
when User Preset is set to OFF (Factory Preset) and the FieldFox is powered 
ON. See “User Preset” on page 727.

How to setup Startup Mode

— Press System 7

— Then Preferences 

— Then Preferences

— Then scroll to Global Settings > Startup Mode and press Edit.

— Then repeatedly press the Startup Mode to scroll through the available 
choices.

— <Default> is the factory default mode for your FieldFox model.

— Built-in Power Meter Mode is NOT allowed as a Startup Mode.

Display
Choose the Display values (Display Colors, Trace Width, Brightness, Title 
Enabled, Title). See “Display (Settings)” on page 729.

How to select Display values:

— Press System 7

— Then Preferences

— Then Preferences
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— Then use arrow softkeys or the knob to select Display 

— Then Edit for each of the following:

— Display Colors

— Indoor (default)

— Night Vision

— Outdoor Sun

— Outdoor Dusk

— Outdoor Clouds

— Trace Width

— Normal (default)

— Wide

— Brightness

— 0 to 100% (80% default)

— Title Enabled

— On

— Off (default)

— Title

User Title (default)

— Then Done Edit (for each change in setting)

Audio
Choose the Audio values (Mute, Volume). See also “Audio (Volume) Control” 
on page 728.

How to select Audio values:

— Press System 7

— Then Preferences

— Then Preferences

— Then use arrow softkeys or the knob to select Audio

— Then Edit for each of the following:

Setting trace width to Wide, will result in slower trace refresh rates.



 746                                                                                                                     Keysight N9938-90006 User’s Guide

System Settings
Date and Time

— Mute

——On

——Off (default)

— Volume

— 0 to 100 (default is 50)

— Then Done Edit (for each change in setting)

Date and Time
Choose the Date and Time values (Date and Time, Time Format, Date Format, 
and Time Zone). See also “Date and Time, Format, and Time Zone Settings” on 
page 764.

How to select CAT distance units:

— Press System   7

— Then Preferences

— Then Preferences 

— Then use arrow softkeys or the knob to select Date and Time

— Then Edit for each of the following:

— Date and Time

——Edit as needed (Refer to “Date and Time, Format, and Time 
Zone Settings” on page 764):

——Time Format 

——Date Format 

——Time Zone 

— Then Done Edit (for each change in setting)

GPS
Choose the GPS values (GPS State, Elevation Unit, GPS Sync Clock, Display, Lat/Lon 
Format). See also “GNSS (GPS+) and GPS” on page 756.

How to select CAT distance units:

— Press System   7

— Then Preferences
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— Then Preferences

—  Then use arrow softkeys or the knob to select GPS

— Then Edit for each of the following:

— GPS State

——Off (default)

——Internal

——External

— Elevation Unit 

——Meters (default)

——Feet

——Inches

— GPS Sync Lock 

——Off (default)

——Internal

——External

— Display

——On

——Off

— Lat/Lon Format 

——dddº mm’ ss.sss”

——ddd.dddddddº

——dddº mm.mmmmm’

— Then Done Edit (for each change in setting)
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Frequency Reference
When Internal or External is selected, a search is made for satellites overhead. 
GPS (default) works best when outdoors and in full view of the open sky.  

See also, “GNSS (GPS+) and GPS” on page 756.

How to set the frequency reference settings:

This procedure saves your frequency reference settings using the Quick 
Settings Table in Preferences. Learn more in “Quick Settings Table” on 
page 740.

1. Press System 7 > Preferences > Preferences then

2. Press Next Page until Frequency Reference is displayed.

3. Use arrow keys  or knob to scroll down to until Frequency Ref Source is 
highlighted.

4. Press Edit > Frequency Ref Sou [GPS] then

5. Choose from the following:

— GPS - (default setting).

— External - Enable GPS using an external, 
customer-supplied, USB dongle device. A check is made 
to detect a USB GPS device at the USB connectors.

— Internal - Enable GPS using Option 307 – Built-in GPS. 
Connect a GPS antenna to the top-panel GPS connector. 
Learn more about additional GPS antenna accessories at 
http://www.keysight.com/find/fieldfox. Internal is set 
automatically when Frequency Reference Source is set to 
GPS. Learn more in “Frequency Reference Source” on 
page 760.

File folders
When enabled, FieldFox uses the last selected Device and Folder location as the 
default device location after instrument power cycle. 

How to set File Folders 

— Press System   7

Before setting the preferences for the File Folders, you must select the 
Device and Folder locations. Refer to Chapter 32, “File Management.”
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— Then Preferences

— Then Preferences

— Then scroll to User Folder Persist:

— User Folder Persist (On/Off) – Defaults to the current Device and 
folder location at power up. Toggle User Folder Persist On/Off when a 
new Device location is selected location.

— User Folder – displays the default folder location.

— User Device – displays the default device location.

See also: “Alpha Numeric Editing” and “File Saving Naming Options”.

Alpha Numeric Editing
— Keyboard Style – Toggles through Qwerty/ABC style keyboards that the 

Labeler displays. Refer to “How to use the FieldFox labeler ” on page 780.

File Saving Naming Options
— Prefix – Displays the current choice for Prefix. Choices are User, Last File 

(default), or Off. Refer to Prefixes and Suffixes for Filenames in “Prefixes and 

Suffixes for Filenames” on page 789.

— Auto Append – Displays the current choice for Auto Append to a filename 
(Suffix). Choices are Off (default), Number, Date. Refer to “Prefixes and 
Suffixes for Filenames” on page 789.

Quick Save Editing
Enables/disables the Quick Save feature. Quick Save saves any files you have 
set to On in the Group Save File Types preferences. Refer to “Group Save File 
Types Editing” on page 750.

To save the User Device storage location, refer to Chapter 32, “File 
Management.”

1. Press System 7 > Preferences > Preferences then

IMPORTANT!

To avoid losing data, before using the Quick Save feature, verify that you 
have all of the correct data file types enabled for saving. 
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2. Press Next Page until Quick Save is displayed.

3. Use arrow keys  or knob to scroll down to until your choice is 
highlighted then choose one or more of the following:

— Save/Recall Long Press – Enables/Disables the Quick Save feature. When 
enabled (default = Off), when the Save/Recall 9 hardkey is held down for 
~3 seconds, the specified files are saved to a file with the FFoxData prefix. 

See also, Prefixes and Suffixes in “Prefixes and Suffixes for Filenames” on 

page 789.

— Quick Save Prefix – Chooses the name of the Quick Save data file’s prefix. 
Press the Edit softkey to edit the prefix name in the “Quick Save Prefix” 
menu (default = FFoxData). Refer to “Prefixes and Suffixes for Filenames” 
on page 789.

— Quick Save Suffix – Chooses the name of the Quick Save data file’s suffix. 
Press the Edit softkey to edit the suffix type Number or Data (default = 
Number). Refer to “Prefixes and Suffixes for Filenames” on page 789. 

Group Save File Types Editing
Enables/disables the selected file types to be saved as part of the Group Save 
File Types feature. (Default for all group save file types = Off.) Refer to “Quick 
Save Editing” on page 749.

Group Save File Types Procedure

1. Press System 7 > Preferences > Preferences then

2. Press Next Page until Group Save File Types is displayed.

3. Use arrow keys  or knob to scroll down to until your choice is 
highlighted then:

4. Press Edit then

5. Press ’file type’ Data (.xxx) to enable/disable the data file type (default = 
Off). (e.g., Image (.png) ON OFF, CSV Data (.csv) ON OFF, etcetera).

6. Repeat steps 3 through 5 as required.

7. Press Done Edit to exit the current data type softkey menu.

8. Press Done to exit the Preferences menu and save your Preferences.

Group Save File Types

— State+Trace (.sta) – Enables/Disables .sta as a group. file to be saved when 
the Quick Save (Save/Recall 9) hardkey is pressed for ~3 seconds.
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— State (.sta) – Enables/disables .sta files as a group file to be saved when 
the Quick Save (Save/Recall 9) hardkey is pressed for ~3 seconds.

— Image (.png) – Enables/disables .png files as a group file to be saved when 
the Quick Save (Save/Recall 9) hardkey is pressed for ~3 seconds. 

— CSV Data (.png) – Enables/disables .csv data files as a part of the group 
files to be saved when the Quick Save (Save/Recall 9) hardkey is pressed for 
~3 seconds. 

— S1P Data (.s1p) – Enables/disables ..s1p data files as a part of the group 
files to be saved when the Quick Save (Save/Recall 9) hardkey is pressed for 
~3 seconds. 

— S2P Data (.s2p) – Enables/disables .s2p data files as a part of the group 
files to be saved when the Quick Save (Save/Recall 9) hardkey is pressed for 
~3 seconds. 

— Matalab Data (.mat) – Enables/disables .mat data files as a part of the 
group files to be saved when the Quick Save (Save/Recall 9) hardkey is 
pressed for ~3 seconds. 

— SDF Data (.sdf) – Enables/disables .sdf data files as a part of the group files 
to be saved when the Quick Save (Save/Recall 9) hardkey is pressed for ~3 
seconds. 

CAT (Distance Units)
Choose the CAT distance units (i.e., Meters (default), Feet, Inches). See “DTF 
Units” on page 73.

How to select CAT distance units:

— Press System   7

— Then Preferences

— Then Preferences 

— Then Edit for each of the following:

— Distance Units:

——Meters (default)

——Feet

——Inches

— TDR Sweep:

——Cable (default and the most accurate)

——Auto

— Then Done Edit (after each change in setting)
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CAT/NA
Choose the CAT/NA settings for SnP file save, default factory error corrections, 
extended cal default. See also “> What Data Processing functions are 
included in saved SNP Data:” on page 785.

How to select CAT/NA defaults:

— Press System   7

— Then Preferences

— Then Preferences

— Then use arrow softkeys or the knob to select CAT/NA

— Then Edit for each of the following:

— SnP File Save

——Default

——Advanced

— Default Factory Error Corr. (N995xB/6xB Only)

——Enhanced Response

——Full 2 Port

— Extended Cal Default (N995xB/6xB Only)

——On

——Off (default on models >6 GHz)

— Then Done Edit (after each change in setting)
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SA
Choose the SA setting for Individual measurement Control default. See also 
“Alignments” on page 201.

How to select SA defaults:

— Press System   7

— Then Preferences

— Then Preferences

— Then use arrow softkeys or the knob to select SA

— Then Edit for each of the following:

— Individual measurement Control

——On (Default - recommended) 

——Off

— ADC Over Range Large Warning

——On 

——Off (Default) 

— Then Done Edit (after changing setting)
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Discrete Colors Softkey Menu
The discrete colors softkey menu can be used to increase the choice of colors 
displayed from two to up to six colors, for easier measurement readings. Refer 
to Figure 30-7.

Figure 30-7 Display Example: Color Coded Bar Scale (x6 Colors)

Using the Discrete Colors Softkey Menu

1. Press System 7 > Preferences > Discrete Colors 

2. Choose from the following:

— Discrete Colors ON OFF – to enable/disable the discrete colors 
greater than 2.

— Number of Colors – choose up to 6 discrete colors (Minimum 
(default) = 2, red and blue).

— High Power Red Blue – choose red or blue to choose the color to 
indicate the highest power levels (default = Red).

System Configuration

Options (Licensing)

You can view and install options on your FieldFox. To see a comprehensive list 
of the options that are available, view the FieldFox Configuration Guide at: 
https://www.keysight.com/us/en/assets/7018-06515/configuration-guides/
5992-3701.pdf.

How to view the Installed Options

— Press System 7

— Then System Configuration

— Then Options (Licensing)

— Then Show Options

The currently installed options are listed.s
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How to Install Options (License File)

A license file (*.lic file) must already be on a USB Flash Drive. To learn how to 
obtain a. license file (*lic file), visit: 
https://www.keysight.com/us/en/lib/resources/service-manuals/keysight-fi
eldfox-library-help-and-manuals-2153870.html.

Insert the USB Flash Drive in the FieldFox. 

— Press System 7

— Then System Configuration

— Then Options (Licensing)

— Then Install Options The FieldFox reads, validates, then installs the options. 

— Press and hold the power button to shut down, then restart the FieldFox.

How to Delete ALL Options

Deleting individual options is NOT supported. 

— Press System 7

— Then System Configuration 

— Then Options (Licensing)

— Then Advanced

— Then Delete All Options

After a warning message, all options on the FieldFox are deleted.

For more information about Licensing, see the FieldFox Service Manual at: 
https://edadocs.software.keysight.com/kkbopen/fieldfox-manuals-firmware
-software-and-product-support-589310103.html.

Delete All CFG Options is to be used by Service Personnel ONLY.
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GNSS (GPS+) and GPS

GPS (Global Positioning System) allows you to ‘stamp’ each data trace with 
your physical position in latitude/longitude/elevation format. This can be 
useful when making measurements on cell towers or other antennas at remote 
locations.

— With Option 307, GPS is available with the built-in receiver accessed 
through the top-panel SMA (f) connector. This connector has a settable 3.3 
VDC or 5 VDC bias voltage which is switched ON when GPS is set to 
Internal. This system is designed for use with an active antenna such as the 
Keysight N9910X-825. 

— Without Option 307, GPS is usable ONLY with an external GPS receiver that 
is shipped with Microsoft “Streets and Trips” and “AutoRoute”. The GPS 
receiver is NOT available from Keysight. Only the GPS USB receiver is used 
with the FieldFox. Therefore, it is NOT necessary to purchase the very latest 
version of the map software.

How to make GPS settings

GPS settings are the same with, or without, Option 307.

— Your GPS settings can be saved with Preferences. Learn more in “Quick 
Settings Table” on page 740.

— Press System 7

— Then System Configuration

— Then GPS or GNSS (GPS+) – depending on options

— Then choose from the following:

— Display ON OFF Enable and disable the GPS display on the FieldFox main 
window. 

— GPS 

— OFF - Disable GPS (default setting).

— External - Enable GPS using an external, customer-supplied, USB 
dongle device. A check is made to detect a USB GPS device at the 
USB connectors.

IMPORTANT! The FieldFox may display "Ant OPEN", even when a GPS 
antenna is connected to the FieldFox. If the GPS antenna is powered by 
another power supply and has a DC blocking capacitor where the feed is 
connected to FieldFox, then minimal amounts of current will be drawn 
from the FieldFox, so the instrument will display "Ant OPEN". The 
threshold to detect the presence of an antenna is approximately 1.6 mA.
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— Internal - Enable GPS using Option 307 – Built-in GPS. Connect a 
GPS antenna to the top-panel GPS connector. Learn more about 
additional GPS antenna accessories at 
http://www.keysight.com/find/fieldfox. Internal is set automatically 
when Frequency Reference Source is set to GPS. Learn more in 
“Frequency Reference Source” on page 760.

When Internal or External is selected, a search is made for satellites overhead. 
GPS works best when outdoors and in full view of the open sky.  When several 
satellites are found, the following screen appears (when Display is set to ON) 
and is updated frequently:

Figure 30-8 GPS Display

— The left portion of the screen displays satellites and the corresponding 
number on the adjacent Satellite Power chart.

— The right portion of the screen displays Satellite Power Carrier to Noise 
(C/No) dBHz values on the tops of the satellite power chart. 

As the bar graph count exceeds 9 bars, the “dB” text is dropped from the 
number displayed on the bar. Units for C/No are dBHz.

The C/No values returned are not calibrated at the factory or warranted for 
accuracy. The numbers retrieved are passed unprocessed directly from the 
GPS receiver in use.
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GPS Status

With GPS enabled the following is displayed at the top of the FieldFox screen:

The following icons (located in RED circle above) indicate the GPS lock status:

   - GPS ON and locked on satellites.

 - GPS ON, but NOT locked on satellites.

 - GPS ON, but no GPS receiver is present or detected.

The following annotation (BLUE circle in above image) indicates the INTERNAL, 
top-panel antenna status:

— Ant: INIT – antenna status initializing.

— Ant: OK – antenna present and working. 

— Ant: OPEN – antenna is not drawing DC bias current. This could occur when 
an active antenna is not connected properly or the antenna does not require 
DC bias current. Antennas that do not require bias current can still provide 
an accurate GPS reading.

— Ant: SHORT – antenna center pin has been shorted to ground. The internal 
bias circuitry is disabled for about one minute, then re-enabled. You can 
also press GPS OFF, then GPS Internal to quickly re-enable the antenna 
bias.

More GNSS and GPS settings

See also, “GNSS and GPS Freq Ref Source Settings” on page 760.

— Press System 7

— Then System Configuration

— Then GNSS (GPS+) or GPS (depending on options) > GNSS Settings

— Then choose from the following:

— Enable and disable the synchronization of the FieldFox internal clock to the 
GPS UTC time standard. 

— ON  The FieldFox clock is synchronized and updated approximately 
once every hour to the time of the GPS clock.

The GPS Sync setting has the same restrictions as the Date and Time 
setting. Learn more in “Date and Time” on page 746.
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— OFF  The FieldFox clock is NOT synchronized with GPS. When set to 
OFF after Sync was ON, the date and time does NOT revert back to 
the settings before the clock was synchronized.

— Display ON OFF Enables or disables displaying Lat/Lon Format and 
Elevation Units.

— Lat/Lon Format Change the format of the GPS display on the FieldFox 
screen. Choose from:

— ddd°mm’ ss.sss”   degrees, minutes, seconds (default setting)

— ddd°mm.mmmmm’  degrees, minutes, fractional minutes

— ddd.ddddddd° decimal degrees

— None  Lat/Lon is not displayed.

— Elevation Unit   Choose from:

— m  (Meters) 

— Feet 

— Inches 

— Antenna Voltage   Choose from:

— 3.3V 5V  – Settable to: 3.5 VDC or 5 VDC. When the bias voltage is 
set to ON and when the GPS is set to Internal. This system was 
designed for an active antenna such as the Keysight N9910X-825

Saving Data with GPS Enabled

GPS position and clock data are included when data is saved with the following 
files types: *.csv, *.SnP, State, State+Trace data save. 

A warning is shown if the GPS is ON but unlocked at time of save, or if the GPS 
feature is ON but no GPS is physically present at time of save.

The following is a sample S1P file with GPS information:

!GPS Latitude: 38 28.87717 N
!GPS Longitude: 122 42.66625 W
!GPS TimeStamp: 06/25/2010 16:24:48
!GPS Seconds Since Last Read: 2s

Saving GPS Display Data

To save the current GPS data displayed:

— Press Save/Recall 9

— Then Save File Picture (PNG) 
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— A menu opens to enable naming the file you are saving (*.png).

More GNSS Settings

— Press System 7

— Then System Configuration

— Then GNSS Selection 

— Then choose from the following:

— GPS Refer to “How to make GPS settings” on page 756.

— GLONASS Global navigation system, operating as part of a radio 
navigation-satellite system. Learn more “More GNSS and GPS 
settings” on page 758.

— BDS - China’s BeiDou navigation system. Learn more “More GNSS 
and GPS settings” on page 758. 

— GALILEO - European navigation system. Learn more “More GNSS and 
GPS settings” on page 758. 

GNSS and GPS Freq Ref Source Settings

For convenience, the GNSS Settings menu includes the Freq Ref Source 
softkey.

— Press System > System Configuration > GNSS (GPS+) > Freq Ref Source 
[GPS] then

— Choose one of the following:

— Int, Ext, or GPS

For more, on the Freq Ref Source softkey choices, refer to “Frequency 
Reference Source” on page 760.

Frequency Reference Source

The FieldFox internal frequency reference source is used to make accurate and 
stable measurements. To improve measurement accuracy and stability, you 
can use a highly-stable external 10 MHz reference source or a precision timing 
signal provided with Built-in GPS (Opt. 307).

The Frequency Reference setting will survive a Factory Preset or Mode Preset 
and is saved as part of the Instrument State. When resuming after Standby, the 
FieldFox will display an Unlock message while it acquires a lock to an external 
or GPS source.

How to select Frequency Reference Source

— Press System 7 > System Configuration > Frequency Ref > Freq Ref 
Source
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— Then choose from the following:

— Int Internal frequency reference

— Ext External frequency reference. Connect the 10 MHz External 
Reference to the Ref In/Trig In SMA (f) connector on the FieldFox top 
panel. The FieldFox may take up to 10 seconds to lock to a valid 
External Reference source

— GPS Available ONLY with Built-in GPS (Opt. 307). When selected, the 
internal GPS is immediately enabled and a search for satellites 
begins. When satellites are found, the precision timing signal is NOT 
used directly, but is used to correct the absolute frequency of the 
internal reference many times per second.

Hold-over mode

When the GPS signal is lost, the last GPS reading is used as a hold-over 
correction value for the internal reference. The hold-over correction value is no 
longer used, but instead the factory-set correction value is used, when any of 
the following occur:

— when GPS is disabled.

— when Reference Source is set to Internal.

— when the FieldFox resumes from Standby mode or shut down. 

Frequency Reference Status

When switched to Ext or GPS, one of the following annotations appears in the 
lower-left corner of the screen:

— EXT R – External reference is selected.

— GPS R – GPS reference is selected.

— GPS H – Internal Reference is used with last ‘hold-over’ correction reading.

If the FieldFox does NOT find an appropriate Ext or GPS reference signal, then 
Ext Ref UNLOCKED is displayed in the lower-left corner of the graticule area. 
This can occur when any of the following conditions exist:

— NO reference signal is present. 

— A low or very high-level external reference signal is present. For best 
results, the signal should be between –5 dBm and +5 dBm. 

— The external reference is off-frequency.

To learn the expected measurement accuracy when connected to a frequency 
reference source, see the FieldFox specifications in “Specifications/Data 
Sheet” on page 829.
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Reference OUT

The internal 10 MHz frequency reference is available from the Ref/Trig output 
connector on the right-side panel. Use this signal as a common frequency 
reference when making measurements using external equipment. See this 
connector in “Top Panel” on page 41.

Variable Voltage Source (Opt. 309)

An internal DC source, available with Opt. 309, may be used to provide power 
for external devices. The maximum power available is 8 watts.

The voltage is output through an SMB (m) output connector located on the 
left-side panel. See the connector in “Left Side Panel” on page 43.

An optional SMB (f) to BNC (m) bias-tee power cable is available with Keysight 
part number: N9910X-713.

The following status line is provided near the top of the FieldFox screen. 

Figure 30-9 

How to make Voltage Source settings

— Press System   7

— Then System Configuration.

IMPORTANT! Noise Figure mode uses DC variable voltage source (VVS) – 
(Option 309) during the measurements. The voltage might be as high as 
28V during the measurement. During the noise figure measurement, 
always make sure there are no voltage sensitive devices connected to the 
DC SMB output port. Refer to Chapter 28, “Noise Figure Mode (Option 
356)”, on page  649.

When you initially change the FieldFox mode to Noise Figure, the FieldFox 
displays the following message for ten seconds: 
"Ensure your Noise Source is connected to the VVS DC Output 
It (VVS) will be driven up to +28V during the measurement". 

Voltage Source Status Line

1. Voltage source state: ON, OFF, TRIPPED.

2. Voltage setting from 1.00 V to 32.00 V with.01 V resolution.

3. Current: The amount of current (in Amperes) being drawn from the source.

4. Max Current: A conservative estimate of maximum current possible given 
the present voltage setting. The actual ‘trip’ level may be slightly different. 
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— Then Voltage Source.

— Then Source ON OFF to enable and disable the voltage source output.

— Then Voltage x.xx V Using  arrows, the rotary knob, or numeric 
keypad, enter a value between 0.001 and 32 volts.

— Clear Overload If the voltage source becomes ‘TRIPPED’ press to re-enable 
the voltage source output. Then set Source ON.

— Status Line ON OFF Turn ON and OFF the voltage source status line that 
appears near the top of the screen. The status line is always ON while 
making Voltage Source settings.

— Hi Impd. Load ON OFF Enables/Disables low current use (Step) and high 
current use (Ramp). Default = OFF (Low current (Step)). 

Security Level

For security reasons, you can prevent frequency information from appearing on 
the FieldFox while in SA, NA, or CAT modes.

How to set Security Level

— Press System   7

— Then System Configuration

— Then Security Level

— Then choose from the following:

— None All frequency settings are visible. 

— High Frequency information is blanked from the following:

——Display annotation

——Softkeys

——Marker display and marker table

——Calibration properties

——All settings tables

——Limit line tables

——All saved.png files

— Any of the following will re-display frequency information: 

——Set to None, Preset, Mode Preset, or FieldFox restart.
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Date and Time, Format, and Time Zone Settings

Set the local date and time, Date and Time format, and Time Zone that is 
shown on the FieldFox screen. The Date and Time is also used to identify files 
that are saved. 

The Date and Time can also be set by synchronizing with GPS satellites. Learn 
more in “GPS” on page 746.

How to Update Date and Time using Internet

This method of setting the Date and Time does NOT have the security 
restrictions of the other methods (listed below).

This method will NOT set the correct Time Zone. You must do that using the 
manual method. See below.

— Press.System 7

— Then System Configuration.

— Then More

— Then Update Time using Internet

— Connect a LAN cable that is also connected to the Internet.

— Then press Update Time using Internet. When successful, a message is 
displayed indicating the amount of time correction that occurred.

— Optional: Set the following when a Proxy server is used to connect to the 
internet:

— Proxy Host – Enter the name of the proxy host.

— Proxy Port – Enter the port number of the proxy host.

How to MANUALLY set Date and Time, Format, and Time Zone

Because of licensing security, the manual and GPS Sync methods to set 
Date and Time are restricted as follows:

Can be set backward no more than 5 hours at a time.

Can be set forward any amount of time.

Can be set backward or forward no more than once in a day. A new day 
begins at midnight.

There is no restriction for setting the Time Zone.

To change the Date and Time backward a significant amount, send an 
email to csg.servicedesk@keysight.com.
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— Press System   7

— Then System Configuration.

— Then More.

— Then Date and Time.

— Press the  arrows to highlight the row to be edited.

— Then press Edit.

— Use the arrows or rotary knob to select the field to be edited. 

— Use the  arrows or numeric keypad to edit that field.

— Press Cancel or Done when the edits are complete.

— Press Done to exit the Date and Time settings. The readout in the 
upper-right corner of the FieldFox screen will update accordingly.

LAN Settings

Configure the LAN settings to be used to communicate with the Data Link 
Software and connect to the FieldFox for remote SCPI operation. Learn more 
about Data Link at: www.keysight.com/find/fieldfoxsupport.

BEFORE manually setting the Date and Time, be absolutely certain that the 
Time Zone setting is correct.

Table 30-1 LAN LEDs 

LAN LEDs 

When FieldFox is connected to the LAN, the flashing LAN LEDs have the following 
definitions:

Green: Flashing indicates packets are being transferred.
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How to configure LAN settings

The first three ‘Current...’ settings can NOT be edited.

— Press System   7.

— Then System Configuration.

— Then More.

— Then LAN.

— Use the  arrows to select one of the following, then press Edit.

— Hostname Change the name that can be used to address the FieldFox if 
your server supports this feature. The default hostname is generated 
automatically. 

— Obtain IP Choose from:

— DHCP - IP Address is assigned dynamically. If your server supports 
this feature, the IP Address for the FieldFox is assigned each time it is 
started. 

— Static - Set the IP Address manually. The Address remains until you 
change it.

— Static IP Address - Enter the IP Address – including periods - in the 
format nnn.nnn.nnn.nnn

— Static Subnet Mask - Enter the Subnet Mask – including periods - in the 
format nnn.nnn.nnn.nnn

— Static Gateway - Enter the Static Gateway – including periods - in the 
format nnn.nnn.nnn.nnn

— Static DNS - Enter the Static DNS – including periods - in the format 
nnn.nnn.nnn.nnn

Yellow:

— Flash, pause = 10 Mbit link speed

— Flash, flash, pause = 100 Mbit link speed

— Flash, flash, flash, pause = 1 GBit link speed

Table 30-1 LAN LEDs 

LAN LEDs 

For all FieldFoxes with firmware ≤A.08.18 and ≤A.09.50 FW, when using 
Static IP addresses:

— Either a valid Static Gateway is required or 0.0.0.0.

— Either a valid Static DNS is required or 0.0.0.0. (If entry is available.)
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— Apply Settings Choose from:

— Power Up The above settings take effect when the FieldFox is 
started.

— Now The above settings take effect immediately.

— Press Done Edit when finished.

Power ON

When the FieldFox is without a power source, this setting allows the FieldFox 
to power ON when the DC Adapter is inserted without pressing the power 
button. 

How to set Power ON

— Press System 7

— Then System Configuration

— Then More

— Then Power ON

— Then choose from the following:

— Auto The FieldFox will power ON when the DC Adapter is inserted.

— Manual The FieldFox will power ON only when the power button is 
pressed.

FieldFox Package Installer

The FieldFox Package Installer enables you to download new versions of 
firmware from either a USB memory or SD Card. Additionally, the Utility softkey 
enables you to backup user files or restore user files. 

How to run the Installer

— Press System   7.

— Then System Configuration.

— Then More 

To make the LAN settings persist after power up, toggle Apply Settings to 
Now then back to Power Up. You should see a message indicating that the 
LAN config file was saved.

Before running the Installer to update your firmware, you might want to 
back up your user data. Refer to “How to restore files” on page 768.
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— Then Firmware Update

— Then Start Installer

— The Installer software opens after a couple of seconds. 

— Then the  arrows or the knob to scroll to the firmware you want to 
install.

— Press Start Install

— “Current Step Progress:” bar and a “Total Progress:” bar are 
displayed along with this message: “Copying package. Do not 
remove install media.”

— When the installation is completed, the FieldFox reboots.

How to backup files

This procedure backs up your user data to a USB or SD card. See also “How to 
restore files” on page 768.

From the initial Installer menu: 

— Press Utility

— Then Backup Data

— A message is displayed: “Choose backup file location.”

— Then choose either SD Card or USB 

— A progress bar and a message is displayed: “Saving user data…”

— Press Cancel to exit without backing up your files and returning to the initial 
Installer menu.

How to restore files

This procedure restores user files from a USB or SD card. See also “How to backup 

files” on page 768.

If no files are displayed, verify that a USB memory or SD Card is installed 
and press Refresh List.

If you backup multiple versions of the user files, the FieldFox appends a 
“_#” to each subsequently stored file. During restore, the file with the 
highest appended number is loaded into the FieldFox.

Restoring files overwrites the existing user data on the FieldFox. 
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If your stored any user files to a USB or SD card, this procedure restores those 
files.

From the initial Installer menu: 

— Press Utility

— Then Cancel to exit without restoring your files and returning to the initial 
Installer menu. 

Or

Press Restore Data 

— A message is displayed: “This option will COMPLETELY ERASE 
existing user data. ARE YOU SURE?”

— Then No to return to the previous menu without restoring files.

Or

Press Yes 

— Then choose either SD Card or USB

A progress bar and a message is displayed: “Restoring user data…”

Service Diagnostics

— The Service diagnostics menu is generally used to display service-related 
information. To access these menu items, press System   7 then Service 
Diagnostics.

System Information

The System information table shows important information about your 
FieldFox. The following is the most useful information:

— Model Number – FieldFox model

— Serial Number – Identification number of your FieldFox

— Firmware Release – The currently installed version of software. Check to 
see if you have the latest firmware at: 
www.keysight.com/find/fieldfoxsupport

— Network Identity – The network name and current IP address of your 
FieldFox.

If you backup multiple versions of the user files, the FieldFox appends a 
“_#” to each subsequently stored file. During restore, the file with the 
highest appended number is loaded into the FieldFox
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— Reflectometer Factory Cal - The Factory (CalReady) Calibration shows the 
date and time that the factory cal was performed for each test port and the 
Thru connection. The format is P1 <date time>, P2 <date time>, P1-P2 
<date time>. The factory calibration is updated when you send your 
FieldFox to Keysight for Instrument Calibration. Learn more in “Instrument 
Calibration” on page 831.

Event Log

The Event Log shows the information that has appeared on the FieldFox 
screen. The most recent information is at the top of the table. 

Press Clear Events to erase this information.

Battery

Learn more in Chapter 33, “Working with the Lithium-Ion Battery”, on page  
793.

Internal Temperatures

Learn about the importance of the internal FieldFox temperatures in “FieldFox High 
Temperature Protection” on page 32.

Erase User Data

All data that you have written to the FieldFox can be erased with the press of a 
button. You would do this if your FieldFox is located in a secure environment 
and must be routinely erased of sensitive data. 

All data is removed from the FieldFox internal “UserData” partition. This 
includes all State files and Trace + State files (*.sta), all Data files (*.csv, *.snp), 
all Picture files (*.png), all Cal Kit files, and all Cable files. 

External media that is inserted (mini-SD card or USB flash drive) is NOT 
erased.

The “Lost Clusters“ folder and files are NOT erased because they are part of 
the file system housekeeping. 

IMPORTANT!

The process in this section erases all User Data from the FieldFox. Before 
proceeding, Keysight strongly recommends that you back up all of your 
User Data to an external storage device. refer to “How to backup files” on 
page 768. 
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How to Erase User Data

— Press System   7.

— Then Service Diagnostics.

— Then Advanced

— Then Erase User Data

— Then Confirm Erase

— Then the following occurs:

— All data files and folders are deleted from the “UserData” partition.

— The FieldFox is rebooted, which manages the newly-freed data and 
re-writes the factory cal kits and cable files.
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Understanding the Fan Controls

This section contains the following:

— “How to find the Fan Control Softkey Menu”

— “Fan Error Messages” on page 773

How to find the Fan Control Softkey Menu

This section discusses how to locate the fan control softkeys to monitor your 
fans performance (i.e., the fan control softkeys are for informational purposes 
only).

1. Press System 7.

2. Then Service Diagnostics.

3. Then Advanced

4. Then Fan Control

5. These softkeys are for informational purposes only:

— Fan Mode Auto – Manual is not selectable.

— Manual Speed [Medium] – this is the default. No other speeds are 
selectable.

— Fan RPM – displays the current fan RPM.

— Fan Temp – displays the current fan air temperature.

— Back –to exit the fan control softkey menu

Figure 30-10 Fan Control Softkeys – Informational Use Only (Not Editable)

 

If the FieldFox displays a “Fan Stuck” or “Error: Internal Fan has stopped 
spinning”, to avoid incorrect measurements and possibly damaging your 
FieldFox, shut your FieldFox down and contact Keysight. Refer to 
“Contacting Keysight” on page 5.

The fan is replaceable, but not removable by non-Keysight trained 
personnel.
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Fan Error Messages

The FieldFox displays fan error messages, when the fan is not functioning 
properly. Refer to Figure 30-11, Figure 30-12 on page 774, and Figure 30-13 
on page 774. 

Figure 30-11 Initial Fan Stuck Error Message – Displays For a Few Seconds

If the FieldFox displays a “FanStuck” or “Error: Internal Fan has stopped 
spinning” message, to avoid incorrect measurements and possibly 
damaging your FieldFox, shut your FieldFox down and contact Keysight. 
Refer to “Contacting Keysight” on page 5.

If the FieldFox displays a “Fan: Service"message the fan needs replacing. 
Call Keysight and request a fan kit. Refer to Figure 30-13 on page 774 and 
to “Contacting Keysight” on page 5.
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Figure 30-12 Persistent Fan Stuck Error Message

Figure 30-13 Fan: Service Message 
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31 Using the Mini-USB Port to send SCPI Commands and Queries

In this Chapter

Mini-USB Connection to PC with IO Libraries
The FieldFox comes with a mini-USB port that can be used to connect to your 
PC’s standard USB 2.0 port. Using Keysight IO Libraries, Connection Expert 
and connecting via a VISA connection, you can send SCPI commands via the 
Keysight Interactive IO window to the FieldFox. Refer to your IO Libraries 
online help for the details on connecting to your instrument. Refer to 
keysight.com to download the IO Libraries.

Overview of mini-USB to PC setup for sending SCPI commands and queries:

— Connect a mini-USB (FieldFox device-side) to standard USB (host-PC)

— On the FieldFox: Power on the instrument.

— Click System 7 > System Diagnostics > System Information and find the 
FieldFox serial number.

— On your PC: Open the Keysight IO Libraries software, Connection Expert 
and connect to the FieldFox using the VISA connection. Refer to the 
Keysight Connection Expert Help.

— In the Keysight Interactive IO window: Type in your SCPIs on the Command 
line and click Send Command, Read Response, or Send & Read. Refer to 
the Keysight Connection Expert Help and Figure 31-1 on page 776.

IMPORTANT! It is recommended that only USB certified cables are used 
with the FieldFox.

“Mini-USB Connection to PC with IO Libraries” on page 775

The FieldFox may be communicated with via the VISA libraries.  This 
makes it available to VEE, LabView, and other software tools that can 
communicate with VISA instruments.

You can connect to USB ports that are not type 2.0 USB. But, the 
mini-USB port is optimized for a type 2.0 USB ports. 
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Figure 31-1 Keysight Interactive IO Window
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32 File Management

The FieldFox can save any of the following types of files:

— Current settings and calibration

— Trace data (*.csv, *.S1P, *.S2P)

— Picture of the FieldFox screen

In addition, files can be saved to the internal memory, a USB Flash drive, or a 
standard SD card.

In this Chapter

“Save Files” on page 778

“Recall Files” on page 782

“Move (Copy) Files” on page 782

“Set File Type and Select Device” on page 783

“Manage Files” on page 786

“Manage Folders” on page 788

“Edit Keywords” on page 789

“Prefixes and Suffixes for Filenames” on page 789

See Also:

“Erase User Data” on page 770
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Saving and Recalling Files

The FieldFox model families are:

— N991x (VNA/SA) model family

— N992x (VNA) model family

— N993x (SA) model family

— N995x (VNA/SA) model family

— N996x (SA) model family

Save Files

How to Save a File

— Press Save/Recall 9

— Then Save

— At the top of the current ‘labeler’ screen (see following image) check the 
File Type to save and Device (Internal, USB, Storage Card) to which the file 
is saved. Learn how to change these settings in “Set File Type and Select 
Device” on page 783.

— Then use the labeler to specify a filename.

FieldFox State files are intended to be recalled on the same instrument 
model on which they were saved. Sometimes you may able to recall them 
within model families.  An error will result when trying to recall a state file 
that was saved on a different model family. 

If you are having difficulty saving to a USB flash drive, it may be a timing 
issue. The turn-around time for “file open, write data, file close” to a USB 
drive is much longer than to FieldFox’s internal memory.  Alternative 
methods are:

1. Save your content to the FieldFox’s internal memory; and then move 
your files off to a USB flash drive using FTP SCPI programming. Refer to 
Using FTP with FieldFox and to the FieldFox Programming Guide.  

2. Save your data to the FieldFox’s internal memory, then move the data 
to a PC using a binary block transfer, and delete the data from the 
FieldFox’s internal memory. An example for transferring an image: 
http://na.support.keysight.com/fieldfox/help/Programming/webhelp/
Examples/Transfer_Image_to_PC.htm. Please note that the receiving 
computer program needs to be able to handle the binary block transfer. See 
also FieldFox Programming Guide. 
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Saving MATLAB files

Figure 32-1 I/Q Analyzer Mode (IQA) MATLAB File Save

Insert only ONE USB flash drive in the FieldFox when saving or copying 
files.

If you have Option 351 I/Q Analyzer option, you can directly save your data 
as MATLAB files (*.mat). Refer to Chapter 11, “  IQ Analyzer (IQA) – Option 
351”, on page  285 and to Chapter 32, “File Management”, on page  777.

If you have the FieldFox’s Remote Server mode (89600 VSA software 
connectivity), you can use the VSA software to capture and record your 
data as MATLAB files (*.mat). Learn more about FieldFox and 89600 VSA 
software, refer to Chapter 17, “Remote Server Mode (Requires SA 
Hardware/SA Option 233)” and to 
http://rfmw.em.keysight.com/wireless/helpfiles/89600B/WebHelp/89600
.htm.
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Figure 32-2 VSA Software MATLAB File Save

How to use the FieldFox labeler 

The FieldFox labeler is used to edit or change the current filename. It is also 
used for many other labeling functions, such as creating a title, prefix, and 
keyword to display on the FieldFox screen. Learn about Titles in “How to 
Manage files” on page 786. 

— Move the cursor (see section below, How to move the cursor), then press 
Select to add the cursor character to the end of the existing filename. 

— Back Space to erase the last character(s) from the end of a filename.

— Press Shift to toggle keyboard between lower case and upper case 
characters.

— Press Alt Keyboards to display the different keyword choices.

You can select either an ABC or Qwerty style keyboard. Refer to “Alpha 
Numeric Editing” on page 749. 
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The preselected keywords (File, Site, and so forth) can be selected just like a 
single character. These keywords can also be edited. Learn more in “Edit 
Keywords” on page 789.

Figure 32-3 The FieldFox labeler

In the graphic above, the current filename is File_0. The cursor is on the 
custom DTF_VSWR keyword. The file will be saved to USB (flash drive). File 
Type is “Trace + State” (Instrument State).

How to move the cursor

— Use the rotary knob to move cursor on the same row. The cursor will change 
rows when it comes to a row end. 

— Use the  arrows to move the cursor up and down the rows.

When the current filename is complete

— Press Done to save the file to the specified filename.

— Press Cancel to close the labeler without saving a file.
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—  If the filename already exists, you are prompted to choose from the 
following:

— Press Yes to overwrite the existing file.

— Press Cancel to return to edit the filename. 

Recall Files

The FieldFox can recall State files, Trace + State files, and image files.

State Files

ALL FieldFox instrument settings for ALL Modes are saved and recalled in a 
*.sta file. If error correction is ON in CAT or NA Mode, then calibration data is 
also saved and recalled.

If error correction is OFF (CalRdy is active), calibration data is NOT saved in the 
*.sta file. When a Trace + State file is recalled on a FieldFox other than the one 
it was saved on, differences in the CalRdy calibration data may result in 
differences between the displayed traces.

Image Files

The FieldFox can open and display *.png, *.jpg, and *.jpeg images. 

How to Recall a File

— Press Save/Recall 9 

— Then Recall File or Enter

— Navigate to the file to be recalled using the Up/Down arrow keys. 

— Optional: Sort by Name to list the current files by name.

— Optional: Sort by Date to list the current files by date.

— Optional: Next Page if available, to go to the next page of filenames.

— Optional: Previous Page if available, to go to the previous page of 
filenames.

— Then Recall File or Enter.

—  Cancel to cancel recall file and return to the previous menu.

Move (Copy) Files

The FieldFox can Move files (i.e., including Trace + State files, and image files). 

Before recalling a file, first Select the Device and Location from which the 
file will be recalled. See the following section for more information.
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How to move a file

— Press Save/Recall 9

— Then  Device  to be copied from (i.e., Internal, SD, or USB). Refer to “Set 
File Type and Select Device” on page 783.

— Then More  

— Then Manage Files 

— Then  Select Files  

— Navigate to the file(s) to be copied using the Up/Down arrow keys or the 
knob.

— Then  Copy 

— Select the destination device using the softkeys:

—— Copy to Internal Copies to FieldFox’s internal memory.

—— Copy to USB  Copies to a USB memory device.

—— Copy to SD Card Copies to a SD/SDHC memory card.

——Cancel to cancel copy file and return to the previous menu

— Use the close folder icon or the open folder icon to locate the target folder 
for your files. 

— Then  Do Copy  copies files to selected location and FieldFox displays a 
confirmation message of a successful file copy.

— Cancel to cancel copy file and return to the previous menu.

Set File Type and Select Device

The following File TYPE and DEVICE settings are used to determine the type of 
file to save, and the location to be used for all file operations.

These two settings remain through an instrument preset, but are reset to the 
default values when the FieldFox power is shutdown. 

Select Device (location of File Save/Recall)

— Press Save/Recall 9

— Then Device to set the LOCATION where the file is to be saved, recalled, or 
moved. Choose from the following:

—  Internal Saves/Recalls/Moves (Copies) files to/from the FieldFox 
internal memory. To specify a folder, first select Manage Folders 
(learn how in “Manage Folders” on page 788). The Data Link software 
will read data ONLY from the \UserData folder. 
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— SD Card Saves/Recalls/Moves (Copies) files to/from the SD card (not 
included), inserted in the card slot. See “Take the FieldFox Tour” on 
page 38. Only the root folder is available.

— USB Saves/Recalls/Moves (Copies) files to or from a USB Flash drive 
(not included) that is inserted in one of the USB connectors. Only the 
root folder is available. 

How to set File Type 

— Press Save/Recall 9

— Then File Type. Choose one of the following:

—  State Saves ALL FieldFox instrument settings for ALL Modes to a 
*.sta file. If a calibration is ON in CAT or NA Mode, calibration data is 
also saved. This file can be opened ONLY by a FieldFox. State files 
can be saved between compatible FieldFox models. See note 
in.“Saving and Recalling Files” on page 778.

— Trace+State Saves the current trace and instrument settings to a 
*.sta file. In SA Mode, all traces are saved. This file can be opened 
ONLY by a FieldFox. When recalled, the FieldFox sweep is set to Hold. 

— Picture (PNG) Saves a 640 x 453 pixel image of the FieldFox screen to 
a *.png file. The picture does NOT include the softkeys.

— Data (csv) Saves trace data from the current Mode to a *.csv file. This 
format can be imported into spreadsheet software such as Microsoft 
Excel. Column A is always the frequency at which the data is 
measured.

——In SA Mode, all visible data traces are saved. Each trace is 
saved to a separate column that is labeled with the Trace 
State.

——In CAT and NA Modes, only the data trace is saved – not the 
memory trace.

——In Power Meter (with Option 208 Frequency Offset Power 
Sensor (FOPS)), all visible traces are saved. Each trace is saved 
to a separate column labeled Output Power or Memory.

——In VVM Mode, NO data is saved.

Insert only ONE USB Flash Drive in the FieldFox when saving or copying 
files.

When using RTSA, the Density Spectrum information is not saved using 
Trace+State. Only the last displayed trace settings is saved.
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— Data (S1P) / (S2P) Saves CAT and NA Mode trace data to an *.S1P or 
*.S2P file, depending on the active measurement. This file format is 
used by CAE programs such as Keysight's Microwave Design System 
(MDS) and Advanced Design System (ADS). It can also be imported 
into spreadsheet software such as Microsoft Excel.

About SNP Files

The SNP file includes header information, and the following data:

— S1P - saves 1-port (receiver) data for the active data trace. *.s1p Files 
contain 1 stimulus value and 1 S-parameter (total of 3 scalar values) Stim 
 Real(Sxx)  Imag(Sxx)

— S2P (NA Mode ONLY) - saves 2-port data for the active trace. *.s2p Files 
contain 1 stimulus value and 4 S-parameters (total of 9 scalar values) Stim 
 Real(S11)  Imag(S11)  Real(S21)  Imag(S21)  Real(S12)  Imag(S12) 
 Real(S22)  Imag(S22) 

— Only data traces are saved – not memory traces.

Corrections

— When parameters are corrected, data is returned even when not displayed. 
Data is returned with the correction type that is applied for each 
S-parameter. The correction type for each S-parameter is annotated in the 
header.

— When parameters are NOT corrected or displayed:

— With Smith chart and Polar formats, Real/Imag zero-filled data 
appears as (1.0, 0.0).

— With all other formats, LogMag/Phase zero-filled data appears as 
(0.0, 0.0).

> Display formats

In CAT Mode, S1P files are always Magnitude (dB) / Phase (angle) format.

In NA Mode:

— Smith chart and Polar display formats are ALWAYS saved in Real/Imag data 
pairs.

— All other display formats are saved in LogMag/Phase (dbAngle).

> What Data Processing functions are included in saved SNP Data:

In NA Mode, the data processing functions (such as trace math) that are 
included in the SNP data depends on a Preference setting. Click System, then 
Preferences, then Preferences, then scroll to NA, SNP File Save, then select 
from the following:
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— Default – SNP data does NOT include smoothing. SNP data saves are taken 
AFTER data processing (location 2) on the processing chain.

— Advanced – SNP data includes the following:

— With Smith or Polar display format, SNP data saves are taken 
BEFORE most processing (location 1 on the data processing chain). 

— With any other display format, SNP data saves are taken just AFTER 
Formatting and Smoothing is applied (location 3 on the data 
processing chain). For each non-active trace, SNP trace data is 
reprocessed using the data processing chain of the active trace. 

See the FieldFox data processing chain at the Supplemental Online Help: 
http://na.support.keysight.com/fieldfox/help/SupHelp/FieldFox.htm Learn 
more about System Preferences in “Preferences” on page 740.

Manage Files

Files that are stored in the FieldFox internal memory, standard SD card, and 
USB Flash drive, can be copied to another device or deleted.

How to Manage files

— Press Save/Recall 9

— Then Device to select the location (Internal, USB, or standard SD Card) of 
the file to copy or delete. 

— Then More

— Then Manage Files

— Then choose from the following: 

— Select Files  Selects a file or files to sort, copy, or delete.

— Sort 

— Sort by Name Sorts the displayed list of files by name.

— Sort by Date Sorts the displayed list of files by date.

— Copy Select a file or files to copy. 

— Then select a device to copy the file to. Choose from Copy to Internal, Copy 
to USB (must be inserted), or Copy to SD Card (must be inserted). 

When selecting Internal, it may also be necessary to first select Manage 
Folders to specify an active folder which contains the files to copy or 
delete. Refer to “Manage Folders” on page 788.
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— Do Copy to complete the file copy to the media/folder selected. 

— Delete 

—  Yes The selected file is deleted.

—  Cancel To cancel Delete and return to previous menu.

— More

— Select Files Selects a file or files to sort, copy, or delete.

— Select All selects all of the displayed files. All files that are displayed 
are to be copied. Then select a device and a folder to copy the file to. 
Choose from Internal, USB (must be inserted), or SD Card (must be 
inserted).

— Clear All Deselects all of the displayed files. 

— Rename Files 

—  Enter the string in the filename or filenames that are to be replaced. 

— Replace With Enter the string that is to be replaced by the 
characters entered with the String to Replace softkey.

— Prefix Enter a prefix (one time) that the current filename or filenames 
are to be renamed. To add a prefix to subsequent filenames 
(persistent), refer to How to edit the Prefix and Suffix (Auto Append) 
in “How to edit the Prefix and Suffix (Auto Append)” on page 790.

— Suffix Enter a suffix that the current filename or filenames are to be 
renamed.

— Do Rename Enable renaming of the current file or files.

Copy can be done to any FieldFox internal folder, standard SD folder, or 
USB storage device.

For more on renaming folders/files, refer to “How to use the FieldFox 
labeler ” on page 780 and “Prefixes and Suffixes for Filenames” on 
page 789.

String to Replace is case sensitive.

Insert only ONE USB Flash Drive in the FieldFox when saving or copying 
files.
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Manage Folders

You can create new folders, delete old folders, and select the active folder to 
which files can be saved. The Parent folder [..] is listed when not in the root 
directory.

Press Save/Recall   9

— Press Save/Recall 9

— Then More

— Then Manage Folders

— Then choose from the following:

— Change Folder Changes the active folder to which files can be saved. 
The active device and current folder is displayed at the top of the 

screen, and below, a list of files in that folder. Use the  arrows to 
highlight a folder within the current folder. Each time the Change 
Folder softkey is pressed, the highlighted folder becomes the active 
folder.

— Create Folder A new folder is created in the current folder. Select a 
name for the new folder from one of the displayed keywords: You can 
change these keywords using the following Edit Keywords function. 
Refer to Edit Keywords in “Edit Keywords” on page 789. 

— Delete Folder The selected folder and its contents are deleted after a 
warning prompt is displayed. A “Parent” folder or system folder can 
NOT be deleted. 

— Copy Folder The selected folder and its contents are copied and a 
message is displayed telling you that the copy was successful.

——Then select a device to copy the folder to. Choose from Copy 
to Internal, Copy to USB (must be inserted), or Copy to SD 
Card (must be inserted). 

——Do Copy to complete the file copy to the media/folder 
selected.

— Rename The rename folder menu opens and the selected folder’s title 
is displayed and available for editing. 

— Press Exit when finished.

For more on renaming folders/files, refer to “How to use the FieldFox 
labeler ” on page 780, and “Prefixes and Suffixes for Filenames” on 
page 789.
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Edit Keywords

The preselected keywords (FILE, SITE, and so forth) can be edited to meet your 
specific needs. Your keywords will remain in the FieldFox until you change 
them. Keywords are limited to 30 characters.

How to edit keywords

— Press Save/Recall 9

— Then More

— Then Edit Keywords

— Then Next Page and Previous Page to view all keywords.

— Use the  arrows to select a keyword to edit.

— When a keyword is selected, then press Edit.

— Then choose from the following:

— Press Select to add the cursor character to the end of the selected 
keyword. 

— Press Backspace to erase the last character from the end of the 
selected keyword. 

— Press Shift to change from upper-case to lower-case and vice versa.

— Press Alt Keywords to toggle through different keyword choices.

How to move the cursor:

— Use the rotary knob to move the cursor along the same row. The cursor will 
change rows when it comes to a row end. 

— Use the  arrows to move the cursor up and down between rows.

When the selected keyword is complete:

— Press Done to save all keywords and close the Edit Keywords labeler. These 
keywords will exist on the FieldFox until changed.

— Press Cancel to close the labeler without saving changes.

Prefixes and Suffixes for Filenames

The prefix and suffix (Auto Append) can be used together to organize files. 
Once set and enabled, they are automatically entered as the beginning (Prefix) 
and end (Suffix - using Auto Append) of a filename when performing a Save 
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operation. These settings are persistent, until disabled. Refer to “How to edit 
the Prefix and Suffix (Auto Append)” on page 790 and “How to enable/disable 
Auto Append (Suffix) ” on page 791.

This section contains the following sections:

— “How to edit the Prefix and Suffix (Auto Append)” on page 790.

— “How to move the cursor” on page 781.

— “When the Prefix is complete” on page 791.

— “How to enable/disable Auto Append (Suffix) ” on page 791.

How to edit the Prefix and Suffix (Auto Append)

If you want to edit a prefix on a finite set of files one time, refer to “Manage 
Files” on page 786.

— Press Save/Recall 9

— Then More   

— Then Prefix Suffix

— Then choose from the following: 

— Edit Prefix to edit the prefix using the labeler. For more, refer to “How 
to edit the Prefix and Suffix (Auto Append)” on page 790.

——Select to add the cursor character to the end of the Prefix.

—— Back Space to delete the last character(s) from the end of the 
prefix.

——Shift to toggle between capital letters and lower case letters.

——Alt Keywords to display the different preselected keywords 
(File, Site, and so forth) can be selected just like a single 
character. These keywords can also be edited. See Edit 
Keywords.

——Cancel to cancel edits and return to the previous menu. 

— Auto Append (Suffix)

— OFF to turn off Auto Append.

— Number to auto-append a number using format “_nnn” sequentially 
to all saved files.

— Date to auto-append a date and time using format 
“_YYYY-MM-DD.HH.MM.SS” sequentially to all saved files.

If you are only interested in adding a prefix or a suffix to a new file or files 
one time, refer to “Manage Files” on page 786.
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— Number Suffix Reset to reset Auto Append number to “_001”.

—  Prefix 

—  OFF to disable the prefix. The Prefix softkeys are grayed out 
(inactive). Refer to How to enable/disable the Prefix (persistent) in 
“How to enable/disable the Prefix (persistent)” on page 791.

—  Last File to use the last filename saved, as your filename for 
subsequent saved filenames. 

— User to use the user-selected prefix. 

—  Back to return to the previous menu.

How to move the cursor

— Use the rotary knob to move cursor on the same row.

— Use the  arrows to move the cursor up and down the rows.

When the Prefix is complete

— Press Done to save the Prefix and close the labeler. This Prefix will exist on 
the FieldFox until it is changed.

— Press Cancel to close the labeler without saving changes.

How to enable/disable the Prefix (persistent)

— Press Save/Recall 9

— Then More 

— Then Prefix Suffix 

— Then Prefix 

— OFF to disable the prefix on subsequently saved files. Edit Prefix, Auto 
Append, and Number Suffix Reset softkeys are grayed out (inactive).

How to enable/disable Auto Append (Suffix) 

— Press Save/Recall 9
— Then More 
— Then Prefix Suffix 
— Then Auto Append 
— OFF to disable the Auto Append (Suffix) on subsequently saved files. Auto, 

and Number Suffix Reset softkeys are grayed out (inactive).

When Last File is selected, the Edit Prefix and Auto Append softkeys are 
unavailable (grayed out). Refer to “Prefixes and Suffixes for Filenames” on 
page 789.
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Press Printing
The current screen or selected files can be printed using a PCL-compatible 
printer (like older HP Deskjet printer) connected to one of the FieldFox USB 
ports. Newer PCL3GUI photo and all-in-one printers are NOT supported.

Measurements can also be printed using the FieldFox Data Link software. 

How to print the current screen or a saved file 

To save ink, first select an outdoor (white background) display color. Learn how 
in “Display Colors” on page 729.

— Connect the printer to a FieldFox USB port. The print softkey will appear 
ONLY when a compatible printer is connected. 

— Then press Save/Recall 9

— Then Print and choose from the following:

— Printer & Page\nSetup - Confirm that the printer is connected and 
configured properly. The Status line should read “Ready’.

— Make other print settings as desired.

— Select Files\nfor Printing - Print up to 16 *.PNG images on one page 
that are stored on the Internal drive. Images can NOT be printed from 
the USB and SD card. 

— Edit the Quick Settings table to select up to FOUR Rows and FOUR 
Columns for up to 16 total images to be printed on a single page.

— If necessary, edit the filenames to be printed.

— Select Done. Then Print Selected\nFiles to begin printing.

——Print Current Screen – Immediately prints the FieldFox screen 
using the selected Printer and Page Setup settings.
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33 Working with the Lithium-Ion Battery

In this Chapter

See Also:

Viewing the Battery Charge Status
You can view the battery charge status in the following ways:

— Icons in the upper right of the front panel screen.

— Battery screen - select System then Service Diagnostics then Battery.

— Built-in battery gauge. Learn more in the following section. 

“Viewing the Battery Charge Status” on page 793

“Charging the Battery” on page 795

“Reconditioning Battery” on page 798

“Battery Care” on page 798

“Maximizing Battery Life” on page 798

“Lithium-Ion Battery Disposal” on page 799

“Install the Lithium-Ion Battery” on page 30

“To conserve battery power:” on page 31

“For the Battery” on page 806

Table 33-1 Front Panel Icons

Icon Status

Connected to external power through the 
AC/DC adapter. Battery installed and charging. 
The amount of charge is indicated by the 
number of bars shown.
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Service Diagnostics—Battery Screen

The Battery screen displays the following information. To access the screen, 
select System then Service Diagnostics then Battery.

Additional battery information is available using SCPI commands. 

1. Status – Fully charged, No battery, Charging, Empty, or Discharging.

2. External DC Supply – ON or OFF indicates if an external DC supply is 
connected.

3. Battery Present – ON or OFF indicates if a battery is installed.

1. Voltage – measured by the battery’s sensor.

2. Current – amount of current being consumed when operating from 
internal battery. If battery is charging, indicates amount of charging 
current.

3. Battery Temperature – internal temperature of the battery as measured by 
a sensor embedded in the battery.

4. Present Run Time to Empty – minutes of power remaining based on 
amount of current being used now.

5. Charge Cycles – number of charge cycles the battery has experienced. 
Charge cycle defined as ≥80% change in relative state of charge.

Built-In Battery Gauge

Each lithium ion battery has an LED gauge that displays its charge status. The 
gauge is active unless the battery is in shut down mode. 

To view the LED gauge, open the FieldFox battery compartment door, remove 
the battery, then press the button on the battery. 

Battery not charging with 84% battery life 
remaining.

Battery fully charged. A fully charged battery 
MAY NOT read 100%. 

Table 33-1 Front Panel Icons

Icon Status

Items 4 through 8 are read directly from the battery. The information is 
based on the battery’s internal sensors and memory.
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The battery in your FieldFox will have either 4 or 5 LED segments. 

Charging the Battery
When you receive your FieldFox, the lithium-ion battery is partially charged to 
approximately 30% to 40% to preserve battery life. Allow four hours to fully 
charge the battery internally, or three and a half hours () by using the external 
battery charger (N9910X–872). A fully charged battery will power your 
FieldFox for about four hours. Upon receiving your FieldFox, it is NOT 
necessary to charge your FieldFox's battery before using your instrument.

The FieldFox circuitry ALWAYS prevents the battery from discharging to a level 
that is damaging. However, if the battery is completely discharged, the 
FieldFox may not turn ON. If this occurs, the battery can still be charged either 
internally or externally. 

Because a lithium-ion battery has no memory effect, you can charge a battery 
at any time regardless of the current charge status. 

Internal Charging with the AC/DC Adapter 

Internal charging time for a fully depleted battery is approximately 4 hours with 
the FieldFox either ON or OFF. 

5-segment 
Gauge

Charge 
Remaining

4-segment Gauge Charge Remaining

5 segments ≥80% 4 segments ≥75%

4 segments 60% to 79% 3 segments 50%,to 74%

3 segments 40% to 59% 2 segments 25% to 49%

2 segments 20% to 39% 1 segment < 25%

1 segment < 20%

Read the safety information in “For the AC/DC Adapter” on page 804.
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Figure 33-1 AC/DC Adapter

To charge a battery inside the FieldFox, insert the AC/DC adapter plug into the 
Power connector on the FieldFox side panel, then plug the adapter into an AC 
outlet.

— FieldFox ON: Charging is indicated by a battery icon in the upper right of 
the front panel screen. 

— FieldFox OFF: Charging is indicated by the FieldFox power LED glowing 
amber, with its intensity increasing from dim to bright every few seconds. 
This pattern repeats until the LED turns off when charging is done. Learn 
more on “Front Panel” on page 38.
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Using the External Battery Charger (N9910X–872) 

Figure 33-2 External Battery Charger (N9910X-872)

The external battery charger (N9910X–872), lets you charge a fully depleted 
battery in approximately three hours. It is a two bay, level–3 stand-alone 
battery charger that is compliant with the standard Smart Battery System. The 
two bays are charged sequentially on a first-come, first-served basis, though a 
discharge can be performed in the left bay while the right bay is charging. 

For more information, refer to the Instruction Manual included with the 
external battery charger.

Read the safety information in “For the External Battery Charger 
(N9910X-872)” on page 805.

External Battery Charger LED Charging Status

Green Fully charged

Green flashing Fast charging

Yellow flashing Reconditioning – the accuracy of the 
battery’s internal LED charge gauge 
is being renewed. See 
“Reconditioning Battery” on 
page 798

Yellow/green Battery is reconditioned

Red flashing Error

Yellow Standby
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Reconditioning Battery
Reconditioning a battery can be performed ONLY with the External Battery 
Charger (N9910X–872).

1. Insert a battery into the left bay of the external charger.

2. Press the button labeled Push to Recalibrate Left Battery Bay

3. The charger will charge the battery fully, discharge it completely, then 
recharge it fully again. The entire process can take up to 12 hours.

4. Install the battery into the FieldFox.

5. On the System, Battery screen, verify that the battery is fully charged.

Battery Care
Visually inspect the battery periodically for signs of degradation, such as 
swelling, cracking of the battery shell, or leakage of fluid. If degradation 
occurs, replace the battery and dispose of it properly. Refer to “Lithium-Ion 
Battery Disposal” on page 799. Operation with a degraded battery could result 
in damage to the FieldFox. 

Maximizing Battery Life
— If AC power is not continuously available (Ex: in a field environment), use the 

battery and recharge it when it holds a 20% to 50% charge, as shown on 
the screen’s battery charge icon. At this charge level, 2 or 3 segments show 
on the battery gauge.

— If the FieldFox is not going to be used for more than a week, remove the 
battery. Best practice is to store the battery with a charge of about 50%. At 
this charge level, 3 segments show on the battery gauge. 

— Allow a battery to warm to room temperature before charging it. 
Temperature shock can damage the battery chemistry and in some cases 
cause a short circuit.

— Store batteries in a cool, dry location, away from metal objects and 
corrosive gases.  
Storage temperature limits (20% to 50% relative charge is recommended): 
          Transportation:   –20°C to 50°C 
          Within 1 month: –20°C to 45°C 
          Within 6 months: –20°C to 40°C 
          Within 1 year:      –20°C to 35°C



Keysight N9938-90006 User’s Guide                                                                                                                      799

Working with the Lithium-Ion Battery
Lithium-Ion Battery Disposal

— Battery charging limits:                                                        
Charge temperature:     0°C to 45°C (<10°C slows charge on some batteries) 
Discharge temperature: –10°C to 60°C

— Operate the FieldFox on battery power between the ambient temperatures 
of –10 and +50°C (–14 to +122°F). Using the battery at lower or higher 
temperatures can damage it and reduce operating life. Cold temperatures 
affect battery chemistry, reducing charge capacity, especially below 0°C 
(32°F). 

Lithium-Ion Battery Disposal
When you notice a large decrease in charge capacity after proper recharging, 
it’s probably time to replace the battery.

Lithium-Ion batteries need to be disposed of properly. Contact your local 
waste management facility for information regarding environmentally sound 
collection, recycling, and disposal of the batteries. Regulations vary for 
different countries. Dispose of the battery in accordance with local regulations.

Keysight Technologies, through Rechargeable Battery Recycling Corporation 
(RBRC), offers free and convenient battery recycling options in the U.S. and 
Canada. Contact RBRC at 877-2-RECYCLE (877.273.2925) or online at: 
http://www.call2recycle.org/ for the nearest recycling location.
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34 Safety Considerations

Keysight has designed and tested the FieldFox in accordance with IEC 
Publication 61010-1Safety Requirements for Electrical Equipment for 
Measurement, Control and Laboratory Use, and the FieldFox is supplied in a 
safe condition. The FieldFox is also designed for use in Installation Category II 
and pollution Degree 2 per IEC 61010-1. Read the following safety notices 
carefully before you start to use this FieldFox to ensure safe operation and to 

maintain the product in a safe condition. 

The input terminals for this product are classified as Measurement 
Category None.
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For the FieldFox

No operator serviceable parts inside except for the lithium-ion 
battery. Refer servicing to qualified personnel. To prevent electrical 
shock do not remove covers. 

If this product is not used as specified, the protection provided by 
the equipment could be impaired. This product must be used in a 
normal condition (in which all means for protection are intact) when 
attached to the AC–DC adapter.

The unit may be used only in the operating conditions and positions 
specified by the manufacturer. 

Do not install substitute parts or perform any unauthorized 
modification to the product. Return the product to Keysight 
Technologies or a designated repair center for service to ensure that 
safety features are maintained.

Applicable local or national safety regulations and rules for the 
prevention of accidents must be observed in all work performed.

Ensure that the connections with information technology equipment 
comply with IEC950 I EN60950.

Observe all ratings and markings of the instrument before 
connecting the instrument.

Maximum Input Voltages and Power:

RF Output Connector: 50V DC, +23 dBm RF

Ext Trig/Ref Connector: 5.5 V DC

RF Input: 

    +27 dBm RF, ±50 VDC Max. (N991xA/B, N9925B, N9926A,       
      N9928A, N993xA/B)

    +23 dBm RF, ±50 VDC Max. (N9923A, N9923AN)

    +25 dBm RF, ±40 VDC Max. (N995xA/B, N996xA/B)

DC Input: 19VDC, 4ADC

When performing a measurement, ensure that the right safety and 
performance ratings of the instrument and accessories are used.

Do not expose the circuit or operate the instrument without its cover 
or while power is being supplied.

Do not operate the instrument in any environment at risk of 
explosion.
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Only Keysight approved accessories shall be used.

Cleaning connectors with alcohol shall only be done with the 
instruments power cord removed, and in a well-ventilated area. 
Allow all residual alcohol moisture to evaporate and the fumes to 
dissipate prior to energizing the instrument.

The power cord and connectors shall be compatible with the connector 
used in the premise electrical system. Failure to ensure adequate earth 
grounding by not using the correct components may cause product 
damage and serious injury.

The measuring terminals on this instrument are designed to be used with 
external signals described in Measurement Category NONE, but NOT with 
external signals described in Categories II, III, and IV. The input of this 
instrument cannot be connected to the mains.

It is not recommended to operate the FieldFox when it is laying on its back 
on a table top or other flat surface, with the kickstand folded in. The 
cooling is less effective when the FieldFox is placed lying down flat on 
back of the instrument.

Use original packaging or comparable for shipping or transporting the 
instrument.
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For the AC/DC Adapter

Use only the designated AC/DC adapter supplied with the 
instrument.

Use only the designated power cord supplied with the AC/DC 
adapter.

Operated at an ambient temperature: 0 to 40°C; full power rating; 
derate linearly at a rate of 3 watts per degree C, from 90W at 40°C 
to 45W at 55°C, 30W at –20°C.

Input: 100-240 VAC, 1.5-0.75A, 50-60 Hz

Output: 15 VDC, 6A

To prevent electrical shock, disconnect the AC to DC adapter from 
the mains before cleaning. Use a dry cloth or one slightly dampened 
with water to clean the external case parts. Do not attempt to clean 
internally.

When the FieldFox is connected to the AC/DC adapter, position the 
adapter so the power cord is readily accessible. The power cord is 
the disconnecting device. It removes main power to the AC/DC 
adapter. The FieldFox front panel switch is only for the DC power 
within the instrument, and not for the AC/DC adapter. Alternately, 
an AC switch or circuit breaker (which is readily identifiable and is 
easily reached by the operator) may be installed and used as a 
disconnecting device to remove mains power from the AC/DC 
adapter.

To avoid overheating, always disconnect the FieldFox from the 
AC/DC adapter before storing the FieldFox in the backpack.

If you prefer to leave the FieldFox connected to the AC/DC adapter 
while inside the backpack, you can disconnect the AC/DC adapter 
from its AC power source to prevent overheating.

Safety of any system incorporating the equipment is the 
responsibility of the assembler of the system.

This is a Safety Protection Class I Product (provided with a 
protective earthing ground incorporated in the power cord). The 
mains plug shall only be inserted in a socket outlet provided with a 
protective earth contact. Any interruption of the protective 
conductor inside or outside of the product is likely to make the 
product dangerous. Intentional interruption is prohibited.
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For the External Battery Charger (N9910X-872)

The AC/DC adapter has an auto–ranging line voltage input – be sure 
the supply voltage is within the specified range and voltage 
fluctuations do not to exceed 10 percent of the nominal supply 
voltage.

The AC/DC adapter is for indoor use only.

Never use a modified or damaged charger. Use the original AC–DC 
adapter ONLY.

The AC/DC adapter is designed for use in Installation Category II and 
Pollution Degree 2 per IEC 61010-1.

The instrument can operate with mains supply voltage fluctuations 
up to ± 10% of the nominal voltage.

Samples of this product have been type tested in accordance with the Keysight Environmental 
Test Manual and verified to be robust against the environmental stresses of Storage, 
Transportation and End-use; those stresses include but are not limited to temperature, humidity, 
shock, vibration, altitude and power line conditions. Test Methods are aligned with IEC 60068-2 
and levels are similar to MIL-PRF-28800F Class 3.

If charging batteries externally, use the optional external charger available 
from Keysight, or another SMBus charger of level II or higher.

Never use a non–SMBus charger because the battery issues commands 
over the SMBus to the charger to control the charge rate and voltage.

Never use a modified or damaged charger.

External AC/DC power 
supply, U.S. FCC 
compliance

Meets the required verification equipment authorization rules.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation.



 806                                                                                                                     Keysight N9938-90006 User’s Guide

Safety Considerations
For the Battery

For the Battery
Lithium battery packs may get hot, explode, or ignite and cause serious injury if 
exposed to abuse conditions. 

This section contains the following:

— “High Capacity Lithium Battery (N9910X-876)”

— “Standard Capacity Battery (N9910X-870)”
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High Capacity Lithium Battery (N9910X-876)

Lithium battery (High Capacity): N9910X-876 (battery Keysight part number: 
1420-0937) is used to provide power to a family of portable microwave test 
instruments produced by Keysight Technologies. Be sure to follow these safety 
warnings: 

External battery, U.S. 
FCC compliance

Battery storage:

 The only instructions related to storage have to do with temperature and are listed below

— “Temperature (1 month): -20°C to +45°C

— “Temperature (6 month): -20°C to +40°C

— “Temperature (12 month): -20°C to +35°C

Rating: 10.8V 6400mAh 70Wh

Lithium–ion batteries:

— Must not be exposed to high temperatures (>70°C) or fire.

— Must be kept away from children.

— Must not be short circuited.

— Must be replaced only with Keysight qualified Li–ion batteries.

— If replaced or charged improperly, there is a danger of explosion.

Do not connect the positive terminal and negative terminal of the 
battery to each other with any metal object (such as wire).

Do not carry or store the battery with necklaces, hairpins, or other 
metal objects.

Do not pierce the battery with nails, strike the battery with a 
hammer, step on the battery, or otherwise subject it to strong 
impacts or shocks.

Do not solder directly onto the battery.

Do not expose the battery to water or salt water, or allow the 
battery to get wet.

Do not disassemble or modify the battery. The battery contains 
safety and protection devices, which if damaged, may cause the 
battery to generate heat, explode, or ignite.
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Do not place the battery in direct sunlight, or use or store the 
battery inside cars in hot weather. Doing so may cause the battery 
to generate heat, explode, or ignite. Using the battery in this 
manner may also result in a loss of performance and a shortened 
life expectancy.

There is a danger of explosion if the battery is incorrectly replaced. 
Replace only with the same or equivalent type of battery 
recommended. Discard used batteries according to manufacturer’s 
instructions.

If you are charging the batteries internally, even while the FieldFox 
is powered off, the FieldFox may become warm. Allow for proper 
ventilation.

Do NOT run the FieldFox with the vents blocked or in the carrying 
case.

Do not discharge the battery using any device except the FieldFox 
or the external battery charger (N9910X–872). When the battery is 
used in a device other than those specified, it may damage the 
battery or reduce its life expectancy. If the device causes an 
abnormal current to flow, it may cause the battery to become hot, 
explode, or ignite and cause serious injury. 

The external battery charger discharges during recalibration.

For a Korean battery safety consideration translation, refer to 
Appendix D:, “Korean Battery Safety Translation.”

For a Russian battery safety consideration translation, refer to 
Appendix E:, “Russian Battery Safety Translation.”

The external battery is not rated for use in a wet location. Do not use 
the external battery in a wet location.



Keysight N9938-90006 User’s Guide                                                                                                                      809

Safety Considerations
For the Battery

Standard Capacity Battery (N9910X-870)

Lithium–ion batteries:

— Must not be exposed to high temperatures (>70°C) or fire.

— Must be kept away from children.

— Must not be short circuited.

— Must be replaced only with Keysight qualified Li–ion batteries.

— If replaced or charged improperly, there is a danger of explosion.

Do not connect the positive terminal and negative terminal of the 
battery to each other with any metal object (such as wire).

Do not carry or store the battery with necklaces, hairpins, or other 
metal objects.

Do not pierce the battery with nails, strike the battery with a 
hammer, step on the battery, or otherwise subject it to strong 
impacts or shocks.

Do not solder directly onto the battery.

Do not expose the battery to water or salt water, or allow the 
battery to get wet.

Do not disassemble or modify the battery. The battery contains 
safety and protection devices, which if damaged, may cause the 
battery to generate heat, explode, or ignite.

Do not place the battery in direct sunlight, or use or store the 
battery inside cars in hot weather. Doing so may cause the battery 
to generate heat, explode, or ignite. Using the battery in this 
manner may also result in a loss of performance and a shortened 
life expectancy. 

There is a danger of explosion if the battery is incorrectly replaced. 
Replace only with the same or equivalent type of battery 
recommended. Discard used batteries according to manufacturer’s 
instructions.

If you are charging the batteries internally, even while the FieldFox 
is powered off, the FieldFox may become warm. Allow for proper 
ventilation.
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Safety Considerations
For the Battery

Do not discharge the battery using any device except the FieldFox 
or the external battery charger (N9910X–872). When the battery is 
used in a device other than those specified, it may damage the 
battery or reduce its life expectancy. If the device causes an 
abnormal current to flow, it may cause the battery to become hot, 
explode, or ignite and cause serious injury.

For a Korean battery safety consideration translation, refer to 
Appendix D:, “Korean Battery Safety Translation.”

For a Russian battery safety consideration translation, refer to 
Appendix E:, “Russian Battery Safety Translation.”
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Battery Protective Functions
This section contains the following:

— “Battery Protective Functions (N9910X-876)”

— “Battery Protective Functions (N9910X-870)” on page 813

Battery Protective Functions (N9910X-876)

The following protective functions are designed into the lithium-ion 
rechargeable battery system used in FieldFox. 

The protective functions can be divided between two categories: active and 
passive. Active protection refers to the type of protection that depends on at 
least two or more protection devices working together to enable the protection   
Passive protection refers to the type of protection that is always enabled 
independent of any other protection device. 

Active Protection

Primary Overcharge Voltage: This prevents the battery from being charged if 
the voltage across any cell exceeds approximately 4.25 V per cell. Once the 
overcharge protection is tripped, the voltage across each cell must drop below 
approximately 4.10 V to reset the protection and permit charging. 

Overdischarge Voltage: This prevents the battery from discharging if the 
voltage across any cell drops below approximately 2.5 V. Once the 
overdischarge voltage protection is tripped, the voltage across each cell must 
be charged to approximately 3 V to reset the protection and permit 
discharging.

Primary Overcharge Current: This prevents the battery from being charged if 
the average charging current reaches or exceeds 3.3A for a time period of 5 
seconds or more. 

Primary Overdischarge Current: This prevents the battery from being 
discharged if the average current out of the battery reaches or exceeds 7A for a 
time period of 5 seconds or more. This protection can be reset by removing the 
load. 

Short Circuit Protection: This prevents the battery from being charged or 
discharged and protects against damage or lost data if the current in or out of 
the battery reaches or exceeds 33.3A for a time period of 274.5 microseconds 
or more. This protection can be reset by removing the load. 

Overtemperature Charging: The system microcontroller prevents the battery 
from being charged if the cell temperature exceeds 48C. Once the 
overtemperature charging protection is tripped, the cell temperature has to 
drop to or below 43C to reset the protection and permit charging.
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Overtemperature Discharging: The system microcontroller prevents the 
battery from being discharged if the cell temperature exceeds 67C. Once the 
overtemperature discharging protection is tripped, the battery is automatically 
shut off which results in turning off the instrument as well. 

Passive Protection

Reverse Charging: A reverse protection diode prevents against damage or lost 
data due to a reverse charge polarity applied to the battery terminals. 

Primary Overtemperature: The maximum operating temperature of this fuse is 
85C. An overtemperature cutout permanently opens at 85C with no recovery. 

Secondary Overtemperature: A second PTC polyfuse built into each Li-ion cell 
will open up and limit current flow at high currents.

Tertiary Overtemperature: A current interrupt device (CID) within each Li-ion 
cell will permanently open up when an individual cell’s internal pressure is too 
high. As each cell fuse is permanently interrupted, overall battery performance 
will become severely degraded, up to and including disabling the battery.
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Battery Protective Functions (N9910X-870)

The following protective functions are designed into the lithium-ion 
rechargeable battery system used in FieldFox. 

The protective functions can be divided between two categories: active and 
passive. Active protection refers to the type of protection that depends on at 
least two or more protection devices working together to enable the protection   
Passive protection refers to the type of protection that is always enabled 
independent of any other protection device. 

Active Protection

Primary Overcharge Voltage: This prevents the battery from being charged if 
the voltage across any cell exceeds approximately 4.35 V per cell. Once the 
overcharge protection is tripped, the voltage across each cell must drop below 
approximately 4.15 V to reset the protection and permit charging. 

Secondary Overcharge Voltage: This is a one-time, permanent protection that 
is triggered when the voltage across any cell exceeds approximately 4.45 V. 
Once this protection is tripped, the battery can no longer be used and must be 
replaced.

Overdischarge Voltage: This prevents the battery from discharging if the 
voltage across any cell drops below approximately 2.6 V. Once the 
overdischarge voltage protection is tripped, the voltage across each cell must 
be charged to approximately 3 V to reset the protection and permit 
discharging.

Primary Overcharge Current: This prevents the battery from being charged if 
the average charging current reaches or exceeds 3.5A for a time period of 120 
seconds or more. 

Secondary Overcharge Current: This prevents the battery from being charged 
if the charging current reaches or exceeds 4A+/–20% for a time period of 20 
milliseconds or more. 

Primary Overdischarge Current: This prevents the battery from being 
discharged if the average current out of the battery reaches or exceeds 5A for a 
time period of 120 seconds or more. This protection can be reset by removing 
the load. 

Secondary Overdischarge Current: This prevents the battery from being 
discharged if the current out of the battery reaches or exceeds 6A for a time 
period of 20 milliseconds or more. This protection can be reset by removing the 
load. 

Short Circuit Protection: This prevents the battery from being charged or 
discharged and protects against damage or lost data if the current in or out of 
the battery reaches or exceeds 12.5A for a time period of 183 microseconds or 
more. This protection can be reset by removing the load. 
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Overtemperature Charging: The system microcontroller prevents the battery 
from being charged if the cell temperature exceeds 46C. Once the 
overtemperature charging protection is tripped, the cell temperature has to 
drop to or below 45C to reset the protection and permit charging.

Overtemperature Discharging: The system microcontroller prevents the 
battery from being discharged if the cell temperature exceeds 65C. Once the 
overtemperature discharging protection is tripped, the battery is automatically 
shut off which results in turning off the instrument as well. 

Passive Protection

Reverse Charging: A reverse protection diode prevents against damage or lost 
data due to a reverse charge polarity applied to the battery terminals. 

Primary Overtemperature: A PTC (positive temperature coefficient) polyfuse in 
series between the Li-ion cells and the charging and discharging transistors 
will open up and limit current flow to the battery terminals as a function of very 
high currents. This protection is resettable once the overstress condition is 
removed. 

Secondary Overtemperature: A second PTC polyfuse built into each Li-ion cell 
will open up and limit current flow as a function of very high currents.

Tertiary Overtemperature: A current interrupt device (CID) within each Li-ion 
cell will permanently open up when an individual cell’s internal pressure is too 
high. As each cell fuse is permanently interrupted, overall battery performance 
will become severely degraded, up to and including disabling the battery.

Overcurrent Fuse: This is a one-time blow fuse with a rated current of 12A.

Batteries: Safe Handling and Disposal
Refer to battery manufacture Safety Data Sheet (SDS) for safe handling and 
disposal information. Battery SDS's are located at: 
https://regulations.about.keysight.com/msds/default.htm

Battery Transportation
Batteries are generally subject to transportation regulations, refer to the 
battery Safety Data Sheet (SDS) and contact your shipping department for 
transportation requirements.
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Environmental Requirements
Refer to the FieldFox Specifications in “Specifications/Data Sheet” on 
page 829.

Electrical Requirements
The FieldFox allows you to use either the lithium-ion battery or the AC/DC 
adapter - both are included. 

Electrostatic Discharge (ESD) Precautions
The FieldFox was constructed in an ESD protected environment. This is 
because most of the semiconductor devices used in this instrument are 
susceptible to damage by static discharge.

Static charges are generated in numerous ways, such as simple contact, 
separation of materials, and normal motions of persons working with the 
FieldFox. To prevent instrument damage, practice industry accepted 
techniques for handling static sensitive devices when using the FieldFox. 

Very often, coaxial cables and antennas also build up a static charge, which, if 
allowed to discharge by connecting to the FieldFox, may damage the 
instrument input circuitry. To avoid such damage, it is recommended to 
dissipate any static charges by temporarily attaching a short to the cable or 
antenna prior to attaching to the instrument. 

FieldFox Markings
The table below lists the definitions of markings that may be on or with the 
product. Familiarize yourself with each marking and its meaning before 
operating the instrument.

All labels and symbols may not apply to the instrument.

This symbol marks the standby position of the power line switch.

This symbol marks the ON position of the power line switch.
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This symbol marks the OFF position of the power line switch.

This symbol indicates that the input power required is AC.

This symbol indicates DC voltage

This symbol indicates a three-phase alternating current.

This symbol indicates Frame or chassis Terminal.

The instruction documentation symbol. The product is marked with this symbol 
when it is necessary for the user to refer to the instruction in the documentation.

This symbol indicate the presence of a Laser device.

This symbol indicates the surface can be hot.

This symbol indicated the product is sensitive to electrostatic discharge.

This symbol identifies the Protective Conductor terminal.

This symbol indicates the equipment is protected throughout by double or 
reinforced insulation.

The CE mark is a registered trademark of the European Community (if accompanied 
by a year, it is the year when the design was proven). It indicates that the product 
complies with all the relevant directives.

The UK conformity mark is a UK government owned mark. Products showing this 
mark comply with all applicable UK regulations.

The Keysight email address is required by EU directives applicable to our product.

The CSA mark is a registered trademark of the CSA International.
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Two person lift required.

Canada EMC label.

Interference-Causing Equipment Standard for industrial, scientific and medical (ISM) 
equipment. Matériel industriel, scientifique et médical (ISM).

CE/ICES/ISM label. (Old mark for reference only.)

This is a space saver label that combines three markings - CE with CAN ICES and ISM (see 
above) and ISM (see below).

This is a space saver label that combines three markings - CE with CAN ICES and ISM (see 
above) and ISM (see below).

The RCM mark is a registered trademark of the Australian Communications and 
Media Authority.

This is a space saver label that combines two markings - CAN ICES and ISM.

This is a symbol of an Industrial Scientific and Medical Group 1 Class A product (CISPR 11, 
Clause 5).

South Korean Certification (KC) mark. It includes the marking’s identifier code.

The crossed-out wheeled bin symbol indicates that separate collection for 
waste electric and electronic equipment (WEEE) is required, as obligated by the 
EU DIRECTIVE and other National legislation. Please refer to 
www.keysight.com/go/takeback to understand your trade-in options with 
Keysight, in addition to product takeback instructions.

China Restricted Substance Product Label. The EPUP (environmental protection use 
period) number in the center indicates the time period during which no hazardous or 
toxic substances or elements are expected to leak or deteriorate during normal use 
and generally reflects the expected useful life of the product.

Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455-2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.

This mark indicates product has been designed to meet the requirements of “IP x y”, 
where “x” is the solid particle protection and “y” is the liquid ingress protection.
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Battery Markings
The table below lists the definitions of markings that may be on or with the 
product. Familiarize yourself with each marking and its meaning before 
operating the instrument.

All labels and symbols may not apply to the instrument.

The CE marking is a registered trademark of the European Community (if 
accompanied by a year, it is the year when the design was proven). It indicates 
that the product complies with all relevant directives.

Eurasian Conformity Mark indicating conformance to all technical regulations of 
the Eurasian Customs Union.

Dispose of properly. Do not throw batteries away—collect as small chemical waste.

Recycle the old battery properly. Consult local or country regulations related to 
disposal.

Keep battery away from excessive heat. Do not dispose of by burning.

Taiwan recycling symbol.

The RCM Mark is a registered trademark of the Australian Communications and 
Media Authority.

Korean Certification (KC) mark.

India mark from the Bureau of Indian standards. IS 13252 is the equivalent India 
standard to IEC 60950-1.
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GOST, Russia’s safety and EMC mark.

The UL Marks are registered certification marks of Underwriters Laboratories Inc. 
(UL). It means that UL has tested and evaluated representative samples of that 
product and determined that it meets UL's safety requirements. When 
accompanied by a 'C' and 'US', it indicates compliance to both Canadian and US 
requirements.

Taiwan’s safety and EMC compliance mark.

Indicates the time period which no hazardous or toxic substance elements are 
expected to leak or deteriorate during normal use. Ten years is the expected 
useful life of the product.

This symbol indicates the Environmental Protection Use Period (EPUP) for the 
product’s toxic substances and for the China RoHS requirements.

The UK conformity mark is a UK government owned mark. Products showing this 
mark comply with all applicable UK regulations.

The CSA mark is a registered trademark of the CSA international.

Canada EMC label. 
Interference-Causing Equipment Standard for industrial, scientific and medical 
(ISM) equipment. Matériel industriel, scientifique et médical (ISM). 

CE/ICES/ISM label. This is a space-saver label that combines three markings — CE 
with CAN ICES (see above) and ISM (see below). 

The RCM mark is a registered trademark of the Australian Communications and 
Media Authority.

This is a combined marking to indicate product compliance with the Industry 
Canadian Interference-Causing Equipment Standard (ICES/NMB-001). This is 
also a symbol of an Industrial Scientific and Medical Group 1 Class A product 
(CISPR 11, Clause 5).

This is a symbol of an Industrial Scientific and Medical Group 1 Class A product 
(CISPR 11, Clause 5).

South Korean Certification (KC) mark. It includes the marking’s identifier code.
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Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455-2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.

This symbol marks the standby position of the power line switch.

This symbol marks the ON position of the power line switch.

This symbol marks the OFF position of the power line switch.

This symbol indicates the input power required is AC.

This symbol indicates DC voltage.

This symbol indicates a three-phase alternating current.

This symbol indicates frame or chassis terminal.

This symbol indicates the presence of a laser device.

This symbol identifies the Protective Conductor Terminal.

This symbol indicates the equipment is protected throughout by double or 
reinforced insulation.
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Packaging Markings

AC/DC Adapter Markings
The table below lists the definitions of markings that may be on or with the 
product. Familiarize yourself with each marking and its meaning before 

operating the instrument.

Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455–2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.

All labels and symbols may not apply to the instrument.

The UL Marks are registered certification marks of Underwriters Laboratories Inc. 
(UL). It means that UL has tested and evaluated representative samples of that 
product and determined that it meets UL's safety requirements. When 
accompanied by a 'C' and 'US', it indicates compliance to both Canadian and US 
requirements.

NOM Mark (Normality of Mexico) indicates that the product was tested by an 
accredited laboratory in Mexico and meets Mexico’s safety requirements.

Japan’s safety and EMC compliance mark.

China’s safety and EMC compliance mark.

Taiwan’s safety and EMC compliance mark.

Singapore’s safety mark.
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Korean Certification (KC) mark; includes the marking’s identifier code.

GOST, Russia’s safety and EMC mark.

AC (Alternating Current).

Direct current (DC) equipment

CAUTION, risk of danger, refer to safety information in manual.

DC connector polarity

Ingress Protection Code

Operating instructions should be considered when operating the device.

U.S. Energy efficiency rating

Eurasian Conformity Mark indicating conformance to all technical regulations of 
the Eurasian Customs Union.

UL component mark. Recognized in Canada and the United States.

Operation for indoors only.
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India mark from the Bureau of Indian standards. IS 13252 is the equivalent India 
standard to IEC 60950-1.

IRAM/S-mark is the safety mark for Argentina.

The crossed out wheeled bin symbol indicates that separate collection for waste 
electric and electronic equipment (WEEE) is required, as obligated by the EU 
DIRECTIVE and other National legislation.

Please refer to keysight.com/go/takeback to understand your Trade in 
options with Keysight in addition to product takeback instructions.

Dispose of properly

The UK conformity mark is a UK government owned mark. Products showing this 
mark comply with all applicable UK regulations.

The CSA mark is a registered trademark of the CSA international.

Canada EMC label. 
Interference-Causing Equipment Standard for industrial, scientific and medical 
(ISM) equipment. Matériel industriel, scientifique et médical (ISM). 

CE/ICES/ISM label. This is a space-saver label that combines three markings — CE 
with CAN ICES (see above) and ISM (see below). 

The RCM mark is a registered trademark of the Australian Communications and 
Media Authority.

This is a combined marking to indicate product compliance with the Industry 
Canadian Interference-Causing Equipment Standard (ICES/NMB-001). This is 
also a symbol of an Industrial Scientific and Medical Group 1 Class A product 
(CISPR 11, Clause 5).

This is a symbol of an Industrial Scientific and Medical Group 1 Class A product 
(CISPR 11, Clause 5).

South Korean Certification (KC) mark. It includes the marking’s identifier code.

Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455-2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.
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Certification and Compliance Statements

Certification

Keysight Technologies, Inc. certifies that this product met its published 
specifications at the time of shipment from the factory. Keysight Technologies, 
Inc. further certifies that its calibration measurements are traceable to the 
United States National Institute of Standards and Technology, to the extent 
allowed by the Institute's calibration facility, and to the calibration facilities of 
other International Standards Organization members. 

This symbol marks the standby position of the power line switch.

This symbol marks the ON position of the power line switch.

This symbol marks the OFF position of the power line switch.

This symbol indicates the input power required is AC.

This symbol indicates DC voltage.

This symbol indicates a three-phase alternating current.

This symbol indicates frame or chassis terminal.

This symbol indicates the presence of a laser device.

This symbol identifies the Protective Conductor Terminal.

This symbol indicates the equipment is protected throughout by double or 
reinforced insulation.
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Manufacturer’s Declaration

This product has been designed and tested in accordance with accepted 
industry standards, and has been supplied in a safe condition. The 
documentation contains information and warnings that must be followed by 
the user to ensure safe operation and to maintain the product in a safe 
condition. 

Declaration of Conformity

Should the Declaration of Conformity be required, visit:

http://www.keysight.com/go/conformity. 

For more information, see “Where to Find the Latest Information” on page 3.

EMC

Complies with the following standards (dates and editions are cited in the 
Declaration of Conformity):

— CISPR Pub 11 Group 1, class B

— AS/NZS CISPR 11

— ICES/NMB-001

This ISM device complies with the Industry Canada Interference-Causing 
Equipment Standard (ICES-001); 
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

Safety

Complies with the European Low Voltage Directive 

— IEC/EN 61010-1 

— Canada: CSA C22.2 No. 61010-1

— U.S.A.: UL std no. 61010-1

Acoustic Statement (European Machinery Directive)

Acoustic Noise Emission

LpA <70 dB

Operator position

Normal operation position per ISO 7779
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A: Connector Care Review

Proper connector care and connection techniques are critical for accurate and 
repeatable measurements. The following table contains for tips on connector 
care.

Prior to making connections to your analyzer, carefully review the information 
about inspecting, cleaning, and gauging connectors. For course numbers 
about additional connector care instruction, contact Keysight Technologies. 
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Handling and Storage

Do Do Not

— Keep connections clean

— Extend sleeve or connector nut

— Use plastic end-caps during storage

— Touch mating-plane surfaces

— Set connectors contact-end down

— Store connectors or adapters loose

Visual Inspection

Do Do Not

— Inspect all connectors carefully

— Look for metal particles, scratches, and dents

— Use a damaged connector—ever

Connector Cleaning

Do Do Not

— Try compressed air first

— use isopropyl alcohola

— Clean connector threads

a. Cleaning connectors with alcohol shall only be done with the DC power cord removed, in a well-venti-
lated area, and with the power to the FieldFox turned OFF. Allow all residual alcohol moisture to evapo-
rate, and the fumes to dissipate prior to energizing the instrument.

— Use any abrasives

— Get liquid into plastic support beads

Gaging Connectors

Do Do Not

— Clean and zero the gage before use

— Use the correct gage type

— Use correct end of calibration block

— Gage all connectors before first use

— Use an out-of-specification connector

Gaging Connectors

Do Do Not

—  connectors carefully

— Make preliminary connection contact lightly

— Turn only the connector nut

— Use a torque wrench for final connection

— Apply bending force to connection

— Over Tighten preliminary connection

— Twist or screw any connection

— tighten past torque wrench “break” point
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B: Specifications/Data Sheet

To ensure the highest accuracy and consistency, the FieldFox Specifications 
are now stored ONLY at: 
https://www.keysight.com/us/en/assets/7018-06516/data-sheets/5992-37
02.pdf.
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C: Instrument Calibration

Over time, the active components in the FieldFox age and the performance 
may degrade or drift. To ensure that the FieldFox is performing to the 
published specifications, you should have an instrument calibration performed 
periodically.

How Often Should Calibrate My Instrument?
You determine the calibration period which best meets your requirements. 
However, a 12 month calibration cycle is appropriate for most users.

There are two things to consider: performance drift and connector wear. 

The instrument specifications are set to consider the performance drift that 
may occur over a 12 month period. Therefore, getting the instrument 
calibrated at 12 month intervals ensures that the analyzer maintains 
performance within the operating specifications. If you need the analyzer to 
maintain more consistent operation, you may want to have the instrument 
calibrated more often.

Connector wear is a bigger factor and depends on the number of connections 
that are made. The test ports become noticeably worn after 500 to 700 
connections. This could represent about 12 months with average use. With 
more frequent connections, the calibration cycle should be sooner. You can 
extend the time between calibrations and thereby save money by using 
connector savers and by performing proper Connector Care. Learn more in 
“Connector Care Review” on page 827.

How do I Get an Instrument Calibration?

To get your Keysight instrument calibrated, send it to one of the Keysight 
Technologies service centers. Please visit this website to learn how: 
www.keysight.com/find/calibration.
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What Are My Choices of Instrument Calibration?

What Are My Choices of Instrument Calibration?
The following types of instrument calibration are available from Keysight 
Technologies service center:

Keysight Calibration Includes the test data from the calibration and the 
certificate of calibration, stating the instrument has been 
calibrated and is operating within the published 
specifications.

ANSI Z540 
Calibration

Includes the test data from the calibration and the 
certificate of calibration, stating the instrument has been 
calibrated using a process in compliance with ANSI 
Z540.1 and is operating within the published 
specifications

ISO 17025 
Calibration

Includes the test data from the calibration and the certificate of 
calibration, stating the instrument has been calibrated using a process in 
compliance with ISO 17025 and is operating within the published 
specifications.Chapter 3, “CAT (Cable and Antenna Test) Mode.”



 833

Keysight Handheld Analyzers
N99xxB User’s Guide

D: Korean Battery Safety Translation
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E: Russian Battery Safety Translation
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Russian Battery Safety Translation
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Russian Battery Safety Translation
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Russian Battery Safety Translation
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Russian Battery Safety Translation
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Russian Battery Safety Translation
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Russian Battery Safety Translation
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F:  Keysight Software End-User Licensing Agreement (EULA)
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Numerics

1-port cable loss 
measurements

CAT mode, 60
1-port cable loss, CAT 

mode, 61
1-Port Cable Trimming VVM 

Measurements, 593
1-Port Cable Trimming, VVM 

measurements, 585
2-port insertion loss 

measurements, 593
CAT mode, 62

2-port insertion loss 
measurements, CAT 
mode, 62

2-port transmission 
measurements

VVM mode, 595
2-port transmission 

measurements, VVM 
mode, 595

5G NR EVM Conducted 
features, 352

5G NR features, 349
89600 VSA software, 507

A

ABC keyboard, 749
AC/DC adapter

markings, 821
power requirements, 29
using, 795

AC/DC adaptermarkings
using, 801

accessories, 26
Adjacent Channel Power 

(ACPR), 220
Alias Faults, 73, 86
align all now,alignments, 203
alignments,align all now, 203
alignments,individual, 201
alignments,overview, 201
all about markers, 700

AM FM Tune & Listen, 166, 170
AM/FM Metrics, error 

messages, 617
AM/FM Metrics, Option 

355, 607
AM/FM Metrics,error 

messages, 617
Amplitude Alignment, 206

InstAlign, 272
EMI, 330
IQA, 310, 677

RF Burst, 206
Antenna Corrections, 161, 163, 

640, 646
Antenna, Option 360, 405
appendix B, 827, 829
attenuation, 159, 257, 303, 321
Audio Beep, 213
Average Type, 199, 271, 330
Averaging

VVM, 590
averaging, 54, 102, 722

VVM, 590
avoid overpowering, 36

B

Band Power Marker IQA, 306
Band Power Marker SA 

mode, 211, 306, 307, 309, 714
Band Span Marker IQA, 307
bandpass mode, 67, 68
battery

care, 798
charge status, viewing, 793
charge status,viewing, 726, 

793
charging, 31

external, 797
internal, 795

disposal, 799
gauge, 794
icons, 793
installing, 30
LED, 797

markings, 818
maximizing life, 798
protective functions, 811, 813
safe handling, 814
saver, 743
service diagnostics, 794
viewing charge status, 30

Big Marker IStates, 110
big marker states, 110
bridge cancellation 

measurements, VVM 
mode, 595

brightness
display, 729

Built-in Power Meter, 537

C

Cable (Correction) 
Specifications

DTF, 69, 81
cable and antenna test See 

CAT
cable loss measurements, 60, 

61
cable specifications, DTF, 70
Cal On ?, 142
Calculated DTF values, 73, 85
calibration

Cal On ?, 142
CAT and NA modes, 125
noise figure, 687
type, 136
verifying integrity, 144

Calibration Type, 136
Calibration Wizard

Wizard,calibration, 687
CalReady, 127

properties, 142
CalReady Properties, 142
Capture Data IQA, 291
care of the battery, 798
CAT mode

1-port cable loss 
measurements, 60
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2-port insertion loss 
measurements, 62

calibration, 125
DTF settings, 66, 78, 91, 115, 290
return loss measurements, 60
settings, 51, 533, 534

CAT mode measurements, 531
certification statements, 824
Channel Power (CHP), 216
channel scanner, option 

312, 621
Channel Selection, 155
charge status, viewing, 726, 793
charging the battery

externally, 797
internally, 795

cleaning the screen, 40
colors, display, 729
compliance statements, 824
compressed measurement, 160, 

258
Compressed SA 

Measurements, 160, 258
connector care review, 827
considerations, safety, 801
Contacting Keysight, 5
Continuous Peak Search 

Marker IQA, 309
Control, Fan, 772
control, temperature, 33
Couple Markers IQA, 307
Coupled Frequency, 58, 68
Coupled Markers, 703
cursor moving, 789
cursor, moving, 781, 789, 791

D

data analysis features, 699, 777
data indicator (*), old, 214
data indicator, old (*), 214
Data Logging, 394
Date and Time Setting, 764
Date and Time setting, 746
date/time setting, 746, 762
declaration of conformity, 825
delta marker, 701, 702
delta markers, 701
Detection Method, 208, 270, 330
detection method, 208, 270, 330
display

brightness, 729

colors, 729
front panel, 44
preferences, 742
settings, 729

display "live" and memory 
traces, 584

Display Resolution
VVM, 588

disposal of battery, 799
dissipate static charge, 37
DTF

measurements, 63, 64
settings, 66, 78, 91, 115, 290
start and stop distance, 64

DTF Measurement, 66, 78
DTF settings, 66
DTF Start and Stop 

Distance, 67, 79
Dynamic Range, 112
dynamic range, 112

E

ECal, 131
Edit a Cable File, 70

DTF, 70, 82
edit keywords, 789
edit, enable and disable the 

current prefix, 789, 791
edit, enable and disable the 

current suffix, 789, 790
Electrical Delay, 101
Electromagnetic 

Interference, 313
EMF

measurements,how to 
make, 390

set up, 387
settings, 226, 387, 732

EMF Settings, 226
EMI

measurements,about, 333
EMI Glossary, 336
EMI mode

settings, 335
units, 320

EMI Mode Units, 320
Enhanced Response 

Optimization, 141
Erase User Data, 770
error

meas UNCAL, 183, 184, 214

red flashing LED, external 
battery charger, 797

red red flashing LED, external 
battery

charger, 797
systematic, 126

error messages, AM/FM 
Metrics, 617

Error messages, fan, 773
ERTA, 597
ESD, 815
Event Log, 770
external frequency 

reference, 760
External Gain, 158, 256, 320
External triggering, 105, 192, 264
external triggering, 192, 264
external zeroing, 547

F

Fan Control, 772
Fan, error messages, 773
features, 5G NR, 349
features, 5G NR EVM 

Conducted, 352
features, overview, 25
FFT Gating, 196
Field Strength 

Measurements, 161, 640
File Management, 777
file management, 777
file,license, 755
files

managing, 786
prefixes, 789, 791
suffixes, 789

FM Tune & Listen, 166, 170
FM tune and listen, 43
folders, 788
Format

NA Mode, 98
format, NA mode, 98
FoxTrot, 597
FreqMaskTrigger, 525
frequency

context, setting, 673
external reference, 760
mode, DTF, 67
range, NA mode, 99
range, setting, 53, 673
range, step size, 153
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step size, 153
Frequency Counter at SA 

Marker, 212, 714
frequency extender

settings, 732
viewing and changing, 733

Frequency Offset Using Power 
Sensor, 557

Frequency Range
NA Mode, 99

front panel, 38
Full Screen Mode, 731

G

Gating, 122
gating, 122
Gating, FFT, 196
gauge, battery, 794
getting started information, 29
glossary,EMI, 336
glossary,OTA, 400
GPS, 746
group delay, 98, 99

H

high-temperature 
protection, 32

hold, 726
how to

change
frequency step size, 151, 

153, 254, 318
units to feet, 73, 85

check for a compressed 
measurement, 160, 258

control the preamp, 160, 258, 
304, 323, 326

create
delta marker, 702
markers, 700

edit keywords, 789
edit, enable and disable the 

current prefix, 791
enter

numeric values, 46
make

1-port cable loss 
measurement, 6
0, 61

2-port insertion loss 
measurement, 6
2

DTF measurements, 64, 
76

manage files, 786
measure return loss, 60
monitor the internal FieldFox 

temperature, 32
move

cursor, 781, 791
reference marker, 702

name files, 780
perform

O, S, L cal, 129
O,S, L cal, 129
single sweep while in 

Hold, 726
preset, 727
recall an *.sta file, 782
save

display settings as 
preferences, 742

file, 778
select

CAT mode, 51, 534
CAT mode 

measurements, 
51, 534

EMI mode, 318
NA formats, 98
RTSA mode, 254
SA mode, 151, 254

set
attenuation, 159, 257, 

303, 321
bandpass mode ON, 68
date and time, 762
frequency context, 673
frequency range, 53, 151, 

254, 255, 318, 319, 
673

output power, 57, 107, 
590

power meter display 
units, 551

res BW, 182, 263, 326, 677
resolution, 56, 104
scale, 53, 722

sweep time, 56
sweep type, 55, 104
trace averaging, 54, 55, 

722, 723
video BW, 183, 184

use
external reference, 760

view and change Quick 
Settings, 97

view and change quick 
settings, 96

How to set a Band
CISPR, 323

How to set a Traces
EMI, 328

https
//www.keysight.com/us/en/a

ssets/7018-04493/applicat
ion-notes/5991-4913.pdf, 
614

I

icons, battery, 793
IF Bandwidth

NA Mode, 103
VVM, 589

IF bandwidth
NA Mode, 103

IF Output, 185
IF output, 185
indicator (*), old data, 214
individual,alignments, 201
initial use, preparing for, 29
input voltages and power, 

maximum, 36
insertion loss 

measurements, 62
InstAlign, 206, 272, 310, 330, 677
installing battery, 30
Interference Analyzer, 513
interference rejection, 58
Interpolation, 142
Interval Power Marker, 211, 306, 

307, 309
Interval Power Marker IQA, 306
Interval Span Marker IQA, 307
IQ Analyzer, 285
IQA

markers,using, 305
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measurement,parameters, 29
4

measurements,about, 289
measurements,how to 

make, 290
trace display states, 310

IQA mode
settings, 290

IQA, Captrure Data, 291
Isolation, 139

K

Keyboard,ABC, 749
Keyboard,Qwerty, 749
keywords, 789

L

LAN Settings, 765
language, settings, 743
latest information, where to 

find, 27
LED

battery, 797
on/off settings, 32

license
file, 755
option, 755

Licensing, 754
Limit Lines, 715
Limit lines, 715

saving and recalling, 718
lithium-ion battery, 

installing, 30
logging, data, 394

M

Magnitude Offset, 100
magnitude offset, 100
Manage Files, 786
Manage Folders, 788
managing

files, 786
folders, 788

manuals, 27
mapping

settings, 732
Mapping mode

settings, 471, 474
Mapping, Option 352, 457

Mapping,Record/Playback, 494
marker

table, 702
markers, 700

Coupled (NA Mode), 703
creating, 700
delta, 701
moving, 700
search function, 704, 706
table, 702
trace, 704
trace (CAT & NA Mode), 704
trace (SA Mode), 704

markers,using
IQA, 305

markings
AC/DC adapter, 821
battery, 818
FieldFox, 815
packaging, 821

math
operations, 721

maximizing battery life, 798
maximum input voltage and 

power, 36
Meas UNCAL error, 214
meas UNCAL error, 183, 184
measurement selection, EMI 

Mode, 313
measurement selection, IQA 

Mode, 285
measurement selection, 

Mapping Mode, 457
measurement selection, NA 

Mode, 89
measurement selection, OTA 

Mode, 337
measurement selection, 

Phased Array Antenna 
Mode, 405

measurement selection, USB 
antenna Mode, 445

measurement,parameters
IQA, 294

Measurements
EMI, 333
IQA, 289
OTA, 342
PAA, 408
Phased Array Antenna, 408
USB antenna, 449

measurements

1-port cable loss 
measurements, CAT 
mode, 60

1-port cable loss, CAT 
mode, 60

2-port insertion loss, CAT 
mode, 62

bridge cancellation, VVM 
mode, 595

compressed, 160, 258
return loss, 60
selection, 51, 534
selection, reflection, 534

measurements,about
EMI, 333
IQA, 289
OTA, 342
Phased Array Antenna, 408
USB antenna, 449

meausrements,how to make
EMF, 390
IQA, 290
Mapping, 471
OTA, 353
PAA, 417
USB antenna, 229, 451

mini-USB port, sending SCPI 
commands, 775

Mixed-Mode S-Parameters, 92
mixed-mode S-parameters, 92
mode, 507

EMI, 313
IQA, 285
Mapping, 457
NA, 89
OTA, 337
Phased Array Antenna, 405
power meter, 537
RTSA, 254
SA, 147, 151, 251, 513, 531, 541, 

557
temperature control, 33
USB antenna, 445
VVM, 585

move
cursor, 781, 789, 791
reference marker, 702

moving the cursor, 781, 789, 791
multiplier abbreviations, 46
multipliers, 46
Multi-Trace Configurations, 95
multi-trace configurations, 95
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N

NA Factory Cal, 770
NA mode

calibration, 125
settings, 91, 94, 96

name files, 780
network analyzer, 89
noise figure, calibration, 687
noise figure, option 356, 649
Noise Marker IQA, 305
normalization, 135
normalize, 135
numeric values, 46
numeric values, entering, 46

O

O, S, L cal, 129
O, S, L calibration, 129
Occupied Bandwidth, 218
old data indicator (*), 214
Opt 010, 113
option

010, 113
215, 75

option 312 , channel 
scanner, 621

Option 352, Mapping, 457
Option 355 AM/FM Metrics, 607
option 356, noise figure, 649
Option 360, Antenna, 405
option,license, 755
options

installing, 754
OTA

measurements,about, 342
measurements,how to 

make, 353
OTA Glossary, 400
OTA mode

settings, 353
OTA troubleshooting, 399
Output Power

NA Mode, 107, 589
output power, 57, 107, 590
overpowering, avoid, 36
Over-The-Air, 337
overview, 25
overview,alignments, 201

P

PAA
settings, 417, 732

PAA mode
settings, 417

packaging markings, 821
panel, front, 38
panel, left side, 43
panel, right side, 42
panel, top, 41
Parameter Conversion, 93
peak

criteria, 711
excursion, 711, 712
threshold, 711

perform
single sweep while in 

Hold, 726
Phase Offset, 101
Phased Array Antenna

measurements,about, 408
phased array antenna

settings, 732
Phased Array Antenna mode

settings, 417
Phased Array 

Antenna,Record/Playback, 
438

Playback Configuration, 280, 
283, 397, 441, 500, 523, 527

Points EMI mode, 328
Points SA mode, 198, 268, 676
points, EMI mode, 328
points, RTSA mode, 268
points, SA mode, 198, 676
Port Extensions, 108
power meter mode, 537
power requirements, 29
power requirements for the 

AC/DC adapter, 29
power sensor input, 42
Power Spectral Density, 217, 

239
power, maximum, 36
Preferences, 740
preferences, 740
prefixes for file names, 789, 791
preparing for initial use, 29
preset, 727
preset settings, 727
Printing, 792

printing, 792
protection, high 

temperature, 32
protective functions of the 

battery, 794
Pulse Measurements, 567

Q

Quick Settings, 97
quick settings, 52
Qwerty keyboard, 749

R

Radio Standard, 153
real-time spectrum analyzer 

mode, 251
recall an *.sta file, 782
recalling files, 782
Receiver Measurements, 94
Record Source, 282, 526
Record/Playback, 276, 519
Record/Playback,Mapping, 494
Record/Playback,Phased Array 

Antenna, 438
Record/Playback,RTSA, 276, 394
Record/Playback,SA, 519
Recording Configuration, 281, 

396, 440, 500, 523
reference marker, 702, 713
reference, external 

frequency, 760
Reflection Mode, 531
remote server, 507
resolution, 44, 56

NA Mode, 104
Resolution Bandwidth EMI 

mode, 326
Resolution Bandwidth SA 

mode, 182, 263, 677
resolution bandwidth, EMI 

mode, 326
resolution bandwidth, NF 

mode, 677
resolution bandwidth, RTSA 

mode, 263
resolution bandwidth, SA 

mode, 182
Resolution, NA mode, 104
Response Cals, 134
response cals, 134
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Restart, 198, 267, 327, 676
restart, 198, 267, 327, 676
return loss measurements, CAT 

mode, 60
review connector care, 47
reviewconnector care, 827
RRC Weighting, 224
RTSA, 251
RTSA mode

settings, 254
units, 256

RTSA, Spectrogram 
Display, 274

RTSA,Record/Playback, 276, 
394

RTSA,Specrtrogram 
Display, 274

RTSA,spectrogram display, 274

S

S11 measurements, NA 
mode, 91, 94

SA mode
settings, 151, 254, 274, 514
units, 157

SA Mode Units, 157, 256
SA,Record/Playback, 519
SA,spectrogram display, 514
Safety Considerations, 801
save

display setting as 
preferences, 742

file, 778
save and recalling files, 778
Save Preferences, 742
Scale Settings

NA Mode, 99
scale settings, NA mode, 99
scale, setting, 53, 722
screen cleaning, 40
screen front panel, 44
Security Level, 763
select

language, 743
sending SCPI commands, 

mini-USB port, 775
sensors,LAN

Troubleshooting, 554
service diagnostics, 769
Sessions, 276, 519
set

date and time, 746
display colors, 729
display units, 551
output power, 589

set up,EMF, 387
settings

CAT mode, 51, 533, 534
CISPR, 321
DTF, 66, 78, 91, 115, 290
DTF mode, 66
EMF, 226, 387, 732
EMI, 335
frequency extender, 732
language, 743
Mapping, 471
mapping, 732
OTA, 353
PAA, 417, 732
phased array antenna, 732
preset, 727
RTSA mode, 254
SA mode, 151, 254, 274, 514
spectral emission mask, 732
USB antenna, 451
USB antennas, 732
VVM mode, 588

Settings, EMF, 226
settings,how to set up

Mapping, 474
smoothing, 55
Source Control with USB 

Power Meter, 548
S-parameters, 91
spectral emission mask

settings, 732
Spectrogram Display, 274, 514
Spectrogram Display, 

RTSA, 274
Spectrogram Display,RTSA, 274
spectrogram display,RTSA, 274
spectrogram display,SA, 514
spectrum analyzer mode, 147, 

251, 513, 531, 541, 557
Spectrum Emission Mask 

(SEM) - (SA Mode Only), 238
stand-by mode, 31
Startup Mode, 744
static charge, dissipate, 37
Step Detection Mode, 553
suffixes for file names, 789
sweep

acquisition parameter, 184, 
185, 189

time, 56
time, NA mode, 105
type, 55, 104
type, EMI mode, 185
type, SA mode, 184

Sweep Acquisition, 188
sweep acquisition, 188
Sweep Time

NA Mode, 105
Sweep Type

EMI Mode, 185
SA Mode, 184

system configuration 
settings, 754

System Impedance (Z0), 108
System Settings, 725
systematic, 126

T

TDR, 75
temperature control mode, 33
Time Domain, 113
time domain, 75
Time Zone, 746, 764
time zone, 746
time/date setting, 746, 762
title, editing, 730, 731, 780
top panel, 41
trace averaging, setting, 55, 723
Trace Display States, 198, 269, 

310, 328
trace display states

IQA, 310
Trace Math, 565, 720
Trace Width, 730, 742
Tracking Generator, 181
Transform, 113
transform, 116
Transform Window, 118
transform window, 118
triggering - RTSA mode, 264
Triggering - SA Mode, 192, 264
triggering - SA mode, 105, 192
TRL, 138
troubleshooting

sensors,LAN, 554
troubleshooting,OTA, 399
Tune & Listen (AM/FM), 166, 170
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units, changing, 73, 85
units, DTF, changing, 73
USB antenna, 445

measurements,about, 449
measurements,how to 

make, 229, 451
settings, 451

USB antenna mode
settings, 226, 451

USB antennas
settings, 732

USB keyboard, 26
use

external reference, 760
User Preset, 727
User Tags, 278, 521
utilities, 732

V

values
multipliers, 46
numeric, 46

values, multipliers, 46
VBW, 183, 184
vector voltmeter, 585
vector voltmeterSeeVVM, 585
Velocity Factor, 69, 109
verifying integrity of

calibration, 144
jumper cables, 144

verifying integrity of calibration 
& jumper cables, 144

video bandwidth, 183, 184
Video Bandwidth SA mode, 183
Video triggering, 105, 192, 264
video triggering, 192, 197, 264
viewing

charge status, battery, 726, 
793

installed options, 742, 754
viewing and changing

frequency extender, 733
Volume Control, 728
volume control, 728
VSA, 507
vsa, 507
VVM Calibration, 591
VVM mode, 585

bridge cancellation 
measurements, 595

settings, 588
VVM mode, settings, 588

W

Waterfall Display, 514, 517
Waveguide Calibrations, 139
where to find the latest 

information, 27
Window Settings

DTF, 72, 84
window settings, DTF, 72

Z

zero span, 190, 191
Zeroing VVM mode, 591
zeroing, external, 547
zeroing, VVM mode, 591
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